# Contents

*About This Book* ................................................................. vii  
*Recommended Reading* .................................................. ix

## PART 1  Introduction  1

**Chapter 1 • General Overview**  ............................................. 3  
Introduction to SAS IT Resource Management ................................................................... 3  
Architecture and Basic Principles for Data Administrators ................................................. 6  
How to Locate Documentation .......................................................................................... 10  
National Language Support (NLS) .................................................................................. 12  
Terminology Changes ....................................................................................................... 13  
Accessibility ..................................................................................................................... 14

**Chapter 2 • Preparing to Work with the SAS IT Resource Management Client** ...................... 15  
Working with SAS Management Console ......................................................................... 15  
Working with SAS Enterprise Guide ................................................................................. 20  
Working with Metadata ..................................................................................................... 27  
Additional Requirements for z/OS .................................................................................. 31

**Chapter 3 • Working with the SAS IT Resource Management Client** ................................. 33  
Overview of the SAS IT Resource Management Client ....................................................... 33  
Features of the SAS IT Resource Management Client ....................................................... 37  
Working with Wizards ....................................................................................................... 45  
SAS IT Resource Management Transformations ................................................................... 48  
Icons for SAS IT Resource Management Objects ................................................................ 48

## PART 2  Accessing and Processing IT Data  51

**Chapter 4 • IT Data Mart** .......................................................... 53  
About the IT Data Mart ....................................................................................................... 53  
Working with IT Data Marts .............................................................................................. 59  
Importing, Exporting, and Promoting Metadata ................................................................. 71

**Chapter 5 • Adapters** ............................................................... 79  
About Adapters .................................................................................................................. 79  
Working with Template Tables .......................................................................................... 87  
Maintaining Template Tables and Staged Tables Based on Adapter Changes .................... 97

**Chapter 6 • Formulas** .............................................................. 111  
About Formulas ............................................................................................................... 111  
Working with Formulas .................................................................................................... 114

**Chapter 7 • Staging the Data** ..................................................... 119  
About Staging the Data ...................................................................................................... 120  
Working with Staging Transformations ............................................................................. 121
Chapter 8 • Aggregating the Data ................................................................. 147
  Overview of the Aggregation Transformation ......................................... 148
  About Aggregation Tables ......................................................................... 149
  Preparing to Create an Aggregation Table ................................................. 160
  Creating an Aggregation Table with the Simple Aggregation Table Wizard ... 161
  Creating Aggregation Tables with the Summarized Aggregation Table Wizard ... 163
  Creating Aggregation Tables with the Aggregation through the Template Wizard ... 183
  Cloning an Aggregation Table .................................................................. 185
  Adding a New Column to an Aggregation Table ....................................... 187
  Deleting an Aggregation Table .................................................................. 189
  Editing or Modifying an Aggregation Table .............................................. 190
  Publishing an Aggregation Table as Template ........................................ 192
  Purging Contents of an Aggregation Table .............................................. 192
  Renaming an Aggregation Table .............................................................. 193
  Indexing an Aggregation Table .................................................................. 194
  Create a View of a Simple Aggregation Table for Source Tables Supported by MXG ... 197
  Working with Aggregation Transformations .............................................. 197
  Working with Aggregation Transformation Filters ..................................... 201

Chapter 9 • Adapter Setup Wizard ............................................................... 209
  About the Adapter Setup Wizard ............................................................... 209
  Using the Adapter Setup Wizard ............................................................... 211
  What Does the Adapter Setup Wizard Create? .......................................... 224
  Domain Categories ................................................................................. 237
  Deploy and Run Jobs That the Adapter Setup Wizard Creates ................... 238

Chapter 10 • Information Maps ................................................................. 239
  About Information Maps ........................................................................... 240
  About Information Map Transformations ............................................... 242
  User-Specified Information Map Transformations .................................... 244
  Information Map Objects That Are Generated by the Adapter Setup Wizard ... 252
  Working with Information Map Filters ..................................................... 254
  Using SAS Information Map Studio ......................................................... 259
  Troubleshooting Information Maps Problems .......................................... 263

Chapter 11 • User-Written Staging Code ..................................................... 265
  User-Written Staging Transformations ..................................................... 265
  What Are the Properties of the User-Written Staging Transformation? ....... 266
  Guidelines for Processing Data with User-Written Staging Transformations ... 267
  Working with User-Written Staging Transformations ............................... 284
  Using the Additional Generated Code ...................................................... 292

Chapter 12 • Jobs ......................................................................................... 295
  Jobs That Process IT Data .......................................................................... 295
  Working with Jobs ..................................................................................... 300
  Running Jobs ............................................................................................ 305
PART 3  Appendixes  319

Appendix 1 • SAS IT Resource Management Components ........................................ 321

Appendix 2 • Data Sources Supported by SAS IT Resource Management Adapters ........ 323
  Data Sources Supported by SAS IT Resource Management Adapters .................. 325
  Supported Adapters ......................................................................................... 325
  MXG Adapters — Accessing Raw Data .......................................................... 332
  BMC Perf Mgr — Accessing Raw Data .......................................................... 332
  CSV — Accessing Raw Data ........................................................................... 335
  DT Perf Sentry — Accessing Raw Data .......................................................... 337
  HP Perf Agent — Accessing Raw Data ............................................................ 340
  RRDtool — Accessing Raw Data .................................................................... 342
  SAR — Accessing Raw Data ............................................................................ 344
  SNMP — Accessing Raw Data ........................................................................ 346
  Web Log — Accessing Raw Data ..................................................................... 354
  Database Adapters: SAP ERP, HP Reporter, MS SCOM, and VMware ............. 354
  Working with Custom Tables .......................................................................... 368
  Working with MXG Code to Stage Data ......................................................... 370
  How MSU and MIPS Columns Are Included in Staged Tables for the SMF Adapter 377
  VMware vCenter Data Acquisition Jobs ......................................................... 396

Appendix 3 • Staging Parameters ........................................................................... 399
  Staging Parameters ......................................................................................... 400
  Staging Parameters for Supported Adapters .................................................... 411
  User-Written Staging Parameters .................................................................... 439

Appendix 4 • Jobs That the Adapter Setup Wizard Creates for Domain Categories ........ 443

Appendix 5 • Duplicate-Data Checking .................................................................. 455
  Duplicate-Data Checking Overview ............................................................... 455
  How Is Data Checked for Duplicates? .............................................................. 456
  Control Data Sets for Duplicate-Data Checking .............................................. 457
  Working with Duplicate-Data Checking Macros ............................................. 458
  How to Implement Duplicate-Data Checking from a Staging Transformation .... 459
  Additional Details for SAP ERP, MS SCOM, and HP Reporter Adapters ........ 460
  Duplicate-Data Checking for User-Written Staging Code ............................. 461
  Examples ........................................................................................................ 461

Appendix 6 • Data Model ....................................................................................... 465
  Overview of the SAS IT Resource Management Data Model ......................... 466
  Data Model Adapter and Domain Category Specifications ............................ 469
  What Are Key Metrics? .................................................................................. 484
  Key Metrics for the Server Performance Domain Category ............................. 485

Appendix 7 • Naming Standards ........................................................................... 493
  About Naming Standards for SAS IT Resource Management Objects ............. 493
  Naming Standards and Location of Objects ..................................................... 493

Appendix 8 • Macros ............................................................................................ 499
  Introduction to the Macros in SAS IT Resource Management ......................... 500
  %RMDELETE .................................................................................................. 501
  %RMDELPVT ................................................................................................. 503
  Duplicate-Data Checking Macros .................................................................. 506
  %RMMSBMCMP ............................................................................................. 511
  %RMMSDTPS ................................................................................................. 513
Appendix 9 • Best Practices and Troubleshooting Tips ................................. 537
  How to Back Up SAS IT Resource Management .................................................. 538
  Debugging Problems in SAS IT Resource Management ........................................... 541
  Tips for Working with SAS IT Resource Management Client ..................................... 544
  Tips for Working with the IT Data Mart ................................................................. 544
  Tips for Working with Aggregations ........................................................................ 546
  Tips for Working with Information Maps ............................................................... 546
  Tips for Installing and Configuring SAS IT Resource Management ......................... 547
  Handling Holidays ................................................................................................... 547
  Performance Issues .................................................................................................. 552

Appendix 10 • Statistics ............................................................................................ 555

Index .......................................................................................................................... 557
About This Book

Audience

The purpose of the SAS IT Resource Management: Administrator's Guide is to present all topics that are related to system administration and data preparation in SAS IT Resource Management. For information about reporting topics, see SAS IT Resource Management: Reporting Guide.

SAS IT Resource Management: Administrator's Guide is designed for the following users:

• Data administrators are responsible for administering the IT data mart and setting up the jobs that stage and aggregate IT performance data so that report-ready data is available for generating reports. Data administrators typically deploy and schedule the batch production jobs that prepare and generate the IT performance reports. They often function as IT performance managers and capacity planners.

Data administrators typically use the documentation that is found in the SAS IT Resource Management: Administrator's Guide, although they usually refer to all SAS IT Resource Management documentation.

• Performance analysts are responsible for analyzing IT performance data that is managed by the data administrator, and designing and creating reports that communicate IT intelligence. These users analyze this data in order to best benefit the business and to improve the utilization, availability, and performance of IT resources and the IT enterprise. Performance analysts often function as capacity planners, system administrators, and business analysts.

Performance analysts typically use the documentation that is found in SAS IT Resource Management: Reporting Guide, although they might refer to all SAS IT Resource Management documentation.

• Information consumers are responsible for analyzing report data and making decisions based on that data. These users are business people who are interested in the overall performance aspects of IT at a company. They often function as system architects, IT managers, and IT executives. Information consumers use the reports that are generated by SAS IT Resource Management to support executive-level decision-making. They need to access the reports from the office as well as from remote locations.

Information consumers typically use the documentation that is found in SAS IT Resource Management: Overview and in SAS IT Resource Management: Reporting Guide, especially the sections about SAS Web Report Studio, Gallery Manager, and interpreting reports.
Prerequisites

Here are the prerequisites for using SAS IT Resource Management:

- A user ID and password that is appropriate for the type of access that is needed to accomplish designated IT Resource Management functions.
  
  *Note:* Data administrators use SAS Management Console to define the logins for users and groups of users, based on their roles and the SAS products that they need to work with.

- An operating environment that includes a supported client, middle tier, and server.

- **Depending on your role, access to the following software that is used by SAS IT Resource Management:**
  
  - SAS Data Integration Studio with plug-ins for SAS IT Resource Management
  - SAS Information Map Studio
  - SAS Enterprise Guide with add-ins for SAS IT Resource Management
  - SAS Add-In to Microsoft Office
  - Gallery Manager
  - SAS Web Report Studio
  - SAS BI Dashboard
  - SAS Information Delivery Portal
  - SAS Management Console

To log on to a SAS product, select **Programs ⇒ SAS.** From the list of software that displays, select the application you want to work with. If prompted, enter your user ID and password.

Online Help is available for all SAS software. Click **Help** within the product in order to access it. In addition, documentation for SAS software is available at this Web location: [http://support.sas.com/documentation/index.html](http://support.sas.com/documentation/index.html). Use the A-Z index to locate the documentation that you want to access.
Recommended Reading

- *SAS IT Resource Management: Overview*
- The "Administering SAS Enterprise Guide" chapter in *SAS Intelligence Platform: Desktop Application Administration Guide*
- *SAS Data Integration Studio: User's Guide*
- *SAS IT Resource Management: Reporting Guide*
- *SAS IT Resource Management: Migration Guide*
- *SAS Intelligence Platform: Overview*
- *SAS Management Console: Guide to Users and Permissions*

For a complete list of SAS publications, go to support.sas.com/bookstore. If you have questions about which titles you need, please contact a SAS Publishing Sales Representative:

SAS Publishing Sales
SAS Campus Drive
Cary, NC 27513-2414
Phone: 1-800-727-3228
Fax: 1-919-677-8166
E-mail: sasbook@sas.com
Web address: support.sas.com/bookstore
x  Recommended Reading
Part 1

Introduction

Chapter 1
General Overview ................................................................. 3

Chapter 2
Preparing to Work with the SAS IT Resource Management Client . 15

Chapter 3
Working with the SAS IT Resource Management Client .............. 33
Chapter 1
General Overview

Introduction to SAS IT Resource Management

What Is SAS IT Resource Management?

Information Technology managers need to access, manage, integrate, manipulate, analyze, and share information about large quantities of performance data for many IT resources (such as hardware, operating system software, networks, Web servers, databases, and applications). As such, IT performance evaluation software requires technology that can work with performance data from these many different sources, summarize and analyze that data, and provide reports that permit quick and accurate analyses of a company's IT resources from current, historical, and forecasted perspectives. The SAS solution to this critical business challenge is SAS IT Resource Management (ITRM).

Note: The SAS IT Resource Management solution has more than one version of software. Throughout this document, the software for SAS IT Resource Management 2.7 or earlier contains the version number (for example, SAS IT Resource Management 2.7 or earlier). The software for SAS IT Resource Management 3.1.1 or later does not contain the version number and is referred to as SAS IT Resource Management.

SAS IT Resource Management provides many IT domain intelligence features. For example, it provides the following features:
• a comprehensive IT performance management and capacity planning data model for supported adapters
• the Adapter Setup wizard, which facilitates the efficient specification of the extract, transform, and load (ETL) jobs, analysis, and reporting processes for many IT resources
• tools for the creation of user-written adapters
• supplied report definitions that facilitate IT resource analysis

SAS IT Resource Management is built on SAS®. It provides the IT data mart structure, staging and aggregation code for specialized ETL processing of IT data sources, unique plug-ins to SAS Data Integration Studio and SAS Enterprise Guide, and a Web-based Gallery Manager application for the distribution and organization of IT intelligence reports. SAS IT Resource Management also supplies the IT Resource Management Gallery Manager application. Gallery Manager is a Web-based application that enables the many reports that are produced by the SAS IT Resource Management solution to be grouped, filtered, and managed in logical containers called galleries.

SAS IT Resource Management Functionality

SAS IT Resource Management can be used to resolve a variety of systems management challenges within an organization. It provides the functionality to do the following tasks:
• support (access, read, stage, aggregate, and report on) many popular network and systems management tools across hardware platforms, operating system environments, networks, Web servers, databases, and applications.
• establish IT data marts that contain the IT resource management data from data sources that the enterprise.
• create common references to common measurements that are available in disparate data sources. This functionality ensures that the IT data mart provides an independent set of measurements that can be analyzed across the IT enterprise.
• calculate standardized measurements, units, and statistics to populate the IT data mart with analysis and report-ready data.
• define Aggregation transformations that are specific to the time-based summarizations and statistical measurements that are necessary to accommodate a site's analysis and reporting needs.
• provide the ability to create graphical and textual reports that contain all the information that is needed to manage current day IT operations.
• use SAS IT domain knowledge for performance management, capacity planning, IT resource forecasting, prediction, peak period and seasonality analysis, time-based analysis, workload analysis, and enterprise IT performance summaries that complement existing IT utilization, availability, and performance analysis capabilities.
• provide a variety of report output mediums to accommodate the needs of the data administrators, performance analysts, and high-level information consumers.

It also takes advantage of SAS®9 and the enterprise-class solutions that SAS®9 provides, such as:
• SAS Data Integration Studio

The SAS IT Resource Management solution provides additional IT-specific features and functionality to the data management capabilities of SAS Data Integration Studio. These additional ITRM features and functions are seamlessly integrated with
those of SAS Data Integration Studio. The enhanced capabilities of SAS Data Integration Studio that are delivered by SAS IT Resource Management are commonly referred to as the SAS IT Resource Management client, throughout this document. They are labeled accordingly in the SAS IT Resource Management software.

The SAS Data Integration Studio solution provides flexible data integration services for most data sources. These services perform most of the data preparation and aggregation work that is needed to analyze and report on resource performance. You can use SAS Data Integration Studio to perform the following tasks:

• create and maintain the IT data marts that are the containers for the information maps, ETL jobs, tables, templates, data, and libraries that are created by or used by SAS IT Resource Management.

• create and run the processes that stage data in preparation for use by the Aggregation transformations.

• calculate new fields of data from the input data.

• create and run the processes that aggregate the data.

• SAS Statistics and Econometric Time Series

This solution provides a complete set of SAS statistical methods for IT data analysis.

• SAS Enterprise Guide

This solution provides comprehensive report definition and reporting services. Report definitions that are created in this solution can be run interactively within SAS Enterprise Guide, or they can be scheduled to run in batch mode.

• SAS Intelligence Platform

This platform uses the SAS Foundation technology, which includes the following software: Base SAS, SAS/GRAPH, SAS/STAT, the Output Delivery System (ODS), and other technologies. It also provides access to the following components:

• SAS Information Map Studio: This product provides the functionality to create business-oriented data sources that are appropriate for all users, expert to novice, when designing and creating reports.

• SAS Web Report Studio: This Web-based, interactive query and analysis tool simplifies and standardizes access to and reporting of performance evaluation information.

• SAS Metadata Repository: This repository of centralized metadata stores information about the objects that are created and used by SAS IT Resource Management, such as IT data marts, ETL jobs, information maps, and more.

• SAS Information Delivery Portal: This open Java portal is a customizable portal that provides corporate decision makers with easy access to the data that is most pertinent to them. It enables users to access data by means of reports and dashboards, such as key performance indicators (KPIs), filter reports, and more. SAS Information Delivery Portal enables the selective and secure dissemination of information throughout an organization.

• SAS Add-In for Microsoft Office: This product enables integration with commonly used Microsoft products such as Microsoft Word and Microsoft Excel.
The Architecture of SAS IT Resource Management

SAS IT Resource Management uses data integration and business intelligence components that are provided by the SAS Intelligence Platform as well as additional software that was designed specifically for the processing of IT resource data. At installation time, users can deploy these components across multiple tiers. Using a multi-tier architecture to separate major software functions supports flexible processing schemes. The following functions can be supported on the tiers that SAS IT Resource Management uses:

• The client tier provides the interface between the user and SAS IT Resource Management. The client software enables you to perform data administration tasks, build reports, and view reports.

• The middle tier provides server support for Java applications. The Web-based Gallery Manager application runs on this tier.

• The server tier provides services that access data and perform background processing such as managing the metadata, executing stored processes, and performing resource aggregation calculations. In addition, the server tier provides the metadata for the files and tables that are input to and generated by the SAS IT Resource Management software.

With multi-tier processing, the tiers can be separated so that the processing can be done on multiple machines.

• The SAS IT Resource Management client must run on the Windows operating environment.

• The SAS IT Resource Management middle tier can run in Windows or UNIX operating environments.

• The SAS IT Resource Management server can run in Windows, UNIX, or z/OS operating environments.

Therefore, those software components for the server and the middle tiers can be installed on different machines according to the site requirements of an enterprise and the platforms that are supported by SAS for each tier of the SAS software architecture. For example, in a Windows environment, all of the processes that are needed by SAS IT Resource Management can be installed on a single PC. Other sites might prefer to install the client applications and middle tier on a PC and install the remaining components on the mainframe. Another option is to install the components needed for Web-based functions on a UNIX processor. The SAS representative can discuss these options and ensure the most appropriate configuration for a site.

The following diagram displays the architectural components that constitute the clients, middle tier, and servers that are used by SAS IT Resource Management.
The Basic Principles and Components of SAS IT Resource Management

Preliminary Tasks
SAS IT Resource Management has the flexibility to support customers whose usage of the product can range from the basic to the highly complex. Information consumers can work with specialized tools to access their IT data directly and generate ad hoc reports. Information consumers can use these reports to answer specific questions about the health and efficiency of the enterprise's IT resources. In all cases, the raw data for the resources that are being evaluated must be staged and aggregated. The resulting tables are input to the information maps and the reporting processes.

The following information describes the preliminary tasks that must be performed in order to use SAS IT Resource Management. After SAS IT Resource Management is installed and before the staging and aggregating processes can run, the data administrator uses SAS Management Console to perform the following setup tasks:
• Connect to the metadata server.
• Define new workspace servers.
• Add users and groups to the online Metadata Repository.

Note: The installation process for IT Resource Management provides the definitions that are needed for the supplied groups. No definitions are supplied for users, so the data administrator must add these definitions.

• Modify the default Access Control Template (ACT) for users or groups.
• Define Content Server mapping for use by IT Resource Management report packages. The Content Server requires an HTTP server in order to be used by Web Report Studio and other Business Intelligence Platform applications. This server must be configured so that its content and its metadata are synchronized and are compatible with the file structure of IT Resource Management.
• Define deployment locations for deploying jobs from Data Integration Studio.

For more information about these tasks, see “Working with SAS Management Console” on page 15.

Using IT Resource Management

After the preliminary tasks and initial setup are complete, you can use IT Resource Management to process and evaluate IT resource data. IT Resource Management provides the processes and the supporting technology that are required to regularly collect, aggregate, analyze, and report on the IT performance evaluation data that is vital to the health of an enterprise.

To start SAS IT Resource Management from the Windows Start menu, select Programs ⇒ SAS ⇒ SAS IT Resource Management.

In general, the processes that gather and monitor IT performance evaluation data consist of the following steps.

1. Collect the raw data about a resource.

   IT performance data is information about IT resources, such as hardware, operating system software, networks, Web servers, databases, and applications. Raw (or unprocessed) data about the usage or performance of these resources is generated by the logging mechanisms that are inherent to IT resources or is created by the Enterprise Systems Management tools that are used to manage the IT infrastructure. The raw data is input to SAS IT Resource Management transformations that are supplied with SAS IT Resource Management software.

   For information about how to generate and reference the raw data for supported adapters, see the various "Accessing Raw Data" topics in “Data Sources Supported by SAS IT Resource Management Adapters” on page 325.

2. Process (stage) the raw data.

   The raw data is processed (or staged) by adapters that are tailored to the data sources that they process. The adapter's staging code performs functions such as normalizing measurement units, generating computed columns from the raw data, and checking for duplicate data. Staging is performed by transformations that are set up in jobs. The job that actually executes the transformation can run interactively but is normally scheduled to run in batch mode, depending on the requirements of your enterprise.

   A unique staging transformation is supplied for each adapter that is supported by SAS IT Resource Management. It contains the code and can access the associated templates that are needed to process and load the raw data into staged tables. The
staged tables can then be used as input to an Aggregation transformation or other SAS Data Integration Studio and SAS IT Resource Management transformations.

Information about these staging components is available in the following topics.

- For a list of the adapters that are supported by SAS IT Resource Management, see “Supported Adapters” on page 80.
- For more information about user-written staging code, see “User-Written Staging Transformations” on page 265.
- For more information about the staging transformations that are available for the supported adapters, see “About Staging the Data” on page 120.

3. Aggregate the data in the staged tables.

After the raw data is staged, it can be input to the aggregation step. An aggregation is the act or process of grouping data, using an operation that produces a statistic such as a sum, average, minimum, or maximum. The term aggregation can also refer to the grouped data that results from such an operation. Aggregation transformations can generate summarized aggregated tables or simple aggregated tables.

- Simple aggregations do not undergo any summarizations; they simply append new data as it was read by the staging transformation to an existing aggregation table. (These tables are typically called detail aggregation tables.)
- Summarized aggregations read data from a staged or user-defined table and then categorize and aggregate data according to the specifications of the Aggregation transformation.

Jobs that contain Aggregation transformations are created and updated in SAS Data Integration Studio.

An Aggregation transformation can contain multiple aggregations that each generate an aggregation table of data. SAS IT Resource Management provides the ability to customize Aggregation transformations based on a site's requirements. An Aggregation transformation can be customized to perform aging and filtering of the aggregated data. It can perform calculations that create additional columns of data and join columns from different tables. It can support summarizations of data into any choice of time periods. The Aggregation transformation can also compute statistics on the data, calculate percent of change of a statistic over a specified period of time, and calculate the rank of a statistic or a class or ID column.

An unlimited number of aggregations can be created for each staged table. For example, the same data source can be input to both a daily aggregation and a weekly aggregation within the same or separate Aggregation transformations. For more information about working with Aggregation transformations and aggregation tables, see “About Aggregation Tables” on page 149.

After the performance data has been aggregated, it is ready for the reporting processes.

4. Generate information maps.

For a supported adapter, SAS IT Resource Management generates transformations that create information maps that reference the tables of data that are generated by that adapter's Aggregation transformations. Information maps provide clearly labeled references for all data fields that are used to create and view reports. Information maps can be used in SAS Enterprise Guide and SAS Intelligence Platform applications such as SAS Web Report Studio in order to generate reports that provide domain intelligence about the adapters, such as CPU utilization, threshold analysis, and peak period analysis.
For more information about working with Information Map transformations to create and customize information maps, see “About Information Maps” on page 240.

5. Define and generate the reports.

SAS IT Resource Management generates tabular and graphical reports from report definitions that are supplied with the software, or created in SAS Enterprise Guide. Report definitions can be accessed by the Gallery transformation and, when the job that contains that Gallery transformation is run, the reports are generated and stored on the SAS Content Server. Report jobs are usually run in batch mode.

Report definitions can be run directly from SAS Enterprise Guide, and the resulting reports can be viewed interactively from the SAS Enterprise Guide Project window or from a Web browser. The reports can also be published to your Web server.

6. View the reports.

Reports that are generated by running the Gallery transformation are stored on the SAS Content Server where they can be accessed and managed by Gallery Manager. Gallery Manager enables information consumers to organize their reports into galleries and to set accessibility controls on those galleries. Galleries can be marked as private (for an individual’s use) or public (for use by all Gallery Manager users.) Galleries can also be filtered so that they display only a subset of the available reports.

Reports can also be viewed on the Web through SAS Information Delivery Portal.

For more information about the reporting capabilities that are available using SAS IT Resource Management data, see SAS IT Resource Management: Reporting Guide.

Information consumers and performance analysts can also use these additional processes:

- Generate and view ad hoc reports.
  SAS Web Report Studio is a Web-based interface that can use information maps to select and report on data. Information maps are generated by Information Map transformations.

- Use Microsoft Office products.
  SAS Add-In for Microsoft Office enables SAS functionality to be accessed directly from the menus and toolbars of Microsoft Office word processing and spreadsheet products.

Performance analysts and information consumers who frequently work with Microsoft Office products such as Microsoft Word and Microsoft Excel can use SAS to access, analyze, and report on IT performance data that is available in information maps, and then distribute the results to other people in the enterprise.

---

**How to Locate Documentation**

**Accessing SAS IT Resource Management Documentation**

Documentation about SAS IT Resource Management is available in the form of Web-based documentation, and online Help.

To locate the SAS IT Resource Management documentation, use the Products Index at http://support.sas.com/documentation/index.html. The following
documentation can be accessed from the SAS IT Resource Management documentation page:

- **What's New in SAS IT Resource Management**
  
  This document provides a brief description of the new features that are included in this release of the SAS IT Resource Management software and documentation.

- **SAS IT Resource Management: Overview**
  
  This document provides information about the extensive domain intelligence that is available with SAS IT Resource Management. It also provides a glossary for terms that are used by SAS IT Resource Management.

  The audience for this introductory document is anyone who works with SAS IT Resource Management or who uses the reports that are generated by the software.

- **SAS IT Resource Management: Administrator's Guide**
  
  This document contains detailed information about the tasks that are required to set up and manage the IT data mart. It also describes how to set up the IT Resource Management adapters so that they can process the IT resource data that is stored in the IT data mart. This guide provides information about how to set up and maintain IT data marts, work with simple and summarized aggregations, information maps, and the wizards, especially the Adapter Setup wizard, that facilitate the specification of the ETL processes required for administering a site's IT resource data.

  This document provides information about the other functional components of the software, such as the SAS Metadata Repository (SMR) and the like.

  The audience for this document is SAS IT Resource Management data administrators or capacity planners.

- **SAS IT Resource Management: Reporting Guide**
  
  This document contains detailed information about the tasks that are required to generate, view, and manage reports. It describes how to work with the Gallery task in SAS Enterprise Guide, the Gallery transformation, and Gallery Manager application. It also provides information about the other SAS products that support the reporting processes, such as SAS Web Report Studio, SAS Information Delivery Portal, and SAS Add-in for Microsoft Office.

  A “Report Conversion” appendix provides a description of the steps that are performed in order to re-create reports that were generated using SAS IT Resource Management 2.7 report macros. These steps use SAS Enterprise Guide 5.1, which is included in SAS IT Resource Management.

- **Gallery Manager: User's Guide**
  
  This document contains detailed information about the tasks that are required to create, view, and manage galleries and to view the reports that are included in those galleries. (This information is also included in the **SAS IT Resource Management: Reporting Guide**.)

- **SAS IT Resource Management: Migration Documentation**
  
  This document provides a description of the steps that are performed in order to move a site's processing from the earlier versions of the software to the current version.

Documentation is available for the business intelligence and data integration components of the SAS Intelligence Platform and all the SAS products that are referenced in this document. To access this documentation, navigate to the Web site at this location: [http://support.sas.com/documentation/index.html](http://support.sas.com/documentation/index.html).
Accessing SAS IT Resource Management Online Help

Online Help is available for anyone who performs tasks with the user interface.

Note: The Help that is provided with this release of the SAS IT Resource Management software briefly describes the fields on the windows that are specific to IT Resource Management.

To display the field-based Help window for an active window or tab, click Help or press the F1 key.

To search for topics about concepts or features that are identified by specific words, such as "information maps," click the Search tab in the Help window. Enter the text to be found and press the ENTER key.

Online Help is available for all SAS technology products on which SAS IT Resource Management is built.

National Language Support (NLS)

National Language Support (NLS) is a set of features that enable a software product to function properly in every global market in which the product is sold. Typically, software that is written in the English language works well for users who use English and use data that is formatted using the conventions that are observed in the United States. However, without NLS, these products might not work well for users in other regions of the world. NLS in SAS enables users in regions such as Asia and Europe to process data successfully in their native languages and environments.

SAS IT Resource Management uses NLS formats for dates and numbers in template table columns, staged table columns, and aggregation table columns. If a column uses NLS formatting, the value in the Format column of the table begins with “NL” such as NLNUM16.0. These NLS values in the Format column of the tables use the following naming convention:

- **NLNUN** indicates that the data value is numeric.
- **NLDATE** indicates that the data value is a date (without the time component).
- **NLDATM** indicates that the data value is a date (with the time component).
- The number before the period indicates the maximum number of characters (including numerals, commas, and dots) that the data value can have.
- The number following the period indicates the number of decimal places that the data value can have.

For example, if a table column has the value NLNUM16.2 in the Format column of the table, then you know that the data value is numeric, it has a maximum of 16 characters (including numerals, commas, and dots), and it has two decimal places. In this case, NLS enables the same data value to be presented in different ways (such as 1,000,000,123.75 in the United States or 1.000.000.123,75 in some European regions) based on the system locale.

Dates and times have many representations also, depending on the conventions that are accepted in a culture. The month might be represented as a number or as a name. The name might be fully spelled or abbreviated. The order of the month, day, and year might differ according to locale. Likewise, time can be represented in one English-speaking
country or region by using the 12-hour notation, while other English speakers expect time values to be formatted using the 24-hour notation.

In order to have NLS present data in the format that represents the traditional form that your users might expect, you can specify the locale setting when invoking SAS. A locale reflects the language, local conventions such as data formatting, and culture for a geographical region. Local conventions might include specific formatting rules for dates, times, and numbers, and a currency symbol for the country or region. You can use the LOCALE= system option to specify the locale of the SAS session at SAS invocation.

*Note:* For more information about how to set the locale for your system, see the *SAS National Language Support (NLS): User's Guide.*

---

**Terminology Changes**

The versions of SAS IT Resource Management 3.1 and later use new terminology to describe similar tasks, objects, or features that you might have used when working with earlier versions of the software. The following table provides some of the old terms that were used before this version of SAS IT Resource Management and the new terms that describe the same or similar tasks or objects.

*Table 1.1 Terminology Changes for SAS IT Resource Management 3.1, 3.1.1, 3.2, 3.21, and 3.3*

<table>
<thead>
<tr>
<th>Old Term or Phrase</th>
<th>New Term or Phrase</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDB</td>
<td>IT data mart</td>
</tr>
<tr>
<td>collectors</td>
<td>adapters</td>
</tr>
<tr>
<td>QuickStart wizard</td>
<td>Adapter Setup wizard</td>
</tr>
<tr>
<td>detail level data</td>
<td>simple aggregation data</td>
</tr>
<tr>
<td>summary level data</td>
<td>summarized aggregation data</td>
</tr>
<tr>
<td>process macro</td>
<td>staging transformation</td>
</tr>
<tr>
<td>reduction macro</td>
<td>Aggregation transformation</td>
</tr>
</tbody>
</table>

*Note:* The terms and phrases in the table show the change in terminology for similar objects and concepts. These terms do not represent an exact one-to-one correlation. For example, the Adapter Setup wizard provides more functionality and features than the QuickStart wizard. However, the general concepts and objectives of the two wizards are similar.
Accessibility

SAS IT Resource Management includes the following accessibility and compatibility features that improve usability of the product for users with disabilities. These features are related to accessibility standards for electronic information technology that were adopted by the U.S. Government under Section 508 of the U.S. Rehabilitation Act of 1973, as amended.

If you have questions or concerns about the accessibility of SAS products, send e-mail to accessibility@sas.com.

SAS IT Resource Management addresses several areas of 508 compliance:

- Software accessibility compliance applies to software.
  
  In SAS IT Resource Management, software accessibility compliance applies to the SAS Data Integration Studio user interface. SAS IT Resource Management uses the functionality of SAS Data Integration Studio for data manipulation functions. As such it has the same accessibility features as that product. For information about these features, see the SAS Data Integration Studio: User's Guide. This documentation is located at this address: http://support.sas.com/documentation/index.html.

- Windows accessibility compliance applies to Windows applications, such as SAS Enterprise Guide and SAS Add-In for Microsoft Office.

  SAS Enterprise Guide conforms to accessibility standards for the Windows platform. In addition, SAS Enterprise Guide has keyboard shortcuts for the following areas: the Import Data task, the main workspace, menus, the project tree, a process flow, the properties window for an object, and the code editor. For more information, see the Keyboard Shortcuts in the Help for SAS Enterprise Guide.

  You can also use keyboard navigation to navigate through the options in a drop-down list by pressing ALT and the up and down arrow keys.

  In some instances, you can use the Enable accessibility features option to enable additional accessibility features in the task windows and the windows that appear when you run a stored process. This option is available from the Options dialog box.

  - Documentation about SAS Enterprise Guide: User's Guide is located at this address: .

  - Documentation about SAS Add-In for Microsoft Office is located at this address: .

  - Web accessibility compliance applies to browser-based content and Web-based applications, such as SAS Web Report Studio, SAS ID Portal, SAS BI Dashboard.

  The accessibility features for these products are described in the documentation for these products. To locate the appropriate documentation for a SAS product, use the A-Z index at this location: http://support.sas.com/documentation/index.html.
Chapter 2
Preparing to Work with the SAS IT Resource Management Client

Working with SAS Management Console

Introduction to SAS Management Console ........................................ 15
Adding Users and Groups of Users .............................................. 16
Adding Locations for the Deployment of Jobs ................................. 18

Working with SAS Enterprise Guide ........................................... 20
About Working with SAS Enterprise Guide .................................. 20
Migrating SAS Enterprise Guide Projects to Work with SAS IT Resource Management 3.2 and Later ........................................ 22

Working with Metadata .......................................................... 27
About Metadata ........................................................................ 27
Supplied Metadata ..................................................................... 27
System Authentication When Logging On to the SAS Metadata Repository ........... 28
Backing Up and Restoring the SAS Metadata Repository .................... 29
Migrating from an Earlier Version of SAS IT Resource Management .................. 29
Tools for Exploring SAS IT Resource Management Metadata ....................... 29
Metadata Server Memory Issues ................................................ 31

Additional Requirements for z/OS ............................................... 31

Working with SAS Management Console

Introduction to SAS Management Console

After successfully executing the installation and configuration instructions that are delivered with SAS IT Resource Management, the data administrator must perform the setup tasks that are required by SAS IT Resource Management. These tasks ensure that performance analysts and information consumers have the permissions and tools that they need in order to work with their IT resource data. The data administrator performs these tasks with SAS Management Console and SAS Enterprise Guide.

Note: Unlike the previous versions of SAS IT Resource Management (versions 3.1 and 3.1.1), no specific customizations are needed for SAS IT Resource Management 3.2 and later.

SAS Management Console provides a single point of control for managing resources on all platforms that are supported by SAS. By invoking SAS Management Console, the data administrator has access to the many management functions that it provides. For information about these functions, see the SAS Management Console: User's Guide at
SAS Management Console enables SAS IT Resource Management data administrators to perform the following tasks:

- Add users and groups to the SAS Metadata Repository. By creating user groups, the data administrator can set permissions that provide security for data and reports that are registered in the SAS Metadata Repository. These groups govern how group members can access the various components of the system.

  Note: The User Manager component of SAS Management Console controls this function.

- Add users and groups to the Access Control Template (ACT) table. When you add users or user groups to the ACT table, you can also set permissions that govern the tasks that those users or user groups can perform. The permissions govern the resources that have been registered in the SAS Metadata Repository.

  Note: The Authorization Manager component of SAS Management Console controls this function.

- Add locations (or directories) for the deployment of jobs that are created in SAS IT Resource Management. After users define their jobs, they can submit those jobs for immediate execution or deploy them for scheduling in SAS Management Console. After a job is deployed, you can schedule the job to run in batch mode at a specified date and time.

  Note: The Schedule Manager component of SAS Management Console controls the function of specifying a job deployment directory.

To access SAS Management Console, from your Windows desktop, select Start ⇒ Programs ⇒ SAS ⇒ SAS Management Console.

**Adding Users and Groups of Users**

**About SAS IT Resource Management User Groups**

The installation process of SAS IT Resource Management establishes two user groups:

- IT Resource Management Administrators
  
  IT Resource Management Administrators can access all folders and galleries in Gallery Manager.

- IT Resource Management Users
  
  IT Resource Management Users can access their own private folders and any public folders and galleries. In addition, they can access only their own private folders in Gallery Manager. (Public folders can be accessed by anyone.)

  Note: Users who do not belong to either group have Read-Only access to public folders in Gallery Manager. In addition, Gallery Manager honors only the IT Resource Management Administrators and IT Resource Management Users groups. It does not honor any other groups that might be established.

SAS Management Console enables you to add new or existing users to a SAS IT Resource Management user group. To invoke SAS Management Console, perform the following steps:
1. Start SAS Management Console by selecting **Start ⇒ Programs ⇒ SAS ⇒ SAS Management Console**. 
   Connect to SAS Management Console by using the unrestricted user ID.

2. In the **Repository** field at the top of the **Plug-ins** tab, select the **Foundation** repository from the drop-down list.

3. With SAS Management Console, you can perform the following tasks:
   - “Add a New User to a SAS IT Resource Management User Group” on page 17.
   - “Add an Existing User to a SAS IT Resource Management User Group” on page 17.
   - “Set Permissions for Users” on page 18.

After adding a new or existing user to one of the IT Resource Management groups, set the login and then the permissions for that user. (A login is a copy of information about the external account for each application authentication domain.)

### Add a New User to a SAS IT Resource Management User Group

To add a new user to one of the two groups that are provided by SAS IT Resource Management, perform the following steps:

1. Right-click the **User Manager** component of SAS Management Console. From the drop-down list, select **New ⇒ User**.
   The **General** tab of the New User Properties dialog box appears. Enter the name and other identifying information for the user on this dialog box.

2. Click the **Groups and Roles** tab. From the **Available Groups and Roles** column, select the group (that is, IT Resource Management Administrators or IT Resource Management Users) into which you want to place the new user. Click the arrow to add the selected group to **Member of** column.

3. Define a login for this new user.
   Click the **Accounts** tab. Click **New** to display the New Login Properties dialog box where you can add login information for the new user. Ensure that the **User ID** and **Password** fields are entered. (DefaultAuth is the supplied entry that contains the login for the SASITRM server.)

4. Click **OK** to save your changes.

### Add an Existing User to a SAS IT Resource Management User Group

To add an existing user to one of the two groups that are provided by SAS IT Resource Management, perform the following steps:

1. From the list of registered users in the **User, Group, or Role** column, right-click the **IT Resource Management Administrators** or **IT Resource Management Users** and select **Properties**.
Display 2.1  IT Resource Management Administrators Properties Dialog Box

The dialog box contains five tabs: General, Members, Groups and Roles, Accounts, and Authorization. The Properties dialog box enables you to view and modify information about the selected user or user group.

2. Click the Members tab to display a list of the Available Identities and the Current Members. To add a user to the Current Members of selected group, highlight that user in the Available Identities column. Use the arrow to move the selected user to the Current Members column.

3. For each selected member, make sure that user has a login.

   To set the login for a user, click Properties. On the Accounts tab, ensure that the User ID and Password fields are entered. (DefaultAuth is the supplied entry that contains the login for the SASITRM server.)

4. Click OK to save your changes.

Set Permissions for Users

Permissions can be set in the ACT table in the Authorization Manager component of SAS Management Console. The ACT consists of a list of users and groups and indicates, for each user or group, whether permissions are granted or denied. An entry in the table can be applied to multiple resources. Make sure that the users have the appropriate permissions for the Foundation repository.

Note: For more information, see the SAS Intelligence Platform: Security Administration Guide.

Adding Locations for the Deployment of Jobs

In order to run a job in batch mode, a job must be deployed into a directory on the application server. The location of this directory can be defined in SAS Management Console. New deployment directories can also be defined in the SAS IT Resource Management Client, while you are deploying a job. To specify the location, perform the following steps:
1. If SAS Management Console is not running, start it by selecting Start ⇒ Programs ⇒ SAS ⇒ SAS Management Console.

*Note:* You must have the authority to use the Scheduler Manager plug-in in SAS Management Console. Your system administrator can grant this authority, if necessary.

2. Click the Plug-ins tab, if necessary, to display plug-ins in the left panel of SAS Management Console. In the Repository field at the top of this panel, select the Foundation repository from the drop-down list.

3. Select the Schedule Manager component of SAS Management Console.

*Note:* If the Schedule Manager component is not displayed in the list of plug-ins, your user ID is not defined to have access to Schedule Manager. Users can be granted access to Schedule Manager by administrative users.

4. From the menu bar, select Actions. From the drop-down list, select Deployment Directories. The Deployment Directories dialog box appears.

*Display 2.2 Deployment Directories Dialog Box*

5. In the Application Server field, you can specify the application server that you want to use for deploying jobs. Use the drop-down list to show the application servers that are available, and click to select a server. SASITRM is the application server that is configured by default when SAS IT Resource Management is installed.

SAS IT Resource Management establishes a SAS Application Server named SASITRM that sets properties such as memory size options and formats for the exclusive use of the solution. Establishing SASITRM as the SAS Application Server ensures that SAS IT Resource Management can be installed and operated with other SAS products and solutions, some of which may also establish SAS Application Servers.

*Note:* For more information, see “Defining Multiple Application Servers” in the *SAS® 9.3 Intelligence Platform: Application Server Administration Guide*.

6. In the Directories section of the Deployment Directories dialog box, you can specify one or more directories where the generated code for deployed jobs is to be stored. The server that is selected in the Application Server field must be able to resolve the paths to these directories.

SAS IT Resource Management supplies a Batch Jobs directory. The path to this supplied directory on the SASITRM server is: *SASEnvironment\SASCode\Jobs*. 
In the Deployment Directories dialog box, you can perform the following tasks:

- Define a new directory. To do so, click **New**.
- Update a directory. To do so, select the directory and click **Edit**.
- Remove the metadata for a directory. To do so, select the directory and click **Delete**.

If you are defining locations in z/OS traditional file system locations, you can specify the name of the directory as the full name of a partitioned data set.

For more detailed information about these tasks, click **Help**.

7. Click **OK** to save your changes.

---

**Working with SAS Enterprise Guide**

**About Working with SAS Enterprise Guide**

SAS Enterprise Guide is one of the primary reporting vehicles for SAS IT Resource Management. The data administrator uses the functions of SAS Enterprise Guide in order to perform the following tasks:

- Set up SAS Enterprise Guide so that it can work with SAS IT Resource Management data.
- Migrate SAS Enterprise Guide projects so that they can work with your SAS IT Resource Management 3.3 IT data marts, in which you created the report data.

**Setting Up SAS Enterprise Guide for SAS IT Resource Management Data**

In order to work with the data from SAS IT Resource Management, SAS Enterprise Guide needs to access the SAS Metadata Repository. To access a SAS Metadata Repository for use by SAS Enterprise Guide, perform the following steps:

1. Invoke SAS Enterprise Guide. To do so, from the **Start** menu, select **Programs** ⇒ **SAS** ⇒ **Enterprise Guide**.

2. From the menu bar, select **Tools** ⇒ **Options**. The Options dialog box appears. From the list in the left pane, select **Administration**.
3. If you want to create a profile or change your profile, click Modify, which opens the Connections window. Select the profile that you want to change and click Modify.

4. The Modify Profile window appears and enables you to create or revise the profile. Enter or revise the following information.
   a. The name of the profile is required. The description is optional.
   b. Specify whether the machine is remote or local by clicking the appropriate button.
   c. Enter the machine and port number of the server that you want to connect to. (If you selected Local, the machine name is automatically set to localhost.)
   d. Enter the user ID and password for the person who can access this server.
   e. Click Save to save all specified values and close the window, or Cancel to discard all values and close the window.

5. To connect to the server, select the appropriate profile and click Set active. The active server is the source for all resource definitions (such as servers and libraries).
   If the Credentials Required dialog box appears, enter your user ID and password and click OK.
   The selected repository is identified by the active repository icon: 📁.

6. Click Close to return to the Administration window.

7. Click OK to return to the main SAS Enterprise Guide workspace.
Migrating SAS Enterprise Guide Projects to Work with SAS IT Resource Management 3.2 and Later

About the Migration Wizard
The Migration Wizard for SAS Enterprise Guide and the SAS Add-in for Microsoft Office enables you to upgrade report projects that are created with earlier versions of SAS IT Resource Management and SAS Enterprise Guide. The upgraded version can then be used with your current version of SAS IT Resource Management and SAS Enterprise Guide.

SAS Enterprise Guide projects supplied by SAS IT Resource Management, and typically those created for use with SAS IT Resource Management, use information maps in the report projects. Therefore, you must change the map paths of the supplied information maps to point to the information maps that you created with the Adapter Setup wizard. The easiest way to change the map paths is to use the Migration Wizard for SAS Enterprise Guide and the SAS Add-in for Microsoft Office.

Prerequisites to Running the Migration Wizard
Before you run the Migration Wizard, you must run the staging, aggregation, and information map jobs that create the information maps for the adapter and domain category that you want to work with.

If you installed the supplied SAS Enterprise Guide projects, they can be accessed by navigating to the location where you installed SAS IT Resource Management. The projects are located at \SASITResourceManagement\SASEnterpriseGuideComponents\3.3. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at C:\Program Files\SASHome\x86\SASITResourceManagement\SASEnterpriseGuideComponents\3.3.

**T I P** Make sure the projects are not read-only projects. To do this, right-click each project and select Properties. On the General tab, make sure that the Attributes box is not checked. Then click OK.

**T I P** Make a copy of the SAS Enterprise Guide projects and migrate only the copied projects. The original projects should be kept as a backup.

Running the Migration Wizard
To run the Migration Wizard, navigate to the location where the current version of SAS Enterprise Guide is installed. Then select MigrationWizard.exe. Click Enter to invoke the Migration Wizard. The first page of the Migration Wizard appears. This page contains information about why you should use this wizard and what you should do before you run it.
On page 2 of the wizard, verify the connection profile of the application server where your information maps are located. You can click Modify to change your connection profile.

On page 3 of the wizard, select the files that you want to migrate. To do so, perform the following steps:

1. To facilitate the selection of files, from the drop-down list in the Show field, select SAS Enterprise Guide Projects (*.egp). This action causes only SAS Enterprise Guide projects to be displayed in the Available files column.

2. In the Available files column, navigate to the location of the SAS Enterprise Guide projects that you want to migrate.

3. Check the boxes next to the projects to be migrated.

4. Click the right arrow to move the projects to the Selected files column.

On page 4 of the wizard, information is displayed that explains the next steps of the migration process. Click Next to run the process that parses the files. The progress of the wizard is displayed as it locates all the references to the projects that you selected.
Display 2.5  Parsing Files Information Box

Click **Done** when the progress indicator shows that this task is complete.

On page 5 of the wizard, you must enter the new mapping information for the selected projects. To do so, perform the following steps:

1. Use the Show field to shorten the number of entries on this page. From the drop-down list, select **Global references only**. (This setting removes the information maps from this page, which significantly simplifies the contents of this page.)
2. Expand the page to the full width of your screen. This action enables you to have space to see the complete path information for the current and new mappings.

3. If necessary, resize the Current Mapping column width so that you can see the complete path. This path is the path that was used in the SAS Enterprise Guide project when it was last saved. It identifies the adapter and domain category for which the project was developed. As shown in the following display, a typical path is quite long (for example, `/Shared Data/SAS IT Resource Management/IT Data Marts/VMwareForReporting2/VMware vCenter 1/Domain Categories/Guest System`).

Display 2.7 Expanded Current Mapping Column

4. If you want to globally change all references to the server, click the ellipsis button (…) in the New Mapping column. The Change Resource dialog box appears. Use the Browse button to display the list of servers from which you can select the Server.
name that you want to use in your paths. If you want to apply this change to all the object references that contain this value, check the corresponding box.

5. You must enter the mapping information for your new IT data mart in the **New Mapping** column for each of the project folders that are shown on this page. To do so, perform the following steps:
   a. Select the folder and click the ellipsis button (…) in the **New Mapping** column. The Change Resource dialog box appears.
   b. Use the **Browse** button to display the list of folders to which the projects can be migrated. Expand the **Folders** tree until you locate the IT data mart from which you ran the Adapter Setup wizard for these projects.

   ![Display 2.8 Locating the IT Data Mart](image)

   c. Continue expanding the folders within the IT data mart until you find the location of the adapter and the domain category that corresponds to the path in the **Current Mapping** field. In the Select a Location box, the **Selected location** field displays the complete path for the new location.
   d. Make sure that the box is checked that specifies to apply this change to all object references that contain this value.

6. When you have entered the new mapping information for all the SAS Enterprise Guide project folders, click **Next**.

7. On the Begin the migration process page, you can also enter the path to your Migration Record File. You can also change the path to the Log File, specify whether to create automatic backups of the original files, and specify whether to verify the existence of all resources that were changed.
For best results, specify that the original files should be backed up automatically.

8. Click Finish to perform the migration. The Migrating files window displays the progress of your migration. When the migration is complete, the status of the processing is displayed. If a processing error occurred, you can view the log file. Otherwise, click Done to exit from the Migration Wizard. The jobs that contain the projects that were successfully migrated can be opened in the IT data mart and run.

---

**Working with Metadata**

**About Metadata**

Metadata is structured data that describes the location and structure of enterprise data. During the installation of SAS IT Resource Management, metadata is created and stored in the SAS Metadata Repository. The metadata for SAS IT Resource Management consists of the following information:

- where SAS servers are deployed and how they are configured
- the location of the physical SAS data and how to access it
- the attributes of the data, such as types, formats, and dimensions of the tables that contain the data
- the specifications for processes and jobs, such as ETL processes
- security issues, such as credentials, user identities, groups, and roles

The metadata for SAS IT Resource Management is created, maintained, and used by the following applications:

- SAS Management Console: creates and maintains metadata that describes the attributes of SAS servers that are used by SAS IT Resource Management. For example, it describes where the servers are deployed and how they are configured. The metadata also maintains lists of authorized users, their permissions, their account information, and more.

- SAS IT Resource Management Client: creates and maintains metadata that describes the attributes of the data that is used by SAS IT Resource Management. For example, it describes the tables of staged or aggregated data, the definitions of the columns within those tables, the jobs, the libraries, and the transformations that make up the data management component of SAS IT Resource Management.

- SAS Enterprise Guide: uses metadata that describes the servers, users, libraries, information maps, and information map filters for reporting with SAS Enterprise Guide.

- SAS Web Report Studio: creates and maintains metadata for Web-based reports, and uses other metadata created and maintained by other SAS clients.

**Supplied Metadata**

In addition to the metadata that is described in the previous topic, SAS IT Resource Management also supplies other metadata. This supplied metadata consists of IT template tables for the supported adapters, IT formulas, and IT report definitions. The
installation process for SAS IT Resource Management stores the metadata in the Folders tree.

• The **SAS IT Resource Management** folder of the **Products** folder contains the metadata for the IT template tables of the supported adapters and the IT formulas. This metadata cannot be changed.

• The **SAS IT Resource Management** folder of the **Shared Data** folder contains the metadata for the 3.3 IT report definitions, IT data marts, and the IT formulas. This metadata can be changed, although changing the IT report definitions is not recommended. (If you need to change an IT report definition, copy it first and change the copy, not the supplied definition.)

**CAUTION:**

Do not make changes to the original IT report definitions in the Shared Data folder. For information about how to modify IT report definitions, see “Working with SAS Enterprise Guide Reports” in the **SAS IT Resource Management: Reporting Guide**.

• The **ITRM Transformations** folder of the **Transformations** tree contains the aggregation, gallery, information map, staging, and user-written staging transformations. These transformations can be dragged and dropped onto the process flow diagram of a job and further specified as needed.

**Note:** SAS IT Resource Management also uses folders, jobs, libraries, staged tables, aggregation table, and information maps. These objects are created by transformations that the user specifies (either directly or by means of the Adapter Setup wizard), the jobs that the user creates and runs, or by wizards (such as the New Folder, New IT Data Mart, or New Job wizards) that are invoked from the SAS IT Resource Management menu bar.

**System Authentication When Logging On to the SAS Metadata Repository**

To enable users to log on from SAS IT Resource Management to the SAS Metadata Server that contains the SAS IT Resource Management metadata, perform the following steps:

1. Invoke SAS IT Resource Management.

2. If you are already connected, from the menu bar, select **File ⇒ Connection Profile**. A message box displays a message that your application will be discontinued from its metadata server. It asks whether you want to continue. Click **Yes**.

3. The Connection Profile dialog box appears. In this dialog box, you can create a new connection profile or you can open an existing connection profile and modify it. After you specify the metadata profile that you want to use, click **OK**.

4. In the Login dialog box that opens, enter your user ID and password, and click **OK** to access the server that contains the metadata repository.

**Note:** If you previously chose to save the user ID and password for the particular connection profile, you are connected without being prompted to enter them.

When SAS IT Resource Management is installed, two groups of users are defined by default: IT Resource Management Administrators and IT Resource Management Users. Data administrators define additional users and groups as part of the setup tasks for SAS IT Resource Management. The metadata for all the logins for each user and group includes an authentication domain. Each user must have a login for the authentication domain that is associated with the relevant server definition. The user ID and password
in that login must correspond to an account that has been established with the repository. In addition, this account must correspond to a valid account on the server. In other words, the user must already have an account on the target machine. Otherwise, the user will not be able to access any existing metadata. For more information about defining login metadata for users, see the SAS Intelligence Platform: Security Administration Guide. This document can be found in the Administration Documentation section of the SAS Intelligence Platform documentation that is available at: http://support.sas.com/documentation/onlinedoc/intellplatform/index.html.

Note: The permissions that govern access to the metadata can be set in the Access Control Template table in the Authorization Manager component of SAS Management Console. For more information, see the SAS Intelligence Platform: System Administration Guide and the SAS Intelligence Platform: Security Administration Guide.

Backing Up and Restoring the SAS Metadata Repository

For recommendations about backing up and refreshing the SAS Metadata Repository, see the SAS Intelligence Platform: System Administration Guide. When you back up the metadata server, it is important to also back up the data that is associated with the metadata objects that are contained in the repositories. The metadata cannot be used without the associated data. If you need to recover from a failure, the metadata that you restore must be synchronized correctly with the associated data.

Migrating from an Earlier Version of SAS IT Resource Management

If you worked with SAS IT Resource Management 3.1.1, 3.2, or 3.21, you can migrate your metadata to the new (SAS IT Resource Management 3.3) environment. After you install and configure the current version of the software, you can migrate the metadata for all your IT data marts or for a single IT data mart. For information about these migration options, see SAS IT Resource Management 9.3: Migration Documentation. For more information about migrating the SAS system, see the SAS Intelligence Platform: Migration Guide.

If you created your own projects with SAS Enterprise Guide 4.1, 4.2, or 4.3, then you can use the Migration Wizard for SAS Enterprise Guide and the SAS Add-in for Microsoft Office to convert multiple projects at the same time to your current version of SAS Enterprise Guide. The Migration Wizard can change the paths in your SAS Enterprise Guide projects from the application server that was used with SAS 9.1.3 (SASMain) to the application server that is used with SAS 9.3 (SASITRM). If the paths were used in the SAS Enterprise Guide 4.1, 4.2, or 4.3 projects, the wizard can update the paths to the information maps. For information about the Migration Wizard, see “Migrating SAS Enterprise Guide Projects to Work with SAS IT Resource Management 3.2 and Later” on page 22.

Tools for Exploring SAS IT Resource Management Metadata

How to Access the SAS IT Resource Management Metadata

You can access the SAS IT Resource Management metadata in the SAS Metadata Repository by using the following methods:

• Explore the metadata repository from the SAS IT Resource Management Client. This method is the preferred way to access the SAS IT Resource Management metadata.
• Explore the metadata repository from the Folders tab of SAS Management Console.
• Browse the metadata repository from a Base SAS session. This method should be used only under the direction of SAS Technical Support.

**Explore the Metadata Repository from the SAS IT Resource Management Client**

The SAS IT Resource Management Client uses the data accessing and manipulation functions of SAS Data Integration Studio in order to populate its tables with data and to prepare that data for reporting.

**Display 2.9  Main Window of the SAS IT Resource Management Client**

The objects that SAS IT Resource Management uses are contained in folders in the Folders, IT Data Marts, and Transformations trees. For more detailed information about the many options and functions that are available within the SAS IT Resource Management client, see “Features of the SAS IT Resource Management Client” on page 37.

**Browse the Repository from a Base SAS Session**

Under the direction of SAS Technical Support, you can browse the repository from a Base SAS session. To do so, perform the following steps:

1. Enter `metabrowse` on the command line. The Metadata Server Configuration dialog box appears.
2. Specify the appropriate logon information for the server that you want to access. Enter **Server Name**, **Port Number**, **Protocol**, **User Name**, and **Password**. Under Windows, the **User Name** can be domain qualified. For example, you might need to use `domainname\username`, where `domainname` is your domain name and `username` is your user ID.

Click **OK** to open the Metadata Browser.

3. To navigate through the metadata on this site, follow the directions of SAS Technical Support.

### Metadata Server Memory Issues

**Memory Issues with the SAS IT Resource Management Metadata Server**

As the process size increases, the data administrator should delete from the SAS Metadata Repository any objects that are no longer needed or that have been marked for deletion by other processes. For best results, follow the recommendations for managing and maintaining your metadata server that are described in the *SAS Intelligence Platform: System Administration Guide*. This documentation is available at [http://support.sas.com/documentation/index.html](http://support.sas.com/documentation/index.html) in the Administration Documentation section of that Web site.

### Additional Requirements for z/OS

If you are using SAS IT Resource Management software on z/OS, the user account running the batch jobs needs the following settings:

- Batch jobs require a **REGION** specification of at least 1024M.
- TSO user IDs that are using SAS IT Resource Management software should have an **ASSIZEMAX** specification of at least 1024M.
Chapter 3
Working with the SAS IT Resource Management Client

Overview of the SAS IT Resource Management Client

Introduction to the SAS IT Resource Management Client

SAS IT Resource Management leverages and enhances SAS Data Integration Studio to administer and manage IT resource data. (The SAS IT Resource Management solution provides features and functionality in addition to that which is provided by SAS Data Integration Studio.) SAS Data Integration Studio is a visual design tool that provides a single point of control for managing data repositories and performing extraction, transformation, and loading (ETL) processes. It offers a variety of built-in transformations that enable you to perform the following tasks:

- build and manage data repositories
- construct and maintain data integration projects
- import data from and export data to a variety of sources
- create, modify, and deploy ETL jobs
The SAS IT Resource Management client uses SAS Data Integration Studio in order to create and manage metadata objects that define sources, targets, and the transformations that connect them. It also enables you to create the jobs that contain those transformations. SAS IT Resource Management uses metadata to create or retrieve SAS code that reads input from any data source that can be read by using SAS software. The metadata objects are stored in the SAS Metadata Repository that can be shared by multiple users.

SAS IT Resource Management enhancements to SAS Data Integration Studio provide additional object types, transformations, the Adapter Setup wizard, and other wizards that facilitate the process of generating and displaying analysis and report-ready data about your IT resources.

This chapter introduces the features and functions that are available with the SAS IT Resource Management client and provides basic information about the features and functions of SAS Data Integration Studio.

Note: To locate specific topics in the Help for SAS Data Integration Studio, you can use the Index or the Search feature.

- From the menu bar of SAS IT Resource Management, select Help ⇒ Contents and Index.
- Click the Index tab or the Search tab. Then type the name of the topic in the Find field and press the ENTER key.

**Getting Started**

To access the online data manipulation and administrative services that are provided by the SAS IT Resource Management client, you must first log on to and connect to a metadata server:

1. To start SAS IT Resource Management from Microsoft Windows, select Start ⇒ Programs ⇒ SAS ⇒ SAS IT Resource Management Client 3.3. The following dialog box appears.

   **Display 3.1 Open a Connection Profile Dialog Box**

2. Select (or create) a connection profile to connect to the server that contains the metadata for the SAS IT Resource Management objects such as jobs, templates, data, IT data marts, tables, information maps, report definitions, and transformations that you want to work with. The connection profile contains the information that identifies the server that contains that repository and the user who will be accessing the information from that repository.

   **Note:** At run time, SAS IT Resource Management authenticates to the metadata server using the one-time password technique documented for SAS 9.2 and later. This means that the user submitting the code (whether interactively or in batch)
should have a User object defined in metadata and a Login object defined for each authentication domain, with the correct user ID and password for each. In SAS Management Console, the User Manager can be used to create and modify Users. For each User object, the Logins can be created or modified on the Accounts tab of the User dialog box. For more information, see the “Security Overview” chapter in SAS 9.3 Intelligence Platform: Overview.

**Working with the Connection Profile Dialog Box**

To manage your connection profiles, select **File ➤ Connection Profile**. From the dialog box that appears, you can perform the following tasks:

- Create a new connection profile.
  
  If you select this task and click **OK**, the Connection Profile wizard appears. Enter the information that is requested by the wizard.

In the following display, values for the **Machine**, **Port**, **User ID**, and **Password** fields have been entered.

**Display 3.2  New Configuration Profile Wizard**

![New Connection Profile Interface](image)

Click **Finish** to create the new connection profile.

- Open an existing connection profile.
  
  If you select this task, from the drop-down list of existing connection profiles, select the profile that you want to open and click **OK**.

- Edit an existing connection profile.
  
  If you click **Edit**, the Connection Profile wizard appears. Enter the changes to the information that is requested by the wizard. Click **Finish** to open the updated connection profile.

- Delete an existing connection profile.
If you click **Delete**, from the drop-down list of existing connection profiles, select the profile that you want to delete and click **Delete**. In the confirm deletion message box, click **Yes** to delete the connection profile.

**Using the Connection Profile Wizard**

The Connection Profile wizard guides you through the steps that are needed to build (or edit) a connection profile that enables you to connect to a metadata server. The wizard prompts you to enter (or revise) the following information:

- the name of the connection profile. If you want to set this profile as the default connection profile, check the corresponding box.

- the fully qualified name of the machine on which the repository server operates.

  **CAUTION:**
  Do not enter “localhost” in the **Machine** field. SAS IT Resource Management jobs fail to run if the metadata host in the configuration profile is set to `localhost`.

- the TCP port on which the metadata server is listening for connections. To enter a port number, type directly in the field.

- the user ID (and domain if applicable) that is used to log on to the metadata server. In order to specify the domain for this profile, you must also specify a value in the **Authentication Domain** field.

  **Note:** You must authenticate to the operating environment where the metadata server is running.

- the password that is required for the specified user to log on to the metadata server. If you want to save the user ID and password in this connection profile, check the corresponding box.

- the authentication domain for the metadata server. If you specify a value for this field, the credentials that are specified for the metadata server are used to access servers or databases that are in the same authentication domain.

  **Note:** You must authenticate to the operating environment where the metadata server is running.

- If you want to save the user ID and password in this profile, check the corresponding box.

- If you want to use the Integrated Windows authentication (single sign-on), check the corresponding box. When you check this box, the **Advanced** option is enabled.

Click the **Advanced** option to open the Advanced Settings dialog box.

**Display 3.3 **Advanced Settings for the Configuration Profile

![Advanced Settings](image-url)
This dialog box enables you to specify the method for authenticating your credentials to the server and to SAS application servers. For information about how to specify the security package, the service principal name (SPN), and the security package list, click Help.

- After the required information is entered, the wizard displays a summary page that lists the options that you specified for this connection profile. If necessary, you can go back to previous pages of the wizard and modify your specifications.
- When you click Finish, the connection profile is created (or updated).

---

**Features of the SAS IT Resource Management Client**

**About the Desktop**

After you open a connection profile, the SAS IT Resource Management desktop is displayed. (The SAS IT Resource Management client is powered by SAS Data Integration Studio.) The following display shows the desktop that opens by default.

**Display 3.4 SAS IT Resource Management Desktop**
The main components that are shown in the previous display are described in the following table.

**Table 3.1 Desktop Components**

<table>
<thead>
<tr>
<th>Component</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title bar</td>
<td>Top of the desktop</td>
<td>Shows the current version of SAS IT Resource Management and the name of the current connection profile.</td>
</tr>
<tr>
<td>Menu bar</td>
<td>Under the title bar</td>
<td>Provides access to the drop-down menus. The list of active options varies according to the current work area and the type of object that you select. Inactive options are disabled or hidden.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Under the menu bar</td>
<td>Provides access to shortcuts for items on the menu bar. The list of active options varies according to the current work area and the type of object that you select. Inactive options are disabled or hidden.</td>
</tr>
<tr>
<td>Tree view</td>
<td>Left pane on the desktop</td>
<td>Provides access to the Folders, Inventory, Transformations, and IT Data Marts trees. It also provides access to the Basic Properties pane.</td>
</tr>
<tr>
<td>Basic Properties pane</td>
<td>Bottom of the left pane on the desktop</td>
<td>Displays basic properties of an object that is selected in the tree view. To display this pane, select View ⇒ Basic Properties from the desktop.</td>
</tr>
<tr>
<td>Status bar</td>
<td>Bottom of the desktop</td>
<td>Displays the name of the currently selected object, the name of the default SAS Application Server if one has been selected, the login ID and metadata identity of the current user, and the name of the current SAS Metadata Server. To select a different SAS Application Server, double-click the name of that server to display a dialog box. If the name of the SAS Metadata Server turns red, the connection is broken. In that case, you can double-click the name of the metadata server to display a dialog box that enables you to reconnect.</td>
</tr>
<tr>
<td>Runtime Manager</td>
<td>Under the Details pane</td>
<td>Displays the run-time status of the current job, the last time the job was executed in the current session, and the SAS Application Server that was used to execute the job. To display this pane, select View ⇒ Runtime Manager from the desktop.</td>
</tr>
</tbody>
</table>
The Tree Views

About Trees
Trees facilitate how you work with SAS IT Resource Management. They provide you with easy access to the folders, transformations, and metadata objects that are registered with the SAS Metadata Server. In addition to the Folders, Inventory, and Transformations trees that are provided by SAS Data Integration Studio, the SAS IT Resource Management client provides the IT Data Marts tree.

You can change how the trees are displayed in the left panel of the desktop. To do so, select one of the options from the drop-down list. These options enable you to move the tree up, down, to the right, or to the left in the left panel.

IT Data Marts Tree
The IT Data Marts tree displays the IT data marts that can be accessed by the current connection profile. IT data marts contain the metadata for the jobs, libraries, tables, information maps, and other elements that support the ETL processes and reporting of IT resource data. As such, the IT Data Marts tree is the primary starting point for most of the SAS IT Resource Management processes. For best results, perform your IT resource management tasks from within this tree.

For more information about IT data marts, see “About the IT Data Mart” on page 53.

Folders Tree
The Folders tree organizes metadata into folders that are shared across a number of SAS applications. My Folder and Shared Data are the folders that you use most of the time. The following folders are supplied by default:

- **My Folder** is the private folder of the user who is currently logged on. It can be used to store metadata that is not available to other users. Metadata in this folder can be viewed only by the user who is currently logged on and by users who have unrestricted access.

- **Products** is the folder that contains the software that is installed with SAS Data Integration Studio and SAS IT Resource Management. Along with other objects, this folder contains the template tables for the adapters that are installed and the supplied formulas that can be used to compute new columns from existing columns of data. The contents of this folder cannot be modified. However, they can be viewed and copied to another folder.

- **Shared Data** is the folder that contains data that can be accessed by any user who is logged on. It contains the supplied SAS Enterprise Guide report definitions and the formulas that are installed with SAS IT Resource Management. This folder can also contain IT data marts that are intended to be accessed by multiple users.

- **System** is the folder that contains applications, channels, subscribers, services, and the dialog boxes of the types of objects that are installed and used by SAS Data Integration Studio and SAS IT Resource Management.
• **Users** is the folder that contains the private folders of users who are connected to the active metadata server.

**Inventory Tree**
The **Inventory** tree displays metadata for objects that are registered on the current metadata server, such as tables and libraries. Metadata in this tree can be stored in folders that group metadata by type, such as Table, Library, Job, Information Map, and so on.

**Transformations Tree**
The **Transformations** tree displays transformations that can be dragged and dropped onto the process flow diagrams of SAS Data Integration Studio jobs. SAS IT Resource Management provides the **ITRM Transformations** folder that contains the Aggregation and Information Map transformations. In addition, this folder contains the staging transformations for each of the adapters supported by SAS IT Resource Management.

The transformation's **Properties** dialog box enables you to view or update the metadata for a transformation in a SAS Data Integration Studio job. One way to display this dialog box is to open a job on the **Diagram** tab of the **Job Editor** window. Then, right-click a transformation on the **Diagram** tab, and click **Properties** in the pop-up menu. The Property dialog box for most transformations has one or more tabs that are unique to that transformation. The following table describes the purpose of the common tabs for a transformation. For more information about each tab, see the Help for that tab.

**Table 3.2** **Common Tabs in a Transformation Properties Dialog Box**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Enables you to enter general information that identifies and describes the transformation.</td>
</tr>
<tr>
<td>Mappings</td>
<td>Enables you to review and modify the mappings for the transformation.</td>
</tr>
<tr>
<td>Note:</td>
<td>This tab is not used by SAS IT Resource Management transformations.</td>
</tr>
<tr>
<td>Options</td>
<td>Enables you to review and modify options for the transformation.</td>
</tr>
<tr>
<td>Table Options</td>
<td>Enables you to review and modify table options for the transformation.</td>
</tr>
<tr>
<td>Code</td>
<td>Enables you to review and modify the code that is generated for the transformation.</td>
</tr>
<tr>
<td>Precode and Postcode</td>
<td>Enables you review and modify user-written code that is inserted at the beginning or end of the transformation.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Enables you to review and modify parameters for the transformation.</td>
</tr>
<tr>
<td>Notes</td>
<td>Enables you to review and modify notes for the transformation.</td>
</tr>
</tbody>
</table>
### Tab Description

| Extended Attributes | Enables you to review and modify extended attributes for the transformation. |

**Basic Properties Pane**

The Basic Properties pane displays the basic properties of an object that is selected in a tree view. The Basic Properties pane is an optional pane that can be displayed on the left side of the desktop. To display or hide this pane, select or deselect **View ➔ Basic Properties** from the menu bar.

**Checkouts Tree**

The Checkouts tree displays metadata that has been checked out for update, as well as any new metadata that has not been checked in. The metadata is displayed automatically when you are working under the change management function of SAS Data Integration Studio.

*Note:* This tree is not used by SAS IT Resource Management.

### The Job Editor

**Job Editor Window**

The Job Editor window enables you to create, maintain, and troubleshoot SAS IT Resource Management jobs. To display this window, right-click a job in the tree view and select **Open**. The following display shows a sample Job Editor window.
To open an existing job in the Job Editor window, navigate to the folder where it is located and double-click it. To create a new job, from the menu bar select New \( \Rightarrow \) Job. In order to maintain unique job names within the repository, the name of the new job is a concatenation of "New Job" and a five-digit number (for example, "New Job 28424").

**Note:** You can rename a job to a more meaningful name. For information about how to rename a job, see “Rename a Job” on page 305.

The job opens in the Job Editor window. In the Job Editor window, you can add, delete, and modify the transformations and tables of a job.

**Job Editor Tabs**

The following table describes the main tabs in the Job Editor window.

<table>
<thead>
<tr>
<th>Tab</th>
<th>How to Display the Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Diagram</strong></td>
<td>Always displayed.</td>
<td>Used to build and update the process flow for a job.</td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>Select Tools ( \Rightarrow ) Options from the desktop. On the General tab, select Show Code Tab.</td>
<td>Used to review or update code for a job.</td>
</tr>
</tbody>
</table>
How to Display the Tab

- **Log**
  - Select **Tools ➤ Options** from the desktop. On the General tab, select **Show Log Tab**.
  - Description: Used to review the log for a submitted job.

- **Output**
  - Select **Tools ➤ Options** from the desktop. On the General tab, select **Show Output Tab**.
  - Description: Used to review the output of a submitted job.

Use the Details pane to monitor and debug a job in the Job Editor window. To open this pane, select **View ➤ Details** from the desktop.

Use the Runtime Manager pane to display the run-time status of the current job, the last time the job was executed in the current session, and the SAS Application Server that was used to execute the job. This information is available as long as the job is active. To open this pane, select **View ➤ Runtime Manager** from the desktop.

Properties of Jobs and Tables

**Job Properties**

The job’s Properties dialog box enables you to view or update the metadata for a SAS Data Integration Studio job. One way to display this dialog box is to right-click a job in the IT Data Marts tree, Folders tree, or Inventory tree. Then, click **Properties** in the menu that is displayed. The following table describes the purpose of each tab in a job's Properties dialog box. For more information about each tab, see the Help for that tab.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td>Enables you to enter general information that identifies, describes, and locates the job.</td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>Enables you to review and modify the code that is generated for the job.</td>
</tr>
<tr>
<td><strong>Precode and Postcode</strong></td>
<td>Enables you to review and modify user-written code that is inserted at the beginning or end of the job.</td>
</tr>
<tr>
<td><strong>Status Handling</strong></td>
<td>Enables you to review and modify status handling conditions and actions for the job. (Some transformations have this tab as well.)</td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td>Enables you to review and modify parameters for the job.</td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td>Enables you to review and modify options for the job.</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>Enables you to review and modify notes for the job.</td>
</tr>
<tr>
<td><strong>Extended Attributes</strong></td>
<td>Enables you to review and modify extended attributes for the job.</td>
</tr>
</tbody>
</table>
### Table Properties

The table's Properties dialog box enables you to view or update the metadata for the table. One way to display this window is to right-click a table in the Folders tree or the Job Editor window and click Properties. The next table describes the purpose of each tab in a table's Properties dialog box. For more information about each tab, see the Help for that tab.

#### Table 3.5  Tabs in a Table Properties Dialog Box

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorization</td>
<td>Enables you to review and modify metadata access settings for the job.</td>
</tr>
<tr>
<td>General</td>
<td>Enables you to enter general information that identifies and describes the table.</td>
</tr>
<tr>
<td>Columns</td>
<td>Enables you to maintain column metadata.</td>
</tr>
<tr>
<td>Indexes</td>
<td>Enables you to review, add, and modify indexes on table columns.</td>
</tr>
<tr>
<td>Keys</td>
<td>Enables you to review, add, and modify key columns.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Enables you to review and modify parameters for the table.</td>
</tr>
<tr>
<td>Physical Storage</td>
<td>Enables you to specify the format and location of a table.</td>
</tr>
<tr>
<td>Options</td>
<td>Enables you to review and modify options for the table.</td>
</tr>
<tr>
<td>Notes</td>
<td>Enables you to review and modify notes for the table.</td>
</tr>
<tr>
<td>Extended Attributes</td>
<td>Enables you to review and modify extended attributes for the table.</td>
</tr>
<tr>
<td>Authorization</td>
<td>Enables you to review and modify metadata access settings for the table.</td>
</tr>
</tbody>
</table>
Working with Wizards

Wizards Supplied by SAS IT Resource Management

In addition to the wizards that are supplied by SAS Data Integration Studio, SAS IT Resource Management provides the following wizards:

The following wizards are invoked from the New menu:

- New IT Data Mart wizard

  The New IT Data Mart wizard enables you to create a new IT data mart. An IT data mart contains the metadata for the jobs, libraries, tables, information maps, and other elements that support the ETL processes of and reporting on IT performance data.

  To invoke the New IT Data Mart wizard, navigate to the IT Data Marts tree. Then select New ⇒ IT Resource Management ⇒ IT Data Mart.

  Note: You can also invoke the New IT Data Mart wizard from the first page of the Adapter Setup wizard by selecting the New IT data mart option.

  For more information about IT data marts, see “About the IT Data Mart” on page 53.

- New Formula wizard

  SAS IT Resource Management provides standard formulas that can be used to generate a computed column. To locate these formulas, navigate to the Shared Data folder in the Folders tree and select SAS IT Resource Management ⇒ IT Formulas. You can copy these formulas, modify them, or create new customized formulas by using the New Formula wizard.

  To invoke the New Formula wizard, navigate to the IT Data Marts tree. Then select New ⇒ IT Resource Management ⇒ Formula.

  For more information about formulas, see “About Formulas” on page 111.

- defining ETL jobs

  The Adapter Setup wizard helps you define the ETL jobs that read, stage, aggregate, map, and generate information maps and reports for the IT resource data that an adapter loads. This wizard also helps you define the report jobs that generate gallery reports.

  The Adapter Setup wizard produces data acquisition, staging, aggregation, information map, and report jobs. Configuration options of minimal, typical, and full are available to define the quantity of jobs generated by the Adapter Setup wizard and are good choices for most user's needs. You can also specify that only the staging job is generated. However, your site might have other requirements that limit or expand the number and type of jobs that should be generated. Therefore, you should examine the results of the Adapter Setup wizard. You might need to add or delete elements of the jobs, transformations, or tables in order to accommodate the needs of your site or organization.

  To invoke the Adapter Setup wizard from the SAS Data Integration Studio toolbar, select New ⇒ IT Resource Management ⇒ Adapter Setup.

  For more information about the Adapter Setup wizard, see “About the Adapter Setup Wizard” on page 209.
The following wizards are supplied by SAS IT Resource Management, but are not invoked directly from the New menu:

- **Aggregation wizards**
  
  Aggregation tables contain IT resource data that has been classified, summarized, or aged according to the specifications of an Aggregation transformation.

  To invoke the aggregation table wizards, open (or create) a job that contains an Aggregation transformation. Right-click the Aggregation transformation and select the **Add Aggregation Table** option. You can then choose one of the following options:

  - **Summarized Aggregation Table**, which enables you to directly specify the variables (and their associated properties) that are to be aggregated.
  
  - **Simple Aggregation Table**, which is not summarized. The new data is simply appended to the aggregation table.
  
  - **Aggregations through Template**, which creates aggregation tables by using the provided aggregation templates or user-defined templates.

  For more information about aggregating data, see “Working with Aggregation Transformations” on page 197.

- **Maintain Staged Tables wizard**
  
  The Maintain Staged Tables wizard enables adapter updates that are delivered by SAS to be applied to your IT data marts. It enables you to update the staged tables of an IT data mart, based on the revisions that have been made in the IT resource collection software and files.

  To invoke the Maintain Staged Tables wizard, navigate to the **IT Data Marts** tree. Then right-click the IT data mart whose tables are to be updated, and select the **Maintain staged table** option.

  For more information about IT data marts and maintaining their associated tables, see “About the IT Data Mart” on page 53.

- **Staged Table wizard**
  
  A staged table is a SAS IT Resource Management table that contains data that has been extracted from an input data store and rendered into a form that is suitable for further transformation. It can be created either by the Adapter Setup wizard or by the Staged Table wizard.

  To invoke the Staged Table wizard, open (or create) a job that contains a staging transformation. Right-click the staging transformation and select the **Add Staged Tables** option. Then select either of the following templates:

  - **From Supplied Template**
  
  - **From User Defined Template**

  For more information about staged tables, see “Working with Staging Transformations” on page 121.

---

**Wizards Supplied by SAS Data Integration Studio**

After you are connected to the server that you want to use, you can access the wizards that SAS Data Integration Studio provides.
These wizards can create the new objects that can help you work with your IT performance data. From the menu on the SAS IT Resource Management toolbar select New to open the wizards, dialog boxes, and windows that create the following objects:

- Folder
- Job
- Table
- Transformation
- External File
- Library
- Document
- Note
- Stored Process
- IT Resource Management
- Cube

*Note:* This option enables you to access the wizards that the SAS IT Resource Management enhancements to SAS Data Integration Studio provide.
SAS IT Resource Management Transformations

SAS IT Resource Management supplies many transformations that enable you to work with your IT data. To specify a transformation, you must first open (or create) a job. This action creates a process flow diagram on the Diagram tab of the Job Editor window. Transformations can be dragged and dropped onto the process flow diagram of the job, and their properties, data sources, and resulting tables can then be specified according to your requirements. The Adapter Setup wizard specifies the necessary transformations programmatically, or you can do so by working directly with the transformations.

In addition to the standard SAS Data Integration Studio transformations that are accessible from the Transformations tree, SAS IT Resource Management provides the following transformations:

<table>
<thead>
<tr>
<th>Type of Transformation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation</td>
<td>Specifies how a staged (or other) table is to be aggregated into a simple or summarized aggregation table.</td>
</tr>
<tr>
<td>Data Acquisition</td>
<td>Specifies how to extract a subset of VMware data from a database.</td>
</tr>
<tr>
<td>Gallery</td>
<td>Specifies the gallery reports that are to be generated from information maps or aggregation tables and how these reports are to be stored on the SAS Content Server.</td>
</tr>
<tr>
<td>Information Map</td>
<td>Creates information maps from aggregation tables.</td>
</tr>
<tr>
<td>Staging</td>
<td>Specifies how raw data is to be processed and loaded into staged tables for the supported adapters.</td>
</tr>
<tr>
<td>(one for each supported adapter)</td>
<td></td>
</tr>
<tr>
<td>User-Written Staging</td>
<td>Specifies how raw data is to be processed and loaded into staged tables for data that is not supported by IT Resource Management adapters.</td>
</tr>
</tbody>
</table>

To locate these transformations, select the Transformations tree and navigate to the ITRM Transformations folder. For information about the properties of transformations, see “Transformations Tree” on page 40.

Icons for SAS IT Resource Management Objects

The following table lists icons that are used by objects in SAS IT Resource Management.
<table>
<thead>
<tr>
<th>Object Name</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter transformation</td>
<td>![Adapter transformation icon]</td>
</tr>
<tr>
<td>Aggregation transformation</td>
<td>![Aggregation transformation icon]</td>
</tr>
<tr>
<td>Column (Character contents)</td>
<td>![Character content icon]</td>
</tr>
<tr>
<td>Column (Numeric contents)</td>
<td>![Numeric content icon]</td>
</tr>
<tr>
<td>Deployed Job</td>
<td>![Deployed Job icon]</td>
</tr>
<tr>
<td>External file</td>
<td>![External file icon]</td>
</tr>
<tr>
<td>Folder</td>
<td>![Folder icon]</td>
</tr>
<tr>
<td>IT Formula</td>
<td>![IT Formula icon]</td>
</tr>
<tr>
<td>Gallery transformation</td>
<td>![Gallery transformation icon]</td>
</tr>
<tr>
<td>Information Map</td>
<td>![Information Map icon]</td>
</tr>
<tr>
<td>IT Data Mart</td>
<td>![IT Data Mart icon]</td>
</tr>
<tr>
<td>Job</td>
<td>![Job icon]</td>
</tr>
<tr>
<td>Library</td>
<td>![Library icon]</td>
</tr>
<tr>
<td>IT Report Definition</td>
<td>![IT Report Definition icon]</td>
</tr>
<tr>
<td>IT Resource Management Desktop</td>
<td>![IT Resource Management Desktop icon]</td>
</tr>
<tr>
<td>Table</td>
<td>![Table icon]</td>
</tr>
<tr>
<td>IT Template</td>
<td>![IT Template icon]</td>
</tr>
</tbody>
</table>
Part 2

Accessing and Processing IT Data

Chapter 4
IT Data Mart .......................................................... 53

Chapter 5
Adapters ................................................................. 79

Chapter 6
Formulas ................................................................. 111

Chapter 7
Staging the Data ..................................................... 119

Chapter 8
Aggregating the Data ............................................... 147

Chapter 9
Adapter Setup Wizard ............................................. 209

Chapter 10
Information Maps .................................................... 239

Chapter 11
User-Written Staging Code ....................................... 265

Chapter 12
Jobs ................................................................. 295
Chapter 4
IT Data Mart

About the IT Data Mart

What Is an IT Data Mart?

An IT data mart is a key component of SAS IT Resource Management. It is the logical collection of the jobs, data, information maps, tables, and other elements that support the processing and analysis of IT data. IT data marts are set up, managed, and administered by the data administrator using the wizards and user interfaces that are available in SAS IT Resource Management. Multiple IT data marts can be created in order to help organize a site's data. For example, a site's data administrator might set up a separate data mart for each of the operating system types or business areas that exist within the corporate enterprise.
**Note:** Foundation is the only type of repository supported for IT data marts. The use of a Custom repository for separating metadata, or a Project repository for change management of IT data marts is not supported at this time. For more information about SAS Metadata Repositories see the *SAS Intelligence Platform: System Administration Guide*. However, IT Data Marts that are migrated from SAS IT Resource Management 3.11 that are contained in an ITMS repository are supported.

**How Is an IT Data Mart Created?**

An IT data mart is created by invoking the New IT Data Mart wizard. This wizard can be invoked in two ways:

- from the SAS IT Resource Management menu bar.
  
  From the SAS IT Resource Management menu bar, select `New ⇄ IT Resource Management ⇄ IT Data Mart` to open the New IT Data Mart wizard.

- from the Adapter Setup wizard.
  
  From the SAS IT Resource Management menu bar, select `New ⇄ IT Resource Management ⇄ Adapter Setup` to open the Adapter Setup wizard. On the first page of that wizard, you can click `New IT data mart` to open the New IT Data Mart wizard. (You can also select an existing IT data mart from this page.)

**About the IT Data Mart Wizard**

The New IT Data Mart wizard guides you through the steps to create an IT data mart. You are prompted to specify the name and description of the IT data mart, the default application server, and the default root path. You can also change the default location where the IT data mart is to be stored.

On completion, the New IT Data Mart wizard generates the main root folder for the IT data mart, the IT data mart itself, an Administrative subfolder, a Contents subfolder, and the administrative library, ADMIN.

**Note:** The name of the Admin library is programmatically generated by the concatenation of `Admin` and a random number, `nnnn`.

**Where Can the IT Data Mart Be Stored?**

When you create an IT data mart, you can specify a location where it will be stored. The `Location` field on the first page of the New Object wizard enables you to specify where your IT data mart is to be stored. By default, your IT data mart is stored in the SAS IT Resource Management/IT Data Marts subfolder of the Shared Data subfolder. However, you can change this location to any location to which you have Write privileges.

**CAUTION:**

*IT data marts should be stored only in Foundation repositories.* Storing an IT data mart in a repository other than Foundation causes processing errors.
How Can the IT Data Mart Be Accessed?

You can access an IT data mart from the subfolders that are listed on the IT Data Marts tree, the Folders tree, or the Inventory tree of SAS IT Resource Management. To work most effectively with your IT data mart, access it from the IT Data Marts tree.

How Is the IT Data Mart Populated?

IT data marts can be populated in two ways.

• The standard way to populate the IT data mart is through the Adapter Setup wizard. For information about the Adapter Setup wizard, see “Adapter Setup Wizard” on page 209.

• You can also populate an IT data mart with jobs, tables, libraries, and other objects by explicitly adding individual objects, by using the menu actions and menu bar actions.

What Are the Contents of an IT Data Mart?

IT data marts can contain the following objects:

• Admin library

The Admin library is stored in the Administrative folder of the IT data mart. You can store any content, including SAS formats, in this library. The Admin library also stores adapter resource lookup tables for the staging transformations of several adapters, such as the SNMP or IBM SMF adapters.

Note: If the IT data mart is created outside of the Adapter Setup wizard (that is, by invoking the IT Data Mart wizard directly from the New menu of SAS IT Resource Management), the Administrative folder with its ADMIN library, is the only subfolder that is created.

CAUTION: Do not delete this library. Deleting this library can cause processing errors.

• The Contents folder is a general-purpose folder that can be used for manually entered content. For example, you can use this folder to store jobs, tables, and so on.

  TIP Use this folder when you want to generate your own jobs and specify transformations in those jobs manually (that is, without invoking the Adapter Setup wizard).

• IT data mart object ( )

The IT data mart object enables you to perform certain tasks, which are available when you right-click the object.
In the **IT Data Marts** tree, the IT data mart object and its root folder object are the same; in the **Folders** tree, the IT data mart object, and its root folder object appear as two separate objects. Use the **IT Data Marts** tree for most IT Resource Management tasks that involve IT data marts.

**CAUTION:**

For best results, use the **IT Data Marts** tree for most IT Resource Management tasks that involve IT data marts. Working in the **IT Data Marts** tree ensures that the metadata is updated properly.

- **adapter-based subfolders**

  A separate subfolder is generated each time you successfully execute the Adapter Setup wizard. The name of the subfolder is based on the adapter that you selected during the Adapter Setup wizard. Each adapter-based subfolder contains a **Domain Categories** subfolder and a **Staging** subfolder.

- **Separate subfolders in the Domain Categories subfolders**

  Separate subfolders in the **Domain Categories** subfolders contain the objects such as jobs and tables for each domain category that you specified. The name that is assigned to this subfolder is the name of the domain category that you selected. The objects that are added for a domain category can include the output aggregation tables, libraries, information maps, and the aggregation, information map, and reporting jobs that are associated with that domain category.
Note: The physical tables are generated when their corresponding jobs are run. These tables do not have to be stored in a fixed location with respect to the root location of the IT data mart. You can store these tables in any location to which you have Write privileges.

Note: The metadata for information maps is not generated until the information map job is run. The metadata for the information maps does not have to be stored in a fixed location with respect to the root location of the IT data mart. You can store this metadata in any location to which you have Write privileges.

- A Staging subfolder is generated for each instance of the adapter that you selected. This subfolder contains the staging job, library, and staged tables for that adapter. (For some adapters, a spin library is also generated.)

The name that is assigned to the adapter-based subfolder is generated based on the name of the selected adapter.
The following figure displays the **IT Data Mart** tree view of IT Data Mart 49400.

**Figure 4.1 Example of an IT Data Mart**

![Diagram of IT Data Mart tree view](image)

1. Admin library that was generated for IT Data Mart 49400
2. Folder that is generated for the first instance of running the Adapter Setup wizard for the DT Perf Sentry adapter
3. Folder that contains objects related to the Server Disk domain category for DT Perf Sentry
Tables and information maps for the aggregations that are connected with the Server Disk domain

Library that contains all aggregation tables that are connected with the Server Disk domain

Job that generates the aggregation tables that are connected with the Server Disk domain

Job that generates reports that are connected with the Server Disk domain

Job that generates information maps that are connected with the Server Disk domain

Folder that contains the staging library, tables, and job that are connected with DT Perf Sentry

Staging job for DT Perf Sentry

Library that contains all staged tables that are populated by the DT Perf Sentry Staging job

Staged table that is populated by the DT Perf Sentry Staging job

In the preceding figure, the IT data mart called IT Data Mart 49400 also contains metadata for two instances if the DT Perf Sentry adapter:
- DT Perf Sentry 1, the first instance of using the Adapter Setup wizard for DT Perf Sentry
- DT Perf Sentry 2, the second instance of using the Adapter Setup wizard for DT Perf Sentry

Folders, libraries, jobs, and staging information are generated for these, and any other adapters, according to the Figure 4.1 on page 58. However, the IT data mart is populated with the information maps when the information map job runs.

Note: Some adapters require a SPIN library that manages transactions or events that are not yet complete. If required, SAS IT Resource Management creates and registers the library.

Working with IT Data Marts

Introduction to Working with IT Data Marts

You can create, delete, erase, modify, purge, and rename an IT data mart. For best results, perform these functions from the IT Data Marts view.

Copy and Paste an IT Data Mart

To copy an IT data mart and then paste it into another location, perform the following steps:

1. Determine the folder into which you want to paste the IT data mart. If you want to create a new folder for the IT data mart, from the Folders tree, click New. From the drop-down list, select Folder. The New Folder wizard appears. You can retain the
default name of the new folder, or you can enter a new name. You can also retain the
default location, or you can click Browse to navigate to another location. Select the
location that you want to use. Click OK to create the new folder.

**CAUTION:**
Copy IT data marts only into Foundation repositories. Copying an IT data
mart into a repository that is not Foundation causes processing errors.

2. Copy the IT data mart.

To do so, from either the Folders tree or the IT Data Marts tree, right-click the IT
data mart that you want to copy and select Copy.
3. Paste the IT data mart into its new location.
To do so, in the Folders tree, right-click the folder into which you want to paste the IT data mart. Then select one of the following actions:

- Select **Paste** to paste the IT data mart into the selected folder. (The Paste action pastes only the IT data mart itself and a limited number of associated objects, such as the Administrative folder.)

  Then click **Finish** to create the new IT data mart.

- If you want to create a new IT data mart that contains other (or all) contents of the IT data mart that you copied, perform the following steps:

  1. In the Folders view, navigate to the folder where you want to copy the IT data mart. Right-click the folder and select **Paste Special**.
Display 4.3  Paste Special Action of an IT Data Mart
2. The Paste Special wizard appears. The first page of this wizard prompts you to select the libraries, tables, and other objects that you want to copy.

Display 4.4  First Page of the Paste Special Wizard

3. The next page of the wizard describes the changes you might need to make to servers and target directory paths. However, it is more convenient to make such changes by invoking the %RMDMPATH after this wizard has completed.
Click **Next** two times to skip changing the servers and target directory paths in this wizard.

4. The next page of the wizard shows a summary of your specifications. If you need to make changes, click **Back**. Otherwise, click **Next** to complete the wizard.
When the Copy Complete page appears, click **Finish** to create the new IT data mart.

When the Paste Special wizard is finished, the IT Data Marts view shows the original copy and the new copy of the IT data mart that you copied.

**Tip** You might have to select **View ⇒ Refresh** to view the IT data mart that you just copied.
Display 4.7  Copied SampleDataMart

Many objects might be named “Copy of [previous]” to avoid name duplications. You can rename the IT data mart at this time and you can also rename libraries, table, and other objects.

7. Run %RMDMPATH to change the paths of the IT data mart and its contents so that they reflect their new locations.

Create an IT Data Mart

To create an IT data mart, perform the following steps:

1. From the SAS IT Resource Management menu bar, select New ➜ IT Resource Management. From the list that is displayed, select IT Data Mart. The New IT Data Mart wizard appears.

2. On the General information page of the wizard, specify the name, description, and location of the IT data mart.
   - The name of the new data mart is required. The Name field can contain a maximum of 60 characters. The wizard does not permit you to enter invalid
characters. The name must be unique within its parent folder. For best results, the name should be unique within the metadata server.

- A value is optional in the **Description** field. The **Description** field can contain a maximum of 200 characters.

- The **Location** field contains the default location for the IT data mart. A value is required in this field. This location is typically in the *Shared Data\SAS IT Resource Management* folder of the repository where you are logged on. You can modify this field to specify any location to which you have Write privileges. The wizard does not permit you to enter invalid characters.

  **Note:** Make sure that the folder where the IT data mart is stored is not the root folder (that is, in the `<Users/<userID>` folder). If you want to store the IT data mart in the `/Users/` folder, make sure that you specify the folder location as `/Users/<userID>/MyFolders`.

**CAUTION:**

Create IT data marts only in **Foundation** repositories. Creating an IT data mart in a repository other than **Foundation** causes processing errors.

3. On the Application server information page, specify the default application server.

   Application servers store and execute SAS code. The default application server that is specified with this wizard accesses metadata, DBMS tables, and external files on remote hosts so that it can build and support an IT data mart. A value is required in this field.

   Select the default application server from the drop-down list of currently defined SAS Application servers. Then click **Test Connection** to make sure that you are connected to the server that you specified. If you are not connected at this time, you are prompted to enter your user ID and password in order to access the server.

   **Note:** Application servers are defined when the SAS IT Resource Management software is installed and configured. Use SAS Management Console to modify this list of available servers.

4. On the Root path information page, specify the path that will be used for the creation of the physical libraries. The path that you specify should be a fully qualified path; relative paths are not supported. A value is required in this field. You can enter the path in the field. Alternatively, you can click **Browse** and select a root path from the Select a Directory dialog box that displays the directory structure on your file system. IT data marts with invalid root path will not be created and an error message that explains the problem will be displayed. This physical path is not validated. Make sure that each IT data mart uses a different path. The value for this field cannot contain the single quotation character (').

   **Browse** is disabled when the selected application server is running on a machine that uses the z/OS operating system. When entering a z/OS path manually, you can use either a prefix for a traditional z/OS filesystem path (*MY.DATAMART*) or a root directory in the UFS hierarchical file system (*/u/mynam/datamart*).

   **Note:** The documentation for SAS on z/OS has traditionally used the terms UNIX System Services (USS) and hierarchical file system (HFS) to refer to the UNIX file system on z/OS. The SAS 9.3 documentation uses the terms UNIX file system and UFS to refer to this file system. In addition to the original HFS implementation, the z/OS operating system also provides another UNIX file system known as the z/OS file system (zFS). zFS, which provides certain performance and manageability benefits, is functionally equivalent to HFS from the perspective of a SAS user.
5. On the Summary page, the wizard displays the specifications that will be used to create the new IT data mart. If they are satisfactory, click Finish to create the new IT data mart.

**Delete an IT Data Mart**

Deleting an IT data mart removes all the metadata that is associated with the IT data mart. It does not remove the physical tables. To delete an IT data mart and all its contents, perform the following steps:

1. On the IT Data Marts tree of SAS IT Resource Management, right-click the IT data mart that you want to delete. (Make sure that the jobs that are located in that IT data mart are not open in a Diagram tab of the Job Editor window.)

   *Note:* You can also access the Delete function from the Folders tree of SAS IT Resource Management. However, performing tasks on the IT data mart from any tree other than the IT Data Marts tree is not recommended because the metadata that is associated with the IT data mart might not be properly updated.

2. Click Delete. A message box appears that asks you to confirm that you want to delete the objects from the selected IT data marts and all their contents.

3. To continue with the deletion, click Yes. To cancel the deletion, click No.

**CAUTION:**

Do not delete an IT data mart from the Folders tree. If you want to delete an IT data mart, always do so from the IT Data Marts tree.

**Erase an IT Data Mart**

Erasing an IT data mart deletes all the SAS libraries and their contents from the metadata. It also deletes all empty directories at the root level of the IT data mart. (The Erase action does not delete any directories that have contents.) It also deletes all the metadata that is in the IT data mart. To erase an IT data mart and all its contents, perform the following steps:

1. On the IT Data Marts tree of SAS IT Resource Management, right-click the IT data mart that you want to delete. (Make sure that the jobs that are located in that IT data mart are not open in a Diagram tab of the Job Editor window.)

   *Note:* You can also access the Delete function from the Folders tree of SAS IT Resource Management. However, performing tasks on the IT data mart from any tree other than the IT Data Marts tree is not recommended because the metadata that is associated with the IT data mart might not be properly updated.

2. Click Erase. A message box appears that asks you to confirm that you want to erase the objects from the selected IT data marts and all their contents.

3. To continue with the deletion, click Yes. To cancel the erase action, click No.

**Modify an IT Data Mart**

You can modify some of the properties of an IT data mart.

To do so, perform the following steps:
1. On the IT Data Marts tree of SAS IT Resource Management, right-click the IT data mart that you want to modify. Select Properties. (Make sure that the jobs that are located in that IT data mart are not open in a Diagram tab of the Job Editor window.)

2. • Select the General tab to view and modify the Name, Description, and Location fields.
   Note: If you rename an IT data mart to the same name as an existing IT data mart within the same application server, the following message is displayed: “IT Data Mart folder with this name already exists in the selected folder location. Change the name or select a different folder location.”

   CAUTION: IT data marts should be located only in Foundation repositories. Selecting a repository that is not Foundation causes processing errors.
   • Select the Extended Attributes tab to view and modify the fields on this tab.
     Use the Add and Delete buttons to add and delete fields. In general, you should not change or delete any supplied fields on this tab.
   • Select the Advanced tab to view metadata for the IT data mart. In general, modifying these fields can cause processing errors. However, you can modify the Name and Description fields.

3. Click OK to save your changes.
   Note: If you change anything about a job, you should redeploy all the jobs that are contained in the IT data mart. These changes can include adding or deleting tables or columns, changing the locations of tables, and changing a parameter on a transformation.

Purge the Tables of an IT Data Mart

Purging an IT data mart removes the contents of the tables in that IT data mart. It does not remove the metadata or the physical tables. To purge the tables of an IT data mart, perform the following steps:

1. On the IT Data Marts tree of SAS IT Resource Management, right-click the IT data mart whose table you want to purge.

2. From the drop-down menu that displays, click Purge.

3. Review the list of tables that are displayed in the confirmation dialog box. Click Yes to delete the tables. Otherwise, click No.

Rename an IT Data Mart

Note: If the renaming of the IT data mart includes moving it to another folder, perform the Move to Folder task in the Folders view. Then, perform the renaming task in the IT Data Marts view.

To rename an IT data mart, perform the following steps:

1. On the IT Data Marts tree of SAS IT Resource Management, right-click the IT data mart that you want to rename. (Make sure that the jobs that are located in that IT data mart are not open in the Diagram tab of the Job Editor window.)
2. From the drop-down menu, click **Rename**. The name of the IT data mart is highlighted.

3. Enter the new name of IT data mart in the highlighted area.

   **Note:** If you rename an IT data mart to the same name as an existing IT data mart within the same application server, the following message is displayed: “IT Data Mart folder with this name already exists in the selected folder location. Change the name or select a different folder location.”

Alternatively, you can rename the IT data mart by right-clicking the IT data mart and selecting **Properties**. Select the **General** tab. Enter the new name of the IT data mart in the **Name** field. If you rename an IT data mart to the same name as an existing IT data mart, a message is displayed that warns that the new name is already in use for another IT data mart.

   **Note:** In any job, if you have explicitly specified the path to an IT data mart, and you subsequently rename that IT data mart, then you should change the name of the IT data mart in that explicitly specified path. In addition, if you change any other folder name that is used in an explicit path reference, you should ensure that the explicitly specified path uses the changed folder name.

   **CAUTION:**

   Redeploy the jobs that are contained in the IT data mart. Redeploying jobs is necessary because renaming an IT data mart changes the metadata path of anything that is associated with that IT data mart.

### Importing, Exporting, and Promoting Metadata

#### About Importing, Exporting, and Promoting Metadata

SAS IT Resource Management metadata objects are managed as all other SAS metadata objects are managed. The SAS Intelligence Platform provides several tools to assist you in copying, promoting, importing, and exporting your metadata. For information about how metadata can be managed, see the “Using the Promotion Tools” chapter in the SAS Intelligence Platform: Data Administration Guide.

   **Note:** SAS IT Resource Management does not support the exporting or importing IT data marts that contain duplicate named items, even if those items are in different folders. If you want to export (and then import) IT data marts that contain duplicate items, you should first export (and then import) the IT data mart without including its dependent objects. After that, as subsequent steps, you can export (and then import) each separate first-level subfolder including its dependent objects.

#### About Promoting an IT Data Mart

The IT data mart object is unique to SAS IT Resource Management and enables you to perform actions on the whole IT data mart. One of these actions is the ability to promote the IT data mart by means of the import and export tools. These tools can be used to promote IT data marts that were created in SAS IT Resource Management 3.2 and later to a new IT Resource Management environment. They enable you to move the definition of an IT data mart from one metadata server to another. For example, you might want to move (or promote) an IT data mart for one of the following reasons:
• to move an IT data mart from a test system to a production system
• to move an IT data mart to a new server when the original host is being replaced by new or different hardware
  
  *Note:* Both servers must be SAS 9.3 servers.

• to share an IT data mart within or across an organization
• to share user-written or customized adapters across IT data marts or IT Resource Management systems

You can perform the exporting and importing of an IT data mart in two ways:

• interactively, using the Export SAS Package and Import SAS Package wizards

• in batch mode from an operating system command line or from a batch script. The tools that run in batch mode provide the same capabilities as the Export SAS Package and Import SAS Package wizards, with the following exceptions:

  • The wizards provide the option of either including or excluding associated physical content such as table data and source code files. When you use the batch tools, the promotion automatically includes all associated content except physical files for tables and external files. (The batch tools do not provide the option of promoting physical files for tables and external files.)

  • In the export wizard, you can display a list of the objects on which an object depends and then individually specify which of these objects to export. In the batch export tool, you can select a global option to include all dependent objects.

  *Note:* For information about using the batch export and import tools, see the topic called “About the Batch Export and Import Tools” ([http://support.sas.com/documentation/cdl/en/bisag/63132/HTML/default/viewer.htm#n13lro0e98gxul1rc3k9v9p9x7hl0.htm](http://support.sas.com/documentation/cdl/en/bisag/63132/HTML/default/viewer.htm#n13lro0e98gxul1rc3k9v9p9x7hl0.htm)). This topic can be found in the *SAS Intelligence Platform: System Administration Guide*.

To determine which view of the SAS IT Resource Management client to use to perform the export and import functions, follow these guidelines:

• If you are exporting and importing an IT data mart, perform both of those functions from the IT Data Mart view of the SAS IT Resource Management client.

• If you are exporting and importing any of the subfolders or contents of an IT data mart, perform both of those functions from the IT Data Mart view of the SAS IT Resource Management client.

• If you are exporting and importing any other content, that is, content that is outside of an IT data mart, perform both of those functions from the Folders view of the SAS IT Resource Management client.

### How to Export an IT Data Mart Using the Export SAS Package Wizard

To export an IT data mart using the SAS Export Package wizard, perform the following steps:

1. In the **IT Data Marts** tree, navigate to the IT data mart that you want to move.
2. Right-click the IT data mart and select **Export SAS Package**.

   The first page of the Export SAS Package Wizard appears.
3. In the **Specify a package to contain the collection of objects that you are exporting** field, you can accept the default location. The package is called **Package\nn.spk**, where *nn* is a number that is incremented by the value “1” each time the wizard is invoked.

   Alternatively, click **Browse** to navigate to another location. Select the location that you want to use and click **OK**.

   In addition, if you want to include all the contents of the IT data mart, make sure that **Include dependent objects when retrieving initial collection of objects** is checked.

4. On the **Select Objects to Export** page, all the contents of the selected IT data mart are selected. You can deselect any items that you do not want to export.

5. The **Summary** page displays the objects that will be included in the SAS package. When you are satisfied with your selections, click **Next** to export the IT data mart and its selected objects.

   Click **View Log** to see the log file that was created during the export process.

6. Click **Finish** to return to the **IT Data Marts** tree.

---

**How to Import an IT Data Mart Using the Import SAS Package Wizard**

**CAUTION:**

Import into the IT Data Mart view only those objects that were exported from the IT Data Mart view.

If the exported IT data mart contains any staging jobs whose rawdata input is a database, the Import wizard might require you to select a library to which the exported library can
map. If the library that points to the input database is located within the IT data mart that is being promoted, then you will not be required to specify a new library definition.

In addition, if the exported IT data mart contains any staging jobs whose rawdata input is a database, the Import from SAS Package wizard will require you to select a database server definition. This database server is associated with the library that is specified on the staging job as rawdata. If you want to work with a database server definition that does not exist, you must create one. For information about how to register a database server, see the “Connecting to Common Data Sources” topic in the SAS Intelligence Platform: Data Administration Guide.

**T I P** If you need to specify either a library or a database server, do so before you invoke the Import from SAS Package wizard.

For best results, make sure that the name of the IT data mart that you are importing is unique within the metadata server. If the metadata server already contains an IT data mart with the same name as the one being imported, the name of the IT data mart is automatically changed to “Copy of <original-name>” or, if that name is already in use, “Copy n of <original-name>”.

**Note:** You might be importing the IT data mart to a machine that is running a different version of SAS IT Resource Management from the one where the source data mart resides. Similarly, you might be importing the IT data mart to a different machine from the one where the source IT data mart resides. In either case, any deployed jobs within the imported data mart on the target system should be deleted and then deployed again. You should not redeploy them.

To import an IT data mart using the SAS Import Package wizard, perform the following steps:

1. Right-click in the white space of the **IT Data Marts** tree, and select **Import SAS Package**. The first page of the Import from SAS Package Wizard appears.

**Display 4.9  First Page of the Import SAS Package Wizard**
Note: If you have selected an IT data mart, the Import SAS Package selection is not available. The Import SAS Package selection is available only if an IT data mart has not been selected.

2. On this page, you can accept the default location, which is the location of the most recent exported SAS package. Alternatively, click Browse to navigate to another SAS package. Select the SAS package that you want to use and click OK.

CAUTION: Import IT data marts only into a Foundation repository. Importing an IT data mart into a repository that is not Foundation causes processing errors.

You can also choose the following options:

- include the access controls. These access controls govern which users or user groups can access the imported IT data mart.
- import all objects in the selected SAS package. This option causes objects that exist in the destination IT data mart to be overwritten.
- import only new objects in the selected SAS package. This option imports only those objects that do not exist in the destination IT data mart.

3. On the second page of the wizard, you can select the objects that you want to import. All items in the SAS package are selected by default. You can deselect those items that you do not want to import.

Display 4.10 Select the Objects to Import

4. The next page of the Import from SAS Package Wizard displays a note that explains that you might need to create metadata definitions for some of the objects that you want to import. For example, if this package contains a table but does not contain a library for that table, then a library for that table must already exist in metadata before importing the table metadata. (If the table and the library containing the table are both in the package, as they normally would be, you do not need to do anything.)
If you need to do so, you can create a new library definition with the New Library wizard.

To access the New Library wizard from the SAS IT Resource Management client menu bar, select **File ⇒ New ⇒ Library**. Respond to the prompts of the wizard as needed. In addition, some adapters (such as MS SCOM, SNMP, or VMware) have a raw data source that is a database. If an IT data mart contains that type of adapter, then a database server definition must be created that points to that database. For information about how to create a database server definition, see the “Overview of Common Data Sources” chapter in *SAS Intelligence Platform: Data Administration Guide* at [http://support.sas.com/documentation/onlinedoc/intellplatform/index.html](http://support.sas.com/documentation/onlinedoc/intellplatform/index.html). In the topic that discusses your database, you can find the section called “Register the Database Server.”

5. The next page of the wizard prompts you to specify the target application server to which you are importing the IT data mart.

6. The Directory Paths page shows the target locations for the folders of the IT data mart that is being imported.

**Display 4.11 Select Target Directory Paths for IT Data Mart Objects**

You can accept the default target locations, or you can click the ellipsis (...) to open the Browse dialog box. When you have selected the new target location, click **OK**.

7. The Summary page displays the choices that you specified. Click **Next** to import the IT data mart and the objects that you specified.

8. When the IT data mart has been imported, the Import Complete page is displayed. Click **View Log** to see the log file that was created during the import process.

9. Click **Finish** to return to the **IT Data Marts** tree.

10. Use your file system management tools to copy the physical files that are associated with the IT data mart from the source to a location on the target server that is to be referenced from the IT data mart. For more information, see *SAS IT Resource Management: Migration Documentation*. 
Handling Out of Memory Problems in an Export Operation

If you try to export a large IT data mart, your client machine might run out of memory. If this happens, you can export the IT data mart in two or more parts.

To import all the exported packages, you must invoke the Import SAS Package wizard multiple times. However, you must avoid importing duplicate objects because that results in a corrupted IT data mart and orphaned objects. The first page of the Import SAS Package wizard provides options that enable you to prevent this problem. Perform the following steps:

1. For the first exported package, select the option to Import All objects.
2. For all the other exported packages, select New Objects Only as shown in the following display.

Display 4.12  Import New Objects Only

Correcting Formulas for Computed Columns after Importing an IT Data Mart

If the staged or aggregated tables of the IT data mart that you imported contain computed columns that use formulas, you need to re-establish those formulas. The expression syntax will be correct, but if you want future changes to the formula to be reflected in each column that uses it, the link to the formula must be re-established. To do so, perform the following steps for each table that contains the computed column:
1. Open the job that contains the table in the **Diagram** tab of the Job Editor window.

2. Right-click the table that contains the computed column to open the Properties dialog box.

3. Select the **Columns** tab to open a grid that contains the list of columns and any expressions that are associated with them.

4. Double-click the computed column to display an ellipsis (...). Click the ellipsis to open the Expression Builder window.

5. The **IT Formulas** tab contains a list of supplied formulas and a list of user-defined formulas. Select the formula that applies to the computed column that you selected and click **Insert**. Then click **OK** to close the Expression Builder window and return to the **Columns** tab of the Properties dialog box.

*Note:* When all computed columns in the table are corrected, click **OK** to return to the job in the **Diagram** tab of the Job Editor window. When all the tables generated in the job have been corrected, save the job.
Chapter 5
Adapters

About Adapters

What are Adapters?
Adapters consist of specialized software that enables you to process data about IT resources from many diverse data sources. Adapters convert raw data from a given source into a set of organized IT resource information. This organization includes staged tables, aggregated tables, analysis- and report-ready data, and reports that facilitate aggregation and reporting on your IT resources.

Raw performance data is generated by the logging mechanisms that are inherent to IT resources. It can also be created by the Enterprise Systems Management tools that are used to manage the IT infrastructure. SAS IT Resource Management accepts data from many different vendors. The only requirement is that the data must include a timestamp so that it can be categorized and aggregated appropriately for subsequent analysis.

Raw data about an IT resource is represented using measures and formats that are specific to the software that collected it. In order for the data to be processed into meaningful statistics about an enterprise's IT resources, the raw data must be read, interpreted, and possibly converted into a more standard form. The data can then be
loaded into staged tables in preparation for subsequent aggregation and reporting. For each type of IT performance data that is supported, SAS IT Resource Management supplies an adapter that consists of the transformations, template tables, and code that are necessary to stage, aggregate, and report on that IT performance data.

For most adapters, by means of the Adapter Setup wizard, SAS IT Resource Management also supplies Aggregation, Information Map, and Gallery transformations. When executed, these transformations create the aggregation tables, information maps, and reports that enable you to convert raw data from various sources into meaningful intelligence about your IT resources. If these transformations are not created by the Adapter Setup wizard, then they can be created manually. To do so, see “Preparing to Create an Aggregation Table” on page 160 and “Overview of Specifying an Information Map Transformation” on page 244. For more information about using Gallery transformations and reporting jobs, see the SAS IT Resource Management: Reporting Guide.

Adapters stage the data by means of transformations that are executed by the SAS Data Integration Studio jobs. For information about how to work with SAS Data Integration Studio, see the documentation that is available for this product at http://support.sas.com/documentation/onlinedoc/etls/index.html.

**Supported Adapters**

The name of an adapter represents the data source from which SAS IT Resource Management gathers raw data.

*Note:* All SAS IT Resource Management adapters are supported on all SAS IT Resource Management operating environments unless there is a technical limitation that is associated with the raw data (log file) sources. For example, if the raw data resides on a device that is not compatible with the architecture of the host system on which the SAS IT Resource Management server is installed, then that raw data file might not be usable as input unless further processing is performed.

<table>
<thead>
<tr>
<th>Adapter Name</th>
<th>Description</th>
<th>Latest Verified Version of the Data Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG TMON2CIC</td>
<td>ASG TMON for CICS TS for z/OS (formerly from Landmark) monitors the CICS Transaction Server (TS) and provides resource consumption measurements by tracing each transaction's performance by CICS event and related unit of work. Note: CICS data can be produced by either ASG TMONCICS or as a subtype of SMF.</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>Adapter Name</td>
<td>Description</td>
<td>Latest Verified Version of the Data Source</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>ASG TMONDB2</td>
<td>ASG TMON for DB2 (formerly from Landmark) works with the SQL Analyzer to manage DB2 applications and critical DB2 resources by providing a single view of DB2 data-sharing group performance. ASG TMON for DB2 tracks DB2 buffer pools, lock contention and serialized resource usage, transaction statistics from ASG TMON for CICS to ASG TMON for DB2, and dynamic and static SQL calls. ASG TMON for DB2 provides a view for all performance statistics by plan, package, and statement, including CPU time, I/O analysis, lock activity, and buffer pool utilization by SQL statement.</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>BMC Mainview IMS</td>
<td>BMC Mainview for IMS (formerly IMF) supplies transaction information such as CPU usage, number of I/Os, and response time. When you collect BMC Mainview for IMS data instead of IBM IMS data, BMC recommends that you collect a duration of one hour of consistently high activity, starting at the beginning and ending at the end of an RMF interval.</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>BMC Perf Mgr</td>
<td>BMC Performance Manager for Servers (formerly BMC PATROL) collects UNIX and Windows enterprise system management data.</td>
<td>v3.7.30</td>
</tr>
<tr>
<td>CA TMS</td>
<td>The Computer Associates CA 1 Tape Management product (formerly TMS) controls and protects tape data sets and volumes in z/OS environments.</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>Comma Separated Values (CSV)</td>
<td>The Comma Separated Values adapter is a SAS product that reads any character delimited file.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Adapter Name</td>
<td>Description</td>
<td>Latest Verified Version of the Data Source</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>DT Perf Sentry</td>
<td>Demand Technology Performance Sentry (formerly NTSMF) collects data from Windows systems and for Windows server applications such as Exchange, SQL Server, and IIS. SAS IT Resource Management also supports a separate Demand Technology Performance Sentry adapter that is z/OS based. The Demand Technology Performance Sentry with MXG adapter that is z/OS based is for raw data sources that are supported through MXG.</td>
<td>v3.1.4</td>
</tr>
<tr>
<td>DT Perf Sentry with MXG</td>
<td>Demand Technology Performance Sentry (formerly NTSMF) with MXG collects data from Windows systems and for Windows server applications such as Exchange, SQL Server, and IIS. (SAS IT Resource Management also supports a separate Demand Tech Perf Sentry adapter that is not MXG based.)</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>HP Perf Agent</td>
<td>HP Performance Agent (formerly OpenView Performance Agent) captures enterprise systems management measurement data for IT resources from Windows systems and many UNIX variants such as HP-UX, Sun OS/Solaris, IBM AIX, Tru 64 UNIX, and Linux.</td>
<td>v5.0</td>
</tr>
<tr>
<td>HP Reporter</td>
<td>HP Reporter software (formerly OpenView Reporter) captures HP Performance Agent measurement data that is stored in a relational database via SAS/ACCESS to Oracle or ODBC.</td>
<td>v3.70</td>
</tr>
<tr>
<td>IBM AS400</td>
<td>IBM OS/400 Collection Services</td>
<td>MXG 30.30*</td>
</tr>
</tbody>
</table>

**Note:** The staging code that is required for the IBM AS400 data source is not automated by a SAS IT Resource Management adapter. Instead, SAS IT Resource Management supplies a User-written Staging transformation and templates that contain table and column metadata for this adapter for use with user-written staging code.
<table>
<thead>
<tr>
<th>Adapter Name</th>
<th>Description</th>
<th>Latest Verified Version of the Data Source</th>
</tr>
</thead>
</table>
| IBM DCOLLECT | IBM DFSMS Data Collection Facility obtains the following Mainframe Storage System data:  
  • active data sets  
  • VSAM data set information  
  • volumes  
  • inactive data  
  • migrated data sets  
  • backed-up data sets  
  • capacity-planning data such as the following:  
    - DASD capacity planning: IBM DCOLLECT provides information and statistics for volumes that are managed by DFSMSHsm (ML0 and ML1).  
    - tape capacity planning: IBM DCOLLECT provides statistics for tapes that are managed by DFSMSHsm.  
  • SMS configuration information | MXG 30.30* |
| IBM EREP     | IBM Environmental Record Editing and Printing Program processes the error records from the MVS, VM, and VSE operating systems to produce formatted reports. These IBM EREP reports can show the status of the entire installation, an I/O subsystem, or an individual device, depending on which report you request. IBM EREP reports can vary in format, depending on the following report types:  
  • System summary reports show error data in summary form.  
  • Trend reports show error data by daily totals.  
  • Event history reports show error data in a time sequence by occurrence. | MXG 30.30* |
<table>
<thead>
<tr>
<th>Adapter Name</th>
<th>Description</th>
<th>Latest Verified Version of the Data Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM IMS</td>
<td>IBM Information Management System (IMS) is the transaction and hierarchical database management system from IBM. <strong>Note:</strong> The staging code that is required for the IBM IMS data source is not automated by a SAS IT Resource Management adapter. Instead, SAS IT Resource Management supplies a User-written Staging transformation and templates that contain table and column metadata for this adapter for use with user-written staging code.</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>IBM SMF</td>
<td>IBM System Management Facility collects and records system and job-related information that is used for the following purposes: • billing users • reporting reliability • analyzing the configuration • scheduling jobs • summarizing direct access to volume activity • evaluating data set activity • profiling system resource use • maintaining system security <strong>Note:</strong> RMF is a subtype of SMF records. IBM RMF is the IBM strategic product for z/OS performance measurement and management. IBM RMF is the base product that collects performance data for z/OS and Sysplex environments to monitor system performance. Because IBM RMF data is a subtype of IBM SMF data, the IBM SMF adapter can be used with IBM RMF data without requiring additional customizations.</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>IBM TPF</td>
<td>The IBM Transaction Processing Facility operating system works with application programs to process transactions in a real-time environment. The IBM TPF system is designed for businesses and organizations that have large networks and high volumes of online transactions.</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>Adapter Name</td>
<td>Description</td>
<td>Latest Verified Version of the Data Source</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>IBM VMMON</td>
<td>IBM VM Monitor Collection product collects performance information that is associated with VM, including measurements for user activity, processor storage, I/O, and applications.</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>MS SCOM</td>
<td>Microsoft System Center Operations Manager monitors Windows systems, Microsoft software, and applications to provide a view of the health of an organization’s Windows environment.</td>
<td>v2007</td>
</tr>
<tr>
<td>RRDtool</td>
<td>RRDtool is the OpenSource industry standard, high performance data logging and graphing system for time series data. It compiles on Microsoft Windows and many Linux and UNIX platforms.</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>
| SAP ERP      | Enterprise Resource Planning (ERP) Software from SAP (formerly SAP R/3), via the SAS IT Management Adapter for SAP, collects SAP ERP and SAP Business Warehouse (BW) workload performance measurements.  
  - For SAP ERP, measurements are read from the SAP Statistic File (stat file).  
  - For SAP BW, the measurements that communicate the amount of computer resources that were consumed to populate and query BW cubes are read. These measurements are then used to supplement BW server performance statistics. | v7.0 |
| SAR          | System Activity Reporter is a logging mechanism that is native to most UNIX and Linux variants. SAR captures the contents of cumulative system activity counters. | Dependent on the operating system.  
For information about specific operation system release versions, see “Accessing Raw Data for SAR” in Appendix 2, “Data Sources Supported by SAS IT Resource Management Adapters” in SAS IT Resource Management: Administrator’s Guide. |
<table>
<thead>
<tr>
<th>Adapter Name</th>
<th>Description</th>
<th>Latest Verified Version of the Data Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNMP</td>
<td>Simple Network Management Protocol is a component of the Internet Protocol Suite. The SNMP adapter also supports gathering SNMP data from round-robin databases (RRDs) that are used in many network management tools.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>VMware vCenter</td>
<td>VMware vCenter Server is an operational console for VMware and includes the VMware vCenter database that serves as the raw data source for this SAS IT Resource Management adapter. The vCenter database contains VMware performance and utilization measurements for both the virtual machines and the physical servers on which they run, including detailed CPU, memory, storage, and I/O metrics. The vCenter relational database is accessed via SAS/ACCESS to Oracle, DB2, or ODBC.</td>
<td>v4.0</td>
</tr>
<tr>
<td>VMware Data Acquisition</td>
<td>VMware Data Acquisition is a transformation that can extract topology and configuration information from the VMware vCenter database more frequently than once a day. The vCenter relational database is accessed via SAS/ACCESS to Oracle, DB2, or ODBC.</td>
<td>v4.0</td>
</tr>
<tr>
<td>Web Log</td>
<td>The Web Server Log adapter reads and analyzes Web logs that conform to the Common and W3C Extended Log Formats (CLF and ELF.)</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

* SAS IT Resource Management uses MXG for this adapter.

Note: The specific software versions of the raw data sources in this table have been used to verify each SAS IT Resource Management 3.3 adapter. This information is not an exclusive list of all data source versions that are supported. Earlier versions of some data source software might be supported. Future releases of some data source software might be compatible and supported by adapters for SAS IT Resource Management 3.3. For information about supporting a data source version that is not included in the previous table, contact your SAS Installation Representative or on-site SAS support personnel.
For data sources (and for raw data sources) that are user-written, staging code is supported by the wizards of SAS Data Integration Studio, and the transformations that are supplied by SAS IT Resource Management. The New Table wizard of SAS Data Integration Studio can create the transformations that can stage raw data from any input source.

**Adapter Components That Stage Data**

SAS IT Resource Management supports adapters that are essential for extracting, standardizing, and staging data. These adapters include the following three components to stage data:

**template tables**
These adapter-specific models are used when transforming and loading raw data into SAS data sets called staged tables. The values in template tables are supplied by SAS IT Resource Management for specific IT data sources and thus cannot be changed. However, you can view a template table's properties such as associated columns and related metadata. For additional information about template tables, see “Working with Template Tables” on page 87.

**staging transformations**
These transformations generate the SAS code that extracts raw data, transforms it to a standardized format, and then loads it into staged tables. Staging transformations include specific staging parameters such as the format of raw data, the location of the data, and how the data will be handled during the staging process. For example, a staging transformation might specify the network path to the raw data, how that data is delimited in its source format, and how duplicate data might be handled when it is staged.

SAS IT Resource Management provides several ways that you can customize and configure how your data is staged by a staging transformation. For example, you can use the Adapter Setup wizard to create and configure staging transformations for a supplied adapter. You can create staging transformations manually by using the User-written Staging transformation. You can also modify the staging parameters that are specified in a staging transformation after it is created. For more information about staging transformations, see “Working with Staging Transformations” on page 121.

**staged tables**
These SAS data sets contain the data that has been extracted from an input data store and rendered into a format that is suitable for further transformation and generation into reports. The structure and metadata for staged tables are based on corresponding template tables that SAS IT Resource Management provides for specific adapters and domain categories. For more information about staged tables, see “Working with Staged Tables” on page 127.

---

**Working with Template Tables**

**What are Template Tables?**

Template tables are representations of adapter-specific tables that are supplied by SAS IT Resource Management for specific IT data sources. Template tables are models that are used to create staged tables. These staged tables are, in turn, populated by staging transformations when loading and transforming raw data.
Each template table provides the metadata for all regular columns, computed columns, and other attributes (formats, formulas, source code for computed columns, and so on) that a staged table can include when it is created from a template table. The resulting staged table can include all or a subset of this metadata that is provided by the template table.

A template table includes regular columns and computed columns that indicate how raw data is computed and populated into the staged table. This predefined metadata is based on data classifications and metrics that SAS IT Resource Management considers most important for aggregation and reporting in various performance areas. Thus, template tables are the starting point where SAS IT Resource Management begins to add intelligence to raw data. For more information about the metrics that SAS IT Resource Management uses for the various adapters, see the metrics documentation that is located on the SAS IT Resource Management documentation page. To locate the SAS IT Resource Management documentation, use the Products Index A-Z at http://support.sas.com/documentation/index.html.

**Locate Template Tables**

Template tables are available from the Folders tree view. Expand Products ⇒ SAS IT Resource Management ⇒ Adapters. Then, expand an adapter subfolder, the IT Template Tables subfolder, and one or more of the subfolders for domain category. SAS IT Resource Management groups the tables by adapter and domain category (such as Disk or Network).

*Note:* You cannot delete template tables unless you have the appropriate permission to do so.

Domain categories are categories of template tables (and aggregation tables) that are organized logically to represent subsets of the IT resource measurements that are available from an adapter. This enables you to identify the template tables that correspond with the performance data that you want to use when creating staged tables.
In the previous image from the Folders tree view, the template table PCSDSK is in the Disk subfolder and is therefore related to the disk performance data from the HP Reporter adapter. Using this information, you can determine that this template table provides metadata for staging the data that relates to PCS disk metrics such as disk performance and disk space usage. Other template tables that relate to other facets of disk performance are also in the Disk subfolder.

**Note:** Domain categories also surface in the Staged Table wizard and the Adapter Setup wizard for creating staged tables.

---

**Differentiate between Template Tables and Staged Tables**

Staged tables have the same name as the template tables on which they are modeled. For this reason, identifying an object as a template table or a staged table when working within SAS Data Integration Studio can be confusing.

The following table shows the differentiating factors that enable you to distinguish a template table from a staged table.

<table>
<thead>
<tr>
<th>Differentiator</th>
<th>Template Tables</th>
<th>Staged Tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon</td>
<td>Template tables are indicated by the icon in the tree views and the Staged Table wizard.</td>
<td>Staged tables are indicated by the icon in the tree views.</td>
</tr>
<tr>
<td>Differentiator</td>
<td>Template Tables</td>
<td>Staged Tables</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td><strong>Location</strong></td>
<td>In the Folders tree view, template tables are in the Products (\rightarrow) SAS IT Resource Management (\rightarrow) Adapters (\rightarrow) &lt;adapter name&gt; (\rightarrow) IT Template Tables (\rightarrow) &lt;domain category&gt; subfolders.</td>
<td>In the Inventory tree view, staged tables are in the Table folder. In the IT Data Marts tree view, staged tables are in the same folder as the corresponding staging job (unless you designated otherwise when creating the staged tables). Staged tables are also stored in the same IT data mart subfolders as their respective staging jobs.</td>
</tr>
<tr>
<td><strong>Job</strong></td>
<td>A template table never appears in a folder of the IT Data Marts tree view or in the process flow diagram of a job.</td>
<td>Each staged table appears as an object in the process flow diagram of a staging job. The following image is an example of how a staged table looks in a process flow diagram.</td>
</tr>
</tbody>
</table>

**Template Table Properties**

*About Template Table Properties*

Template tables are distinct tables that are defined to the metadata for SAS IT Resource Management. You cannot modify the properties of template tables because these predefined tables include values and attributes that make up the intelligence for processing raw IT data based on industry research. You can, however, view the properties of template tables to determine the template tables from which you want to create staged tables for a given adapter.

To view the properties of a template table, perform the following steps:

1. In the Folders tree view of SAS IT Resource Management, expand Products \(\rightarrow\) SAS IT Resource Management \(\rightarrow\) Adapters. Then expand an adapter subfolder, the IT Template Tables subfolder, and one or more of the domain category subfolders to see the corresponding template tables.

2. Right-click a template table and select Properties. A Properties dialog box appears and enables you to view the template table’s metadata, such as table name, column metadata, and external properties.
The Properties dialog box contains the following tabs:

- **General** tab displays information that identifies the template table, such as name, description, folder location, and responsibilities.

- **Notes** tab displays notes or documents that are associated with the template table.

- **Advanced** tab displays additional metadata attributes about the template table, such as metadata ID and filename.

- **Authorization** tab displays users and groups that have various permissions related to template table.

- **Columns** tab displays the metadata for each column in the template table. This tab includes information such as the name and description for each column, the expressions used for any computed columns in the template table, and the type classification for each column in the template table. In addition, this tab displays the length, informat, format, external name, and whether the column is recommended. For more information about the **Columns** tab for template tables, see “Columns in Template Tables” on page 91.

- **ITRM Options** tab identifies the adapter that is associated with the template table as well as any predecessor tables, external names, and data model versions that correspond with the template table. For more information about **ITRM Options** tab for template tables, see “ITRM Options for Template Tables” on page 94.

**Note:** You can click **Help** in the Properties dialog box for more information about each tab.

### Columns in Template Tables

The **Columns** tab of a template table's Properties dialog box enables you to view the specific column metadata for the table. You can use this information to view the types of
data that the template table includes, understand how computed columns are formulated, and determine whether you want to use the template table for creating a staged table.

**Display 5.3** Sample Columns Tab from the Properties Dialog Box of the PCSDSK Template Table

The following list describes the information that you can view for each column in a template table. Each row on the **Columns** tab shows the metadata for a single column of the template table. You cannot modify this information because the predefined metadata includes values and attributes that make up the intelligence for processing raw IT data based on industry research.

- **#** specifies the column's ordinal position in the grid on the **Columns** tab. Note that the ordinal position is not necessarily the same as the alphabetic sequence of variable names.

- **Name** specifies the name of the column in the template table.

- **Expression** specifies the combination of functions and mathematical operations that are used to derive a value for the column. This field is blank unless the column is a computed column. For more information about computed columns in template tables, see “Computed Columns in Template Tables” on page 95.

- **Description** provides a description of the data that populates the column. The description provides more information about the type of data that the column includes.

The column descriptions in template tables are propagated to staged tables and used as labels in information maps and aggregations. Therefore, column descriptions for template tables are standardized to be concise, easily understood, and efficiently integrated into other objects and SAS products such as SAS Enterprise Guide and SAS Information Map Studio. Standardizing column descriptions and label names ensures that equivalent data is labeled the same across all adapters. Standardization also reduces the need for editing label content in reporting clients.

Here are some of the ways that column descriptions in template tables have been standardized to be effective labels:

<table>
<thead>
<tr>
<th>#</th>
<th>Name</th>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CAPNAME</td>
<td>64KB_BUSY_CAPACITY (Resource...</td>
<td>Ram @ 64KB</td>
</tr>
</tbody>
</table>
• Character length is reduced by removing spaces between words and capitalizing the first letter of each word or term within the description (such as ManagementClassLength).

• Character length is typically reduced by removing special characters, punctuation, and redundant words that do not enhance the meaning of the data.

• Words that indicate performance area or domain category (such as CPU, processor, disk, memory, and network) are typically at the beginning of the description.

• Words that indicate data interpretation and normalization (such as rate, bytes, and seconds) are at the end of the description.

• Words are abbreviated if a clear alternative is available (such as Average to Avg).

**Type**
specifies the data type of the column. Valid types are character and numeric. You can also identify column types by looking at the Name variable. A round icon to the left of the name indicates that the data in the column is numeric. A pyramid icon to the left of the name indicates that the column contains character data.

**Length**
specifies the maximum length of the data in the column.

**Informat**
specifies the SAS informat that is used (if needed) to read values for the selected column. Informs are required for reading fixed-width data.

**Format**
specifies the SAS format that is used to write values for the selected column. Template table columns are in NLS format when applicable. NLS formats are indicated by NL as the first two characters in the format column. For more information about NLS formatting, see “National Language Support (NLS)” on page 12.

**External Name**
specifies the name by which the staging code maps columns in a staged table to their corresponding variables in the raw data. External names are used by both staged tables and template tables. However, not all columns in a staged or template table have a predetermined external name.

*Note:* For MXG adapters, the external name is usually the name of the MXG variable. For the DT Perf Sentry adapter, the external name is the name of the DT Perf Sentry metric.

**Recommended**
specifies whether the column provides data that SAS IT Resource Management has predefined as critical for reporting and analysis in the performance area of the template table. The Staged Table wizard enables you to use only the recommended columns from a template table when creating a corresponding staged table. This enables you to create staged tables that include only the columns that are recommended and thus not spend resources staging and analyzing data that is likely not relevant. For more information about using the Staged Table wizard, see “Create Staged Tables” on page 129.

The Adapter Setup wizard also uses the recommended columns of a template table to create various levels of output. For example, when using the Adapter Setup wizard, you can choose staging only, minimal, typical, or full output and then the wizard creates the appropriate level of output based on your selection and the columns
recommended for the corresponding tables. For more information about the Adapter Setup wizard, see “About the Adapter Setup Wizard” on page 209.

**ITRM Options for Template Tables**
The ITRM Options tab of the Properties dialog box for a template table includes information such as what tables are staged before the template table and how the original data collector identifies the data that is used for the template table.

**Display 5.4** Sample ITRM Options Tab from the Properties of the PCSDSK Template Table

![Sample ITRM Options Tab from the Properties of the PCSDSK Template Table]

The ITRM Options tab includes the following parameters:

**Adapter Key**
specifies the adapter that is associated with the template table. For adapter names, SAS IT Resource Management uses the latest names that are approved by respective third parties. However, due to the constraints of character limitations in software code and organizations changing the names of their products and software, SAS IT Resource Management uses an abbreviation called an adapter key to represent an adapter in the software if necessary. The adapter key is for reference by SAS Technical Support and does not require any action from the SAS IT Resource Management user.

*Note:* In some cases, the adapter key does not match the current name of the adapter but instead reflects the former name of the adapter. For example, the adapter key for the BMC Perf Mgr adapter is PATROL, the former name of this adapter.

**Predecessor Tables**
specifies other tables that are required to be staged in order to produce this table. For example, one of the staged tables (named SAR) for the SAR adapter is a compilation of many SAR tables (predecessor tables). When the SAR table is staged, SAS IT Resource Management programmatically stages the various predecessor tables that make up the resulting SAR staged table so that you do not have to stage each predecessor table individually. If a template table does not require staging predecessor tables, this parameter is blank.
External Names

specifies the names that the original data collector (or other software) uses to identify the data that serves this template table. External names are the means by which the staging code maps a SAS IT Resource Management template table to a table in the raw data. For example, a template table that is named “NTPHDSK” in SAS IT Resource Management might have an external name such as “Physical Disk” in the raw data file. The staging code uses this information to determine that the Physical Disk data in the raw data file belongs in the staged table that is modeled from the NTPHDSK template table.

Note: The staging code for some adapters does not use external names. For example, the table name in the raw data might be the same as the table name in SAS IT Resource Management.

The external names for template tables are similar in concept to the external names for staged tables. For more information about using external names for staged tables and columns in staged tables, see “Understanding External Names of Staged Tables and Columns” on page 144.

Data Model Version

specifies the version of the template table. This is the version from which the staged table is created or updated through the Maintain Staged Tables wizard. For more information about the Maintain Staged Tables wizard, see “About the Maintain Staged Tables Wizard” on page 97.

Computed Columns in Template Tables

Computed columns in a table contain data values that are derived from other columns in the table. Template tables contain computed columns for data that is not directly provided by the raw data source but the data might be useful for reporting or promoting consistency across various data sources.

The following table demonstrates how template tables might use computed columns for a data source for consistency across various data sources. In this example, Data Source 1 includes three columns: Column A, Column B, and Column C, which is the total of Column A and B. Data Source 2 provides only two columns: Column A and Column B. For Data Source 2, a template table might compute the total of Column A and Column B so that the data for Data Source 2 is as comprehensive as Data Source 1.

Table 5.3 Example of a Computed Column in a Template Table

<table>
<thead>
<tr>
<th>Data Source 1</th>
<th>Data Source 2</th>
<th>Template Table for Data Source 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column A</td>
<td>Column A</td>
<td>Column A</td>
</tr>
<tr>
<td>Column B</td>
<td>Column B</td>
<td>Column B</td>
</tr>
<tr>
<td>Column C (equal to Column A + Column B)</td>
<td>Column C (a computed column equal to Column A + Column B)</td>
<td></td>
</tr>
</tbody>
</table>

Note: A computed column should not be used as a source of calculations for other computed columns. Using a computed column as a source for a computation can be problematic due to the order of computations that are necessary to derive the final value.
To find a computed column in a template table and view the formula that it uses, click the **Columns** tab of a template table's Properties dialog box. All computed columns contain an expression in the **Expression** column of the grid.

Here are some of the reasons for which SAS IT Resource Management might use computed columns in a template table:

- Create datetime derivations such as changing week date and shift values to your local environment.
- Provide normalizations such as converting bytes to kilobytes, seconds to milliseconds, and percentages between 0 and 1 to percentages between 0 and 100.
- Total paired columns to provide a summed value that includes input and output values, or received and sent values.
- Derive opposite values by using a percentage-based computation that typically subtracts one value from another. For example, a computed column might subtract the number of used components from the number of allocated components to determine the number of components that are still available.
- Standardize performance event count to total events across various classifications such as batch jobs, TSO sessions, and started tasks.
- Create class columns when a table contains an instance column that can contain either a global or an individual instance of a performance metric. In this case, a computed column such as CpuId or DiskId is created and set to an individual instance value, or it is set to a blank value for global instances. These new class columns can then be used as targets of filters to divide global and individual instances into appropriate aggregations.
- Convert raw counts to rates.
- Calculate response time counts and percentages.

**Use Template Tables to Create Staged Tables**

The Staged Table wizard and Adapter Setup wizard enable you to create staging jobs that use template tables to create corresponding staged tables. When executed, the staging jobs load the source data into the staged tables. The staged tables can be used as input to an Aggregation transformation or other SAS Data Integration Studio transformations that are used for analysis and reporting.

SAS IT Resource Management enables you to select the template tables that you want to use or accept the template tables that are selected programmatically for a given adapter.

- To select the template tables that you want to use, create a staging job manually. For more information about how to create a staging job, see “Add a Staging Transformation to a Staging Job” on page 124. For more information about how to create a staged table, see “Create Staged Tables” on page 129.

- To have template tables preselected programmatically for a staging job, run the Adapter Setup wizard for a supported adapter. The template tables that the Adapter Setup wizard uses are predetermined by SAS IT Resource Management to include the data that is most relevant and appropriate for the level of analysis and reporting that you select. For more information about the template tables that are preselected by the Adapter Setup wizard for each adapter and domain category, see “Overview of the SAS IT Resource Management Data Model” on page 466.
Maintaining Template Tables and Staged Tables Based on Adapter Changes

Working with the Maintain Staged Tables Wizard

About the Maintain Staged Tables Wizard

The data collectors on which template tables are based might change over time. These changes can require new columns in a template table or revisions to existing columns, such as label or character length. Therefore, when SAS IT Resource Management provides a new software release or update, the definitions for some template tables might also change. After a software update is installed, a preexisting staged table can differ from the new version of its corresponding template table.

The Maintain Staged Tables wizard enables you to perform the following tasks with software updates to template tables:

• View updates that can be propagated to existing staged tables.
• Commit updates to the corresponding staged tables within an IT data mart.
• Commit updates to the corresponding staged tables across all IT data marts.
• Add new columns and update existing columns to the corresponding staged tables.
• Commit only updates that add new columns to the affected staged tables.
• Commit only updates to the recommended columns in the corresponding staged tables.
• Generate an HTML report of the actions that the wizard performs.

Note: If there are no staged tables to maintain, the HTML report is not produced.

CAUTION:

After updating your staged tables with the Maintain Tables wizard or with the corresponding BatchMaintainTable command, you must redeploy your staging jobs. Aggregation jobs do not need to be redeployed.

SAS IT Resource Management identifies affected template tables and their associated staged tables by the DataModelVersion field for each table. For example, a template table and a staged table are eligible for impact analysis and updates if the current DataModelVersion field of the table does not match the version that is associated with the software update.

For more information about using the Maintain Staged Tables wizard to maintain staged tables within an IT data mart, see “Using the Maintain Staged Tables Wizard to Update Staged Tables within an IT Data Mart” on page 97. For more information about using the Maintain Staged Tables wizard to maintain staged tables across all IT data marts, see “Using the Maintain Staged Tables Wizard to Update Staged Tables across All IT Data Marts” on page 103. For more information about maintaining staged tables using a batch process, see “Maintaining Staged Tables in Batch Mode” on page 103.

Using the Maintain Staged Tables Wizard to Update Staged Tables within an IT Data Mart

After you install software updates for SAS IT Resource Management, you can use the Maintain Staged Tables wizard to see whether any software changes to the template
tables affect the staged tables that you use and propagate these template table changes to their corresponding staged tables. To do so, perform the following steps:

1. In the IT Data Marts tree view of SAS IT Resource Management, locate the IT data mart that contains the staged tables for which you want to view or commit updates.

2. Right-click the IT data mart and select Maintain Staged Tables to open the wizard.

3. Specify the scope of the operation that you want to perform with the Maintain Staged Tables wizard.

   **Display 5.5  Specify Scope of Operation Page in the Maintain Staged Tables Wizard**

   ![Specify Scope of Operation Page](image)

   a. Select Commit updates with report to view a report of the template table changes that affect your staged tables and then commit the changes to the corresponding staged tables.

   b. Select Create report only to view only a report of the template table changes that affect your staged tables but not commit the changes in this instance of the wizard.

   c. Click Next.

4. Select an adapter for which you want to analyze the impact of table revisions that are available.

   **Note:** This page is not displayed when accessing the wizard from a specific template table to commit updates across all IT data marts. For more information about using the Maintain Staged Tables wizard to maintain staged tables across all IT data marts, see “Using the Maintain Staged Tables Wizard to Update Staged Tables across All IT Data Marts” on page 103.
Specify Adapter Page in the Maintain Staged Tables Wizard

a. Click the adapter for which you want to analyze updates. The list of adapters includes all of the adapters that SAS IT Resource Management supports. However, you must select an adapter that is used in the IT data mart in order to complete the wizard successfully.

Note: You can select only one adapter on this page and must perform updates for another adapter by using a separate instance of the wizard.

b. Click Next. If a message states that there are no staged tables that need maintenance, then there are no staged table updates required based on your selections and the latest software updates. You can close the message box and stop here. Otherwise, continue to the next step.

5. Select the staged tables for which you want to view changes or commit updates.
Select the staged tables for which you want to analyze updates. The list of staged tables includes only the staged tables that are associated with the selected adapter.

A tooltip is available for each staged table in the list. The tooltip shows the metadata path of the table in order to help distinguish between tables, especially tables that might have duplicate names.

**Note:** If there are no updates to the template tables for the selected adapter, then the wizard displays a message to that effect.

b. Click **Next**.

6. Compare table updates with the previous value of the tables and columns and specify the commit options.
Display 5.8  Impact Analysis Page in the Maintain Staged Tables Wizard

a. Expand the folders in the grid to view the version of the tables and the table columns that have been modified or added to the corresponding template tables. The rows in the grid include the table name, version, description, or columns that are affected by the update. This comparison list also shows previous values before the update and the corresponding new values after the update.

New columns that are added to the template table display the previous value as blank because the column did not exist in the previous version. New columns are also preceded by an asterisk (*) in the HTML report that the wizard generates.

Note: Within a specific table, columns are matched by SASColumnName and SASColumnType (numeric or character). Therefore, if a column's SASColumnName or SASColumnType has been changed by the user, the column might not be recognized as a supplied column. Also, if a supplied column needs to have its SASColumnName or SASColumnType changed in the supplied template table definition, then it is treated as a new column.

b. If you choose to commit the updates that are detailed on this page, select one or more of the following Update Options that enable you to refine the scope of changes that you commit:

- **Add new columns as well as update existing columns** commits all of the changes that are detailed on this page of the wizard. This option must be deselected for the other options to be available.
- **Add only new columns** commits only the new columns.
- **Update only recommended columns** commits only the updates that affect the recommended columns in the associated template tables. For more information about recommended columns in template tables and determining which columns are recommended for a given template table, see “Columns in Template Tables” on page 91.

Note: The Update Options are interdependent and the availability of each option in this window depends on whether the other options are selected or

<table>
<thead>
<tr>
<th>Name</th>
<th>Previous Value</th>
<th>New Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table data model version</td>
<td>3.01030</td>
<td>3.03000</td>
</tr>
<tr>
<td>Table columns</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ACTIVFRA (Formula)</td>
<td>Real</td>
<td>NUM151.0</td>
</tr>
<tr>
<td>ALGNFSC (Description)</td>
<td>Alignment/Fixed</td>
<td>Alignment/Fixed</td>
</tr>
<tr>
<td>ALGNFSC (External name)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALGNFSC (Length)</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>ALGNFSC (Format)</td>
<td></td>
<td>NUM151.2</td>
</tr>
<tr>
<td>ALGNFSC (Informat)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
deselected. For example, if **Add new columns as well as update existing columns** is selected, then the other options are not available. If this option is deselected, then the other options are available. Likewise, if **Add only new columns** or **Update only recommended columns** is selected, then **Add new columns as well as update existing columns** is not available for selection.

c. Click **Next**.

7. View a summary of the impact analysis and update options that you selected for the staged tables.

**Display 5.9 Summary Page in the Maintain Staged Tables Wizard**

![Summary Page in the Maintain Staged Tables Wizard](image)

a. Review the summary and ensure that it reflects the specifications and result that you expect.

b. Click **Finish**. The wizard then generates an HTML report and saves it to your workstation.

*Note:* If there are no staged tables to maintain, the HTML report is not produced.

On the client, the report is located in a directory that is determined based on the APPDATA environment variable.

- On Windows XP, this location is typically `C:\Documents and Settings\userid\Application Data\SAS\SASITResourceManagement\3.3\MaintainTableReportYYMMDDHHMMSS.htm`

- On Windows 7, this location is typically `C:\Users\userid\AppData\Roaming\SAS\SASITResourceManagement\3.3\MaintainTableReportYYMMDDHHMMSS.htm`

If you selected **Commit updates with report** previously in the wizard, then the metadata for the selected staged tables is updated immediately. The physical data sets for these tables are then updated when the associated staging jobs are run.
Note: The data model version of the staged tables is updated and stamped only when you select both Commit updates with report and Add new columns as well as update existing columns in the wizard.

Using the Maintain Staged Tables Wizard to Update Staged Tables across All IT Data Marts

The Maintain Staged Tables wizard enables you to see whether any software changes to the template tables affect the staged tables that you use. You can also propagate these template table changes to their corresponding staged tables across all IT data marts at once. To do so, perform the following steps:

1. In the Folders tree view of SAS IT Resource Management, expand the following folders to locate the template table: Products ⇒ SAS IT Resource Management ⇒ Adapters ⇒ <adapter name> ⇒ IT Template Tables ⇒ <domain category> that corresponds to the template table for which you want to propagate updates to its corresponding staged tables.

2. Right-click the template table and select Maintain Staged Tables to open the wizard.

3. Complete the Maintain Staged Tables wizard. When you access the wizard from a specific template table as described in the previous steps, you are able to view and commit staged table updates across all IT data marts instead of within a single IT data mart. For more information about how to complete the Maintain Staged Tables wizard, see “Using the Maintain Staged Tables Wizard to Update Staged Tables within an IT Data Mart” on page 97. This topic includes instructions for reading and completing each page of the wizard.

Maintaining Staged Tables in Batch Mode

About Maintaining Staged Tables in Batch Mode

In order to run the Maintain Staged Tables process in batch mode, you need to invoke the command from the server tier where the SAS IT Resource Management data tier has been installed. You cannot perform this action from a client install.

Note: You must use the Maintain Staged Tables wizard if you want to update selected staged tables that are affected by an update. The BatchMaintainTable command does not provide the ability to specify staged tables to update. For more information about maintaining specific staged tables, see “Using the Maintain Staged Tables Wizard to Update Staged Tables within an IT Data Mart” on page 97.

Perform the following steps to maintain the tables in a batch process:

1. Open a command prompt and enter the following command:

   cd $SAS\SASITResourceManagementDataTier\3.3

   Note: The locations that are specified in this and in other sections of the following instructions assume that you have installed SAS IT Resource Management at cd $SAS.

2. Execute the BatchMaintainTable command, specifying options as required.

   TIP For best results, set all the options as needed but set the commit option to N. This setting produces a report that lists the actions that might be performed under the current settings of the command. However, if there are no staged tables to maintain, no HTML report is produced. After reviewing the report, if you are satisfied with the additions or updates that might be performed by using the
options that you specified, simply change the commit option to \texttt{Y} and rerun the command.

**Syntax for the Batch Maintain Table Command Line**

\texttt{BatchMaintainTable}

- \texttt{-Commit Y | N}
- \texttt{-AdapterName “adapter-name”}
  \texttt{<-ITDataMartName “ITDataMartName”>}
  \texttt{<-TemplateTableName “TemplateTableName”>}
  \texttt{<-AddAndUpdateColumns Y | N>}
  \texttt{<-AddNewColumnsOnly Y | N>}
  \texttt{<-UpdateRecommendedColumnsOnly Y | N>}
- \texttt{<-profile profile>}
- \texttt{<-user userID>}
- \texttt{<-password password>}
- \texttt{<-host hostname>}
- \texttt{<-port port>}
- \texttt{<-domain domain>}
- \texttt{<-help>}

To invoke the \texttt{BatchMaintainTable} command, use the following code:

```
"C:\Program Files\Java\jre1.5.0_12\bin\java.exe"
   -Djava.system.class.loader=com.sas.app.AppClassLoader
   -Dsas.ext.config="cd $SAS\sas.java.ext.config"
   -Dsas.launch.config="cd $SAS
      \SASITResourceManagementDataTier\3.3
      \plugins\itmmdatatier\picklist"
   -Dsas.app.repository.path="cd $SAS
      \SASVersionedJarRepository\eclipse"
   -Dlog4j.configuration=\SASDataIntegrationStudioServerData\4.3
      \log4j.properties"
   -Dsas.app.class.path=.;"$SAS
      \SASITResourceManagementClient\3.3\build"
   -Xmx1024m
   -Xss1m
   -classpath "$SAS\SASVersionedJarRepository
      \eclipse\plugins\sas.launcher.jar"
com.sas.solutions.itms.batch.maintaintable.BatchMaintainTable
```

\textbf{Note:} If you copy and paste the preceding command from this document onto your command line, be sure to remove any extraneous spaces so that the folder name is correct and that each parameter is pointing to the correct location.

\textbf{Note:} If you installed SAS IT Resource Management on the C: drive in Windows, the preceding locations should be used. If you installed in another location, adjust the preceding locations accordingly.

**BatchMaintainTable Options**

\textbf{Note:} When the command is entered, make sure that each option is preceded in the command line by a hyphen.

- Commit Y | N
specifies whether to commit changes to the staged tables.

- **AdapterName “adapter-name”**
  specifies the adapter whose staged tables you want to update.
  *Note:* Enclose *adapter-name* in double quotation marks.

- **ITDataMartName “IT-data-mart-name”**
  specifies the IT data mart where the adapter's staged tables are stored. This option is required if the TemplateTableName option is not set to Y.
  *Note:* Enclose *IT-data-mart-name* in double quotation marks.

- **TemplateName template-table-name**
  specifies the template table that you want to update. This option is required if the ITDataMartName option is not set to Y.

- **AddAndUpdateColumns Y | N**
  specifies whether to add new columns and update all existing columns. If the AddAndUpdateColumns option is N, then either or both of the AddNewColumnsOnly and the UpdateRecommendedColumnsOnly options should be set to Y.
  *Note:* Setting this option to Y is recommended.

- **AddNewColumnsOnly Y | N**
  specifies whether to add only new columns. This option is required if the AddAndUpdateColumns option is not set to Y.

- **UpdateRecommendedColumnsOnly Y | N**
  specifies whether to update only recommended columns. This option is required if the AddAndUpdateColumns option is not set to Y.

- **profile profile**
  specifies the metadata server connection profile. This option can be used in place of the host, port, user, and password options.

- **user user-ID**
  specifies the user login identity. This option is required if the profile option is not set or if the profile does not contain connection credentials.

- **password password**
  specifies the user login password. This option is required if the profile option is not set or if the profile does not contain connection credentials.

- **host host-name**
  specifies the metadata server host. This option is required if the profile option is not set.

- **port port-number**
  specifies the metadata server port. This option is required if the profile option is not set.

- **domain domain**
  specifies the user authentication domain.

- **? (or -help)**
prints help information.

Note: By default, running the BatchMaintainTable command always produces a report of the results unless there are no staged tables to be maintained. In that case, no HTML report is produced.

**Examples of the Batch Maintain Table Command Line**

**Example 1**

This example shows how to run the Batch Maintain Table command on Windows. The command examines the staged tables in an IT data mart called “My IT Data Mart” that were generated for the BMC Performance Manager adapter. Any new or changed columns that apply to the staged tables for the BMC Performance Manager adapter are not performed, but are included in the report that is produced by the Batch Maintain Table command.

```
"C:\Program Files\Java\jre1.5.0_12\bin\java.exe"
-Djava.system.class.loader=com.sas.app.AppClassLoader
-Dsas.ext.config="$SAS\sas.java.ext.config"
-Dsas.app.launch.config="$SAS\SASITResourceManagementDataTier\3.3\plugins\itrmdatatier\picklist"
-Dsas.app.repository.path="$SAS\SASVersionedJarRepository\eclipse"
-Dlog4j.configuration="file:///$SAS\SASDataIntegrationStudioServerData\4.3\log4j.properties"
-Dsas.app.class.path=.;"$SAS\SASITResourceManagementClient\3.3\build"
-Xmx1024m
-Xss1m
-classpath "$SAS\SASVersionedJarRepository\eclipse\plugins\sas.launcher.jar"
com.sas.solutions.itms.batch.maintaintable.BatchMaintainTable
-Commit N
-AdapterName "BMC Perf Mgr"
-ITDataMartName "My IT Data Mart"
-AddAndUpdateColumns Y
-profile MyMetadataServerProfile
```

**Example 2**

This example shows how to run the Batch Maintain Table command in Windows. The command examines tables across all IT data marts on the application server that were generated for the BMC Performance Manager adapter and the PTCACHE template table. Only changes to the recommended columns are made. A report of these updates is produced.

```
"C:\Program Files\Java\jre1.5.0_12\bin\java.exe"
-Djava.system.class.loader=com.sas.app.AppClassLoader
-Dsas.ext.config="$SAS\sas.java.ext.config"
-Dsas.app.launch.config="$SAS\SASITResourceManagementDataTier\3.3\plugins\itrmdatatier\picklist"
-Dsas.app.repository.path="$SAS"
Maintaining Template Tables and Staged Tables Based on Adapter Changes

Sample Batch Maintain Table Commands for Windows, UNIX and z/OS Operating Environments

Batch Maintain Table Command for Windows Operating Environments

"C:\Program Files\Java\jre1.5.0_12\bin\java.exe"
-Djava.system.class.loader=com.sas.app.AppClassLoader
-Dsas.ext.config="$SAS\sas.java.ext.config"
-Dsas.app.launch.config="$SAS\SASITResourceManagementDataTier\3.3\plugins\itrmdatatier\picklist"
-Dsas.app.repository.path="$SAS\SASVersionedJarRepository\eclipse"
-Dlog4j.configuration="file:///SAS\SASDataIntegrationStudioServerData\4.3\log4j.properties"
-Dsas.app.class.path=.;$SAS/SASITResourceManagementClient\3.3\build
-Xmx1024m
-Xss1m
-classpath "$SAS\SASVersionedJarRepository\eclipse\plugins \\sas.launcher.jar"
com.sas.solutions.itms.batch.maintaintable.BatchMaintainTable
-Commit Y
-AdapterName "BMC Perf Mgr"
-TemplateTableName PTCACHE
-AddNewColumnsOnly Y
-UpdateRecommendedColumnsOnly Y
-profile MyMetadataServerProfile
-host <host-name>
-port (port-number)
-user <userID>
-password <password>
-domain DefaultAuth
-Commit N
-AdapterName "<adapter-name>"
-ITDataMartName "<IT-data-mart-name>"
-TemplateTableName <template-table-name>
-AddAndUpdateColumns Y
-AddNewColumnsOnly N
-UpdateRecommendedColumnsOnly N

**Note:** Double quotation marks are needed in this command line wherever a part of an address (for example, “Program Files”) contains a space.

**Batch Maintain Table Command for UNIX Operating Environments**
This example is enclosed in a shell script. It was run on the H64 UNIX operating environment.

```bash
#!/bin/sh
export SAS=<full-path-to-SAS directory>
export DISPLAY=<hostname:displaynumber.screennumber>
cd $SAS/SASITResourceManagementDataTier/3.3
$JAVA_HOME/jre1.5.0.08/bin/java \
-Djava.awt.headless=false \
-Xmx1024m \
-Xss1m \
-classpath $SAS/SASVersionedJarRepository/eclipse \
-plugins/sas.launcher.jar \
-com.sas.solutions.itms.batch.maintaintable.BatchMaintainTable \
-host <metadata-server-hostname> \
-port <metadata-server-port-number> \
-user <unrestricted-metadata-server-userID> \
-password <password-for-specified-user> \
-domain DefaultAuth \
-Commit N \
-AdapterName "BMC Perf Mgr" \
-ITDataMartName "IT Data Mart" \
-TemplateName PTCACHE \
-AddAndUpdateColumns Y \
-AddNewColumnsOnly N \
-UpdateRecommendedColumnsOnly N
```

**Batch Maintain Table Command for z/OS Operating Environments**
This example is enclosed in a shell script. It was run on the z/OS operating environment.

```bash
#!/bin/sh
export SAS=<$JAVA_HOME 
export SAS=<$full-path-to-SASHOME-directory>
```
export DISPLAY=<hostname:displaynumber.screennumber>

echo DISPLAY is $DISPLAY

cd "$SAS/SASITResourceManagementDataTier/3.3" \\
$JAVA_HOME/bin/java \\
-Djava.awt.headless=false \\
-Djava.system.class.loader=com.sas.app.AppClassLoader \\
-Dsas.ext.config="$SAS/sas.java.ext.config" \\
-Dsas.app.launch.config="$SAS/SASITResourceManagementDataTier \\
/3.3/plugins/itrmdatatier/picklist \\
-Dsas.app.repository.path="$SAS/SASVersionedJarRepository/eclipse" \\
-Dlog4j.configuration="file://$SAS/SASITResourceManagementDataTier \\
/3.3/log4j.properties" \\
-Dsas.app.class.path=.;$SAS/SASITResourceManagementClient \\
/3.3/build \\
-Xmx1024m \\
-Xss1m \\
-classpath "$SAS/SASVersionedJarRepository/eclipse/plugins/sas.launcher.jar \\
com.sas.solutions.itms.batch.maintaintable.BatchMaintainTable \\
-host <metadata-server-hostname> \\
-port <metadata-server-port-number> \\
-user <unrestricted-metadata-server-userID> \\
-password <password-for-specified-user> \\
-domain DefaultAuth \\
-Commit N \\
-AdapterName "BMC Perf Mgr" \\
-ITDataMartName "IT Data Mart" \\
-TemplateName PTCACHE \\
-AddAndAndUpdateColumns Y \\
-AddNewColumnsOnly N \\
-UpdateRecommendedColumnsOnly N
Chapter 6
Formulas

About Formulas

What Is a Formula?

A formula is an expression that calculates the value for a computed column in a staged or aggregation table.

There are two types of formulas: supplied formulas and user-defined formulas.

• Supplied formulas are provided by SAS IT Resource Management and are loaded along with the SAS IT Resource Management software at installation. Supplied formulas cannot be modified. However, you can copy a supplied formula and modify the copied version, thus creating a user-defined formula.

• User-defined formulas are created by the data administrator or the performance analyst.

How Can a Formula Be Used?

Formulas can be used in all SAS IT Resource Management tables in order to calculate new computed columns.
Computed columns can be used for various purposes, such as to standardize the measurement units or time zones of related data or to establish datetime-related constructs such as WEEKDATE and SHIFT.

- Computed columns are supplied with the template tables for supplied adapters.
- Computed columns can be generated and added to staged or aggregation tables.

For more information about computed columns, see “Specify Computed Columns” on page 179.

How Is a Formula Created?

There are two ways to create a user-defined formula.

- A user-defined formula can be created by using the New Formula wizard, which is invoked by selecting Formula from the File ⇒ New ⇒ IT Resource Management menu of SAS IT Resource Management.

- A user-defined formula can be created by copying a supplied formula and pasting it into a folder to which you have Write privileges. The newly copied formula will retain its name unless it is pasted into a folder that already contains a formula with the same name. In that situation, the formula will be named "Copy of formula name." After it is pasted into the target folder, the formula can be renamed and modified.

How Can Formulas Be Accessed?

Formulas can be accessed from several folders in the Folders tree of SAS Data Integration Studio and can be used when specifying the expression that defines a computed column.

- Products is a folder that contains formulas that are supplied with SAS IT Resource Management software. These supplied formulas cannot be changed. However, they can be copied to another folder where they can be modified.

  To access these supplied formulas from the Folders tree, expand Products ⇒ SAS IT Resource Management ⇒ IT Formulas.

- Shared Data is a folder that contains formulas that are supplied with SAS IT Resource Management software, as well as those user-defined formulas that can be shared by other users at your site. Formulas that are in this folder can be modified.

  To access these formulas from the Folders tree, expand Shared Data ⇒ SAS IT Resource Management ⇒ IT Formulas.

- My Folder is a folder that contains user-defined formulas that you have saved in that location. My Folder is the private folder of the person, or owner, who is currently logged on to SAS IT Resource Management. The contents, including formulas, are not accessible to anyone other than the owner.

- The Users folder contains the private folders of all the users who are registered users of the metadata repository to which you are connected. The only folder that you can access in the Users folder is your own, private folder. It is the folder that belongs to the person who is logged in to SAS IT Resource Management.

The following display shows the IT Formulas tab of the Expression Builder window. You can expand My Folder, Shared Data, or your private folder within the Users folder and use any of those formulas in your expression. Alternatively, you can select the
Inventory tab and from the list that is displayed, use any of those formulas in your expression.

Display 6.1  IT Formulas Tab of Expression Builder

Note:  The IT Formulas tab of the Expression Builder window is available only when you are editing columns of a staged or aggregation table from the Properties dialog box in the process flow diagram.

How to Access the Expression Builder Window

You can use the Expression Builder window to add a new computed column to a table or to modify an existing computed column in a table. To access the Expression Builder in order to add a new computed column to a table, perform the following steps:

1. From the IT data mart that contains the table, double-click the job that uses the table. The job opens on the Diagram tab of the Job Editor window.
2. Select the table to which you want to add a column. Right-click the table to display the Properties dialog box of that table and click Properties.
3. Click the Columns tab to display the columns that make up the table.
4. Click New to add a new column to the table. From the drop-down menu, click Computed column.
5. Double-click the enabled Expression field for the new field to display an ellipsis (...).
6. Click the ellipsis (...). The Expression Builder window appears.
To access the Expression Builder in order to modify a computed column in a table, perform the following steps:

1. From the IT data mart where the table is stored, double-click the job that uses the table. The job opens on the **Diagram** tab of the Job Editor window.
2. Select the table whose column you want to modify. Right-click the table to display the Properties dialog box of that table and click **Properties**.
3. Select the **Columns** tab to display the columns that make up the table.
4. Select the **Expression** field of the column that you want to change.
5. Double-click the enabled **Expression** field for the field to display an ellipsis (...).
6. Click the ellipsis. The Expression Builder window appears.

For more information about the Expression Builder window, press the F1 key or select **Help** from within that window.

**Working with Formulas**

You can create, rename, delete a formula. You can also modify a formula and change its expression.

**Creating a Formula**

**How to Create a Formula**

You can create a formula in two ways:

- by invoking the New Formula wizard
- by copying an existing formula to a folder, renaming it, and modifying it

You can create a formula and save it in any of the **Formulas** folders to which you have Write privileges. For example, you can create a formula in the **Formulas** folder of **Shared Data** or in your private folder within **My Folder**.

If you want to use a formula in a wizard, you can specify the location of that formula. If the formula is not found in your specified location, then the wizard will search for the formula in this location: **Shared Data/SAS IT Resource Management/IT Formulas**. If the formula is still not found, the wizard will search for it in this location: **Products/SAS IT Resource Management/IT Formula**.

**Create a Formula By Using the New Formula Wizard**

To create a formula using the New Formula wizard, perform the following steps:

1. From the SAS Data Integration menu bar, select **File** ⇨ **New** ⇨ **IT Resource Management** ⇨ **Formula** to open the New Formula wizard.
2. On the General Information page of the New Formula wizard, specify the name, description, and location of the new formula.

   - The **Name** field can contain a maximum of 60 characters. A value is required in this field and it must be unique within its folder.

   **Note:** The wizard automatically generates a name for this new formula. You can either delete the system-generated name and enter a more meaningful name for this formula or you can retain the system-generated name.
• The **Description** text box can contain no more than 200 characters. A value is optional in this field.

• The **Location** field is automatically generated and, by default, specifies /Shared Data/SAS IT Resource Management/IT Formulas. Click **Browse** to navigate to another folder to use as the location for your new formula.

  **TIP** User-defined formulas are more easily accessed if they are all stored in a location that is identified as a “Formulas” folder.

3. On the **Expression** page of the New Formula wizard, enter the expression that specifies the combination of functions and mathematical operations that are used to derive a value. A value is required in this field.

You can enter the expression for a formula in any one of these three ways:

• Enter the expression in the text area of the **Expression** field.

• Copy and paste the expression text from the **Expression** tab of an existing formula to the **Expression** text area of the new formula.

• Copy and paste the computation from the **Expression** tab of the computed column into the **Expression** text area of the new formula.

In addition to the conventional rValue expression (where the expression consists of code that is appropriate only for the right-hand side of an assignment statement), SAS IT Resource Management also supports more complex expressions. For example, your expression can use SAS code that might include loops, IF statements, and so on. As shown in the following display, this code must be written in valid SAS DATA step syntax.

**Note:** You can use a SAS macro in a formula expression or in the expression for a computed column. The SAS macro definition needs to be available to the SAS session that executes the staging or aggregation job that populates the computed column. For example, you might need to add a new autocall library using the SASAUTOS SAS option in the SAS configuration.

**Display 6.2** Expression Page of the New Formula Wizard

4. The final page of the New Formula wizard is a summary page that displays the following information about the formula that you specified. Click **Finish** to store the formula that you created in the folder that you specified in the **Location** field.

**Create a Formula By Copying an Existing Formula**

To create a formula by copying an existing formula, perform the following steps.
1. In the Folders tree of SAS IT Resource Management, navigate to an IT Formulas folder (or to a folder that contains formulas) to locate the formula that you want to use as a template for the new formula.

   **TIP** User-defined formulas are more easily accessed if they are all stored in a location that is identified as a “Formulas” folder.

2. Right-click the formula that you want to copy. From the list that is displayed, select Copy. Then navigate to the folder where you want to store your new formula and click Paste.

   If you are copying and pasting the formula to the same folder, then the name of the new formula is retained unless a formula of the same name already exists at this location. In that situation, Copy of is appended to the original name of the formula. This ensures that the formula name is unique within its folder.

   **Note:** You can select the Copy to Folder option, which opens the Select a Location dialog box in which you can navigate to the folder where you want to store the copied formula. You can also select the Move to Folder option, which opens the Select a Location dialog box in which you can navigate to the folder where you want to store the formula.

3. On the new copy of the formula, modify the fields as required. For information about changing the fields of a formula, see “Modify a Formula” on page 116.

**Delete a Formula**

You can delete formulas only from the folders for which you have Write privileges.

To delete a user-defined formula, perform the following steps:

1. In the Folders tree of SAS data Integration Studio, navigate to an IT Formulas folder or a folder where the formula that you want to delete is located.

2. Right-click the formula. From the list that is displayed, select Delete.

3. In the confirmation dialog box, click Yes to delete the formula. Otherwise, click No.

   Deleting a formula does not change the expression that used the formula, and the columns that are computed using that expression are not affected. The columns will continue to be created according to the specified expression. However, when a formula that is used in an expression no longer exists, then modifications to that expression can no longer be performed simply by changing the formula. The modifications must be changed in every column where the expression is used.

**Modify a Formula**

You can change any formula to which you have Write privileges. To do so, perform the following steps:

1. Double-click the formula to open the Properties dialog box, where you can change the name, description, location, and expression of the formula.

   • Select the General tab to change the name, description, or location of the formula.

   • To change the name or description of the formula, enter your modifications in the corresponding fields.
To change the location of the formula, click **Browse** to open the Select a Location dialog box where you can navigate to another folder.

2. Select the **Expression** tab to change the combination of functions and mathematical operations that are used to derive a value.

   If you modify the expression text for a formula, then the system checks to see whether the original formula is used by any computed column of any table. If the formula is being used, an Update Formula dialog box opens that lists the computed columns that will be affected by the change. You can select **Yes** to change the formula in the computed columns that use it or **No**. If you click **Yes**, then the modified expression for the formula is saved and applied in all instances where it is used.

   *Note:* Computed columns in staged tables or aggregation tables will be calculated using the latest version of the formula.

3. Select the **Notes** tab to enter additional information about the formula.

   **CAUTION:**
   *The Advanced tab contains information about the metadata for this formula.*
   *The Authorization tab contains information about the groups, users, and permissions that are in effect for this formula. Do not change the information that is displayed on these tabs.*

4. Click **OK** to make your changes take effect.

**Consequences of Changing a Formula**

Formulas can be shared across multiple computed columns and across multiple IT data marts. For example, the SHIFT computed columns for a particular IT data mart can all be based on the same SHIFT formula. If you want to change the site-specific definition of SHIFT, you can make a change to the SHIFT formula and click **OK**. If this expression is used in any other formula, the Update Formula dialog box appears and displays the computed columns where this formula is used. Click **Yes** to cause all computed columns that use the formula to inherit the change. Otherwise, click **No**.

Computed columns in staged or aggregation tables are calculated using the latest version of the formula. In other words, if you change the expression for a computed column in a staged table or an aggregation table and redeploy the job, then the next time the job is run, the values for that column in that staged table or aggregation table will be computed according to the new expression. This computation occurs whether the expression is from a formula or only for that computed column.

**CAUTION:**
*If the expression of a computed column is changed and if that column was already used as input to a subsequent transformation that in turn created a target table, then the values in that target table are not automatically re-created.*

To make the old and new values of the computed columns consistent with each other, redeploy and rerun all the previous ETL jobs that contain the new formula, according to the following guidelines.

- Case 1: The change to the expression of a formula should be reflected in all the tables, including the aggregation tables. This situation might occur if an erroneous expression was entered and needs to be corrected. Previously aggregated data is affected and must be changed.
Solution: Purge the aggregation tables. Then redeploy and rerun all the staging jobs and all the aggregation jobs that contain the data that uses the altered expression to create a new column. Thus, you re-create the aggregation tables.

- Case 2: The change to the expression of a formula should be reflected only from this time forward. This situation might occur if there has been a change to the billing rate. Previous aggregated data is not affected.

Solution: Redeploy the staging job that uses the altered expression. You do not have to redeploy and rerun the aggregation jobs whose source tables use the altered expression to create a new column.

For example, consider the following situation:

- There is a computed column RATE in a staged table, where RATE=BYTES/SECOND (that is, RATE equals BYTES divided by SECOND).
- There is an aggregation with statistics based on that RATE column (for example, the mean RATE).
- Data for the RATE and the mean RATE columns has already been aggregated.

If you subsequently change the expression for RATE to RATE=BYTES/MINUTE, and redeploy the job, in the next ETL, the values of the staged table's RATE column will be computed according to BYTES/MINUTE. However, the values in the aggregation table that already exist (that is, they were already aggregated) will still reflect the previous BYTES/SECOND calculation. According to the guidelines in Case 1, if you want the statistics that are generated to reflect the rate change in the aggregated data, you should rerun all the associated staging and the aggregation jobs.

**Rename a Formula**

Renaming a formula does not affect the tables that use it. To rename a formula, perform the following steps:

1. In the Folders tree of SAS data Integration Studio, navigate to the IT Formulas folder where the formula that you want to rename is located.
2. Right-click the formula. From the list that is displayed, select Rename. The name of the formula is highlighted.
3. Enter the new name of the formula. The name can contain no more than 60 characters. The name must be unique within its folder.
4. Click Enter.
Chapter 7
Staging the Data

About Staging the Data .................................................. 120
  Why Stage the Data? .................................................... 120
  Methods for Staging the Data ....................................... 120

Working with Staging Transformations .......................... 121
  What is a Staging Transformation? ................................. 121
  Properties of Staging Transformations ............................ 122
  Add a Staging Transformation to a Staging Job ............... 124
  Edit a Staging Transformation ...................................... 127
  Delete a Staging Transformation ................................... 127

Working with Staged Tables ........................................ 127
  What is a Staged Table? .............................................. 127
  Properties of a Staged Table ........................................ 128
  Task List for Staged Tables ......................................... 129
  Create Staged Tables .................................................. 129
  Add an Existing Staged Table to a Job ......................... 136
  Erase a Staged Table .................................................. 136
  Delete a Staged Table from a Tree View ....................... 137
  Delete a Staged Table from a Job ................................. 137
  Purge the Content of a Staged Table ......................... 138
  Modify a Staged Table ............................................... 138
  Publish a Staged Table as Template ............................. 140

Columns in Staged Tables ........................................... 141

Computed Columns in Staged Tables ............................ 142

Staging VMware Data Using Local Time ....................... 143
  About Staging VMware Data Using Local Time ................ 143
  Change the Formula Expression for the IT Formula VMwareDatetime .... 143
  Change the Expressions for Other Datetime-related .......... 144
    Computed Columns in Your Staged Tables ..................... 144

Creating Views for MXG Tables .................................... 144

Understanding External Names of Staged Tables and Columns 144
  About External Names of Staged Tables and Columns .......... 144
  Change the External Name of a Table or a Variable .......... 145
  View the External Names of Tables .............................. 145
  View the External Names of Columns ............................ 146
  External Names for MXG Adapters ................................ 146

Insufficient Disk Space .............................................. 146
About Staging the Data

**Why Stage the Data?**

IT performance data is created and processed by unique IT systems, methods, management utilities, and code. Therefore, SAS IT Resource Management must stage the raw data that is created by these various utilities so that the IT performance data is standardized and comparable. For example, the formats for timestamps and units of measurement must be standardized, duplicate data must be processed based on business needs, and so on.

SAS IT Resource Management uses the following two components of a job to prepare and stage raw data:

- staging transformations (including user-written staging transformations)
- staged tables

*Note:* The VMware vCenter adapter uses two staging transformations (VMware Data Acquisition and VMware vCenter) to prepare and stage raw data. For information about the VMware Data Acquisition staging transformation, see “VMware vCenter Data Acquisition Jobs” on page 396.

Staging transformations generate the code that extracts raw data, transforms it to a standardized format, and loads it into staged tables. These staged tables are based on template tables that are supplied for supported adapters. For more information about template tables, see “Working with Template Tables” on page 87.

You can review the specifications of staging transformations and staged tables. You can also configure elements of the extraction and staging process to accommodate the requirements of your raw data and business environment. For more information about staging transformations, see “What is a Staging Transformation?” on page 121. For more information about staged tables, see “What is a Staged Table?” on page 127.

**Methods for Staging the Data**

To administer the staging process and specify the parameters for your environment, you must create and deploy one or more jobs that include an associated staging transformation for the adapter that you use. Staging transformations are included in staging jobs in order to create the SAS programs that stage the data and populate the staged tables. These staging jobs create SAS staged tables in the IT data mart. The SAS staged tables serve as the basis for all performance management, capacity planning data management, analysis, and reporting that you perform when using SAS IT Resource Management.

SAS IT Resource Management provides the following methods for staging IT performance data to create and populate staged tables:

- using the Adapter Setup wizard to create staging transformations and staging jobs automatically for a given adapter. When these staging transformations are executed within a job, a set of staged tables is created based on the parameters set in the Adapter Setup wizard. For more information about using the Adapter Setup wizard to stage data, see “Using the Adapter Setup Wizard” on page 211.
• creating and modifying jobs with staging transformations manually and using the Staged Table wizard to create customized staged tables. For more information about performing these tasks, see the following topics:
  • “Add a Staging Transformation to a Staging Job” on page 124
  • “Create Staged Tables” on page 129
You can also create staging transformations and staged tables to stage data from any input source based on the unique specifications of any business environment. SAS IT Resource Management provides a user-written staging transformation for user-written code. For more information about the user-written staging transformation, see “User-Written Staging Transformations” on page 265.
SAS Data Integration Studio tools such as the Process Designer can also help create the staging code and the staging job that is necessary to support any input source. For more information about using these tools to create user-written staging code, see “User-Written Staging Transformations” on page 265.

---

**Working with Staging Transformations**

**What is a Staging Transformation?**

A staging transformation generates a SAS program that loads raw data into staged tables. Before loading raw performance data into staged tables, the staging transformation performs the processing that is necessary to create a SAS program that converts the raw data into standardized, normalized values. For example, the staging transformation might perform the following functions:

• provide code that supports the input of single files, directories, or databases
• detect and handle duplicate data
• normalize measurement units
• standardize timestamps
• generate computed columns from the input data

When a staging transformation is executed by a job in SAS IT Resource Management, the SAS program accesses the parameters that are specified in the staging transformation and the metadata for the staged table that it will populate. The SAS program uses this information to populate the staged table that can be used as input to an Aggregation transformation or other transformations. Every time a staging transformation is executed, any existing data in the staged table is removed, and the new data is loaded.

You can also modify a staging transformation to include additional staged tables that are supported by a given adapter. This feature enables the system to process data from various staged tables for a given data source via the same staging transformations and aggregations. For more information about aggregations, see “Working with Aggregation Transformations” on page 197.

SAS IT Resource Management provides a unique staging transformation for each adapter that it supports. The staging transformations that are supplied for each adapter are available in the ITRM Transformations folder of the Transformations tree view of SAS IT Resource Management, as shown in the following display. (Other SAS IT Resource Management transformations are also in this list, such as Aggregation, Gallery, and Information Map.)
Properties of Staging Transformations

Staging transformations specify the staging parameters that are pertinent for the adapter on which they are based. Because raw data sources differ in format, file structure, and type of data collected, the staging parameters that are necessary for each adapter vary as well. Staging parameters enable you to indicate how you want to handle certain types of data based on your needs. For example, you can specify how to handle duplicate or future data in a raw data source. Staging parameters can also have different default values based on the adapter.

To access the staging transformation properties, right-click a staging transformation in the process flow diagram and select Properties. A Properties dialog box appears and enables you to view the staging transformation properties and specifications for the staging code that the transformation generates.
The Properties dialog box contains the following tabs:

- The **General** tab displays information that identifies the staging transformation such as name and description.

- The **Staging Parameters** tab displays the staging and duplicate-data checking parameters that are pertinent for the adapter on which the staging transformation is based. (If you specify the User-Written Staging transformation, user-written parameters are also available on the **Staging Parameters** tab.) The parameters that are available on this tab vary based on the requirements of each adapter. You can click the value field of a parameter to modify the value. If there is a defined set of values available for this parameter, a drop-down list appears and enables you to select a value. For more information about staging parameters, see "Staging Parameters" on page 400.

  *Note:* If you modify the value of any parameter in the source code of a job, that modification is not updated in the SAS Metadata Repository, and the new value is not reflected on the **Staging Parameters** tab. However, you can save the modified version of the source code to the local file system.

- The **Options** tab displays information about how to further customize and generate the code.

- The **Code** tab enables you to manage the code that is generated for the transformation.

- The **Precode and Postcode** tab enables you to specify that user-written code should be inserted at the beginning or end of the current job or transformation.

- The **Parameters** tab enables you to manage prompts or prompt groups.

- The **Notes** tab displays any notes or documents that are associated with the transformation.

- The **Extended Attributes** tab displays the custom properties that are available for the transformation.

For more information about the tabs that are available from the Properties dialog box, see the Help for SAS IT Resource Management.
Add a Staging Transformation to a Staging Job

You can use the Adapter Setup wizard to create staging jobs automatically for a supplied adapter. The Adapter Setup wizard provides a convenient way to create staging jobs as well as other jobs and the components that are necessary to stage and summarize the IT resource data that an adapter loads. The wizard guides you through the process of specifying the staging parameters. It also creates the necessary staging transformation, staging job, and other jobs that are required for the adapter that you select. For more information about using the Adapter Setup wizard, see “About the Adapter Setup Wizard” on page 209.

You can also create a staging job manually by adding a staging transformation to a job. To do so, perform the following steps:

1. Open the job that is to contain the new staging transformation. The job shows on the Diagram tab of the Job Editor window.

   Note: If you want to add a staging transformation to a new job, you must first create the job. For more information about how to create a job, see “Create a Job” on page 300.

2. In the Transformations tree of SAS IT Resource Management, expand the ITRM Transformations folder and locate the staging transformation for the adapter that you want to work with.

3. Drag and drop the staging transformation onto the Job Editor window. The staging transformation appears in the process flow diagram for the job.

   Display 7.3  Sample Job with a New Staging Transformation

4. Right-click the staging transformation and select Add New Staged Table from the Properties dialog box. You can choose to create the new staged table from one of the supplied templates or from a user-defined template.
The Staged Table wizard opens. This wizard enables you to specify the parameters for the staged tables that the staging transformation code populates. For more information about using the Staged Table wizard, see “Create Staged Tables” on page 129.

*Note:* A staging transformation can process output for multiple staged tables. To add more staged tables, repeat this step as needed.

5. Right-click the staging transformation and select **Properties**.

6. Use the **Staging** page of the **Staging Parameters** tab to specify the staging parameters for your data such as the location of the raw data, how to handle future data, and so on. You must specify all parameters that are marked with an asterisk (*) before the staging transformation is complete.

On the **Duplicate Checking** page of the **Staging Parameters** tab, you can specify how you want duplicate data to be handled.

*Note:* Select **Enable duplicate checking** to access the duplicate checking parameters associated with the adapter that you are specifying.

When the transformation is complete and ready to run in a staging job, the staging transformation object is marked with a green check in the process flow diagram.

If you are working with a user-defined adapter, use the **User-Written** page of the **Staging Parameters** tab to access the user-written parameters associated with that adapter.
For more information about the staging parameters for each adapter, see “Staging Parameters” on page 400.

Display 7.5  Sample Job with a Complete Staging Transformation and Staged Tables

Note: The location of the raw data input for the staging transformation is specified in the staging transformation properties. Thus, a staging transformation object does not have an input object in the process flow diagram. (The only exception to this rule is the VMware vCenter staging transformation that has the data acquisition table as input).

7. If you are adding an ASG TMON2CIC or IBM SMF staging transformation, you must specify the associated spin library. Use the Spin Library tab (available only for these two staging transformations) to view and modify the parameters for the corresponding spin library. For more information about setting the spin library parameters, see “Data Sources Supported by SAS IT Resource Management Adapters” on page 325.

8. Run the staging job to generate the staging code, execute the code, and load the staged tables.

   Note: You can also generate the staging code without executing it. To do so, click the Code tab of the Job Editor window. You can then select from the Code generation mode options on this tab to edit the code manually before executing it.

9. Click the Log tab of the Process Designer window to check the SAS log and confirm that there were no errors or warnings during processing.

After the staging job executes successfully, you can view the staged data in the staged tables. To do so, right-click a staged table in the process flow diagram and select Open.
**Edit a Staging Transformation**

To edit the parameters that a staging transformation uses to locate and stage raw data, perform the following steps:

1. In the **IT Data Marts** tree, double-click the job that contains the staging transformation that you want to edit.

2. Right-click the staging transformation in the process flow diagram and select **Properties**. A Properties dialog box displays and enables you to modify the various parameters that are specified for the staging transformation and the staging code that it generates.

   *Note:* The name of a staging transformation should not contain double quotation marks.

   For more information about staging transformation properties, see “Properties of Staging Transformations” on page 122.

3. Click **OK** to save your changes.

**Delete a Staging Transformation**

Deleting a staging transformation disassociates it permanently from the staged tables in the job.

**CAUTION:**

If you delete a staging transformation and then try to re-create or reconnect it to the staged tables, the staged tables might lose computed columns or experience other errors. For best results, make a copy of the staging job before deleting or modifying the staging transformation or any other components that you do not want to lose.

To delete a staging transformation from a job, perform the following steps:

1. In the **IT Data Marts** tree, double-click the job that contains the staging transformation that you want to delete.

2. Right-click the staging transformation in the process flow diagram and select **Delete**. The staging transformation object is deleted from the job. However, the staged tables that were associated with the staging transformation remain in the job.

3. Select **File → Save** to save your changes, or close the job and select **Yes** when prompted to save your changes.

---

**Working with Staged Tables**

**What is a Staged Table?**

A staged table contains data that has been extracted from an input data store by a staging transformation and has been rendered into a SAS data set that is suitable for further transformation. The structure and metadata for most staged tables that SAS IT Resource Management provides are based on corresponding template tables for specific adapters.
and domain categories. For more information about template tables, see “Working with Template Tables” on page 87.

The data in a staged table is accumulated according to rules that are specified by a staging transformation. The IT performance data resides in the staged table after the data is refined and loaded into a SAS data set that is ready for aggregation and reporting. Likewise, the staged table determines how the data appears after it has completed the staging process.

You can create a staged table by using the Adapter Setup wizard, the Staged Table wizard, or a user-written staging transformation. When a staged table is created, it is associated with a staging transformation in a staging job and stored in the same subfolder of the IT Data Marts tree as the staging job by default. This enables you to keep track of the staged tables and their corresponding jobs as they are stored together.

Note: If you manually create your own user-defined tables using one of the Designer tools of SAS Data Integration Studio, then consider saving these tables in a similar manner to maintain consistency.

When a staging job executes, the staging transformation reads the raw IT performance data from an input data source, processes it, and loads it into the corresponding staged tables. These tables can then be input into Aggregation transformations.

The staged table is generally used as input to an Aggregation transformation. However, a user can change this process flow by using the manual methods that are available in SAS IT Resource Management.

SAS IT Resource Management supplies adapters that provide staging transformations, template tables, and staged tables for many diverse data sources.

Note: The New Table wizard of SAS Data Integration Studio can create other tables that stage raw data from any other input data sources.

For information about the adapters that SAS IT Resource Management supports, see “Supported Adapters” on page 80.

Properties of a Staged Table

The metadata about a staged table, such as how raw data is computed and formed into a SAS data set structure, is available from the Properties dialog box of a staged table.

To view the properties of a staged table, complete the following steps:

1. Navigate to the folder in the IT Data Marts tree that contains the staging job and staged table.

2. Open the staging job that includes the staged table.

3. Right-click the staged table in the process flow diagram and select Properties.

Note: You can also right-click a staged table in the tree view of SAS IT Resource Management to access the staged table properties. However, the set of properties that are available when using this method differs slightly from the properties that are available from the process flow diagram. For best results when viewing and modifying relevant properties, access the properties from the staged table object in the process flow diagram as explained in the preceding steps.
The following list includes all of the staged table properties. It also indicates whether a property is available only from the staged table in the tree view or the staged table in the process flow diagram:

- The **General** tab displays information that identifies the staged table name, description, location, and associated responsibilities.

- The **Columns** tab displays the metadata for each column in the staged table. For more information about the properties that are available from the **Columns** tab of a staged table, see “Columns in Staged Tables” on page 141.

- The **Indexes** tab displays any indexes that have been created for this staged table. For each column, the name, description, length, and type are stored.

- The **Keys** tab displays any keys that have been created for this staged table. However, the values displayed on this tab are ignored by SAS IT Resource Management.

- The **Parameters** tab displays any prompts or groups that have been created for this staged table. This tab is available from the tree view only.

- The **Physical Storage** tab displays information about the physical name of the table and the library and DBMS where it is located.

- The **Options** tab displays table options such as compressing observations in a SAS data set, additional security options, and rules for overwriting data sets.

- The **Notes** tab displays any notes or documents that are associated with this staged table.

- The **Extended Attributes** tab displays information about any custom property that is not part of the standard metadata for this staged table. This tab includes any external names for a table, if available.

- The **Authorization** tab, available only from the tree view, displays the settings that define access to the staged table. This tab is available from the tree view only.

- The **ITRM Options** tab displays the adapter, template table, data model version, and predecessor tables that are associated with the staged table. This tab is available from the process flow diagram only.

For information about the contents of these tabs, click **Help** in the dialog box.

**Task List for Staged Tables**

When you right-click a staged table, you gain access to several actions that you can perform for that table such as analyze, update metadata, delete, copy, move, export, and so on. The tasks that are available differ depending on whether you right-click the staged table in the tree view or the process flow diagram. For information about these tasks, see the Help that is available for these topics in SAS IT Resource Management.

**Create Staged Tables**

SAS IT Resource Management does not enable you to create a staged table without associating it to a staging transformation. Thus, you must have a staging job that includes a staging transformation before creating a staged table.

If you want to create staged tables for the BMC Perf Mgr, DT Perf Sentry, MS SCOM, or SNMP adapters, other than the tables that are included in the staged table templates for those adapters, you can specify and then run macros to do so. These macros create...
the metadata for the staged table and attach that metadata to the staging transformation in your job.

- To create staged tables for BMC Perf Mgr, see “%RMMSBMCP” on page 511.
- To create staged tables for DT Perf Sentry, see “%RMMSDTPS” on page 513.
- To create staged tables for MS SCOM, see “%RMMSSCOM” on page 515.
- To create staged tables for SNMP, see “%RMMSSNMP” on page 518.

Note: For best results, always create or add staged tables to a job from the Staged Table wizard as described in this topic. If you copy an existing table from another IT data mart or job and move it into a different job, or if you attempt to reattach a staged table to its original staging transformation after it was removed, then you might lose valuable components of the table, such as computed columns.

To create the metadata for a staged table, perform the following steps:

1. Open a staging job that includes a staging transformation. For more information about creating a staging transformation, see “Add a Staging Transformation to a Staging Job” on page 124.

2. Right-click the staging transformation in the process flow diagram and select Add New Staged Table. Then select the type of template that you want to work with:
   - From Supplied Template
   - From User-Written Template

   The type of template that you select governs the templates that are available to you on the second page of the wizard. (A message is displayed if no user-written templates have been created.)

   The Staged Table wizard opens and prompts you to enter the information that is required to create a staged table.

3. On the first page of the wizard, you can specify an IT data mart, storage location, and formulas.
Display 7.6 Specify IT Data Mart and Formulas Page of the Staged Table Wizard

a. Confirm and specify the IT data mart and the location where the staged tables will be stored. The **IT Data Mart** and **Location** fields default to the IT data mart name and location of the current staging job. You must specify a location for the staged table that is within the IT data mart that is specified in the **IT Data Mart** field.

You can use the **Browse** option to select a different location for the staged table or to create subfolders inside the IT data mart for storing the staged tables. However, the Adapter Setup wizard creates and stores staged tables in the same folder as the staging job, so you might choose to accept the default values for consistency.

b. Specify the location for any user-written formulas that you want the Staged Table wizard to use in addition to those supplied by SAS IT Resource Management. The default location directs the Staged Table wizard to the supplied formulas. This field does not allow manual entries. Use **Browse** to navigate to the appropriate folder as needed.

The default location for the formulas folder is the **IT Formulas** folder, which is located here: `Shared Data/SAS IT Resource Management/IT Formulas`.

**Note:** If you select or create a folder location where the formulas that are required for the staged table are not found in the folder location or its subfolders, the column will not be created. The failure to create the column will be noted in the SAS log file.

4. On the second page of the wizard, you can select template tables. Based on the adapter for the staging transformation, a list of available template tables and their descriptions are displayed within domain categories of table types.
a. Use the check boxes to select the template tables that you want to use to generate staged tables. (You can click + to expand a folder or click – to collapse a folder.) If you select a folder, all of the subfolders and template tables within that folder are automatically selected and the check box displays a check (✓) next to the folder and its template tables. If you select an individual template table within a folder, but not all template tables within the given folder, then the check box for the parent folder shows a darkened box with a check (✓). This indicates that some, but not all, template tables within the folder are selected.

The **Number of selected template tables** maintains a real-time count of the template tables that you select.

**CAUTION:**

The more template tables that you select and staged tables that you add to a job, the longer it takes to create the staged tables and later run the job. If you select more than 100 template tables, then a warning message explains that creating a large number of staged tables at once can result in long processing times or processing errors.

b. Select **Include only recommended columns in the new staged tables** if you want only the recommended columns to be included in the staged tables that you are creating. Recommended columns are those that SAS IT Resource Management has predefined as critical or relevant for reporting and analysis in the performance area of the staged table. If this option is not checked, the staged tables will include all available columns.

**Note:** You can view the recommended columns in a template table from the **Columns** tab of the Properties dialog box for a given template table. For more information about how to access and view the recommended columns of a template table, see “Columns in Template Tables” on page 91.

c. Click **Next** to continue.
5. Specify the SAS library parameters for the staged tables and their staging transformation.

*Note:* This page appears only if you are creating the first staged tables for a staging transformation. If you have already created staged tables for the staging transformation, then the wizard skips this page. Library parameters are set once for a staging transformation and all staged tables for that transformation use the same library parameters. However, if all staged tables are later removed from the staging transformation and new staged tables are subsequently added, then the Specify SAS Library page is displayed again in the wizard. In this case, the staged tables in the subsequent iteration are placed in a different library from the first set of tables.

**Display 7.8 Specify SAS Library Page of the Staged Table Wizard**

a. Specify the **Name** and **Description** for the SAS library. The SAS library name must be unique within its folder in the application server. The Staged Table wizard uses the naming convention `<adapter name> + Staging <unique number>` to name SAS libraries. You can accept the default name or enter a new name for the library. However, library names must be unique within the application server.

b. Confirm that the **Server** field shows the server that is associated with the selected IT data mart where this library is to be stored. This field does not enable modifications.

c. Specify the **Libref** that is associated with the staged table library. The Staged Table wizard uses the naming convention `STG + <the same number generated for the library>` to name the libref. You can accept the default name or enter a new libref name.

*Note:* The following naming rules apply to the libref:

- The libref can consist of no more than eight characters.
- The libref must begin with a letter (A through Z) or an underscore (_).
The remaining characters of the libref must be letters (A through Z), numerals (0 through 9), or an underscore (_). The libref cannot contain spaces.

d. Specify the **Path Specification** for the location of the library and thus where the tables for this library are stored. The default value is based on the combination of the default path that is specified for the IT data mart, and the operating system of the server. The characters `stg<unique number>` are also appended to the path, where the unique number is the same as that generated for the preceding library.

For example, if the default path for an IT data mart on Windows is `C:\SAPJob1`, then the default value for a new staging library might be `C:\SAPJob1\stg27416`, as shown. If the default path for an IT data mart on UNIX is `/u/<user ID>/Sample52`, then the default value for a new staging library might be `/u/<user ID>/Sample52/stg27416`.

You can accept the default path, enter a new path, or click **Browse** to select a path.

**Note:** **Browse** is disabled when the selected application server is running on a machine using the z/OS operating system. When entering a z/OS path manually, you can use either a prefix for a traditional z/OS filesystem path (**MY .DATAMART**) or a root directory in the UFS hierarchical file system (**/u/mynname/datamart**).

e. Click **Next** to continue. The completed Staged Table wizard will create one SAS library that stores all of the tables and catalogs from the staging transformation. This includes staged tables, control tables for data duplication, and the compiled macro code for the transformation.

6. Specify the z/OS attributes that allocate file space in the operating environment if the application server is running on z/OS. The Staged Table wizard skips this page for operating environments that are not z/OS. For more information about these parameters, see the Help for SAS IT Resource Management.

7. Review the details of the staged tables and storage parameters that you entered.
If you want to change anything that you entered, click **Back** to return to the parameter that you want to change.

**Note:** You cannot change the name of a staged table because it is automatically assigned the same name as the template table on which it is modeled.

8. Click **Finish** to create the metadata for the new staged table and SAS library (if applicable). The staged tables appear in the process flow diagram for the staging job.
The staged tables in the process flow diagram show the name and the description of the staged table.

9. Select File ⇒ Save to save the changes to the job.

*Note:* The metadata for the staged tables is saved in the staging job. However, the physical staged tables are created only after the staging job is run.

---

**Add an Existing Staged Table to a Job**

SAS IT Resource Management does not enable you to create a staged table without associating it to a staging transformation. For best results, always create or add staged tables to a job from the Staged Table wizard. If you copy an existing table from another IT data mart or job, copy or move it into a different job, or attempt to reattach a staged table to its original staging transformation, then you might lose valuable components of the table, such as computed columns. For more information about using the Staged Table wizard to add a staged table to an existing job, see “Create Staged Tables” on page 129.

---

**Erase a Staged Table**

Erasing a staged table deletes the physical table, its contents, and its metadata.

**CAUTION:**

If you erase a staged table that serves as a source table in other jobs, then these associated jobs might not execute because they are missing a source table. Simply erasing a staged table does not affect the metadata of the associated aggregation or information map jobs. However, if you erase a staged table and then re-run the staging job, then the data for the deleted staged table is not created. Thus, the jobs that used that table will fail due to a missing source table.
To erase a staged table, perform the following steps:

1. In a tree view of SAS IT Resource Management, locate the staged table that you want to erase.
2. Right-click the staged table that you want to erase and select **Erase**. The staging job that includes the staged table must be closed and currently not in use before erasing.
3. In the confirmation dialog box, click **Yes** to erase the staged table. The staged table disappears from the tree view and the process flow diagram for the job.

**Delete a Staged Table from a Tree View**

Deleting a staged table from the tree view in SAS IT Resource Management removes the metadata object. This action does not delete the physical data set or the library that is associated with the staged table.

**CAUTION:**

If you delete a staged table that serves as a source table in other jobs, then these associated jobs might not execute because they are missing a source table. Simply deleting a staged table does not affect the metadata of the associated aggregation or information map jobs. However, if you delete a staged table and then re-run the staging job, then the data for the deleted staged table is not created. Thus, the jobs that used that deleted table will fail due to a missing source table.

To delete a staged table from a folder in a tree view of SAS IT Resource Management, perform the following steps:

1. In a tree view of SAS IT Resource Management, locate the staged table that you want to delete.
2. Right-click the staged table that you want to delete. The staging job that includes the staged table must be closed and currently not in use before deleting.
3. Select **Delete**.
4. In the confirmation dialog box, click **Yes** to delete the staged table. The staged table disappears from the tree view and the process flow diagram for the job.

**Note:** If you modify or delete a physical table without using the process described in this topic, the metadata for the table will not be updated.

**Delete a Staged Table from a Job**

Deleting a staged table from a job removes it from the job so that it is no longer associated with the transformation in the job. This action removes the staged table from the job but does not delete the table's metadata, the physical table, or the library that is associated with the staged table.

**CAUTION:**

If you delete a staged table that serves as a source table in other jobs, then these associated jobs might not execute because they are missing a source table. Simply deleting a staged table from a job does not affect the metadata of the associated aggregation or information map jobs. However, if you delete a staged table and then re-run the job, then the data for the deleted staged table is not created. Thus, the jobs that used the deleted staged table (or any existing tables that used the deleted staged table) will fail due to a missing source table.
To delete a staged table from a job, perform the following steps:

1. In the **IT Data Marts** tree view of SAS IT Resource Management, locate the job that includes the staged table that you want to delete.
2. Double-click the job to open it on the **Diagram** tab of the Job Editor window.
3. Right-click the staged table object in the process flow diagram and select **Delete**. The staged table is no longer visible in the process flow diagram of the job.

### Purge the Content of a Staged Table

To purge the contents of a staged table while keeping the physical table and its metadata intact, perform the following steps:

1. In the **IT Data Marts** tree view of SAS IT Resource Management, locate the job that includes the staged table that you want to purge.
2. Double-click the job to open it on the **Diagram** tab of the Job Editor window.
3. Right-click the staged table object in the process flow diagram and select **Purge**.
4. In the confirmation dialog box, click **Yes** to purge the staged table.

### Modify a Staged Table

To modify a staged table, navigate to and open the job that contains the staged table that you want to modify.

**CAUTION:**

*For best results, always modify staged tables from the process flow diagram.* If you access a staged table's Properties dialog box by opening a staged table from a tree view in SAS IT Resource Management, then you might not see all modification options that are available for a staged table.

Perform the following steps:

1. In the process flow diagram of the job, right-click the staged table that you want to modify.
2. Select **Properties** to open the Properties dialog box.
3. On the **General** tab, you can change the name and description of the table.
4. On the **Columns** tab, you can modify an existing table by adding a new column or a computed column to the staged table.

**Add a New Data Column to the Staged Table**

a. Select **New ⇒ Data Column**. A new line is added to the grid.

b. Click the corresponding cells in the new grid line to enter the name (must be unique), description, type, length, informat, and format for the new data column.

*Note:* The **Expression** cell is not available because the new column is a data column and not a computed column.

**Add a New Computed Column to the Staged Table**

a. Select **New ⇒ Computed Column**. A new line is added to the grid.

b. In the new grid line, enter the name (must be unique), expression, description, type, length, informat, and format for the new data column.
Note: You can use a SAS macro in a formula expression or in the expression for a computed column. The SAS macro definition needs to be available to the SAS session that executes the staging or aggregation job that populates the computed column. For example, you might need to add a new autocall library using the SASAUTOS SAS option in the SAS configuration.

Import a Column from Another Table into the Staged Table

a. Click to open the Import Columns dialog box.

b. In the Available columns list, navigate to the table that contains the column that you want to import.

Note: "User" is a reserved word in SQL and should not be the name of any imported column.

c. Highlight the column that you want to import.

Note: Data and computed columns from other SAS IT Resource Management staged and aggregation tables can be imported, as well as columns from supplied template tables.

d. Click the right arrow to transfer the column into the Selected columns list.

e. Click OK when you are satisfied with your list of selected columns to import. The new columns appear in the grid.

Note: After you import the column, you must run the staging job before you can view the data in the new column. When the staging job runs, the data is propagated to the physical table and is available for viewing.

Modify the Properties of a Column in the Staged Table

a. Locate the column that you want to modify and double-click the cell that you want to change.
b. Enter the new name (must be unique), expression, description, type, length, informat, or format value for the column. The Expression cell is not available for data columns. The External Name cell is not applicable for all columns.

*Note:* You can also use the icons in the top row of the Columns tab to manage, move, and modify additional properties of each column of the staged table. For more information about using these features, click Help on the Columns tab.

**Delete a Column in the Staged Table**

a. Locate the column that you want to delete and right-click the column name.

b. Select Delete. The column is immediately removed from the grid and no confirmation message is displayed.

*Note:* If you delete an instanced variable from a staged table, then the staging code might not run successfully later.

5. On the other properties tabs (Indexes, Keys, Physical Storage, Options, Notes, Extended Attributes, and ITRM Options), you can view additional properties for the staged table. For more information about the parameters on these tabs, click Help on each tab.

*Note:* The values displayed on the Keys tab are ignored by SAS IT Resource Management.

6. When you are finished, click OK to save your changes.

**Publish a Staged Table as Template**

To publish a staged table as a template, perform the following steps:

1. Locate the staging transformation that generates the staged table that you want to publish as a template. To do so, from the IT Data Marts tree, navigate to the IT data mart that contains the job where the staging transformation is located. Double-click the job to open it on the Diagram tab of the Job Editor window.

2. Right-click the staged table that you want to publish.

3. From the drop-down list, select Publish. The Publish as User Defined Template - Staged dialog box appears.

4. The Name field contains the name of the table that you want to publish.

   (Optional) Enter a name and a description, that is more meaningful to you.

5. In the Location field, accept the default location or click Browse. This action opens the Select a Location dialog box where you can navigate to another location. Select the location that you want to use and click OK.

   *Note:* The Location field must be the default location or a location that is underneath it.

6. Click OK to create the template.

7. Save the job.

In order for your changes take effect, you must redeploy the job. For information about redeploying jobs, see “Redeploy All Jobs on the Server” on page 314.
Columns in Staged Tables

The **Columns** tab is available from the Properties dialog box of a staged table. It enables you to view the specific column metadata for the table. You can use this information to view the types of data that the staged table includes and understand how computed columns are formulated.

The following list describes the information that you can view for each column in a staged table. Each row on the **Columns** tab shows the metadata for a single column of the staged table.

**Note:** To access the Properties dialog box and **Columns** tab of a staged table, you can right-click a staged table in the tree view or in the process flow diagram. However, the properties that are available differ with each method. For best results, access the properties from the staged table object in the process flow diagram.

- **#** specifies the column's ordinal position in the grid on the **Columns** tab.
- **Name** specifies the name of the column in the staged table. The name of a computed column can exceed eight characters.
- **Expression** specifies the combination of functions and mathematical operations that are used to derive a value for the column. The field is blank unless the column is a computed column. For more information about computed columns in staged tables, see “Computed Columns in Staged Tables” on page 142.
  
  This field is available only when opening the Properties dialog box from the process flow diagram.
- **Description** provides a description of the data that populates the column. The description provides more information about the type of data that the column includes.
  
  The column descriptions in staged tables are used as labels in information maps and aggregations.

  - **Type** specifies the data type of the column. Valid types are **Character** and **Numeric**. You can also identify column types by looking at the Name variable. A round icon to the left of the name indicates that the column is numeric. A pyramid icon to the left of the name indicates that the column contains character data.

  - **Length** specifies the maximum character length of the data in the column.

  - **Informat** specifies the SAS informat that is used (if needed) to read values for the selected column. Informats are required for reading fixed-width data.

  - **Format** specifies the SAS format that is used to write values for the selected column. If the staged table column was instantiated from a template table, the format is in NLS format when applicable. NLS formats are indicated by NL as the first two characters in the format column. For more information about NLS formatting, see “National Language Support (NLS)” on page 12.
External Name

specifies the name of the corresponding field in the raw data that is used to populate this column. External names are the means by which the staging code maps columns in a staged table to their corresponding variables in the raw data. Not all columns in a staged or template table have a predetermined external name. A value is optional in this field for these columns. However, if the column is associated with an adapter that uses external names, do not change an external name that is provided. For more information about external names, see “Understanding External Names of Staged Tables and Columns” on page 144.

Note: This field is available only when opening the Properties dialog box from the process flow diagram.

Is Nullable

indicates whether a column can contain null or missing values.

This field is available only when opening the Properties dialog box from the tree view.

Summary Role

indicates the intended role of the column in summary data.

This field is available only when opening the Properties dialog box from the tree view.

Sort Order

defines how the values in the column are sorted, such as ascending or descending.

This field is available only when opening the Properties dialog box from the tree view.

Note: The Data Column, Computed Column, or Import Columns options might be disabled if you used the up or down arrows to change the sort order of the columns. To re-enable these options, click the # icon that appears in the grid of columns.

Computed Columns in Staged Tables

Computed columns in a table contain data values that are derived from other columns in the table. Staged tables contain computed columns for data that is not directly provided by the raw data source. Instead, the computed columns might be useful for reporting or promoting consistency across various data sources. For example, a data source normally has a datetime stamp and from that datetime stamp, SAS IT Resource Management might provide a computed column that calculates weeks or months.

Note: A computed column should not be used as a source of calculations for other computed columns. Using a computed column as a source for a computation can be problematic because the order of computing the values for the computed column is not guaranteed.

To find a computed column in a staged table and view the formula that it uses, right-click the staged table in a process flow diagram and select Properties. Then, open the Columns tab of the staged table's Properties dialog box. This method is the only way to view the Expression column.

Note: If you open a table from a folder view or from the IT Data Marts view, and select the Columns tab, the columns of the table are displayed. However, the expressions that are associated with the columns are not displayed.
All computed columns contain a formula or expression in the **Expression** column of the grid.

**Note:** You can use a SAS macro in a formula expression or in the expression for a computed column. The SAS macro definition needs to be available to the SAS session that executes the staging or aggregation job that populates the computed column. For example, you might need to add a new autocall library using the SASAUTOS SAS option in the SAS configuration.

You can double-click an expression to modify it for the column. To open the Expression Builder, click the ellipsis button in the cell. For information about how to work with the Expression Builder, click **Help** in the Expression Builder window.

**Note:** Aggregation tables also use computed columns. You can use the computed columns that are provided for these tables and you can create your own. For more information about creating and using computed columns, see “Specify Computed Columns” on page 179.

---

**Staging VMware Data Using Local Time**

**About Staging VMware Data Using Local Time**

All datetime stamps are stored in Coordinated Universal Time (UTC) or Greenwich Mean Time (GMT) in the VMware vCenter database. However, you can convert the datetime-related values in your staged tables (and thus in your IT data mart) to use local time instead of UTC or GMT.

**Note:** The following procedures apply only to the data processed by the VMware vCenter adapter.

To change the datetime-related values in your IT data mart from UTC to local time, perform the following steps:

1. Change the formula expression for the IT Formula VMwareDatetime.
2. Change the expressions for other datetime-related computed columns in your staged tables. To do so, change the computed column expression from `<datetime-related variableName> + 0` to `<datetime-related variableName> + GMT offset`.

**Change the Formula Expression for the IT Formula VMwareDatetime**

To change the values for the DATETIME column in your VMware staged tables from UTC to local time, modify the expression for the IT Formula, VMwareDatetme, by adding the GMT offset to the formula expression.

By changing the expression for the VMwareDatetme IT Formula, the datetime value adjustments will be made during staging for the DATETIME column in all VMware staged tables. For example, to adjust the DATETIME variable from UTC to Eastern Daylight Time in your staged tables, change the expression for the VMwareDatetme IT Formula from `DATETIME + 0;` to `DATETIME - 14400;`. 
Change the Expressions for Other Datetime-related Computed Columns in Your Staged Tables

To change the other datetime-related values in your staged tables from UTC to local time, change the expressions for those datetime-related computed columns in your staged tables. To do so, change the computed column expression from `<datetime-related variableName> + 0` to `<datetime-related variableName> + GMT offset`. For example, to adjust the CREATETIME variable in the Events staged table from UTC to Eastern Daylight Time during staging, change the computed column expression from `CREATETIME + 0;` to `CREATETIME - 14400;`.

Note: If you modify any one of the datetime-related columns to be adjusted with a GMT offset, then all of the datetime-related columns in your staged tables should be adjusted with the same GMT offset.

The following list shows the datetime-related values that can be changed for each type of VMware staged table:

- All VMware staged tables - DATETIME variable
- EVENTS staged table - CREATETIME
- TASKS staged table - QUEUETIME, STARTTIME, COMPLETETIME

Creating Views for MXG Tables

Staging transformations for adapters that are supported by MXG create additional tables that are MXG views for each of the staged tables that are targets of the transformation. The views enable you to use the staged tables because you can use the names of tables and columns as MXG traditionally names them. Thus, views provide compatibility with any of your existing programs that might use MXG tables. These tables are identified in the metadata by the prefix `MXG_Staged_`.

By default, the views are stored in the same library as the staged tables that are associated with the views.

The MXG views are defined or updated in metadata each time an MXG staging transformation is saved, if there are eligible tables supported by MXG that are associated with it. When the job is executed, the physical views are created or re-created.

Understanding External Names of Staged Tables and Columns

About External Names of Staged Tables and Columns

Staged tables and the columns in a staged table can each have an external name. These external names are the means by which the staging code maps the SAS IT Resource Management staged tables and columns to the tables and variables in the raw data. For example, a staged table that is named NTPHDSK in SAS IT Resource Management has an external name of PhysicalDisk. The staging code uses this information to determine
that the PhysicalDisk data in the raw data file belongs in the NTPHDSK staged table. The same is true for columns and the external names for their corresponding variables.

*Note:* The SAR adapter is the only supported adapter that does not require external names.

You can view the external names that are associated with a staged table and its columns from the Properties dialog box of the staged table.

**CAUTION:**

*For best results, do not modify the external names of a staged table or column that is associated with an adapter that uses external names.* Changing the external names that are associated with adapters that use external names can cause errors when the raw data is staged. The staging code for these adapters relies on external names to associate the raw data file with the appropriate staged tables and columns. However, you can modify the external names of staged tables and columns that are associated with the SAR adapter, because this adapter does not use external names. The SAR adapter ignores the values for external names, so there is no danger of corrupting the staging metadata.

### Change the External Name of a Table or a Variable

**CAUTION:**

*Do not change the external name that is prepopulated for a staged table or variable unless instructed to do so by a SAS representative.* You should change a table external name or variable external name only if the data source has changed the table or variable name that is output in the raw data, and if the SAS IT Resource Management table or variable external name has not been updated to reflect that change.

For most adapters, SAS IT Resource Management uses the external names in order to map the tables and variables in the raw data to the SAS IT Resource Management table and column names. For example, previous versions of the Demand Technologies Performance Sentry collector wrote an object to the log file as `SQLServer-Locks`. However, in later versions, this object name changed to `SQLServer:Locks`. In order to process data for the new object, the external name value for the SAS IT Resource Management table NTSLCKS should be changed from `SQLServer-Locks` to `SQLServer:Locks`. In the preceding example, the mapping could not take place and the updated table or variable could not be processed.

If you expect to process log files that will contain only the new table or variable external names, then you can resolve the situation by opening the table properties and replacing the existing table or variable external name with the new table or variable external name. (This is a rare situation and you should change external names only when this particular condition occurs.)

### View the External Names of Tables

To view the external name for a staged table, perform the following steps:

1. Right-click a staged table in the tree view or in a process flow diagram.
2. Click **Properties** to open the Properties dialog box.
3. Select the **Extended Attributes** tab. The **ExternalName** field shows the external name that is assigned to the staged table.
Note: Do not change the external name for a staged table unless instructed to do so by a SAS representative.

View the External Names of Columns

To view the external name for a column in a staged table, perform the following steps:

1. Right-click a staged table in the process flow diagram.
2. Click Properties to open the Properties dialog box.
3. Select the Columns tab. The External Name field provides the external names of the variables that are associated with the columns in a staged table. Not all columns have an external name that is predetermined. You can add a value in the External Name field for these columns.

Note: Do not change an external name that is prepopulated for a column unless instructed to do so by a SAS representative.

External Names for MXG Adapters

For MXG adapters, the external table name is the name of the SAS data set that MXG creates. The external column names are the variable names that MXG uses within those data sets. There is no benefit to changing the external names of the tables or columns for MXG adapters.

CAUTION: Do not change the external names of the columns or the tables for MXG adapters. If you do change these external names, your data could be corrupted and errors could occur in the processing of that data.

For more information about working with MXG data and adapters, see “Data Sources Supported by SAS IT Resource Management Adapters” on page 325.

Insufficient Disk Space

If there is not enough disk space to run a staging job, then the job fails and a message indicates that there was a failure writing to the disk. If this occurs, then point the failing SAS library to an alternate path that has more space available or delete unwanted files on that disk. Then, rerun the staging job.
Chapter 8
Aggregating the Data

Overview of the Aggregation Transformation ........................................ 148
About Aggregation Tables ................................................................. 149
  What Is an Aggregation Table? ....................................................... 149
  How Is the Metadata for an Aggregation Table Created? ................. 151
  How Is the Physical Aggregation Table Generated? ......................... 152
  What Are the Properties of an Aggregation Table? ......................... 153
Preparing to Create an Aggregation Table ........................................ 160
  Set Up the Aggregation Transformation in the Process Flow Diagram .... 160
Creating an Aggregation Table with the Simple Aggregation Table Wizard . 161
Creating Aggregation Tables with the Summarized Aggregation Table Wizard 163
  How to Enter General Information about the Aggregation Table .......... 163
  How to Specify Library Information .............................................. 163
  How to Select a Filter and Enable Data Duplication Checking .......... 164
  Specify Aging Columns .............................................................. 165
  Specify Class and ID Columns .................................................... 166
  Specify Statistics Columns ........................................................ 168
  Specify Percentiles Columns ...................................................... 171
  Specify Percent Change Columns ............................................... 172
  Specify Moving Statistic Columns .............................................. 174
  Specify Ranking Columns ........................................................ 175
  Specify Join Columns .............................................................. 177
  Specify Computed Columns ...................................................... 179
  How to Complete the Specification of the Summarized Aggregation Table 183
Creating Aggregation Tables with the Aggregation through the Template Wizard . 183
Cloning an Aggregation Table .......................................................... 185
Adding a New Column to an Aggregation Table .................................. 187
Deleting an Aggregation Table ......................................................... 189
  Delete an Aggregation Table from an Aggregation Transformation ...... 189
  Delete an Aggregation Table from the IT Data Mart ......................... 189
  Erase an Aggregation Table ...................................................... 190
Editing or Modifying an Aggregation Table ........................................ 190
Publishing an Aggregation Table as Template ................................... 192
Purging Contents of an Aggregation Table ......................................... 192
  Purge Data from an Aggregation Table from the Process Flow Diagram 192
  Purge Data from an Aggregation Table on the IT Data Mart Tab ....... 193
Overview of the Aggregation Transformation

The Aggregation transformation provides a graphical user interface for the purpose of accumulating data. The Aggregation transformation is invoked from within a job. Right-clicking the transformation provides access to its properties and to various other functions such as creating an aggregation table by means of aggregation wizards.

SAS IT Resource Management supports two types of aggregation tables:

- Summarized aggregation tables:
  Summarized aggregation tables consist of data from the source table that is summarized in accordance with the rules that are specified in the Aggregation transformation. Summarized aggregation tables also include statistics, percentiles, moving statistics, and more that are calculated and stored for the categories of data that you specify. By means of the summarized aggregation wizard, the Aggregation transformation enables you to do the following:
  - specify the name, table name and description of the table
  - define filters to limit the input data
  - specify if and how the data should be aged
  - assign source columns as class or ID columns
  - define statistics and percentiles
  - calculate the percent change for statistic, and percentile columns
  - define moving statistics
  - generate ranks on all columns or across specified class columns
• define join columns
• generate computed columns
• modify column labels and formats

• Simple aggregation tables:
  Simple aggregation tables consist of data from the source table that is simply appended to the target table. Like summarized aggregations, simple aggregations support aging, join columns, and computed columns. Simple aggregations are analogous to the detail tables of the performance data warehouse (PDB) in SAS IT Resource Management 2.7.

---

### About Aggregation Tables

**What Is an Aggregation Table?**

Aggregation tables contain data that is collected and accumulated according to rules that are defined to an Aggregation transformation. These rules pertain to columns from the source table and are used to classify, organize, and calculate columns such as statistics, percentiles, and moving statistics about IT data. The target table that is produced by an Aggregation transformation is used for further data management, analysis, or report processes.

With SAS IT Resource Management, you can perform the following actions:

• generate a simple or a summarized aggregation table
  
  To generate a summarized or simple aggregation table, you must first set up the Aggregation transformation. For information about setting up the Aggregation transformation, see “Preparing to Create an Aggregation Table” on page 160.

  You can then invoke one of the three wizards that will enable you to specify the aggregation table.
For information about creating simple aggregation tables, see “Creating an Aggregation Table with the Simple Aggregation Table Wizard” on page 161.

For information about creating a summarized aggregation table, see “Creating Aggregation Tables with the Summarized Aggregation Table Wizard” on page 163.

For information about creating an aggregation table using a template, see “Creating Aggregation Tables with the Aggregation through the Template Wizard” on page 183.

- add a column to an aggregation table
- clone an aggregation table
- create a view of a simple aggregation table for an adapter that is supported by MXG
- delete an aggregation table
- edit (or modify) an aggregation table
- publish an aggregation table as a template
- purge an aggregation table
- rename an aggregation table
How Is the Metadata for an Aggregation Table Created?

Methods for Creating Metadata for an Aggregation Table
The metadata for an aggregation table can be created in three ways:

- automatically, by means of the Adapter Setup wizard
- directly, by invoking one of the three aggregation wizards from an Aggregation transformation
  - Summarized Aggregation Table wizard
  - Simple Aggregation Table wizard
  - Aggregations through Template wizard

Creating Metadata with the Adapter Setup Wizard
Using the Adapter Setup wizard, you can specify the adapter, domain category, and time periods for which you want to generate reports. The Adapter Setup wizard creates the metadata for the appropriate Staging and Aggregation transformations, according to your specifications.

To invoke the wizard, from the menu bar, select **New ➔ IT Resource Management ➔ Adapter Setup**.

*Note:* The Adapter Setup wizard prompts for other input, such as the IT data mart where the job is to be stored, the location of the formulas that should be used when creating computed columns, and information about where the reports are to be stored. For more information about the Adapter Setup wizard and the other objects that it creates, see “About the Adapter Setup Wizard” on page 209.

The following display shows the Disk Aggregation job that was generated by the Adapter Setup wizard for the SAR adapter. It contains a SAR Disk Aggregation transformation that specifies the creation of five aggregation tables.

**Display 8.2  SAR Disk Job That Generates Multiple Aggregation Tables**

*Note:* The Adapter Setup wizard can generate multiple aggregation tables from a single Aggregation transformation.
Creating Metadata with the Aggregation Wizard

To create an aggregation table with an aggregation wizard from an Aggregation transformation, you must first open a job in the Diagram tab of the Job Editor window. Then drag and drop the Aggregation transformation onto the process flow diagram. For information about how to perform these steps, see “Set Up the Aggregation Transformation in the Process Flow Diagram” on page 160.

To invoke an aggregation wizard, right-click the Aggregation transformation and select Add Aggregation Table from the drop-down list. You can then choose to create one of the following wizards:

- Summarized Aggregation Table
- Simple Aggregation Table
- Aggregations through Template

Note: From this option, you can choose to create an aggregation table from either a supplied table template or a user-defined table template.

Respond to the prompts of the selected wizard in order to specify how the aggregation table is to be generated. When the wizard is successfully completed, the metadata for the aggregation table is generated and stored in the folder of the IT data mart in which the job resides.) The Diagram tab of the Job Editor window is updated to display the job that, when run, generates the aggregation table that you specified.

The following display shows a job called MyJob that was generated by directly invoking the Summarized Aggregation Table wizard. It contains an Aggregation transformation that is specified to create a single aggregation table.

Display 8.3  Table Generated by the Summarized Aggregation Table Wizard

Note: An aggregation wizard that is directly invoked can generate only one aggregation table for each invocation of the wizard. However, you can invoke the wizard multiple times on the same Aggregation transformation, each time generating another aggregation table.

How Is the Physical Aggregation Table Generated?

Aggregation transformations are contained in jobs that generate physical aggregation tables when the jobs are successfully run. For information about how to run a job immediately, see “Running Jobs” on page 305. For information about how to deploy a job for batch scheduling, see “Run a Job Immediately” on page 305.
What Are the Properties of an Aggregation Table?

CAUTION:
Except for defining an index, do not make changes to an aggregation table from the Properties dialog box. For all changes other than index definition, use the Edit wizard to make changes to an aggregation table.

To open the Properties dialog box of an aggregation table, right-click the aggregation table in the process flow diagram. The following menu appears:

From the drop-down menu that is displayed, select Properties.

The following display shows the Property dialog box for the DayDisk aggregation table, which was displayed by right-clicking the DayDisk aggregation table image on the
process flow diagram. (The metadata for this table is one of many tables that are generated by the Disk Aggregation transformation of the SAR adapter.)

**Display 8.4 Properties for the DayDisk Aggregation Table**

Note: Unlike other SAS Data Integration Studio transformations, there is no Mapping tab. The aggregation wizards manage this function.

The Properties dialog box consists of the following tabs:

- The **General** tab contains the identifying information about the table. The fields on this tab can be modified.

The following display shows the **General** tab of an aggregation table.

For items in the preceding display, the following definitions apply.

**Name**

Identifies the name of the aggregation table.
Description

describes the aggregation table.

Location

specifies the location of the aggregation table in the metadata folder hierarchy. Click **Browse** to select a path to the table from the Select a Location dialog box that displays the metadata directory structure.

- The **Columns** tab contains a grid that provides information about each column of the table. For each aggregation table, the aggregation wizards supply the following three columns:
  - **ContribCount** is a numeric column in summarized aggregation tables. The value of ContribCount is the number of input observations (rows of data) that were used in computing this summarized row of data.
  - **LastUpdated** is the system datetime of when this row of data was last updated. This column is in simple and summarized aggregation tables.
  - **CompleteDay** is a single character, set to 'Y', 'N', or blank. If the Completed Day processing is not enabled, it is always set to blank. If the Completed Day processing is enabled, this column is set to 'Y' if the value of DATETIME indicates that this row of data represents a completed day. Otherwise, this column is set to 'N', which indicates an incomplete day. A day is considered complete if any input row of data has a time portion of the datetime value that is greater than the specified cutoff time.

The following display shows the **Columns** tab of an aggregation table.

**Display 8.5  Columns Tab of an Aggregation Table (partial listing)**

<table>
<thead>
<tr>
<th>#</th>
<th>Name</th>
<th>Expression</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TimePeriod</td>
<td>DAYDATE</td>
<td>TimePeriod</td>
<td>Name</td>
</tr>
<tr>
<td>2</td>
<td>CompleteDay</td>
<td>CompleteDay</td>
<td>CompleteDay</td>
<td>Char</td>
</tr>
<tr>
<td>3</td>
<td>LastUpdated</td>
<td>LastUpdated</td>
<td>LastUpdated</td>
<td>Name</td>
</tr>
<tr>
<td>4</td>
<td>ContribCount</td>
<td>ContribCount</td>
<td>ContribCount</td>
<td>Name</td>
</tr>
<tr>
<td>5</td>
<td>DATETIME</td>
<td>DATETIME</td>
<td>DATETIME</td>
<td>Name</td>
</tr>
<tr>
<td>6</td>
<td>DEVICE</td>
<td>DEVICE</td>
<td>DEVICE</td>
<td>Char</td>
</tr>
<tr>
<td>7</td>
<td>MACHINE</td>
<td>MACHINE</td>
<td>MACHINE</td>
<td>Char</td>
</tr>
<tr>
<td>8</td>
<td>OS</td>
<td>OS</td>
<td>OS</td>
<td>Char</td>
</tr>
<tr>
<td>9</td>
<td>WEEDATE</td>
<td>WEEDATE</td>
<td>WEEDATE</td>
<td>Name</td>
</tr>
<tr>
<td>10</td>
<td>DAYOFWEEK</td>
<td>DAYOFWEEK</td>
<td>DAYOFWEEK</td>
<td>Name</td>
</tr>
<tr>
<td>11</td>
<td>MONTHDATE</td>
<td>MonthDates</td>
<td>MonthDates</td>
<td>Name</td>
</tr>
<tr>
<td>12</td>
<td>MOYMONTH</td>
<td>DayOfMonth</td>
<td>DayOfMonth</td>
<td>Name</td>
</tr>
<tr>
<td>13</td>
<td>AVGQERRMAX</td>
<td>StdQerrAngAvgMax</td>
<td>AvgQerrMax</td>
<td>Name</td>
</tr>
<tr>
<td>14</td>
<td>AVGQERRMAXN</td>
<td>StdQerrAngAvgMaxn</td>
<td>AvgQerrMaxN</td>
<td>Name</td>
</tr>
<tr>
<td>15</td>
<td>AVGQERRMAXM</td>
<td>StdQerrAngAvgMaxm</td>
<td>AvgQerrMaxM</td>
<td>Name</td>
</tr>
<tr>
<td>16</td>
<td>AVGQERRMAXP</td>
<td>StdQerrAngAvgMaxp</td>
<td>AvgQerrMaxP</td>
<td>Name</td>
</tr>
<tr>
<td>17</td>
<td>AVGQERRMAXS</td>
<td>StdQerrAngAvgMaxs</td>
<td>AvgQerrMaxS</td>
<td>Name</td>
</tr>
<tr>
<td>18</td>
<td>AVGQERRMIN</td>
<td>StdQerrAngAvgMin</td>
<td>AvgQerrMin</td>
<td>Name</td>
</tr>
<tr>
<td>19</td>
<td>AVGQERRMINN</td>
<td>StdQerrAngAvgMinn</td>
<td>AvgQerrMinN</td>
<td>Name</td>
</tr>
<tr>
<td>20</td>
<td>AVGQERRMINM</td>
<td>StdQerrAngAvgMinm</td>
<td>AvgQerrMinM</td>
<td>Name</td>
</tr>
<tr>
<td>21</td>
<td>AVGQERRMINP</td>
<td>StdQerrAngAvgMinp</td>
<td>AvgQerrMinP</td>
<td>Name</td>
</tr>
<tr>
<td>22</td>
<td>AVGQERRMINS</td>
<td>StdQerrAngAvgMins</td>
<td>AvgQerrMinS</td>
<td>Name</td>
</tr>
</tbody>
</table>

For items in the preceding display, the following definitions apply.

# specifies the column's ordinal position in the grid on the **Columns** tab.
Name
 specifies the name of the column.

If the Key icon ❇️ appears next to the name, then that column is used as a primary, unique, or foreign key.

Expression
 specifies the combination of functions and mathematical operations that are used to derive a value for the column. This field is blank unless the column is a computed column.

Description
 describes the column.

Type
 specifies the data type of the column. Valid types are character and numeric. You can also identify column types by looking at the Name column. A round icon to the left of the name indicates that the column is numeric. A pyramid ▲ icon to the left of the name indicates that the column contains character data.

Length
 specifies the length of the column. The length of numeric columns is from 2 through 8. The length of character columns is from 1 through 32,767.

Informat
 specifies the SAS informat that is used (if needed) to read values for the selected column. Informats are not used by the Aggregation transformation.

Format
 specifies the SAS format that is used to write or display values for the selected column.

Summary Role
 specifies the type of the column. It is not used by SAS IT Resource Management.

CAUTION:
The New, Import, and Delete buttons at the top of the grid should not be used. The preferred method of adding, deleting, or modifying a column is to do so from the appropriate aggregation wizard. Using the wizard ensures that the metadata is properly updated.

• The Indexes tab contains a list of the columns (and their descriptions, types, and lengths) that can be selected to use as indexes. Indexes can improve queries that use the aggregation table.
The following display shows the **Indexes** tab of an aggregation table.

**Display 8.6  Indexes Tab of an Aggregation Table**

For more information about indexes, see “Indexing an Aggregation Table” on page 194.

- The **Keys** tab is not used by SAS IT Resource Management, and its values are ignored.
- The **Physical Storage** tab contains information about where the table is stored.

The following display shows the **Physical Storage** tab of an aggregation table.

**Display 8.7  Physical Storage Tab of an Aggregation Table**

For items in the preceding display, the following definitions apply.

**Physical name**

specifies the name of the physical table. The name must follow the rules for table names in the DBMS that is selected in the DBMS field. For example, if SAS is the selected DBMS, the name must follow the rules for SAS data sets. If you
select another DBMS, the name must follow the rules for tables in that DBMS. Note the check boxes for DBMS names below.

*Note:* SAS IT Resource Management does not use this field.

**Enable case-sensitive DBMS object names**
specifies whether case-sensitive names for tables and columns are to be supported in the metadata for the current table. If the check box is deselected, no support is provided. If the check box is selected, support is provided.

*Note:* Do not select or modify this field.

**Enable special characters within DBMS object names**
specifies whether special characters in names for tables and columns are to be supported in the metadata for the current table.

*Note:* Do not select or modify this field.

**Create as view**
is valid only if the table is specified as an output in a SAS IT Resource Management job. If this option is selected, the table will be created as a view, if that is possible. If it is not possible to create a view, a physical table will be created even when the Create as view option is selected. Deselect this option to specify that the table should be created as physical table instead of a view.

*Note:* SAS IT Resource Management does not use this field.

**Library**
specifies a library that can be used to access the table. To create a new library, click New, which opens the New Library wizard. To edit the properties of the existing library, click Properties, which opens the properties window for the data library.

**DBMS**
displays the database management system (DBMS) format of the library that is selected in the Library field.

*Note:* Do not select or modify this field.

**Schema**
is for DBMS software other than SAS. It specifies the database schema that is associated with the table that is specified in the Name field.

*Note:* Do not select or modify this field.

- The Notes tab contains areas where you can annotate the table.
- The Extended Attributes tab contains a custom property that is not part of the metadata for the table.
The following display shows the **Extended Attributes** tab of an aggregation table.

**Display 8.8  Extended Attributes Tab of an Aggregation Table**

For items in the preceding display, the following definitions apply.

- **Star** adds a row to the attribute table. A number and a default name are provided, but you must enter the value and description.
- **X** deletes a selected attribute from the list.
- **Up** If present, enables you to reorder rows by moving a selected row up in the table.
- **Down** if present, enables you to reorder rows by moving a selected row down in the table.
- **#** specifies the number of the extended attribute.
- **Field Name** specifies the attribute name to be defined.
- **Value** specifies the value for the attribute that is specified in the **Field Name** column.
- **Description** describes the attribute and value.

**CAUTION:**

Do not delete or modify the AgeLimit field from the Extended Attributes tab. In addition, do not delete the Filter from the Extended Attributes tab. Modifying or deleting these fields can cause processing errors.
Preparing to Create an Aggregation Table

Set Up the Aggregation Transformation in the Process Flow Diagram

To create an aggregation table, you must first set up the Aggregation transformation in a job and then invoke one of the aggregation wizards. To set up the necessary Aggregation transformation, perform the following steps:

1. Locate the job that you want to contain this Aggregation transformation. From the IT Data Marts tree, navigate to the IT data mart and folder that contains the job that you want to use. Double-click the job to open it on the Diagram tab of the Job Editor window.

   If you want to create a new job, see “Jobs That Process IT Data” on page 295.

2. Navigate to the Transformations tree and expand ITRM Transformations.

3. Drag and drop the Aggregation transformation onto the process flow diagram.

   Note: A job can contain multiple Aggregation transformations.

4. Drag and drop a source table onto the process flow diagram and using the cursor, connect the table to the left side of the aggregation image.

   Note: The source table is usually a staged table that was created by a SAS IT Resource Management staging transformation, but it can be any SAS table.

5. Right-click the aggregation image and, from the drop-down menu that is displayed, select Add Aggregation Table.

6. Select the type of aggregation table that you want to create. (If you click Cancel on any page of an aggregation wizard, a confirmation dialog box is displayed. If you do not want to cancel, click No.)

   - Select Simple Aggregation Table to invoke the Simple Aggregation Table wizard. For information about using this wizard, see “Creating an Aggregation Table with the Simple Aggregation Table Wizard” on page 161.

   - Select Summarized Aggregation Table to invoke the Summarized Aggregation Table wizard. For information about using this wizard, see “Creating Aggregation Tables with the Summarized Aggregation Table Wizard” on page 163.

   - Select Aggregations through Template to invoke the Aggregations through Template wizard. This wizard enables you to choose one of the following template sources:

     - From Supplied Template
     - From User Defined Template

   For information about using this wizard, see “Creating Aggregation Tables with the Aggregation through the Template Wizard” on page 183.

Note: You can create multiple summarized aggregation tables. The aggregation wizard provides a unique suffix for each table that is created.
Creating an Aggregation Table with the Simple Aggregation Table Wizard

To create an aggregation table with the Simple Aggregation Table wizard, respond to the wizard's prompts.

1. To enter general information about the table, see “How to Enter General Information about the Aggregation Table” on page 163.

2. If this aggregation table is the first target table that is specified for this Aggregation transformation, an additional page of the wizard opens. This page prompts you for the physical target location and for information about the SAS library where the data will be stored. For information about specifying a library, see “How to Specify Library Information” on page 163.

3. Filters can limit the amount of data that is input to an aggregation table. On the page of the wizard that is called Select filter and enable data duplication checking, you can specify a filter and specify that data duplication checking will be performed. For information, see “How to Select a Filter and Enable Data Duplication Checking” on page 164.

4. On the Specify aging page, you can specify aging and purging criteria. For information, see “Specify Aging Columns” on page 165.

5. On the Specify target columns page, you can specify the columns from the source table that are to be included in the target aggregation table. To select columns for the target table, highlight the columns in the Available source columns panel and then click the right arrow to move those columns into the Selected source columns.
You can select the entire list of available source columns by clicking the double right arrow. Back arrows can be used to deselect one, several, or all columns.

If aging is to be performed for this simple aggregation table, then the selected aging column is automatically added to this list. It cannot be deleted while it is still in use as the aging column.

6. On the Specify column details page, you can modify the Target Column Name and Target Column Label fields for any of the source columns that you are including in the target aggregation table. To do so, enter the new value in the field.

   To modify the Target Column Format, double-click in the field and select the new format from the drop-down list.

7. On the Specify join columns page, you can specify columns from other aggregation tables in this Aggregation transformation to join with columns in this target table. For information, see “Specify Join Columns” on page 177.

   Note: The Specify join columns page is available from the Simple Aggregation Table wizard only if there are columns from separate target tables that are eligible for joining.

8. On the Specify computed columns page, you can create, modify, or delete computed columns.

   For information about how to add, modify, or delete computed columns, see “Specify Computed Columns” on page 179.

9. The final page of the wizard displays the details for the simple aggregation table that you specified. If you are satisfied with your choices, click Finish. Click OK to return to the process flow diagram.
Creating Aggregation Tables with the Summarized Aggregation Table Wizard

To create an aggregation table (that is, the target table) with the Summarized Aggregation Table wizard, respond to the wizard's prompts. Whenever you have completed your specifications for the aggregation table and want to skip the remaining pages of the wizard, click Finish (if that button is enabled). This action updates the Aggregation transformation with this new aggregation table and returns you to the process flow diagram. For information, see “How to Complete the Specification of the Summarized Aggregation Table” on page 183.

How to Enter General Information about the Aggregation Table

To specify general information about the aggregation table, perform the following steps:

1. Enter the name of the table in the Name field. This field can contain up to 60 characters. It must be unique within the metadata folder. It must also be unique among all other table names within the application server. A value is required in this field.

   Note: The name of this aggregation table will be displayed on subsequent pages of the wizard.

2. (Optional) Enter the identifying information in the Description field. This field can contain up to 200 characters.

3. (Optional) In the SAS table name field, you can accept the default value, or enter the physical name of the aggregation table.

4. The IT data mart contains the job in which the Aggregation transformation is located. (It cannot be changed.)

5. (Optional) In the Location field, you can accept the default value, or enter the metadata path to the metadata folder where the job that contains the Aggregation transformation is stored.

   CAUTION: Use only English characters when entering textual information in the fields of the wizard. Non-English characters can cause processing errors.

How to Specify Library Information

If this aggregation table is the first target table that is specified for this Aggregation transformation, an additional page of the wizard opens. This page prompts you for the physical target location and for information about the SAS library where the data will be stored. When this page opens, the following fields are already specified with default values. If you want to modify these fields, perform the following steps:

1. In the Name field, enter the name of the library that contains all aggregation tables that are associated with the Aggregation transformation that you are working with. This field can contain up to 60 characters. A value is required in this field.

2. In the Description field, enter the information that describes the library. It can contain no more than 200 characters. It is an optional field.
3. In the **Server** field, enter the application server that you specified for the IT data mart that you are working with. The default application server is the SASITRM server. A value is required in this field.

At installation time, SAS IT Resource Management establishes a SAS Application Server named SASITRM that sets properties such as memory size options and formats for the exclusive use of the solution. Establishing SASITRM as the SAS Application Server ensures that the SAS IT Resource Management solution can be installed and operated with other SAS products and solutions, some of which may also establish SAS Application Servers.

*Note:* For information about SAS Application Servers, see *SAS® 9.3 Intelligence Platform: Application Server Administration Guide.*

4. In the **Libref** field, enter the name that is temporarily associated with the library. The libref or an aggregation library is a concatenation of AGG and a random number (for example, `AGG27040`). A value is required in this field. The libref name must be unique within the application server.

*Note:* The following naming rules apply to the libref:

- The libref can consist of no more than eight characters.
- The libref must begin with a letter (A through Z) or an underscore (_).
- The remaining characters of the libref must be letters (A through Z), numerals (0 through 9), or an underscore (_). The libref cannot contain spaces.

5. In the **Path specification** field, enter the location where the tables for this library are to be stored. You must specify a location for the tables that is within the IT data mart that is specified in the **IT Data Mart** field.

Enter this field manually or click **Browse** to select a location from the Select a Directory dialog box that displays the directory structure on the server's file system. A value is required in this field.

---

**How to Select a Filter and Enable Data Duplication Checking**

Filters can limit the amount of data that is input to an aggregation table. To select a filter and a column for data-duplication checking, perform the following steps:

1. From the drop-down list in the **Select filter** field, select the filter that you want to use. The selected filter is displayed in the **Select filter** field and its corresponding expression is displayed in the **Expression** field.

2. The **Expression** field displays the formula that defines the filter. It cannot be changed from this location. For information about how to modify the expression field of a filter, see “Modify a Filter of an Aggregation Transformation” on page 204.

If you want to create a new filter to use for your aggregation table, perform the following steps:

1. Click the **Add New** button to open the Add Filter dialog box.

2. In the **Name** field, enter the name of the new filter. The name field can contain no more than 60 characters.

3. In the **Expression** field, enter the formula.

4. Click **OK**.
Note: For more information about how to work with filters, see “Working with Aggregation Transformation Filters” on page 201.

Select the Enable data duplication checking box to indicate that you want to aggregate only data items from the source table that have a value for LSTPDATE that is greater than the last date that the aggregation job ran.

Note: The LSTPDATE column represents the last date and time that data was staged. This option is available if LSTPDATE is found in the source table for the aggregation. (The default value for this option is deselected.)

Specify Aging Columns

Managing Your Data: Aging and Purging Options

SAS IT Resource Management provides several ways of managing the amount of data that is kept in the aggregation tables of your IT data mart. You can apply the aging and purging functions to both simple and summarized aggregations. The selection of the aging and purging attributes for a simple or a summarized aggregation table can be performed on the Specify aging page of the wizard.

- Purge target table before loading new data
  Purging the data from the target table before the new data is loaded.

- Perform aging for target table
  You can specify whether and how you want to age your data when you create the Aggregation table.

  By entering a value for the Age limit in days, you are specifying the age range that data will be present in the table. The minimum number of days is 1; the maximum number of days is 9999.

  Note: Columns that are used for aging are DATETIME columns. For these columns, one day of aging extends over 24 hours of data collection, which might extend over one or more days.

  You are not specifying that the data is to be aged out after that number of days. Instead, the value that you specify is the number of days of data that you want to keep. Calculate what is aged out by subtracting the value of the Age limit in days from the latest date of the new or existing data. The resulting date is the date before which data will age out. For example, in the following figure, Day 9 is the latest date of the data and the Age limit in days is seven.

  Display 8.10 Example of How Data Is Aged Out

<table>
<thead>
<tr>
<th>Day 1</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
<th>Day 7</th>
<th>Day 8</th>
<th>Day 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>No data was loaded</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>No data was loaded</td>
<td>Data</td>
</tr>
</tbody>
</table>

Data is aged out. Data is kept.

All data from Day 2 and earlier is aged out. All data from Day 3 through Day 9 is kept. However, because no data was loaded on Day 4 and Day 8, only five days of data is kept, namely the data for Day 3, Day 5, Day 6, Day 7, and Day 9.

Note: If you reduce the aging value, the change takes effect the next time the job is run, even if there is no new data.
**How to Specify Purging Criteria**

To purge the target table before you load new data, check the corresponding check box. This action removes the data that was processed in previous executions of the job.

**How to Specify Aging Criteria**

You can specify whether and how you want to age your data when you define the aggregation target table. Based on these specifications, data will be kept in the aggregation table or aged out of it. To specify aging criteria for the target table, perform the following steps:

1. To perform aging for the target table, check the corresponding check box. This action enables you to select the column to be used for aging and to specify the format of that column.
   - The **Column** field displays a list of the columns from the source table that are available to use for aging the data. From the drop-down list, select the column that you want to use. It is displayed in the **Column** field. The format of the selected field is displayed.
     
     **Note:** If you want to specify percent change or moving statistic columns, you must select an aging column. SAS IT Resource Management uses that aging column in order to calculate the period-to-period changes for that column. The selected aging column is automatically added to the list of class columns for a summarized aggregation table.
   - The **Date** or **Datetime** option is automatically selected, based on the contents of the column that you selected for aging. Changing this option is permissible, but it is not recommended.
     
     **Note:** Specify the option that reflects the type of column that you chose. For DATE values, the aging counts by days. For DATETIME values, the aging counts by the number of seconds in a day.

2. Use the spinner to select the number of days age limit.

3. To specify the completed day, check the corresponding check box. This action enables you to select the column to use to determine whether a day is complete. (This option is enabled if aging has been specified for this aggregation table and the source table has a column called DATETIME.)

   This feature is useful only for tables where the aging column represents a DAY or less. For example, this feature is not useful for WEEKDATE aggregations.

   **Note:** If the **Apply completed day** option is deselected on an existing aggregation table that previously selected that option, the rank columns of that table are analyzed. If they depend on Completed Day being selected, a message is displayed that lists the rank columns that would be affected. The deselection of the Completed Day option is not permitted.

4. Use the **Cut off time** field to specify when a day is completed. Use the spinners to specify the hours, minutes, and whether the time is a.m. or p.m.

**Specify Class and ID Columns**

**About Specifying Class and ID Columns**

On the Specify class and ID columns page, you can specify the columns from the source table that are to be included in the target aggregation table as class columns and as ID columns.
A class column is used to group or classify data. For example, the value of a class column could be a device address.

At least one column must be selected as a class column.

Note: If aging is specified for this target aggregation table, then the aging column is automatically added to the list of class columns. The aging column cannot be deleted from the list of class columns. If aging is turned off, the column can be removed from the list of class columns.

An identification (ID) column contains an alternate identifier for the data in a class column. For example, the value of the corresponding ID column could be the name of a particular device.

The value that is assigned to the ID column is the last value that is read into the group that is defined by the unique combination of class columns.

ID columns are not required.

Note: If an input column is given a role as a class column, ID column, or a statistic, it cannot simultaneously be assigned a different role. Therefore, it will not be available for selection. If all available columns are assigned as class or ID columns, then no columns will be available to be used as statistic, percentile, percent change, moving statistics, or rank columns. In that case, the wizard will not display the pages that enable you to specify those columns.

**How to Specify Class and ID Columns**

To specify class or ID columns, click **New** to open the **Add New Class and ID Columns** window.

- To select class columns for the target aggregation, highlight the columns in the **Available columns** panel that you want to select as class columns. Then click the right arrow to move those columns into the **Selected class columns**.

- To select ID columns for the target table, highlight the columns in the **Available columns** panel that you want to select as ID columns. Then click the right arrow to move those columns into the **Selected ID columns**.

You can select the entire list of available columns by clicking the double right arrow. Back arrows can be used to deselect one, several, or all columns.

**T I P** After your data has been aggregated, you can change the class list. If you remove columns from the class list, the existing data in the summarized aggregation table is merged again so that it matches the new class list. If you add new columns to the class list, these new columns in the summarized aggregation table will have a missing value (for numeric) or blank value (for character) in the existing data.

Note: You cannot remove a class or ID column if it is used to satisfy a join column in another aggregation table. Similarly, you cannot remove a class or ID column if it is used as the source column of a rank column in this aggregation table.

**How to Modify the Fields of a Class or ID Column**

After the class and ID columns have been selected, you can modify the name, label, and format for any of the input columns that you are including in the target aggregation table.

- To modify the **Target Column Name** and **Target Column Label**, enter the new value in the field that you want to change. The **Target Column Name** can be any legal SAS column name. However, it must be unique within its table.
• To modify the **Target Column Format**, double-click in the field and select the new format from the drop-down list.

**Specify Statistics Columns**

**About Specifying Statistics**
On the Specify statistics page, you can calculate or delete one or more statistics on analysis columns that you selected on the previous page. These columns are displayed in a grid format, which contains a row for each analysis column. The grid contains the following columns: **Analysis Column and Statistics**, **Weight By**, **Target Column Name**, **Target Column Description**, and **Target Column Format**. Except for the **Analysis Column and Statistics** column, which displays the names of the selected analysis and statistics columns, the columns of the grid are blank until the statistic is specified.

*Note:* For the list of statistics that SAS IT Resource Management enables you to create, see “Statistics” on page 555.

**How to Create Statistics for an Analysis Column**
To create statistics for an analysis column, perform the following steps:

1. Click **New**, which opens the Add New Statistics window.

2. In the **Select analysis variables** panel, check the box next to the analysis column for which you want to specify statistics. (Checking multiple analysis columns enables you to specify the same statistics for all the analysis columns that you selected. Otherwise, check an analysis column and specify the statistics for it individually.)

3. To specify unweighted statistics, in the **Statistic Types** panel, check the statistics that you want to create. The counter that is next to **All Selected Statistics** displays the number of statistics that you selected.

4. To specify weighted statistics, in the **Weighted Statistic Types** panel, select the column that you want to use from the Weighted by drop-down list. Then check the weighted statistics that you want to create.

5. In the following display, Count, Geometric Mean, Weighted Geometric Mean, and Weighted Mean statistics for the DATETIMEONEMIN analysis column are to be created.
6. Click **OK** to add the requested and any underlying statistics to the grid under the analysis column. The row displays these statistics along with its attributes, such as **Weight By**, **Target Column Name**, **Target Column Description**, and **Target Column Format**. These fields contain the default values that are associated with the statistics. To modify a field on this grid, highlight it, and change it as needed by entering the revision in the field.

7. The following display shows the newly added Count, Geometric Mean, Weighted Geometric Mean, and Weighted Mean statistics that will be generated for the DATETIMEONEMIN analysis column.
How to Modify a Statistic Column
You can modify only the **Target Column Name**, **Target Column Description**, and **Target Column Format** fields on the grid. (The **Weight By** column cannot be modified.)

To modify a field, enter the revision into the field. The **Target Column Name** can be any legal SAS column name. However, it must be unique within its table.

*Note:* For best results, do not change the **Target Column Format** column. If you do change it, make sure that the value that you enter in the **Target Column Format** is a valid SAS format.

How to Delete a Statistic Column
To delete a statistic column from the list of statistic columns that will be created for an analysis column, perform the following steps:

1. Select the statistic. (Deleting a statistic column that uses another (underlying) statistic column does not delete that underlying statistic column.)

2. Click *Delete*.

*Note:* If the column that you want to delete is used to calculate another column in this table or a join column in another table, a dialog box displays where the column is used. You must remove those columns before you can delete this column.

How to Delete Multiple Statistics Columns
In some instances, you might want to delete multiple columns at the same time. For example, you might want to delete all of the statistic columns for a particular analysis...
column, or only some of them. You can delete all of the statistic columns for a particular analysis column by either selecting all the statistic columns individually, or by selecting the analysis column itself. Either action will accomplish the same purpose.

However, if your selection of columns to delete includes an analysis column and some, but not all, of the statistic columns for that analysis column, a message is displayed. The message states that you selected conflicting choices and that no columns will be deleted. The message advises you to select either an analysis column or one or more statistics columns.

Specify Percentiles Columns

About Specifying Percentiles
Percentile measurements in SAS IT Resource Management enable IT organizations to quantify and analyze utilization, availability, performance, and capacity characteristics of IT infrastructure components. These measurements can be compared with other components or other time periods in the infrastructure so that IT organizations can prioritize and resolve current day and potential problems.

Note: Jobs that calculate percentile columns might require longer processing times because the data might have to be read multiple times. For best results, minimize the number of percentile columns that you specify.

On the Specify percentiles page, you can request that multiple percentiles be generated for an input metric. Percentile information is displayed in a grid format, which contains a row for each percentile that is being calculated. The grid contains the following columns: Input Column and Percentiles, Round To, Target Column Name, Target Column Description, and Target Column Format.

Note: Each requested percentile for a given analysis column must use the same precision of granularity, that is, it must specify the same rounding. If you specify a different precision of granularity for the same analysis column, a message is displayed indicating that the granularity will be changed to that of the first analysis column.

How to Create Percentiles for an Analysis Column
To create percentiles for an analysis column, perform the following steps:

1. Click New, which opens the Add New Percentiles window.

2. In the Select variables panel, check the box next to the analysis column for which you want to specify percentiles. (Checking multiple analysis columns enables you to specify the same percentiles for all the analysis columns that you selected. Otherwise, check an analysis column and specify the percentile characteristics for it individually.)

3. In the Requested percentile field, enter the numeric value of the percentile that you want to calculate. This value will apply to all the columns that you checked. The percentile must be greater than or equal to zero and less than or equal to 100.

   Note: The zero percentile would be the same as the MINIMUM statistic, rounded to the granularity that is requested for the percentile. The 100th percentile would be the same as the MAXIMUM statistic, rounded to the granularity that is requested for the percentile.

4. In the Round to nearest field, enter the numeric value of the precision of granularity that you want to calculate. This value will apply to all the columns that you checked.
5. Click **OK** to add the requested percentiles to the grid. The row displays these percentiles along with their attributes, such as **Round To**, **Target Column Name**, **Target Column Description**, and **Target Column Format**.

**How to Modify a Percentile Column**

You can modify only the **Target Column Name**, **Target Column Description**, and **Target Column Format** fields on the grid. (The **Round To** column cannot be modified.)

To modify a field, enter the revision into the field. The **Target Column Name** can be any legal SAS column name. However, it must be unique within its table.

*Note:* For best results, do not change the **Target Column Format** column. If you do change it, make sure that the value that you enter in the **Target Column Format** is a valid SAS format.

**How to Delete a Percentile Column**

To delete a percentile column from the list of columns that will be created for an analysis column, perform the following steps:

1. On the grid, select the percentile.
2. Click **Delete**.

*Note:* If the column that you want to delete is used to calculate another column in this table or a join column in another table, a dialog box displays where the column is used. You must remove those columns before you can delete this column.

**How to Delete Multiple Percentile Columns**

In some instances, you might want to delete multiple columns at the same time. For example, you might want to delete all of the percentile columns for a particular analysis column, or only some of them. You can delete all of the columns for a particular analysis column by either selecting all the columns individually, or by selecting the analysis column itself. Either action will accomplish the same purpose.

However, if your selection of columns to delete includes an analysis column and some, but not all, of the percentile columns for that analysis column, a message is displayed. The message states that you selected conflicting choices and that no columns will be deleted. The message advises you to select either an analysis column or one or more percentile columns.

**Specify Percent Change Columns**

**About Specifying Percent Change**

You can calculate the percent change of a resource’s given statistic or percentile in specified time periods and compare the results from one time period to another. This enables you to see the percent change of the statistic or percentile column for a resource in one time period and compare it to the same statistic or percentile for this same resource in another time period. The percent change metric is useful for capacity planning.

Percent change information is displayed in a grid format, which contains a row for each statistic that is being calculated. The grid contains the following columns: **Statistic and Percentile**, **Weight By**, **Input Column**, **Target Column Name**, **Target Column Description**, and **Target Column Format**.
If you want to specify percent change for a column, you must have selected an aging column. SAS IT Resource Management uses that aging column in order to calculate the period-to-period changes for that column.

All statistics, percentiles, percent change, moving statistics, ranks, and computed columns are recomputed each time the aggregation transformation is executed.

**How to Specify Percent Change for a Statistics or Percentile Column**

To calculate the percent change for a statistic or percentile, perform the following steps:

1. Click **New**, which opens the Add New Percent Change Columns window.
2. From the list under **Select columns**, select the statistics and percentile columns for which you want to calculate the percentage of change. Use the arrow to transfer those statistics to the **Selected columns**.
3. Click **OK**. The selected columns are added to the Percent Change grid, and you are returned to the Specify Percent Change page.

**How to Modify a Percent Change Column**

You can modify only the **Target Column Name**, **Target Column Description**, and **Target Column Format** fields on the grid. (The **Weight By** cannot be modified.)

To modify a field, enter the revision into the field. The **Target Column Name** can be any legal SAS column name. However, it must be unique within its table.

**Note:** For best results, do not change the **Target Column Format** column. If you do change it, make sure that the value that you enter in the **Target Column Format** is a valid SAS format.

**How to Delete a Percent Change Column**

To remove the calculation of percent change for a statistics or percentile column, perform the following steps:

1. On the percent change grid, select the statistics or percentile column.
2. Click **Delete**.

**Note:** If the column is used to calculate another column in this table or a join column in another table, a dialog box is opened that displays where the column is used. You must remove those columns before you can delete the percent change column.

**How to Delete Multiple Percent Change Columns**

In some instances, you might want to delete multiple columns at the same time. For example, you might want to delete all of the percent change columns for a particular analysis column, or only some of them. You can delete all of the columns for a particular analysis column by either selecting all the columns individually, or by selecting the analysis column itself. Either action will accomplish the same purpose.

However, if your selection of columns to delete includes an analysis column and some, but not all, of the percent change columns for that analysis column, a message is displayed. The message states that you selected conflicting choices and that no columns will be deleted. The message advises you to select either an analysis column or one or more percent change columns.
Specify Moving Statistic Columns

About Specifying Moving Statistics
Moving statistics enable IT organizations to identify and establish baseline and threshold measurements for the many performance measurements that they want to measure. This statistic can also be used to monitor characteristics of the SAS IT Resource Management system. For example, it can help monitor the growth in the number of systems for which data is analyzed, or the volume of reports created by each SAS IT Resource Management report job (if measures on those items are retained and managed using SAS IT Resource Management).

On the Specify moving statistic page, you can request that multiple moving statistics be generated for a statistic or a percentile. (Moving statistics cannot be created directly on an input column.) The following types of moving statistics can be created:

Moving Average
- an arithmetic mean computed on a subset (typically the N-most recent points) of data instead of the entire population of data. Moving averages are used to smooth out short-term fluctuations, and highlight longer-term trends.

Moving Standard Deviation
- a standard deviation computed on a subset (typically the N-most recent points) of data instead of the entire population of data.

All moving statistics are recomputed each time the aggregation transformation is executed.

Moving statistic information is displayed in a grid format, which contains a row for each moving statistic that is being calculated. The grid contains the following columns: Statistic and Percentile, Input Column, Number of Periods, Moving Statistic Type, Target Column Name, Target Column Description, and Target Column Format.

How to Create Moving Statistics for a Statistic or Percentile Column
To create moving statistics for a statistic or percentile column, perform the following steps:

1. Click New, which opens the Add New Moving Statistic Columns window.

2. In the Select columns panel, check the box next to the statistic or percentile column for which you want to specify moving statistics. (Checking multiple statistic or percentile columns enables you to specify the same moving statistics for all the columns that you selected. Otherwise, check a statistic or percentile column and specify the moving statistics and its characteristics individually.)

3. Check the Moving Average box if you want to create a moving average for each of the selected columns. Moving averages will be created for all the columns that you checked.

4. Check the Moving Standard Deviation box if you want to create a moving standard deviation for each of the selected columns. Moving standard deviations will be created for all the columns that you checked.

5. In the Number of periods field, enter the number of periods for which you want to calculate the selected moving statistic. This value will apply to all the columns that you checked.
6. Click **OK** to add the requested moving statistics to the grid. The row displays these moving statistics along with their attributes, such as **Round To**, **Target Column Name**, **Target Column Description**, and **Target Column Format**.

   **Note:** If more than one moving statistic is specified for the same column, a number is appended to the **Target Column Name**. This number is incremented by one for every new moving average that is specified for a column. For example, if you specified a moving average column of name CPUBusyPct\_MA, then if another moving average column is requested for CPUBusyPct, then by default it should be called CPUBusyPct\_MA1.

**How to Modify a Moving Statistics Column**

You can modify only the **Target Column Name**, **Target Column Description**, and **Target Column Format** fields on the grid. (The **Round To** column cannot be modified.)

To modify a field, enter the revision into the field. The **Target Column Name** can be any legal SAS column name. However, it must be unique within its table.

**Note:** For best results, do not change the **Target Column Format** column. If you do change it, make sure that the value that you enter in the **Target Column Format** is a valid SAS format.

**How to Delete a Moving Statistics Column**

To delete a moving statistics column from the list of columns that will be created for an analysis column, perform the following steps:

1. On the grid, select the moving statistics column.
2. Click **Delete**.

   **Note:** If the column that you want to delete is used to calculate another column in this table or a join column in another table, a dialog box displays where the column is used. You must remove those columns before you can delete this column.

**How to Delete Multiple Moving Statistics Columns**

In some instances, you might want to delete multiple columns at the same time. For example, you might want to delete all of the moving statistics columns for a particular analysis column, or only some of them. You can delete all of the columns for a particular analysis column by either selecting all the columns individually, or by selecting the analysis column itself. Either action will accomplish the same purpose.

However, if your selection of columns to delete includes an analysis column and some, but not all, of the moving statistics columns for that analysis column, a message is displayed. The message states that you selected conflicting choices and that no columns will be deleted. The message advises you to select either an analysis column or one or more moving statistics columns.

**Specify Ranking Columns**

**About Ranking**

You can specify ranking for class, ID, statistics, percentiles, percent change, and moving statistics columns. The ranking of data determines the position of the value of a column or a value within a selected group of class columns. You can specify that ranks be
computed on class columns, ID columns, or statistical columns. Only numeric columns can be ranked.

SAS IT Resource Management computes a dense rank, which means that the rank numbers are sequentially numbered, without gaps. The ranks start with 1 and are incremented by 1. Ties receive the same rank. For more information about ranking, see “The RANK Procedure” chapter in the Base SAS Procedures Guide.

Ranks are computed before the calculation of computed columns so that ranks can be used in the calculation of a computed column.

On the Specify ranking page, you can specify the columns that you want to rank and how these columns should be ranked. You can also delete a rank column. Rank columns are displayed in a grid format, which contains a row for each defined rank column. The grid contains the following columns: Rank Columns, Target Column Name, Target Column Description, Rank Grouping, and Completed Days, which are all initially blank until you add a ranking specification for a column.

Note: Jobs that calculate rank columns might require longer processing times because the data might have to be read multiple times. For best results, minimize the number of rank columns that you specify.

How to Specify Ranking for a Column
To specify ranking for a column, perform the following steps:

1. Click New to open the Add New Rank window.

2. To rank columns over all the data, click the corresponding option. (The list of columns with this option includes numeric class and ID columns that you selected from the source table as well as the statistics, percentile, percent change, and moving statistics columns that you specified on the previous page.)

   Then, under Select columns to rank, check the columns that you want to rank.

3. Alternatively, to rank columns over specific class columns, click the corresponding option. (The list of columns with this option includes only the statistics columns that you specified on the previous page.) In the Rank over the following class columns box, check the class columns over which you want to rank selected columns.

   Then, in the Select columns to rank column, check the columns that you want to rank.

Note: You can select any class columns over which to rank the selected statistic. However, you should leave at least one class column deselected. The class columns that are not selected are the columns over which the statistic is to be ranked. For example, you might have an aggregation table of average CPU Utilization, and the class columns are DAYDATE, DOMAIN, and MACHINE. If you request a descending rank of Average CPU Utilization using a Rank Grouping of DAYDATE and DOMAIN, then that request would result in a ranking of Average CPU utilization for all machines within the DOMAIN for the given DAYDATE. Thus, the observation where the rank value is 1 would be the machine with the highest average CPU utilization, ranked separately for each unique DOMAIN and DAYDATE combination. Alternatively, if you request a descending rank of Average CPU Utilization using a Rank Grouping of DAYDATE, DOMAIN, and MACHINE, then that request would result in a ranking of Average CPU utilization for a single row of data, which is not a useful ranking.

4. In the Rank Order box, click Ascending or Descending.
**Note:** In a descending rank, the largest value gets a rank of 1, with the next largest value getting a rank of 2, and so on. In an ascending rank, the smallest value gets a rank of 1, and the next smallest value gets a rank of 2, and so on.

5. To rank only completed days, check the corresponding box.

**Note:** This option is available only if the **Apply completed days** option was selected on the Specify aging page of this wizard. Furthermore, if a rank is defined to have completed days, then you cannot disable the **Apply completed days** option, and you cannot disable aging.

6. Click **OK** to add the rank to the list of rank columns.

**How to Modify a Rank Column**
You can modify only the **Target Column Name** and **Target Column Description** fields on the grid. (The **Rank Column**, **Rank Grouping**, and **Completed Day** columns cannot be modified.)

To modify a field, enter the revision into the field. The **Target Column Name** can be any legal SAS column name. However, it must be unique within its table.

**How to Delete a Rank Column**
To delete a rank column, perform the following steps:

1. Select the column that you want to delete.

2. Click **Delete**.

You cannot delete a rank column if it is used as the source for a join column in another aggregation table. You must first delete the join column from the other table before deleting the rank column.

**CAUTION:**

Rank columns are often used as filters in information maps. If you remove a rank column that is used as a filter in an information map, then the information map, the information map job, and the report jobs that depend on that filter might fail to run. To avoid processing errors, delete any reference to a deleted rank column in any information map, report, or transformation that uses that column.

**How to Delete Multiple Rank Columns**
In some instances, you might want to delete multiple columns at the same time. For example, you might want to delete all of the rank columns for a particular analysis column, or only some of them. You can delete all of the columns for a particular analysis column by either selecting all the columns individually, or by selecting the analysis column itself. Either action will accomplish the same purpose.

However, if your selection of columns to delete includes an analysis column and some, but not all, of the rank columns for that analysis column, a message is displayed. The message states that you selected conflicting choices and that no columns will be deleted. The message advises you to select either an analysis column or one or more moving statistics columns.

**Specify Join Columns**

**About Join Columns**
The following rules govern the join function:
• Simple aggregations cannot serve as the source of a join column.

• Only ID, statistic, percentile, percent change, moving statistics, and rank columns can be joined from a summarized aggregation.

• A simple aggregation (the destination) can join columns from a summarized aggregation (the source) if and only if every class column in the source table exists as a column in the destination table.

• A summarized aggregation can join columns from another summarized aggregation if and only if the complete class list of the source table is a proper subset of the union of class and ID list of the destination table.

Note: Jobs that include joined columns might require lengthy processing time. For best results, minimize the number of joined columns that you specify.

Information about join columns is displayed in a grid format, which contains a row for each column that is to be joined. The grid contains the following columns: Source Columns, Target Column Name, Target Column Description, and Target Column Format. The entries in the grid are initially blank.

On the Specify join columns page, you can specify columns from other aggregation tables in this Aggregation transformation to join with columns in this target table.

CAUTION:
If you changed the list of class columns for an aggregation table, you might have made the join invalid. This case would break the fourth rule of the rules that govern a join.

**How to Specify Join Columns**
To add a join column from an existing table to the table that you are specifying, perform the following steps:


2. Select columns from the list in the Available Columns. Use the arrow to transfer those columns to the Selected Columns panel and click OK. The selected columns are entered automatically into the appropriate cells of the grid, along with their corresponding default values for Target Column Name, Target Column Description, and Target Column Format.

Note: By default, the first character of the name of the resulting join column (the Target Column Name) is the first letter of the aging column of the source table. So the join column default name would be: <first character of aging column of source table>_ <column name from source table>.

**How to Modify a Join Column**
You can modify only the Target Column Name, Target Column Description, and Target Column Format fields on the grid.

To modify a field, enter the revision into the field. The Target Column Name can be any legal SAS column name. However, it must be unique within its table.

Note: For best results, do not change the Target Column Format column. If you do change it, make sure that the value that you enter in the Target Column Format is a valid SAS format.

**How to Remove Join Columns**
To delete join columns, perform the following steps:

1. Highlight the join column in the grid of columns to be joined.
2. Click **Delete**.

### How to Delete Multiple Join Columns

In some instances, you might want to delete multiple columns at the same time. For example, you might want to delete all of the join columns from a particular table, or only some of them. You can delete all of the columns for a particular table by either selecting all the columns individually, or by selecting the table itself. Either action will accomplish the same purpose.

However, if your selection of columns to delete includes a source table and some, but not all, of the join columns for that table, a message is displayed. The message states that you selected conflicting choices and that no columns will be deleted. The message advises you to select either a source table or one or more join columns.

### Specify Computed Columns

#### About Computed Columns

A computed column stores the results of computational tasks. For example, a computed column can be used to convert unit measurements so that all the data uses the same standardized units of measurement. You can add, modify, or delete computed columns on the Add or modify computed columns page that is available in the Summarized Aggregation Table wizard or the Simple Aggregation Table wizard. By default, a computed column is numeric.

**Note:** If you change a computed column, the values for the computed column are recalculated for that column in all rows of the data when the job is executed. (This recalculation is performed even if no new data is added to the aggregation table.)

The Specify computed columns page displays a grid that shows the following fields for each computed column: **Name**, **Expression**, **Description**, **Length**, **Type**, **Informat**, and **Format**.

**TIP** A computed column called **TimePeriod** is automatically added to every simple and summarized aggregation table. Its value is always the same as the aging column, and you can refer to **TimePeriod** instead of referring to the aging column directly. This technique simplifies reporting, especially in those instances where you do not know the name of the aging column. (If no aging is specified for the target table, then the field is set to missing.) The expression for this column is defined when the aggregation wizard is completed. For example, if the aging column of an aggregation table is **DAYDATE**, the expression for the TimePeriod computed column is **TIMEPERIOD=DAYDATE**;

On the Specify computed columns page, you can create, modify, or delete computed columns.

#### How to Add a Computed Column

To add a computed column to the aggregation table, on the Computed Columns page of the aggregation wizard, perform the following steps:

1. Click **New**. A new line is displayed on the grid that contains default values for the following attributes: name, length, type, informat, and format. (The default value for the name of the column is “Untitledn”, where n is the nth computed column for this aggregation.)
2. Enter the values that you want to use for the **Name**, **Expression**, and **Description** fields. You can enter values for the **Length**, **Type**, **Informat**, and **Format** fields, or you can accept the default values for these fields.

   **Note:** You can use a SAS macro in a formula expression or in the expression for a computed column. The SAS macro definition needs to be available to the SAS session that executes the staging or aggregation job that populates the computed column. For example, you might need to add a new autocall library using the SASAUTOS SAS option in the SAS configuration.

### How to Modify a Computed Column

To modify a computed column, perform the following steps:

1. Select the column from the drop-down list. You can change the values of this column as needed.

2. In the **Name** field, you can change the name of your computed column. The name of the computed column can be any legal SAS name. It must be unique within the target table.

3. In the **Expression** field, you can specify a modified computation for this computed column by entering it in this field or by using the Expression Builder function. Double-click in the field and click ... to open the Expression Builder window.
Display 8.14  Expression Builder Dialog Box with IT Formulas Tab

Many functions are available from the **Functions** and **Data Sources** tabs of this window. In addition, the Expression Builder window provides another tab to assist you in defining the computation for this column—the **IT Formulas** tab.

- The **Functions** tab of the Expression Builder window lists a variety of functions, conversions, and other actions that you can specify in your expression. Select the function that you want to use in the expression and click **Insert**.

- The **Data Sources** tab of the Expression Builder window lists all the columns that are generated in the aggregation table output. Select the column that you want to use in the expression and click **Insert**.

For simple aggregations, the **Data Source** tab displays all the output columns that you selected for the simple aggregation table. For the summarized aggregation table, the **Data Source** tab displays all the class, ID, statistic, percent change, rank, and join columns that you selected for the summarized aggregation table. In addition, it displays the system-generated LastUpdated, CompletedDay, and ContribCount columns.

All column names that are used in the computation are the output column names. For example, if you choose to use an input column named SYSTEM as a class column, you might rename it MACHINE. Then, if you want to use that column when defining a computed column, you should refer to that column as MACHINE, not SYSTEM.

- The **IT Formulas** tab lists the formulas that you have defined as well as the formulas that are supplied with SAS IT Resource Management. Select the formula that you want to use and click **Insert**.
In addition to the conventional rValue expression, SAS IT Resource Management also supports more complex expressions. (An rValue expression is an expression that consists of code that is appropriate only for the right-hand side of an assignment statement.) For example, your expression can use SAS code that might include loops, IF statements, and so on. This code must be written in valid SAS DATA step syntax.

**Note:** You can use a SAS macro in a formula expression or in the expression for a computed column. The SAS macro definition needs to be available to the SAS session that executes the staging or aggregation job that populates the computed column. For example, you might need to add a new autocall library using the SASAUTOS SAS option in the SAS configuration.

When you are satisfied with the expression that you defined, click **OK** in the Expression Builder window. This action closes that window and places the expression in the appropriate field of the computed column.

**Note:** If invoked from the **Filters** tab of an Aggregation transformation, the Expression Builder window does not contain the **IT Formulas** tab. This tab is available only when the window is invoked from the **Add or modify a computed column** page of the wizards for summarized and simple aggregations.

For more information about the Expression Builder window, click the F1 key or **Help** from within that window.

4. In the **Description** field, you can change the descriptive information about the computed column.

5. In the **Type** field, you can change the type of the computed column. Double-click in the field and use the arrow to display the drop-down list of valid types (either character or numeric). From this list, you can select the appropriate type for this computed column. Fields that are the result of a calculation should be specified as numeric. By default, the computed column is numeric.

6. In the **Length** field, you can change the length of the computed column. For numeric type columns (not character type columns), this numeric value must be from 2 through 8. (Reducing the length of a numeric computed column might introduce precision errors.) For character computed columns, the length can be from 1 through 32767.

7. The **Informat** field is not used by the Aggregation transformation.

8. In the **Format** field, you can change the SAS format of the computed column. Double-click in the field and from the drop-down list of valid formats, select the format for this computed column.

   You can also enter a format name if it will be available when you execute the job or when you view the data in SAS.

### How to Delete a Computed Column

Deleting a computed column removes it from the metadata for a table. The column will no longer be generated when the Aggregation transformation job is run. However, deleting a computed column does not remove the column from the physical tables of aggregated data that have already been generated.

To delete a computed column from an aggregation table, perform the following steps:

1. Select the computed column that you want to delete.

2. Click **Delete**.

When you have finished working with your computed columns, click **Next** to continue to the final page of the wizard.
How to Complete the Specification of the Summarized Aggregation Table

The final page of the wizard displays the details for the summarized aggregation table that you specified. If you are satisfied with your choices, click **Finish**. Click **OK** to return to the process flow diagram.

In the metadata, aggregation tables are stored in sorted order, with an asserted **SORTEDBY=** data set option. The SORTEDBY assertion reflects that the data is stored in the following order:

1. alphabetical list of the remaining class columns
2. aging column

BY-processing can be performed using the class list, if the BY list matches the same SORTEDBY assertion. With SAS IT Resource Management, you can leverage SAS Data Integration Studio to define additional indexes for use where BY-processing is required. If you require a sorted aggregation table, you can input that table to a SORT transformation and store the resulting table wherever you want.

For information about indexes, see “Indexing an Aggregation Table” on page 194.

Creating Aggregation Tables with the Aggregation through the Template Wizard

The Aggregation Tables through Template enables you to create aggregation tables by using supplied templates or user-defined templates.

**Note:** User-defined templates are tables that are created by users. These tables are located in the `/Shared Data/SAS IT Resource Management/IT User-defined Templates/Aggregation` folder.

To create an aggregation table with the New Aggregation Table through Templates wizard, respond to the wizard's prompts.

1. On the Specify location page, you can view the metadata location of the folder within the IT data mart where the newly created tables will be saved.

   You can override the default value for this folder by clicking **Browse** and selecting a path to the table from the Select a Location dialog box that displays the metadata directory structure.

   **Note:** The **IT data mart** field displays the name of the IT data mart where the job is located. It cannot be modified.

2. On the Select templates page, check the template tables that you want to use to create aggregation tables. The **Total number of selected template tables** field is updated to reflect the number of template tables that you selected.
For staged tables that are designed to contain data that is already summarized to an hourly interval, you cannot successfully select aggregations that attempt to summarize the data to smaller intervals. When you specify an aggregation table that summarizes data for a time period that is shorter than the source table normally provides, a warning message is displayed stating that the aging column cannot be created. In that case, the aggregation table is not created. To avoid this situation, make sure that your source table provides the appropriate level of summarized values for the aggregation that you want to generate. For example, you might want to specify an aggregation table such as FifteenMinAcctTcodeSy. In that case, make sure that the source data (that is, the staged table) is summarized no higher that 15 minutes and import the DATETIMEFIFTEENMINUTE computed column into the staged table. 

Note: If the templates that you select have a dependency on other templates, an information box is displayed that lists the additional aggregations that will be created. Click OK to continue.

3. If this aggregation table is the first target table that is specified for this Aggregation transformation, an additional page of the wizard opens. This page prompts you for the physical target location and for information about the SAS library where the data will be stored. When this page opens, the following fields are already specified with default values. (However, you can modify these fields.)

- The Name field contains the name of the library that will contain all aggregation tables that are associated with the Aggregation transformation that you are working with. This field can contain up to 60 characters and should be unique within the IT data mart. A value is required in this field.
- The Description field contains the information that describes the library. It can contain no more than 200 characters. It is an optional field.
• The **Server** field contains the application server that you specified for the IT data mart that you are working with. The default application server is the SASITRM server. A value is required in this field.

At installation time, SAS IT Resource Management establishes a SAS Application Server named SASITRM that sets properties such as memory size options and formats for the exclusive use of the solution. Establishing SASITRM as the SAS Application Server ensures that the SAS IT Resource Management solution can be installed and operated with other SAS products and solutions, some of which may also establish SAS Application Servers.

*Note:* For information about SAS Application Servers, see *SAS® 9.3 Intelligence Platform: Application Server Administration Guide.*

• The **Libref** field contains the name that is temporarily associated with the library. The libref for an aggregation library is a concatenation of AGG and a random number (for example, `AGG27040`). A value is required in this field.

• The **Path specification** field contains the location where the tables for this library are to be stored. You must specify a location for the tables that is within the IT data mart that is specified in the **IT Data Mart** field.

Enter this field manually or click **Browse** to select a location from the Select a Directory dialog box that displays the directory structure on the server's file system. A value is required in this field.

4. The final page of the wizard displays the details for the aggregation tables that you specified. If the aggregation job that you specified adds more than 20 tables to an existing job, a warning message is displayed. The message suggests that you might want to remove some tables in order to experience better performance. Click **Yes** to continue to generate the tables. Click **No** to return to the Select templates page, where you can change your selections. If you are satisfied with your choices, click **Finish**.

Click **OK** to return to the process flow diagram.

*Note:* Some aggregation templates require other aggregation tables to be created. If so, a dialog box appears that notes the dependency and asking for confirmation before proceeding.

---

**Cloning an Aggregation Table**

Many IT organizations establish separate IT data marts for different IT resources based on their use by different business organizations or for use in support of production, testing, or development. The cloning feature is useful because it allows Aggregation transformation definitions to be created once and then copied and reused across other IT data marts.

To clone an aggregation table, perform the following steps:

1. Locate the Aggregation transformation that generates the aggregation table that you want to clone. To do so, from the **IT Data Marts** tree, navigate to the IT data mart that contains the job where the Aggregation transformation is located. Double-click the job to open it on the **Diagram** tab of the Job Editor window.

2. Right-click the aggregation table that you want to clone.
3. From the drop-down list, select **Clone**. If you are cloning a summarized aggregation table, the Clone Summary Aggregation Table dialog box appears. If you are cloning a simple aggregation table, the Clone Simple Aggregation Table dialog box appears.

   *Note:* The dialog boxes contain the same fields and are specified the same way.

4. The **Name** field contains the following text by default: “the name of the original table _Clone n”, where n is the nth table that is cloned from the original aggregation table.

   (Optional) Enter a name and a description that are more meaningful to you.

5. The dialog box displays the default values for the column to use for aging, its format, and whether the column represents the date or the datetime. (These values reflect the original table from which you created this cloned table.)

   To change the aging criteria for the cloned table, check the corresponding box. This action enables you to select a different **Column to use for aging**.

   • From the drop-down menu, select the column to use for aging.

   • The **Format** field displays the format for the selected column. It cannot be changed.

   • If possible, the system selects the appropriate **Date** or **Datetime** format.

   When you specify datetime values, one day of aging extends over 24 hours of data collection. This period might extend over one or more days.

   *Note:* If the system cannot determine whether the field represents a **Date** or a **Datetime** format, both of these options are enabled so that you can select the appropriate one.

   • The **SAS table name** field displays the unique name of the physical file that is associated with this new cloned table. It can be changed; however, the new SAS table name must be unique within its associated SAS library.

6. Click **OK** to create the cloned table.
Note: If you changed the column used for aging, a message appears that asks whether you are sure that you selected the correct Date or Datetime format. If your selection is correct, click Yes. Otherwise, click No and correct the Format field.

7. Save the job.

In order for your changes to take effect, you must redeploy the job. For information about redeploying jobs, see “Redeploy All Jobs on the Server” on page 314.

---

### Adding a New Column to an Aggregation Table

**CAUTION:**

Do not define a new staged table and use it as the source for an existing aggregation transformation. Doing so changes the metadata identity of the columns of the source table so that the aggregation transformation cannot process the source table correctly. If new columns were added to the staged table and you want to include them in an associated aggregation table, modify that aggregation table by using the Edit function for that table. (To modify or add a column to an existing staged table, modify the properties of the table or use the Maintain Tables function. For information about modifying a staged table, see “Modify a Staged Table” on page 138. For more information about the Maintain Staged Tables wizard, see “About the Maintain Staged Tables Wizard” on page 97.)

To add a new column to an aggregation table, perform the following steps:

1. Locate the Aggregation transformation that generates the aggregation table that you want to modify. To do so, from the IT Data Marts tree, navigate to the IT data mart that contains the job where the Aggregation transformation is located. Double-click the job to open it on the Diagram tab of the Job Editor window.

2. Right-click the aggregation table that you want to modify. From the list that displays, select **Edit table type Aggregation Table**.

   **Note:** If the table is a simple aggregation table, the list displays **Edit Simple Aggregation Table**. If the table is a summarized aggregation table, the list displays **Edit Summarized Aggregation Table**. However, if the aggregation table is not associated with an Aggregation transformation, then the Edit table type Aggregation Table option is not available.

3. Use the Jump to Page option to go directly to the page of the Summarized Aggregation wizard that you want to change. Use the drop-down list to display the pages to which you can go directly.
4. Select the page that contains the specifications that you want to modify and click Next.

5. Modify the contents of the page that you selected. (For information about which fields can be changed, follow the instructions that apply to the creation of the type of table that you want to modify.)
   
   • For information about creating summarized aggregation tables, see “Creating Aggregation Tables with the Summarized Aggregation Table Wizard” on page 163.

   • For information about creating simple aggregation tables, see “Creating an Aggregation Table with the Simple Aggregation Table Wizard” on page 161.

   Note: If you try to delete a column that is used to create a statistic, percentile, percent change, moving statistic, rank, or join column, a message appears that lists the column, where it is used, and its table name. If a column was deleted using the Columns tab of the Properties dialog box, then the next time the aggregation wizard is opened on that table, a message appears that identifies any columns whose source column is no longer available. Click Yes to delete the columns from the table and continue to edit the table. Click No to keep the columns. In that case, the wizard does not open.

6. Click through the remaining pages of the wizard until the summary page appears.

7. Click Finish to save your changes and return to the process flow diagram.
Deleting an Aggregation Table

Delete an Aggregation Table from an Aggregation Transformation

To delete an aggregation table from an Aggregation transformation, perform the following steps:

1. Locate the Aggregation transformation that generates the aggregation table that you want to delete. To do so, from the IT Data Marts tree, navigate to the IT data mart that contains the job where the Aggregation transformation is located. Double-click the job to open it on the Diagram tab of the Job Editor window.

2. Right-click the aggregation table that you want to delete.

3. From the drop-down list, select Delete. The table is removed from the Aggregation transformation that is displayed in the process flow diagram. However, the metadata for that table and the library are not deleted from the IT data mart. For information about this topic, see “Delete an Aggregation Table from the IT Data Mart” on page 189.

In order for your changes to take effect, you must redeploy the job. For information about redeploying jobs, see “Redeploy All Jobs on the Server” on page 314.

CAUTION:
To avoid processing errors, delete any reference to this table, as a source or target for any transformation in any other job. For example, Information Map transformations that use the deleted table as a source table should be deleted.

Delete an Aggregation Table from the IT Data Mart

To delete an aggregation table from an IT data mart, perform the following steps:

1. Locate the aggregation table that you want to delete. To do so, from the IT Data Marts tree, navigate to the IT data mart that contains the job where the aggregation table is generated.

2. Expand that IT data mart and navigate to the aggregation table that you want to delete. Right-click the table.

3. From the drop-down list, select Delete.

4. Click Yes to confirm that you want to delete this table. The table is removed from the IT data mart. However, the associated library is not deleted.

Note: This delete action does not delete the physical table. It deletes the metadata of the table.

CAUTION:
Deleting a table can break join columns if the table that you delete is the source for another table.
Erase an Aggregation Table

Erasing an aggregation table deletes the physical table, its contents, and its metadata. To erase an aggregation table, perform the following steps:

1. In a tree view of SAS IT Resource Management, locate the aggregation table that you want to erase.
2. Right-click the aggregation table that you want to erase. The aggregation job that includes the aggregation table must be closed and currently not in use before erasing.
3. Select **Erase**.
4. Click **Yes** to confirm that you want to erase this aggregation table.

**CAUTION:**

If you erase an aggregation table that serves as a source table in other jobs, then these associated jobs might not execute because they are missing a source table. Simply erasing an aggregation table does not affect the metadata of the associated aggregation or information map jobs. However, if you erase an aggregation table and then rerun the aggregation job, then the data for the deleted aggregation table is not created. In addition, the jobs that used that table will fail due to a missing source table.

Editing or Modifying an Aggregation Table

**CAUTION:**

Do not define a new staged table and use it as the source of an existing aggregation transformation. To do so changes the metadata identity of the columns of the source table so that the aggregation transformation cannot process the source table correctly. If new columns were added to the staged table and you want them to be included in an associated aggregation table, modify that aggregation table by using the **Edit** function for that table.

If you need to modify an aggregation table, for best results do so from within the aggregation job. (If you want to edit an aggregation table that was created by the Simple Aggregation Table wizard, the Summarized Aggregation Table wizard, or the Aggregation through Template wizard, you must first save the job that created that aggregation table.) To modify a simple or a summarized aggregation table, perform the following steps:

1. Locate the Aggregation transformation that generates the aggregation table that you want to modify. To do so, from the **IT Data Marts** tree, navigate to the IT data mart that contains the job where the Aggregation transformation is located. Double-click the job to open it on the **Diagram** tab of the Job Editor window.
2. Right-click the aggregation table that you want to modify. From the list that displays, select **Edit table type Aggregation Table**.

**Note:** If the table is a simple aggregation table, the list displays **Edit Simple Aggregation Table**. If the table is a summarized aggregation table, the list displays **Edit Summarized Aggregation Table**. However, if the aggregation table is not associated with an Aggregation transformation, then the **Edit table type Aggregation Table** option will not be available.
3. Use the **Jump to Page** option to go directly to the page of the aggregation wizard that you want to change. Use the drop-down list to display the pages to which you can go directly.

**Display 8.18 Jump to Percent Change Page for a Summarized Aggregation Table**

4. Select the page that contains the specifications that you want to modify and click **Next**.

5. Modify the contents of the page that you selected. (For information about which fields can be changed, follow the instructions that apply to the creation of the type of table that you want to modify.)
   - For information about creating summarized aggregation tables, see “Creating Aggregation Tables with the Summarized Aggregation Table Wizard” on page 163.
   - For information about creating simple aggregation tables, see “Creating an Aggregation Table with the Simple Aggregation Table Wizard” on page 161.

**Note:** If you try to delete a column that is used to create a statistic, percentile, percent change, moving statistic, rank, or join column, a message appears that lists the column, where it is used, and its table name. If a column was deleted using the **Columns** tab of the Properties dialog box, then the next time the aggregation wizard is opened on that table, a message appears that identifies any columns whose source column is no longer available. Click **Yes** to delete the columns from the table and continue to edit the table. Click **No** to keep the columns. In that case, the wizard does not open.

6. Click through the remaining pages of the wizard until the summary page appears.

7. Click **Finish** to save your changes and return to the process flow diagram.
In order for your changes take effect, you must redeploy the job. For information about redeploying jobs, see “Redeploy All Jobs on the Server” on page 314.

---

**Publishing an Aggregation Table as Template**

To publish an aggregation table as a template, perform the following steps:

1. Locate the Aggregation transformation that generates the aggregation table that you want to publish as a template. To do so, from the **IT Data Marts** tree, navigate to the IT data mart that contains the job where the Aggregation transformation is located. Double-click the job to open it on the **Diagram** tab of the Job Editor window.

2. Right-click the aggregation table that you want to publish.

3. From the drop-down list, select **Publish**. If you selected a summarized aggregation table, the Publish as User Defined Template - Summarized Summary Aggregation dialog box appears. If you selected a simple aggregation table, the Publish as User Defined Template - Simple Aggregation dialog box appears.

4. The **Name** field contains the name of the table that you want to publish.  
   (Optional) Enter a name and a description, that is more meaningful to you.

5. In the **Location** field, accept the default location or click **Browse**. This action opens the Select a Location dialog box where you can navigate to another location. Select the location that you want to use and click **OK**.

   *Note:* The **Location** field must be the default location or a location that is underneath it.

6. Click **OK** to create the template.

7. Save the job.

---

**Purging Contents of an Aggregation Table**

**Purge Data from an Aggregation Table from the Process Flow Diagram**

To purge data from an aggregation table, perform the following steps:

1. Locate the Aggregation transformation that generates the aggregation table that you want to modify. To do so, from the **IT Data Marts** tree, navigate to the IT data mart that contains the job where the Aggregation transformation is located. Double-click the job to open it on the **Diagram** tab of the Job Editor window.

2. Right-click the aggregation table whose data you want to purge.

3. From the drop-down list, select **Purge**.

4. Click **Yes** to confirm that you want to purge the data from this aggregation table.
Purge Data from an Aggregation Table on the IT Data Marts Tab

You can also purge the contents of an aggregation table by performing the following steps:

1. Locate the Aggregation transformation that generates the aggregation table that you want to modify. To do so, from the IT Data Marts tree, navigate to the IT data mart that contains the job where the Aggregation transformation is located.

2. Right-click the aggregation table whose data you want to purge.

3. From the drop-down list, select Purge.

4. Click Yes to confirm that you want to purge the data from this aggregation table.

Renaming an Aggregation Table

CAUTION:

You can change the name of the physical aggregation table only by using the Edit Aggregation wizard. Changing the name of the table on the General tab of the Properties dialog box does not change the name of the physical table.

To rename a simple or a summarized aggregation table, perform the following steps:

1. Locate the Aggregation transformation that generates the aggregation table that you want to modify. To do so, from the IT Data Marts tree, navigate to the IT data mart that contains the job where the Aggregation transformation is located. Double-click the job to open it on the Diagram tab of the Job Editor window.

2. Right-click the aggregation table that you want to rename.

3. From the drop-down list, select Edit <aggregation-type> Aggregation Table, where aggregation-type is Summarized or Simple. This action opens the Summarized Aggregation Table wizard or the Simple Aggregation Table wizard.

4. To change the name of the table in the metadata, enter the new name of the aggregation table in the Name field on the first page of the wizard.

To change the name of the physical table, enter the new name of the aggregation table in the SAS Table Name field.

5. Click Next to proceed through all the pages of the wizard. Then click Finish.

6. Click OK to save your changes and return to the process flow diagram.

Note: This task changes the name of the table in the metadata. The name of the physical SAS data set is changed when you click Finish. In order for your changes to take effect, you must redeploy the aggregation job. In addition, even though the metadata linkage to that renamed table still exists, it is advisable to redeploy the information map job that uses the renamed table as input. For more information about redeploying jobs, see “Redeploy All Jobs on the Server” on page 314.
Indexing an Aggregation Table

Introduction to Indexes

An index is a component of a SAS data set that enables SAS to access observations in the SAS data set quickly and efficiently. The purpose of SAS indexes is to optimize WHERE clause processing and to facilitate BY-group processing. SAS IT Resource Management supports indexes for summarized and simple aggregation tables.

- Summarized Aggregations: You can create additional indexes manually.
  
  **CAUTION:**
  
  Do not create unique indexes for summarized aggregation tables.

- Simple Aggregations: Indexes are not automatically created for input columns that are specified for aggregation tables. However, you can create indexes manually.

For more information about indexes, see *SAS Data Integration Studio: User’s Guide* or the Help for SAS Data Integration Studio.

How to Access an Index

Indexes are physically created when the aggregation job is run. To access an index, perform the following steps:

1. Right-click the aggregation table and select Properties from the drop-down list.
2. Select the Indexes tab.

The left panel of the Indexes tab contains a list of the columns that can be used to index the data.

*Note:* Any columns that are in the table can also be in the index. For a simple aggregation table, these columns were previously specified as input columns for the table. For a summarized aggregation table, these columns were previously specified as class, ID, statistic, rank, percent change, join, or computed columns for the table.

The right panel contains the indexes that are specified for this aggregation.
In the following display, an index called TimeIndex has already been created. A new index called Index2 is in the process of being created.

Display 8.19  Indexes Tab of an Aggregation Table

From the Indexes tab, you can create, rename, and delete indexes.

Create an Index

To add an index, perform the following steps:

1. Navigate to the Index tab of the aggregation table for which you want to create an index. For information about how to access an index, see “How to Access an Index” on page 194.

2. Click New. An index entry (Indexn) opens in the right panel.

   Note: In the preceding display, the new index was given the default name Index2.

3. From the left panel, select the columns that you want to index. An index must have at least one column.

4. Use the right arrow to include them under the index entry in the right panel.

5. Do not specify that the values of an index are to be unique, because this might interfere with the processing of the transformation.

6. To specify that the values of an index should not include missing values, highlight the index in the right panel and click No missing values.

7. When you finish specifying the columns that you want to index, you might want to rename the index so that it is more informative. Otherwise, click OK to save your changes and return to the process flow diagram.

   Note: At this time, if the name of a simple index is not the same as the column that is being indexed, a message box appears. It asks whether you want to change the name to conform to the name of the column. You must click Yes and change the name. Then you can save the index.
In the following display, the new index, called Index2, is specified for the column Machine. It contains only unique values and does not contain missing values.

Display 8.20 Newly Created Index Named Index2

Delete a Column from an Index

To delete a column from an index, perform the following steps:
1. Navigate to the Index tab of the aggregation table that you want to work with. For information about how to access an index, see “How to Access an Index” on page 194.
2. From the right panel, expand the indexes that are displayed. Select the column that you want to delete.
3. Click Delete.
4. Click OK to save your changes and return to the process flow diagram.

Delete an Index

To delete an index, perform the following steps:
1. Navigate to the Index tab of the aggregation table whose index you want to delete. For information about how to access an index, see “How to Access an Index” on page 194.
2. Select the index that you want to delete.
3. Click Delete.
4. Click OK to save your changes and return to the process flow diagram.

Rename an Index

To rename the index, perform the following steps:
1. Navigate to the Index tab of the aggregation table whose index you want to rename. For information about how to access an index, see “How to Access an Index” on page 194.

2. Right-click the index entry.

3. From the drop-down list, select Rename.

   Note: From this drop-down list, you can also add and delete indexes.

4. Enter the new name of the index. If the index contains only one column, it is a simple index. For simple indexes, the name of the index must be the same as the column that is being indexed.

   Press the ENTER key.

5. Click OK to save your changes and return to the process flow diagram. At this time, if the name of a simple index is not the same as the column that is being indexed, a message box appears. It asks whether you want to change the name to conform to the name of the column. You must click Yes and change the name. Then you can save the index.

---

Create a View of a Simple Aggregation Table for Source Tables Supported by MXG

The Aggregation transformation might create an additional table that contains MXG views under the following conditions:

- the input (source) table to the Aggregation transformation is a staged table supported by MXG
- the Aggregation transformation creates at least one simple aggregation table

The view is created for the first such simple aggregation table. These tables are identified in the metadata by the prefix MXG_Simple_.

By default, the view is stored in the same library as the simple table associated with the view.

MXG views are defined or updated in the metadata each time an MXG Aggregation transformation is saved, if the preceding conditions are met. When the job is executed, the physical view is created or re-created.

---

Working with Aggregation Transformations

Properties of an Aggregation Transformation

To access an Aggregation transformation, from the IT Data Marts tree navigate to the IT data mart that contains the job where the Aggregation transformation is located. Double-click the job to open it on the Diagram tab of the Job Editor window. Right-click the Aggregation transformation and select Properties.

The Properties dialog box appears. It consists of the following tabs:
• The **General** tab contains the identifying information about the transformation. The fields on this tab can be modified.

*Display 8.21  General Tab of an Aggregation Transformation*

The following display shows the **General** tab of an aggregation table.

For items in the preceding display, the following definitions apply:

**Name**
identifies the name of the Aggregation transformation.

**Description**
describes the Aggregation transformation.

• The **ITRM Options** tab enables you to view, add, modify, and delete filters for an Aggregation transformation. It also enables you to specify that the Aggregation transformation should purge data from the source table after the Aggregation transformation has executed successfully.

*Display 8.22  ITRM Options Tab of an Aggregation Transformation*

The Name column displays the list of filters that are available for an Aggregation transformation. (You can apply only zero or one filter to an aggregation target table.) A value is required in this field.

**Expression**
The **Expression** field displays the definition or the calculation of the filter. A value is required in this field.
New
Clicking the New option adds a new row in the table that displays all the available filters. This action enables you to specify a filter that can be applied to a table that is input to an Aggregation transformation.

Delete
Clicking the Delete option deletes the selected filter.

Purge source table after the successful execution of this transformation
Checking the Purge source table after the successful execution of this transformation option removes the data from the source table after the aggregation tables are processed.

• The Options tab on the Aggregation transformation Properties dialog box both enables you to view and specify the options that pertain to the Aggregation transformation. The options that are marked with an asterisk (*) require a value.

Select Additional Options in the left panel to view and specify the following options:
  • The Reset to defaults button sets all the options for the Aggregation transformation to the default values.
  • The Create SYSLAST macro variable option specifies whether to create the SYSLAST macro variable to hold the name of the output table.
    Use the down arrow to select Yes or No. The default value for this option is Yes.
  • The Generate indexes on target tables option specifies whether to automatically generate the code that creates the target table indexes.
    Use the down arrow to select Yes or No. The default value for this option is Yes.
  • The Use formats and informats in column definitions option specifies that the generated code for this Aggregation transformation will include column definitions with format and informat information.
    The value for this option is Use job level setting. No other value is possible for this option.
  • The System options option enables you to specify additional options on an OPTIONS statement. The options must be separated by spaces
  • The Collect diagnostic messages option specifies whether to generate code for diagnostic messaging for this transformation
    Use the down arrow to select Yes or No. The default value for this option is No.

Select Checkpoint in the left panel to view and specify the following options:
  • The Assign as restart-point option specifies whether this Aggregation transformation should be the first transformation that is executed when the job is restarted.
    Use the down arrow to select Yes or No.
  • The Run this transformation always when restarting option specifies whether this Aggregation transformation should always be run when the job is restarted.
    (The Assign as restart-point option obviates the necessity for this option.)
    Use the down arrow to select Yes or No.

• The Code tab contains the code that is generated for the transformation.
• The Precode and Postcode tab contains information about user-written code that might be inserted at the beginning or the end of the transformation.
The Parameters tab contains information about prompts.

The Notes tab contains areas where you can annotate the table.

The Extended Attributes tab contains a custom property that is not part of the metadata for the transformation.

The following display shows the Extended Attributes tab of an aggregation table.

Display 8.23  Extended Attributes Tab of an Aggregation Transformation

For items in the preceding display, the following definitions apply:

- **#** specifies the number of the extended attribute.
- **Field Name** specifies the attribute name to be defined.
- **Value** specifies the value for the attribute that is specified in the Field Name column.
- **Description** describes the attribute and value.

Delete an Aggregation Transformation from a Job

A job can consist of multiple transformations. An Aggregation transformation can consist of multiple aggregations, each generating an aggregation table. To delete an Aggregation transformation from a job, perform the following steps:

1. Locate the Aggregation transformation that you want to delete. To do so, from the IT Data Marts tree, navigate to the IT data mart that contains the job where the
Aggregation transformation is located. Double-click the job to open it on the Diagram tab of the Job Editor window.

2. Right-click the box that represents the Aggregation transformation that you want to delete.

3. From the drop-down menu, select Delete.

Note: If you delete an Aggregation transformation, the target tables that were populated by those aggregations are not deleted. However, the tables are no longer updated.

**Rename an Aggregation Transformation**

1. Locate the Aggregation transformation that you want to rename. To do so, from the IT Data Marts tree, navigate to the IT data mart that contains the job where the Aggregation transformation is located. Double-click the job to open it on the Diagram tab of the Job Editor window.

2. Right-click the Aggregation transformation box.

3. From the drop-down menu, select Properties.

4. On the General tab, enter the new name of the Aggregation transformation.

5. Click OK to save your changes and return to the process flow diagram.

Note: Renaming an Aggregation transformation does not rename the aggregation tables that it generates.

---

**Working with Aggregation Transformation Filters**

**About Aggregation Transformation Filters**

A filter can be used to limit the amount of data that is input to an individual aggregation table. You can define a filter to be used in an Aggregation transformation, modify or edit the filter, and delete it from an Aggregation transformation. A filter that is specified for an Aggregation transformation can be applied to any of the aggregation tables that are being specified in the Aggregation transformation. However, the filter will not affect any of the data that is already in the tables that were created or updated before the application of the filter. If you define or modify a filter for an Aggregation transformation, or delete a filter from an Aggregation transformation, the existing aggregation tables are not automatically regenerated.

Note: Filters are used only when data is read into the aggregation table. If you modify a filter, the data that is already in the table remains unchanged.

After a filter has been added to an Aggregation transformation, it can be applied to the input of any aggregation table within that transformation. For both the Simple Aggregation Table wizard or the Summarized Aggregation Table wizard, you can select an input filter on the Select filter and column for data duplication page of that wizard. When you are using the Aggregations through Template wizard, if the aggregation that you select uses a filter, it will be added to the specification automatically.
Access the ITRM Options Tab on the Properties Dialog Box of an Aggregation Transformation

To define, modify, or delete a filter for an Aggregation transformation, you must first access the ITRM Options tab on the Properties dialog box of that Aggregation transformation. To do so, perform the following steps:

1. From the IT Data Marts tree, navigate to the IT data mart that contains the job where the Aggregation transformation is located.
2. Double-click the job to open it on the Diagram tab of the Job Editor window, and locate the appropriate Aggregation transformation.
3. Right-click the Aggregation transformation. From the drop-down list, select Properties.
4. Select the ITRM Options tab to open the grid of input filters. The List of Filters group box displays the name and expression of input filters that are defined for this Aggregation transformation.

Define a Filter for an Aggregation Transformation

To define an input filter for an Aggregation transformation, perform the following steps:

Access the ITRM Options tab on the Properties dialog box of the Aggregation transformation for which you want to define a filter. To do so, see the preceding topic.

1. Click New to display a new line in the grid on which you can enter a new filter. The default name of this filter is "Untitledn," where n is the nth filter that exists for this Aggregation transformation.
The following display of the **ITRM Options** tab shows that a new filter is being defined for the SMF Jobs Aggregation.

**Display 8.24  List of Filters Group Box**

2. Enter the name of the filter. Consider giving the filter a name that is unique within this Aggregation transformation.

3. Enter the expression that specifies the filter. You can enter the expression directly in this field, from a formula, or by using the Expression Builder functionality. For information about how to use this functionality, see “About the Expression Builder” on page 205.

4. If you want to purge the source table upon successful creation of aggregation tables, click the corresponding check box.

5. When you are satisfied with the definition for the filter, click **OK** to save your work and return to the process flow diagram.

**Delete a Filter from an Aggregation Transformation**

To remove a filter from an Aggregation transformation, you must first remove the filter from all the aggregation tables that use it. (For information about how to do so, see “Delete a Filter from an Aggregation Table” on page 204.)

Access the **ITRM Options** tab on the Properties dialog box of the Aggregation transformation from which you want to delete a filter. To do so, see “Access the ITRM Options Tab on the Properties Dialog Box of an Aggregation Transformation” on page 202. Then perform the following steps:

1. Select the filter that you want to delete.
2. Click **Delete**. If the filter that you selected is used in another table, a warning message is displayed that lists the tables where the filter is used. In that case, you must delete the filter from those tables.

3. Click **OK** to save your changes and return to the process flow diagram.

*Note:* In order to apply the changes that you made, you must redeploy the jobs that use that filter. For information about deploying jobs, see “**Redeploy All Jobs on the Server**” on page 314.

---

**Delete a Filter from an Aggregation Table**

An aggregation filter that is being used by an aggregation table cannot be deleted from an Aggregation transformation. If you attempt this action, a message box appears that identifies the aggregation tables that are using the filter. To delete the input filter from the Aggregation transformation, you must first remove it from all aggregations where it is being used.

To remove a filter from an aggregation table, perform the following steps:

1. From the **IT Data Marts** tree, navigate to the IT data mart that contains the job where the Aggregation transformation is located. Double-click the job to open it on the **Diagram** tab of the Job Editor window.

2. Right-click the aggregation table that uses the input filter. From the drop-down list, select **Edit**.

3. Use the **Jump to Page** option to go directly to the page of the wizard where you can delete the filter. From the drop-down list, select **Apply Filter** and click **Next**.

4. In the **Select filter** field, the drop-down list shows the filters that can be applied. You can choose another filter to apply to the table, or else the **(None)** option, which removes the filter from this table.

*Note:* Only one filter can be applied to an aggregation table.

5. Click through the remaining pages of the wizard until the summary page displays.

6. Click **Finish** to save your changes and return to the process flow diagram.

---

**Modify a Filter of an Aggregation Transformation**

To modify or edit a filter that is associated with an Aggregation transformation, perform the following steps:

1. Access the **ITRM Options** tab on the Properties dialog box of the Aggregation transformation for which you want to modify a filter. To do so, see “**Access the ITRM Options Tab on the Properties Dialog Box of an Aggregation Transformation**” on page 202.

2. Select the filter that you want to modify. You can change the name and the expression of the filter. You can also change the specification about purging the input table after the aggregation tables have been created.

   • To change the name of the filter, select the **Name** field of the filter to highlight it. Then enter the new name of the filter.

   • To change the expression, select the **Expression** field to highlight it. Then enter the modified expression that specifies the filter. You can enter the expression directly in this field or you can use the Expression Builder functionality. For
information about how to work with the Expression Builder in SAS IT Resource Management, see “About the Expression Builder” on page 205.

- To change the specification about purging the input table after the aggregation tables are created, click the corresponding check box. (A checked box means that the source table will be purged.)

3. When you have finished modifying the filters, click **OK** to save your changes and return to the process flow diagram.

---

**About the Expression Builder**

To invoke the Expression Builder, double-click the **Expression** field.

**Display 8.25 Invoking the Expression Builder**

Then, double-click the icon that contains the ellipsis (...). The Expression Builder window appears and enables you to specify a filter.

*Note:* When invoked from the Add Filter dialog box, the Expression Builder window consists of two tabs: **Functions** and **Data Sources**.
Display 8.26  Expression Builder Window with Functions Tab Selected
The **Data Sources** tab of the Expression Builder window lists the columns of the table that is the input to this Aggregation transformation.

**Display 8.27** Expression Builder Window with Data Sources Tab Selected

You can select any of these columns from the list of data sources to be an operand in the expression that you are building.

For information about the Expression Builder window, click the F1 key or **Help** from within that window.

*Note:* The syntax of the expression that specifies the filter must conform to the rules for an **IF** statement. The expression should result in a nonzero value for *true* and zero value for *false*. (Do not code the word **IF**; code the expression only.) Certain operations that are valid only in a **WHERE** clause fail if they are used in a filter. For information about the **IF** and **WHERE** statements, see the *SAS Statements: Reference*.

When you are satisfied with the expression, click **OK** in the Expression Builder window to close that window and place the expression in the appropriate field of the filter.
Chapter 9
Adapter Setup Wizard

About the Adapter Setup Wizard

What Is the Adapter Setup Wizard?
The Adapter Setup wizard enables you to define and create staging jobs, aggregation jobs, information map jobs, and reporting jobs that process the raw data for an IT resource. These jobs include predefined configurations that are based on industry intelligence that represents a best estimate about the types of aggregations and reports that most sites need for analysis.

Note: The Adapter Setup wizard produces staging, Aggregation, Information Map, and Gallery transformations that are good choices for many users. However, your site might have site-specific requirements. Therefore, you should examine the results of the Adapter Setup wizard. You might need to add or delete elements of the jobs,
After the wizard creates the appropriate jobs, you can schedule and run each as needed. The jobs process the raw data in a manner that is specified by or based on a selected adapter and domain category.

For more information about using the Adapter Setup wizard, see “Accessing and Navigating the Adapter Setup Wizard” on page 211.

**Advantages of the Adapter Setup Wizard**

In addition to defining and programmatically creating jobs, staged tables, summarized aggregations, information maps, and reporting jobs for a given adapter, the Adapter Setup wizard also applies intelligence to these objects. Here are some of the benefits that the Adapter Setup wizard provides:

- programmatic creation of staging, aggregation, and information map jobs that include transformations and output tables that are used for staging and aggregating data with the recommended summarizations, statistics, percentiles, percent changes, and rankings for reporting
- programmatic creation of reporting jobs that include Gallery transformations that use predetermined information maps and report definitions to build relevant reports based on a given adapter and domain category
- options to specify the scope and size of jobs that are created for a given adapter as determined by output level (staging job only, minimal, typical, and full) or other criteria (domain category, time period, key metrics, and so on)
- translation of metrics in the raw data source to standard units of measure
- generation of a default set of computed columns that are appropriate for the adapter data source
- the ability to choose appropriate statistics for aggregations and weighting them appropriately
- a default list of metrics that will be ranked
- an appropriate set of aggregations based on the staged data for the adapter data source
- a default set of filters that might be useful for limiting the output size of aggregations
- categorization of data in summarized aggregations by appropriate specification of class variables
- creation of an information map for each aggregation table
- report-ready data

With the Adapter Setup wizard, you can create comprehensive jobs that meet your reporting needs.

**Naming Conventions That the Adapter Setup Wizard Uses**

The Adapter Setup wizard uses specific naming conventions when naming and saving the various folders, jobs, transformations, and tables that it creates. These standards simplify the management and maintenance of the various objects that are interrelated. For best results, if you choose to edit the IT data mart folders, subfolders, jobs,
transformations, or tables that the Adapter Setup wizard creates, then use the same naming conventions that the Adapter Setup wizard uses for consistency and efficiency.

This chapter provides several examples of the naming conventions that the Adapter Setup wizard uses. For a comprehensive list of the naming conventions and location standards that SAS IT Resource Management uses, see “About Naming Standards for SAS IT Resource Management Objects” on page 493.

Using the Adapter Setup Wizard

**Accessing and Navigating the Adapter Setup Wizard**

To access the Adapter Setup wizard, open SAS IT Resource Management and select **New** → **IT Resource Management** → **Adapter Setup**. To navigate through the pages of the wizard, use the following wizard buttons:

- **Help**
  - displays a Help topic for the current window.

- **Cancel**
  - abandons changes that were made since the last save and closes the current window.

- **Back**
  - displays the previous window in the wizard.

- **Next**
  - displays the next window in the wizard.

- **Finish**
  - saves changes that were made since the last save and closes the current window.

**Steps to Complete the Adapter Setup Wizard**

The Adapter Setup wizard guides you through several steps that help define the ETL jobs, staged tables, summarized aggregation tables, information maps, and Gallery transformations for the selected adapter. The steps vary based on the requirements of the adapter that you select.

Here are all of the possible steps or pages that the Adapter Setup wizard can present for a given adapter:

- Specify an adapter for your input data source.
- Specify the configuration level that controls the scope and amount of output jobs.
- Specify the IT data mart.
- Specify staging parameters such as the location of the raw data and how to handle duplicate data.
- Select domain categories for the selected adapter.
- Select the time periods for which you want to create aggregation jobs and report jobs.
- Specify the location of any user-written formulas.
- Specify the SAS Content Server and job deployment information for report packages.
• View a summary of the specifications that you have chosen and the ETL objects that the Adapter Setup wizard creates when the resulting jobs are executed.

Creating Jobs Using the Adapter Setup Wizard

The Adapter Setup wizard enables you to define and create the ETL jobs that are required to process your IT resource data. You do not need to run the Adapter Setup wizard frequently for a given adapter. For best results, run the Adapter Setup wizard initially for a given adapter and do not run it again for the same adapter unless you have changes in how you would like to process input data. Running the Adapter Setup wizard additional times does not update the jobs, transformations, or tables from the previous runs. Instead, it creates new jobs, transformations, and tables.

To specify all of the necessary parameters that the Adapter Setup wizard requires to create the jobs for an adapter, perform the following steps:

1. From the SAS IT Resource Management menu bar, select **New ➔ IT Resource Management ➔ Adapter Setup** to open the Adapter Setup wizard.

2. Specify the adapter for which you want to create jobs.

   **Display 9.1** Specifying the Adapter

   ![Adapter Setup Wizard](image)

   a. Click the adapter that you want to use from the list of the adapters provided. You can move the cursor over an adapter to view a tooltip that provides the full name of the adapter, any former names of the adapter, and information about the types of data that the adapter provides. The remaining pages and parameters that are presented in the Adapter Setup wizard are based on the specific adapter that you select on this page.

   **Note:** The AS/400 and IMS adapters are not available for selection on this page.

   The staging code that is required for these data sources is not automated by the Adapter Setup wizard. However, SAS IT Resource Management supplies
staging transformations for these adapters. You can use these staging transformations to create staging jobs manually for these data sources. For more information about how to create a staging job manually using a staging transformation, see “Add a Staging Transformation to a Staging Job” on page 124.

For more information about the specific adapters that SAS IT Resource Management supports, see “Supported Adapters” on page 80.

b. Click Next.

3. Specify the configuration level that represents the scope of output jobs that you want the Adapter Setup wizard to create.

     Note: If you are using an adapter that does not include aggregations that are categorized with configuration levels, then the level is automatically set to create a staging job only and this page does not display.

     Display 9.2  Specifying the Level of Output

     Configuration levels enable you to specify the general scope or amount of aggregation tables and jobs that you want the Adapter Setup wizard to create. These levels provide various presentations of granularity in the data based on the aggregations and metrics that are available for an adapter. The jobs that are created for each level include the metrics that are used in the reports for that level. These jobs might also include other metrics that have been predetermined to be useful for reporting on the given level.

     Configuration levels are unique for each adapter. However, in some cases, the levels can be identical for a given adapter. For more information about the metrics and aggregations that are supported for each adapter, see the SAS IT Resource Management metrics documentation. To locate the SAS IT Resource Management
To specify the level of output, complete the following steps:

a. Select one of the following configuration levels:

   **Staging Job Only**
   creates a staging job only for the adapter. If you select this option, no aggregation jobs, information map jobs, or reporting jobs are created.

   **Minimal**
   creates a staging job and additional jobs that include metrics, aggregations, and report definitions for a small number of reports. This level is for reporting on a small scale. You might use this level to create jobs that are related to low-priority, non-critical machines.

   **Typical**
   creates a staging job and a robust set of jobs that include metrics, aggregations, and report definitions for a typical set of reports. This level includes all of the jobs that are part of the Minimal level. In addition, it includes metrics, aggregations, and jobs that IT Resource Management has identified as being of interest for the selected adapter. You might use this level to create jobs that are related to mission critical resources.

   This configuration level is the default option.

   **Full**
   creates a staging job and a comprehensive set of jobs that include most metrics, aggregations, and report definitions that SAS IT Resource Management supports. This level includes all of the jobs that are part of the Typical level. In addition, it includes many of the other metrics that are recommended for an adapter. You might use this level when you want the full benefits of the domain intelligence that is available with the IT Resource Management solution as well as additional information from the full set of metrics that are available from the adapter data sources.

   *Note:* Increasing the configuration level results in more complex transformations and jobs. If you select **Full** when you need only the **Typical** level, then the extra complexity causes the Adapter Setup wizard to be slower to complete than is necessary for your needs. Also, the nightly ETL jobs will take longer to process.

b. Click **Next**.

4. Specify the IT data mart where you want to save the ETL jobs that the Adapter Setup wizard will create, or create a new IT data mart.
a. Select an IT data mart from the list of available IT data marts. If you do not want
to use one of the data marts in the list, then click **New IT Data Mart**. This action
launches a wizard that guides you through the process of creating and defining a
new IT data mart. When you are finished, the wizard returns you to the Adapter
Setup wizard.

b. Click **Next**.

5. Specify staging and duplicate-data checking parameters for the selected adapter.
Staging parameters vary by adapter as they specify the configurations that are
required to extract, transform, and load specific raw data into staged tables.

The parameters that are marked with an asterisk (*) require a value. All other
parameters do not require a value.

You can also click **Reset** for a given staging parameter to use the default value if
there is one available for the parameter. If the default value is already selected, then
the **Reset** option is not available. You can also click **Reset to defaults** to set all the
staging parameters to the default values.

**Note:** **Reset to defaults** does not reset a parameter that is dependent on another
parameter if the parent parameter does not change.

For more information about the staging and duplicate-data checking parameters that
are available for each adapter, see “Staging Parameters” on page 400.

a. Specify the staging parameters in order to govern how you want the staging code
to execute for the adapter. The following image is an example of the staging
parameters for the DT Perf Sentry adapter:
b. Specify the duplicate-data checking parameters in order to govern how you want the duplicate-data checking to execute for the adapter. The following image is an example of the duplicate-data checking parameters for the DT Perf Sentry adapter.
c. Click Next.

*Note:* If you selected the adapter VMware vCenter, then the Adapter Setup wizard presents two pages of staging parameters: one for VMware Data Acquisition jobs and one for VMware vCenter jobs. For more information about accessing raw data for the VMware vCenter adapter, see “Data Sources Supported by SAS IT Resource Management Adapters” on page 325.

6. Specify one or more domain categories that you want the Adapter Setup wizard to use when creating the resulting jobs.

*Note:* If you are using an adapter that does not have aggregation and information map jobs available from the Adapter Setup wizard, then the wizard creates only a staging job and skips this page.
The preceding example shows the domain categories that are available for the DT Perf Sentry adapter. All of the domain categories that are related to Server data have been selected. Note that the description in the box on the right corresponds with the domain category that is highlighted in the Select domain categories box.

The Adapter Setup wizard helps you manage system performance by enabling you to select only the domain categories that are essential to the performance management and capacity planning processes for your enterprise. The Adapter Setup wizard creates a predefined set of jobs based on the domain categories that you select. The time that the Adapter Setup wizard takes to create the jobs varies based on the number of staged tables, aggregation jobs, and report jobs that are generated for the domain categories that you select.

Note: If you are using an adapter that does not include domain categories, then this page does not display.

For more information about domain categories, see “Domain Categories” on page 237.

a. Click one or more domain categories to enable or disable the domain category for staging and aggregation. At least one domain category must be selected before you can continue to the next page of the wizard.

b. Click Next.

7. Select the time periods and key metrics that you want to use for the aggregation and reporting jobs.

Note: If you are using an adapter that does not have aggregation and information map jobs available from the Adapter Setup wizard, then the wizard creates only a staging job and skips this page.
The preceding example shows that all time periods and key metrics have been selected. Note that the description in the box on the right corresponds with the time period that is highlighted in the **Select time periods** box.

The time periods are another way that the Adapter Setup wizard helps you manage system performance, aggregations, and jobs. The wizard enables you to select only the time periods that are essential to the performance management and capacity planning processes for your enterprise. The Adapter Setup wizard creates only the aggregation and report jobs that reflect the time periods and key metrics that you select. In turn, you do not have to sort through extra jobs and reports that focus on time intervals that you do not need.

**Note:** You must select at least one time period or the **Key metrics** option to continue. (That is, you can select any combination of these four choices: **Day**, **Week**, **Month**, or **Key metrics**, but you must select at least one.)

For more information about the specific aggregations that the Adapter Setup wizard creates based on time period and shift, see “Aggregations by Time Period” on page 229.

a. Select the time periods for which you want to create aggregation and report jobs.

   **Day**
   creates aggregation jobs and the daily, weekly, and monthly report jobs that generate reports about the daily data.

   **Week**
   creates aggregation jobs and the weekly report job that generate reports about the weekly data.
Month
creates aggregation jobs and the monthly report job that generate reports about the monthly data. If you check the Shift option, additional aggregations are created and additional reports are included in the monthly report job.

*Note:* If you also select Shift (as described in the next step), then additional aggregations are created and additional reports are included in the report jobs.

b. Select Shift if you want to generate aggregations, information maps, and reports that are based on shift data, in addition to daily, weekly, or monthly data.

*Note:* In some cases, Shift might be selected by default because of the adapter that you selected earlier in the wizard.

c. Select Key metrics if you want to generate aggregation tables, information maps, and reports that include only the key metrics that focus on the most critical data for a performance area or domain category.

*Note:* If the domain categories that you selected do not include key metrics, then this option is not available.

d. Click Next.

8. Specify the location of any user-written formulas to use in addition to the formulas that SAS IT Resource Management supplies.

Display 9.8 Specifying User-Written Formulas

The staged tables and aggregation tables that the Adapter Setup wizard creates include computed columns that reference various formulas. When the tables with computed columns are instantiated, SAS IT Resource Management looks for the corresponding formulas in the list of supplied formulas.

You might have customized or user-written formulas that you prefer to use. If so, then use this page of the wizard to specify the location of the user-written formulas that you want to use. The Adapter Setup wizard then looks in the folder that you specified for any formulas that have the same name as those in the tables that it creates. If a formula with the same name is in the folder, then the wizard uses that formula. If the formula is not found in your specified location, then the wizard searches for the formula in this location: Shared Data/SAS IT Resource Management/IT Formulas. If the formula is still not found, then the wizard searches for it in this location: Products/SAS IT Resource Management/IT Formula.

a. Click Browse to navigate to and select the folder that includes any user-written formulas that you want to use instead of the formulas that SAS IT Resource Management supplies. This field is optional and does not allow manual entries. If
you do not have user-written formulas that you want to use and do not specify a folder in this field, then the Adapter Setup wizard defaults to the supplied formulas.

b. **Click Next.**

9. Specify the location of the SAS Content Server where the report definitions are retrieved and where the reports that are generated from the resulting jobs are stored. Also specify whether you want the Adapter Setup wizard to automatically deploy the jobs that it creates.

This page does not appear if you selected the configuration level **Staging Job Only** on the second page of the wizard. In this case, the Adapter Setup wizard creates only one staging job that you must deploy manually.

### Display 9.9 Specifying SAS Content Server and Job Deployment Page

**Note:** If you are using domain categories that do not result in reporting jobs, then the SAS Content Server options are not available on this page. For more information, see “Jobs That the Adapter Setup Wizard Creates for Domain Categories” on page 443.

The report definitions that the Adapter Setup wizard uses to create the report jobs are stored on the SAS Metadata Server. In addition, the reports that are generated from the report jobs are stored on the SAS Content Server.

a. If you are using domain categories that result in reporting jobs, specify the following parameters for the SAS Content Server:

**SAS Content Server**

specifies the name of the server that is used as the SAS Content Server for storing report definitions and report job outputs.
Note: Only servers that can be valid SAS Content Servers are included in the drop-down list for this parameter.

Repository folder path
specifies the path within the SAS Content Server where the report definitions and reports are stored. The default location is /SASContentServer/repository/default/sas dav/ITRM.

URL file name parameters
URL file name parameters specifies the parameters that pertain to the URL filename, such as Proxy, user ID, or password. For example, the contents of this field could be user='userId', pass='password', and so on. The contents of this field are used to communicate with Gallery Manager. In most configurations, these parameters are not needed.

A value is optional in this field. The default value for this field is blank.

For information about the contents that can be entered in this field, see the “FILENAME Statement, URL Access Method” topic in the SAS Statements: Reference.

Note: The contents of the field are not verified.

b. Specify the following parameters to indicate whether you want the Adapter Setup wizard to deploy the jobs that it creates:

Deploy jobs automatically
specifies if you want the Adapter Setup wizard to deploy all of the jobs that it creates. Otherwise, the Adapter Setup wizard only creates the jobs and you must deploy them manually.

Deployment directory
specifies the location where the jobs are deployed if you select to deploy the jobs automatically.

Note: If you are working with z/OS, then the location for deployment must be a directory in the UFS file system. The Adapter Setup wizard does not support the automatic deployment of jobs to a partitioned data set (PDS) directory.

c. Click Next.

10. View a summary of the metadata that you specified for the adapter, staging, aggregations, information maps, reports, and jobs that you specified with the Adapter Setup wizard.
The summary consolidates all of the specifications that you provided on the previous pages of the wizard.

a. Review the summary and ensure that it reflects the specifications and results that you expect. If you want to change a value that you specified on a previous page, click Back to navigate to the appropriate page and change the parameter value as needed.

The last item on the Summary page provides the location where a log file for the current Adapter Setup wizard instance is stored. This text file is automatically stored on your machine after each execution of the Adapter Setup wizard. The log includes all of the information that is detailed on the Summary page of the Adapter Setup wizard. It also includes the dates and times at which the Adapter Setup wizard was run. For more information about the log file, see “Log File Created by the Adapter Setup Wizard” on page 236.

b. Click Finish when complete. The wizard creates the jobs and saves them in an <adapter><number> folder within the IT data mart that you selected. The time that the Adapter Setup wizard takes to create the resulting jobs varies based on the adapter and the parameters that you specify. A progress bar shows the status when the wizard creates the appropriate jobs. If the jobs cannot be created, an error message is displayed.

Note: The first time you edit a job that the Adapter Setup wizard created, the job is marked as needing to be saved. (An asterisk is next to the name in the title bar of the Job Editor window). This is because the Job Editor is storing the initial editor settings for how the job is displayed in the window. The job was saved when the Adapter Setup wizard executed.

If you do not select to have the Adapter Setup wizard automatically deploy the jobs that it creates, then you must deploy the resulting jobs if you want to run them in
batch mode. You can right-click a job to open a menu that provides various options such as deployment and scheduling tasks. For information about running the jobs that the Adapter Setup wizard creates, see “Running Jobs” on page 305. For more information about deploying a job, see “Deploy a Job for Scheduling” on page 306 or SAS Data Integration Studio Help.

---

**What Does the Adapter Setup Wizard Create?**

**What are the Types of Jobs That the Adapter Setup Wizard Creates?**

Based on your specifications, the Adapter Setup wizard creates a set of ETL jobs and all the metadata that is necessary for those jobs to execute. These jobs and the associated metadata are stored in the `<adapter><number>` folder and other subfolders of the IT data mart that you are working with.

*Note:* The default name of each job contains the name that matches the subfolder where the job is located in addition to the domain category that you specify with the Adapter Setup wizard.

The Adapter Setup wizard creates the following types of jobs:

- one staging job that contains only the part of the ETL flow that relates to the staging transformation and the target staged tables.

  *Note:* The Adapter Setup wizard creates two staging jobs for the VMware vCenter adapter: VMware Data Acquisition and VMware vCenter.

- zero or more aggregation jobs that each contain one Aggregation transformation with target summary tables. The number of aggregation jobs that are created varies based on the domain categories (and their respective subcategories), time periods, and reporting selections that you specified. For more information about the aggregations that the Adapter Setup wizard creates and how you can use these aggregations to analyze and report on your IT data, see “Aggregation Jobs and Objects Created by the Adapter Setup Wizard” on page 229.

- zero or more information map jobs that each contain one Information Map transformation per aggregation table. The number of information map jobs that are created varies based on the domain categories (and their respective subcategories), time periods, and reporting selections that you specified.

  *Note:* In SAS IT Resource Management 3.1 and SAS IT Resource Management 3.1.1, the Adapter Setup wizard created jobs that created or updated aggregation tables and also generated information maps based on those tables. If the job that modified aggregation tables was run, the corresponding Information Map transformations were part of that job. Therefore, the information maps were automatically regenerated. Starting with SAS IT Resource Management 3.2, jobs that create or update aggregation tables do not include transformations that generate information maps. Therefore, if any changes are made to the tables that are input to those Information Map transformations, that alter the structure of the table (for example, by adding or deleting columns), then the user must rerun the corresponding information map jobs so that the information maps are regenerated.

For more information about the information map jobs that the Adapter Setup wizard creates and how you can use them to report on your IT data, see “Information Map Jobs and Objects Created by the Adapter Setup Wizard” on page 232.
zero or more reporting jobs that each contain one or more Gallery transformations per information map. The number of reporting jobs that are created varies based on the domain categories (and their respective subcategories), time periods, and reporting selections that you made when specifying the adapter.

If you do not select to have the Adapter Setup wizard automatically deploy the jobs that it creates, then you must deploy the resulting jobs if you want to run them in batch mode. For more information about deploying and scheduling the jobs that the Adapter Setup wizard creates, see “Deploy and Run Jobs That the Adapter Setup Wizard Creates” on page 238.

Here is an example of the subfolders and jobs that the Adapter Setup wizard created for a third instance of the DT Perf Sentry adapter with the domain categories of Server Disk and Server System selected.

**Display 9.11  Subfolders and Jobs Created by the Adapter Setup Wizard**

The domain categories for some adapters include a very large amount of data and associated tables. In these cases, the domain categories are divided into domain subcategories. A separate aggregation table, information map job, aggregation job, and reporting job is created for each domain subcategory based on the time periods and other reporting selections that you made when specifying the adapter. For example, the IBM SMF adapter includes a domain category called DB2 Global. The DB2 Global domain category is divided into four domain subcategories (AttachConName, ConType, JobAttach, Plan, and Subsystem).
Here is an example of the objects that the Adapter Setup wizard created for a second instance of the IBM SMF adapter with the DB2 Global domain category and the Day time period selected:

**Display 9.12 Subfolders and Jobs Created for Domain Subcategories**

![Diagram of subfolders and jobs]

**Where Does the Adapter Setup Wizard Store the Objects That It Generates?**

The Adapter Setup wizard stores the objects that it generates in predetermined locations within the IT data mart that you select. These objects can be stored in any location to which you have Write access. However, the Adapter Setup wizard uses the following folder organization to simplify the management and maintenance of the various objects that are interrelated. For best results, if you choose to create or edit IT data mart folders, subfolders, jobs, transformations, or tables, then use the same naming conventions and folder structure that the Adapter Setup wizard uses for consistency and efficiency.

The wizard creates an `<adapter><number>` folder in the IT data mart that you are working with. Within this folder, the wizard creates the following two subfolders for the objects that it creates:

- The **Staging** subfolder, which contains the staging job, staged tables, and the library for those tables.
The following display shows the metadata that is created in the **Staging** subfolder for a third instance of the DT Perf Sentry adapter within the IT data mart. The **Staging** subfolder contains the DT Perf Sentry Staging job, the NTLGDSK and NTSYSTEM_ITRM staged tables, and the library (NTSMF Staging 6066) for those tables.

**Display 9.13  Default Location of Objects Created by the Adapter Setup Wizard for Staging the Raw Data**

- The **Domain Categories** subfolder contains additional subfolders that are named by domain category. Each of these subfolders for domain categories contain the libraries, aggregation tables, and jobs (aggregation, information map, and reporting) that are associated with the respective domain category.

For example, the following display shows the metadata that is created in the **Domain Categories** subfolder for the following scenario:

- DT Perf Sentry adapter is selected, and it is the third time the wizard is run for this adapter in the IT data mart.
- Two domain categories (Server Disk and Server System) are selected.
- Two time periods (Day and Month) are selected.

In this example, the **Domain Categories** subfolder contains two subfolders of domain objects: Server Disk and Server System. Each domain subfolder contains five
aggregated tables, the library associated with those tables, the aggregation job, the information map job, and the two reporting jobs.

**Display 9.14** Default Location of Objects Created by the Adapter Setup Wizard for Aggregating, Creating Information Maps, and Reporting on the Staged Data

For adapters that are supported by MXG, the following feature is provided. For each staged table that is created by the **Adapter Setup** wizard, an additional table is created that contains MXG views for that staged table. These additional tables are identified in the metadata by the prefix MXG_Staged_.

By default, the views are stored in the same library as the staged table associated with the view.

The MXG views are defined or updated in metadata each time an MXG staging transformation is saved, if there are eligible tables supported by MXG that are associated with it. When the job is executed, the physical views are created or re-created.

**Views of Staged Tables for Adapters Supported by MXG**

For adapters that are supported by MXG, the following feature is provided. For each staged table that is created by the Adapter Setup wizard, an additional table is created that contains MXG views for that staged table. These additional tables are identified in the metadata by the prefix MXG_Staged_.

By default, the views are stored in the same library as the staged table associated with the view.

The MXG views are defined or updated in metadata each time an MXG staging transformation is saved, if there are eligible tables supported by MXG that are associated with it. When the job is executed, the physical views are created or re-created.

**Staging Jobs and Objects Created by the Adapter Setup Wizard**

For most adapters, the Adapter Setup wizard creates one staging library and one staging job for each execution of the wizard. The staging library is named `<adapter> Staging <unique number>`. The staging job is named `<adapter> Staging` and it contains the following objects for a given adapter:

- one staging transformation
- one or more target staged tables
For the VMware vCenter adapter, the Adapter Setup wizard creates two staging jobs (VMware Data Acquisition and VMware vCenter) with one staging transformation and one staging library for each.

A staging job creates the code that populates the associated staged tables. The staged tables are created by the Adapter Setup wizard based on template tables that are supplied as part of SAS IT Resource Management. These tables are predetermined to include the data that is most relevant and appropriate for analysis and reporting based on the domain category and time periods that you selected in the wizard. A staged table in the staging job is given the same name as the template table on which it is modeled. For more information about the specific staged tables that each domain category supports, see “Overview of the SAS IT Resource Management Data Model” on page 466.

Aggregation Jobs and Objects Created by the Adapter Setup Wizard

Overview
The Adapter Setup wizard creates zero or more aggregation jobs for a supported adapter. Each of these aggregation jobs contain one staged table as the source table, one Aggregation transformation, and one or more target summary aggregation tables. The aggregation tables are named using the convention <time period> (such as Day, WeekShift, MonthShiftHour, KeyMetrics, Detail, and so on) <domain subcategory> (such as cache, memory, server, and so on). For example, an aggregation table name might be MonthShiftHourDisk.

There are three types of aggregations that the Adapter Setup wizard might include in an aggregation job.

regular aggregations by time period transformations that specify one or more ways to classify, summarize, and age an input table based on a specified time period. For more information about aggregations that are created by time period, see “Aggregations by Time Period” on page 229.

key metrics aggregations aggregations that include only key metrics and any relevant classification and ID columns that are associated with these key metrics to provide vital data for the longer term forecast and capacity planning reporting. About key metrics aggregations, see “Key Metrics Aggregations” on page 230.

detail aggregations simple aggregation tables that contain detail data as it was read by the staging transformation. For more information about the detail aggregations that the Adapter Setup wizard creates, see “Detail Aggregated Tables” on page 231.

Aggregations by Time Period
The Adapter Setup wizard creates a set of aggregations based on the domain categories and time periods (Day, Week, Month, Shift) that you select. These aggregations, stored
in separate folders for each domain category that you selected, classify, summarize, and age an input table based on the selected time periods. For example, the WeekDisk aggregation includes weekly data about server disk performance. In turn, the weekly reporting job uses the information from this aggregation table and its corresponding information map to generate a report that shows the weekly performance data for the server disk.

The following table shows the aggregations that the Adapter Setup wizard creates based on selected time periods.

**Table 9.1 Aggregations Created by Time Period Selection**

<table>
<thead>
<tr>
<th>Selected Time Period</th>
<th>Generated Aggregations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>Detail Day DayHour</td>
</tr>
<tr>
<td>Day + Shift</td>
<td>Detail Day DayShift DayHour DayShiftHour</td>
</tr>
<tr>
<td>Week</td>
<td>Week WeekHour</td>
</tr>
<tr>
<td>Week + Shift</td>
<td>Week WeekShift WeekHour WeekShiftHour</td>
</tr>
<tr>
<td>Month</td>
<td>Month MonthHour</td>
</tr>
<tr>
<td>Month + Shift</td>
<td>Month MonthShift MonthHour MonthShiftHour</td>
</tr>
</tbody>
</table>

**Key Metrics Aggregations**

The Adapter Setup wizard creates key metrics aggregations if you select the **Key metrics** option in the wizard. These aggregations are named with the prefix "KeyMetrics" and are stored with the other aggregation tables for a given domain category.

Key metrics aggregations are tables that have only a few columns that are deemed highly important for the domain category. These aggregations serve as the source for capacity planning and forecasting. These aggregations include only key metrics and any relevant
classification and ID columns that are associated with these key metrics to provide vital supporting data for the selected metrics.

Key metrics are a subset of the available metrics that are provided by adapters for a given performance area such as resource utilization. You can use key metrics aggregation tables to quickly view the most critical data for a performance area.

The following image shows a key metrics aggregation, circled in red, in a process flow diagram.

Display 9.15  Key Metrics Aggregation in a Process Flow Diagram

For more information about key metrics, see “What Are Key Metrics?” on page 484.

**Detail Aggregated Tables**

For some adapters, the Adapter Setup wizard creates simple aggregation tables that consist of the raw data from the staged table that is appended to the simple aggregated table. These aggregated tables are named with the prefix “**Detail**” and are stored with the other aggregation tables for a given domain category.

Detail aggregated tables provide a granularity that enables you to view and report on the raw data as it is retrieved from the source. These simple aggregated tables can support join columns, computed columns, and aging, but they do not include statistics or other intelligence from SAS IT Resource Management.

The following image shows a detail aggregation, circled in red, in a process flow diagram.

Display 9.16  Detail Aggregation in a Process Flow Diagram
Information Map Jobs and Objects Created by the Adapter Setup Wizard

The Adapter Setup wizard creates one information map job (named `<domain category> Information Map`) for each domain category that you select. These information map jobs include an Information Map transformation for each aggregation table that the wizard creates for the domain category. Each Information Map transformation is named the same as its corresponding aggregation table `<level>` (such as Day, WeekShift, MonthShiftHour, and so on) `<domain subcategory>` (such as cache, memory, server, and so on).

*Note:* When the Adapter Setup wizard creates Information Map transformations, it populates the **Information map path** field on the **Information Map Parameters** tab and checks the **Use default path of the job** box. (When this box is checked, the **Information map path** is grayed out and cannot be changed.) The Information Map transformation stores the information maps in the current folder where the information map job resides. This enables you to move or rename elements of the folder structure easily without having to modify each of the Information Map transformations that are affected. If you want to change the location where the information maps are stored, uncheck the **Use default path of the job** box and enter the changed path. You can click **Browse** to navigate to the location where you want to store your information maps.

When the information map jobs run, the Information Map transformations create information maps for the corresponding aggregation tables and the information maps are stored in the same `<domain category>` folder as the information map job, aggregation tables, and aggregation job. In the case of objects created by the Adapter Setup wizard, an Information Map transformation assigns the same name to the information map that it creates. As a result, the aggregation table, Information Map transformation, and resulting information map have the same name. This helps identify and associate each object easily.

*Note:* In SAS IT Resource Management 3.1 and SAS IT Resource Management 3.1.1, the Adapter Setup wizard created jobs that created or updated aggregation tables and also generated information maps based on those tables. If the job that modified aggregation tables was run, the corresponding Information Map transformations were part of that job. Therefore, the information maps were automatically regenerated. Starting with SAS IT Resource Management 3.2, jobs that create or update aggregation tables do not include transformations that generate information maps. Therefore, if any changes are made to the tables that are input to those Information Map transformations, that alter the structure of the table (for example, by adding or deleting columns), then you must rerun the corresponding information map jobs so that the information maps are regenerated.

The Adapter Setup wizard provides filters for the Information Map transformations that it creates. The wizard automatically provides one filter for each ranked column and one or more filters for the ranked columns of dates. These filters are specified in the Information Map transformations and propagated to the information maps that are created when the job is run. For more information about working with Information Map transformations, information maps, and information map filters, see “About Information Maps” on page 240.
Reporting Jobs and Objects Created by the Adapter Setup Wizard

About Reporting Jobs Created by the Adapter Setup Wizard
The Adapter Setup wizard programatically creates reporting jobs for the domain categories and time periods that you might select. These reporting jobs are named using the convention `<domain subcategory> <time period>` (such as Daily, Weekly, and Monthly) Reporting, and they are stored in the same domain category folder as the aggregation and information map jobs.

Reporting jobs include Gallery transformations that use report definitions, information maps, and aggregation tables to generate readable reports on the IT resource data. When a reporting job executes, it creates the necessary report packages and reports based on the information maps that are in the same domain category folder. The reports are then saved as tabular or graphic files (such as HTML or .png files) in the SAS Content Server that you selected in the Adapter Setup wizard. For more information about the reporting jobs that the Adapter Setup wizard creates for specific domain categories and time periods, see “How to Determine Whether the Adapter Setup Wizard Will Create Reporting Jobs for Your Selections” on page 233.

Note: The metadata server and SAS Content Server must be running when reporting jobs execute or the jobs will fail to generate output.

After a reporting job is deployed, scheduled, and executed, the resulting report output is available for viewing with Gallery Manager. Gallery Manager enables you to access, filter and manage your report content from a Web browser. For more information about reporting jobs and using Gallery Manager, see the SAS IT Resource Management: Reporting Guide.

How to Determine Whether the Adapter Setup Wizard Will Create Reporting Jobs for Your Selections
SAS IT Resource Management supplies predefined report definitions for several domain categories and time periods. These report definitions include information such as the table and level, the names of the variables, the report style, and other attributes that are used to build graphical reports from your IT resource data. The Adapter Setup wizard uses these prepackaged report definitions in the reporting jobs that it creates for the domain categories and time periods that you select.

If you select a domain category and time period for which SAS IT Resource Management supplies report definitions, then the Adapter Setup wizard creates the appropriate reporting jobs. To determine whether the Adapter Setup wizard is going to create reporting jobs for the domain category and time periods that you selected, you can view the Summary page of the wizard before you select Finish.
The Summary page lists the report jobs that the Adapter Setup wizard will create and the report definitions that the report jobs use, as shown in the following image:

Display 9.17  Example of a Summary Page Listing Report Jobs

Note: The Summary page also includes a note if no reporting jobs will be created.

You can also determine whether the Adapter Setup wizard is going to create reporting jobs based on your selections by viewing the list of supplied report definitions for a given domain category and time period. If SAS IT Resource Management supplies report definitions for a given adapter, domain category, and time period, then the Adapter Setup wizard creates a reporting job for those selections. If there are no supplied report definitions for a given adapter, domain category, and time period, then the Adapter Setup wizard does not create reporting jobs for those selections.

To view the supplied report definitions, perform the following steps:

1. In the Folders tree, select Shared Data ⇒ SAS IT Resource Management ⇒ 3.3 IT Report Definitions.
2. Select an <adapter> folder.
3. Select a <domain category> folder.
4. Select Supplied.
5. Select a <time period> folder.
Supplied Report Definitions for DT Perf Sentry, Server Disk, Day Data

CAUTION:
For best results, maintain copies of any supplied report definitions and any supplied report definitions that you might have modified so that your collection of reports is preserved. The Adapter Setup wizard looks in the Supplied folder for the report definitions to use in the reporting jobs that it creates. If you modify or remove these supplied report definitions, then you will lose or overwrite the intelligence that SAS IT Resource Management has incorporated into these definitions to ensure proper creation of the reports. Likewise, subsequent updates to SAS IT Resource Management software will overwrite any modifications that you have made to those report definitions that were supplied by the solution.

You can also create your own report definitions, Gallery transformations, and reporting jobs. You can create reporting jobs to supplement the reporting jobs that the Adapter Setup wizard creates or to add reporting jobs to the domain categories and time periods for which the Adapter Setup wizard does not create reporting jobs. Report definitions that you create can be stored in the User Defined folder within the domain category folder. If you decide to create your own reporting objects and jobs, use the same naming conventions and folder structure that the Adapter Setup wizard uses for consistency and efficiency. For more information about creating your own report definitions, Gallery transformations, and reporting jobs, see the SAS IT Resource Management: Reporting Guide.

Libraries Created by the Adapter Setup Wizard
The Adapter Setup wizard creates libraries that are required to hold the various tables that are used by the jobs that the wizard creates. The wizard creates the necessary libraries based on the adapter and domain categories that you select. For example, only a
few adapters such as IBM SMF and ASG TMON2C1C require a spin library for spin data. The Adapter Setup wizard creates a spin library only for those adapters that require one.

Staged library and libref names must be unique within the application server. The Adapter Setup wizard creates the following libraries and stores them in the same folder as their corresponding jobs and tables in the IT data mart:

library for staged tables
  holds the staged tables that the Adapter Setup wizard creates. The Adapter Setup wizard creates one staged library for each staging job that it creates with every execution of the wizard. This library is named \texttt{<adapter> Staging <unique number>}. The corresponding libref name is \texttt{STG <the same unique number as the library>}. 

libraries for aggregation tables
  hold the aggregation tables that the Adapter Setup wizard creates. The Adapter Setup wizard creates an aggregation library for each aggregation transformation that it creates. These libraries are named \texttt{<domain subcategory> <unique number>}. The corresponding libref name is \texttt{AGG <the same unique number as the library>}. 

spin library
  holds the spin metadata for adapters that use spin data. These libraries are named \texttt{<adapter name> Spin <unique number>}. The corresponding libref name is \texttt{SPIN}.

\textbf{Log File Created by the Adapter Setup Wizard}

The Adapter Setup wizard creates a log file after each execution of the wizard and stores the text file on your machine. The last item on the Summary page of the Adapter Setup wizard provides the location where the log file is stored. On the client, these log files are located in a directory that is determined based on the APPDATA environment variable.

- On Windows XP, this location is typically \texttt{C:\Documents and Settings\userid\Application Data\SAS\SASITResourceManagement\3.3}.
- On Windows 7, this location is typically \texttt{C:\Users\userid\AppData\Roaming\SAS\SASITResourceManagement\3.3}.

The name of the log file is based on the adapter that you selected and the date and time that the Adapter Setup wizard was executed (\texttt{ASWlogYYMMDDHHMMSS-<adapter name> <number>}). For example, the Adapter Setup wizard might create the following log file if executed for the DT Perf Sentry adapter on June, 15 2010 at 10:35 p.m.: \texttt{ASWlog100615103500-DT Perf Sentry 1.txt}.

The Adapter Setup wizard log includes all of the information that is detailed on the Summary page of the Adapter Setup wizard. It also includes the processing time for each
process and the total processing time for the wizard to execute. The following image shows a sample log file from an execution of the Adapter Setup wizard.

**Display 9.19 Sample Log File from the Adapter Setup Wizard**

Domain Categories

**About Domain Categories**

Domain categories are categories of template tables and aggregation tables that are organized logically to represent subsets of the IT resource measurements that are available from an adapter. This organization helps you create reports from one or more related template tables and aggregation tables of IT performance measurements.

**Note:** The domain categories that the Adapter Setup wizard displays are not necessarily all of the available domain categories for an adapter. You can view all of the domain categories for an adapter by opening the **Folders** tree view and expanding **Products** ➔ **SAS IT Resource Management** ➔ **Adapters** ➔ `<adapter name>` ➔ **IT Template Tables**. The template tables are grouped by domain category. All of the domain categories for an adapter are in this list.

The domain categories that are associated with an adapter vary based on the requirements and capabilities of each adapter. If SAS IT Resource Management provides
aggregation and information map jobs for a given adapter, then the Adapter Setup wizard enables you to select the domain categories that you want to use. If an adapter does not have aggregation and information map jobs available from the Adapter Setup wizard, then the wizard creates only a staging job and does not enable you to select a domain category.

This capability helps you manage system performance by enabling you to select the specific domain categories that are essential to the performance management and capacity planning processes for your enterprise. The time that the Adapter Setup wizard takes to create the resulting jobs varies based on the number of staged tables, aggregation jobs and tables, information map jobs, and reporting jobs that are generated for the domain categories that you select.

**Note:** The Adapter Setup wizard creates ETL jobs based on the domain categories that you select. However, for some adapters such as those based on event-type data, domain categories are divided further into domain subcategories. In these cases, the jobs that are created are based on the domain subcategories instead. This prevents jobs from being too large. When working with the ETL jobs that the Adapter Setup wizard creates, you might notice that the jobs are categorized into these subcategories.

For more information about the types of jobs that the Adapter Setup wizard creates for each adapter and domain category, see “Jobs That the Adapter Setup Wizard Creates for Domain Categories” on page 443.

---

**Deploy and Run Jobs That the Adapter Setup Wizard Creates**

The Adapter Setup wizard provides a convenient way to create the jobs that stage, summarize, and report on the IT resource data that an adapter loads. However, the Adapter Setup wizard does not run the jobs that it creates. You must run the resulting jobs as needed.

Deploying a job enables you to execute the job outside of the SAS IT Resource Management client, such as when scheduling a job to run at a specified time, or when a job might need to be made available as a stored process. SAS IT Resource Management enables you to deploy as well as run jobs. For more information about deploying and running jobs, see “Jobs That Process IT Data” on page 295.

Because the Adapter Setup wizard creates jobs that are separated into individual component jobs, you have the flexibility to modify, deploy, and run them separately if you have updates to only one aspect of the data extraction, transformation, loading, and reporting process.

The jobs that the Adapter Setup wizard creates depend on one another to process the raw data for reporting. For example, the aggregation jobs include aggregations that rely on the staged tables that are generated when the staging job is run. As a result, each job should be run only after the jobs that it depends on have been run. The following list shows the types of jobs that the Adapter Setup wizard creates and the dependencies of each. Each job type in the list is dependent on the job type that precedes it.

1. staging job
2. aggregation job
3. information map job
4. reporting job
Chapter 10
Information Maps

About Information Maps ........................................ 240
What Is an Information Map? .................................. 240
Benefits of Using Information Maps ......................... 240
How Are Information Maps Created? ......................... 240
Where Are Information Maps Stored? ....................... 241

About Information Map Transformations .................. 242
What Are Information Map Transformations? ............ 242
What Are the Properties of an Information Map Transformation? 242
How to Access the Properties of an Information Map Transformation 243

User-Specified Information Map Transformations ........ 244
Overview of Specifying an Information Map Transformation 244
Create an Information Map Transformation ................ 244
Modify an Information Map Transformation ............... 248
Delete an Information Map Transformation from a Job ... 250
Delete an Information Map ..................................... 251
Update an Information Map from a Template ............... 251

Information Map Objects That Are Generated by the Adapter Setup Wizard .................. 252
What Information Map Objects Does the Adapter Setup Wizard Generate? ............ 252
How the Adapter Setup Wizard Names Information Map Objects ..................... 253
Where the Adapter Setup Wizard Stores Information Map Objects ............... 253
What Information Map Filters Does the Adapter Setup Wizard Create? ............ 254
How the Adapter Setup Wizard Names Information Map Filters ..................... 254

Working with Information Map Filters ...................... 254
Benefits of Using Information Map Filters ................. 254
How to Access the Filters for an Information Map ........ 255
About the Information Map Parameters Tab ............... 255
Add a Filter to an Information Map ......................... 257
Modify a Filter on an Information Map ...................... 258
Delete a Filter from an Information Map .................... 259

Using SAS Information Map Studio ......................... 259
Overview of SAS Information Map Studio .................. 259
Benefits of Using SAS Information Map Studio .......... 260
How to Access SAS Information Map Studio .............. 260
Access an Information Map in SAS Information Map Studio .................. 261
Create an Information Map with SAS Information Map Studio .................. 261
Modify, Rename, or Delete Items in an Information Map with SAS Information Map Studio .................. 262
Test an Information Map with SAS Information Map Studio .................. 262
About Information Maps

What Is an Information Map?

An information map is a collection of data items and filters that describe and present a view of physical data tables in a form that is relevant and meaningful to a business user. (An information map does not contain any data—it is a map to the physical data.) You can use information maps with query and reporting applications such as SAS Enterprise Guide and SAS Web Report Studio to build business reports for your enterprise data.

Note: SAS IT Resource Management does not enable you to manipulate information maps directly. You must use Information Map transformations to specify the information maps that will be created when the transformation’s job is run. As a result, the information map properties that you can view from SAS IT Resource Management are limited and not available for direct modification. These properties include metadata about the information map such as its name, location, when it was created, who created it, when it was last modified, and who modified it. They are for information purposes only and cannot be modified. If you want to edit the parameters for an information map using SAS IT Resource Management, you must modify the Information Map transformation that creates the information map and run the corresponding job. In addition, the SAS IT Resource Management solution includes SAS Information Map Studio, which you can use to modify copies of supplied information maps.

Benefits of Using Information Maps

Information maps provide the following benefits:

- Descriptive labels can be created and used rather than variable names in reports. For example, an information map might assign a column label such as “PagingFileType” to the raw data field that is named “PAGTYPE.”

- Filters are available that can be added to any information map to make it easier to report on subsets of data. For example, you can select a filter named “Last Week” rather than constructing a WHERE clause like “WeekDateDescRank=2”. (Filters can be used for multiple reports.)

- IT intelligence can be shared with other SAS applications, which can use information maps as sources for reporting. SAS Web Report Studio requires an information map as a source for its reporting processes. SAS Enterprise Guide supports information maps for reporting. SAS Foundation supports information maps by means of the information maps LIBNAME engine.

How Are Information Maps Created?

There are two ways to create an information map:
• Execute a job that contains an Information Map transformation. You can create a job that contains an Information Map transformation in two ways:

• For many supported adapters, the Adapter Setup wizard creates jobs that contain Information Map transformations that, when run, create information maps for those adapters. For information about how to work with the Adapter Setup wizard, see “About the Adapter Setup Wizard” on page 209.

Note: In SAS IT Resource Management 3.1 and SAS IT Resource Management 3.1.1, the Adapter Setup wizard created jobs that created or updated aggregation tables and also generated information maps based on those tables. If the job that modified aggregation tables was run, the corresponding Information Map transformations were part of that job. Therefore, the information maps were automatically regenerated. Starting with SAS IT Resource Management 3.2, jobs that create or update aggregation tables do not include transformations that generate information maps. Therefore, if any changes are made to the tables that are input to those Information Map transformations that alter the structure of the table (for example, by adding or deleting columns), then the user must rerun the corresponding information map jobs so that the information maps are regenerated.

• SAS IT Resource Management enables you to create information maps for adapters by executing Information Map transformations. Information Map transformations are specified within a job. When the job runs, the Information Map transformations create information maps that are based on specified parameters. For information about how to create an Information Map transformation, see “Create an Information Map Transformation” on page 244.

• Use SAS Information Map Studio to create, modify, and test information maps for SAS IT Resource Management. For more information, see the SAS Information Map Studio Help and “Using SAS Information Map Studio ” on page 259.

Note: If you use SAS Information Map Studio to modify an information map that was created by an Information Map transformation, the changes are not carried over to the Information Map transformation. As a result, modifications that are made to an existing information map by using SAS Information Map Studio might be overwritten and lost when the corresponding job is rerun. To avoid this situation, modify a copied version of the automatically generated information map. Then save that modified version under a different name so that it will not be overwritten by the extract, transform, and load (ETL) processes.

Note: Information maps must be re-created whenever the structure of the tables underlying the maps is modified.

Where Are Information Maps Stored?

The Adapter Setup wizard creates folders within the IT data mart that you selected for each specified adapter. Within the adapter folder, Domain Category folders are set up for each separate domain that you specified. The information maps that pertain to a particular domain and the job that will create those maps are stored within that domain folder. The information map is created and stored when the job that contains the Information Map transformation is executed.

Note: When created by the Adapter Setup wizard, an information map is given the same name and is stored in the same location as the associated aggregation table. The icons that are next to the object can be used to distinguish the aggregation table from the information map. In the list of objects that can be displayed in the IT Data
About Information Map Transformations

What Are Information Map Transformations?

Information Map transformations are parts of a job that create information maps for source tables, which are typically aggregation tables. These transformations use PROC INFOMAPS to create information maps that describe source table items for reporting processes. Each Information Map transformation corresponds to a single source table within a job.

- When the Adapter Setup wizard runs, it automatically specifies the columns that are to become data items. The wizard also creates data items that are based on expressions, if needed.
- When you work with the Information Map transformation manually, you must select the columns that you want to include in the transformation. No columns are included automatically.

When data item specifications are added to the Information Map transformation, the name for each data item that is based on a column in the source table is derived from the label of the source column. However, these names can be changed by the user after the data item is created.

What Are the Properties of an Information Map Transformation?

The Properties dialog box of an Information Map transformation provides tabs where you can specify the parameters for the information map that it creates.
As shown in the preceding display, the Properties dialog box for an Information Map transformation contains the following tabs:

- **The General tab** contains information that identifies the Information Map transformation.

- **The Information Map Parameters tab** contains the name, description, path, and filter information for the information map that this transformation will create.

  *Note:* If the path is blank, the information map will be created in the path where the job is located.

- **The Data Items tab** contains information about the data items that are specified for this transformation, such as the source column name, the data item name that is assigned to it in the information map, the description of the data item, and the expression, if specified.

  *Note:* A data item can be based on a source column or an expression, but not both.

- **The Options tab** contains information about additional options that can be specified for this transformation.

- **The Code tab** contains the code that is generated for this transformation.

- **The Precode and Postcode tab** contains the user-written code that can be inserted at the beginning or end of the current job or transformation. The user-written code can be stored in metadata or in a file.

- **The Notes tab** contains any notes or documents that are associated with this Information Map transformation.

- **The Extended Attributes tab** contains any property that is specific to SAS IT Resource Management and is not part of the standard metadata for an Information Map transformation.

### How to Access the Properties of an Information Map Transformation

To access the properties of an Information Map transformation that are created by the Adapter Setup wizard, perform the following steps:
1. From the **IT Data Marts** tree, navigate to the IT data mart that contains the job where the Information Map transformation is located.

2. Double-click the job to open it on the **Diagram** tab of the Job Editor window, and locate the Information Map transformation whose properties you want to access.

3. Right-click the Information Map transformation. From the list that is displayed, select **Properties**. The Properties dialog box appears.

   **Note:** You have the option to store the job that contains your Information Map transformation in another location. If so, the preceding instructions are not applicable.

---

**User-Specified Information Map Transformations**

**Overview of Specifying an Information Map Transformation**

Using the Adapter Setup wizard is the most convenient way to create Information Map transformations and information maps for supported adapters. However, you can also specify Information Map transformations manually.

An Information Map transformation requires that you specify the following information:

- the name of the Information Map transformation
- the name of the information map that it creates
- the location where the information map is to be stored

  **Note:** If you do not specify the location, and it is left blank, the information map is created in the same folder as the job.

- the filter specification (if filtering is needed)
- the data items that are to be included in the information map

**Create an Information Map Transformation**

To create an Information Map transformation, perform the following steps:

1. Navigate to the job that is to contain the new Information Map transformation. Double-click the job to open it on the **Diagram** tab of the Job Editor window.

   **Note:** If you want to create an Information Map transformation in a new job that does not already exist, you must first create the job using the New Job wizard. For information about how to do so, see “Jobs That Process IT Data” on page 295.

2. From the **Transformations** tree of SAS IT Resource Management, locate and expand the **ITRM Transformations** folder. Scroll down to the Information Map transformation. Then drag and drop the Information Map transformation object onto the open job on the **Diagram** tab of the Job Editor window.

3. Navigate to the IT data source for this Information Map transformation. (This source table is typically an aggregation table. However, it can be any SAS table.) Drag and drop the IT data source onto the process flow diagram and connect it to the Information Map transformation object.
4. To specify the required information for the new Information Map transformation, right-click the Information Map transformation in the process flow diagram and select **Properties**. The Properties dialog box appears.

5. Click the **General** tab to enter the name and description for the Information Map transformation. The name and description that you specify here are for the Information Map transformation, not for the information map that the transformation creates. The name of the Information Map transformation can contain no more than 60 characters.

   **Note:** For best results, use the same naming convention that the Adapter Setup wizard uses for Information Map transformations. For information about the naming conventions that are used by the Adapter Setup wizard, see “About Naming Standards for SAS IT Resource Management Objects” on page 493.

6. Click the **Information Map Parameters** tab to display the following screen.

   **Display 10.2 Information Map Parameters**

On that screen, enter the following information:

- Specify the name of the information map that is to be created and the location where the information map is to be saved.

- For best results, use the same naming convention that the Adapter Setup wizard uses for information maps. For information about the naming conventions that are used by the Adapter Setup wizard, see “How the Adapter Setup Wizard Names Information Map Objects” on page 253.

- In addition, it is a best practice to use the same information map path that the Adapter Setup wizard uses for information maps. To do so, check the **Use default path of the job**. The default path is displayed in the **Information map path** field. (It is grayed and cannot be changed.) For more information, see “Where the Adapter Setup Wizard Stores Information Map Objects” on page 253.
However, you can change where the information map is stored. To do so, uncheck the **Use default path of the job** box and enter a path in the **Information map path** field. Click **Browse** to select a path to the information map from the Select a Location dialog box that displays the metadata directory structure.

7. Use the **Information Map Filters** section of the **Information Map Parameters** tab if you want to specify filters for the information map. This section displays a grid that contains the name, expression, and description of filters that are defined for the information map that this transformation creates. (When you are creating a new Information Map transformation, the grid will be empty.) For information about how to add a filter to an Information Map transformation, see “Add a Filter to an Information Map” on page 257.

8. Click the **Data Items** tab to specify the data items that you want to include in the information map that will be created by this Information Map transformation. Data items that are class columns will be available in SAS Web Report Studio for selection as filters.

**Note:** In order to use or reuse the reports that are supplied by SAS IT Resource Management, specify the data items according to the standards that are in effect for the solution. For information about the standards used by SAS IT Resource Management, see “About Naming Standards for SAS IT Resource Management Objects” on page 493.

The grid that appears on this tab contains columns for **Column Name**, **Data Item Name**, **Description**, **Expression**, and **Format** for each data item. When a map is being created, the grid is empty.

- Click **Import** to display the list of **Available columns**. The columns that are listed here are columns that exist in the Information Map transformation's source table. Highlight the columns that you want to include as categories in the information map and use the right arrow to transfer them to the **Selected category columns**. Highlight the columns (numeric only) that you want to include as measures in the information map and use the right arrow to transfer them to the **Selected measure columns**.

In the following display, two data items are selected as category columns, and three data items are selected as measure columns.
Then click **OK** to display the selected category and measure columns on the **Data Items** grid where you can modify the name of the data item or its description.

- Click **New** to open the New Data Item window where you can add a new data item to the grid. Enter the **Data Item Name**, **Description**, **Classification** (Category or Measure), **Type** (Character or Numeric), **Format**, and **Expression** fields for the new data item.

  **Note:** The **Expression** field of a data item can contain 1024 characters. Do not enter double quotation marks in the **Expression** field.

In the following display, a new data item called **NewMeasure** is defined and ready to be added to the **Data Items** grid.
10.4 New Data Item Window

Click **OK** to display the new data item on the **Data Items** grid where it can be modified if needed.

**Note:** In the case of data items that are added from the New Data Item window, the **Column Name** of the added item is blank.

- To remove a data item from the information map, highlight the data item and click **Delete**.

9. The remaining tabs (**Options**, **Code**, **Precode and Postcode**, **Notes**, and **Extended Attributes**) are optional. For information about these tabs, see the Help for SAS IT Resource Management.

10. Click **OK** to save the parameters for the Information Map transformation.

11. To save the modified job, from the menu bar select **File** ⇒ **Save**.

**Modify an Information Map Transformation**

Editing an Information Map transformation can cause errors in reporting if the information map is used for reports. For example, do not remove or rename any data items or filters that are used in a report. If you do so, the report will fail. However, you can add anything or rename anything that is not used in a report.

To modify an Information Map transformation, perform the following steps:

1. Navigate to the job that contains the Information Map transformation that you want to modify. Double-click the job to open it on the **Diagram** tab of the Job Editor window.

2. Within the process flow diagram, right-click the box that represents the Information Map transformation that you want to modify.
3. From the menu list, select **Properties** to open the Information Map Properties dialog box. From this dialog box, you can access the **General, Information Map Parameters, and Data Items** tabs that serve as the primary locations for the information map parameters and metadata. These tabs enable you to view and modify the following items:

- the name of the transformation
- the name of the generated information map
- the location of the information map
- the filters for the information map
- the data items that make up the information map

4. On the **General** tab, you can modify the name and description of the Information Map transformation by changing the text in the **Name** field and the **Description** field.

   **Note:** The name and description that you specify here are for the Information Map transformation, not for the information map that the transformation creates. For best results, use the same naming convention that the Adapter Setup wizard uses for Information Map transformations. For information about the naming conventions that are used by the Adapter Setup wizard, see “How the Adapter Setup Wizard Names Information Map Objects” on page 253.

5. On the **Information Map Parameters** tab, you can make the following changes:

   - Change the name of the information map that the transformation creates by changing the text in the **Information Map Name** field. Changing the name of an information map that was already created does not delete the map that was created with the old name.

     **Note:** For best results, use the same naming convention that the Adapter Setup wizard uses for information maps. Furthermore, to facilitate the association of the table with the information map, the name of the information map should be the same as the name of the source table. For information about the naming conventions that are used by the Adapter Setup wizard, see “How the Adapter Setup Wizard Names Information Map Objects” on page 253.

   - Change the location where the transformation saves the information map that it creates. Information maps can be stored wherever you specify. To change the location, uncheck the **Use default path of the job**. Then you can manually enter the new path in the **Information map path** field. You can also click **Browse** to navigate to the new location in the metadata structure.

     If **Use default path of the job** is checked, you cannot change the **Information map path** field.

     **Note:** For best results, use the same storage path that the Adapter Setup wizard uses for information maps. To do so, make sure the **Use default path of the job** box is checked. The information map is saved in the same folder as the information map job. For more information, see “Where the Adapter Setup Wizard Stores Information Map Objects” on page 253.

   - Change the filters for the information map that are displayed on the filter grid.

     - For information about adding filters to information maps, see “Add a Filter to an Information Map” on page 257.

     - For information about modifying filters on information maps, see “Modify a Filter on an Information Map” on page 258.
For information about deleting filters from information maps, see “Delete a Filter from an Information Map” on page 259.

6. On the **Data Items** tab, you can make the following changes:

   • Select additional category or measure data items from the source table to add to the information map by clicking **Import**. Then highlight the columns in the **Available columns** of the source table that you want to add and use the arrow to transfer them to the **Selected category columns** or **Selected measure columns** panels. Click **OK** to include these data items in the information map.

   • Define an additional data item for the information map by clicking **New**, which opens the **New Data Item** window. Then enter the **Data Item Name**, **Description**, **Classification** (Category or Measure), **Type** (Character or Numeric), **Format**, and **Expression** fields for the new data item.

     **Note**: The **Expression** field of a data item can contain 1024 characters. Do not enter double quotation marks in the **Expression** field.

     Click **OK** to add the new data item to the information map.

   • Delete a data item from the information map by highlighting it and clicking **Delete**.

7. Click **OK** to save the parameters for the Information Map transformation and the information map that it will generate. You will not be able to view the new information map that the modified transformation creates until the corresponding job has run.

   **Note**: To see the results of the job in the hierarchy view, right-click in the hierarchy view and select **Refresh**.

**Note**: SAS Information Map Studio can also be used to modify the information maps that are generated by Information Map transformations in SAS IT Resource Management. However, the information maps that are generated by Information Map transformations in an information map job are regenerated each time that job is run. Therefore, any modifications that are made to an information map using SAS Information Map Studio might be overwritten and lost when the ETL job is rerun. To avoid this situation, modify a copied version of the automatically generated information map. Then save that modified version under a different name so that it will not be overwritten by the ETL processes.

### Delete an Information Map Transformation from a Job

If you delete an Information Map transformation from a job, the information map itself is not deleted and your reports should continue to run correctly. However, if you later change a table, you must regenerate the associated information map in order to reflect the table changes in the report and thus avoid errors in the report. Do not delete an Information Map transformation unless you are certain that this action will not affect your reporting needs.

If you choose to delete an Information Map transformation from a job, perform the following steps:

1. Navigate to the job that contains the Information Map transformation that you want to delete. Double-click the job to open it on the **Diagram** tab of the Job Editor window.

2. Right-click the Information Map transformation in the process flow diagram.

3. From the menu list, select **Delete**.
To save the modified job, from the menu bar select File ➪ Save.

Note: If you delete an Information Map transformation, the information maps that it created previously are not deleted.

**Delete an Information Map**

Deleting an information map can create errors in reporting if your reports use the information map that you delete. Do not delete an information map unless you are certain that this action will not affect your reporting needs.

If you choose to delete an information map, perform the following steps:

1. Navigate to the location that contains the information map that you want to delete. (The default location for information maps is the folder that contains the information map job that creates the information map. However, you might have chosen to store your information map in another location.)
2. Right-click the information map. From the menu list, select Delete.
3. In the confirmation dialog box, click Yes to delete the information map. Otherwise, click No.

Note: If you delete an information map and not the Information Map transformation that created it, a new information map with the same name will be created the next time the corresponding job runs.

**Update an Information Map from a Template**

The following steps enable you to update the Information Map transformation for a table so that the information map’s filters and data items conform to the supplied template. (If an information map template exists for the source table, you can use that template to automatically update the filters and data items of an information map instead of manually specifying them from the Information Map Parameters and Data Items tabs of the Properties dialog box.)

Note: You can attach the Information Map transformation to the existing aggregation job, which generated the table that will be used as the source table for the Information Map transformation. Alternatively, you can place the Information Map transformation in a new or in another existing job.

1. Navigate to the job that contains the aggregation table that was created from a template table. Double-click the job to open it on the Diagram tab of the Job Editor window.
2. In the IT Data Marts tree, locate the aggregation table that was created from a template table. Drag and drop the table onto the Diagram tab of the Job Editor window. (If the table was already present in this job, you can skip this step.)
3. From the Transformations tree of SAS IT Resource Management, locate and expand the ITRM Transformations folder. Scroll down to the Information Map transformation. Then drag and drop the Information Map transformation object onto the open job on the Diagram tab of the Job Editor window.
4. Connect the aggregation table to the left side of the Information Map transformation.
5. Right-click the box that represents the Information Map transformation and select Update map definition from template.
If an aggregation table that was created from a template is not connected to the Information Map transformation, an error message is displayed. Similarly, if an information map template does not exist for the current source table, an error message is displayed.

6. If an information map template is available for the current source table, the following message is displayed: “This action will replace all the filters & data items. Do you want to continue?”

7. To update the information map, click Yes.

8. When the job that contains the Information Map transformation is run, the information map will be created with the updated map attributes, including filters and data items.

   *Note:* To see the results of the job in the hierarchy view, right-click in the hierarchy view and select Refresh.

*Note:* The information map transformation might have a source table that is not an aggregation table, or might have a source aggregation table that was not constructed from a supplied template. In these cases, no information map template is available. Likewise, an aggregation table that was constructed from an aggregation template, but which has been modified by the user to have a different name, might not be recognized as having an information map template.

---

**Information Map Objects That Are Generated by the Adapter Setup Wizard**

**What Information Map Objects Does the Adapter Setup Wizard Generate?**

The Adapter Setup wizard creates jobs that contain Information Map transformations for many of the adapters that SAS IT Resource Management supports. Using the Adapter Setup wizard is the most convenient way to create Information Map transformations and information maps for selected adapters.

When the Adapter Setup wizard is run, it creates objects that pertain to the staging and aggregating of data, and in the case of most supported adapters, the objects that pertain to the creation of information maps, such as the following:

- an information map job.
- Information Map transformations that are contained in the information map job. For most supported adapters, an Information Map transformation is created for each aggregation table.
- information maps that are generated when their corresponding Information Map transformations are run.

   *Note:* To see the results of the job in the hierarchy view, right-click in the hierarchy view and select Refresh.

When generated by the Adapter Setup wizard, information map objects are defined and created according to predetermined conventions for naming, storage, and filter creation. These conventions enable you to effectively manage and locate the information map objects that the Adapter Setup wizard creates.
For more information about the Adapter Setup wizard, see “About the Adapter Setup Wizard” on page 209.

**How the Adapter Setup Wizard Names Information Map Objects**

For consistency and efficient identification, name your Information Map transformations and information maps using the same conventions as the Adapter Setup wizard.

For most supported adapters, the Adapter Setup wizard automatically creates jobs that contain Information Map transformations. The source tables for these transformations are aggregation tables, which are also created by the Adapter Setup wizard. The transformations are given the same names as their associated source aggregation tables—for example, `<level>` (such as week, day, month, and so on) + `<measurement category>` (such as cache, memory, server, network, and so on). The following name is an example of this naming convention:

```
MonthHourServicePctResponse
```

The Information Map transformations also create information maps with the same name as the source aggregation tables. As a result, the aggregation tables, Information Map transformations, and resulting information maps for an information map job created by the Adapter Setup wizard all have the same name. This naming technique helps you identify and associate each object easily.

**Note:** The name of the information map cannot contain any of the following characters: * ? " ' | \ / [ ] $ & > ( ) { } ; ' ~ % ^ @ # ! In addition, the name cannot contain a newline or tab character.

**Where the Adapter Setup Wizard Stores Information Map Objects**

By default, the Adapter Setup wizard stores information maps in the same location as the job that contains the corresponding Information Map transformation. However, you can change where the information map is stored by revising the Information map path field on the Information Map Parameters tab of the Properties dialog box of the Information Map transformation.

For example, when the Network Information Map was run, the resulting information maps were created and stored in the default location. That is, they were stored in a subfolder named for the measurement category in the Network subfolder of the Domain Categories folder of the IT data mart. The following display shows the tree structure of these objects. The Network folder contains the aggregation tables, the information maps, the library, and the aggregation and information map jobs that were created by the Adapter Setup wizard.

**Display 10.5** Network Domain Category

```
[ ] Domain Categories
  [ ] Network
    [ ] KeyMetricsNetwork
    [ ] KeyMetricsNetwork
    [ ] MonthHourNetwork
    [ ] MonithourNetwork
    [ ] MonthNetwork
    [ ] MonthNetwork
    [ ] Network 24
    [ ] Network Aggregation
    [ ] Network Information Map
```
What Information Map Filters Does the Adapter Setup Wizard Create?

When the Adapter Setup wizard creates Information Map transformations, it also creates filters. The wizard automatically provides two categories of filters for columns in the aggregation tables that they are associated with.

• It provides one filter for each ranked statistic column.
• It provides one or more filters for each ranked date class column.

These filters are specified in the Information Map transformations and propagated to the information maps that are created when the job is run. The filters are then available in the information maps for analysis and reporting when you use SAS Enterprise Guide and SAS Web Report Studio.

For more information about working with information map filters, see “Working with Information Map Filters” on page 254.

How the Adapter Setup Wizard Names Information Map Filters

The Adapter Setup wizard uses specific conventions for naming and describing the information map filters that it provides. These conventions use best practices for naming and describing filters in a way that is concise, meaningful, and effective for use with other SAS solutions. For best results, use the following conventions that the Adapter Setup wizard uses when naming and describing the information map filters that you create:

• Provide each filter with a unique name within an information map. No two filters in an information map can have the same name. However, filters with the same name can be in multiple information maps.
• Specify filter names that do not exceed 32 characters in length. The information map library engine that is used by SAS Enterprise Guide to access information maps truncates filter names that are longer than 32 characters.
• Include the ranked column name and the corresponding filter value in the description for the filter. The Adapter Setup wizard includes the ranked column name and the corresponding filter value in the description for the filters that it provides. For example, if the CacheReadHitPctMinAscRank column is filtered in ascending order from one to ten (including one and ten), then the description for that filter is “CacheReadHitPctMinAscRank 1–10.” For best results, use this convention to describe the information map filters that you create so that your information map filters are consistently identifiable.

Working with Information Map Filters

Benefits of Using Information Map Filters

Information maps support filters that enable you to subset data for efficient reporting. These filters make reporting easier by filtering out data that is not necessary for a given report and focusing on the data of interest. For example, you might create and use a filter named “Last Week” that specifies a WHERE clause for WeekDateDescRank=2 in order to report on last week’s data. Or, you might create a filter named “E-mail Servers”
to filter the data with a WHERE clause Domain='E-mail' in order to report on a subset of the data that relates to an e-mail server.

As mentioned in the preceding topic, the Adapter Setup wizard automatically provides several filters for the Information Map transformations that it creates. If you create your own filter for an information map, ensure that the column with which you want to create the filter has been defined in the source table.

Note: A report can use one or more filters and these filters can be selected at reporting time. Unlike aggregation filters, these filters do not filter out any data until they are used in a report.

How to Access the Filters for an Information Map

The filters for an information map can be accessed on the Information Map Parameters tab of the Properties dialog box of the Information Map transformation. To access the filters, perform the steps that are shown in “How to Access the Properties of an Information Map Transformation” on page 243. Then select the Information Map Parameters tab.

Display 10.6 Information Map Parameters

About the Information Map Parameters Tab

As shown in the preceding display, the following information is displayed on the Information Map Parameters tab.

Information map name

specifies the name of the information map that the transformation creates. The name can contain no more than 60 characters. The name of information maps cannot contain any of the following characters: * ? " | \ [ ] $ & < ( ) { } ; ' ; ~ % ^ @ # !

In addition, information map names cannot contain a newline, or tab character. A value is required in this field.

Information map description

defines information about the information map. A value is optional in this field.
Use default path of the job

specifies whether you can enter a path in the Information map path.

- If this box is checked, the Information map path points to the same folder as the job that contains the Information Map transformation. The path is grayed out in the Information map path field. This box is checked by default.

- If this box is not checked, a path can be entered in the Information map path field.

Information map path

specifies where the transformation stores the information map that it generates. If the Use default path of the job is checked, you cannot modify the path. (The path is grayed out.) If that box is not checked, you can enter a new path.

Click Browse to select a path to the information map from the Select a Location dialog box that displays the metadata directory structure.

Information Map Filters

lists the filters for the information map in the form of a grid. Filters in an information map are criteria (rules) that subset data. You can click any of the fields of a filter (Filter Name, Filter Expression, and Filter Description) to change them. You can also add and delete filters for the information map.

#

The numbers under this symbol specify the ordinal position of the filter for the information map.

Filter Name

specifies the name of the filter. The name must be unique and can contain up to 60 characters.

Filter Expression

specifies the filter criteria (rules). The valid form for an expression of an information map filter is <<name of the table.name of the column>> valid operator and value for a numeric column or a string column.

CAUTION:

Filter expressions for information maps are case-sensitive. Filter expressions must not contain any double quotation marks. A discrepancy in case might cause errors or unexpected results when using the information map filter with other SAS solutions. Filter expressions that contain double quotation marks might cause the Information Map transformation to fail when executed.

Here are three examples of valid expressions for information map filters:

- <<DaySystem.DayDateDescRank>> = 1
- <<DaySystem.DayDateDescRank>> between 1 and 7
- <<DaySystem.Machine>> contains 'MACHINENAME'

Note: For more information about filter expressions, see the documentation for PROC INFORMAP in the Base SAS Procedures Guide. This documentation can be found at http://support.sas.com/documentation/onlinedoc/base/index.html.

Description

displays a description of the filter. The description can contain up to 200 characters. However, short descriptions require less system memory and are often processed more efficiently by various SAS solutions.
Note: The Adapter Setup wizard includes the ranked column name and the corresponding filter value in the description for the filters that it provides. For example, if the CacheReadHitPctMinAscRank column is filtered in ascending order from one to ten (including one and ten), then the description for that filter is “CacheReadHitPctMinAscRank 1–10.” For best results, use this same convention to describe the information map filters that you create.

reorders filters by moving a selected filter up in the list.

reorders filters by moving a selected filter down in the list.

New
This button enables you to enter a new information map filter. When you click New, a new row is displayed in the filter list and you can enter the parameter values for the new filter.

Delete
This button enables you to delete an information map filter. Highlight the filter that you want to delete and click Delete.

Add a Filter to an Information Map

To add a filter to an information map, perform the following steps:

1. Navigate to the location that contains the information map where you want to add a filter.

2. In the appropriate Domain Categories folder of the adapter that you are working with, locate the job that contains the transformation for the information map.

3. Double-click the job to open it on the Diagram tab of the Job Editor window.

4. Right-click the box that represents the Information Map transformation. From the menu list, select Properties to open the Properties dialog box.

5. Select the Information Map Parameters tab to view a grid of filters. This grid displays the name, expression, and description of filters that are already defined for the information map that this transformation creates.

6. At the bottom of the page, click New. This action displays a new line in the grid on which you can enter a new filter. The default name of this filter is “Untitledn,” where n is the nth filter that exists for this information map.

7. In the Filter Name column, enter the name of the filter. This name must be unique within the information map.

   Note: Although the Filter Name field can contain up to 60 characters, the information map library engine that is used by SAS Enterprise Guide to access information maps truncates filter names that are longer than 32 characters. To avoid the potential for truncation when using this information map with other SAS solutions, specify a filter name that does not exceed 32 characters in length.

8. In the Filter Expression column, enter the expression that specifies the filter criteria. The valid form for an expression of an information map filter is <<name of the table.name of the column>> valid operator and value for a numeric column or a
Here are three examples of valid expressions for information map filters:

- \(<\text{DaySystem.DayDateDescRank}>> = 1\)
- \(<\text{DaySystem.DayDateDescRank}>> \text{ between 1 and 7}\)
- \(<\text{DaySystem.Machine}>> \text{ contains 'MACHINENAME'}\)

If you enter an invalid expression, the message “Error: Failed to insert filter <name-of-filter>” will display in the log when the job is run.

**CAUTION:**

Filter expressions for information maps are case-sensitive. Filter expressions must not contain any double quotation marks. A discrepancy in case might cause errors or unexpected results when using the information map filter with other SAS solutions. Filter expressions that contain double quotation marks might cause the Information Map transformation to fail when executed.

**Note:** SAS Enterprise Guide honors both measures and categories for information map filters. In SAS Enterprise Guide, you can open the information map that is generated from this transformation and you can select the filters that you have created.

9. In the Description column, enter a brief description of the filter. The description can contain up to 200 characters. However, short descriptions require less system memory and are often processed more efficiently by various SAS solutions. For best results, minimize the number of characters in the description while maintaining meaning and clarity.

**Note:** The Adapter Setup wizard includes the ranked column name and the corresponding filter value in the description for the filters that it provides. For example, if the `CacheReadHitPctMinAscRank` column is filtered in ascending order from one to ten (including one and ten), then the description for that filter is “`CacheReadHitPctMinAscRank 1–10`.” For best results, use this same convention to describe the information map filters that you create.

10. Click **OK** to save. The new filters that you create are available in the information map only after the corresponding job runs.

---

**Modify a Filter on an Information Map**

To modify a filter on an information map, perform the following steps:

1. Navigate to the location that contains the information map where you want to modify a filter.

2. In the appropriate **Domain Categories** folder of the adapter that you are working with, locate the job that contains the transformation for the information map.

3. Double-click the job to open it on the **Diagram** tab of the Job Editor window.

4. Right-click the box that represents the Information Map transformation.

5. From the menu list, select **Properties** to open the Properties dialog box.

6. Select the **Information Map Parameters** tab to view a grid of filters. The grid displays the name, expression, and description of filters that are defined for the information map that this transformation creates.
7. In the Information Map Filters panel of the tab, highlight the field of the filter that you want to change and enter the revised value. In addition, you can click New to add a filter to the grid or Delete to delete a highlighted filter from the grid.

8. Click OK to save the Information Map transformation with its revised filter. The filter is revised only after the corresponding job runs.

**Delete a Filter from an Information Map**

Deleting an information map filter can create unexpected results in reporting if your reports use the filter that was deleted. For example, if a report used an information map filter that was deleted, then the next time the report is run, it can experience errors or produce unexpected results. Do not delete an information map filter unless you are certain that this action will not negatively affect your reporting needs.

To delete a filter from an information map, perform the following steps:

1. Navigate to the location that contains the information map where you want to delete a filter.

2. In the appropriate Domain Categories folder of the adapter that you are working with, locate the job that contains the transformation for the information map.

3. Double-click the job to open it on the Diagram tab of the Job Editor window.

4. Right-click the box that represents the Information Map transformation.

5. From the menu list, select Properties to open the Properties dialog box.

6. Select the Information Map Parameters tab to view a grid of filters. The grid displays the name, expression, and description of filters that are defined for the information map that this transformation creates.

7. Right-click the filter that you want to delete.

8. From the menu list, select Delete.

9. Click OK to save. The filter is deleted in the information map only after the corresponding job runs.

*Note:* Filter changes are not applied immediately. They are applied the next time the job runs.

---

**Using SAS Information Map Studio**

**Overview of SAS Information Map Studio**

SAS Information Map Studio enables you to create and manage information maps outside of SAS IT Resource Management and SAS Data Integration Studio. When you are working with information maps for SAS IT Resource Management, you might choose to use SAS Information Map Studio to perform the following tasks:

- Create and maintain additional information maps other than those that are created by Information Map transformations in SAS IT Resource Management.

*Note:* Information maps can be saved in any location that you specify. You might also choose to use the same guidelines that the Adapter Setup wizard uses to
manage information maps so that all of your information maps are consistent for your IT resource data.

• View information maps that were created by Information Map transformations in SAS IT Resource Management.

Note: You should not use SAS Information Map Studio to modify information maps that were created by Information Map transformations. Changes that are made to an information map using SAS Information Map Studio do not persist in the SAS IT Resource Management Information Map transformation that created the information map. As a result, the changes that are made in SAS Information Map Studio might be overwritten the next time the information map job runs. To avoid this situation, modify a copied version of the automatically generated information map. Then save that modified version under a different name so that it will not be overwritten by the ETL processes.

• Test information maps that were created by Information Map transformations in SAS IT Resource Management.

**Benefits of Using SAS Information Map Studio**

SAS Information Map Studio provides advanced capabilities for creating and managing information maps. These capabilities can provide some advanced benefits when working with information maps for your IT resource data. Here are some of the advanced features that are available in SAS Information Map Studio that might be helpful when managing your information maps:

• joining multiple tables within an IT data mart, across multiple IT data marts, and with other tables outside of the IT data mart.

For information about the rules that govern joins, see “Specify Join Columns” on page 177.

• defining prefilters in information maps.

• using only a subset of available columns to make reporting easier by providing fewer choices of appropriate columns to report on.

• creating folders within an information map to organize data items and filters.

**How to Access SAS Information Map Studio**

To access SAS Information Map Studio and connect to the metadata server that contains your data, perform the following steps:

1. Open SAS Information Map Studio. To do so, from your Start menu, select Programs ⇒ SAS ⇒ SAS Information Map Studio.

2. If you are not connected to a metadata server, perform these steps:
   a. On the SAS Information Map Studio menu bar, right-click File.
   b. From the drop-down list, select Connection Profile where you can specify metadata server that contains the tables that you want to work with.
   c. When the Connection Profile dialog box appears, you can create a connection profile with the Connection Profile wizard. Alternatively, you can open an existing one by selecting Profile from the drop-down list.
   d. If you want to use this connection profile as your default profile, click the corresponding option.
Access an Information Map in SAS Information Map Studio

You can use SAS Information Map Studio to create, modify, view properties, and test information maps.

**CAUTION:**

If the information map was created by a SAS IT Resource Management Information Map transformation, save it with a different name. Changes that are made to an information map using SAS Information Map Studio do not persist in the SAS IT Resource Management Information Map transformation that created the information map. As a result, the changes that are made in SAS Information Map Studio might be overwritten the next time the information map job runs. To avoid this situation, modify a copied version of the automatically generated information map. Then save that modified version under a different name so that it will not be overwritten by the ETL processes.

1. After you connect to the metadata server, use the Folders tree in the Resources panel to navigate to the location of the information map that you want to work with.
2. Highlight the information map that you want to open and click **Open**. Alternatively, you can double-click the information map to open it.
3. The Properties panel displays the properties and the values of the object that is highlighted in the Information Map Contents panel. Click **Details** to display more information about the highlighted object.
   - To view the properties of the information map, highlight the information map name in the Information Map Contents panel.
   - To view the properties of a column, highlight the column name in the Information Map Contents panel.

For more information about SAS Information Map Studio, see the SAS Information Map Studio Help and *SAS Information Map Studio: Getting Started with SAS Information Maps*.

Create an Information Map with SAS Information Map Studio

To create an information map, select **File** ⇒ **New** from the menu bar. In the Resources panel, navigate to the IT data mart that contains the table for which you want to create an information map. Double-click the table to display its items in the Information Map Contents panel.

- To add a new folder, data item, or filter to the map, in the Information Map Contents panel right-click the map and select an option from the drop-down list.
  
  **Note:** Do not enter blank spaces in the **Name** field of a data item. To do so causes errors when the report is processed in Gallery Manager.

- To delete an item from the map, highlight the item and select **Delete** from the drop-down list.

- To rename an item on the map, highlight the item and select **Rename** from the drop-down list.

Save the information map by selecting **File** ⇒ **Save** from the menu bar.
To be consistent with the naming conventions of the Adapter Setup wizard, save the information map under the same name as the table on which it is based. For information about the naming conventions that are used by the Adapter Setup wizard, see “How the Adapter Setup Wizard Names Information Map Objects” on page 253.

Modify, Rename, or Delete Items in an Information Map with SAS Information Map Studio

To modify an existing information map, navigate to the map and double-click it. The items in the existing map are displayed in the Information Map Contents panel.

- To add a new folder, data item, or filter to the map, in the Information Map Contents panel, right-click the map and select an option from the drop-down list.
  
  Note: Do not enter blank spaces in the Name field of a data item. To do so causes errors when the report is processed in Gallery Manager.

- To delete an item from the map, right-click the item and select Delete from the drop-down list.

- To rename an item on the map, right-click the item and select Rename from the drop-down list.

- When you are finished making changes, click OK.

Save the information map by selecting File ⇒ Save from the menu bar.

Test an Information Map with SAS Information Map Studio

To test a map, select Tools ⇒ Run a Test Query. Then, select one or more items from the Available items panel and add them to the Selected items box.

Display 10.7  Test the Information Map Window

Set the Output options to specify how you want to view the results and click Run Test. The results are displayed in a separate window.
Troubleshooting Information Maps Problems

Information Map Does Not Appear in the IT Data Mart Folder

Problem: After successful execution of an Information Map transformation, the resulting information map is not displayed in the IT Data Mart folder.

Solution: To view the results of a successful execution of an Information Map transformation, you must explicitly refresh the current tree or work area. To do so, right-click somewhere in the tree. From the drop-down menu, click Refresh.

Lengthy Processing Time

Problem: Information maps take quite a bit of time to process.

Solution: To save processing time, you might want to delete any Information Map transformations for information maps that will not be used. You might also save processing time by deleting filters that are not useful.

Error Opening or Accessing Data from Information Maps


Solution: To determine whether you have Read access restrictions that prevent you from accessing the data, perform the following steps:

• Open SAS Information Map Studio. Navigate to the information map that experienced the error.

• From the Resources panel, select items from the information map that you want to verify and add them to the Selected Resources panel. Verify that the columns of the selected table are displayed correctly in the Information Map Contents panel.

• Select Tools ⇒ Run a Test Query.

• Click Run Test.

If you see any errors or warnings during the preceding steps, verify that you have Read privileges and Read metadata privileges. Otherwise, contact your data administrator.

Errors Running Information Map Transformations

Problem: An error occurs when running the Information Map job and information maps are not created.

Solution: Information Map transformations use PROC INFOMAPS, which requires specific authorization settings. Review the following list of authorization requirements and recommended configurations to ensure that your settings are configured correctly:

• Your user logon ID and password must be stored in metadata, using the SAS Management Console.
Note: At run time, PROC INFOMAPS authenticates the user to the metadata server using the one-time password technique documented for SAS 9.2 and later. This means that the user submitting the code (whether interactively or in batch) should have a User object defined in the metadata and a Login object defined for each authentication domain, with the correct user ID and password for each. In SAS Management Console, the User Manager can be used to create and modify Users. For each User object, the logins can be created or modified on the Accounts tab of the User dialog box. For more information, see “Security Overview” in SAS Intelligence Platform: Overview.

- You must have access to the physical files and directories. (PROC INFOMAPS does not validate the table at run time.)
- You must have Read authorization to the physical tables.
- You cannot have multiple SAS libraries with the same metadata name.
- Your default ACT on SAS Foundation must be set according to the configurations that are detailed in the installation guide for your operating environment.

Note: You can submit jobs if you are logged on as an administrative user. However, this is not recommended.

Information Job Fails

If you change the name of the source aggregation table or the name of a column in that table, you must manually change the associated filter expressions for the information map. You can then redeploy and rerun the job.
Chapter 11
User-Written Staging Code

User-Written Staging Transformations ........................................ 265
  Overview .................................................................................. 265
What Are the Properties of the User-Written Staging Transformation? ...... 266
  General Tab ............................................................................. 266
  Staging Parameters Tab ............................................................. 266
  Code Tab .................................................................................. 267
  Precode and Postcode Tab ........................................................ 267
  Notes Tab ................................................................................. 267
  Extended Attributes Tab .............................................................. 267
Guidelines for Processing Data with User-Written Staging Transformations ... 267
  About Processing Data with User-Written Staging Transformations .... 267
  Staging Data with User-Written Staging Transformations ................. 268
  Aggregating Data Created by User-Written Staging Transformations .... 279
  Creating Information Maps for User-Written Adapters ................... 281
  Reporting on Data Created with User-Written Staging Transformations ... 284
Working with User-Written Staging Transformations ......................... 284
  Create a User-Written Staging Transformation .............................. 284
  Delete a User-Written Staging Transformation from a Job ................ 290
  Modify a User-Written Staging Transformation .............................. 291
  Rename a User-Written Staging Transformation ............................ 291
Using the Additional Generated Code ........................................... 292
  Macro Variables ....................................................................... 292
  Macros ..................................................................................... 292
  Tabinfo and Varinfo .................................................................. 293

User-Written Staging Transformations

Overview

The SAS IT Resource Management User-Written Staging transformation provides a place for you to enter your staging code for a data source. The process consists of the following steps:

1. dropping the User-Written Staging transformation onto a job on the Diagram tab of the Job Editor window

2. (optional) attaching a source table
3. writing the SAS program to load raw data into SAS tables
4. attaching target tables
5. specifying the options and parameters for the transformation, including the location of the staging code
6. generating the code and running the job

When the code is generated, macros and macro variables that might be useful in the user-written code are also generated. After reviewing the generated code, you can save the job and run it to create the physical tables. However, before doing so, you must create the metadata for the target table by invoking the New Table wizard. (To do so, from the SAS Data Integration Studio menu, select File ⇒ New ⇒ Table.)

For more guidance about the processes that enable you to create user-written staging transformations, see “Guidelines for Processing Data with User-Written Staging Transformations” on page 267. This topic also includes information about aggregating, creating information maps, and reporting on the data that is produced by your user-written staging code.

The remainder of this chapter consists of the four following topics:

- “What Are the Properties of the User-Written Staging Transformation?” on page 266
- “Guidelines for Processing Data with User-Written Staging Transformations” on page 267
- “Working with User-Written Staging Transformations” on page 284
- “Using the Additional Generated Code” on page 292

---

### What Are the Properties of the User-Written Staging Transformation?

#### General Tab

The General tab contains the following information about the table. The fields on this tab can be modified.

- **Name**: identifies the name of the user-written staging transformation that you are specifying.
- **Description**: describes the user-written staging transformation that you are specifying.

#### Staging Parameters Tab

The Staging parameters tab contains three subgroups of information: Staging, Duplicate Checking, and User Written. In the left panel, you can select the subgroup whose properties you want to specify. For information about these properties, see Step 8 of the Create a User-Written Staging Transformation topic on page 285.
Code Tab

The Code tab can display and manage the code that is generated for the User-Written Staging transformation. Click Help for more information about this tab.

Precode and Postcode Tab

The Precode and Postcode tab contains Precode and Postcode check boxes that enable you to specify that user-written code should be inserted at the beginning or end of the current job or transformation. Click Help for more information about this tab.

Notes Tab

The Notes tab contains areas where you can annotate the table. Click Help for more information about this tab.

Extended Attributes Tab

The Extended Attributes tab contains custom properties that are not part of the standard metadata for the transformation. All extended attributes that are added to this tab will be made into macro variables when the code for this transformation is generated. Click Help for more information about this tab.

Guidelines for Processing Data with User-Written Staging Transformations

About Processing Data with User-Written Staging Transformations

The user-written staging transformation enables you to create your own staging code. You can process data from any data source that SAS can read and you can generate user-defined staged tables. These user-defined staged tables can then be used as the source tables for additional transformations, including the Aggregation and Information Map transformations, in preparation for reporting on the data in those tables.

The following topics provide guidelines that describe how to work with user-written transformations:

- “Staging Data with User-Written Staging Transformations” on page 268
- “Aggregating Data Created by User-Written Staging Transformations” on page 279
- “Creating Information Maps for User-Written Adapters” on page 281
- “Reporting on Data Created with User-Written Staging Transformations” on page 284

These topics explain the process of developing a user-written adapter to be used with the SAS IT Resource Management 3.3 client. The method described in the following topics is not the only way to create an adapter. You can write an adapter in any way that you want. However, this method can help you follow the same standards that are used for the supplied SAS IT Resource Management 3.3 adapters. Following these standards keeps your adapter consistent with other adapters. You can use some or all of the following
processes as needed. For information about standards that should be followed to keep your adapter consistent with adapters that SAS IT Resource Management provide, see “About Naming Standards for SAS IT Resource Management Objects” on page 493.

Staging Data with User-Written Staging Transformations

Overview of Staging Data with User-Written Staging Transformations

The staging step reads data from a raw data source and makes SAS staged tables. These staged tables are then used as the source to the Aggregation transformation. The User-Written Staging transformation is provided in the SAS IT Resource Management client to help in the development of the staging process. This transformation enables staged table developers to point to their own SAS code that can read the raw data and create the SAS tables. In addition, the User-Written Staging transformation supplies a set of macros and macro variables that provide information from the metadata that can be useful when creating the target tables.

The following topics discuss best practices or guidelines for staging the data with user-written staging transformations, aggregating the data processed by those transformations, creating information maps for the aggregated tables of data, and reporting on that data.

For more information about staged tables, see “About Staging the Data” on page 120.

How to Stage Data with User-Written Staging Transformations

Use the following steps as a guide to staging the data with the User-Written Staging transformation.

1. Design the adapter.

   To accomplish this step, you need to thoroughly understand the raw data. You also need to determine what your staged tables should look like. For example, you should determine the names of the staged tables, the column names for each table, the attributes of the columns, and so on.

2. Create an IT data mart.

   On the IT Data Marts tab create an IT data mart for your adapter. For information, see “Create an IT Data Mart” on page 67.

3. Set up the metadata for your staged tables.

   Create the folder for your staged tables and libraries.

   a. Right-click the IT data mart that you just created. Select New ⇒ New Folder.

   b. Right-click the new folder that you just created and select New ⇒ New Folder.


   d. Select SAS Base Library as the type of library that you want to define. On the next page of the wizard, specify a name such as Staging for the new library.

   e. On the next page of the wizard, choose SASITRM.

   f. On the next page of the wizard, specify the libref that is associated with the staged table library.
For best results, specify the name of the libref as stgxxxx, where xxxx is a random number to ensure that the libref is not used elsewhere.

In the Path Specification box, click New to add a new path.

**TIP** Use the root path that you specified for the IT data mart that you created and add an identifier to the end of that path. The identifier could be the folder, directory, or name of the libref, according to the standards of your operating environment. For best results, use the same name as the libref you just specified. For example, on Windows, if your root path is C:\DataMarts\MyAdapter, and your libref is stg1357, then specify this library path as C:\DataMarts\MyAdapter\stg1357.

g. Continue to follow the prompts of the wizard to create the appropriate metadata for the library.

4. On your operating system, create the physical folder for the library. (The previous step created only the metadata for the library.)

5. Write the SAS code to read the raw data and create SAS tables as output. The complexity of this step varies depending on the raw data that you are reading and the tables that you are creating.

**TIP** This code can be any SAS program that creates one or more permanent SAS data tables as output. These tables should be put in the location that you created in step 4. It will simplify your work later if you use the same libref that you specified in step 3.

For best results, consider adding the following columns to your staged tables.

- **DATETIME**
  
  In the adapters that are supplied by SAS IT Resource Management, the staged tables are date and time based. All the tables contain a column called DATETIME to hold this information. Using this column name enables you to use the supplied formulas and the duplicate and future checking processes without modification. Its attributes are as follows:

  ```sas
  attrib DATETIME length = 8
  format = NLDATM.
  label = 'Datetime';
  
  Note: DATETIME is the starting date and time of interval data. If the raw data provides the ending date and time, you should subtract the interval duration from the date and time in order to calculate the starting date and time.
  ```

- **LSTPDATE**
  
  In order to take advantage of the duplicate checking process that is available in SAS IT Resource Management aggregations, include a column called LSTPDATE in your staging tables. This column should be set to the current date and time:

  ```sas
  LSTPDATE = datetime();
  ```

  Its attributes are as follows:

  ```sas
  attrib LSTPDATE length = 8
  format = NLDATM.
  label = 'LastProcessDate';
  ```

- **DURATION**
  
  In order to take advantage of the duplicate checking process that is available in SAS IT Resource Management aggregations, include a column called LSTPDATE in your staging tables. This column should be set to the current date and time: LSTPDATE = datetime();

  Its attributes are as follows:

  ```sas
  attrib DURATION length = 8
  format = NLDATM.
  label = 'LastProcessDate';
  ```

- **DURATION**
Interval-type data is data that is captured or snapshot at given intervals. For interval type data, supplied adapters include a field called DURATION. This field is set to the duration of each interval in seconds. It is useful as the weight variable in an aggregation when creating weighted statistics. Its attributes are as follows:

```
attrib DURATION length = 8
  format = TIME8.
  label = 'Duration';
```

Assign an appropriate format and label to your other columns. (You can also do this at a later time in the SAS IT Resource Management client in steps 9.k through 9.m.)

*Note:* It is not necessary to create aggregation variables such as Hour, Shift, WeekDate, and so on. You can add these columns in step 9.l.

6. Run the program to create the staged tables.


**How to register your staged tables.**

a. On the SAS IT Resource Management client, right-click the staging library that you created in steps 3c through 3g, and select Register Tables. The Register Tables wizard opens.

b. On the first page of the wizard, you do not need to make any changes. Your library is listed on that page.

c. The tables that you created in step 6 are listed. Click Select All Tables to register all the tables in metadata.

d. Continue to follow the prompts of the wizard to complete the registration.

8. If the input to the User-Written Staging transformation is a SAS data set or another type of database table, then create the metadata for it.

**TIP** One method that you can use to create the necessary metadata for your input is to create a library in metadata that points to your source data. Then select File ➔ Register Tables to register the tables in metadata.

9. Create a staging job to populate the staging tables.

**How to create a staging job.**

a. Right-click the Staging folder in your IT data mart and select New ➔ Job.

b. Give the job a name such as Staging.

c. From the Transformations tree, expand ITRM Transformations. Then drag the User-Written Staging transformation onto the job that you just created in the Diagram tab of the Job Editor window.

d. Drag the staging tables from the Staging folder in your IT data mart onto the job.

e. Connect the User-Written Staging transformation to each of the staging tables so that the tables are outputs of the transformation.

f. If you created input metadata in step 8, then drag the input table to the job. Connect the table as input to the User-Written Staging transformation.
g. Right-click the User-Written Staging transformation and select **Properties**. From the drop-down list, select the **Staging Parameters** tab. The Staging page appears.

a. On the Staging page, specify the path to the raw data that you want to process. A macro variable called Rawdata will be created in the generated code with this value.

b. Select the **Duplicate Checking** option in the left panel. The Duplicate Checking page appears. On this page, you can specify duplicate checking and future data actions. The page provides a set of parameters that will be used if you decide to implement the duplicate checking process. For information about how to implement duplicate checking of your data, see “Duplicate Checking” on page 274.

c. Select the **User-Written** option in the left panel. The User-Written page appears. The first parameter on this page enables you to specify the path to your SAS staging program. A value for this parameter is required. The other parameters enable you to specify what macros and macro variables you want the transformation to generate for your SAS program.

**Note:** For information about these properties, see Step 8 of the “Create a User-Written Staging Transformation” topic on page 285.

**TIP** You can click the **Reset to defaults** option at the top of the page to reset all the parameters in that subgroup to the values that were established when SAS IT Resource Management was installed. Click the **Reset** option next to any one of these parameters to reset it to the value that was established when SAS IT Resource Management was installed. Also note that **Reset to defaults** does not reset a parameter that is dependent on another parameter if the parent parameter does not change.

d. Standard SAS IT Resource Management formulas are provided to compute columns such as WEEKDATE and SHIFT. If you want to use any of these formulas, double-click the tables in the job that is opened in the **Diagram** tab of the Job Editor window. Then select the **Columns** tab.

e. On the **Columns** tab, you can add the standard SAS IT Resource Management date columns and their formulas.

The following table lists the standard columns.

**Table 11.1 Table of Standard SAS IT Resource Management Columns**

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Length</th>
<th>Format</th>
<th>SAS IT Resource Management Formula</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATETIMEFIFTEENMIN</td>
<td>Length: 8</td>
<td>NLDATM.</td>
<td>DatetimeFifteenMinute</td>
<td>DatetimeFifteenMinute</td>
</tr>
<tr>
<td>DATETIMEFIVMIN</td>
<td>Length: 8</td>
<td>NLDATM.</td>
<td>DatetimeFiveMinute</td>
<td>DatetimeFiveMinute</td>
</tr>
<tr>
<td>Column Name</td>
<td>Length</td>
<td>Format</td>
<td>SAS IT Resource Management Formula</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------</td>
<td>--------------</td>
<td>-----------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>DATETIMEONEMIN</td>
<td>Length: 8</td>
<td>Format: NLDATM.</td>
<td>DatetimeOneMinute</td>
<td>DatetimeOneMinute</td>
</tr>
<tr>
<td>DATETIMETENMIN</td>
<td>Length: 8</td>
<td>Format: NLDATM.</td>
<td>DatetimeTenMinute</td>
<td>DatetimeTenMinute</td>
</tr>
<tr>
<td>DATETIMETHIRTYMIN</td>
<td>Length: 8</td>
<td>Format: NLDATM.</td>
<td>DatetimeThirtyMinute</td>
<td>DatetimeThirtyMinute</td>
</tr>
<tr>
<td>DATETIMETWENTYMIN</td>
<td>Length: 8</td>
<td>Format: NLDATM.</td>
<td>DatetimeTwentyMinute</td>
<td>DatetimeTwentyMinute</td>
</tr>
<tr>
<td>DAYDATE</td>
<td>Length: 8</td>
<td>Format: NLDATE10.</td>
<td>DayDate</td>
<td>DayDate</td>
</tr>
<tr>
<td>DAYOFMONTH</td>
<td>Length: 8</td>
<td>Format: 2.</td>
<td>DayOfMonth</td>
<td>DayOfMonth</td>
</tr>
<tr>
<td>DAYOFWEEK</td>
<td>Length: 8</td>
<td>Format: WKD.</td>
<td>DayOfWeek</td>
<td>DayOfWeek</td>
</tr>
<tr>
<td>HOUR</td>
<td>Length: 8</td>
<td>Format: 2.</td>
<td>Hour</td>
<td>Hour</td>
</tr>
<tr>
<td>MONTHDATE</td>
<td>Length: 8</td>
<td>Format: NLDATE10.</td>
<td>MonthDate</td>
<td>MonthDate</td>
</tr>
<tr>
<td>SHIFT</td>
<td>Length: $1</td>
<td>Format: SCHAR1.</td>
<td>Shift</td>
<td>Shift</td>
</tr>
<tr>
<td>TIME</td>
<td>Length: 8</td>
<td>Format: TOD5.</td>
<td>Time</td>
<td>Time</td>
</tr>
<tr>
<td>Column Name</td>
<td>Length: 8</td>
<td>Format: NLDATE10</td>
<td>SAS IT Resource Management Formula</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------</td>
<td>------------------</td>
<td>-----------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>WEEKDATE</td>
<td>WeekDate</td>
<td>WeekDate</td>
<td>WeekDate</td>
<td></td>
</tr>
<tr>
<td>YEARDATE</td>
<td>YearDate</td>
<td>YearDate</td>
<td>YearDate</td>
<td></td>
</tr>
</tbody>
</table>

Tip: It is easier to add these computed columns to the metadata using the SAS IT Resource Management client than to include them in the physical table that you used to register the table. If you include them when you register the table, then they will all be created as “Data Columns” instead of “Computed Columns.” In that case, you must delete the columns and then re-create them as “Computed Columns.”

From the **Columns** tab, you can import columns from another source or add new columns.

**Import columns to your staged table.**

a. Click the Import Columns icon.

Tip: The Import Columns icon is next to the **New** button.

b. In the Import Columns dialog box, expand **Adapters**. Then drill down to any standard adapter template table.

Tip: One of the SAR adapter template tables is a good choice because these tables are small.

c. Choose the columns that you want to include in your staging tables. For information about available columns, see the preceding list of columns.

d. Click OK. The columns are added to your table with the appropriate attributes and formulas.

**Add new columns to your staged table.**

e. Click the **New** button.

f. You can add data and computed columns to your staged table. For information, see “Columns in Staged Tables” on page 141.

g. If you add computed columns, the automatically generated macro called _ITMS_computedColumns can be used in your SAS program to calculate the values of these columns.

**CAUTION:**

When creating a computed column, do not base it on another computed column, because the code might not calculate the columns in the correct order. For example, if you are computing column A as \(1+1\), and you want another computed column called B that is \(A+5\), then the expression for B should be \((1+1)+5\), not \(A+5\).

Expressions can be simple or complex.
• A simple expression is only the content on the right side of an equation without a semicolon.

• A complex expression contains multiple statements including the necessary semicolons. The following code is an example of a complex expression.

if \( \frac{1}{A} \) (\(A \neq 0\)) then \(B=\frac{1}{A}\); else \(B=0\);

This code prevents division by zero, which causes errors when the code runs.

10. Save the job and deploy the SAS code. To do so, right-click the job and select Scheduling ⇒ Deploy. For more information, see “Deploy a Job for Scheduling” on page 306.

11. To make your SAS program more robust, you might want to use some of the macro variables and macros that are provided by SAS IT Resource Management. These macros and macro variables enable your program to handle changes in metadata without changing the program. The following topics discuss some of the changes that you can make to your program.

• “Duplicate Checking” on page 274

• “Future Checking” on page 275

• “Error Checking” on page 276

• “LIBNAME Statements” on page 276

• “Formats” on page 276

• “Helper Macros and Macro Variables” on page 276

For examples of how macros and macro variables can be used, see “Example of Modifying the Code” on page 277.

**Duplicate Checking**

A set of macros is provided to check for duplicate data. These macros are used in all the supplied adapters to handle reading and saving duplicate data. If your SAS program finds data in the raw data that has already been read, then the data is handled based on the setting of the Duplicate checking options on the Duplicate Checking page of the Staging Parameters tab. The following actions are available if you set Duplicate checking options to Yes:

• Discard—delete the duplicate data from the input stream

• Terminate—stop processing

• Force—ignore any duplicate data and continue processing

**Tip** To access the Duplicate checking options, you must first set Enable duplicate checking to Yes. This setting displays all the parameters that are available for the User-Written Staging transformation. If Enable duplicate checking is set to No, none of these parameters are displayed.

You can use some of the helper macros from the User-Written Staging transformation as well as the standard duplicate-data checking macros to handle duplicate-data checking. For more information about duplicate-data checking macros, see “Duplicate-Data Checking Macros” on page 506. To implement duplicate checking in your code, perform the following steps.

1. In the DATA statement of the DATA step that reads the raw data, add this macro call:

   `%RMDUPDSN (SOURCE=USR)`
This creates a work data set with duplicate information. For example, suppose that the following is the current data statement:

```plaintext
data stage.stageTable1
    stage.stageTable2;
```

Change the macro invocation to this:

```plaintext
data stage.stageTable1
    stage.stageTable2
%RMDUPDSN(SOURCE=USR);
```

2. At the beginning of the DATA step, add this macro call:

```plaintext
%_ITMS_dupInit;
```

This initializes the duplicate-data checking process.

3. On the SET or INFILE statement, be sure to include the END= option. This option should point to the ENDFILE variable specified on the Duplicate Checking page of the Staging Parameters tab of the User-Written Staging Properties dialog box.

4. In the DATA step, you also need to add this macro call:

```plaintext
%_ITMS_dupCheck;
```

This macro runs the %RMDUPCHK macro, which performs the duplicate-data checking. The parameters for the %RMDUPCHK macro are specified on the Duplicate Checking page of the Staging Parameters tab of the User-Written Staging Properties dialog box. You can call this macro multiple times in your code if the TIMESTMP column is set in different places.

**TIP** Put this macro call in the DATA step at any point after the TIMESTMP column has a value. TIMESTMP is a parameter in the %RMDUPCHK macro that specifies the date and time column name. (Typically, this column is DATETIME, but you can call it anything you want.) Specify the column to use on the Staging Parameters tab of the User-Written Staging Properties dialog box.

5. Following the DATA step that ran the _ITMS_dupCheck macro, add this macro call:

```plaintext
%RMDUPUPD;
```

This macro completes the duplicate checking process by adding the new date and time stamps from the data that was just read to the duplicate checking tables that are kept in the staging library.

**Future Checking**

A set of macros is provided to check for data that has a date and time stamp that is in the future. (This situation probably means that the data is invalid). These macros assume that your TIMESTMP variable (as described in the previous duplicate checking page) is called DATETIME.

To implement future checking, you can use a User-Written Staging transformation helper macro as well as the standard future processing macros:

- In the DATA step that you use to read the raw data, add this macro call after the DATETIME column has been set:

```plaintext
%RMSETFTR;
```
Note: You can call this macro multiple times if the DATETIME column is set in multiple places.

- After the DATA step that ran the %RMSETFTR macro, add this macro call:

  %_ITMS_futureData;

  This macro invokes the %RMFUTURE macro for all your staging tables.

Error Checking
If you do error checking in your program, you can take advantage of the abnormal ending routine that is provided at the end of the generated code. If you set the macro variable &trans_rc to a value greater than 4, then the program will be canceled and set its return code to 8 (abort cancel 8;).

To set the &trans_rc and the &job_rc error flags outside of a PROC step or DATA step, you can use the %RCSET(ERROR) macro. To set those flags inside a DATA step, you can use the %RCSETDS(ERROR) macro.

The error parameter for these macros is the error code that you want to specify. For example, you can use the following code to set a return code of 8.

  %rcSet(8);

You can use the following code to set the return code to the error code from the proceeding DATA step or PROC step.

  %rcSet(&syserr);;

The macro definitions for %RCSET and %RCSETDS can be found at the beginning of the generated code.

LIBNAME Statements
All the LIBNAME statements for the source and target tables will be generated for you. Therefore, you do not need to include LIBNAME code in the user-written code. However, if you are using tables that are not in the metadata as source or target tables, then you should issue your own LIBNAME statements.

Formats
To access standard SAS IT Resource Management formats, set the FMTSEARCH option as follows:

  options fmtsearch=(admin.formats sashelp.itms_formats);

Your own formats can be put in the ADMIN.FORMATS catalog or in your own catalog. If you use a different catalog, you need a LIBNAME statement for that library. You then need to set the FMTSEARCH option to point to your formats. For example:

  options fmtsearch=(admin.formats mylib.formats sashelp.itms_formats);

The NOFMTERR option will be set for you so that processing does not fail if there is a missing format.

Helper Macros and Macro Variables
A set of macros and macro variables can be created for you in the generated code. On the Staging Parameters tab of the User-Written Staging Properties dialog box, select User-Written to access these options. For information about the macro variables and macros that are available, see “Macro Variables” on page 292 and “Macros” on page 292.
Set all the options on the macro variables to Yes, and then generate the code. You can then see what macros and macro variables are available and determine whether you want to use them. You can then turn off the macros and macro variables that you do not need.

On the User-Written page of the Staging Parameters tab of the User-Written Staging Properties dialog box, you can also specify the creation of the Tabinfo and Varinfo tables. For information about these tables, see “Tabinfo and Varinfo” on page 293.

Example of Modifying the Code
The following two examples show a simple user-written staging program before it is modified, and then after it is modified to include the helper macros.

Example Code 11.1 Original Program

```plaintext
LIBNAME STAGING 'C:\USERWRITTEN\STAGING';
DATA STAGING.METRIC1 (KEEP = DATETIME MACHINE METRIC1 LSTPDATE)
    STAGING.METRIC2 (KEEP = DATETIME MACHINE METRIC3 LSTPDATE);
ATTRIB DATETIME LABEL = "DATE" FORMAT = DATETIME18.;
ATTRIB MACHINE LABEL = "MACHINE" LENGTH = $20;
ATTRIB METRIC1 LABEL = "METRIC1" FORMAT = NLNUM16.;
ATTRIB METRIC3 LABEL = "METRIC2*100" FORMAT = NLNUM16.;
ATTRIB LSTPDATE LABEL = "LASTPROCESSDATE" FORMAT = NLDATM.;
ATTRIB METRIC2 FORMAT = NLNUM16.;
LSTPDATE = DATETIME(); /* needed for aggregation */
INFILE "C:\USERWRITTEN\RAWDATA.TXT" MISSOVER;
INPUT DATETIME DATETIME15. MACHINE METRIC1 METRIC2;
METRIC3 = METRIC2 * 100;
OUTPUT STAGING.METRIC1
    STAGING.METRIC2;
RUN;
```

Here is what the program might look after adding the helper macros.

Example Code 11.2 Modified Program

```plaintext
LIBNAME STAGING 'C:\USERWRITTEN\STAGING';
DATA STAGING.METRIC1 (KEEP = DATETIME MACHINE METRIC1 LSTPDATE)
    STAGING.METRIC2 (KEEP = DATETIME MACHINE METRIC3 LSTPDATE);
ATTRIB DATETIME LABEL = "DATE" FORMAT = DATETIME18.;
ATTRIB MACHINE LABEL = "MACHINE" LENGTH = $20;
ATTRIB METRIC1 LABEL = "METRIC1" FORMAT = NLNUM16.;
ATTRIB METRIC3 LABEL = "METRIC2*100" FORMAT = NLNUM16.;
ATTRIB LSTPDATE LABEL = "LASTPROCESSDATE" FORMAT = NLDATM.;
ATTRIB METRIC2 FORMAT = NLNUM16.;
LSTPDATE = DATETIME(); /* needed for aggregation */
INFILE "C:\USERWRITTEN\RAWDATA.TXT" MISSOVER;
INPUT DATETIME DATETIME15. MACHINE METRIC1 METRIC2;
METRIC3 = METRIC2 * 100;
OUTPUT STAGING.METRIC1
    STAGING.METRIC2;
RUN;
```
/* ddMONyyyy:hh:mm machineName metric1 metric2                    */
/* <etc.>                                                         */
/* ************************************************************** */
/* ***PUT CODE INTO A MACRO IN ORDER TO USE %DO STATEMENTS***     */
%macro readRawdata;
/*  libname staging 'c:\UserWritten\Staging';                     */
data
/* ***GENERATE TABLE NAMES WITH OPTIONS AND KEEP LISTS***         */
%do i = 1 %to &numTargets;
&&target&i (%_ITMS_tableOptions(targetTableNum=&i,
generateTableName=NO)
  keep = %_ITMS_columnList(targetTableNum=&i))
%end;
/* ***DUPLICATE CHECKING OUTPUT TABLE***                         */
%RMDUPDSN(SOURCE=USR)
/*      staging.metric1 (keep = datetime machine                 */
/*                              metric1 lstpdate)                */
/*      staging.metric2 (keep = datetime machine                 */
/*                              metric2 metric3 lstpdate)        */;
/* ***INITIALIZE DUPLICATE CHECKING***                           */
%_ITMS_dupInit;
/* ***GENERATE ATTRIB STATEMENTS FOR COLUMNS IN OUTPUT TABLES*** */
%_ITMS_attrib();
/*  attrib datetime label = "DateTime" format = datetime18.;     */
/*  attrib machine  label = "Machine"  length = $20;             */
/*  attrib metric1  label = "Metric1"  format = NLNUM16.;        */
/*  attrib metric3  label = "Metric2*100" format = NLNUM16.;     */
/*  attrib lstpdate label = "LastProcessDate" format = NLDATM.;  */
attrib metric2  format = NLNUM16.;
lstpdate = datetime();   /* needed for aggregation */
/*    infile "c:\UserWritten\rawdata.txt" missover;              */
/* ***USE &RAWDATA AND INCLUDE AN END-OF-FILE FLAG FOR***        */
/* ***DUPLICATE CHECKING***                                      */
infile "rawdata" end = _eof missover;
input datetime datetime15. machine metric1 metric2;
/* ***RUN DUPLICATE CHECKING***                                  */
%_ITMS_dupCheck;
/* ***RUN FUTURE DATA CHECKING***                                */
%RMSETFTR;
/* ***CREATE COMPUTED COLUMNS***                                 */
%_ITMS_computedColumns;
/*  metric3 = metric2 * 100;                                     */
/* ***OUTPUT DATA TO TARGET TABLES***                            */
output
%do i = 1 %to &numTargets
  &&target&i
%end;
/*    output staging.metric1                                     */
/*    staging.metric2;                                           */
run;
/* ***UPDATE DUPLICATE CHECKING FILES***                         */
%RMDUPUPD;
Aggregating Data Created by User-Written Staging Transformations

After the data is staged, it is ready to be aggregated. The data in the staged tables that you created can be rolled up into aggregation tables. These tables are then available for analysis.

Creating and working with aggregations is described in detail in chapter 8, “Aggregating the Data.” For information, see “About Aggregation Tables” on page 149.

Use the following tips to keep your user-written adapter consistent with the supplied adapters.

- In the IT data mart that you created for your user-written adapter, create a folder called Domain Categories. Within that folder, create one or more folders for your domain categories. (A domain category is a way of grouping different types of data such as System, Disk, or Network data.) Specify a name for these categories that makes sense for your application.

Many of the supplied adapters have a domain category for each of the staged tables that were created. If you do not have domain categories, create a single folder that has a descriptive name.

- Create an aggregation job for each domain category. Specify a job name using this format: <domain category> Aggregation.

- In the supplied adapters, the data in each staged table is used as input to multiple aggregations. The data is typically summarized into different time periods. Most supplied adapters include the following time period aggregations.

<table>
<thead>
<tr>
<th>Table 11.2 Supplied Time Period Aggregations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation Table Prefix</td>
</tr>
<tr>
<td>--------------------------</td>
</tr>
<tr>
<td>Day</td>
</tr>
<tr>
<td>DayHour</td>
</tr>
<tr>
<td>DayShift</td>
</tr>
<tr>
<td>DayShiftHour</td>
</tr>
<tr>
<td>Week</td>
</tr>
<tr>
<td>WeekHour</td>
</tr>
<tr>
<td>WeekShift</td>
</tr>
<tr>
<td>WeekShiftHour</td>
</tr>
<tr>
<td>Month</td>
</tr>
<tr>
<td>MonthHour</td>
</tr>
</tbody>
</table>
In addition, many adapters supply the following aggregations:

**Table 11.3  Other Supplied Aggregations**

<table>
<thead>
<tr>
<th>Aggregation Table Prefix</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail</td>
<td>This data is not summarized. It is left at the same level as the staging data.</td>
</tr>
<tr>
<td>KeyMetrics</td>
<td>Generally, this data is summarized into the DAYDATE and HOUR level. It also includes a limited number of metrics. This table usually keeps data for a longer period than the other aggregations, so that it can be used in trending and forecasting.</td>
</tr>
</tbody>
</table>

**TIP** For the best results, use these standard prefixes on your aggregation tables. The tables will then conform to the standard that is used for the supplied adapters.

- Consider using rank columns if needed.

Rank columns can be used to create “Top N” reports and ranked listings. They also provide a way to filter the data. With rank columns, you can filter the data so that only data from a certain time period (relative to the data that has been collected) is processed in the reports. For example, if you want the data for yesterday, you can select all values that have a value of 1 for the rank variable called DayDateRank01.

Some standard data and time rank columns are listed in the following table.

**Table 11.4  Standard Data and Time Rank Columns**

<table>
<thead>
<tr>
<th>Summarization Level of Aggregation Tables</th>
<th>Staging Column</th>
<th>Rank Column</th>
<th>Rank Column Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>For all aggregation tables that are summarized at the Day level and more granular</td>
<td>DayDate</td>
<td>DayDateRank01</td>
<td>DayDateDescRank</td>
</tr>
<tr>
<td>For all aggregation tables that are summarized at the Week level and more granular</td>
<td>WeekDate</td>
<td>WeekDateRank01</td>
<td>WeekDateDescRank</td>
</tr>
<tr>
<td>For all aggregation tables that are summarized at the Month level and more granular</td>
<td>MonthDate</td>
<td>MonthDateRank01</td>
<td>MonthDateDescRank</td>
</tr>
</tbody>
</table>
• Consider using join columns if needed.

Join columns are usually rank columns that are copied from another aggregation table. These columns can be used to filter the data for Top 10 reports. For example, a rank column in the DayHour aggregation table is the ranking of that column for each day and hour.

You might want to filter the data by the top 10 for the day, even if you are showing the data by hour. If so, you need to create a join column in the DayHour table in order to get the ranking column from the Day table. By default, the supplied aggregations have join columns for all the non-date and time ranking columns. However, in the user-written adapter, you can create only the ones that you will need.

The naming convention for join columns is the following: X_rankColumn, where rankColumn is the name of the rank column from the original table and X is one of the following values:

•  D if the rank column is from the Day table
•  W if the rank column is from the Week table
•  M if the rank column is from the Month table

Creating Information Maps for User-Written Adapters

The supplied adapters contain jobs that, when run, create information maps for each of the aggregation tables that were generated. You can also create information map jobs for your user-written aggregations. An information map enables you to access your data with SAS Web Report Studio, SAS Enterprise Guide, and other SAS reporting tools.

Note: In SAS Enterprise Guide, you can also access the data directly from the SAS data tables.

Creating and working with information maps is described in detail in chapter 10, “Information Maps.” For more information, see “About Information Maps” on page 240.

The following tips can be used to keep your user-written adapter consistent with the supplied adapters.

• Create an information map job for each domain category. Specify a name for the job such as <domain category>Information Map.

• Each job should have an Information Map transformation for each aggregation in the domain category. The following diagram shows the resulting Information Map transformations for the job.
Use the name of the aggregation table as the name of your information map.

Information map filters are helpful when using information maps for reporting. Some standard filters that are used in the supplied adapters are shown in the following tables. The filters are listed by the columns on which the aggregation table is summarized: DayDate, WeekDate, and MonthDate.

Table 11.5 Standard Filters Used for Supplied Adapters Based on the DayDate Column

<table>
<thead>
<tr>
<th>Filter Name</th>
<th>Filter Expression and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LastDay</td>
<td>Expression: (&lt;\text{aggTableNameDAYDATERANK01}&gt; = 1 ) Description: DayDateDescRank 1</td>
</tr>
<tr>
<td>Last3Days</td>
<td>Expression: (&lt;\text{aggTableNameDAYDATERANK01}&gt; \text{ between 1 and 3} ) Description: DayDateDescRank 1 – 3</td>
</tr>
<tr>
<td>RollingWeek</td>
<td>Expression: (&lt;\text{aggTableNameDAYDATERANK01}&gt; \text{ between 1 and 7} ) Description: DayDateDescRank 1 - 7</td>
</tr>
<tr>
<td>RollingMonth</td>
<td>Expression: (&lt;\text{aggTableNameDAYDATERANK01}&gt; \text{ between 1 and 31} ) Description: DayDateDescRank 1 - 31</td>
</tr>
<tr>
<td>Last14Days</td>
<td>Expression: (&lt;\text{aggTableNameDAYDATERANK01}&gt; \text{ between 1 and 14} ) Description: DayDateDescRank 1 - 14</td>
</tr>
<tr>
<td>Last90Days</td>
<td>Expression: (&lt;\text{aggTableNameDAYDATERANK01}&gt; \text{ between 1 and 90} ) Description: DayDateDescRank 1 - 90</td>
</tr>
</tbody>
</table>
### Table 11.6  Standard Filters Used for Supplied Adapters Based on the WeekDate Column

<table>
<thead>
<tr>
<th>Filter Name</th>
<th>Filter Expression and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ThisWeek</td>
<td>Expression: &lt;&lt;aggTablenameWEEKDATERANK01&gt;&gt; = 1</td>
</tr>
<tr>
<td></td>
<td>Description: WeekDateDescRank 1</td>
</tr>
<tr>
<td>LastWeek</td>
<td>Expression: &lt;&lt;aggTablenameWEEKDATERANK01&gt;&gt; = 2</td>
</tr>
<tr>
<td></td>
<td>Description: WeekDateDescRank 2</td>
</tr>
<tr>
<td>Last2Weeks</td>
<td>Expression: &lt;&lt;aggTablenameWEEKDATERANK01&gt;&gt; between 2 and 3</td>
</tr>
<tr>
<td></td>
<td>Description: WeekDateDescRank 2 - 3</td>
</tr>
<tr>
<td>Last4Weeks</td>
<td>Expression: &lt;&lt;aggTablenameWEEKDATERANK01&gt;&gt; between 2 and 5</td>
</tr>
<tr>
<td></td>
<td>Description: WeekDateDescRank 2 - 5</td>
</tr>
<tr>
<td>Last12Weeks</td>
<td>Expression: &lt;&lt;aggTablenameWEEKDATERANK01&gt;&gt; between 2 and 13</td>
</tr>
<tr>
<td></td>
<td>Description: WeekDateDescRank 2 - 13</td>
</tr>
</tbody>
</table>

### Table 11.7  Standard Filters Used for Supplied Adapters Based on the MonthDate Column

<table>
<thead>
<tr>
<th>Filter Name</th>
<th>Filter Expression and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ThisMonth</td>
<td>Expression: &lt;&lt;aggTableName.MONTHDATERANK01&gt;&gt; = 1</td>
</tr>
<tr>
<td></td>
<td>Description: MonthDateDescRank 1</td>
</tr>
<tr>
<td>LastMonth</td>
<td>Expression: &lt;&lt;aggTableName.MONTHDATERANK01&gt;&gt; = 2</td>
</tr>
<tr>
<td></td>
<td>Description: MonthDateDescRank 2</td>
</tr>
<tr>
<td>Last2Months</td>
<td>Expression: &lt;&lt;aggTableName.MONTHDATERANK01&gt;&gt; = 2 - 3</td>
</tr>
<tr>
<td></td>
<td>Description: MonthDateDescRank 2 - 3</td>
</tr>
<tr>
<td>Last4Months</td>
<td>Expression: &lt;&lt;aggTableName.MONTHDATERANK01&gt;&gt; = 2 - 4</td>
</tr>
<tr>
<td></td>
<td>Description: MonthDateDescRank 2 - 4</td>
</tr>
<tr>
<td>Last13Months</td>
<td>Expression: &lt;&lt;aggTableName.MONTHDATERANK01&gt;&gt; = 2 - 14</td>
</tr>
<tr>
<td></td>
<td>Description: MonthDateDescRank 2 - 14</td>
</tr>
</tbody>
</table>

You can also make filters for the other ranked and joined columns in your data. For the supplied adapters, there are filters for all the rank and join columns in the aggregation. These filters enable you to create top-ten reports. To generate this type of report, specify “between 1 and 10” in the filter expression.
Reporting on Data Created with User-Written Staging Transformations

To create reports that can be displayed in the Gallery Manager, you must use SAS Enterprise Guide. For information about creating and using reports within the SAS IT Resource Management 3.3 framework, see the SAS IT Resource Management 3.3: Reporting Guide. This document can be accessed from the http://support.sas.com/itrm Web site.

Working with User-Written Staging Transformations

Create a User-Written Staging Transformation

To create a User-Written Staging transformation, perform the following steps:

1. From the IT Data Marts tree of SAS IT Resource Management, double-click the job that is to contain the User-Written Staging transformation. The job opens on the Diagram tab of the Job Editor window.

2. From the Transformations tree of SAS IT Resource Management, expand the ITRM Transformations folder.

3. Scroll down to the User Written Staging entry. Drag and drop it onto the job on the Diagram tab of the Job Editor window.

4. (Optional) Attach a source table on the left side of the transformation.
   To create a table, select File ⇒ New ⇒ Table to open the New Table wizard. Respond to the prompts as needed and click Finish. To attach the new table to the transformation, navigate to the location of the table in the tree where you stored its metadata. Drag and drop the table onto the process flow diagram and attach the table to the transformation.

5. Attach a target table to the transformation. (Multiple target tables can be attached to the transformation.)
    TIP If you cannot attach the table to the transformation, right-click the transformation and from the menu that is displayed, select Connections. In the User Written Staging Connections dialog box that opens, the Output Node field of the target table should have a value. If the field does not have a value (or displays <none>), double-click the ellipsis (...) in the Output Node field and select the table to which you want to connect. Then click OK. Click OK again to return to the process flow diagram and connect the target table to the transformation.

6. Right-click the User-Written Staging transformation. From the drop-down menu, select Properties.
The **General** tab of the User-Written Staging Properties dialog box appears. The **Name** field displays the default value of the transformation, **User-Written Staging**.

**Display 11.2  General Tab of the User-Written Staging Transformation**

7. In the **Name** field on the **General** tab, enter the name of the transformation if you do not want to retain the default name. The name of the transformation can be no more than 60 characters. It must be unique within the job that contains it. This field cannot be blank.

   The new name of the transformation appears in the box that represents the User-Written Staging transformation in process flow diagram.

   In the **Description** field, you can enter up to 200 characters of information about the transformation. A value is optional in this field.

8. On the **Staging Parameters** tab, you can customize the staging transformation with staging parameters, duplicate data checking parameters, and user-written parameters.

   a. In the left panel of the tab, select **Staging**.
You can specify the following information:

- In the **Raw data input file or directory** field, enter the location of the file or directory that contains the raw data that is input to your staging transformation.

  Click **Browse** to open the Select the File or Directory dialog box. In the **Look in** field, the drop-down list displays the files and directories that are available in the metadata repository to which you are connected. From the drop-down list that is displayed, select the file or directory that contains the raw data that is input to your user-written staging transformation.

  For information about the Raw data input file or directory parameter, see “Choose Raw Data Input Type” on page 401.

- In the **Future Data** field, the drop-down list displays the options that are available for handling future data. These options are **Accept**, **Discard**, and **Terminate**. Select the option that you want to use, or use the default value, **Discard**.

  For information about the Future Data parameter, see “Future Data” on page 405.

**Note:** Click the **Reset to defaults** option at the top of the tab to reset all the Staging parameters to the values that were established when SAS IT Resource Management was installed. Click the **Reset** option next to any one of these parameters to reset it to the value that was established when SAS IT Resource Management was installed. Also note that **Reset to defaults** does not reset a parameter that is dependent on another parameter if the parent parameter does not change.
b. In the left panel of the tab, select **Duplicate Checking**. To specify these parameters, use the drop-down list in the **Enable duplicate checking** field to select **Yes**. The following dialog box appears. If you select **No**, the duplicate checking parameters are removed from the panel.

**Display 11.4  Duplicate Checking Staging Parameters**

You can specify the following information, which pertains to the parameters and options that affect how duplicate data checking is performed:

- In the **Duplicate checking options** field, you can specify how duplicate data is to be handled.

  The default value is **USR**. The following values can be selected.

  **Discard**
  removes duplicates.

  **Force**
  loads data regardless of whether duplicates are found.

  **Terminate**
  ends the job if duplicates are found.

**CAUTION:**
Although the job terminates, the resulting staged table might contain data. However, termination of the job indicates an error in processing, and any data in the resulting staged table might be invalid.

- In the **SOURCE variable for %RMDUPCHK macro** field, you can specify the data source for this adapter.
The default value is **USR**.

- In the IDVAR variable for **%RMDUPCHK macro** field, you can specify the name of the SAS variable that identifies the system or machine that generated the input data.

  The default value is **MACHINE**.

- In the TIMESTAMP variable for **%RMDUPCHK macro** field, you can specify the name of the SAS variable that contains the datetime stamp. This SAS variable uniquely identifies the time of the event or interval that is being recorded.

  The default value is **DATETIME**.

- In the ENDFILE variable for **%RMDUPCHK macro** field, you can specify the name of the SAS variable that is used as the END= keyword for the SAS INFILE statement that reads the raw data.

  The default value is **_EOF**.

- In the **INT** value for **%RMDUPCHK macro** field, you can specify the maximum time gap (or interval) that is allowed between the timestamps on any two consecutive records from the same system or machine. If the interval between the timestamp values exceeds the value of this parameter, then an observation with the new time range is created in the control data set. This is referred to as a *gap* in the data.

  The value for this parameter must be provided in the format *hh:mm*, where *hh* represents hours and *mm* represents minutes. For example, to specify an interval of 14 minutes, use **INT=0:14**. To specify an interval of 1 hour and 29 minutes, use **INT=1:29**.

  The default value is **00:29**.

  **TIP**  For best results, specify an interval that is a little larger than the natural interval of the raw data. For example, if the data is in 10-minute intervals, set **INT=00:12**. If the data is hourly, set **INT=01:02**.

- In the **KEEP** value for **%RMDUPCHK macro** field, you can specify the number of weeks for which control data is saved. Because this value represents the number of Sundays between two dates, a value of **2** (the default) results in a maximum retention period of 20 days. This value must be an integer.

  The default value is **9**.

- In the REPORTS value for **%RMDUPCHK macro** field, you can specify whether to display the duplicate-data checking messages in the SAS log or to save the messages in an audit table. If set to **Yes**, this parameter causes all the messages from duplicate-data checking to be displayed in the SAS log. If set to **No**, the duplicate-data checking messages are saved in an audit data table that is stored in the staging library. The name of the audit table is **source AUDIT** (where **source** is the 3-character data source code).

  The default value is **Yes**.

*Note:* Click the **Reset to defaults** option at the top of the tab to reset all the duplicate checking parameters to the values that were established when SAS IT Resource Management was installed. Click the **Reset** option next to any one of these parameters to reset it to the value that was established when SAS IT Resource Management was installed. Also note that **Reset to defaults**
does not reset a parameter that is dependent on another parameter if the parent parameter does not change.

c. In the left panel of the tab, select **User-Written**. The following dialog box appears.

**Display 11.5 User-Written Staging Parameters**

You can specify the following information:

- In the **User written code** field, enter the location where your staging code is stored.

  Click **Browse** to open the Select a File dialog box.

- In the **Generate a macro variable with input table name** field, you can choose to generate a macro variable that contains the full table name (`libref.table`) of the input table. From the drop-down list, select **Yes** if you want to generate the macro variable. Otherwise, select **No**.

- In the **Generate macro variables with target table names** field, you can choose to generate macro variables that contain the full table name (`libref.table`) of the target tables. From the drop-down list, select **Yes** if you want to generate the macro variables. Otherwise, select **No**.
• In the **Generate a macro with target table options** field, you can choose to generate a macro that contains the data set options for each target table. From the drop-down list, select **Yes** if you want to generate the macro. Otherwise, select **No**.

• In the **Generate Tabinfo and Varinfo tables** field, you can choose to generate code that creates the following tables:
  - **tabinfo**, which contains all the target tables
  - **varinfo**, which contains all the columns in all the target tables

  From the drop-down list, select **Yes** if you want to generate the code. Otherwise, select **No**.

• In the **Generate a macro to create target table ATTRIB statements** field, you can choose to generate a macro that contains **attrib** statements for each column in the target tables. From the drop-down list, select **Yes** if you want to generate the macro. Otherwise, select **No**.

• In the **Generate a macro to create computed columns** field, you can choose to generate a macro that contains the computations for any computed columns in the target tables. From the drop-down list, select **Yes** if you want to generate the macro. Otherwise, select **No**.

• In the **Generate a macro to create column lists** field, you can choose to generate a macro that creates a list of all the columns in the table that can be used as a keep list, a retain list, or any other list of columns that is needed. From the drop-down list, select **Yes** if you want to generate the macro. Otherwise, select **No**.

• In the **Generate a macro to assign columns to missing** field, you can choose to generate a macro that contains assignment statements to set all columns in the target table to missing. From the drop-down list, select **Yes** if you want to generate the macro. Otherwise, select **No**.

**Note:** Click the **Reset to defaults** option at the top of the tab to reset all the User-Written parameters to the values that were established when SAS IT Resource Management was installed. Click the **Reset** option next to any one of these parameters to reset it to the value that was established when SAS IT Resource Management was installed. Also note that **Reset to defaults** does not reset a parameter that is dependent on another parameter if the parent parameter does not change.

9. The remaining tabs on the User-Written Staging Properties dialog box consist of standard SAS Data Integration Studio properties. For information about how to use these properties, click **Help** on the tab.

10. Click **OK** to return to the process flow diagram.

11. Click **File ⇔ Save** to save the job.

---

**Delete a User-Written Staging Transformation from a Job**

To delete a User-Written Staging transformation from a job, perform the following steps:

1. From the **IT Data Marts** tree of SAS IT Resource Management, double-click the job that contains the User-Written Staging transformation. The job opens on the **Diagram** tab of the Job Editor window.

2. Right-click the box that represents the User-Written Staging transformation.
3. From the drop-down menu, select **Delete**.
4. Click **File ➔ Save** to save the job.

**Modify a User-Written Staging Transformation**

To modify a User-Written Staging transformation, perform the following steps:

1. From the **IT Data Marts** tree of SAS IT Resource Management, double-click the job that contains the User-Written Staging transformation. The job opens on the **Diagram** tab of the Job Editor window.
2. Right-click the box that represents the User-Written Staging transformation.
3. From the drop-down menu, select **Properties**.
4. Click the tab that contains the information that you want to modify.
   - On the **General** tab, you can change the name of the transformation. The name of the transformation can be no more than 60 characters. It must be unique within the job that contains it.
   - On the **Staging Parameters** tab, you can change the standard staging parameters and the user-written staging parameters. For information about these parameters, see “Create a User-Written Staging Transformation” on page 284.
5. The remaining tabs on the User-Written Staging Properties dialog box consist of standard SAS Data Integration Studio properties that can also be modified. For information about how to use these properties, click **Help** on the tab.
6. Click **OK** to return to the process flow diagram.
7. Click **File ➔ Save** to save the job.

**Rename a User-Written Staging Transformation**

To rename a User-Written Staging transformation, perform the following steps:

1. From the **IT Data Marts** tree of SAS IT Resource Management, double-click the job that contains the User-Written Staging transformation. The job opens on the **Diagram** tab of the Job Editor window.
2. Right-click the box that represents the User-Written Staging transformation.
3. From the drop-down menu, select **Properties**.
4. In the **Name** field on the **General** tab, enter the new name of the transformation. The name of the transformation can be no more than 60 characters. It must be unique within the job that contains it.
   
   The new name of the transformation is displayed in the box that represents the User-Written Staging transformation in process flow diagram.
5. Click **OK** to return to the process flow diagram.
6. Click **File ➔ Save** to save the job.
Using the Additional Generated Code

When the SAS code for the User Written Staging transformation is generated, additional code is generated and precedes the user-written code. This additional code provides information that can be useful in the user-written code. The generation of this additional code is controlled by the options on the User Written page of the Staging Parameters tab.

Macro Variables

Macro variables for any extended attributes can be entered on the Extended Attributes tab of the User-Written Staging Properties dialog box. The name of each extension is the macro variable name, and the value of the extension is the value of the macro variable. If the name has spaces or other invalid characters, they are removed.

&input
If there is a source table to the transformation, then this macro variable contains the libref.tablename of the source table.

&target1–&targetn
These macro variables contain the names of the n target tables in the libref.tablename format.

Macros

These macros are available for use with user-written staging transformations.

• The following macro generates table options for specified target tables.

```sas
%macro _ITMS_tableOptions (targetTableNum=,
    generateTableName=YES,
    generateIndexes=YES);
```

• If the TARGETTABLENUM= parameter is left blank, then the table options for all the target tables are generated.

• If you specify generateTableName=NO, the macro generates a list of the table options.

• If you specify generateTableName=YES, the macro generates the table name with the table options in parentheses after it.

• The following macro generates an ATTRIB statement for each column of the requested table. If the TARGETTABLENUM= parameter is left blank, the macro generates an ATTRIB statement for each column for all tables. The ATTRIB statement includes the column name, type, length, format, informat, and label.

```sas
%macro _ITMS_attrib (targetTableNum=);
```

• The following macro generates assignment statements for all the columns of the requested table that will set the value to "" or .(missing), depending on the type of column. If the TARGETTABLENUM= parameter is left blank, the macro generates assignment statements for all columns in all tables.
The following macro generates a statement for each computed column of the requested table. If the TARGETTABLENUM= parameter is left blank, the macro generates a statement for each computed column for all tables.

%macro _ITMS_computedColumns (targetTableNum=);

• The following macro generates a list of all the columns of the requested table. If the TARGETTABLENUM= parameter is left blank, the macro generates a list of all the columns for all tables.

%macro _ITMS_columnList (targetTableNum=,
                   delimiter=,
                   sqlAlias=);

The additional parameters allow the list to be generated in different ways:

DELIMITER=
This parameter is set to a character string that will be put between each column in the list. The most common value of this parameter is a comma, so that the list can be used in SQL code. If a value is not specified, then the column names will be separated by blanks.

SQLALIAS=
This parameter is an alias that can be used as a prefix for each column name. There will be a period between this prefix and the column name. The most common use of this parameter is in SQL when a table alias is needed for each column.

Tabinfo and Varinfo

You can choose to create the Tabinfo and Varinfo tables in the Work library. These tables can be used in the user-written code to generate SAS code that is based on the target table and column information.

The Tabinfo table contains one record for each target table. The following columns are included in the Tabinfo table:

TABLENM
specifies the name of the table.

LIBREF
specifies the libref for this table.

ISCOMPRESSED
specifies the COMPRESS data set option. The values can be YES (that is, COMPRESS=YES) or NO (that is COMPRESS=NO).

INDEXOPTION
specifies the INDEX data set option (if there is an index on the table).

The Varinfo table contains one record for each column in all the target tables. The following columns are included in the Varinfo table:

TABLENM
specifies the name of the table.
VARNM
   specifies the name of the column.

VARLAB40
   specifies the column label.

VARFMT
   specifies the column format.

VARINFMT
   specifies the column informat.

VARLEN
   specifies the length of the column.

VARTYPE
   specifies the type of the column. The type can be C (that is, character) or N (that is, numeric).

FORMULA
   specifies the expression that is used to create this column, if it is a computed column.
Chapter 12
Jobs

Jobs That Process IT Data

Overview of Jobs That Prepare, Stage, Aggregate, Generate Information Maps, and Report for IT Data

To prepare and process IT resource data, SAS IT Resource Management requires jobs that perform the following tasks:

- Prepare the raw data for staging
- Stage the raw data
- Aggregate the data
- Generate information maps of the data
- Generate reports

For information about how to generate the job that prepares the raw data for staging, see “Data Sources Supported by SAS IT Resource Management Adapters” on page 325. The remaining jobs (staging, aggregating, generating information maps, and reporting) can be generated in two ways:

- automatically, by using the Adapter Setup wizard
manually, by using the SAS IT Resource Management transformations

*Note:* After the jobs are created, either automatically by using the Adapter Setup wizard or manually by using the SAS IT Resource Management transformations, only the metadata definitions of the tables exist. You must actually execute the jobs in order to load data into the physical tables.

**CAUTION:**

Make sure that all tables that are associated with the job are closed before you run the job. If any one table cannot be accessed with Write access, the job will fail with a nonzero return code.

### Processing IT Data Using the Adapter Setup Wizard

#### Generating Jobs with the Adapter Setup Wizard

You can automatically generate the metadata for the jobs that process IT resource data by invoking the Adapter Setup wizard.

To invoke the Adapter Setup wizard, from the SAS IT Resource Management menu bar select **File ➔ New ➔ IT Resource Management ➔ Adapter Setup**. The Adapter Setup wizard appears and prompts you to specify information about the adapters that you want to work with. For any adapter, you can specify one of the following configuration levels that governs the types and number of jobs that the wizard generates.

- **Staging Job Only** creates only the staging job for the selected adapter.
- **Minimal** creates the staging job and only a small number of aggregations for the metrics that are used to generate a minimal set of reports for the selected adapter.
- **Typical** creates the staging job, all output from the Minimal level, and any additional metrics, and aggregations. It also creates report definitions that the SAS IT Resource Management solution has predetermined to be of interest for the selected adapter and reports. This option is the default setting.
- **Full** creates the staging job, all output from the Typical level, and any additional metrics, aggregations. It also creates report definitions that make up a comprehensive set of jobs that are supported by the Adapter Setup wizard for the selected adapter.

When you click **Finish**, the Adapter Setup wizard creates the required jobs and all the metadata that is necessary for those jobs to execute. Among other information that it requests, the Adapter Setup wizard requires you to specify the IT data mart where it stores (by default) the jobs and the associated metadata for the adapter that you are working with. These jobs and the associated metadata are stored in the `<adapter><number>` folder that you are working with.

The Adapter Setup wizard creates the following jobs:

- one staging job that contains only the part of the ETL flow that relates to the staging transformation and the target staged tables.
- zero or more aggregation jobs that each contain one Aggregation transformation with target summary tables. The number of aggregation jobs that are created varies based on the domain categories (and their respective subcategories), time periods, and reporting selections that you made when specifying the adapter.
- zero or more information map jobs that each contain one Information Map transformation per aggregation table. The number of information map jobs that are created varies based on the domain categories (and their respective subcategories), time periods, and reporting selections that you made when specifying the adapter.
Note: In SAS IT Resource Management 3.1 and SAS IT Resource Management 3.1.1, the Adapter Setup wizard created jobs that created or updated aggregation tables and also generated information maps based on those tables. If the job that modified aggregation tables was run, the corresponding Information Map transformations were part of that job. Therefore, the information maps were automatically regenerated. Starting with SAS IT Resource Management 3.2, jobs that create or update aggregation tables do not include transformations that generate information maps. Therefore, if any changes are made to the tables that are input to those Information Map transformations that alter the structure of the table (for example, by adding or deleting columns), then the user must rerun the corresponding information map jobs so that the information maps are regenerated.

- zero or more reporting jobs that each contain one or more Gallery transformations per information map. The number of reporting jobs that are created varies based on the domain categories (and their respective subcategories), time periods, and reporting selections that you made when specifying the adapter.

The default name of each job that is created by the Adapter Setup wizard contains the name of the adapter and the domain category that you specified with the wizard.

Note: The jobs that the Adapter Setup wizard creates depend on one another to process the raw data for reporting. For example, the aggregation jobs include aggregations that rely on the staged tables that are generated when the staging job is run. As a result, each job should be run only after the jobs that it depends on have been run. The following list shows the types of jobs that the Adapter Setup wizard creates. Each job type in the list is dependent on the job type that precedes it.

1. staging job
2. aggregation job
3. information map job
4. reporting job

For information about how to work with the Adapter Setup wizard, see Chapter 9, “Adapter Setup Wizard,” on page 209.

Where Does the Adapter Setup Wizard Store the Objects That It Generates?
The Adapter Setup wizard stores the objects that it generates in predetermined locations within the IT data mart that you select. The wizard generates two sets of subfolders for the objects that it creates:

- the Staging subfolder, which contains the staging job, staged tables, and the library for those tables
- the <Domain Category> subfolder within the Domain Categories folder, which contains the aggregation, information map, and reporting jobs, their associated tables and maps, and the library that is associated with those objects

However, jobs, tables, and libraries can be stored in any location to which you have Write access. To change where an object is stored, right-click the object (in the process flow diagram or in the tree where it is currently stored) and select Properties. On the General tab of the Properties dialog box, click the Browse button that is next to the Location field. The Select a Location dialog box appears. Navigate to the location that you want to use and click OK.
The default location for the staging job, the staged tables, and the associated library is the **Staging** subfolder that is located within the adapter folder of the IT data mart that you selected.

The following display shows the metadata that is created in the **Staging** subfolder for the third instance of the DT Performance Sentry adapter within the IT data mart. The **Staging** subfolder contains the DT Perf Sentry Staging job, the NTLGDSK and NTSYSTEM_ITRM staged tables, and the library for those tables—NTSMF Staging 6066.

**Display 12.1** Default Location of Objects Created by the Adapter Setup Wizard for Staging the Raw Data

```
- DT Perf Sentry 3
  + Domain Categories
    - Server Disk
    - Server System
  - Staging
    - DT Perf Sentry Staging
    - NTLGDSK
    - NTSMF Staging 6066
    - NTSYSTEM_ITRM
```

The default location for the remaining jobs, their associated tables, and library is in the **Domain Categories** subfolder that is located within the adapter folder of the IT data mart that you selected.

The following display shows the metadata that is created in the **Domain Categories** subfolder for the third instance of the DT Performance Sentry adapter within the IT data mart. The **Domain Categories** subfolder contains two subfolders of domain objects: Server Disk and Server System. Each domain subfolder contains five aggregated tables,
the library associated with those tables, the aggregation job, the information map job, and the two reporting jobs.

Display 12.2  Default Location of Objects Created by the Adapter Setup Wizard for Aggregating, Creating Information Maps, and Reporting on the Staged Data

Note: Information maps are not generated until the information map job runs. When they are generated, they are stored by default in the appropriate **Domain Categories** subfolder, although you can store them in any location to which you have Write access.

**Processing IT Data without the Adapter Setup Wizard**

You can manually generate the metadata for the tasks that process IT resource data instead of invoking the Adapter Setup wizard. To do so, you must first open a job. Then, within that job, you can specify the staging, aggregating, information map, and reporting (gallery) transformations that are needed. You can also modify existing jobs by adding and deleting transformations, tables, and information maps.

To generate the metadata for a transformation, perform the following steps:

1. Open a job. If you want to work with an existing job, double-click on that job to open it on the **Diagram** tab of the Job Editor window of SAS IT Resource Management.

   If you need to create a job, you can invoke the New Object wizard from the **File** menu of SAS IT Resource Management. For information about how to perform this task, see “Create a Job” on page 300.

   The new job opens on the **Diagram** tab of the Job Editor window.
2. Navigate to the **ITRM Transformations** folder of the **Transformations** tree of SAS IT Resource Management.

   *Note:* A job can consist of a single transformation, or it can include multiple transformations such as staging transformations, Aggregation transformations, Information Map transformations, and Gallery transformations.

3. Drop the transformation that you want to work with onto the job in the **Diagram** tab of the Job Editor window.

4. Locate and follow the instructions for working with transformations that perform the following tasks:

   • Stage the raw data
     
     For information about how to stage the raw data, see Chapter 7, “Staging the Data,” on page 119.

   • Aggregate the data
     
     For information about how to aggregate the data, see Chapter 8, “Aggregating the Data,” on page 147.

   • Generate information maps of the data
     
     For information about how to generate information maps, see on page 239.

   • Report on the IT intelligence and analysis that SAS IT Resource Management generates
     
     For information about how to generate, manage, and view reports, see the *SAS IT Resource Management: Reporting Guide*.

   *Note:* In order to create (or update) the tables that are specified by the transformation, the job that contains the transformation must be executed. Jobs can be run immediately from SAS IT Resource Management, or they can be scheduled to execute as part of the operational procedures of an organization. (Due to the size of the aggregation jobs, it is preferable to run them in batch mode.)

---

**Working with Jobs**

**Create a Job**

To create a job, perform the following steps:

1. From the SAS Data Integration menu bar, select **File** ➤ **New** ➤ **Job** to open the New Job wizard.

2. In **Name** field, you can override the default name that is assigned to the job. You can enter up to 60 characters in this field. A value is required in this field.

3. In **Description** field, enter the information that describes the job. You can enter up to 200 characters in this field. A value is optional in this field.

4. In **Location** field, you can override the default location of the job. To do so, click **Browse** to open the Select a Location dialog box where you can navigate to another location.

   *Note:* If you are working in the IT Data Marts view and you have not selected a folder, but have referenced an IT data mart, then the job is created within the
Contents subfolder of the last-referenced IT data mart. If you are working in the folders view, the job is created in My Folders.

For information about how to create an IT data mart, see “Create an IT Data Mart” on page 67. To create a folder within an IT data mart, perform the following steps:

Create a Folder

a. Navigate to the IT data mart.

Tip You might want to create new subfolders to better organize the objects that you are creating. You can create these subfolders in the Contents folder within the IT data mart.

b. From the SAS Data Integration menu bar, select File ⇔ New ⇔ Folder. The New Folder wizard appears.

c. (Optional) Override the default name of the folder with a name that does not exceed 60 characters. A value is required in this field.

Note: For best results, enter a name that indicates the purpose of the folder.

d. (Optional) Enter a description of the folder. You can enter up to 200 characters. A value is optional in this field.

e. (Optional) Override the default location by clicking Browse to open the Select a Location dialog box, where you can navigate to another location. A value is required in this field.

f. Click OK to create the folder and store it in the IT data mart from which you invoked the New Folder wizard.

5. Click OK to create the job and store it in the location that you chose.

Note: The Diagram tab of the Job Editor window of SAS IT Resource Management automatically displays the job that you created. (The window is empty except for the job name that displays on the banner of the window.)

6. To view the new job in the folder, click Refresh in the menu bar. (In order to activate the Refresh icon in the menu bar, click anywhere in the left panel of SAS IT Resource Management.)

Delete a Job

To delete a job, perform the following steps:

1. Navigate to the location of the job in the IT Data Marts tree.

2. Right-click the job.

3. From the menu that is displayed, select Delete.

4. In the confirmation box, click Yes to delete the job.

Modifying a Job

Add a Transformation to a Job

Note: If you modify a job, you should redeploy it.

To add a transformation to a job, perform the following steps:
1. Navigate to the location of the job in the IT Data Marts tree.

2. Double-click the job to open it on the Diagram tab of the Job Editor window.

3. In the Transformations tree, expand the ITRM Transformations folder.

4. Drag and drop the transformation that you want to add to the job onto the process flow diagram.

5. Right-click the transformation to display a menu of options with which you can specify the transformation that you are adding to the job.
   - For information about how to add a staging transformation, see “Working with Staging Transformations” on page 121.
   - For information about how to add an Aggregation transformation, see “Preparing to Create an Aggregation Table” on page 160.
   - For information about how to add an Information Map transformation, see “User-Specified Information Map Transformations” on page 244.
   - For information about how to add a Gallery transformation, see the “Working with the Gallery Transformation” topic in the “Running Reports” chapter of the SAS IT Resource Management: Reporting Guide.

6. Save the job that you modified. To do so, select File ➔ Save.

Delete a Transformation from a Job

Note: If you modify a job, you should redeploy it.

To delete a transformation from a job, perform the following steps:

1. Navigate to the location of the job in the IT Data Marts tree.

2. Double-click the job to open it on the Diagram tab of the Job Editor.

3. Right-click the transformation that you want to delete.

4. Save the job that you modified. To do so, select File ➔ Save.

Add a Table to a Transformation

Note: If you modify a job, you should redeploy it.

You can add a table to a staging transformation or an Aggregation transformation. To add a table to a transformation in a job, perform the following steps:

1. Navigate to the location of the job in the IT Data Marts tree.

2. Double-click the job to open it on the Diagram tab of the Job Editor.

3. Right-click the transformation to which you want to add a target table. A menu of options is displayed in the Properties dialog box.
   - The menu for a staging transformation provides an action to Add New Staged Table. For information about this topic, see “Working with Staging Transformations” on page 121.
   - The menu for an Aggregation transformation provides an action to Add Aggregation Table. For information about this topic, see “Preparing to Create an Aggregation Table” on page 160.

4. Select the table that you want to add to invoke the wizard that will generate the metadata for that table.
5. The wizard prompts you for information that is required to specify the metadata for the table. When you are satisfied with your specifications, click **Finish** to generate the metadata for the table.

6. Save the job that you modified. To do so, select **File ➔ Save**.

**Delete a Table from a Transformation in the Process Flow Diagram**

To delete a table from a transformation in the process flow diagram, perform the following steps:

1. Navigate to the location of the job in the **IT Data Marts** tree.
2. Double-click the job to open it on the **Diagram** tab of the Job Editor.
3. Right-click the table that you want to delete. The table is removed from the transformation. However, the metadata of this table and its library are not deleted from the **IT Data Marts** tree, and its contents are not deleted from the physical file.
4. Save the job that you modified. To do so, select **File ➔ Save**.

If you delete the source table of an Aggregation transformation in the process flow diagram, the target tables of that transformation are also deleted. However, if this action is not acceptable, you can reinstate these tables. To do so, from the **Edit** menu, click **Undo**.

**CAUTION:**

To avoid processing errors, delete any reference to a deleted table, as a source or target for any transformation in any other job. For example, Information Map transformations that use the deleted table as a source table should be deleted.

**Note:** Be sure to redeploy any jobs that reference the deleted table.

**Delete a Table from the IT Data Marts Tree**

The **Delete** action deletes the metadata for the table in the **IT Data Marts** tree. The physical table and the library are not deleted. To delete a table from the **IT Data Marts** tree, perform the following steps:

1. Navigate to the folder that contains the table in the **IT Data Marts** tree.
2. Expand that folder and right-click the table that you want to delete.
3. From the menu that appears, select **Delete**.
4. In the confirmation box, click **Yes**.

**CAUTION:**

A job that accesses a table that is deleted will not run successfully.

**Note:** Be sure to redeploy any jobs that reference the deleted table.

**Delete a Table with Its Contents from a Transformation in the Process Flow Diagram**

The **Delete with Contents** action deletes the metadata of the table and the physical table. It does not delete the associated library. To delete a table with its contents from the **IT Data Marts** tree, perform the following steps:

1. Navigate to the folder that contains the table in the **IT Data Marts** tree.
2. Double-click the job to open it on the **Diagram** tab of the Job Editor.
3. Right-click the table whose contents and metadata you want to delete.
4. From the menu that displays, select **Delete with Contents**.

**CAUTION:**
A job that accesses a table that is deleted will not run successfully.

*Note:* Be sure to redeploy any jobs that reference the deleted table.

**Delete a Table with Its Contents from the IT Data Marts Tree**
The **Delete with Contents** action deletes the metadata of the table and the physical table.
It does not delete the associated library. To delete a table with its contents from the **IT Data Marts** tree, perform the following steps:

1. Navigate to the folder that contains the table in the **IT Data Marts** tree.
2. Expand that folder and right-click the table whose contents and metadata you want to delete.
3. From the menu that displays, select **Delete with Contents**.

**CAUTION:**
A job that accesses a table that is deleted will not run successfully.

*Note:* Be sure to redeploy any jobs that reference the deleted table.

**Erase a Table from a Transformation**
Erasing a table deletes the physical table, its contents, and its metadata. To erase a table, perform the following steps:

1. In a tree view of SAS IT Resource Management, locate the table that you want to erase.
2. Right-click the table that you want to erase. The job that uses the table must be closed and currently not in use before erasing.
3. Select **Erase**.
4. Click **Yes** to confirm that you want to erase this table.

**CAUTION:**
If you erase a table that serves as a source table in other jobs, then these associated jobs might not execute because they are missing a source table.

Simply erasing a table does not affect the metadata of the associated jobs. However, if you erase a table and then rerun the job that creates that table, then the data for the deleted table is not created. In addition, the jobs that used that table will fail due to a missing source table.

*Note:* Be sure to redeploy any jobs that reference the erased table.

**Purge a Table from a Transformation in the Process Flow Diagram**
The **Purge** action removes all observations from physical tables but leaves the physical table structure intact. To purge a table from the process flow diagram, perform the following steps:

1. Navigate to the job that contains the table in the **IT Data Marts** tree.
2. Double-click the job to open it on the **Diagram** tab of the Job Editor.
3. Right-click the table whose contents you want to purge.
4. From the menu that displays, select **Purge**.
5. In the confirmation box, click **Yes**.
**Purge a Table from the IT Data Marts Tree**

The **Purge** action removes all observations from physical tables but leaves the physical table structure intact. To purge a table from the *IT Data Marts* tree, perform the following steps:

1. Navigate to the folder that contains the table in the *IT Data Marts* tree.
2. Expand that folder and right-click the table that you want to purge.
3. From the menu that displays, select **Purge**.
4. In the confirmation box, click **Yes**.

**Rename a Job**

To rename a job, perform the following steps:

1. Navigate to the folder that contains the job in the *IT Data Marts* tree.
2. Right-click the job.
3. From the menu that displays, select **Rename**.
4. In the highlighted field, enter the new name of the job.

**Running Jobs**

**Run a Job Immediately**

After a job is created, and the transformation within it is defined, the job is ready to be run. To run a job immediately on the SAS Application Server where you are currently logged on, perform the following steps:

1. If the job is not open on the **Diagram** tab of the Job Editor window, open it by navigating to the job in the *IT Data Marts* tree and double-clicking it.
2. In the toolbar of the Job Editor window, select **Run**. This action submits the job's source code.
3. The **Diagram**, **Code**, and **Log** tabs are located at the bottom of the window. You can select the **Code** tab to view the generated code. After the job executes, you can select the **Log** tab to view the SAS log.

   *Note:* To see the results of the job in the hierarchy view, right-click in the hierarchy view and select **Refresh**.

### Deploy a Job for Scheduling

**How to Deploy a Job**

You can deploy a job so that it can be scheduled to run in batch mode on the default SAS Application Server.

To deploy a job to be run in batch mode, perform the following steps:

1. In the **IT Data Marts** tree of SAS IT Resource Management, navigate to the job that you want to deploy.

   *Note:* By pressing the CNTL key, you can select multiple jobs within an IT data mart to deploy. However, if the server is z/OS, you can deploy only one job at a time.

2. Right-click the job and from the menu that appears, select **Scheduling ⇒ Deploy**. The Deploy a job for scheduling dialog box appears.

   - Under Windows or UNIX operating environments, the following dialog box appears.
Under the z/OS operating environment, the following dialog box appears.

3. The batch server, the deployment directory, and the name and path of the job that you selected are the default values that are displayed in this window.

   - The **Batch Server** field contains the server where the job is to be executed.
   - The **Deployment Directory** field specifies the physical path to the directory where the generated code for the job is stored. From the drop-down list, select a different deployment directory. Select **New** to open the New directory window where you can define a new deployment directory.
     - If you define a new deployment directory in the Windows or UNIX operating environments, the new deployment directory will contain the SAS source code for the job.
     - If you define a new deployment directory in the z/OS operating environment, the new directory will contain a file that has the SAS source code for the job. It will also contain a file of the generalized job control language (JCL) that can run the job. You can modify this generalized file of JCL according to the requirements of your site.

   **Note:** At this time, the JCL Deployment Directory must be deployed to a UFS location and not a traditional file system (PDS) because partitioned data sets are not yet supported for JCL Deployment directory.
• The **Deployed Job Name** field specifies the name of the file that contains the generated code for the selected job. You can edit the default name, but the name must be unique in the context of the Deployment Directory that was previously specified. This field is available only when you deploy a single job. When you deploy multiple jobs, the filename is the same as the job names, but the name has a `.sas` extension.

The default value of the **Deployed Job Name** that is displayed is based on the name of your Job object. Therefore, you might need to revise the name in order to make it a legal filename on the operating system to which it is being deployed.

**Note:** For z/OS traditional file system locations, if the **Deployment Directory** name points to a partitioned data set (PDS), then the deployed job name specifies a member name for that PDS. The member name of the PDS cannot exceed 8 characters.

• The **Location** field contains the path to the **Folders** tree that contains the job. Click **Browse** to open the **Select a Location** dialog box where you can select another location.

**Note:** For more information about the fields on this window, click **Help**.

4. Click **OK** to deploy the job.

5. The code is then generated for the job and stored in the directory that is specified. If the deployment is successful, a message is displayed confirming that result. Metadata about the deployed jobs is saved to the current SAS Metadata Server. A status window is displayed and indicates whether the deployment was successful. Another object with the same name as the deployed job is stored in the **IT Data Marts** tree. This deployed job can be identified by the deployed job icon: 🔄 . This deployed job is now available for scheduling.

If you update a job or if your computing environment changes, you must redeploy it so that the latest version of the job is the available for execution. For example, if you add, remove, or change a transformation in a job, you must redeploy it to have those changes take effect.

### Schedule a Job to Run in Batch

After you deploy a job for scheduling, you can deploy it using any scheduling software that is available in your operating environment. An administrator can set up and run your job with any of the following types of software:

• any scheduler that is built in to your operating system.

• any third-party scheduler.

• the Schedule Manager plug-in to SAS Management Console. This software can define a flow, add one or more deployed jobs to it, and schedule the flow to run.

**Note:** For more information about scheduling, see *Scheduling in SAS*. This document is associated with plug-ins to SAS Management Console. It is available at [http://support.sas.com/documentation/onlinedoc/sasmc/index.html](http://support.sas.com/documentation/onlinedoc/sasmc/index.html).

### How to Schedule a Job Using a Built-In or Third-Party Scheduler

The deployed job is a file that contains SAS code. In order to schedule it using a built-in or third-party scheduler, you must supply an appropriate invocation of SAS, which runs this code.

**Windows Specifics**

You need to supply a batch file.
UNIX Specifics
You need to supply a shell script.

z/OS Specifics
You need to supply the JCL. A file of JCL that can be modified according to the requirements of your site can be found in the deployment directory that you selected.

This invocation must invoke the correct version of SAS with the configuration that is specified in the SAS IT Resource Management installation and configuration instructions.

To run batch jobs using the same SAS configuration as for the application server, depending on platform:

Windows Specifics
Run the sas.bat shell command in the configured application server. For example, run this: \SAS\<config-dir>\Lev1\SASITRM\sas.bat

UNIX Specifics
Run the sas.sh shell command in the configured application server. For example, run this: <config-dir>/SASITRM/sas.sh

z/OS Specifics
For USS tasks, run the sas.sh shell command in the configured application server. For example, run this: <config-dir>/SASITRM/sas.sh

z/OS Specifics
For traditional batch jobs, use the generated PROCLIB member PROCENW0 (or the equivalent for other languages). For example, run this:

&CONFIGDIR.PROCLIB(PROCENW0)

For more information about how to invoke SAS on your operating system, see SAS Companion for the Microsoft Windows Environment, SAS Companion for UNIX Environments, or SAS Companion for z/OS, as appropriate.

After you have set up the SAS invocation, you can then use your preferred scheduler to add this job to the script, batch file, or JCL that invokes SAS. For example, on UNIX, you can use ‘cron’ and add the shell script invocation to the crontab file. For third-party schedulers and for schedulers that are supplied as part of the operating system, follow the documentation for that scheduler.

How to Schedule a Job Using the Schedule Manager in SAS Management Console
To schedule a job to run in batch mode, perform the following steps:

1. On the main navigation tree of SAS Management Console, right-click Schedule Manager. From the drop-down list, select New Flow to open the New Flow window.
2. In the **Name** field, enter the name of the job flow. (The name cannot contain spaces.)

3. If you want to specify a new scheduling server, select **New**. The New Scheduling Server wizard opens.

4. From the **Available Jobs** column, select the jobs that you want to schedule. Use the arrow to transfer those jobs to the **Selected Jobs** column. (In the preceding display, the NewServerFlow called Server_Disk_Aggregation job is selected for scheduling.)

5. Click **Properties** to specify the scheduling details and authorization requirements of the jobs.

6. Click **OK** to define the job flow.
7. Select the new flow under **Schedule Manager**.

8. (Optional) Highlight the flow and from the **Actions** menu, select **Manage Dependencies**. The Manage Dependencies dialog box appears, where you can specify one or more conditions that control the starting of the current job.
9. From the **Actions** menu, select **Schedule Flow**. The Schedule Flow dialog box appears.

**Display 12.9  Select a Trigger to Start the Current Flow**

10. From the drop-down list, select when to run the flow—to run now or to run manually. Click **Options** to open the Trigger Options box on which you can select a trigger to start the flow, such as a specific date, time, and recurrence. Click **OK**.
When prompted, enter a user ID and password for the scheduling server. A message will be displayed confirming the successful scheduling of the job.

For information about the functions that can be performed from SAS Management Console, and options that can be specified when scheduling flows, see the online Help for the Schedule Manager plug-in to SAS Management Console and the *SAS Management Console: User's Guide*. 
Redeploy a Job

If you update a job that you already deployed, you must redeploy it so that the latest version of the job is scheduled. For example, if a table is deleted from a job, then the job must be deployed again.

To redeploy a job, perform the following steps:

1. In the IT Data Marts tree of SAS IT Resource Management, navigate to the job that you want to redeploy. You can select multiple jobs within an IT data mart to redeploy.

2. Right-click the job and from the menu that displays, select Scheduling ➔ Redeploy.

   The Redeploy a job for scheduling dialog box appears.

   • Under Windows or UNIX operating environments, the following dialog box appears.

   Display 12.10  Redeploying a Windows or UNIX Job

   ![Redeploy a job for scheduling dialog box](image)

   You can choose to preserve the deployed value of the job's metadata. However, you can change where the job is redeployed by changing the deployment directory and its location. If you define a new deployment directory in the Windows or UNIX operating environments, the new deployment directory will contain the SAS source code for the job.

   A message displays the name of the jobs that will be redeployed. These jobs are all the deployed jobs that are contained on the server that you are connected to. Click Yes to redeploy them.

   • Under the z/OS operating environment, you can also choose to preserve the deployed value of the job's metadata. If you want to change where the job is redeployed, select a new value for the Deployment Directory field. If you define a new deployment directory in the z/OS operating environment, the new directory will contain the SAS source code for the job. It will also contain a file of the generalized JCL that can run the job. You can modify this generalized file of JCL according to the requirements of your site.

   The following dialog box appears.
Redeploying a z/OS Job

3. A message appears that lists the jobs that were redeployed. If a job was not redeployed, an error message appears.

Redeploy All Jobs on the Server

If you made changes that affect all jobs that are deployed on the server, you must redeploy them so that the latest versions of the jobs are scheduled. For example, if the computing environment of the server where the deployed jobs are stored changes, the jobs must be deployed again.

Note: The code that is generated for a job contains the credentials of the person who created the job. If those credentials have changed, and a deployed job contains outdated user credentials, the deployed job will fail to execute. In that case, redeploy the job with the appropriate credentials.

To redeploy jobs, perform the following steps:

1. From the SAS IT Resource Management menu bar, select Tools ⇒ Redeploy Jobs for Scheduling.
A message then displays the names of the jobs that will be redeployed. These jobs are all the deployed jobs that are contained on the server that you are connected to. Click Yes to redeploy them.

2. Under the z/OS operating environment, you can choose to preserve the deployed value of the job's metadata. If you want to change where the job is redeployed, select a new value for the Deployment Directory field. If you define a new deployment directory in the z/OS operating environment, the new directory will contain the SAS source code for the job. It will also contain a file of the generalized JCL that can run the job. You can modify this generalized file of JCL according to the requirements of your site. Code is generated for the jobs that you redeployed. The code is saved to the deployment directory of the SAS Application Server that is used to deploy jobs.

Running an “Overall” Job with the %RMRUNETL Macro

You can choose to run your staging, aggregation, information map, and reporting jobs within a single processing macro. The staging job is run first. Then the aggregation jobs are run in parallel using Multi-Processing (MP) Connect. Those jobs are followed by the information map jobs that are also run in parallel. Lastly, the report jobs are run in parallel. If the staging job fails, the aggregation, information map, and report jobs are not run. After each job completes, the SAS log is examined by the program. The completion status of the job (Success, Warning, or Error) is sent by e-mail to the specified recipient. If the log displays warnings or errors, the e-mail includes the text of the error or warning along with the corresponding line number in the log file.

Note: To see the results of the job in the hierarchy view, right-click in the hierarchy view and select Refresh.

For information about how to set up the %RMRUNETL macro that provides this ability, see “%RMRUNETL” on page 524.
Allocating the Raw Data File Externally

When a job is deployed, the file that was entered in the Raw data file or directory field of the Staging Parameters tab of the staging transformation (or in the Adapter Setup wizard) appears in the generated code as part of a macro assignment (%let statement). In a production environment, it is possible that the raw data file changes from day to day, or that it needs to be allocated externally, for example in the JCL of a z/OS batch job.

Note: For adapters that accept files or directories as input, the code is %LET RAWDATA=raw-data-assignment.

If the raw data file or directory is allocated externally, it will be used in preference over the location referred to in the %let statement. For completeness, the %let statement can be removed, but this is not necessary.

CAUTION:
Do not remove or comment out the %let statement for adapters that do not have a raw data file or a directory. For some adapters such as the SAP ERP, MS SCOM, HP Reporter, VMware Data Acquisition, and VMware vCenter adapters, the %let statement is present in the code. However, that statement does not specify a file or a directory. Instead, the %let statement points to the libref of the SAS library that is associated with the raw data. (The location of the input library typically remains fixed, unlike the name or location of individual raw data files.)

If the job is redeployed, the raw data assignment will be reset and will need to be removed again, unless the raw data parameter in the Staging Parameters tab is removed beforehand.

When allocating the raw data file externally for MXG based adapters, the correct fileref must be used. (On z/OS, the fileref is assigned with a DD JCL statement.)

For adapters that are not based on MXG, use a fileref of RAWDATA. For adapters that are based on MXG, use the filerefs in the following table:

Table 12.1 Table of Filerefs for Adapters That Are Based on MXG

<table>
<thead>
<tr>
<th>Adapter</th>
<th>Fileref</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM DCOLLECT</td>
<td>DCOLLECT</td>
</tr>
<tr>
<td>IBM EREP</td>
<td>EREP</td>
</tr>
<tr>
<td>BMC Mainview IMS</td>
<td>IMSLOG</td>
</tr>
<tr>
<td>DT Perf Sentry with MXG</td>
<td>NTSMF</td>
</tr>
<tr>
<td>IBM SMF</td>
<td>SMF</td>
</tr>
<tr>
<td>ASG TMONDB2</td>
<td>TMDBIN</td>
</tr>
<tr>
<td>ASG TMON2CIC</td>
<td>MONICICS</td>
</tr>
<tr>
<td>CA TMS</td>
<td>TMC</td>
</tr>
<tr>
<td>IBM TPF</td>
<td>TPFIN</td>
</tr>
<tr>
<td>Adapter</td>
<td>Fileref</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
</tr>
<tr>
<td>IBM VMMON</td>
<td>MWINPUT</td>
</tr>
</tbody>
</table>
Part 3

Appendixes

Appendix 1
SAS IT Resource Management Components .......................... 321

Appendix 2
Data Sources Supported by SAS IT Resource Management Adapters ........................................ 323

Appendix 3
Staging Parameters .............................................................. 399

Appendix 4
Jobs That the Adapter Setup Wizard Creates for Domain Categories ........................................... 443

Appendix 5
Duplicate-Data Checking ......................................................... 455

Appendix 6
Data Model ........................................................................... 465

Appendix 7
Naming Standards ................................................................. 493

Appendix 8
Macros ............................................................................... 499

Appendix 9
Best Practices and Troubleshooting Tips ......................................................... 537

Appendix 10
Statistics ............................................................................. 555
Appendix 1
SAS IT Resource Management Components

Server Tier Components
SAS IT Resource Management Server for the AIX, HP PA-RISC, HP-UX on Itanium, Solaris SPARC and Solaris 10 x64, Linux 32-bit and x64, z/OS, and Windows x64 and 32-bit operating environments uses the following components:

- Base SAS
- SAS IT Resource Management Server
- MXG from Barry Merrill (z/OS only and included in the IT Resource Management license)
- Demand Technology Performance Sentry (Windows x64 and 32-bit)
- SAS Metadata Server
- SAS Data Integration Studio
- SAS Enterprise BI Server
- SAS/SHARE
- SAS/ETS
- SAS/STAT
- SAS/HPF (includes SAS Threaded Kernel Extensions for Operations Research)
- SAS/ACCESS Interface to ORACLE
- SAS/ACCESS Interface to ODBC (for AIX, HP PA-RISC, HP-UX on Itanium, Linux 32-bit and x64, Solaris SPARC and Solaris 10x64, and Windows 32-bit and x64)
- SAS/ACCESS Interface to DB2 (for AIX, HP PA-RISC, HP-UX on Itanium, Linux 32-bit, Solaris SPARC, z/OS, Windows 32-bit, and Windows 64-bit for Itanium)
- SAS/ACCESS Interface to PC Files

Middle Tier Components
SAS IT Resource Management Web Tier for the AIX, HP-UX on Itanium, Solaris SPARC and Solaris 10 x64, Linux x64, and Windows x64 and 32-bit operating environments uses the following components:

- SAS IT Resource Management Middle Tier
- SAS Web Report Studio
• SAS Information Delivery Portal Web Application
• SAS Web Parts for Microsoft SharePoint
• SAS BI Dashboard
• SAS BI Portlets
• SAS Content Server

*Note:* An application server is obtained separately. Application servers that are supported include the following products:

• JBoss (AIX, HP-UX on Itanium, SPARC and Solaris 10 x64, Linux x64, and Windows x64 and 32-bit)
• Oracle WebLogic (HP UX on Itanium using a 32-bit JRE, Solaris SPARC and Solaris 10 x64 using a 32-bit JRE, and Windows 32-bit)
• IBM WebSphere (z/OS, AIX, Solaris SPARC and Solaris 10 x64, Linux x64, and Windows x64 and Windows 32-bit)

### Client Tier Components

SAS IT Resource Management SAS Client for the Windows XP Professional, Windows Vista, and Windows 7 workstation operating environments uses the following components:

• SAS Data Integration Studio
• SAS IT Resource Management Client
• SAS Enterprise Guide
• SAS Management Console (AIX, HP PA-RISC, HP-UX on Itanium, Linux 32-bit and x64, Solaris SPARC and Solaris 10 x64, and Windows 32-bit and x64)
• SAS Add-In for Microsoft Office
• SAS Information Map Studio
• SAS Workflow Studio
• SAS OLAP Cube Studio
• SAS OLAP Server Monitor
Appendix 2

Data Sources Supported by SAS IT Resource Management Adapters

---

Data Sources Supported by SAS IT Resource Management Adapters .......................... 325

Supported Adapters .................................................................................................. 325

MXG Adapters — Accessing Raw Data ................................................................. 332
  About Accessing MXG Raw Data ........................................................................ 332
  Extracting Data from MXG .................................................................................. 332

BMC Perf Mgr — Accessing Raw Data ................................................................. 332
  Preparing BMC Perf Mgr Data for SAS IT Resource Management .................. 332
  Extracting Data from BMC Perf Mgr ................................................................. 333
  Notes about BMC Perf Mgr ................................................................................ 334

CSV — Accessing Raw Data ................................................................................... 335
  Preparing CSV Data for SAS IT Resource Management .................................... 335
  Accessing CSV Files That Contain Data Encoded in UTF-8 .............................. 336

DT Perf Sentry — Accessing Raw Data ................................................................. 337
  Preparing DT Perf Sentry Data for SAS IT Resource Management .................. 337
  Preparing DT Perf Sentry Data for Processing on z/OS ...................................... 338
  Extracting Data from DT Perf Sentry ............................................................... 338
  Notes about DT Perf Sentry Version 4 and Later ............................................. 338
  Notes about DT Perf Sentry Prior to Version 4 ................................................ 339

HP Perf Agent — Accessing Raw Data ................................................................. 340
  Preparing HP Perf Agent Data for Staging ....................................................... 340
  Extracting Data from HP Perf Agent ............................................................... 340
  Example 1 ........................................................................................................... 341
  Example 2 ........................................................................................................... 342

RRDtool — Accessing Raw Data .......................................................................... 342
  Preparing RRDtool Data for SAS IT Resource Management ......................... 342
  Preparing the RRDtool Adapter for Staging ..................................................... 343

SAR — Accessing Raw Data .................................................................................. 344
  Preparing SAR Data for SAS IT Resource Management ................................... 344
  Extracting Data from SAR ................................................................................ 344
  Using the sar Command .................................................................................... 345

SNMP — Accessing Raw Data ............................................................................. 346
  Sources of SNMP Data ...................................................................................... 346
  Extracting Data By Using HP NNM Tools ......................................................... 348
  Extracting Data By Using the Round-Robin Database Tool (RRDTOOL) .......... 349
  Notes about the SNMPWALK Command ........................................................ 350
  Notes about the SSH Host Command .............................................................. 351
  Working with the ITMS_SNMP_DeviceType Lookup Table ............................... 352
Data Sources Supported by SAS IT Resource Management Adapters

SAS IT Resource Management supports various adapters that enable you to load raw data about IT resources from many diverse data sources and convert that raw data into a standard form that facilitates aggregation and reporting on your IT resources. These adapters extract data from raw data files in a given data source and load that data into staged tables in the IT data mart.

The following table lists each SAS IT Resource Management adapter and identifies the software versions of the raw data sources that were used to verify each of them. The remainder of this appendix provides information about how to prepare the raw data source for use by SAS IT Resource Management.

Note: The specific software versions of the raw data sources in this table have been used to verify each SAS IT Resource Management adapter. This information is not an exclusive list of all data source versions that are supported. Earlier versions of some data source software might be supported and future releases of some data source software might be compatible and supported by adapters for SAS IT Resource Management. For information about supporting a data source version that is not included in the following table, contact your SAS Installation Representative or on-site SAS support personnel.

The following topics provide information about how to access raw data for each adapter. These topics might also provide information about how adapters process that data, when those processes differ from the standard approach used by IT Resource Management.

Supported Adapters

The name of an adapter represents the data source from which SAS IT Resource Management gathers raw data.

Note: All SAS IT Resource Management adapters are supported on all SAS IT Resource Management operating environments unless there is a technical limitation that is associated with the raw data (log file) sources. For example, if the raw data resides on a device that is not compatible with the architecture of the host system on which the SAS IT Resource Management server is installed, then that raw data file might not be usable as input unless further processing is performed.
Table A2.1  Table of Supported Adapters

<table>
<thead>
<tr>
<th>Adapter Name</th>
<th>Description</th>
<th>Latest Verified Version of the Data Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG TMON2CIC</td>
<td>ASG TMON for CICS TS for z/OS (formerly from Landmark) monitors the CICS Transaction Server (TS) and provides resource consumption measurements by tracing each transaction’s performance by CICS event and related unit of work. Note: CICS data can be produced by either ASG TMONCICS or as a subtype of SMF.</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>ASG TMONDB2</td>
<td>ASG TMON for DB2 (formerly from Landmark) works with the SQL Analyzer to manage DB2 applications and critical DB2 resources by providing a single view of DB2 data-sharing group performance. ASG TMON for DB2 tracks DB2 buffer pools, lock contention and serialized resource usage, transaction statistics from ASG TMON for CICS to ASG TMON for DB2, and dynamic and static SQL calls. ASG TMON for DB2 provides a view for all performance statistics by plan, package, and statement, including CPU time, I/O analysis, lock activity, and buffer pool utilization by SQL statement.</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>BMC Mainview</td>
<td>BMC Mainview for IMS (formerly IMF) supplies transaction information such as CPU usage, number of I/Os, and response time. When you collect BMC Mainview for IMS data instead of IBM IMS data, BMC recommends that you collect a duration of one hour of consistently high activity, starting at the beginning and ending at the end of an RMF interval.</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>BMC Perf Mgr</td>
<td>BMC Performance Manager for Servers (formerly BMC PATROL) collects UNIX and Windows enterprise system management data.</td>
<td>v3.7.30</td>
</tr>
<tr>
<td>CA TMS</td>
<td>The Computer Associates CA 1 Tape Management product (formerly TMS) controls and protects tape data sets and volumes in z/OS environments.</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>Adapter Name</td>
<td>Description</td>
<td>Latest Verified Version of the Data Source</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Comma Separated Values (CSV)</td>
<td>The Comma Separated Values adapter is a SAS product that reads any character delimited file.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>DT Perf Sentry</td>
<td>Demand Technology Performance Sentry (formerly NTSMF) collects data from Windows systems and for Windows server applications such as Exchange, SQL Server, and IIS. SAS IT Resource Management also supports a separate Demand Technology Performance Sentry adapter that is z/OS based. The Demand Technology Performance Sentry with MXG adapter that is z/OS based is for raw data sources that are supported through MXG.</td>
<td>v3.1.4</td>
</tr>
<tr>
<td>DT Perf Sentry with MXG</td>
<td>Demand Technology Performance Sentry (formerly NTSMF) with MXG collects data from Windows systems and for Windows server applications such as Exchange, SQL Server, and IIS. (SAS IT Resource Management also supports a separate Demand Tech Perf Sentry adapter that is not MXG based.)</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>HP Perf Agent</td>
<td>HP Performance Agent (formerly OpenView Performance Agent) captures enterprise systems management measurement data for IT resources from Windows systems and many UNIX variants such as HP-UX, Sun OS/Solaris, IBM AIX, Tru 64 UNIX, and Linux.</td>
<td>v5.0</td>
</tr>
<tr>
<td>HP Reporter</td>
<td>HP Reporter software (formerly OpenView Reporter) captures HP Performance Agent measurement data that is stored in a relational database via SAS/ACCESS to Oracle or ODBC.</td>
<td>v3.70</td>
</tr>
<tr>
<td>IBM AS400</td>
<td>IBM OS/400 Collection Services</td>
<td>MXG 30.30*</td>
</tr>
</tbody>
</table>

Note: The staging code that is required for the IBM AS400 data source is not automated by a SAS IT Resource Management adapter. Instead, SAS IT Resource Management supplies a User-written Staging transformation and templates that contain table and column metadata for this adapter for use with user-written staging code.
<table>
<thead>
<tr>
<th>Adapter Name</th>
<th>Description</th>
<th>Latest Verified Version of the Data Source</th>
</tr>
</thead>
</table>
| IBM DCOLLECT | IBM DFSMS Data Collection Facility obtains the following Mainframe Storage System data:  
  - active data sets  
  - VSAM data set information  
  - volumes  
  - inactive data  
  - migrated data sets  
  - backed-up data sets  
  - capacity-planning data such as the following:  
    - DASD capacity planning: IBM DCOLLECT provides information and statistics for volumes that are managed by DFSMS/hsm (ML0 and ML1).  
    - tape capacity planning: IBM DCOLLECT provides statistics for tapes that are managed by DFSMS/hsm.  
  - SMS configuration information | MXG 30.30* |
| IBM EREP     | IBM Environmental Record Editing and Printing Program processes the error records from the MVS, VM, and VSE operating systems to produce formatted reports. These IBM EREP reports can show the status of the entire installation, an I/O subsystem, or an individual device, depending on which report you request. IBM EREP reports can vary in format, depending on the following report types:  
  - System summary reports show error data in summary form.  
  - Trend reports show error data by daily totals.  
  - Event history reports show error data in a time sequence by occurrence. | MXG 30.30* |
<table>
<thead>
<tr>
<th>Adapter Name</th>
<th>Description</th>
<th>Latest Verified Version of the Data Source</th>
</tr>
</thead>
</table>
| IBM IMS      | IBM Information Management System (IMS) is the transaction and hierarchical database management system from IBM.  
\textit{Note:} The staging code that is required for the IBM IMS data source is not automated by a SAS IT Resource Management adapter. Instead, SAS IT Resource Management supplies a User-written Staging transformation and templates that contain table and column metadata for this adapter for use with user-written staging code. | MXG 30.30* |
| IBM SMF      | IBM System Management Facility collects and records system and job-related information that is used for the following purposes:  
• billing users  
• reporting reliability  
• analyzing the configuration  
• scheduling jobs  
• summarizing direct access to volume activity  
• evaluating data set activity  
• profiling system resource use  
• maintaining system security  
\textit{Note:} RMF is a subtype of SMF records. IBM RMF is the IBM strategic product for z/OS performance measurement and management. IBM RMF is the base product that collects performance data for z/OS and Sysplex environments to monitor system performance. Because IBM RMF data is a subtype of IBM SMF data, the IBM SMF adapter can be used with IBM RMF data without requiring additional customizations. | MXG 30.30* |
<p>| IBM TPF      | The IBM Transaction Processing Facility operating system works with application programs to process transactions in a real-time environment. The IBM TPF system is designed for businesses and organizations that have large networks and high volumes of online transactions. | MXG 30.30* |</p>
<table>
<thead>
<tr>
<th>Adapter Name</th>
<th>Description</th>
<th>Latest Verified Version of the Data Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM VMMON</td>
<td>IBM VM Monitor Collection product collects performance information that is associated with VM, including measurements for user activity, processor storage, I/O, and applications.</td>
<td>MXG 30.30*</td>
</tr>
<tr>
<td>MS SCOM</td>
<td>Microsoft System Center Operations Manager monitors Windows systems, Microsoft software, and applications to provide a view of the health of an organization’s Windows environment.</td>
<td>v2007</td>
</tr>
<tr>
<td>RRDtool</td>
<td>RRDtool is the OpenSource industry standard, high performance data logging and graphing system for time series data. It compiles on Microsoft Windows and many Linux and UNIX platforms.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>SAP ERP</td>
<td>Enterprise Resource Planning (ERP) Software from SAP (formerly SAP R/3), via the SAS IT Management Adapter for SAP, collects SAP ERP and SAP Business Warehouse (BW) workload performance measurements.</td>
<td>v7.0</td>
</tr>
<tr>
<td></td>
<td>• For SAP ERP, measurements are read from the SAP Statistic File (stat file).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• For SAP BW, the measurements that communicate the amount of computer resources that were consumed to populate and query BW cubes are read. These measurements are then used to supplement BW server performance statistics.</td>
<td></td>
</tr>
<tr>
<td>SAR</td>
<td>System Activity Reporter is a logging mechanism that is native to most UNIX and Linux variants. SAR captures the contents of cumulative system activity counters.</td>
<td>Dependent on the operating system.</td>
</tr>
<tr>
<td></td>
<td>For information about specific operation system release versions, see “Accessing Raw Data for SAR” in Appendix 2, “Data Sources Supported by SAS IT Resource Management Adapters” in SAS IT Resource Management: Administrator’s Guide.</td>
<td></td>
</tr>
<tr>
<td>Adapter Name</td>
<td>Description</td>
<td>Latest Verified Version of the Data Source</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>SNMP</td>
<td>Simple Network Management Protocol is a component of the Internet Protocol Suite. The SNMP adapter also supports gathering SNMP data from round-robin databases (RRDs) that are used in many network management tools.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>VMware vCenter</td>
<td>VMware vCenter Server is an operational console for VMware and includes the VMware vCenter database that serves as the raw data source for this SAS IT Resource Management adapter. The vCenter database contains VMware performance and utilization measurements for both the virtual machines and the physical servers on which they run, including detailed CPU, memory, storage, and I/O metrics. The vCenter relational database is accessed via SAS/ACCESS to Oracle, DB2, or ODBC.</td>
<td>v4.0</td>
</tr>
</tbody>
</table>
| VMware Data Acquisition| VMware Data Acquisition is a transformation that can extract topology and configuration information from the VMware vCenter database more frequently than once a day. The vCenter relational database is accessed via SAS/ACCESS to Oracle, DB2, or ODBC.  
*Note:* This is not an adapter. However, a staging transformation is available for this source. | v4.0                                      |
| Web Log                 | The Web Server Log adapter reads and analyzes Web logs that conform to the Common and W3C Extended Log Formats (CLF and ELF.) | Not applicable                           |

* SAS IT Resource Management uses MXG for this adapter.

**Note:** The specific software versions of the raw data sources in this table have been used to verify each SAS IT Resource Management 3.3 adapter. This information is not an exclusive list of all data source versions that are supported. Earlier versions of some data source software might be supported. Future releases of some data source software might be compatible and supported by adapters for SAS IT Resource Management 3.3. For information about supporting a data source version that is not included in the previous table, contact your SAS Installation Representative or on-site SAS support personnel.
For data sources (and for raw data sources) that are user-written, staging code is supported by the wizards of SAS Data Integration Studio, and the transformations that are supplied by SAS IT Resource Management. The New Table wizard of SAS Data Integration Studio can create the transformations that can stage raw data from any input source.

## MXG Adapters — Accessing Raw Data

### About Accessing MXG Raw Data

MXG creates SAS data sets for each of the data sources that it supports. These data sets can be accessed directly by the adapter staging code. MXG supports the following data sources:

- ASG TMON2CIC
- ASG TMONDB2
- BMC Mainview IMS
- CA TMS
- DT Perf Sentry with MXG
- IBM DCOLLECT
- IBM EREP
- IBM SMF
- IBM TPF
- IBM VMMON

For information about the IBM SMF performance areas that are collected by MXG, see “SMF Adapter - RMF Domain Category” on page 477 and “SMF Adapter - Jobs, TSO, and OMVS Domain Categories” on page 478.

### Extracting Data from MXG

MXG creates SAS data sets for each of the data sources that it supports. These data sets can be accessed directly by the adapter staging code.

## BMC Perf Mgr — Accessing Raw Data

### Preparing BMC Perf Mgr Data for SAS IT Resource Management

BMC Performance Manager for Servers data is collected by BMC Performance Manager, which was formerly BMC Patrol. BMC Perf Mgr data can be collected from the following operating systems:

- Windows NT
- UNIX
- SAP ERP
The BMC Perf Mgr Agent maintains parameter history data about the systems that it monitors. For more information, see your BMC Perf Mgr documentation.

BMC Perf Mgr enables each metric to be sampled at its own interval. This interval can be set by the BMC Perf Mgr administrator. SAS IT Resource Management requires that the sample rates be specified on minute boundaries. (However, you can also specify a sample rate of 30 seconds.)

SAS IT Resource Management provides support for three Knowledge Modules:

- Windows NT Knowledge Module
- UNIX Knowledge Module
- SAP ERP Knowledge Module Version 2.2

For information about the performance areas that are collected by BMC Perf Mgr, see “BMC Perf Mgr Adapter - BMC Perf Mgr Domain Category” on page 469.

**Extracting Data from BMC Perf Mgr**

A raw data file of BMC Perf Mgr history data can be generated in two ways:

- extracting data from the BMC Perf Mgr History Knowledge Module

  The history knowledge module organizes the collection of the history data and ensures that it is sent to a central server from which it can be extracted. For more information about this method, see the documentation from BMC Perf Mgr about the History Loader Knowledge Module.

- extracting data by using the `dump_hist.exe` command

  This command extracts the same history data that is extracted from the History Knowledge Module. However, it does not manage the transferal of the data to a central location. (This option is useful if you prefer writing your own scripts to control the extraction and transferal of the data to a central location.)

  *Note:* When transferring the history data across platforms, ensure that the data retains its ASCII text format.

Although these two methods produce slightly different output, both can be processed by the staging transformation of SAS IT Resource Management. The BMC Perf Mgr Operator Console retrieves the historical data that is stored by the Agent. The `dump_hist` line command copies the parameter history data that is maintained by the BMC Perf Mgr Agents. The BMC Perf Mgr Agent Reference Manual contains more detailed information about the `dump_hist` command. (The `dump_hist.exe` program is provided as part of the BMC Performance Manager software.)

The following command copies parameter history data for one day for the file that is indicated by `filename`. The command uses start (-s) and end (-e) parameters to specify the date and time of data that is to be copied. The format of these parameters is `MMddhhmm[yyyy]`, where

- `MM` = month
- `dd` = day
- `hh` = hour
- `mm` = minute
- `yyyy` = year, which is optional

The following code copies the full day of data from July 18, 2007.
The following example shows the format of the text file that is created by the preceding `dump_hist` command. This file can be input to the staging transformation of SAS IT Resource Management.

```
machinename/NT_CPU.CPU_0/CPUprcrUserTimePercent
Thu Jul 18 10:00:57 2007 26.981
Thu Jul 18 10:01:58 2007 5.35963
Thu Jul 18 10:02:58 2007 0.598205
Thu Jul 18 10:03:58 2007 0.333915
machinename/NT_CPU.CPU_0/CPUprcrPrivTimePercent
Thu Jul 18 10:00:57 2007 61.0279
Thu Jul 18 10:01:58 2007 1.20528
Thu Jul 18 10:02:58 2007 1.56053
Thu Jul 18 10:03:58 2007 1.05312
machinename/NT_SYSTEM.NT_SYSTEM/SYSsysTotalProcTimePercent
Thu Jul 18 10:00:57 2007 88.013
Thu Jul 18 10:01:58 2007 6.56211
Thu Jul 18 10:02:58 2007 2.1812
Thu Jul 18 10:03:58 2007 1.36592
```

To dump data for a single server, add the `-host <hostname>` parameter to the previous command. The command then dumps a full day of data for the single server that is identified by `<hostname>`.

For additional information about the syntax of the `dump_hist`, see the PATROL® Script Language Reference Manual.

**Notes about BMC Perf Mgr**

When staging BMC Perf Mgr data on z/OS, allocate the z/OS file with an LRECL= 200. (BMC Perf Mgr data typically has variable length records, but they do not exceed 200 bytes in length.)

Processing BMC Perf Mgr history data into a staged table might require the following two issues to be resolved:

- different sample rates are collected for each metric

  Two metrics 'A' and 'B' are not necessarily sampled at the same rate. Metric 'A' might be sampled at 1-minute intervals, and 'B' might be sampled at 5-minute intervals. To combine these two metrics into the same observation in a table is invalid because each value should eventually be weighted by the duration variable. To resolve this problem, the staging code of SAS IT Resource Management includes a variable in each BMC Perf Mgr table called DURGRP. DURGRP is a string that represents the duration group to which a metric belongs. In this example, metric 'A,' which is sampled every minute, is included in the observation with a DURGRP value of 60 (60 seconds). Metric 'B' is included in an observation with a DURGRP of 300 (300 seconds).

  The DURGRP variable is used only during staging to ensure that the metrics are reduced and summarized by their respective duration values (assuming that they are weighted by DURATION).

  If numerous null values are present in each observation, then the BMC Perf Mgr data in the SAS IT Resource Management tables might look unusual. The number of DURGRPs and null values depends on the number of different sample rates that are applied to metrics that belong to the same table.
Datetime Stamps of Samples Are Not Exactly Aligned

In this example, two metrics 'A' and 'B' are both sampled at 1-minute intervals. In the following example history data, the first sample occurred at x for both metrics. However, in the second sample, the datetime stamps differ by a second and 'B' is sampled later than 'A'. The first sample for each metric is combined into a single observation because the duration and datetime stamps are the same. However, this is not the case for the second sample.

machinename/NT_CPU.CPU_0/A
Thu Jul 18 10:00:57 2007 26.981
Thu Jul 18 10:01:58 2007 5.35963
machinename/NT_CPU.CPU_0/B
Thu Jul 18 10:00:57 2007 61.0279
Thu Jul 18 10:01:57 2007 1.20528

During the staging of the raw data, SAS IT Resource Management detects that this second sample has related datetime values and collapses the data into one observation. The result is that the data in the staged table is less sparse. However, the datetime and duration values are only near approximations.

---

**CSV — Accessing Raw Data**

**Preparing CSV Data for SAS IT Resource Management**

CSV (Comma Separated Values) files are flat files that contain rows of data. The values (or columns) on each row are separated by some sort of delimiter (CSV has come to mean any delimited data, not just comma delimited data). The delimiter is either a single character or a string of characters.

<table>
<thead>
<tr>
<th>Type of Delimiter</th>
<th>Delimited Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comma Delimited (,)</td>
<td>7.8048232979,68.79,7110.58</td>
</tr>
<tr>
<td>Bang Delimited (!)</td>
<td>7.8048232979!68.79!7110.58</td>
</tr>
<tr>
<td>String Delimited (abc)</td>
<td>7.8048232979abc68.79abc7110.58</td>
</tr>
</tbody>
</table>

*Note:* In each of the preceding table entries, there are three sets of values. CSV files often have a header line that contains the names of the columns. The names must also be delimited like the data.

<table>
<thead>
<tr>
<th>Type of Delimiter</th>
<th>Delimited Header Rows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comma Delimited (,)</td>
<td>Column 1, Column 2, Column 3</td>
</tr>
</tbody>
</table>

---
<table>
<thead>
<tr>
<th>Type of Delimiter</th>
<th>Delimited Header Rows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bang Delimited (!)</td>
<td>Column 1!Column 2!Column 3</td>
</tr>
<tr>
<td>String Delimited (abc)</td>
<td>Column 1abcColumn 2abcColumn 3</td>
</tr>
</tbody>
</table>

*Note:* The header row can be on any row although it is usually the first row. The data rows begin any time after the header row, but they usually begin on the second row. Values that contain, or could contain, the delimiter are enclosed in quotation marks (“ ”) to indicate that the delimiter should be ignored.

The CSV adapter can read most styles of CSV files. There are a set of parameters on the **Staging Parameter** tab of the CSV staging transformation that will enable you to describe the following data:

- what the delimiters are
- whether there can be embedded delimiters
- what row the header is on
- what row the data starts on

The adapter can also read a CSV file that does not have a header row. In that case, the columns are named: Column1-Columnn.

The CSV adapter can read multiple CSV files (all the files in a specified directory) at the same time as long as the files have the same structures. In other words, if they have a header row, then the header rows must be the same. If they do not have a header row, then the files must have the same number of columns. If these conditions are not satisfied, then the adapter will not be able to read the data. In addition, an error will be displayed when you try to create the new staged table. When reading multiple CSV files, the adapter creates a single staged table as output with all the data combined.

Because this data is being read by SAS IT Resource Management, the data is expected to include a date/time or time stamp. If there is a column in the CSV file that has a header of DATETIME, then the adapter uses that column as the standard IT Resource Management DATETIME column. (The case of DATETIME is not significant.) Otherwise, a DATE column and a TIME column are combined to create the DATETIME column. If none of these headers are found in the CSV file, then the DATETIME column is created from the first encountered columns that have a datetime, date, or time value. If no date or time columns are found in the data, then the DATETIME is set to missing.

### Accessing CSV Files That Contain Data Encoded in UTF-8

If your CSV rawdata files contain data that is encoded in UTF-8, then you must set the encoding on the staging LIBNAME statement in order to access them. To do this, perform the following steps:

1. In the SAS IT Resource Management client, navigate to the staging library for your CSV staged tables and right-click that library.
2. Select **Properties**.
3. Select the **Options** tab.
4. Click **Advanced Options**.
5. Select the **Options for any host** tab. In the **Encoding to use when reading a file** field, enter *utf8*. 
6. Click OK.

---

DT Perf Sentry — Accessing Raw Data

Preparing DT Perf Sentry Data for SAS IT Resource Management

SAS IT Resource Management provides both a native DT Perf Sentry adapter and an adapter based on MXG (DT Perf Sentry with MXG). IT Resource Management supplies aggregations with the native DT Perf Sentry adapter. Therefore, using the native DT Perf Sentry adapter is recommended.

Note: Demand Technology Performance Sentry software is included in your SAS Software Depot for IT Resource Management when the server tier is licensed on a Windows system. The executable software that installs Demand Technology Performance Sentry is in the products\perfsentry__92110__prt__xx__sp0__folder. The Performance Sentry license installation enables you to manage up to 100 Windows systems and is set to expire 180 days after installation. At that time, you must contact Demand Technology to arrange to continue the use of this software at your site. For information about this software, see http://www.demandtech.com.

The Demand Technology Performance Sentry product (formerly NTSMF) collects a variety of Windows NT performance objects and their associated counters. Perf Sentry gathers and calculates object counter values that are based on the counter type. It then writes them on a periodic basis to an ASCII-formatted, comma-delimited, or tab-delimited data file. This file is input directly into SAS IT Resource Management.

The following requirements apply to the collection of DT Perf Sentry data:

- For Windows and UNIX operating environments, if you transfer files across operating systems, make sure that the files retain their ASCII format. (If you want to process your data on z/OS, then the data must be converted from ASCII format to EBCDIC. For information, see “Preparing DT Perf Sentry Data for Processing on z/OS.”)

- Discovery records must be collected in DT Perf Sentry smf log files and must be written for all types of data records.

- If your version of Performance Sentry Administration enables you to select which Discovery record types are collected, select the type 5 records. However, record types 6 and 7 can also be selected because these records do not add any significant overhead in terms of space or performance.

- Compressed and uncompressed records can be processed.

- The delimiter that is used in DT Perf Sentry data must be a comma or a tab character.

- Total records must not be written to the data file.

- DT Perf Sentry filters must not be used.

For information about the performance areas that are collected by DT Perf Sentry, see “DT Perf Sentry Adapter - DT Perf Sentry Server-Based Domain Categories” on page 470 and “DT Perf Sentry Adapter - DT Perf Sentry Exchange Domain Category” on page 471.
Preparing DT Perf Sentry Data for Processing on z/OS

In addition to the preceding requirements, if you want to process DT Perf Sentry logs on z/OS, you must allocate a PDS with the following DCB attributes on z/OS:

DSORG=PO, RECFM=VB, LRECL=256

Note: Accept the default for BLKSIZE.

Extracting Data from DT Perf Sentry

The log file that is created by the DT Perf Sentry agent program can be input directly into SAS IT Resource Management 3.1.1 and later. It contains two types of records:

• discovery records that contain the format of the data records
• data Interval records that contain the counters for the performance areas that are being measured

Each DT Perf Sentry smf file should be maintained as a separate smf file. Concatenating smf files is not recommended. The DT Perf Sentry adapter accepts the pathname to either a raw data file or a directory that contains the input files for the adapter.

If a directory is specified, the directory cannot contain subdirectories or any files other than valid DT Perf Sentry raw data files. DT Perf Sentry does not manage the transferal of the data to a central location.

• On the UNIX and Windows operating environments, place the multiple smf files into a single directory where they can be input to the staging transformation in SAS IT Resource Management. No other files or subdirectories should be in this directory. Use the file management utility of your choice to accomplish this transferal of data.

• On the z/OS operating environment, use the File Transfer Protocol (FTP) to transmit each smf log on to a unique PDS member, converting it from ASCII to EBCDIC as it is transmitted. By specifying the PDS name in the input location, each member is processed.

For more information, see the Demand Technology Performance Sentry (NTSMF) User Guide.

Notes about DT Perf Sentry Version 4 and Later

After installation, DT Perf Sentry logs the performance data that is based on default parameter values that are stored in the chosen Data Collection Set (DCS). The parameter values determine what data elements to collect and how frequently to collect them.

For best results, use these collection sets: “Default Collection Set” for Windows server and “Exchange Server Starter Set” for Exchange.

For more information about Data Collection Sets, see the "Performance Sentry Administration" chapter of the Demand Technology Performance Sentry (NTSMF) User Guide for version 4. This document is also available at http://demandtech.com in the Product Documentation section of the Downloads tab.
Notes about DT Perf Sentry Prior to Version 4

How to Use Data Collection Sets Prior to Version 4
For Demand Technology Performance Sentry prior to version 4, use the “ITRM Windows Server” and “ITRM Exchange” collection sets. These collection sets are designed to correspond to the aggregations that SAS IT Resource Management provides for the DT Perf Sentry adapter. However, you do not have to use these data collection sets (DCS) in order to load DT Perf Sentry data into SAS IT Resource Management IT data marts. You can modify the objects and counters within the data collection sets as needed.

Note: You can access the ITRM Windows Server and ITRM Exchange collection sets for prior versions of Demand Technology Performance Sentry from the SAS IT Resource Management website at: http://support.sas.com/documentation/onlinedoc/itsv/dtperfsentry.html.

These DCS files are included wherever the IT Resource Management server tier is installed. You should move these files to the system where you installed DT Perf Sentry. Then, during the setup of the Demand Technology Performance Sentry product on the Windows system, instruct the product to use these two files. This action enables the correct set of metrics to be recorded on the DT Perf Sentry log files.

• By default, if the IT Resource Management server is installed on z/OS, a PDS called ITRM.CPMISC is automatically created with the ITRMEXCH and ITRMSRVR members. Use the File Transfer Protocol (FTP) to transmit the ITRMEXCH and ITRMSRVR members of the ITRM.CPMISC installation data set to the Windows system where Demand Technology Performance Sentry software is installed. (These members of the PDS are plain text fields and do not have to be transmitted in binary mode.)

• By default, if the IT Resource Management server is installed on UNIX, the DCS files are called ITRMExch.DCS and ITRMSrvr.DCS. The files can be located at /SASHome/SASFoundation/9.3/misc/itmsmvadata. Use the File Transfer Protocol (FTP) to transmit the two DCS files to the Windows system where Demand Technology Performance Sentry software is installed.

• By default, if the IT Resource Management server is installed on Windows, the DCS files are called ITRMExch.DCS and ITRMSrvr.DCS. The files can be located at C:\Program Files\SASHome\SASFoundation\9.3\itmsmvadata\sasmisc. You can copy and paste the files from this location to the Windows system where Demand Technology Performance Sentry software is installed.

Note: The DCS files are also available wherever the IT Resource Management server tier is installed. If you want to use these files, you should move them to the system where your DT Perf Sentry is installed.

How to Access the ITRM Windows Server DCS
To access the ITRM Windows Server DCS, perform the following steps:

1. Navigate to the ITRM Windows Server section of the http://support.sas.com/documentation/onlinedoc/itsv/32/dtps.html page. In that section, click the [ZIP] file that is referenced there. Download the ITRM Windows Server data collection set and place it in a location that is accessible to the Demand Technology Performance Sentry DCS Administration client.

2. Open the Sentry Administration client.
3. In the DCS Administration window, select File \(\implies\) Import DCS.

4. Provide the location where the ITRM Windows Server data collection set was downloaded. The ITRM Windows Server data collection set should appear in the list of Available Data Collection Sets.

**How to Access the ITRM Exchange DCS**

To access the ITRM Exchange DCS, perform the following steps:

1. Navigate to the ITRM Exchange section of the [http://support.sas.com/documentation/onlinedoc/itsv/32/dtps.html](http://support.sas.com/documentation/onlinedoc/itsv/32/dtps.html) page. In that section, click the [ZIP] file that is referenced there. Download the ITRM Exchange data collection set and place it in a location that is accessible to the Demand Technology Performance Sentry DCS Administration client.

2. Open the Sentry Administration client.

3. In the DCS Administration window, select File \(\implies\) Import DCS.

4. Provide the location where the ITRM Exchange data collection set was downloaded. The ITRM Exchange data collection set should appear in the list of Available Data Collection Sets.

---

**HP Perf Agent — Accessing Raw Data**

**Preparing HP Perf Agent Data for Staging**

HP Performance Agent software captures enterprise systems management measurement data from Windows systems and many UNIX variants such as HP-UX, Sun OS/Solaris, IBM AIX, Tru 64 UNIX, and Linux. (HP Performance Agent software was formerly called OpenView Performance Agent.)

For information about the performance areas that are collected by HP Perf Agent, see “HP Perf Agent and HP Reporter Adapters” on page 472.

**Extracting Data from HP Perf Agent**

The log files that contain the performance data can be exported by using `extract`, an HP Performance Agent program. The `extract` program writes the performance data in binary format. This binary file is then used as input to SAS IT Resource Management.

The following list is a partial list of the options and arguments that can be used to specify how to run the `extract` command. For the complete list of options and arguments that are available, see the *HP Performance Agent User's Manual*.

- `-xp`
  - exports the extracted data to the specified output file.

- `d`
  - extracts all the data from a single day.

- `-f output-filename`
  - specifies that the output is to be written to an output file that can be read directly into SAS IT Resource Management.
-gapdcnt
  specifies the types of data to extract.

-i
  specifies the extraction of logical system data for the host and any associated guest machines present in the virtual environment. If -i is not specified, the extraction can still work, but no logical system data is extracted.

Note: The -i option applies to the designated host machine in a virtual operating environment. At this time, the -i option applies to the following three platforms: HP-UX (virtual machine configuration), AIX (LPARs or logical partition configuration), and Linux (VMWARE ESX configuration).

-r export-template-filename
  specifies the name of the export template file. This file governs the format that is used for the exported data.

Note: See the HP Performance Agent User's Manual for the Windows or for the UNIX operating systems for instructions about running the HP Extract command interactively in Guided mode. Running the command in this mode enables you to create an export-template-file that is used to generate the data that can be input to SAS IT Resource Management. SAS IT Resource Management expects the extracted data to be in a binary format. This format is specified when the export template file is created. The SAS IT Resource Management data model lists the tables and variables for the HP Perf Agent Adapter. The data model is available for review at . You can use the data model to specify the HP export function so that it produces a customized export template file that meets the needs of your site.

-v
  generates verbose output report formats.

  Verbose mode enables the echoing of commands and command results.

Example 1

The following command extracts all the data for yesterday (d-1). It exports the data to the output file that is named data.bin, using the template in a file that is named reptfile.mwr. The purge parameter specifies that any existing file is purged in order to make room for the new file. The gapdcnt option specifies that the following types of data are to be extracted and exported: global detail, application detail, process detail, disk device detail, configuration detail, netif detail, and transaction detail.

```
extract -xp d-1 -gapdcnt -r reptfile.mwr -f data.bin,purge -v
```

The log file that is created by HP Performance Agent software can be input directly into SAS IT Resource Management. Alternatively, you can store multiple log files in a directory that can be input to SAS IT Resource Management.

It is advisable to put the extract command into a shell, bat, or Perl script that runs once a night by means of a scheduling tool. (Perl is an open-source programming language that can be used for data manipulation tasks.) Cron can be used for scheduling on UNIX systems, and Task Manager can be used on Windows operating systems. The extracted files from each server can then be transferred to a centralized location to be read by SAS IT Resource Management using the file transfer utility of your choice. Delete the older raw data files to preserve disk space.
Example 2

The following shell script runs on Linux and extracts yesterday's data into files that have date extensions as part of the name.

```bash
$ cat /var/opt/perf/datafiles/itrm-extract/extract.sh
# shell script to do HPOV extracts
/opt/perf/bin/extract -xp d-1 -gapdcnt -l /var/opt/perf/datafiles/logglob -r /var/opt/perf/reptfile.mwr -f /var/opt/perf/datafiles/itrm-extract/server1-'date +%y%m%d'.bin, purge -v
```

The output file that is generated by the preceding shell script is of the form `server1-yyyyymmdd.bin`. (If yesterday's date is November 26, 2007, then the name of the output file is `server1-071126.bin`). The output file is placed in the directory that is located at: `/var/opt/perf/datafiles/itrm-extract`.

For more information about generating HP Perf Agent data files, see the *HP Performance Agent User's Manual*.

RRDtool — Accessing Raw Data

**Preparing RRDtool Data for SAS IT Resource Management**

The round-robin database tool, RRDtool, is a freeware package that is available for download from Tobias Oetiker.

The RRDtool adapter reads any round-robin databases that have been created with rrdtool. The data can be gathered at any interval (step), any metrics can be gathered, and any consolidation function (CF) can be used. Because SAS IT Resource Management has its own aggregation process, the data read from the round-robin databases should be detail data, not consolidated data. In order to store detail data using rrdtool, set the CF to any statistic, and then set the number of steps for each consolidation point to 1. This keeps the data at the detail level, that is, one record for each time interval.

*Note:* The RRDtool adapter reads the data even if it has been consolidated.

The adapter will read a single round-robin database, or it will read all round-robin databases in directory. If multiple round-robin databases are read, the data will be combined into a single staging table.

Because a round-robin database can store only numeric data, users of rrdtool generally store identifying character data in the name or path of the round-robin database. For example, SNMP data is often stored in round-robin databases and the device and interface information is usually used in the name of the round-robin database to identify the metrics that are being gathered. The filename of each round-robin database is saved by the RRDtool adapter in a field called `filename`. Therefore, it can be used to create computed columns with this identifying information. For example, if you have two round-robin databases: `c:\RRD\ABC.rrd` and `c:\RRD\XYZ.rrd`, then you can create a computed column with an expression of `scan(filename, 3, ".")`

This enables you to store the name of each RRD (“ABC” and “XYZ”) in a new column.
Note: You can backload data from the RRDtool adapter. To do so, use the `rrdtool fetch --start` option and `rrdtool fetch --end` option staging parameters to specify the date range of data to be read.

**Preparing the RRDtool Adapter for Staging**

To read the raw data from rrdtool, run Perl scripts as part of the staging process. This means that Perl must be installed on the machine that the SAS program runs on, that is, the SAS Workspace Server, the SAS batch server, or interactive SAS.

The Perl scripts that are used by the staging code are generated as part of the code generation of the staging job. This code can be viewed and modified as necessary in the Code tab of the job.

To run these scripts in batch mode, it is necessary to set the xcmd option for the Batch server. To do so, change `set USERMODS_OPTIONS=` to `set USERMODS_OPTIONS=XCMD`.

To run these scripts from within the SAS Workspace server, it is necessary to have the SAS option XCMD turned on. By default this option is off in the Workspace server. To turn the option on, perform the following steps:

1. Launch SAS Management Console. Log on as an administrator.
2. Expand the Server Manager in the left panel.
3. Expand SASITRM. Then expand SASITRM-Logical Workspace Server.
5. Select the Options tab and click Advanced Options.
6. Select the Launch Properties tab to open the following dialog box.

**Display A2.1** Launch Properties Tab of the Advanced Options Dialog Box

7. Select the Allow XCMD check box.
8. Click OK to close all the open dialog boxes.
9. Stop and then restart your Object Spawner service.

Windows Specifics
To stop your Object Spawner service, select Start ⇒ Programs ⇒ SAS ⇒ SAS Configuration ⇒ <configuration-name> ⇒ Object Spawner ⇒ Stop. To restart your Object Spawner service, select Start ⇒ Programs ⇒ SAS ⇒ SAS Configuration ⇒ <configuration-name> ⇒ Object Spawner ⇒ Stop.

UNIX Specifics
To stop and then restart your Object Spawner service, from the command line, change directories to SAS-config-dir/Lev1/SASMain/ObjectSpawner. Stop the object spawner by issuing this command: $ ./ObjectSpawner.sh stop. When you receive a confirmation that the object spawner has stopped, start it again by issuing this command: $ ./ObjectSpawner.sh start. You should receive a confirmation that the object spawner has started.

z/OS Specifics
To stop and restart your Object Spawner service, stop and restart the z/OS started task associated with the Object Spawner. Follow the stop and restart procedures that are established at your site.

SAR — Accessing Raw Data

Preparing SAR Data for SAS IT Resource Management
System Activity Reporter (SAR) data can be collected from the following operating systems:
- HP-UX 10.2 and later
- IBM AIX 3.2 and later
- SunOS Solaris 5.8 and later
- Linux (Use Sysstat 4.0.1 or Sysstat 5.0.0 and later.)

SAR performance data can be set up to write continuously to a binary file by means of the sapd command. At appropriate intervals, the sar command can be used to write the binary file to an ASCII file. The ASCII file is input to a staging transformation of SAS IT Resource Management.

For information about the performance areas that are collected by SAR, see “SAR Adapter - SAR Domain Category” on page 476.

Extracting Data from SAR
The following sapd and sar commands and shell scripts that collect SAR data are usually available in the /usr/lib/sa directory:
- The sapd command collects performance data into a binary file.

The sa1 shell script is a wrapper for the sapd command and can be scheduled to run automatically through cron.

By default, the binary file that is created by the sa1 shell script is called /var/adm/sa/sa$DATE (where $DATE is the current date). To save the binary data in a different location, modify the sa1 shell script accordingly.
The following cron entry shows an example of running the sa1 shell script to collect performance data every five minutes. The sa1 shell script is run every 20 minutes by cron, and within the sa1 shell script, the `sapd` command collects data for four 300 second (that is, 5-minute) intervals:

```
0,20,40 * * * * /usr/lib/sa/sa1 300 4
```

- The `sar` command extracts the data from the binary file that was created by the `sapd` command and creates an ASCII file that can be read by the SAR staging transformation of SAS IT Resource Management 3.1.1.

The sa2 shell script is a wrapper for the `sar` command, and can be scheduled to run automatically through cron.

By default, the binary file is `/var/adm/sa/sa$DATE`. To change the location of the binary file or the location of the ASCII file, modify the sa2 shell script accordingly.

The following cron entry shows an example of running the sa2 shell script on Linux to create ASCII files once a day at 12:55AM:

```
55 0 * * * /usr/lib/sa/sa2 -A
```

**Note:** The switches for the `sar` command can be passed as parameters to the sa2 shell script.

### Using the `sar` Command

The `sar` command can be used to collect the following types of data:

- global data (data for the entire system)
- processor level data (data for each processor on the system)

If processor level data is collected, it can be staged in the SARCPUB table. Each UNIX environment has its own set of options that can be specified with the `sar` command.

SAS IT Resource Management recommends setting the following switches:

- for HP-UX operating environments:
  
  To collect global data as well as per-processor data on HP-UX, you must create two files by executing two `sar` commands.

  - To collect global data, execute the following command:
    
    ```
    ```

  - To collect processor level data, execute the following command:
    
    ```
    sar -Mu -f /var/adm/sa/sa$DATE > /var/adm/sa/sar$DATE_processor
    ```

- for AIX operating environments:

  To collect global data as well as per-processor data on AIX, you must create two files by executing two `sar` commands.

  - To collect global data, execute the following command:
    
    ```
    sar -bdkqrvy -f /var/adm/sa/sa$DATE > /var/adm/sa/sar$DATE_global
    ```

  - To collect processor level data, execute the following command:
    
    ```
    sar -A -P ALL -f /var/adm/sa/sa$DATE > /var/adm/sa/sar$DATE_processor
    ```

- for Linux operating environments:

  To collect both global and processor level data, use the following `sar` command:
SNMP — Accessing Raw Data

Sources of SNMP Data

Simple Network Management Protocol (SNMP) data can be collected from the following sources:

- HP Network Node Manager (HP NNM)
- Round-Robin Database

Reporting on the data available from the SNMP adapter can be enhanced by mapping devices to their device type. For information about how to enable this functionality, see “Working with the ITMS_SNMP_DeviceType Lookup Table” on page 352.

The SNMP adapter is designed with a data model that contains MIB2 data and can be extended to other MIBs. For information about how to do so, see For “Working with Management Information Base (MIB) Definitions for SNMP Staged Tables” on page 353.

In order to read the raw data from either HP NNM or rrdtool, it is necessary to create Perl scripts as part of the staging process. This means that Perl must be installed on the machine that the SAS program runs on, that is, the SAS Workspace Server, the SAS batch server, or interactive SAS.

The Perl scripts that are used by the staging code are generated as part of the code generation of the staging job. This code can be viewed and modified as necessary in the Code screen of the job. To run these scripts in batch mode, it is necessary to set the xcmd option for the Batch server. To do so, change `set USERMODS_OPTIONS=` to `set USERMODS_OPTIONS=XCMD`.

By default, on the Workspace server, this option is turned off. To turn the option on, perform the following steps:

1. Launch SAS Management Console. Log on as an administrator.
2. Expand the Server Manager in the left panel.
3. Expand SASITRM. Then expand SASITRM-Logical Workspace Server.

5. Select the **Options** tab and click **Advanced Options**.

6. Select the **Launch Properties** tab to open the following dialog box.
7. Select the **Allow XCMD** check box.

8. Click **OK** to close all the open dialog boxes.

9. Stop and then restart your Object Spawner service.

**Windows Specifics**

To stop your Object Spawner service, select **Start** ⇒ **Programs** ⇒ **SAS** ⇒ **SAS Configuration** ⇒ `<configuration-name>` ⇒ **Object Spawner** ⇒ **Stop**. To restart your Object Spawner service, select **Start** ⇒ **Programs** ⇒ **SAS** ⇒ **SAS Configuration** ⇒ `<configuration-name>` ⇒ **Object Spawner** ⇒ **Stop**.

**UNIX Specifics**

To stop and then restart your Object Spawner service, from the command line, change directories to `SAS-config-dir/Lev1/SASMain/ObjectSpawner`. Stop the object spawner by issuing this command: `$ ./ObjectSpawner.sh stop`. When you receive a confirmation that the object spawner has stopped, start it again by issuing this command: `$ ./ObjectSpawner.sh start`. You should receive a confirmation that the object spawner has started.

**z/OS Specifics**

To stop and restart your Object Spawner service, stop and restart the z/OS started task associated with the Object Spawner. Follow the stop and restart procedures that are established at your site.

---

**Extracting Data By Using HP NNM Tools**

For versions of HP NNM that are earlier than HP NNMi 8.x, there are tools that produce a repository of SNMP data that can be processed the SAS IT Resource Management solution.

The two commands to produce the SNMP data are:

- `snmpCollect`, which gathers SNMP data into binary files
- `snmpColDump`, which reads the binary files and writes the data into ASCII files that can be processed by the SNMP staging transformation
The `snmpCollect` executable uses a file called `snmpCol.conf` to determine the metrics to collect and the devices from which to gather data.

You can create the `snmpCol.conf` file by using either of the following methods.

- Use the sample UNIX script (`snmpmkcf`) that SAS IT Resource Management provides. The sample script is located in the `sasmisc` folder. It reads the `snmphost` and the `snmpvars` files, which are also located in the `sasmisc` folder, and creates the `snmpCol.conf` file.
  - The `snmphost` file contains a list of the device names for which SNMP data is being gathered.
    - **Note:** The job will run successfully even if, in the Perl script, the alias of the host name contains a hyphen (-) or an underscore (_).
  - The `snmpvars` file contains a list of the SNMP metrics that are to be gathered from each device. By default, the values in this list are the metrics that are in the recommended staging tables.
    - **Note:** This method creates the `snmpCol.conf` file more quickly than using the NNM graphical user interface.

- Use the HP NNM graphical user interface to create `snmpCol.conf`. The user interface prompts you to select the metrics that you want to gather and the devices about which you want to gather data. Using your responses, it then creates the `snmpCol.conf` file.

When the `snmpCol.conf` file is created, you can run the `snmpCollect` command to gather data. You can run the collect as often as you choose. The command collects a set of files in the location that you specify. For each metric and interface, two files are generated:

- `metricName.interface-number`, that contains the raw data
- `metricName.interface-number!`, that contains the information about the metrics that are collected

Consider the following example. For the metric called `ifOctets` and for interface 3, the `ifOctets.3` and `ifOctets.3!` files are generated. The SNMP staging code runs the `snmpColDump` command against these files to get the raw data that is to be read and loaded into staged tables. In order to read the data, the `snmpColDump` executable requires both the file that contains the binary data and file that contains the information about the metrics that are collected.

**T I P** The binary data files continue to accumulate until they are deleted. For best results, these data files (whose names do not end with "!") should be moved to another location before staging. The `snmpCollect` command then creates a new set of binary files into which the data is to be collected. The files that contain the information about the metrics (whose names end with "!") should be copied (not moved) to the other location as well. In this way, the `snmpCollect` command can continue to use these metrics as it collects the raw data. The staging code can then read the files from the location to which they were moved or copied.

---

**Extracting Data By Using the Round-Robin Database Tool (RRDTOOL)**

The SNMP adapter can read data from a round-robin database that was created with `rrdtool`. 
Note: The round-robin database tool, rrtdtool, is a freeware package that is available for download from Tobias Oetiker. This software is widely used, often in conjunction with Tobias Oetiker's MRTG package, which is a real-time monitor of data.

The SNMP adapter reads only those round-robin databases that contain one round-robin database for each combination of the device, the network interface to which the device is connected, and the metric. The data can be gathered at any interval, and any metrics and devices can be gathered.

In order to produce the correct set of round-robin databases, SAS IT Resource Management provides a sample Perl script for data collection and storage in the round-robin database. This script, called snmpuprd.pl, is available in the `sasmisc` folder. The section at the top of the script enables you to specify modifications that control how the data is collected. The Perl script uses the snmphost and snmpvars files, which are located in the `sasmisc` folder, to determine which metrics to gather from your devices. It also uses the snmpwalk command to collect the snmp data. When you have the script set up correctly, you can use your operating system's scheduling facility to run the script at the appropriate interval.

Note: If the data is being collected by a tool other than the snmpuprd.pl script provided with SAS IT Resource Management, then it might be necessary to modify the staging code to handle the format differences. This code can be modified by one of the following methods:

- Edit the code from the staging job’s Code window. To do so, change the Code Generation Mode option at the top of the screen to All user written.
- Deploy the job. The deployed code can be modified from an external editor. The code to be modified begins with this comment line:

  ```
  /*---- Create script to read data from an RRD ----*/
  ```

Note: You can backload data from the rrtdtool. To so, specify the Number of days to load option in the Staging Parameters property tab of the SNMP staging transformation. (This option is available only if the chosen access command is RRDTool.)

### Notes about the SNMPWALK Command

The snmpwalk command is an executable that is available as part of the Net-SNMP package. This package is available as freeware that you can download from the Sourceforge.net website. The snmpwalk command provides an easy way to read SNMP data from specified devices.

The SNMP adapter uses snmpwalk in two places:

- Using rrtdtool: If you choose to store your rawdata using rrtdtool, the script that is provided with SAS IT Resource Management uses snmpwalk to gather the data to put in the round-robin database.
- Staging the data: The SNMP staging transformation provides the ability to collect the non-numeric data at staging time instead of at the normal regular intervals that the rest of the SNMP data is collected. This can be useful for character data that does not change frequently. If you want to collect character data and are using rrtdtool to gather your rawdata, then you must collect it at staging time, because rrtdtool does not store character data. If you are using HP NNM, you can set it up to gather the character data at regular intervals along with the rest of the data. Alternatively, you can choose to collect it at staging time.
If you want to use the snmpwalk method, go to the Staging Parameters tab of the SNMP transformation's property window. On the Use snmpwalk to gather character data option, select Yes. Then fill in values for the following options:

- **snmpwalk Executable**: This is the path and exe file that contains the snmpwalk command.
- **HostFile for snmpwalk**: This is the path and file that contains a list of the devices to poll for character data.
- **Community value for snmpwalk**: This option is usually "public." Check with your SNMP administrator to ascertain the correct value for your site.

If you choose to use snmpwalk, then a script is generated and executes when the staging code runs. This script executes the snmpwalk command in order to gather the SNMP data for specified character metrics and adds that data directly to the staged tables.

**Notes about the SSH Host Command**

The secure shell host command is an executable object that is available as part of the SNMP adapter’s functionality when data is only in a round-robin database. This command specifies the rsh or ssh version of the command and the name of the host for running the rrdtool command. The rrdtool command facilitates reading data from round-robin database files that are located on other hostnames. Entering the ssh version of the command triggers this ssh functionality. This is the format of the command: `ssh user@hostname`. It is entered in the rsh/ssh host command field on the Staging Parameters tab of the Properties dialog box for the SNMP staging transformation.

If you enter a value in the rsh/ssh host command field that begins with `ssh`, then SAS IT Resource Management assumes that this job is running on a UNIX environment. The Perl script is changed so that it uses the UNIX find command to get the list of round-robin database files from the other hostnames.

To enable this functionality, set up ssh authentication using the SSH key-gen file and copy the file that stores the key to the host where the rrdtool executable and raw data are located. After the SSH key-gen file is copied, make sure that you can access the target host that is issuing the ssh command from the source host. If you have alias names for your target host, make sure that you execute the ssh command manually from the source host with that alias. By doing this, the command generates the host/RSA key for that alias host name so that the expected warning or error message is avoided during execution of the SNMP staging job. The following message is an example of the warning or error message:

```
Host key verification failed
```

To use this ssh method, go to the Staging Parameters tab of the Properties dialog box for the SNMP staging transformation. Then fill in values for the following options:

- **Raw data input directory**: Enter the location of the raw data in the target host.
- **rsh/ssh host command**: Start this command with `SSH` (for example: `ssh user@hostname`).
- **Use snmpwalk to gather character data**: Select Yes to use snmpwalk. A script is generated and executes when the staging code runs. This script executes the snmpwalk command to gather the SNMP data for specified character metrics and adds that data directly to the staged tables.

The default value for this option is No.
Choose access command: Enter RRDTool.

rrdtool executable: Enter the rrdtool location of the target host machine.

Working with the ITMS_SNMP_DeviceType Lookup Table

In order to provide better reporting, the SNMP adapter provides a SAS data table that enables you to indicate the type of device for each of the devices for which you are gathering data. This table is located by default in the SASHELP library, and contains no data. To use this table to define your device types, perform the following steps from the SAS IT Resource Management client:

1. Locate, or create, the IT data mart that you want to use for staging SNMP data.
2. Locate the Administrative folder. Right-click the library within that folder. (The library is called Adminnnnn, where nnnn is a random number that was generated when the IT data mart was created.)
   Select View Libname.
3. Select the entire LIBNAME statement in the displayed box. Then right-click the LIBNAME statement and select Copy.
4. Launch an interactive session of SAS. Use the Paste function to paste the LIBNAME statement into an Editor window.
5. Submit the LIBNAME statement.
6. In the Explorer window, locate the SAS data table called Itms_snmp_devicetype by drilling down into the SASHELP library.
7. Use the Copy and Paste functions to copy this table to the Adminnnnn library.
8. Now you can edit the table that you copied to Adminnnnn library. To do so, use VIEWTABLE to add and update rows. (To access VIEWTABLE, double-click the table in the Explorer window.)
   The value in the Device column should be the name of the device, and deviceType is the type of device.
   • The name of the device should match the device for which SNMP is gathering data. Make sure that the device names use the same case.
   • DeviceType can be any character string that helps identify the device. For example, "Router," "Switch," or "Server" would be reasonable choices for device Type.

You can also update this table programmatically as long as the table has the device and deviceType columns.

Once this table is populated, when you run the staging code, the deviceType column in all the SNMP staging tables will have the correct value from the lookup table. If a device is not in the deviceType table, then deviceType is set to "Unknown."

If your devices are named using a convention (for example, the device type is always the first part of the name, like router_2123), you can create the deviceType value programmatically. To do so, change the expression for the deviceType column in the staged table metadata. By default, the expression for the deviceType column is:

```
put(device, ?? $deviceType.)
```

You can change this to a different expression. An example is:

```
upcase(scan(device, 1, "_"))
```
Or, you can use standard SAS DATA step code to create an expression. An example is:

```sas
if (device eq: "R") then
deviceType = "Router";
else if (device eq: "W") then
deviceType = "Switch";
else if (device eq: "S") then
deviceType = "Server";
else
deviceType = "Unknown";
```

---

**Working with Management Information Base (MIB) Definitions for SNMP Staged Tables**

The SAS macro `%rmmssnmp` enables the SNMP adapter to read Management Information Base (MIB) definitions and create the metadata for SAS IT Resource Management staged tables. This macro enables you to generate staged data from any MIBs that you have. The SAS macro is available in the SAS autocall macro library so that you can use it from any SAS session.

To use the macro, you must first create a job with an SNMP transformation in SAS IT Resource Management. To do so, perform the following steps:

1. In the SAS IT Resource Management client, navigate to the **IT Data Marts** tree.
2. Navigate to an existing IT data mart, or create a new one. (To create a new IT data mart, from the menu bar, select **New** ➔ **IT Resource Management** ➔ **IT Data Mart**. The IT Data Mart wizard opens and prompts you to enter information to specify your new IT data mart.)
3. Create a folder in the IT data mart for your new job and tables.
4. In the new folder, create a new job. (To create a new job, select **New** ➔ **Job**. Then enter the information to specify your new job.)
5. In the process flow diagram, drag the SNMP transformation from the **ITRM Transformations** folder of the **Transformations** tree and drop it onto the job.
6. Save and close the job.
7. Select the job in the tree and in the Basic Properties window, scroll to the **Metadata ID** property, and make a note of the value. This is the job ID that you need to run the macro in the next set of steps.

After the job is created, you can run the `%rmmssnmp` macro. To do so, perform the following steps:

1. Invoke an interactive SAS session.
2. Specify the parameters for the `%rmmssnmp` macro. For information, see “Introduction to the Macros in SAS IT Resource Management” on page 500.
3. Submit the macro call to read the MIB definitions. The macro can generate a report of the staged tables that would be created from this definition, or it can create the staged table metadata.
Web Log — Accessing Raw Data

Preparing Web Log Data for SAS IT Resource Management

SAS IT Resource Management can process the following types of Web Log files:

- Common Log Format (CLF) that can be produced by Microsoft and Apache Web Servers
- Extended Log Format (ELF)
- Microsoft IIS original format
- Oracle WebLogic

SAS IT Resource Management examines the file to determine which type it is, without the type having to be specified. However, some web logs are produced with different delimiters than the expected default. For example, Oracle WebLogic uses a format very similar to Extended Log Format. However, it uses a tab character instead of a space. This delimiter must be specified in the staging transformation properties or supplied as part of the Adapter Setup wizard prompts.

In addition, some web logs do not provide information about the machine that they were running on or what website they were associated with. For this reason, you can also specify the machine and sitename as parameters to the staging transformation or Adapter Setup wizard prompts. Web log files can be concatenated to form one input stream, but they must all have the same web log format.

Database Adapters: SAP ERP, HP Reporter, MS SCOM, and VMware

What Are the Database Adapters?

Several adapters extract raw data from databases. The following adapters are database adapters:

- SAP ERP
- HP Reporter
- MS SCOM
- VMware

Preparing a Database Adapter for Staging

SAP Adapter: The raw data for the SAP ERP adapter must be in SAS data sets. If rawdata does not exist, the SAPERP staging job for the SAPRSS staged table ends with this error message: “ERROR:RAWDATA.RSS data set does not exist.”

HP Reporter, MS SCOM, and VMware adapters: The data sources for the HP Reporter, MS SCOM, and VMware adapters add performance data to relational databases as follows:
For the HP Reporter adapter, the relational database can be one of the following:

- an ORACLE database on a UNIX or Windows operating system
- an SQL database
- a Microsoft Data Engine (MSDE) on a Windows operating system

For the MS SCOM adapter, the relational database must be a Microsoft SQL Server database.

For the VMware adapter, the relational database can be one of the following:

- an ORACLE or DB2 database on a UNIX or Windows operating system
- a Structured Query Language (SQL) database

If an ODBC server definition must be created that points to that database, see the “ODBC Sources” topic in the “Overview of Common Data Sources” chapter in the SAS Intelligence Platform: Data Administration Guide at http://support.sas.com/documentation/onlinedoc/intellplatform/index.html. Find the section that corresponds to the type of database that contains your data, and follow the instructions for that section.

These instructions include the steps required to perform the following tasks:

- define the ODBC driver on your system, if necessary
- register the database server
- create and register the database library that points to your database

If you want to establish connectivity to a SQL Server Database by using ODBC, follow the instructions for “Establishing Connectivity to an Oracle Database by Using ODBC.” (The descriptions of ODBC connections to Oracle and Microsoft Access databases can be helpful when you connect to similar data sources.)

When creating and registering the database library that points to your database, you are prompted to specify several fields, including the Database Schema Name. Use the following values for that field:

- VMware – schema=do
- MS SCOM – schema is left blank
- HP Reporter – schema is left blank

The data from one of these databases is input directly into the Adapter Setup wizard. You can set up the library that points to the database in SAS Management Console. After the library is defined, it can be specified as the raw data input to the appropriate staging transformation.

**Duplicate-Data Checking for Database Adapters**

The staging transformations for the SAP ERP, HP Reporter, MS SCOM, and VMware adapters do not provide a parameter for duplicate-data checking. Duplicate-data checking is always enabled for these adapters.

However, you might want to backload data for HP Reporter, MS SCOM, and VMware staged tables that are added to the PFD after the staging job has already run once. In that case, you must override the default action of subsetting the incoming data based on the duplicate-data control data sets. To do so, set the macro variables ITRM_LoadFromDate and ITRM_LoadToDate to valid start and end datetime values. Then, this datetime range will be used to subset the data from the database instead of the ranges in the duplicate data control data sets.
\%let ITRM_loadFromDate=14FEB2010:00:00:00;
\%let ITRM_loadToDate=15FEB2010:23:59:00;

*Note:* When these macro variables are used with the VMware adapter, you must specify the values for these macro variables in Coordinated Universal Time (UTC). (UTC time is the same as Greenwich Mean Time (GMT).)

**Accessing HP Reporter Data**

HP Reporter, formerly HP OpenView Reporter, captures enterprise systems management measurement data from Windows systems and many UNIX variants such as HP-UX, SunOS Solaris, IBM AIX, Tru 64 UNIX, and Linux.

For information about the performance areas that are collected by HP Reporter, see “HP Perf Agent and HP Reporter Adapters” on page 472.

If the HP Reporter raw data is in a Microsoft Access database and the SAS IT Resource Management server tier is on a 64-bit Windows machine, you need to set up a PC files library. To do so, perform the following steps:

1. Log on to SAS Management Console as an unrestricted user.
   
   To access SAS Management Console, from your Windows desktop, select **Start** ➔ **Programs** ➔ **SAS** ➔ **SAS Management Console**.

2. Navigate to the Data Library Manager.

3. Right-click **Libraries** and select **New Library** from the drop-down list. The New Library Wizard opens.

   As shown in the following display, select **Generic Library** from the list of Resource Templates.
4. On the next page of the wizard, enter the name of the new library. Use the **Browse** button to display the list of folders from which you can select the **Location** that you want to use for your library.
5. On the next page of the wizard, from the list of available servers select **SASITRM**.

At installation time, SAS IT Resource Management establishes a SAS Application Server named **SASITRM** that sets properties such as memory size options and formats for the exclusive use of the solution. Establishing **SASITRM** as the SAS Application Server ensures that the SAS IT Resource Management solution can be installed and operated with other SAS products and solutions, some of which might also establish SAS Application Servers.

*Note:* For information about SAS Application Servers, see *SAS® 9.3 Intelligence Platform: Application Server Administration Guide*.

6. On the next page, specify the fields as shown in the following display.
Display A2.6  Enter Information for the Libref

- In the **Libref** field, enter the name by which you want to refer to the new library.
- In the **Engine** field, enter `pcfiles`.
- In the **Option(s) to be appended** field, enter the specifications for the server, port, and path.

The following example shows how to enter these specifications.

```
server=server56.na.co.com  port=9621
path=D:\Public\ReporterDatabase29Feb2008.mdb;
```

*Note:* You do not need to specify a path in the **Path Specification** box. The path should be entered in the **Option(s) to be appended** field, as shown in the preceding code fragment.

7. Click **Next** and then **Finish** to create the new library.

**Accessing Raw Data for SAP ERP**

**How to Prepare SAP ERP Data for SAS IT Resource Management**

Enterprise Resource Planning (ERP) Software from SAP (formerly SAP R/3), via the SAS IT Management Adapter for SAP, collects SAP ERP and SAP Business Warehouse (BW) workload performance measurements. The SAS server that is used to run the batch ETL work for SAS IT Resource Management can also run the Remote Function Call (RFC) server. The SAP Advanced Business Application Programming (ABAP) code that is executed on the SAP system sends the requested data to the RFC server. The data is stored on that RFC server or on a disk drive that can be accessed on the network.
To enable this communications process, perform the tasks that are listed in the following topics.

**Install the Components of ITM Adapter for SAP ERP**

Part of the server installation includes transport files that must be moved to the SAP system and installed there. These files include the ABAP programs that enable the extraction of the performance data. For information about how to install these files, see the *SAS IT Management Adapter for SAP: User's Guide*.

The SAS server installation process also installs the sasrfc_server and sasrfc_serveru executable programs into the SAS tree at !sasroot\access\sasexe. One or both of these programs should be installed as Windows services in order to create the RFC server. The sasrfc_serveru executable is to be used when the SAP ERP system is running in Unicode.

The SAS client installation includes the itmadaptsapc component, which contains the itmadaptsap.spk file. When this file is imported into SAS Data Integration Studio, it contains all the sample jobs that are required to set up and extract the SAP performance data. The client installation also includes plug-ins for SAS Data Integration Studio and SAS Management Console.

**Establish Communications between SAS and SAP**

To establish communications between SAS and SAP, perform the following steps:

1. **Set up an RFC connection on the SAP system.**
   
The SAP administrator should use transaction SM59 to create an RFC Connection to enable communication to your RFC server. Select a TCP connection and enter a meaningful description. For ease of identification, select "Registered Server Program" with a program ID that matches the RFC name. If the SAP system is running in Unicode, ensure that the Unicode flag is set.

2. **Create a program variant on the SAP system.**
   
The SAP administrator should use transaction SA38 to create a variant for program /SAS/Z_SAS_READ and update the parameters that are passed to the ABAP programs.
   
   • To facilitate identification, name the program variant after the RFC server.
   
   • For the G_BUFMAX parameter, enter 100000.
   
   • For the G_DEST parameter, enter the RFC server name.

3. **Configure Windows services to create the RFC server.**
   
   To start the RFC server, use the following type of command: sasrfc_server -i2 -V <variant-name> -n "<name>,<description>" -p <port_number> where
   
   • *name* is a name that you can choose for the service.
   
   • *description* is a description that you can choose for the service. This description field displays as the name of the service when you display the list of services on the Services window. You can access services by selecting **Windows ⇄ Control Panel ⇄ Services.**
   
   • *port_number* is the port number that you have assigned. The default port number is 6999.
If the SAP system is running in Unicode, change the command so that it refers to the Unicode version instead:

sasrfc_serveru -i2 -V <variant-name> -n "<name>,<description>" -p <port_number>

If a mixture of Unicode and non-Unicode servers is running, install both services, but assign them to different ports.

4. Test the connectivity between your SAS session and the SAP system by using the RFC server that you started in step 3. Start SAS and submit the following code:

```
libname mysap r3 user=<sap_userid> password=<sap_password> client=800
   ashost=<sap_application_server_hostname> sysnr=<sap_system_number>
   host=<rfc_server_host> port=<port_number> batch=Y;
data work.t000;
set mysap.t000;
run;
libname mysap clear;
```

where

- `sap_userid` and `sap_password` are the user ID and password, respectively, that are associated with the SAP system.
- `sap_application_server_hostname` is the host name of the SAP system.
- `sap_system_number` is the system number of the SAP system.
- `rfc_server_host` is the host name of the server that is running the RFC service.

Note: This value is typically `localhost`.

- `port_number` is the assigned port number to be used.

**Create SAS Metadata Objects Using SAS Management Console**

To create SAS metadata server objects that represent SAP systems, authentication domains, and data libraries, perform the following steps:

1. Invoke SAS Management Console.
2. From the File menu, select Connection Profile. Then connect to the profile that is being used for SAS IT Resource Management. In the Repository field, select Foundation.
3. Add an SAP authentication domain for the user ID that you want to be used to access the SAP system. To do this, open the User Manager, right-click the user ID and select Properties. On the Accounts tab, click New to add a new domain for SAP authentication. If you have multiple SAP systems with different user IDs or passwords, add one authentication domain per unique user ID and password pair.
4. Define new SAP servers, one for each SAP system. To do this task, perform the following steps:
   a. Right-click the Server Manager.
   b. Select New Server to invoke the New Server wizard.
   c. From the list of Resource Templates, select SAP Server.
   d. On the next page, enter a name for the server and a description. The description is optional.
   e. On the page that displays server properties, accept the default values.
f. On the page that displays connection properties, enter the requested information in the following fields:

- **Authentication Domain**: select the appropriate authentication domain that was specified in step 3.
- **Client**: enter the appropriate client. (This value is typically 800.)
- **Language**: enter the appropriate language. (This value is typically EN.)

g. In the Select Connection Type part of the page, click the Application Server radio button, and select Options. The Application Server Options dialog box appears.

h. In the Application Server Host field, enter the name of the SAP application server host.

i. In the System Number field, enter the system number. Click OK.

j. Select Advanced Options. In the Advance Options dialog box, select RFC Server Batch Mode. Then click OK. Click Next to display the information that you specified for this server.

*Note:* Repeat step 4 in this task for each SAP system. If you have different pairs of user IDs and passwords for the SAP systems, repeat step 3 to ensure that you are using the correct authentication domain for each system.

5. Define new SAP libraries that represent the newly defined SAP servers. To do this task, perform the following steps:

a. In SAS Management Console, expand the entry for the Data Library Manager.

b. Right-click Libraries.

c. Select New Library to invoke the New Library Wizard.

d. Select SAP Library and click Next.

e. Enter the name and a description for the new library. The description is optional.

f. On the Select SAS Server page, select the SAS application server where this library is to be assigned. (This server is typically SASITRM).

g. On the next page, enter a unique libref and click Next.

h. On the next page, select a database server.

(If you want to define a new server, click New and follow the instructions in step 4.)

Click Next to display the specifications for your library.

i. Click Finish.

6. Create two Base SAS Engine libraries to hold the extracted raw data and other administrative data. To create the libraries, perform the following steps:

a. In SAS Management Console, expand the Data Library Manager node.

b. Right-click Libraries.

c. Select New Library to invoke the New Library Wizard.

d. Select SAS Base Library.

e. Enter the name and a description for the new library. The description is optional.

f. On the Select SAS Server page, select the SAS application server where this library is to be assigned. (The server that is typically assigned is SASITRM.)
How to Configure Sample Data Extraction Jobs Using SAS Data Integration Studio

To configure sample jobs that extract the SAP ERP data, perform the following steps:

2. Select File ➔ Import ➔ Metadata to invoke the Import Metadata Wizard. (You might be prompted to enter the location of your SAS License file.) When prompted by the wizard, enter the following information:
   - Enter the name of the SAS package file to be imported: itmadaptsap.spk.
   - Enter the location where the SAS package was installed: c:\program files \SAS\SASITMAdapterSAP\3.3\ETLComponentsPackage. (This location is the default location for the installation of the SAS package file.)
   - Clear the Include access controls check box.
   - Select the option to import All Objects.
   - Select the SAS Application Server where this library is to be assigned. (The server that is typically assigned is SASMain.)
   - In the Library field, enter the SAP library that was defined in the previous step.
   - In the fields for the physical locations of the administrative data and the raw data, enter the locations that were created in step 6 of the task called “Create SAS Metadata Objects Using SAS Management Console.”
   - Select Finish to create a folder called ITM Adapter 3.1 for SAP.
3. Each sample job is used to achieve a particular step. Samples are provided for scenarios with single SAP servers and multiple SAP servers, so be sure to select the appropriate sample for your environment. Copy and paste only the sample jobs that you need. These sample jobs were installed into the Jobs folder in the IT data mart that is designated for the SAP adapter when the Metadata Import Wizard ran in step 2.

   Note: The following two SAS options should be added to the SAS config file or to the individual adapter batch jobs when they are executed on a z/OS workspace server:

   options nocardimage;   options linesize= 300 ;

   The following scenario describes the jobs that handle multiple SAP servers:
   - Use 0010B Step 1 Select SAP Servers to identify multiple SAP servers from which you want to extract performance data. Using the Custom View, locate the Shared Data folder in the Foundation repository. Then, locate the SAP Server Library that you defined in SAS Management Console. Drag that library onto the drop zone labeled "Place library here" in the Diagram tab of the Job Editor window. Repeat for as many libraries as you defined.
   - Use the job named 0020 Step 2 Suggest Destinations for Selected SAP Servers to extract host information from those SAP servers.
Use the job named **0030 Step 3 Create Final List of Servers and Destinations** to check for duplicate servers and release compatibility.

Use the job named **0040 Step 4 Create Mapping for SAP Program types** to create a mapping table of SAP programs to applications.

Use the job named **0110A Extract Default SAP Performance Data** to actually extract the SAP performance data.

*Note:* This job is the only one that you should have to deploy or schedule. It extracts the SAP ERP performance data and stores it in the rawdata SAS library. Make sure it is run on a regular basis, often enough to ensure that you lose no performance data. (Some sites run it as frequently as every hour.) This job writes to the rawdata library, appending data each time it is run, so that no data is overwritten.

4. The rawdata library must be specified as the input rawdata library to the SAP ERP staging transformation. The ETL job that this transformation generates reads the rawdata library into the IT data mart. However, it does not clear the contents of the rawdata library.

Recommendation: Automate a backup job that copies the rawdata library to an archive location and then empty the rawdata library before the execution of the next extraction job.

*Note:* For more detailed information about these tasks, see the *SAS IT Management Adapter for SAP: User’s Guide*.

For information about the performance areas that are collected by SAP ERP, see “SAPR3 Adapter - Systems, Machines, Tasks, and Transactions” on page 474 and “SAPR3 Adapter - SAPBTCH (Batch Job) and SAPWKLD (Workload)” on page 475.

### VMware vCenter Data

#### VMware Data Collection Level

VMware enables you to control the amount of data that is gathered and the counters that are available by means of the data collection level (also known as the statistics levels). This level is set in the vSphere client and can be a value between 1 and 4. The SAS IT Resource Management adapter for VMware vCenter is designed to process the data collected using a data collection level of 3. (The adapter also operates as expected with a collection level of 4.)

**CAUTION:**

Data collection level should not be set to a value less than 3. If the data collection level is less than 3, then some of the values in the supplied SAS IT Resource Management data model will be missing.

#### Loading Tasks and Events Data for VMware

**How to Limit the Data in the Events and Tasks Staged Table**

**Tip** Users should take care when staging the VMware Tasks and Events tables due to the potentially huge amount of data that exists in the input database for these tables.

The table in the vCenter database that contains data for the Events staged table contains a record for each event that is the result of a task or alarm in vCenter. The table in the vCenter database that contains data for the Tasks staged table contains a record for each
task (power on or off of a virtual machine, alarm created, and so on) that occurs in vCenter. To limit the potential for large amounts of data for these two tables, you can do either one of the following precautions:

- Define a datetime range for which data should be loaded for each of these staged tables.
- Specify the last number of days for which data should be loaded for each of these tables.

**Limiting the VMware Data in the Events Table**

If the Events staged table is added to a VMware vCenter staging job, do one of the following two procedures:

- To define a datetime range for which data should be loaded for each of these staged tables, edit the generated code for the staging job by adding the following code:

```plaintext
%let ITRM_LoadEventsFromDate = <start-datetime>;
%let ITRM_LoadEventsToDate = <end-datetime>;
```

For example,

```plaintext
%let ITRM_LoadEventsFromDate = 12APR2010:00:00;
%let ITRM_LoadEventsToDate = 13APR2010:00:00;
```

By setting these two macro variables to a valid datetime range, the staging job would load data for the Events table that falls within the specified range.

- You can specify the last number of days for which data should be loaded for each of these tables. To do so, edit the generated code for the staging job by adding the following code:

```plaintext
%let ITRM_LoadEventsForDays = <number-of-days>;
```

For example,

```plaintext
%let ITRM_LoadEventsForDays = 3;
```

By setting this macro variable to a valid positive integer, the staging job loads data for the Events table for the last number of days that you specified. In the preceding example, the staging job populates the Events staged table with data for the past three days.

*Note:* Specify the values for these macro variables in Coordinated Universal Time (UTC). (UTC time is the same as Greenwich Mean Time (GMT).)

**Limiting the VMware Data in the Tasks Table**

If the Tasks staged table is added to a VMware vCenter staging job, do one of the two following procedures:

- To define a datetime range for which data should be loaded for each of these staged tables, edit the generated code for the staging job by adding the following code:

```plaintext
%let ITRM_LoadTasksFromDate = <start-datetime>;
%let ITRM_LoadTasksToDate = <end-datetime>;
```

For example,

```plaintext
%let ITRM_LoadTasksFromDate = 12APR2010:00:00;
%let ITRM_LoadTasksToDate = 13APR2010:00:00;
```
By setting these two macro variables to a valid datetime range, the staging job would load data for the Tasks table that falls within the specified range.

- You can specify the last number of days for which data should be loaded for each of these tables. To do so, edit the generated code for the staging job by adding the following code:

```sas
%let ITRM_LoadTasksForDays = <number-of-days>;
```

For example,

```sas
%let ITRM_LoadTasksForDays = 3;
```

By setting this macro variable to a valid positive integer, the staging job loads data for the Tasks table for the last number of days that you specify. In the preceding example, the staging job populates the Tasks staged table with data for the past three days.

*Note:* Specify the values for these macro variables in Coordinated Universal Time (UTC). (UTC time is the same as Greenwich Mean Time (GMT).)

---

**Working with the VMware Lookup Table**

### How to Set Up the VMware Lookup Table

The VMware adapter includes a SAS data table that enables you to provide memory specifications for the hosts in your environment. This table is located by default in the SASHELP library and contains no data. If you want to use this table to provide memory information, perform the following steps:

1. Locate, or create, the IT data mart that you want to use for staging VMware data.

2. Locate the Administrative folder. Right-click the library within that folder. (The library is called Admin nnnnn, where nnnnn is a random number that was generated when the IT data mart was created.)

   Select View Libname.

3. Select the entire LIBNAME statement in the displayed box. Then right-click the LIBNAME statement and select Copy.

4. Launch an interactive session of SAS. Use the Paste function to paste the LIBNAME statement into an Editor window.

5. Submit the LIBNAME statement.

6. In the Explorer window, locate the SAS data table called ITMS_VMware_HostMemory by drilling down into the SASHELP library.

7. Use the Copy and Paste functions to copy this table to the Admin nnnnn library.

8. Now you can edit the table that you copied to the Admin nnnnn library. To do so, use VIEWTABLE to add and update rows. (To access VIEWTABLE, double-click the table in the Explorer window.)

The ITMS_VMware_HostMemory lookup table has the following six columns:

- **Cluster**
  the name of the cluster.

- **Host**
  the name of the host.
- **EsxHostTotalRam**
  the total amount of physical RAM in the ESX host machine that is seen by VMware ESX.

- **EsxHostSystemRam**
  the total amount of RAM that is allocated to the VMkernel. This amount does not include virtualization overhead. This amount is the fixed amount of RAM that is available based on the host's total RAM.

- **EsxHostVirtualMachinesRam**
  the amount of physical memory that is available for virtualization. This value is calculated by subtracting the Service Console memory (if applicable) and the System Memory from the total amount of RAM in the host.

- **EsxHostServiceConsoleRam**
  the total amount of RAM that is configured for the Service Console (if applicable).

The value in the cluster column should be the name of the cluster. The value in the host column should be the name (or the IP address if your site references hosts by address only) of the host for this observation. (Case matters. The names in the Host column should match the names in vCenter up to the first period. For example, Machine.abcdefg.company.com should be listed as Machine.) You can also update this table programmatically if it has the correct columns, as described previously.

When this table is populated and you run the staging code, the columns `EsxHostTotalRam`, `EsxHostSystemRam`, `EsxHostVirtualMachinesRam`, and `EsxHostServiceConsoleRam` in the HostSystem staged table will have with the correct values from the lookup table. If values for the memory metrics are not provided for a cluster and host, then those variables are set to missing values for that cluster and host. If the lookup table does not exist in the ADMIN library or is empty, then all values for the four mentioned memory variables are set to missing.

*Note:* If the lookup table does not exist in the ADMIN library or is empty, the HA and DRS supplied reports that depend on the `EsxHostTotalRam`, `EsxHostSystemRam`, `EsxHostVirtualMachinesRam`, and `EsxHostServiceConsoleRam` metrics will not provide useful reports.

**How to Populate the VMware Lookup Table**
The Virtual Center (vSphere Client) contains information that can be used to load the VMware lookup table. To populate the VMware lookup table, perform the following steps:

1. Log on to the VMware vSphere Client.
2. In the menu bar, select **Inventory ⇒ Host & Clusters.** The name of each cluster is displayed in the left panel next to the symbol 
3. For each cluster that is listed, perform steps 4 and 5.
4. Click the + to expand the contents of the cluster. All the hosts that are associated with that cluster are listed.
5. For each host that is listed, perform the following steps:
   a. Click the name of the host. The page containing the host details opens in the right pane. In the right pane, click the **Configuration** tab.
b. In the **Hardware** section, click **Memory**. The four memory values are displayed. Enter the four values for the appropriate host in the VMware lookup table as follows:

- Copy and paste the **Total** value into the **EsxHostTotalRam** column.
- Copy and paste the **System** value into the **EsxHostSystemRam** column.
- Copy and paste the **Virtual Machines** value into the **EsxHostVirtualMachinesRam** column.
- Copy and paste the **Service Console** value into the **EsxHostServiceConsoleRam** column.

**Note:** *EsxHostServiceConsoleRam* is applicable only to VMware versions prior to vSphere 5.1, which was when the ESXi architecture was released.

---

**Working with Custom Tables**

**IBM SMF Custom Tables**

SAS IT Resource Management provides support for more than 1,100 tables in the IBM SMF adapter. However, it does not support every table that MXG can produce from IBM SMF data. For those instances, you can extend the functionality of the IBM SMF staging transformation to load data into user-defined tables for which SAS IT Resource Management does not provide a template. These are called IBM SMF custom tables.

To create an IBM SMF custom table, you must create (or register) metadata about the physical MXG data set or table. You can use the New Table wizard to do so. The physical table must exist first and it must contain a column (variable) called **DATETIME** to enable it to be added to a user-defined table. If the default definition for the MXG data set does not contain **DATETIME**, it can be added simply by using MXG exits. This process is documented in the first step of the following task. Once the MXG data set is registered, it can be added as an output table to the IBM SMF staging transformation. It can also subsequently be used as input to an Aggregation transformation.

**How to Load IBM SMF Data into User-Defined Tables**

To load IBM SMF data into user-defined tables for which SAS IT Resource Management does not provide a template, perform the following steps:
1. If your MXG data set (with the DATETIME variable present) already exists as a physical table, skip this first step. Otherwise, create it now using regular MXG coding techniques. If the MXG data set does not have a DATETIME variable defined for it, you must identify the variable that contains the datetime stamp for each event or interval that the data represents. Then, modify the EX exit member that contains the OUTPUT statement for that table to also contain an assignment statement of the form:

```plaintext
DATETIME=mxg_variable;
```

You must also add the DATETIME variable to the output data set's keep list. To do so, add it to the `_Kddddd`. For example:

```plaintext
%MACRO _KTY1415 DATETIME
%
```

The preceding example adds the DATETIME variable to the keep list for the TYPE1415 table. Look up the correct names for the EX member and the `_Kddddd` macro for your data source in the MXG documentation.

2. Because you do not want the SAS IT Resource Management staging transformation to write to this copy of the MXG data set, make a copy of the physical MXG data set. You can put the copy in any writable library, such as the Staged library of your IT data mart.

3. Modify the MXG_PROPS_SMF format that maps the name of the tables to the MXG code that has to be executed. Locate the source for this format in your SASHELP.ITRM.FORMATS catalog. In the format, the value to be formatted is the MXG data set name, and the resulting label is a string of MXG code members and macro names. Add a new line to the format containing your MXG data set name and the name of the MXG code and macros using what is there as a template. Make sure that the text strings start in the same columns. When you execute PROC FORMAT, revise the LIBRARY= parameter in the PROC statement to ensure that the output catalog in the PROC FORMAT statement is pointing to ADMIN.ITRM. This revision of the LIBRARY= parameter creates the format in your ADMIN library that precedes the SASHELP.ITRM.FORMATS in your FMTSEARCH SAS option. Therefore, this format will be used instead of the one supplied at installation time.

The task of allocating the ADMIN library requires you to have Update access to it. The allocation can be achieved only when no other SAS IT Resource Management ETL jobs are running against this IT data mart. You must execute the following statement in a SAS session:

```plaintext
libname admin "path_of_ADMIN_library";
```

where "path_of_ADMIN_library" can be found in your SAS IT Resource Management or SAS logs, or by querying the ADMIN library of your IT data mart within SAS IT Resource Management.

4. Start SAS Data Integration Studio and use the Register Tables wizard from the File menu to register your MXG data set as a user-defined table.

To register your MXG data set as a user-defined table, perform the following steps:

a. On the first page of the Register Tables wizard, select SAS as the source type.

b. In the Library field, select the library that contains your MXG data set. If you copied your MXG data set to a library that has already been defined in metadata, select the appropriate library from the SAS Library list. If you copied it to a library that has not yet been defined in metadata, and the library is not in the list, then you must define a new SAS Library in metadata now by selecting New.
c. On the following screen, select the MXG data sets that you want to import metadata from.

d. Choose a folder to store the metadata. Select the Other Tables folder in the appropriate IT data mart. It should be the same IT data mart that contains the job to which you want to add this table.

e. Select Finish on the confirmation screen to import the metadata. The MXG data sets should be listed within the Other Tables folder of your IT data mart in the SAS Data Integration Studio Custom tab.

   Note: The table has a slightly different icon associated with it because it is not backed by a SAS IT Resource Management staged table template.

5. Add the new user-defined table as an extra output of the IBM SMF staging transformation in your existing jobs. To do so, perform the following steps:

   a. Double-click the appropriate job. It appears on the Diagram tab of the Job Editor window.

   b. In the Transformations tree of SAS IT Resource Management, expand the ITRM Transformations folder and locate the IBM SMF staging transformation. Drop that staging transformation onto the Job Editor window. The staging transformation appears in the process flow diagram for the job.

   c. Right-click the IBM SMF staging transformation and select Add output.

   d. Drag the new user-defined table from the Custom tab to the drop zone that now appears on the process flow diagram.

   e. Save the job.

6. Run the job or deploy it for subsequent batch execution, as you would any other SAS IT Resource Management job.

---

**Working with MXG Code to Stage Data**

**About MXG Adapters**

Raw data sources that are supported through MXG, such as z/OS data sources, might require that you customize some of the MXG code. These changes might be required in order to stage the data appropriately for the MXG adapters that SAS IT Resource Management provides.

SAS IT Resource Management uses the following environment variables to locate the MXG sourclib and format data sets:

- **MXGSRC** = Location of the MXG sourclib library
- **MXGFMT** = Location of the MXG format library

On z/OS, these configuration settings are specified in the COMMON member of the `<hlq>CONFIG PDS`, using the SET SAS System option. To override the physical locations to which these environment variables refer, you must manually add one the following options to the SITE member of your *high-level-qualifier*.CONFIG data set:

```plaintext
SET='MXGSRC (<custom> <sourclib>)'
SET='MXGFMT <formatlib>'
```
In the preceding code fragments, the following definitions apply:

- **custom**
  - is the path to your MXG custom source library. It is referred to as MXGUSER.SRCLIB.

- **sourclib**
  - is the path to your MXG source library. It is referred to as MXG.SRCLIB.

- **formatlib**
  - is the path to your MXG format library. It is referred to as MXG.FMTLIB.

For information about configuration files or the SET SAS System option, see the Operating Environment Specific Information (that is, the Companion) for your SAS installation at http://support.sas.com/documentation/onlinedoc/base/index.html.

SAS IT Resource Management supports the following MXG adapters:

- IBM DCOLLECT
- IBM EREP
- BMC Mainview IMS
- DT Perf Sentry with MXG
- IBM SMF
- ASG TMON2CIC
- ASG TMONDB2
- IBM TPF
- IBM VMMON

**MXG Views**

MXG views are SQL views that are created automatically by the staging transformations for MXG adapters.

MXG views are also created by the Aggregation transformation for simple aggregations that are based on staged tables from the same adapters in the preceding list. One MXG view is created for each of these staged tables and simple aggregation tables. The MXG views are stored in the same SAS library in which their dependent SAS tables are stored.

Each MXG view shows a SAS IT Resource Management table and the variables for that table in a structure that is equivalent to an MXG data set. Thus, these views enable experienced MXG programmers to use SAS IT Resource Management tables in MXG reporting jobs as if the tables had been created by MXG.

For example, the staged table STAGE.XTY70 is accompanied by an MXG view called STAGE.TYPE70. Moreover, if a simple aggregation is built from a staged table, then an MXG view called SIMPLE.TYPE70 is created for the SIMPLE.XTY70 table.

**IMACWORK and RMFINTRV Customizations Relevant to the RMF Domain Category of the SMF Adapter**

The IMACWORK and RMFINTRV members define the service classes (for those running in goal mode) or performance groups (for those not running in goal mode) that make up the workloads at your site. As with all MXG customizations, copy the member...
that you want to modify from MXG.SRCLIB to MXGUSER.SRCLIB. Edit these copies according to the instructions or comments therein. Both members contain important notes about the mixing of service classes with reporting classes (in goal mode) and control performance groups with report performance groups (not in goal mode). A good job of customizing these members ensures useful information in the XRMFWKL, XRMFWKP, and XRMFININT tables.

Notice that the RMFINTRV member permits the specification of more workloads than the IMACWORK member permits by itself. Depending on your requirements, you could edit just one, or both, of these members.

If you want to simultaneously process SMF data from multiple machines and if these machines have defined different RMF intervals, then you must also review the setting of the INTERVAL= macro parameter of the %VMXGRMFI macro in the RMFINTRV member. The value that you choose for this parameter must be an interval into which all RMF intervals that are being processed divide evenly, without a remainder. For example, if the RMF intervals of two machines are 10 minutes and 15 minutes, use INTERVAL=HALFHOUR. Review the comments in the RMFINTRV member for all possible values for INTERVAL=. Even if you choose to process the data from different machines in different executions of the same staging job, subsequent analysis of the data is more effective if both sets of the data are processed with the same value for the INTERVAL= parameter.

**IMACSHFT Customizations Relevant to All Domain Categories of the SMF Adapter**

The IMACSHFT member is used to define your shift patterns. However, the SHIFT variable in the IT Resource Management staged tables is populated from a formula that is supplied with IT Resource Management, and is not propagated from MXG. The IT Resource Management shift formula’s definition can be changed to any valid SAS expression, or set of DATASTEP statements.

**Customizations Relevant to the Jobs Domain Category of the SMF Adapter**

**IMACSPIN Customizations**

The IMACSPIN member is used to specify the number of days for which incomplete jobs are retained in SPIN data sets. They are retained until either the jobs become complete or the time specified in the IMACSPIN member elapses. The default value is zero.

For information, see the comments in the IMACSPIN member.

**IMACINTV Customizations**

To enable the collection of SMF interval data, you must first ensure that your system is configured to generate the SMF interval accounting records. Work with your systems programming team to determine the changes that might be required in MVS system data set, SYS1.PARMLIB(SMFPRMxx).

When that change is made, you must also modify the IMACINTV MXG member. The default is set so that no TYPE30_V (SMF interval accounting) records are written to SAS data sets. You must copy IMACINTV from MXG.SRCLIB to MXGUSER.SRCLIB and remove the comments from around the OUTPUT statement, as described in the comments in the member.
Customizations Relevant to the CICS and DB2 Domain Categories of the SMF Adapter

**IMACEXCL and UTILEXCL Customizations**

The IMACEXCL member contains the original methods by which modifications to the CICS SMF type 110 record were supported in the MXG code that read them. These original methods have been superseded by the UTILEXCL member. The UTILEXCL member is the preferred method to dynamically create a new IMACEXCL member that is customized to support the actual SMF data being used at your site. The code is designed to run once, to generate the IMACEXCL member. You must then store that member in MXGUSER.SRCLIB to enable the SMF records to be decoded correctly into the SAS data sets.

**ASUMCICX Customizations**

SAS IT Resource Management has added response time counters to the summarized CICS table that MXG generates by default. To implement this feature, copy the ASUMCICX member from the ITRM.CPMISC pds to your MXGUSER.SRCLIB. Failure to do this causes warning messages to be issued about missing variables.

*Note:* SAS IT Resource Management is adapted to include the new metrics that the ASUMCICX member creates. This MXG member is stored in the SAS IT Resource Management CPMISC PDS on z/OS, or the misc folder on UNIX, or the sasmisc folder on Windows. Before you use the ASUMCICX member, you must run the UTILEXCL MXG job. This job creates and implements the IMACEXCL member that is customized for your site. Documentation for ASUMCICX and UTILEXCL can be found inside each member.

**IMACUOW Customizations**

By default, no ASUMUOW observations (or records) are written to the SAS data set. To process unit-of-work data, you must modify the IMACUOW MXG member. Copy it to your MXGUSER.SRCLIB and comment out (or delete) the first definition of the two macros, _NOOBS and _YESOBS. Then remove the comment indicator from the second definition, so that the macros are defined as follows:

```plaintext
MACRO _NOOBS %
MACRO _YESOBS %
```

In addition, if you have MQ series data that you want to add to the CICS and DB2 unit-of-work process, modify the code as instructed in IMACUOW to remove the comment indicator from the following statement:

```plaintext
%LET MXGMQADD=YES;
```

**IMACUOWT Customizations**

By default, no ASUMUOWT observations (or records) are written to the SAS data set. To process unit-of-work data from ASG TMON for CICS and SMF DB2, you must modify the IMACUOWT MXG member. Copy it to your MXGUSER.SRCLIB and comment out (or delete) the first definition of the two macros, _NOOBS and _YESOBS. Then remove the comment indicator from the second definition, so that the macros are defined as follows:
MACRO _NOOBS  %
MACRO _YESOBS  %

Customizations Relevant to the Jobs Domain Category of the CA TMS Adapter

By default, there is no single DATETIME variable that represents the date and time of each observation. Copy members IMACTMS5 and EXTMSDSN to your MXGUSER.SRCLIB. In the IMACTMS5 member, add the variable DATETIME to both the _KTMSDSN and _KTMSTMS macros by using the following code:

MACRO _KTMSDSN DATETIME %
MACRO _KTMSTMS DATETIME %

In the EXTMSDSN member, insert the following line of code in front of the OUTPUT statement:

RETAIN DATETIME "&SYSDATE:&SYSTIME"DT;

Customizations Relevant to the ASG TMON2CIC Adapter

If you are processing compressed TMON CICS records, you must do the following:

1. Copy the member EXITMON6 to your MXGUSER.SRCLIB, and follow the instructions therein to assemble and install the MXG INFILE exit "TMON". This action permits both compressed and uncompressed records to be processed without intervention.

2. Copy the member IMACTMO2 to your MXGUSER.SRCLIB. Modify it to remove the comment from the three lines of code as described therein. This change causes the INFILE statement to use the TMON exit described in the preceding step. Alternatively, the same three lines of code could be specified in the IMACKEEP member instead.

Complete the following customizations in MXG in order to process data for TMON/CICS versions 8.0, 9.0, 1.0 and 1.1:

1. EXITMON6 - If you are using compressed TMON data, then modify and run EXITMON6 by following the instructions that are contained within EXITMON6.

2. IMACMONI - 1) Tailor IMACMONI by following the instructions within the member.

Complete the following customizations in MXG in order to process data for TMON/CICS ESA version 1.3 and later:

1. EXITMON6 - If you are using compressed TMON data, then modify and run EXITMON6 by following the instructions contained within EXITMON6.

2. IMACTMON - 1) Tailor IMACTMON by following the instructions within the member.

You can also complete the following customizations to process TMON2CIC data with MXG:
1. Run the job `<prefix>.BAMISC(TMONEXIT)` and put the module in `<prefix>.LIBRARY.

2. Update IMACKKEEP by following the instructions in the EXITMON6 member of MXG sourclib. Put the following statements in IMACKEEP:

   ```
   MACRO _TMDB;
   INFILE TMDBIN TMON STOPOVER LENGTH=LENGTH COL=COL END=END; 
   #
   ```

3. Run the staging job.

### Specify Spin Libraries for ASG TMON2CIC and IBM SMF

The ASG TMON2CIC and IBM SMF adapters require that you specify a spin library for spin data. The staging transformations for these adapters create and register a separate spin library. Any existing data is moved to the new spin library as part of the installation, update, or migration process.

For the ASG TMON2CIC and IBM SMF adapters, a spin library must be created. You can create this library on the **Spin Library** tab of the staging transformation properties. On this tab, you can specify various parameters of the spin library or accept the default values. The spin library is then created only after you open the **Spin Library** tab and select **OK**. (If you are using the Adapter Setup wizard to specify the ASG TMON2CIC and IBM SMF adapter, the wizard creates the spin library for you.)

To specify a spin library for ASG TMON2CIC or IBM SMF, perform the following steps:

1. From the Properties window of an ASG TMON2CIC or IBM SMF staging transformation, click the **Spin Library** tab.
2. Confirm that the **IT data mart** is correct for the current job. The value in this field cannot be changed.

3. Specify the **Name** and **Description** of the spin library. SAS IT Resource Management generates default values for these parameters that include a standard naming convention for the library name (**adapter name** + Spin + **unique number**). For best results, if you modify the library name, use a standard naming convention that implements unique, identifiable names for all spin libraries that you register. A name value is required and a description is optional.

4. Confirm the values for the **Server** and **Libref** fields for the IT data mart and spin library. The values in these fields cannot be changed.

5. Enter the value for the **Path Specification** field for the metadata path that stores the spin library. SAS IT Resource Management generates the default path **adapter name** + Spin + **unique number**. You can accept the default path, enter a new path, or click **Browse** to select a path. A value is required in this field.

   *Note:* **Browse** is disabled when the selected application server is running on a machine using the z/OS operating system. When entering a z/OS path manually, you can use either a prefix for a traditional z/OS filesystem path (**MY.DATAMART**) or a root directory in the UFS hierarchical file system (**/u/myname/datamart**).

6. If you are creating and registering libraries on z/OS, specify the following values:
   - file system device
   - the number of cylinders to use as the primary and secondary space allocation for the data set
• the number of volumes to use when allocating space
  A value is required for these parameters only if you are working with z/OS.
7. Click OK. The staging transformation creates the spin library as specified.

Limit IBM SMF Records

You might want to limit the IBM SMF records that are processed into an aggregation table to specific systems. To do so, you can use an aggregation filter. However, the disadvantage of using an aggregation filter is that the staging code is unnecessarily processing system data that will not be aggregated. In addition, this requires that a filter be set on each and every SMF aggregation. It is more efficient to filter data during the staging job processing.

To limit the IBM SMF records in order to process only specific systems in SAS IT Resource Management during a staging job process, add an IF statement in the IMACFILE MXG member. For example, to process only those records from a 'PROD' and 'TEST' system, perform the following steps:

1. Place a copy of the IMACFILE MXG SOURCLIB member into your user MXG SOURCLIB.
2. Modify the user IMACFILE MXG SOURCLIB member with the following SAS statement:

   IF SYSTEM IN ('PROD','TEST'); /*Only process records for these systems*/
   where the systems for which you want to process IBM SMF records are listed in the IN clause.

For more examples or information about coding the IF statement, see the documentation inside the IMACFILE MXG SOURCLIB member.

Note: IMACFILE is a specific exit point taken by all SMF records, immediately after the SMF header is read. This exit point can be used if you want to bypass the processing of a record based on the machine that produced it.

How MSU and MIPS Columns Are Included in Staged Tables for the SMF Adapter

Overview of the MIPS and MSU Automation Process

In SAS IT Resource Management 3.2 and later, additional columns are included. These columns enhance the reporting of resource utilization for various categories of SMF activity, such as systems, LPARs, workloads, workload periods, jobs, TSO and OMVS sessions, and more. The additional columns reflect MSU (millions of service units) and MIPS (millions of instructions per second) based on CPU time expended during the activity. These columns are distinct from other MSU-related columns that are already present in the SMF rawdata. The following topics explain how the population of these new resource utilization columns in several of the SMF performance-based adapters and tables were automated.
Calculation Dependencies for MIPS and MSU Columns

The calculation of MIPS and MSU columns for SMF staged tables depend on the following items:

- the creation of the MXG RMF interval data set. The following columns are extracted directly or derived from this data:
  - ID of the physical machine (MXG column SYSTEM)
  - ID of the physical CEC (MXG column CECSER)
  - CPU Model ID (MXG column CPCFNAME)
  - CPU Model Capacity Type (Full or Sub, value determined from CPCFNAME value)
  - Number of CPUs for the CPU model (MXG column NRCPUS)
  - Number of IFA specialty engines configured for use (MXG column NRIFAS)
  - Number of ZIP specialty engines configured for use (MXG column NRZIPS)
  - Total configured CPU engines. This column is the key merge column with the IBM Large System Performance Reference (LSPR) information.
    - If the CPU model is full capacity, this column is calculated as the sum of all configured standard, IFA, and ZIP engines.
    - If the CPU model is sub-capacity, the MXG column NRCPUS value is used.
  - Adjusted CPU Model ID:
    - If the CPU model is full capacity, the value of this column is determined by recalculating CPU engine specification to include the quantity of those IFA and ZIP engines that are also configured.
    - If the CPU model is sub-capacity, the MXG column CPCFNAME value is used.
  - Software service unit rate constant (MXG column CECSUSEC)
  - Hardware service unit rate constant (MXG column SU_SEC)
  - CPU Model MSU capacity (MXG column CPCMSU)
  - Minimum datetime present in the RMF interval data for the combination of the previously listed columns
  - Maximum datetime present in the RMF interval data for the combination of the previously listed columns
- the availability of Vendor-supplied LSPR Resource Chart from IBM, from which the following columns are extracted:
  - CPU Model ID (This column is labeled Processor in the Vendor-Supplied LSPR Resource Chart. It is a key column that is used for merging with RMF interval data.)
  - CPU model available CPUs (This column is labeled #CP in the resource chart.)
  - IBM Processor Capacity Index (Also known as MIPS, this column is labeled PCI in the Vendor-Supplied LSPR Resource Chart.)
  - CPU Model MSU capacity (Also known as MSU, this column is labeled MSU in the Vendor-Supplied LSPR Resource Chart.)
the normalization of all CPU times used in MSU and MIPS calculations. (Based on current information, these CPU times are normalized in MXG.)

As noted in the preceding list of required items, the new MSU and MIPS columns require that the MXG RMF Interval dataset be created. This table requires SMF record types 70, 71, 72, 75 and 78 to be present in the rawdata that is being processed. If these record types are not present, the RMF Interval dataset will be empty and the MIPS columns will be missing. For more information, see “New MSU and MIPS Fields in the XJOBS Table That Depend on RMF Data” on page 386.

The presence of these record types is especially important when staging the XJOBS table if you have a separate staging job for the XJOBS staged table. If the RMF data is not stored on the same rawdata file as the SMF records for jobs, concatenate the two SMF files together so that both job-related and RMF-related SMF records are available to the XJOBS staging job. It is not necessary to add the RMF Interval table, XRMFINT, to the XJOBS staging job.

**Working with LSPR Tables**

SAS IT Resource Management supplies an initial copy of a SAS data set that is called ITMS_SMF_LSPRDATA. The version of the LSPR table that forms the basis for the table that is shipped with SAS IT Resource Management 3.3 is z/OS V1 R11. It is dated July 2012.

This data set is stored in the SASHELP library and contains Large System Performance Reference (LSPR) information that is based on the IBM table for z/OS V1 R9. The data set also contains columns that enhance the reporting of resource utilization for various categories of System Management Facility (SMF) activity. Among these categories are systems, logical partitions (LPARs), workloads, workload periods, TSO and OMVS sessions, and jobs. The additional columns are distinct from other MSU-related columns that are already present in the SMF raw data. They reflect MSU and MIPS and are based on the CPU time expended during the activity. You can use the LSPR tables to prepare and initialize the MIPS and MSU columns.

SAS IT Resource Management can merge the LSPR information with staged Resource Management Facility (RMF) interval data. For information about this topic, see “Staging Methodology for MIPS and MSU Columns” on page 383.

**Note:** IBM might update this information with new processors or other information at a later date. IBM might also change the location of the LSPR table. Therefore, the LSPR information might need to be updated. If an update is needed, then one of the following two methods can be used to create an updated copy of the LSPR information.

**Initialization and Preparation of the MIPS and MSU Columns**

**Methods for Including MIPS and MSU Columns in Staging Tables**

The following methods update the IT Resource Management Admin library. Therefore, make sure that you have a backup copy of that library before you proceed.

To import MIPS and MSU columns for inclusion in your staging tables and to save them into a permanent SAS data set, perform one of the two following methods:

- **Method 1**, which is applicable to all operating systems
- **Method 2**, which is applicable to all operating systems except z/OS

The following method, Method 1, is applicable to all operating systems.
Be sure to specify **http** instead of **https** in the FILENAME statement.

Run the following code:

```sas
libname admin "<location-of-the-ADMIN-library>";

data work.lsprdata;
  infile lsprurl;
  retain found_toc found_thead found_th td_idx 0;
  retain CPCFMODL LSPRPCUS LSPRPCI LSPRMSU;
  length CPCFMODL $8;
  keep CPCFMODL LSPRPCUS LSPRPCI LSPRMSU;
  array td_array{3} LSPRPCUS LSPRPCI LSPRMSU;
  input @;
  if not found_toc and index(_infile_,'Table of contents') = 0 then return;
  found_toc=1;
  if index(_infile_,'<thead>') then found_thead=1;
  if index(_infile_,'</thead>') then found_thead=0;
  if not found_thead and index(_infile_,'<th ') then do;
    found_th = 1;
    CPCFMODL = scan(_infile_,2,'<>');
    end;
  else if not found_thead and found_th and index(_infile_,'<td ') then do;
    td_idx + 1;
    td_array{td_idx} = input(scan(_ infile_, 2, '<>'), comma10.);
    if td_idx = 3 then do;
      output;
      td_idx = 0;
      found_th = 0;
      end;
    end;
  end;
run;

proc sort data=work.lsprdata out=admin.itms_smf_lsprdata;
  by CPCFMODL;
run;
```

The following method, Method 2, is applicable to all operating systems except z/OS.

1. Create a Microsoft Excel spreadsheet that contains selected information from published (and currently available) IBM LSPR information. (You must reference the

Copy and paste a selected set of columns from the published LSPR data into a Windows Excel spreadsheet. The resulting workbook should look like the following table and reflect the information that is documented in the topic called “Calculation Dependencies for MIPS and MSU Columns” on page 378.

<table>
<thead>
<tr>
<th>Processor (CPU Model ID)</th>
<th>#CP (Number of CPUs Available per CPU Model)</th>
<th>PCI (IBM Processor Capacity Index)</th>
<th>MSU (CPU Model MSU Capacity)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2066-0E1</td>
<td>1</td>
<td>35</td>
<td>7</td>
</tr>
<tr>
<td>2066-0A1</td>
<td>1</td>
<td>71</td>
<td>13</td>
</tr>
<tr>
<td>2066-0B1</td>
<td>1</td>
<td>102</td>
<td>20</td>
</tr>
<tr>
<td>2066-0C1</td>
<td>1</td>
<td>126</td>
<td>25</td>
</tr>
<tr>
<td>2066-0X2</td>
<td>2</td>
<td>145</td>
<td>28</td>
</tr>
<tr>
<td>2066-001</td>
<td>1</td>
<td>170</td>
<td>32</td>
</tr>
</tbody>
</table>

2. Once created, the Microsoft Excel spreadsheet can be used as input in the following PROC IMPORT and DATA step code. This code creates a permanent SAS data set that resides in an IT Resource Management Admin library.

3. Run the following code:

```sas
/* Read the Microsoft Excel workbook that contains extracted information from IBM LSPR documentation and create a SAS data set from it. */
PROC IMPORT OUT=WORK.LSPRDATA
   DATAFILE=<"location-of-spreadsheet">;
   DBMS=EXCEL REPLACE;
   SHEET="Sheet1$";
   GETNAMES=NO;
   MIXED=NO;
   SCANTEXT=YES;
   USEDATE=YES;
   SCANTIME=YES;
RUN;

/* Extract selected fields of information from the vendor-supplied LSPR resource information. */
DATA WORK.LSPRDATA(keep=CPCFMODL LSPRPCUS LSPRPCI LSPRMSU);
   SET WORK.LSPRDATA;
   LENGTH CPCFMODL $ 16;
   IF _n_=1 THEN DELETE;
```
CPCFMODL=F1;
LSPRCFUS=F2;
LSPRPCI=F3;
LSPRMSU=F4;
run;

/* Store IBM LSPR resource information in SAS data set in IT Resource Management Admin library. */
LIBNAME ADMIN <'location-of-ITRM-Admin-library'>;
PROC SORT DATA=WORK.LSPRDATA out=ADMIN.ITMS_SMF_LSPRDATA;
   BY CPCFMODL;
RUN;

How to Retain the Original LSPR Table
Applying software maintenance or hot fixes might automatically update the LSPR table in SASHELP. If you backed up the SASHELP library from your original SAS IT Resource Management 3.3 installation, you can restore the default LSPR table information that was included in that library. To do so, perform the following steps:

Note: You need to have exclusive access to the SASHELP library before you restore the original LSPR table in the SASHELP library.

1. Make a backup copy of the SASHELP library.
2. Submit the following SAS code:

   /*Allocate the backup copy of the SASHELP library */
   /*that uses PROC COPY to copy only the LSPR table */
   /*with the SELECT statement. */
   /*Make sure you have exclusive update access to the */
   /*SASHELP SAS library before you submit code. */
   libname bkuphelp <physical-location-of-backup-sashelp>;
   proc copy in=bkuphelp out=SASHELP;
      select ITMS_SMF_LSPRDATA;
   run;

Sample JCL for z/OS sites:

   //jobname JOB
   //STEP1 EXEC SASPROC,OPTIONS=’SASHELP=SASHELP’
   //SASHELP DD DSN=’& prefix.11Wn.SASHELP’,DISP=OLD
   //SYSIN DD *
      libname bkuphelp <physical-location-of-backup-sashelp> ‘;
      proc copy in=bkuphelp out=SASHELP;
         select ITMS_SMF_LSPRDATA;
      run;
   /*Output contents of LSPR data information */
   PROC PRINT=SASHELP.ITMS_SMF_LSPRDATA;
   RUN;

Note:
• & prefix is the prefix specified at the time of your installation.
• 11 is the code for the language of your installation.
• Wn is the encoding for your installation.
Sample names for the configuration file and SASHELP libraries are here:

USERID.CONFIG(ENW0)
USERID.ENW0.SASHELP
USERID.D54002.ENW0.SASHELP

3. Review the output from the PRINT procedure to make sure that the SAS data set with the LSPR information has been updated.

**Staging Methodology for MIPS and MSU Columns**

The following steps describe the methodology that SAS IT Resource Management uses to stage RMF interval data.

1. After MXG stages the RMF interval data and before IT Resource Management begins its staging transformation processing, code is executed to extract the necessary columns from the RMF interval data (MXG data set RMFINTRV). This code captures the distinct resource utilization entries from the RMF interval data that has just been staged. Another code step also extracts the current contents of the existing Resource Utilization table.

2. Using the recently staged RMF interval data, code is executed to determine whether the available CPU models in the data are full capacity models or sub-capacity models. This model capacity information and a calculation of total available CPUs for the full capacity models are included with the rest of the RMF interval data extracted previously.

3. The existing Resource Utilization table is merged with the staged RMF interval data in preparation for merging with the IBM LSPR information.

4. The latest available LSPR information from IBM is read so that it can be included in the Resource utilization table. The latest available LSPR information is available from one of the following two sources:
   - an IT Resource Management supplied SAS data set in a SASHELP library
   - an updated copy in an IT Resource Management Admin library that was created by the customer. For information about this process, see “Working with LSPR Tables” on page 379.

5. The combined Resource Utilization table information (from the previous resource utilization table data and the new RMF interval data) and the extracted IBM LSPR resource information are merged together by the common column CPCFMODL. The merged result is the adjusted CPU model. This merge creates a new current copy of the Resource Utilization table, which replaces the existing copy. (The staging code created an empty Resource Utilization Table for this purpose.)

   If, as a result of this merge, a machine in your RMF data is not listed in your LSPR table, SAS IT Resource Management will halt the staging job and write the following ERROR message to the SAS log.

   ERROR: The SMF data for system is associated with a mainframe model
   ERROR: <number> which does not appear in your LSPR table.
   ERROR: To preserve the integrity of your data mart, this job will stop.

   - If the LSPR information and the subsequent calculations that are based on it are important to you, you should update your LSPR table as soon as possible. Do not attempt to rerun the staging job until the updated table has been implemented and
stored in your Admin library. For information about updating your LSPR table, see “Working with LSPR Tables” on page 379.

- If you are not interested in the LSPR information, you can bypass the error and continue processing the data. To do so, set the LSPR_ERROR_ON macro variable at the beginning of your staging job. The following code bypasses the error and enables processing to continue:

   ```
   %LET LSPR_ERROR_ON=N;
   ```

   This code sets all subsequent calculations that are based on the LSPR information to missing values. This results in other computed columns also having missing values. This situation is not statistically incorrect, but it can misrepresent MIPS and MSU usage in aggregations. The SAS log will contain notes about this instead of errors.

   **NOTE:** The SMF data for system is associated with a mainframe model `number` which does not appear in your LSPR table. **NOTE:** You coded LSPR_ERROR_ON=N to ignore this problem.

6. The newly updated Resource Utilization table data can be used to include various parts of this information in staging extracts so that resource utilization computed columns for MSU and MIPS can be calculated. Lookups can be done using System, CEC, or CPU Model columns present in the Resource Utilization table. The following table shows the type of columns and the corresponding information for those columns that is available in the Resource Utilization table.

   **Note:** The RMF CPU Resource Table consists of 17 columns and a variable number of rows. (In the following example, the table contains sample data for two rows.) In order to present all the columns that are available in the table in a legible format, the table was rotated 90 degrees. Each column was displayed as rows, and each row was displayed as columns.

   **Table A2.4**  
   **RMF CPU Resource Table: Column Names and Two Rows**

<table>
<thead>
<tr>
<th>Name of the Column in the Resource Utilization Table</th>
<th>Sample Values for First Row of the Table</th>
<th>Sample Values for Second Row of the Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>System ID</td>
<td>DEVA</td>
<td>POA2</td>
</tr>
<tr>
<td>Cec ID</td>
<td>B77A</td>
<td>3A7A</td>
</tr>
<tr>
<td>(from RMF)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU Model</td>
<td>2094-706</td>
<td>2066-0A2</td>
</tr>
<tr>
<td>(from RMF)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cpu Model Capacity Type (extrapolated from CPU Model ID from RMF)</td>
<td>Full</td>
<td>Sub</td>
</tr>
<tr>
<td>Standard CPU Engines (from RMF)</td>
<td>6</td>
<td>2</td>
</tr>
<tr>
<td>Name of the Column in the Resource Utilization Table</td>
<td>Sample Values for First Row of the Table</td>
<td>Sample Values for Second Row of the Table</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>------------------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>IFA CPU Engines (from RMF)</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>ZIP CPU Engines (from RMF)</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Total CPU Engines (calculated if full capacity model, else standard CPUs from RMF)</td>
<td>9</td>
<td>2</td>
</tr>
<tr>
<td>CPU Model extrapolated if full capacity model, else CPU model from RMF)</td>
<td>2094-709</td>
<td>2066-0A2</td>
</tr>
<tr>
<td>CPU Model CPUs (from LSPR)</td>
<td>9</td>
<td>2</td>
</tr>
<tr>
<td>CEC Su/Sec (CEC Service constant from RMF)</td>
<td>19536.019536</td>
<td>6165.7032755</td>
</tr>
<tr>
<td>Su/Sec (CPU Conversion constant from RMF)</td>
<td>25559.105431</td>
<td>6341.6567578</td>
</tr>
<tr>
<td>CPU Model MSU Capacity (from RMF)</td>
<td>422.00</td>
<td>44.00</td>
</tr>
<tr>
<td>CPU Model MSU Capacity (from LSPR)</td>
<td>584.00</td>
<td>44.00</td>
</tr>
<tr>
<td>IBM Processor Capacity Index (also known as MIPS from LSPR)</td>
<td>4,366.00</td>
<td>234.00</td>
</tr>
<tr>
<td>Minimum Datetime (from RMF)</td>
<td>01Mar08:00:00:00</td>
<td>01Mar08:00:00:00</td>
</tr>
<tr>
<td>Maximum Datetime (from RMF)</td>
<td>01Mar08:23:45:00</td>
<td>01Mar08:23:30:00</td>
</tr>
<tr>
<td>MSU/MIPS Conversion Factor (calculated)</td>
<td>7.48</td>
<td>5.32</td>
</tr>
</tbody>
</table>
New MSU and MIPS Fields in the XJOBS Table That Depend on RMF Data

In SAS IT Resource Management 3.2 and later, there are new MSU and MIPS columns in the XJOBS staging table. These columns require Resource Management Facility (RMF) interval data to be present in the input System Management Facility (SMF) file. If the SMF data does not contain the RMF 70, 71, 72, 75, and 78 type data records, the following XJOBS MIPS-related columns are set to missing:

- IFAMIPS
- IFAMSU
- MIPSFACT
- SYSMIPS
- SYSMSU
- TOTMIPS
- TOTMSU
- ZIPMIPS
- ZIPMSU

To ensure that these MIPS columns are calculated in the XJOBS table, process the RMF and XJOBS SMF data together in the same staging job. If the SMF records that populate XJOBS were separated from the ones that populate the RMF tables XRMFSYS, XRMFIN, XASM70L, XASMCEL, XRMFWKL, XRMFWKP, and XTY72GO, then concatenate the two files together. This enables the staging job to make the RMF data accessible for the MSU and MIPS fields in the XJOBS table. You do not have to add the RMF tables to the staging job for this technique to work correctly. For more information about these columns, see “Additional Notes about MIPS and MSU Calculations”.

Additional Notes about MIPS and MSU Calculations

The following notes pertain to the calculation of the MIPS and MSU columns.

- When dealing with a full capacity model, any additional specialty CPU engines, such as IFA and ZIP, that have been configured for your system must be included in the calculations. These specialty CPU engines are added to the Total CPU Engines and this new value is stored in the resource table under a column labeled Total CPU Engines (calculated if full capacity model, else standard CPUs from RMF).

The CPU Model ID value is adjusted to reflect the addition of any specialty engines. For example, suppose there are three additional specialty engines on a full capacity model (2094-706): two engines for IFA and one for ZIP. As a result, the CPU model value is adjusted from 2094-706 to 2094-709 to account for the three additional specialty engines. The latter model ID specification is used to match up to the IBM LSPR information to retrieve the relevant MSU and MIPS ratings. These ratings are then used to calculate the MSU/MIPS conversion factor. This refined methodology for the full capacity CPU model results in a different MsuMipsConversionFactor. The difference is due to using an adjusted CPU model and the LSPR MSU and MIPS ratings that are associated with this adjusted CPU model.

In our sample, without using an adjusted CPU model, the calculation of the MsuMipsConversionFactor is 7.32. Using an adjusted CPU model for the calculation, the MsuMipsConversionFactor is calculated to be 7.48. This results in...
higher MIPS amounts for CPU activity on the full capacity models that include additional specialty engines.

- The calculation of MIPS is done in two distinct ways, depending on the IT Resource Management table that is being staged.
  - For systems (IT Resource Management tables XRMFSYS and XRMFINT) and LPARs (IT Resource Management tables XASM70L and XASMCEL), MSU is calculated using the hardware-based active CPU times from the RMF type 70 records and the hardware service adjustment factor (SUSEC). MIPS are then calculated by multiplying the MSU result by the appropriate MsuMipsConversionFactor for the associated processor type.
  - For workloads and workload periods (IT Resource Management tables XRMFWKL, XRMFWKP, XTY72GO) and batch jobs, TSO sessions, and OMVS sessions (XJOBS), SAS IT Resource Management calculates MSU by using the application-based active CPU times from the RMF type 72 records and the software service adjustment factor (CECSUSEC). MIPS are then calculated by multiplying the MSU result by the appropriate MsuMipsConversionFactor for the associated processor type.

Note: For details about the specific calculations, see “MSU and MIPS Calculations”.

- If comparisons are performed between system and LPAR MIPS values that are based on RMF type70 hardware-based active CPU times and other MIPS values, such as workload, workload period, jobs, and so on, that are based on RMF type72 application-based active CPU times, the system- and LPAR-based MIPS will be larger. The reason that the times are different is because the uncaptured CPU time is not available in the type72 record. The difference in values is typically in the 5-15% range.

### MSU and MIPS Calculations

All calculations listed in the following table are calculated from normalized CPU times, as provided by MXG.

#### Table A2.5 Table of Calculations for MIPS and MSU Values

<table>
<thead>
<tr>
<th>Domain Category</th>
<th>Staged Table</th>
<th>Computed Column</th>
<th>Column Label</th>
<th>Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>XRMFSYS</td>
<td>SYMSU</td>
<td>SystemCpuMsuUsage</td>
<td>if CPACTTM &gt; 0 then SYMSU= CPACTTM * SUSEC / 1000000; else SYMSU=.;</td>
</tr>
<tr>
<td></td>
<td>XRMFINT</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System</td>
<td></td>
<td>SYSMIPS</td>
<td>SystemCpuMipsUsage</td>
<td>if MIPSFACT ^= . and CPACTTM &gt; 0 then SYSMIPS=(CPACTTM * SUSEC / 100000) * MIPSFACT; else SYSMIPS=.;</td>
</tr>
<tr>
<td>Domain Category</td>
<td>Staged Table</td>
<td>Computed Column</td>
<td>Column Label</td>
<td>Calculation</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------</td>
<td>-----------------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>IFAMSU</td>
<td>IfaCpuMsuUsage</td>
<td>if IFAACTT &gt; 0 then IFAMSU = IFAACTT * SUSEC / 1000000; else IFAMSU = ;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IFAMIPS</td>
<td>IfaCpuMipsUsage</td>
<td>if MIPSFACT ^= . and IFAACTT &gt; 0 then IFAMIPS = (IFAACTT * SUSEC / 1000000) * MIPSFACT; else IFAMIPS = ;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZIPMSU</td>
<td>ZipCpuMsuUsage</td>
<td>if ZIPACTT &gt; 0 then ZIPMSU = ZIPACTT * SUSEC / 1000000; else ZIPMSU = ;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZIPIPS</td>
<td>ZipCpuMipsUsage</td>
<td>if MIPSFACT ^= . and ZIPACTT &gt; 0 then ZIPIPS = (ZIPACTT * SUSEC / 1000000) * MIPSFACT; else ZIPIPS = ;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOTMSU</td>
<td>AllEngCpuMsuUsage</td>
<td>AllEngCpuMsuUsage if CPACTTM &gt; 0 or IFAACTT &gt; 0 or ZIPACTT &gt; 0 then TOTMSU = (sum(CPACTTM, IFAACTT, ZIPACTT) * SUSEC) / 1000000; else TOTMSU = ;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOTMIPS</td>
<td>AllEngCpuMipsUsage</td>
<td>if MIPSFACT ^= . then TOTMIPS = (sum(CPACTTM, IFAACTT, ZIPACTT) * SUSEC / 1000000) * MIPSFACT; else TOTMIPS = ;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSUCAP</td>
<td>SystemMsuCapacity</td>
<td>DURATION * NRCPUS * SUSEC / 1000000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Domain Category</td>
<td>Staged Table</td>
<td>Computed Column</td>
<td>Column Label</td>
<td>Calculation</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------</td>
<td>-----------------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>MIPSCAP</td>
<td>SystemMipsCapacity</td>
<td>if MIPSFACT ^= . then MIPSCAP=FLOOR( MIPSFACT * (DURATION * NRCPUS * SUSEC / 1000000)); else MIPSCAP=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lpar</td>
<td>XASM70L</td>
<td>LPRSYSMSU</td>
<td>LparCpMsuUsage</td>
<td>if LCPUPDT &gt; 0 then LPRSYSMSU= LCPUPDT * SUSEC / 1000000; else LPRSYSMSU=.;</td>
</tr>
<tr>
<td></td>
<td>XASMCEL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LPRSYSMIPS</td>
<td>LparCpMipsUsage</td>
<td>if MIPSFACT ^= . and LCPUPDT &gt; 0 then LPRSYSMIPS= ( LCPUPDT * SUSEC / 1000000) * MIPSFACT; else LPRSYSMIPS=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LPRIFAMSU</td>
<td>LparIfaMsuUsage</td>
<td>if IFAACTT &gt; 0 then LPRIFAMSU=IFA ACTT * SUSEC / 1000000; else LPRIFAMSU=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LPRIFAMIPS</td>
<td>LparIfaMipsUsage</td>
<td>if MIPSFACT ^= . and IFAACTT &gt; 0 then LPRIFAMIPS=(IFA ACTT* SUSEC / 1000000) * MIPSFACT; else LPRIFAMIPS=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LPRZIPMSU</td>
<td>LparZipMsuUsage</td>
<td>if ZIPACTT &gt; 0 then LPRZIPMSU=ZIPA CTT * SUSEC / 1000000; else LPRZIPMSU=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Domain Category</td>
<td>Staged Table</td>
<td>Computed Column</td>
<td>Column Label</td>
<td>Calculation</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------</td>
<td>-----------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LPRZIPMIPS</td>
<td>LparZipMipsUsage</td>
<td>if MIPSFACT ^= . and ZIPACTT &gt; 0 then LPRZIPMIPS=(ZIPACTT * SUSEC / 1000000) * MIPSFACT; else LPRZIPMIPS=.;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LPRTOTMSU</td>
<td>LparAllEngMsuUsage</td>
<td>if LCPUPDT &gt; 0 or IFAACTT &gt; 0 or ZIPACTT &gt; 0 then LPRTOTMSU=(sum(LCPUPDT, IFAACTT, ZIPACTT)*SUSEC) / 1000000; else LPRTOTMSU=.;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LPRTOTMIPS</td>
<td>LparAllEngMipsUsage</td>
<td>if MIPSFACT ^= . then LPRTOTMIPS=(sum(LCPUPDT, IFAACTT, ZIPACTT)*SUSEC / 1000000) * MIPSFACT; else LPRTOTMIPS=.;</td>
</tr>
<tr>
<td>Workload</td>
<td>XRMFWKL</td>
<td>WKLMSU</td>
<td>WorkloadCpuMsuUsage</td>
<td>Workload XRMFWKL WKLMSU WorkloadCpuMsuUsage if WKLCPU &gt; 0 then WKLMSU=(WKLCPU*CECSUSE) / 1000000; else WKLMSU=.;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WKLIFAMSU</td>
<td>WorkloadIfaCpuMsuUsage</td>
<td>if WKLIFA &gt; 0 then WKLIFAMSU=(WKLIFA*CECSUSE) / 1000000; else WKLIFAMSU=.;</td>
</tr>
<tr>
<td>Domain Category</td>
<td>Staged Table</td>
<td>Computed Column</td>
<td>Column Label</td>
<td>Calculation</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------</td>
<td>-----------------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>WKLIFAMIPS</td>
<td>WorkloadIfaCpuMipsUsage</td>
<td>if MIPSFACT ^= . and WKLIFA &gt; 0 then WKLIFAMIPS=((WKLIFA*CECSUSE) / 1000000) * MIPSFACT; else WKLIFAMIPS=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WKLZIPMSU</td>
<td>WorkloadZipCpuMsuUsage</td>
<td>if WKLZIP &gt; 0 then WKLZIPMSU=(WKLZIP*CECSUSE) / 1000000; else WKLZIPMSU=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WKLZIPMIPS</td>
<td>WorkloadZipCpuMipsUsage</td>
<td>if MIPSFACT ^= . and WKLZIP &gt; 0 then WKLZIPMIPS=((WKLZIP*CECSUSE) / 1000000) * MIPSFACT; else WKLZIPMIPS=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WKLTOTMSU</td>
<td>WorkloadAllEngCpuMsuUsage</td>
<td>if WKPCPU &gt; 0 or WKPIFA &gt; 0 or WKZIP &gt; 0 then WKLTOTMSU=(sum(WKPCPU,WKPIFA,WKZIP) * CECSUSE) / 1000000; else WKLTOTMSU=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WKLTOTMIPS</td>
<td>WorkloadAllEngCpuMipsUsage</td>
<td>if MIPSFACT ^= . then WKLTOTMIPS=(sum(WKPCPU,WKPIFA,WKZIP) * CECSUSE/1000000)*MIPSFACT; else WKLTOTMIPS=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Workload Period</td>
<td>XRMFWKP</td>
<td>WKPMSU</td>
<td>WorkloadPeriodCpuMsuUsage</td>
<td>if WKPCPU &gt; 0 then WKPMSU=(WKPCPU*CECSUSE) / 1000000; else WKPMSU=.;</td>
</tr>
<tr>
<td>Domain Category</td>
<td>Staged Table</td>
<td>Computed Column</td>
<td>Column Label</td>
<td>Calculation</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------</td>
<td>-----------------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>WKPMIPS</td>
<td>WorkloadPeriodCpuMipsUsage</td>
<td>if MIPSFACT ^= . and WKPCPU &gt; 0 then WKPMIPS=((WKPCPU*CECSUSE) / 1000000) * MIPSFACT; else WKPMIPS=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WKPIFAMSU</td>
<td>WorkloadPeriodIfaCpuMsuUsage</td>
<td>if WKPIFA &gt; 0 then WKPIFAMSU=(WKPIFA*CECSUSE) / 1000000; else WKPIFAMSU=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WKPIFAMIPS</td>
<td>WorkloadPeriodIfaCpuMipsUsage</td>
<td>if MIPSFACT ^= . and WKPIFA &gt; 0 then WKPIFAMIPS=((WKPIFA*CECSUSE) / 1000000) * MIPSFACT; else WKPIFAMIPS=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WKPZIPMSU</td>
<td>WorkloadPeriodZiPCpuMsuUsage</td>
<td>if WKPZIP &gt; 0 then WKPZIPMSU=(WKPZIP*CECSUSE) / 1000000; else WKPZIPMSU=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WKPZIPMIPS</td>
<td>WorkloadPeriodZiPCpuMipsUsage</td>
<td>if MIPSFACT ^= . and WKPZIP &gt; 0 then WKPZIPMIPS=((WKPZIP*CECSUSE) / 1000000) * MIPSFACT; else WKPZIPMIPS=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WKPTOTMSU</td>
<td>WorkloadPeriodAllEngCpuMsuUsage</td>
<td>if WKPCPU &gt; 0 or WKPIFA &gt; 0 or WKPZIP &gt; 0 then WKPTOTMSU=(sum(WKPCPU,WKPIFA,WKPZIP) * CECSUSE) / 1000000; else WKPTOTMSU=.;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### How MSU and MIPS Columns Are Included in Staged Tables for the SMF Adapter

<table>
<thead>
<tr>
<th>Domain Category</th>
<th>Staged Table</th>
<th>Computed Column</th>
<th>Column Label</th>
<th>Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>WKPTOTMIPS</strong></td>
<td>WorkloadPeriodAllEngCpuMipsUsage</td>
<td>if MIPSFACT ^= . then WKPTOTMIPS=(sum(WKPCPU,WKPIFA,WKPIZIP) * CECSUSE/1000000)*MIPSFACT; else WKPTOTMIPS=;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Goal Mode Period

| XTY72GO | PRDMSU | PeriodCpuMsuUsage | if CPUTM > 0 then PRDMSU=CPUTM*CECSUSE/1000000; else PRDMSU=; |
|---------|--------|--------------------|--------------|-------------|
| **PRDMIPS** | PeriodCpuMipsUsage | if MIPSFACT ^= . and CPUTM > 0 then PRDMIPS=(CPUTM*CECSUSE/1000000) * MIPSFACT; else PRDMIPS=; |

| PRDIFAMSU | PeriodIfaCpuMsuUsage | if CPIFATM > 0 then PRDIFAMSU=CPIFATM*CECSUSE/1000000; else PRDIFAMSU=; |
|------------|-----------------------|-----------------|--------------|-------------|
| **PRDIFAMIPS** | PeriodIfaCpuMipsUsage | if MIPSFACT ^= . and CPIFATM > 0 then PRDIFAMIPS=(CPIFATM*CECSUSE/1000000) * MIPSFACT; else PRDIFAMIPS=; |

<p>| PRDZIPMSU | PeriodZipCpuMsuUsage | if CPZIPTM &gt; 0 then PRDZIPMSU=CPZIPTM*CECSUSE/1000000; else PRDZIPMSU=; |</p>
<table>
<thead>
<tr>
<th>Domain Category</th>
<th>Staged Table</th>
<th>Computed Column</th>
<th>Column Label</th>
<th>Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>PRDZIPMIPS</td>
<td>PeriodZipCpuMips Usage</td>
<td>if MIPSFACT ^= . and CPZIPTM &gt; 0 then PRDZIPMIPS=(CP ZIPTM*CECSUSE/1000000) * MIPSFACT; else PRDZIPMIPS=.;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PRDTOTMSU</td>
<td>AllEngCpuTimeMsuUsage</td>
<td>if CPUTM &gt; 0 or CPIFATM &gt; 0 or CPZIPTM &gt; 0 then PRDTOTMSU=(sum(CPUTM,CPIFATM,CPZIPTM) * CECSUSE) / 1000000; else PRDTOTMSU=.;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PRDTOTMIPS</td>
<td>AllEngCpuTimeMipsUsage</td>
<td>if MIPSFACT ^= . then PRDTOTMIPS= (sum(CPUTM,CPIFATM,CPZIPTM) * CECSUSE/1000000)*MIPSFACT; else PRDTOTMIPS=.;</td>
</tr>
<tr>
<td>Batch Jobs</td>
<td>XJOBS</td>
<td>SYSMSU</td>
<td>SystemCpuMsuUsage</td>
<td>if CPUTM &gt; 0 then SYSMSU=CPUTM *CECSUSE/1000000; else SYSMSU=.;</td>
</tr>
<tr>
<td>TSO</td>
<td></td>
<td>SYSMIPS</td>
<td>SystemCpuMipsUsage</td>
<td>if MIPSFACT ^= . and CPUTM &gt; 0 then SYSMIPS=(CPUTM*CECSUSE/1000000) * MIPSFACT; else SYSMIPS=.;</td>
</tr>
<tr>
<td>OMVS</td>
<td></td>
<td>IFAMSU</td>
<td>IfaCpuMsuUsage</td>
<td>if CPIFATM &gt; 0 then IFAMSU=CPIFATM*CECSUSE/1000000; else IFAMSU=.;</td>
</tr>
<tr>
<td>Domain Category</td>
<td>Staged Table</td>
<td>Computed Column</td>
<td>Column Label</td>
<td>Calculation</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------</td>
<td>----------------</td>
<td>--------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>IFAMIPS</td>
<td>IfaCpuMipsUsage</td>
<td>if MIPSFACT ^= . and CPIFATM &gt; 0 then IFAMIPS=(CPIFATM*CECSUSE/1000000)*MIPSFACT; else IFAMIPS=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZIPMSU</td>
<td>ZipCpuMsuUsage</td>
<td>if CPZIPTM &gt; 0 then ZIPMSU=CPZIPTM*CECSUSE/1000000; else ZIPMSU=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZIPMIPS</td>
<td>ZipCpuMipsUsage</td>
<td>if MIPSFACT ^= . and CPZIPTM &gt; 0 then ZIPMIPS=(CPZIPTM*CECSUSE/1000000)*MIPSFACT; else ZIPMIPS=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOTMSU</td>
<td>AllEngCpuMsuUsage</td>
<td>if CPUTM &gt; 0 or CPIFATM &gt; 0 or CPZIPTM &gt; 0 then TOTMSU=(sum(CPUTM,CPIFATM,CPZIPTM)*CECSUSE)/1000000; else TOTMSU=.;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOTMIPS</td>
<td>AllEngCpuMipsUsage</td>
<td>if MIPSFACT ^= . then TOTMIPS=(sum(CPUTM,CPIFATM,CPZIPTM)*CECSUSE/1000000)*MIPSFACT; else TOTMIPS=.;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
VMware vCenter Data Acquisition Jobs

Overview of VMware Data Acquisition Jobs

Although staging jobs for SAS IT Resource Management adapters are typically run once a day, the VMware vCenter adapter requires the ability to run staging jobs more frequently than once a day. The reason for this frequency is that staged VMware data must include information about the mapping of a host (physical machine) to the guest (virtual machine). As virtual machines are moved from host to host, the VMware database is updated with the current location of the virtual machine. The VMware database stores only the most recent host-to-guest mapping information. It does not store any previous mappings. Therefore, if the host-to-guest mappings change more than once a day, those mappings must also be extracted from the VMware database more than once a day. Those mappings must also be stored, along with some of the corresponding data, in a table for use as source tables in the nightly run of the VMware staging transformation. The VMware vCenter Data Acquisition transformation provides this functionality.

How Does the VMware Data Acquisition Job Work?

Like all other transformations, the VMware vCenter Data Acquisition transformation is contained in a job. When the VMware Data Acquisition job runs, it extracts a subset of VMware data from a database. The target table that is created by executing the VMware vCenter Data Acquisition transformation is input to the VMware vCenter staging transformation. Unlike the staged tables created by other staging transformations, the target table is not purged when the VMware Data Acquisition job is executed. The VMware vCenter Data Acquisition staging transformation prompts for the following information:

- **Raw data input library** includes two fields (Library and Libref) that specify the SAS library metadata path and the corresponding libref for the appropriate adapter database. You can enter the library metadata path and the corresponding libref. Alternatively, you can click Browse and select the library metadata object from a dialog box that also populates the libref field with the corresponding value of libref. This parameter does not have a default value.

  *Note:* For VMware Data Acquisition, this parameter supports only libraries with engine types of ODBC, OLE DB, DB2, and Oracle.

- **Age limit for data acquisition table (in days)** specifies the number of days that data is kept in the data acquisition table that populates the staged tables. The default value is 7.

The target table that is created is a staged table. It should be used as input to the VMware vCenter staging transformation. When this staged table is input to the VMware vCenter staging transformation, it is merged with other VMware tables by the VMware vCenter staging transformation during the nightly staging run for that adapter.

The VMware Data Acquisition staged table has its own library. The Adapter Setup wizard creates the two staging libraries—one for the VMware vCenter Data Acquisition table, and the other library for the other VMware vCenter staged tables. (If created by the Adapter Setup wizard, these tables and libraries reside in the Staging folder of the IT data mart. If created manually, outside of the Adapter Setup wizard, these tables and libraries reside in the location of your choice.)
Preserving Information about the VMware Environment

The VMware DataAcquisition staged table that is output from the VMware Data Acquisition staging job contains useful information about the topology of the VMware environment at the time that the VMware Data Acquisition staging job is run. The topology of the VMware environment includes the names and IDs of each guest, and the host or cluster that each guest belongs to. However, the VMware DataAcquisition staged table does not preserve the information about the movements of a guest from host to host or cluster to cluster between staging runs.

If you want to preserve this information over a period of time, you can instruct the VMware Data Acquisition staging job to create a separate data set to contain this information—the VMwareTopologyDimensionTable. To specify the creation of that table, set a macro variable called CreateTopologyDimensionTable to YES in the generated code (or deployed job code) for the VMware Data Acquisition staging job. To specify that the VMwareTopologyDimensionTable be created, add the following line to the generated code for the VMware Data Acquisition staging job:

```bash
%let CreateTopologyDimensionTable = YES;
```

The table will be stored in the same staging library as the DataAcquisition staged table that is output from the VMware Data Acquisition staging job.

Note: The VMware Data Acquisition staging job should be scheduled to run as often as is necessary to capture the information about the movements of guests between hosts and clusters in the VMware environment.

You can use this table as required at your site. The table is not used by the VMware staging code.

When Should the VMware Data Acquisition Job Run?

The VMware Data Acquisition job should be scheduled to run whenever it is necessary to capture the movements of virtual machines across physical machines in your VMware environment. If your environment changes rapidly, then the VMware Data Acquisition job might need to run as frequently as once an hour. However, if the virtual machines in your environment do not move between hosts as often, then the VMware Data Acquisition might need to run only once per day. This scheduling is dependent on, and should be arranged according to, the needs of your site.

For information about deploying jobs, scheduling jobs to run in batch mode, and redeploying jobs, see "Jobs That Process IT Data" on page 295.
Appendix 3
Staging Parameters

Staging Parameters .......................................................... 400
  Age Limit for Data Acquisition Table .............................. 400
  Allow Duplicate ID Variables ...................................... 401
  Choose Access Command ............................................. 401
  Choose Raw Data Input Type ....................................... 401
  Class Columns ....................................................... 402
  Consolidation Function (CF) ....................................... 402
  Default Duration ................................................... 402
  Delimiter Characters ................................................ 402
  Delimiter in Raw Data .............................................. 402
  Delimiter String .................................................... 403
  Duplicate Checking Options ..................................... 403
  Enable Duplicate Checking ....................................... 403
  ENDFILE .............................................................. 403
  FTP .......................................................................... 404
  Future Data ................................................................ 405
  How Many Rows of Data Should Be Used as Guessing Rows ................................................................... 405
  IDVAR ........................................................................ 406
  Is the Delimiter String Case Sensitive ............................ 406
  Is There a Header Row ............................................... 406
  Input File Parameters .................................................. 406
  INT ........................................................................... 406
  JES ........................................................................... 406
  Keep ........................................................................... 406
  Library for Temporary Work Space .................................. 407
  Machine ...................................................................... 407
  Minimum Number of Files to Read on Each Processor .......... 407
  Normalize Datetime ...................................................... 407
  Number of Processors to Use ....................................... 407
  Presummarization Duration ......................................... 407
  Raw Data Input Directory ............................................ 408
  Raw Data Input File ..................................................... 408
  Raw Data Input Library ............................................... 408
  Report ....................................................................... 408
  rrdtool fetch -end Option ......................................... 408
  rrdtool Executable ...................................................... 408
  rrdtool fetch -start Option ........................................ 408
  rsh Host Command ...................................................... 409
  rsh/sh Host Command .................................................. 409
  Site Name ................................................................. 409
  Source ...................................................................... 409
Staging Parameters

The following topics describe the various parameters that adapters use to stage the raw data. The appropriate combination of these staging parameters is available from the Adapter Setup wizard and from the Staging Parameters tab of the Properties dialog box for an adapter or staging transformation. If a parameter includes a browse function, the browse function might be disabled in some instances such as when the input data is associated with an application server that resides on either a traditional MVS operating environment or a UFS file system.

Age Limit for Data Acquisition Table

Age limit for data acquisition table (in days) specifies the number of days that data is kept in the data acquisition table that populates the staged tables.
This parameter is relevant only to the VMware Data Acquisition because other staging transformations purge the existing data of their corresponding staged tables and replace it with new data on execution of the staging job. However, the VMware Data Acquisition staging transformation populates staged tables that are not purged on execution of the staging job. Therefore, this parameter enables you to specify an age limit for the data in this table, after which the data is purged when the staging job executes, so that the table does not grow indefinitely.

**Allow Duplicate ID Variables**

Allow duplicate ID variables specifies whether duplicate ID variables are permitted when transposing data for the adapter. The value for this parameter can be Y (yes) or N (no). N is the default value.

**Choose Access Command**

Choose access command specifies the type of raw data such as NNM, NetView, or RRDtool. The following two options for this parameter also govern other staging parameters that are available for configuration:

- **HP NNM / Netview**, the default value, indicates that the raw data is from HP NNM or NetView. If you select this value, then the corresponding field `snmpColDump executable` appears and enables you to specify the location path and command for `snmpColDump`. The `snmpColDump executable` parameter does not have a default.

  Note: If you select **HP NNM / Netview**, then you must have either of those products installed on the server where the staging job is running either interactively or in batch mode.

- **RRDtool** indicates that the raw data is stored in a Round Robin Database (RRD) that is managed by RRDtool. If you select this value, then the following fields appear:

  - **rrdtool executable** appears and enables you to specify the location path and command for RRDtool. The `rrdtool executable` parameter does not have a default.

  - **Number of days to load** specifies the number of days of raw data that you want to backload into the staged table. This field accepts only integers from one to 365. The default value is 2.

**Choose Raw Data Input Type**

Choose raw data input type specifies whether the raw data is a file or directory that is available from the client network or if the raw data input is available using an FTP access method. The following options for this parameter also govern several of the other staging parameters that are available for configuration. The options that are available for selection vary based on the adapter.

- **File** indicates that the raw data input for the adapter is a file. If you select this value, then the corresponding field `Raw data input file or directory` appears and enables you to specify the full pathname of the raw data file or the directory. You can enter the path directly or use the browsing function to locate the path and enter it automatically. This parameter does not have a default value.
• **File or directory** indicates that the raw data input for the adapter is a file or directory. If you select this value, then the corresponding field **Raw data input file or directory** appears and enables you to specify the full pathname of the raw data file or the directory. You can enter the path directly or use the browsing function to locate the path and enter it automatically. This parameter does not have a default value.

• **FTP** indicates that the raw data input for the adapter is available using the FTP access method. For more information about additional parameters that are required if you select the FTP access method, see “FTP” on page 404.

### Class Columns

Class columns, relevant only to the RRDtool adapter, specifies the list of additional class columns that you want to use when staging the data. If any of these columns are computed columns, they must be based on the filename or datetime columns. This parameter requires a space-delimited list of class columns.

### Consolidation Function (CF)

Consolidation Function (CF), relevant only to the RRDtool adapter, specifies the consolidation function values that should be retrieved from the Round Robin Database (RRD). Select the function whose data you want to fetch from the drop-down menu. You can also type in a value or leave the field blank. If the value is blank, the FETCH command retrieves all the consolidation functions that are in the RRD.

### Default Duration

Default duration, relevant only to the HP Reporter adapter, specifies the value (in seconds) for the duration of the intervals if the input data does not contain an INTERVAL variable. If the input data does not contain an INTERVAL variable and a value for the default duration is not specified, then the interval duration defaults to 3600 seconds, or one hour.

This value must be numeric. If specified, the integer value must be greater than or equal to 1 and less than or equal to 2,147,483,647.

### Delimiter Characters

Delimiter characters, relevant only to the CSV adapter, specifies one or more characters that are used as delimiters in the raw input data. If you enter several characters (for example, !#*), then each of these characters is treated as a delimiter in your data. A value is not required for this parameter.

*Note:* The selected characters must not be separated from each other by spaces or any other character.

### Delimiter in Raw Data

Delimiter in raw data specifies the delimiter (**Space**, **Comma**, or **Tab**) that is used in the raw input data. The values that are available for this parameter vary based on the adapter.
**Delimiter String**

**Delimiter string**, relevant only to the CSV adapter, specifies a string of characters that is used as the delimiter in the raw input data. A value is not required for this parameter.

**Duplicate Checking Options**

**Duplicate checking options** specifies whether to check for duplicate data and indicates what to do when duplicate data is encountered.

*Note:* Duplicate checking is automatically enabled for the adapters that use a database as a raw data source (such as HP Reporter, SAP ERP, MS SCOM, and VMware). This parameter is not available for configuration with these staging transformations. For more information about how to override the default value for duplicate checking with these adapters, see “Example 3: Using Macro Variables to Subset Data for HP Reporter and MS SCOM Adapters” on page 462.

Here are the values that are available for this parameter:

**Discard**
removes duplicates. This is the default value for most adapters.

**Force**
loads data regardless of whether duplicates are found.

**Terminate**
ends the job if duplicates are found.

*CAUTION:*
Although the job terminates, the resulting staged table might contain data. However, termination of the job indicates an error in processing, and any data in the resulting staged table might be invalid.

For more information about duplicate data checking, see “Duplicate-Data Checking Overview” on page 455.

*Note:* If you update the source code of a job and modify the mode for duplicate checking, then you can save the functionality of the new source code to the local file system. However, SAS Data Integration Studio preserves the original source code. The new value of the mode for duplicate checking is not updated in the repository, and the new value is not reflected in the user interface.

**Enable Duplicate Checking**

**Enable Duplicate Checking** specifies whether to perform duplicate checking of the data. If this parameter is set to **Yes**, additional duplicate checking parameters are displayed and enabled for specification. These parameters are INT, Keep, and report. If this parameter is set to **No**, no other duplicate checking parameters are displayed.

**ENDFILE**

**ENDFILE** specifies the name of the SAS variable that is used as the END= keyword for the SAS INFILE statement that reads the raw data.
FTP

Overview
If you select FTP for the Choose raw data input type parameter, then additional parameters appear on the parameters page to facilitate the FTP process. The following topics describe these additional parameters that are available for configuration:

Host
Host specifies the name of the remote host. This parameter does not have a default value.

Port
Port specifies the FTP port number. The default value is 21.

User
User specifies the user ID for the FTP server. This field accepts alphanumeric characters. This parameter does not have a default value.

Password
Password specifies the password of the given user ID for the FTP server. This parameter does not have a default.

CAUTION:
The Adapter Setup wizard generates a job log that displays all information that you specify in the wizard, including any passwords for accessing FTP data. If you have concerns about this password showing in the job log, then you can set up a user ID that you use only for accessing the files via FTP.

External File Name
External file name specifies the filename of the raw data. The maximum number of characters in this field (including the dots in a z/OS filename, if applicable) is 44. This parameter does not have a default value.

Tape
Tape specifies whether the data file is on tape. The default value is No.

RCMD
RCMD specifies the FTP SITE or service command that is sent to the FTP server to provide services that are system-specific or essential to transfer files but not common enough to be included in the protocol. The default value is SITE RDW.

Debug
Debug specifies whether to write to the SAS log any messages that are sent to and from the FTP server. The default value is No.
**Future Data**

**Future data** specifies whether to check for future data and indicates what to do when it is encountered. This parameter specifies the `FUTURE` parameter in the `RMFUTURE` macro.

This parameter controls the processing of incoming data that has a datetime variable that is greater than 48 hours in the future. (That is, the datetime variable is more than 48 hours after the current time on the system where data is being staged for processing into the IT data mart.) The 48-hour buffer provides for different time zones, daylight saving time, Greenwich Mean Time, and so on.

If future data is encountered, a note is written to the SAS log. This note provides the future data option that is selected, shows the datetime that was encountered, and explains the status of the future data, such as whether it was added to the IT data mart or if the job was terminated.

Here are the values that are available for this parameter:

**Accept**

specifies that incoming data is staged for processing and is processed into the IT data mart. If any of the data has a datetime value of 48 hours or more in the future, then a note that future data was encountered is written to the SAS log. This value enables an IT data mart to accept future data. For example, you might want to use this setting to perform end-of-year testing with a test IT data mart.

*Note:* Age limits take effect from the most recent data. Therefore, dates in the future might cause at least some of the existing data to be aged out of the IT data mart.

**Discard**

specifies that data with a datetime value of 48 hours or more in the future is not staged for processing and is not processed into the IT data mart. This value is the default. This value prevents future data from being processed into the IT data mart. Future data might cause existing data to be aged out (the existing data would appear to be older than it is, in comparison with the future data).

**Terminate**

specifies that if any incoming data has a datetime value of 48 hours or more in the future, then staging of the data stops, an error message is written to the SAS log, and the job terminates. This value prevents future data from being processed into the IT data mart, which might cause existing data to be aged out (the existing data would appear to be older than it is, in comparison with the future data). This value stops processing and thus calls more attention to the future data than the **Discard** value.

**CAUTION:**

Although the job terminates, the resulting staged table might contain data. However, termination of the job indicates an error in processing, and any data in the resulting staged table might be invalid.

---

**How Many Rows of Data Should Be Used as Guessing Rows**

**How many rows of data should be used as guessing rows,** relevant only to the CSV adapter, specifies the number of rows to be read from the raw data in order to determine the type and length of each column.
**IDVAR**

IDVAR specifies the name of the SAS variable that identifies the system or machine that generated the input data.

**Is the Delimiter String Case Sensitive**

Is the delimiter string case sensitive, relevant only to the CSV adapter, specifies whether the delimiter that is used in the raw input data must be delimited exactly as specified in the Delimiter string parameter or if the case of the string in the raw data does not matter. This parameter is available only if you have set the Type of Delimiter to Delimiter string.

**Is There a Header Row**

Is there a header row, relevant only to the CSV adapter, specifies whether a header row that contains column headings is in the raw input data. If you specify Yes, the What row is the header on field is enabled. If you specify No, the What row is the header on field is not enabled and the columns are named Column1 to ColumnN.

**Input File Parameters**

Input File Parameters, relevant only to MXG adapters, specifies the record format and logical record length of the input file.

**INT**

INT specifies the maximum time gap (or interval) that is to be allowed between the timestamps on any two consecutive records from the same system or machine. If the interval between the timestamp values exceeds the value of this parameter, then an observation with the new time range is created in the control data set. This is referred to as a gap in the data.

The value for this parameter must be provided in the format hh:mm, where hh represents hours and mm represents minutes. For example, to specify an interval of 14 minutes, use INT=0:14. To specify an interval of 1 hour and 29 minutes, use INT=1:29.

**JES**

JES specifies the version (JES2 or JES3) of the z/OS job entry subsystem that is in use by the system where the input data was recorded.

**Keep**

KEEP specifies the number of weeks for which control data will be kept. Because this value represents the number of Sundays between two dates, a value of 2 results in a maximum retention period of 20 days. This value must be an integer.
Library for Temporary Work Space

Library for temporary work space specifies the table to use if Temporary workspace library is set to Other Library. Use the Browse function to select a library that you have already defined.

Machine

Machine, relevant primarily to the Web Log adapter, specifies the name of the machine that generated the raw data. If the Web Log data already contains a value for machine name, then the value in the raw data is used with the staged table and you do not need to specify a value for this parameter. If the Web Log data does not already specify a machine name, then you can use this parameter to specify a machine name and that value is then associated with the staged table. This parameter does not have a default value.

Minimum Number of Files to Read on Each Processor

Minimum number of files to read on each processor, relevant only to the SAR adapter, specifies the minimum number of files to read in each MPConnect session.

Normalize Datetime

Normalize datetime, relevant only to the RRDtool adapter, specifies how to save the datetime stamps in the data. This parameter requires a value. If this parameter is set to Yes, the datetime stamps are adjusted to an even number, which enables a more efficient combination of data from multiple round-robin databases. If this parameter is set to No, the exact datetime values will be saved in the data.

Number of Processors to Use

Number of processors to use, relevant only to the SAR adapter only, specifies the number of processors that can be used for the MPConnect parallel processing.

- If set to 0, all processors on the machine will be used to stage the data.
- If set to 1, MPConnect will not be used to stage the data and the staging code will run on a single processor.
- If set to more processors than are available on the machine, then the staging code will use the number of processors that are available.

T I P

For best performance, set this option to a number less than the total number of processors that are available on the machine.

Presummarization Duration

Presummarization duration specifies the duration, in seconds, of the intervals into which you want to summarize the raw data before it is staged. For example, if you enter 3600, then the raw data is summarized in intervals of one hour. If specified, the value must be a positive integer less than or equal to 86,400, which is the number of seconds in a day.
**Raw Data Input Directory**

Raw data input directory specifies the full pathname of the directory for the raw data. You can enter the path directly or use the browsing function to locate and select it.

**Raw Data Input File**

Raw data input file specifies the full pathname of the raw data file for the adapter. You can enter the path directly or use the browsing function to locate and select it.

**Raw Data Input Library**

Raw data input library includes two fields (Library and Libref) that specify the SAS library and corresponding libref for the appropriate adapter database. You can enter the library path or use the browsing function to locate and select it.

*Note:* For the HP Reporter adapter, this parameter supports only libraries with engine types of ODBC, OLE DB, and Oracle. For the SAP ERP adapter, this parameter supports only libraries with engine types of SAS or BASE.

**Report**

REPORT, relevant only to MXG adapters, specifies whether to display the duplicate-data checking messages in the SAS log or to save the messages in an audit table. If set to Yes, this parameter causes all the messages from duplicate-data checking to be displayed in the SAS log. If set to No, the duplicate-data checking messages are saved in an audit data table that is stored in the staging library. The name of the audit table is source AUDIT (where source is the 3-character data source code).

**rrdtool fetch -end Option**

rrdtool fetch -end option, relevant only to the RRDtool adapter, specifies the ending point for the data that is retrieved from the RRD. A value for this parameter is not required. If this value is blank, the data from the start time to the current time is retrieved.

*Note:* For information about the formats that are valid for this parameter, see [http://oss.oetiker.ch/rrdtool/doc/rrdfetch.en.html](http://oss.oetiker.ch/rrdtool/doc/rrdfetch.en.html).

**rrdtool Executable**

rrdtool executable, relevant only to the RRDtool adapter, specifies the location of the executable for the RRDtool adapter. You can enter the path to the executable or use the browsing function to locate and select it. This parameter requires a value.

**rrdtool fetch -start Option**

rrdtool fetch -start option, relevant only to the RRDtool adapter, specifies the starting point for the data that is retrieved from the RRD. A value for this parameter is not required.
**rsh Host Command**

*rsh host command*, relevant only to the SNMP adapter, specifies the rsh command and the name of the host for running the NNM snmpColDump command or the rrdtool command. The command in this field is used at the beginning of the rrdtool, snmpColDump, or snmpwalk commands. This field can be left blank if an rsh command is not required to run the rrdtool or snmpColDump command.

**rsh/ssh Host Command**

*rsh/ssh host command*, relevant only to the RRDtool and SNMP adapters, specifies the rsh or ssh command and the name of the host for running the rrdtool command. The command in this field is used at the beginning of the rrdtool command. This field can be left blank if an rsh command is not required to run the rrdtool command.

**Site Name**

*Site name*, relevant to the Web Log adapter, specifies the name of the Web site that generated the raw data. If the Web Log data already contains a Web site value, then the value in the raw data is used with the staged table and you do not need to specify a value for this parameter. If the Web Log data does not already specify a Web site, then you can use this parameter to specify a Web site value and that value is then associated with the staged table. This parameter does not have a default value.

**Source**

SOURCE specifies the data source for this adapter.

**Temporary Work Space Library**

*Temporary work space library*, relevant only to the SAR adapter, specifies how the MPConnect process defines a library for temporary files.

The choices are:

- WORK Library (use the standard SAS work library)
- Staging Library (use the staging library to temporarily store files)
- Other Library (use another library that the user defines to point to another location).

*Note*: You must predefine this library in metadata using the New Library wizard. If you choose this option, then the Library for temporary work space option is displayed.

**TIMESTAMP**

TIMESTAMP specifies the name of the SAS variable that contains the datetime stamp that uniquely identifies the time of the event or interval that is being recorded.
Type of Delimiter

Type of delimiter, relevant only to the CSV adapter, specifies the type of delimiter to use in the raw input data. The type can either be a list of single-character delimiters or a character string. Select the type of delimiter from the drop-down list.

If you select List of delimiter characters, the Delimiter characters field is enabled. The Delimiter string and Is the delimiter string case sensitive? fields are not enabled.

If you select Delimiter string, the Delimiter string and Is the delimiter string case sensitive? fields are enabled. The Delimiter characters field is not enabled.

Use Intermediate Staging View

Use intermediate staging view specifies whether to use the temporary view form when instantiating staged tables. Enter the staged table name or leave this field blank.

This optional parameter can contain the SAS data set name of a staged table or a macro variable that resolves to a SAS data set name. If not specified, this parameter defaults to a blank, which implies that you do not want presummarization.

Use snmpwalk to Gather Character Data

Overview

Use snmpwalk to gather character data specifies whether to use the snmpwalk command to capture data during job execution. The following values are available:

- No does not use the snmpwalk command.
- Yes uses the snmpwalk command. If you select this value, then additional parameters appear. The following subtopics describe each of these additional parameters.

This parameter and others associated with snmpwalk are relevant only to the SNMP adapter.

snmpwalk Executable

snmpwalk Executable specifies the location and command for snmpwalk. This parameter does not have a default value.

HostFile for snmpwalk

HostFile for snmpwalk indicates the location of the snmphost file that lists the hosts from which you want to get data. This parameter does not have a default.

Community value for snmpwalk

Community value for snmpwalk specifies the community name that is required to run the snmpwalk command. The default value is public.
**What Row Does the Data Start On**

*What row does the data start on*, relevant only to the CSV adapter, specifies the number of the row where the data in the raw data file starts. A value for this parameter is required.

**What Row Is the Header On**

*What row is the header on*, relevant only to the CSV adapter, specifies the number of the row that contains the headers.

**User-written Staging Parameters**

For a detailed description of the staging parameters for the User-written Staging transformation, see “Staging Parameters Tab” on page 266.

---

**Staging Parameters for Supported Adapters**

The following tables show the staging parameters for each adapter that SAS IT Resource Management supports. These staging parameters are available from the Adapter Setup wizard and from the Staging Parameters tab of the Properties dialog box for an adapter or staging transformation.

**ASG TMONC2CIC Staging and Duplicate-Data Checking Parameters**

*Table A3.1  Staging Parameters for the ASG TMONC2CIC Adapter*

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input file</td>
<td>any valid file</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>Input File Parameters</td>
<td>values for RECFM and LRECL parameters</td>
<td>RECFM=S370VBS and LRECL=32760</td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Discard</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table A3.2 Duplicate-Data Checking parameters for the ASG TMONC2CIC Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>01:00</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### ASG TMONDB2 Staging and Duplicate-Data Checking Parameters

### Table A3.3 Staging Parameters for the ASG TMONDB2 Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input file</td>
<td>any valid file</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input File Parameters</td>
<td>values for RECFM and LRECL parameters</td>
<td>RECFM=S370VBS and LRECL=32760</td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Discard</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Table A3.4 Duplicate-Data Checking Parameters for the ASG TMONDB2 Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Parameters Supported for This Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Suboptions</th>
<th>Values for Suboptions</th>
<th>Default Values</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Raw data input file</td>
<td>any valid file</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td>Host</td>
<td>any valid host</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td>Port</td>
<td>any valid port</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>User</td>
<td>any valid user</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Password</td>
<td>any valid password</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>External file name</td>
<td>any valid file</td>
<td></td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>Tape</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes</td>
<td>RCMD</td>
<td>any valid site</td>
<td>SITE RDW</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td>Debug</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

**BMC Mainview IMS Staging and Duplicate-Data Checking Parameters**

**Table A3.5**  Staging Parameters for the BMC Mainview IMS Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Suboptions</th>
<th>Values for Suboptions</th>
<th>Default Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose raw data input type</td>
<td>File (default)</td>
<td>Raw data input file</td>
<td>any valid file</td>
<td></td>
</tr>
<tr>
<td>FTP</td>
<td>Host</td>
<td>any valid host</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Port</td>
<td>any valid port</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User</td>
<td>any valid user</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>any valid password</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>External file name</td>
<td>any valid file</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tape</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>RCMD</td>
<td>any valid site</td>
<td>SITE RDW</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Debug</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
### Table A3.6  Duplicate-Data Checking Parameters for the BMC Mainview IMS Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>01:00</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### BMC Perf Mgr Staging and Duplicate-Data Checking Parameters

**Table A3.7  Staging Parameters for the BMC Perf Mgr Adapter**

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input file</td>
<td>any valid file</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow duplicate ID variables</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameters Supported for This Adapter</td>
<td>Values</td>
<td>Default Value</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>--------</td>
<td>---------------</td>
<td>-------</td>
</tr>
<tr>
<td>Input File Parameters</td>
<td>values for RECFM and LRECL parameters</td>
<td>RECFM=S370VBS and LRECL=32760</td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Discard</td>
<td>Terminate</td>
<td></td>
</tr>
</tbody>
</table>

<p>| Table A3.8 Duplicate-Data Checking Parameters for the BMC Perf Mgr Adapter |</p>
<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>00:18</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## CA TMS Staging and Duplicate-Data Checking Parameters

**Table A3.9** Staging Parameters for the CA TMS Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Suboptions</th>
<th>Values for Suboptions</th>
<th>Default Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose raw data input type</td>
<td>File (default)</td>
<td>Raw data input file</td>
<td>any valid file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FTP</td>
<td>Host</td>
<td>any valid host</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Port</td>
<td>any valid port</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>User</td>
<td>any valid user</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Password</td>
<td>any valid password</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>External file name</td>
<td>any valid file</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tape</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>RCMD</td>
<td>any valid site</td>
<td>SITE RDW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Debug</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Input File Parameters</td>
<td>values for RECFM and LRECL</td>
<td>RECFM=S370V B and LRECL=16384</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td>Discard</td>
<td>Terminate</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table A3.10** Duplicate-Data Checking Parameters for the CA TMS Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Parameters Supported for This Adapter

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>25:00</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### CSV Staging and Duplicate-Data Checking Parameters

**Table A3.11  Staging Parameters for the CSV Adapter**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input file or directory</td>
<td>any valid file or directory</td>
<td></td>
<td>The CSV adapter does not support non-ASCII characters in the heading columns. For more information, see “Accessing CSV Files That Contain Data Encoded in UTF-8” on page 336.</td>
</tr>
<tr>
<td>Type of delimiter</td>
<td>list of delimiter characters</td>
<td>list of delimiter characters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>delimiter string</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delimiter characters</td>
<td>any characters</td>
<td>,</td>
<td></td>
</tr>
<tr>
<td>Delimiter string</td>
<td>any characters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Is the delimiter string case sensitive?</td>
<td>Yes</td>
<td>Only available if Type of delimiter is Delimiter string.</td>
<td></td>
</tr>
<tr>
<td>Is there a header row?</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Parameters Supported for This Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>What row is the header on?</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>What row does the data start on?</td>
<td>any integer</td>
<td>any integer</td>
<td></td>
</tr>
<tr>
<td>How many rows of data should be used as guessing rows?</td>
<td>20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Discard</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Table A3.12  Duplicate-Data Checking Parameters for the CSV Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes, No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard, Force, Terminate</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td>IDVAR</td>
<td>SAS variable</td>
<td>FILENAME</td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>hh:mm, where hh represents hours and mm represents minutes</td>
<td>01:15</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes, No</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
### DT Perf Sentry Staging and Duplicate-Data Checking Parameters

#### Table A3.13 Staging Parameters for the DT Perf Sentry Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input file or directory</td>
<td>any valid file or directory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delimiter in raw data</td>
<td>Comma, Tab</td>
<td>Comma</td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept, Discard, Terminate</td>
<td>Discard</td>
<td></td>
</tr>
</tbody>
</table>

#### Table A3.14 Duplicate-Data Checking Parameters for the DT Perf Sentry Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes, No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard, Force, Terminate</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>01:18</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes, No</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
# DT Perf Sentry with MXG Staging and Duplicate-Data Checking Parameters

**Table A3.15** Staging Parameters for the DT Perf Sentry with MXG Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Suboptions</th>
<th>Values for Suboptions</th>
<th>Default Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose raw data input type</td>
<td>File (default)</td>
<td>Raw data input file</td>
<td>any valid file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FTP</td>
<td>Host</td>
<td>any valid host</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Port</td>
<td>any valid port</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>User</td>
<td>any valid user</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Password</td>
<td>any valid password</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>External file name</td>
<td>any valid file</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tape</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>RCMD</td>
<td>any valid site</td>
<td>SITE RDW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Debug</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Input File Parameters</td>
<td>values for RECFM and LRECL parameters</td>
<td>RECFM=V and LRECL=32756</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td></td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Discard</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table A3.16** Duplicate-Data Checking Parameters for the DT Perf Sentry with MXG Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Parameters Supported for This Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>01:00</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### HP Perf Agent Staging and Duplicate-Data Checking Parameters

**Table A3.17**  
*Staging Parameters for the HP Perf Agent Adapter*

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input file or directory</td>
<td>any valid file or directory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Discard</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table A3.18**  
*Duplicate-Data Checking Parameters for the HP Perf Agent Adapter*

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### HP Reporter Staging and Duplicate-Data Checking Parameters

#### Table A3.19  Staging Parameters for the HP Reporter Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input library: Library and Libref</td>
<td>any valid library and libref</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept, Discard, Terminate</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td>Default duration</td>
<td>0 or greater</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

#### Table A3.20  Duplicate-Data Checking Parameters for the HP Reporter Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>01:05</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>260</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes, No</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
**IBM DCOLLECT Staging and Duplicate-Data Checking Parameters**

**Table A3.21  Staging Parameters for the IBM DCOLLECT Adapter**

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Suboptions</th>
<th>Values for Suboptions</th>
<th>Default Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose raw data input type</td>
<td>File (default)</td>
<td>Raw data input file</td>
<td>any valid file</td>
<td></td>
</tr>
<tr>
<td>FTP</td>
<td>Host</td>
<td>any valid host</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Port</td>
<td>any valid port</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User</td>
<td>any valid user</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>any valid password</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>External file name</td>
<td>any valid file</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tape</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RCMD</td>
<td>any valid site</td>
<td>SITE RDW</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Debug</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Input File Parameters</td>
<td>values for RECFM and LRECL parameters</td>
<td>RECFM=S370VB and LRECL=16384</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td>Discard</td>
<td>Terminate</td>
<td>Discard</td>
</tr>
</tbody>
</table>

**Table A3.22  Duplicate-Data Checking Parameters for the IBM DCOLLECT Adapter**

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### IBM EREP Staging and Duplicate-Data Checking Parameters

#### Table A3.23  Staging Parameters for the IBM EREP Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Suboptions</th>
<th>Values for Suboptions</th>
<th>Default Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose raw data input type</td>
<td>File (default)</td>
<td>Raw data input file</td>
<td>any valid file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FTP</td>
<td>Host</td>
<td>any valid host</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Port</td>
<td>any valid port</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>User</td>
<td>any valid user</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Password</td>
<td>any valid password</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>External file name</td>
<td>any valid file</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tape</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>RCMD</td>
<td>any valid site</td>
<td>SITE RDW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Debug</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>
### Parameters Supported for This Adapter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Suboptions</th>
<th>Values for Suboptions</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input File Parameters</td>
<td>values for RECFM and LRECL parameters</td>
<td></td>
<td>RECFM=S370VB and LRECL=16384</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td></td>
<td></td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Discard</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Table A3.24  Duplicate-Data Checking Parameters for the IBM EREP Adapter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>26:00</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**IBM SMF Staging and Duplicate-Data Checking Parameters**

*Table A3.25  Staging Parameters for the IBM SMF Adapter*

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Suboptions</th>
<th>Values for Suboptions</th>
<th>Default Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose raw data input type</td>
<td>File or directory (default)</td>
<td>Raw data input file or directory</td>
<td>any valid file or directory</td>
<td></td>
</tr>
<tr>
<td>FTP</td>
<td>Host</td>
<td>any valid host</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Port</td>
<td>any valid port</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User</td>
<td>any valid user</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>any valid password</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>External file name</td>
<td>any valid file</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tape</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RCMD</td>
<td>any valid site</td>
<td>SITE RDW</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Debug</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input File Parameters</td>
<td>values for RECFM and LRECL parameters</td>
<td>RECFM=S370V BS and LRECL=32760</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td>Discard</td>
<td>Terminate</td>
<td>Discard</td>
</tr>
<tr>
<td>JES</td>
<td>JES2</td>
<td>JES3</td>
<td>JES2</td>
<td></td>
</tr>
<tr>
<td>Presummari- zation duration</td>
<td>any integer greater than or equal to 1 and less than or equal to 2,147,483,647</td>
<td></td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
### Parameters Supported for This Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Suboptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use intermediate staging view</td>
<td>any valid staged table name</td>
<td></td>
</tr>
</tbody>
</table>

### Table A3.26 Duplicate-Data Checking Parameters for the IBM SMF Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>00:29</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### IBM TPF Staging and Duplicate-Data Checking Parameters

**Table A3.27  Staging Parameters for the IBM TPF Adapter**

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Suboptions</th>
<th>Values for Suboptions</th>
<th>Default Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose raw data input type</td>
<td>File (default)</td>
<td>Raw data input file</td>
<td>any valid file</td>
<td></td>
</tr>
<tr>
<td>FTP</td>
<td>Host</td>
<td>any valid host</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Port</td>
<td>any valid port</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User</td>
<td>any valid user</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>any valid password</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>External file name</td>
<td>any valid file</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tape</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RCMD</td>
<td>any valid site</td>
<td>SITE RDW</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Debug</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

**Input File Parameters**
- values for RECFM and LRECL parameters
- RECFM=S370V BS and LRECL=32760

**Future data**
- Accept
- Discard
- Terminate

**Table A3.28  Duplicate-Data Checking Parameters for the IBM TPF Adapter**

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameters Supported for This Adapter</td>
<td>Values</td>
<td>Default Value</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------</td>
<td>---------------</td>
<td>-------</td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard, Force, Terminate</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>01:00</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes, No</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
# IBM VMMON Staging and Duplicate-Data Checking Parameters

## Table A3.29  Staging Parameters for the IBM VMMON Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Suboptions</th>
<th>Values for Suboptions</th>
<th>Default Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose raw data input type</td>
<td>File (default)</td>
<td>Raw data input file</td>
<td>any valid file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FTP</td>
<td>Host</td>
<td>any valid host</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Port</td>
<td>any valid port</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>User</td>
<td>any valid user</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Password</td>
<td>any valid password</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>External file name</td>
<td>any valid file</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tape</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>RCMD</td>
<td>any valid site</td>
<td>SITE RDW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Debug</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Input File Parameters</td>
<td>values for RECFM and LRECL parameters</td>
<td>RECFM=F and LRECL=4096</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td></td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Discard</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Table A3.30  Duplicate-Data Checking Parameters for the IBM VMMON Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Staging Parameters for Supported Adapters

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>26:00</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### MS SCOM Staging and Duplicate-Data Checking Parameters

#### Table A3.31 Staging Parameters for the MS SCOM Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input library: Library and Libref'</td>
<td>any valid library and libref'</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Discard</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Table A3.32 Duplicate-Data Checking Parameters for the MS SCOM Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>01:05</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>Parameters Supported for This Adapter</td>
<td>Values</td>
<td>Default Value</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------</td>
<td>---------------</td>
<td>-------</td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**RRDtool Staging and Duplicate-Data Checking Parameters**

*Table A3.33  Staging Parameters for the RRDtool Adapter*

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input library or directory</td>
<td>any valid library or directory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>rsh/ssh host command</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>rrdtool executable</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>rrdtool fetch -start option</td>
<td></td>
<td>e-2days</td>
<td></td>
</tr>
<tr>
<td>rrdtool fetch -end option</td>
<td></td>
<td>time</td>
<td></td>
</tr>
<tr>
<td>Consolidation Function (CF)</td>
<td>any consolidation function</td>
<td>AVERAGE</td>
<td></td>
</tr>
<tr>
<td>Class columns</td>
<td>any class columns</td>
<td>filename datetime</td>
<td></td>
</tr>
<tr>
<td>Normalize datetime</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Discard</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Table A3.34  Duplicate-Data Checking Parameters for the RRDtool Adapter*

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameters Supported for This Adapter</td>
<td>Values</td>
<td>Default Value</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------</td>
<td>---------------</td>
<td>-------</td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>IDVAR</th>
<th>SAS variable</th>
<th>FILENAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>01:15</td>
</tr>
</tbody>
</table>

| KEEP   | any integer | 52 |
| REPORT | Yes | Yes |
|        | No | |

**SAP ERP Staging and Duplicate-Data Checking Parameters**

**Table A3.35**  Staging Parameters for the SAP ERP Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input library: Library and Libref</td>
<td>any valid library and libref</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Discard</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Presummarization duration</td>
<td>any integer greater than or equal to 1 and less than or equal to 2,147,483,647</td>
<td>3600</td>
<td></td>
</tr>
</tbody>
</table>
### Table A3.36  Duplicate-Data Checking Parameters for the SAP ERP Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>00:20</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>250</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### SAR Staging and Duplicate-Data Checking Parameters

### Table A3.37  Staging Parameters for the SAR Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input file or directory</td>
<td>any valid file or directory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of processors to use</td>
<td>any positive number</td>
<td>0, which means that all available processors are used</td>
<td>If 1, then MPConnect is not used and the staging code is run on a single processor.</td>
</tr>
<tr>
<td>Minimum number of files to read on each processor</td>
<td>any positive number</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Temporary work space library</td>
<td>WORK library, Staging library, Other library</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Library for temporary work space</td>
<td>any valid library</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept, Discard, Terminate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table A3.38  Duplicate-Data Checking Parameters for the SAR Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>01:15</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

SNMP Staging and Duplicate-Data Checking Parameters

Table A3.39  Staging Parameters for the SNMP Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Suboptions</th>
<th>Values for Suboptions</th>
<th>Default Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose raw data input directory</td>
<td>any valid directory</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>rsh host command</td>
<td>any valid command</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use snmpwalk to gather character data</td>
<td>Yes</td>
<td>snmpwalk executable</td>
<td>any valid executable</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>HostFile for snmpwalk</td>
<td>any valid file</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Community value for snmpwalk</td>
<td>any valid community name</td>
<td></td>
</tr>
<tr>
<td>No (default)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table A3.40  Duplicate-Data Checking Parameters for the SNMP Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Suboptions</th>
<th>Values for Suboptions</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose access command</td>
<td>HP NNM/Netview (default)</td>
<td>snmpColDUmp</td>
<td>any valid executable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RRDtool</td>
<td>RRDtool executable</td>
<td>RRDtool executable</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td>Discard</td>
<td>Force</td>
<td>Terminate</td>
<td>Any valid executable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td>Force</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Terminate</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>01:03</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>No</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**VMware Data Acquisition Parameters**

*Table A3.41  Staging Parameters for the VMware Data Acquisition Adapter*

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input library: Library and Libref</td>
<td>any valid library and libref</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Age limit for data acquisition table (in days)</td>
<td>a positive integer</td>
<td>7</td>
<td></td>
</tr>
</tbody>
</table>

*Note:* The VMWare Data Acquisition adapter does not support duplicate-data checking parameters.

**VMware vCenter Staging and Duplicate-Data Checking Parameters**

*Table A3.42  Staging Parameters for the VMware vCenter Adapter*

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input library: Library and Libref</td>
<td>any valid library and libref</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Discard</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Table A3.43  Duplicate-Data Checking Parameters for the VMware vCenter Adapter*

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Web Log Staging and Duplicate-Data Checking Parameters

**Table A3.44  Staging Parameters for the Web Log Adapter**

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input file</td>
<td>any valid file</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delimiter in raw data</td>
<td>Space, Comma, Tab</td>
<td>Space</td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Accept, Discard, Terminate</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td>Machine</td>
<td>any valid machine name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Site name</td>
<td>any valid site name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Presummarization duration</td>
<td>any integer greater than or equal to 1 and less than or equal to 2,147,483,647</td>
<td>3600</td>
<td></td>
</tr>
</tbody>
</table>
Table A3.45  Duplicate-Data Checking Parameters for the Web Log Adapter

<table>
<thead>
<tr>
<th>Parameters Supported for This Adapter</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes, No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard, Force, Terminate</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td>INT</td>
<td>time in the format hh:mm, where hh represents hours and mm represents minutes</td>
<td>08:00</td>
<td></td>
</tr>
<tr>
<td>KEEP</td>
<td>any integer</td>
<td>250</td>
<td></td>
</tr>
<tr>
<td>REPORT</td>
<td>Yes, No</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

User-Written Staging Parameters

Parameters on the Staging Option

The following table shows the parameters that are available from the Staging option of the Staging Parameters tab in the Properties dialog box of the staging transformation.

Table A3.46  Staging Parameters for User-written Staging Code

<table>
<thead>
<tr>
<th>Staging Parameters Supported</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw data input file or directory</td>
<td>any valid file or directory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future data</td>
<td>Discard, Accept, Terminate</td>
<td>Discard</td>
<td></td>
</tr>
</tbody>
</table>
### Parameters on the Duplicate Checking Option

The following table shows the parameters that are available from the **Duplicate Checking** option of the **Staging Parameters** tab in the Properties dialog box of the staging transformation.

**Table A3.47  Duplicate-Data Checking Parameters for User-Written Staging Code**

<table>
<thead>
<tr>
<th>Staging Parameters Supported</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable duplicate checking</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate checking options</td>
<td>Discard</td>
<td>Discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IDVAR variable for %RMDUPCHK macro</td>
<td>name of the SAS variable that identifies the system of machine that generated the input data</td>
<td>MACHINE</td>
<td></td>
</tr>
<tr>
<td>TIMESTMP variable for %RMDUPCHK macro</td>
<td>name of the SAS variable that contains the datetime stamp that uniquely identifies the time of the event or interval that is being recorded</td>
<td>DATETIME</td>
<td></td>
</tr>
<tr>
<td>ENDFILE variable for %RMDUPCHK macro</td>
<td>name of the SAS variable that is used as the END= keyword for the SAS INFILE statement that reads the raw data file</td>
<td>_eof</td>
<td></td>
</tr>
</tbody>
</table>
### Staging Parameters Supported

<table>
<thead>
<tr>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>INT variable for %RMDUPCHK macro maximum time gap (or interval) that</td>
<td>00:29</td>
<td>If the interval between the timestamp values exceeds the value of this parameter, then an observation with the new time range is created in the control data set. This is referred to as a gap in the data. The value for this parameter must be provided in the format hh:mm, where hh represents hours and mm represents minutes. For example, to specify an interval of 14 minutes, use INT=0:14. To specify an interval of 1 hour and 29 minutes, use INT=1:29.</td>
</tr>
<tr>
<td>is to be allowed between the timestamps on any two consecutive records</td>
<td></td>
<td></td>
</tr>
<tr>
<td>from the same system or machine.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>KEEP value for %RMDHPCHK macro number of weeks for which control data</td>
<td>0</td>
<td>Because this value represents the number of Sundays between two dates, a value of 2 (the default) results in a maximum retention period of 20 days.</td>
</tr>
<tr>
<td>is to be kept</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Parameters on the User-Written Option

The following table shows these parameters that are available from the User-Written option of the Staging Parameters tab in the Properties dialog box of the staging transformation. For a detailed description of the staging parameters specific to the User-written Staging transformation, see “Staging Parameters Tab” on page 266.

Table A3.48  User-Written Parameters for User-Written Staging Code

<table>
<thead>
<tr>
<th>User-Written Parameters Supported</th>
<th>Values</th>
<th>Default Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-written code</td>
<td>directory path and file</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>specification</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User-Written Parameters Supported</td>
<td>Values</td>
<td>Default Value</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------</td>
<td>---------------</td>
<td>-------</td>
</tr>
<tr>
<td>Generate a macro variable with input table name</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Generate macro variables with target table names</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Generate a macro with target table options</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Generate Tabinfo and Varinfo tables</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Generate a macro to create target table ATTRIB statements</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Generate a macro to create computed columns</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Generate a macro to create column lists</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Generate a macro to assign columns to missing</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
Appendix 4

Jobs That the Adapter Setup Wizard Creates for Domain Categories

The following table lists the domain categories that the Adapter Setup wizard enables you to select for each adapter. This table also shows whether the Adapter Setup wizard generates aggregation jobs, information map jobs, and reporting jobs for the domain category. The default name of each job contains the name of the adapter and the domain category that you specify with the Adapter Setup wizard.

<table>
<thead>
<tr>
<th>Adapter</th>
<th>Domain Categories and Descriptions in the Adapter Setup Wizard</th>
<th>Aggregation and Information Map Jobs</th>
<th>Reporting Jobs</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG TMON2CIC</td>
<td>None</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>ASG TMONDB2</td>
<td>None</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>BMC Mainview IMS</td>
<td>None</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
### Jobs That the Adapter Setup Wizard Creates for Domain Categories

<table>
<thead>
<tr>
<th>Adapter</th>
<th>Domain Categories and Descriptions in the Adapter Setup Wizard</th>
<th>Aggregation and Information Map Jobs</th>
<th>Reporting Jobs</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMC Perf Mgr</td>
<td>CacheWindows includes Patrol Cache performance measures for Windows.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>CpuUnix includes global CPU performance measures for UNIX.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>CpuWindows includes global CPU performance measures for Windows.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>DiskUnix includes disk performance measures for UNIX.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>FilesystemUnix includes Filesystem performance measures for UNIX.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>KernelUnix includes system kernel performance measures for UNIX.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>LogicalDiskWindows includes logical disk performance measures for Windows.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>MemoryUnix includes memory and paging performance measures for UNIX.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>MemoryWindows includes memory and paging performance measures for Windows.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>NetworkUnix includes network performance measures for UNIX.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>NetworkWindows includes network performance measures for Windows.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>PagingFileWindows includes paging file performance measures for Windows.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>PhysicalDiskWindows includes physical disk performance measures for Windows.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>ProcessUnix includes process performance measures for UNIX.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>SwapUnix includes swap performance measures for UNIX.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>SystemWindows includes system performance measures for Windows.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Adapter</td>
<td>Domain Categories and Descriptions in the Adapter Setup Wizard</td>
<td>Aggregation and Information Map Jobs</td>
<td>Reporting Jobs</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------------------------------------------------</td>
<td>-------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>CA TMS</td>
<td>None</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>DT Perf Sentry</td>
<td><strong>Exchange InfoStore</strong> includes storage measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Exchange InfoStoreMailbox</strong> includes mailbox storage measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Exchange InfoStorePrivate</strong> includes private storage measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Exchange InfoStorePublic</strong> includes public storage measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Exchange MailServer</strong> includes mail server measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Server Disk</strong> includes disk performance measures.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>Server Network</strong> includes network performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Server PagingFile</strong> includes paging file performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Server PhysicalFile</strong> includes physical disk performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Server ProcessorCpu</strong> includes processor CPU performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Server System</strong> includes system performance measures.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>DT Perf Sentry with MXG</td>
<td>None</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
### Jobs That the Adapter Setup Wizard Creates for Domain Categories

<table>
<thead>
<tr>
<th>Adapter</th>
<th>Domain Categories and Descriptions in the Adapter Setup Wizard</th>
<th>Aggregation and Information Map Jobs</th>
<th>Reporting Jobs</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Perf Agent</td>
<td><strong>Disk Unix</strong> includes disk performance measures for UNIX.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>Disk Windows</strong> includes disk performance measures for Windows.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>LogicalSystem Unix</strong> includes logical system performance measures for UNIX.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Network Unix</strong> includes network performance measures for UNIX.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Network Windows</strong> includes network performance measures for Windows.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>ProcessorCpu Unix</strong> includes processor CPU performance measures for UNIX.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>ProcessorCpu Windows</strong> includes processor CPU performance measures for Windows.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>System Unix</strong> includes system performance measures for UNIX.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>System Windows</strong> includes system performance measures for Windows.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Jobs That the Adapter Setup Wizard Creates for Domain Categories

<table>
<thead>
<tr>
<th>Adapter</th>
<th>Domain Categories and Descriptions in the Adapter Setup Wizard</th>
<th>Aggregation and Information Map Jobs</th>
<th>Reporting Jobs</th>
</tr>
</thead>
</table>
| HP Reporter     | **Disk Unix** includes disk performance measures for UNIX.  
**Disk Windows** includes disk performance measures for Windows.  
**LogicalSystem Unix** includes logical system performance measures for UNIX.  
**Network Unix** includes network performance measures for UNIX.  
**Network Windows** includes network performance measures for Windows.  
**ProcessorCpu Unix** includes processor CPU performance measures for UNIX.  
**ProcessorCpu Windows** includes processor CPU performance measures for Windows.  
**System Unix** includes system performance measures for UNIX.  
**System Windows** includes system performance measures for Windows.  
**IBM DCOLLECT** None  
**IBM EREP** None | Yes  
Yes  
Yes  
Yes  
Yes  
Yes  
Yes  
Yes  |
| IBM DCOLLECT    | None                                                                                                                                  | No                                   | No             |
| IBM EREP        | None                                                                                                                                  | No                                   | No             |
## Domain Categories and Descriptions in the Adapter Setup Wizard

### IBM SMF
- **CICS** includes CICS hourly summarized transaction activity and response time performance for ApplicationId and ApplicationIdTransactionId domain subcategories.
- **DB2 Batch** includes DB2 Batch environment activity and performance.
- **DB2 Cics** includes DB2 CICS environment activity and performance.
- **DB2 Ddf** includes DB2 DDF environment activity and performance.
- **DB2 Global** includes DB2 global activity and performance.
- **JOBS** includes batch job activity and performance.
- **OMVS** includes OMVS activity and performance.
- **RMF CecLpar** includes RMF LPAR performance by CEC.
- **RMF Device** includes RMF device performance.
- **RMF GoalModeService** includes RMF workload period performance such as CPU, memory, I/O, service, and response time.
- **RMF Lpar** includes RMF LPAR performance by system.
- **RMF PagingAndSwapping** includes legacy RMF system performance including memory, paging, and swapping.
- **RMF PagingFile** includes RMF Paging file performance.

### Reporting Jobs
- Yes
- No
<table>
<thead>
<tr>
<th>Adapter</th>
<th>Domain Categories and Descriptions in the Adapter Setup Wizard</th>
<th>Aggregation and Information Map Jobs</th>
<th>Reporting Jobs</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM SMF</td>
<td><strong>RMF Processor</strong> includes RMF CPU processor performance.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>RMF System</strong> includes RMF system performance such as CPU, memory, I/O, queuing, paging, and swapping.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>RMF Workload</strong> includes RMF workload performance using normalized structure such as CPU, memory, I/O, service, and response time.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>RMF WorkloadPeriod</strong> includes RMF workload and workload period performance.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>TSO</strong> includes TSO activity and performance.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>IBM TPF</td>
<td>None</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>IBM VMMON</td>
<td>None</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Adapter</td>
<td>Domain Categories and Descriptions in the Adapter Setup Wizard</td>
<td>Aggregation and Information Map Jobs</td>
<td>Reporting Jobs</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------</td>
<td>--------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>MS SCOM</td>
<td><strong>Exchange Disk</strong> includes Exchange server disk performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Exchange InfoStore</strong> includes storage measures.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>Exchange InfoStoreMailbox</strong> includes mailbox storage measures.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>Exchange InfoStorePublic</strong> includes public storage measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Exchange MailServer</strong> includes mail server measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Exchange Network</strong> includes Exchange server network performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Exchange Paging File</strong> includes Exchange server paging file performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Exchange PhysicalDisk</strong> includes performance measures for the physical disk on the Exchange server.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Server Disk</strong> includes disk performance measures.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>Server Network</strong> includes network performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Server Paging File</strong> includes paging file performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Server PhysicalDisk</strong> includes performance measures for the physical disk on the Windows server.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Server ProcessorCpu</strong> includes processor CPU performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Server System</strong> includes system performance measures.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Adapter</td>
<td>Domain Categories and Descriptions in the Adapter Setup Wizard</td>
<td>Aggregation and Information Map Jobs</td>
<td>Reporting Jobs</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------------------------------------------------</td>
<td>-------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>SAP ERP</td>
<td><strong>Batch</strong> includes SAP batch job activity and performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Host</strong> includes SAP hourly application server activity and performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>System</strong> includes SAP hourly system activity and performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>SystemHostTask</strong> includes SAP hourly system, application server, and task type activity and performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Task</strong> includes SAP hourly task type and elapsed time goal activity and performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Transaction</strong> includes SAP hourly transaction activity and performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Workload</strong> includes SAP workload activity and performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>SAR</td>
<td><strong>Disk</strong> includes disk performance measures.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>Network</strong> includes network performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>ProcessorCpu</strong> includes processor CPU performance measures.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>System</strong> includes system performance measures.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## Jobs That the Adapter Setup Wizard Creates for Domain Categories

<table>
<thead>
<tr>
<th>Adapter</th>
<th>Domain Categories and Descriptions in the Adapter Setup Wizard</th>
<th>Aggregation and Information Map Jobs</th>
<th>Reporting Jobs</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNMP</td>
<td>ICMP includes SNMP MIB2 ICMP data.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>IF includes SNMP MIB2 interface data.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>IPDevice includes SNMP MIB2 IP device data.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>System includes SNMP MIB2 system data.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>TCP includes SNMP MIB2 TCP data.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>UDP includes SNMP MIB2 UDP data.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>VMware vCenter</td>
<td>Guest Disk includes measures for VMware guest disk activity.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>VMware vCenter</td>
<td>Guest Network includes measures for VMware guest network activity.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>VMware vCenter</td>
<td>Guest Storage includes measures for VMware guest storage activity.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>VMware vCenter</td>
<td>Guest System includes measures for VMware guest system activity.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>VMware vCenter</td>
<td>Host Disk includes measures for VMware Host disk activity.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>VMware vCenter</td>
<td>Host Network includes measures for VMware host network activity.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>VMware vCenter</td>
<td>Host Storage includes measures for VMware host storage activity.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>VMware vCenter</td>
<td>Host System includes measures for VMware host system activity.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Jobs That the Adapter Setup Wizard Creates for Domain Categories

<table>
<thead>
<tr>
<th>Adapter</th>
<th>Domain Categories and Descriptions in the Adapter Setup Wizard</th>
<th>Aggregation and Information Map Jobs</th>
<th>Reporting Jobs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Log</td>
<td><strong>Browser Activity</strong> includes browser information about visiting clients by machine and browser name.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>Server Activity</strong> includes information about Web site activity and status codes by machine and site name.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>Visitor Organization Activity</strong> includes information about Web site visitors by country, state, domain, host, machine, organization, and organization type.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Web Page Activity</strong> includes information about Web page activity by machine, site name, status, and URL.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

For more information about the performance areas and staged tables that each domain category includes for reporting and analysis, see “Overview of the SAS IT Resource Management Data Model” on page 466.
Appendix 5

Duplicate-Data Checking

Duplicate-Data Checking Overview ........................................ 455
How Is Data Checked for Duplicates? ...................................... 456
Control Data Sets for Duplicate-Data Checking ......................... 457
   Types of Control Data Sets ........................................... 457
   Content of Permanent Control Data Sets ......................... 458
Working with Duplicate-Data Checking Macros ......................... 458
   About Working with Duplicate-Data Checking Macros .......... 458
How to Implement Duplicate-Data Checking from a Staging Transformation ..... 459
Additional Details for SAP ERP, MS SCOM, and HP Reporter Adapters ........ 460
Duplicate-Data Checking for User-Written Staging Code ............... 461
Examples ............................................................................ 461
   Example 1: Processing Data in a DATETIME Range for
      Which a DATETIME and IDVAR Was Already Processed .......... 461
   Example 2: Processing Data for Two IBM SMF Files ............. 461
   Example 3: Using Macro Variables to Subset Data for HP
      Reporter and MS SCOM Adapters ............................... 462
   Example 4: Using Macro Variables to Process Observations
      with Equal Timestamps ............................................. 462

Duplicate-Data Checking Overview

SAS IT Resource Management provides the ability to control whether duplicate data is
processed into the IT data mart. In this context, duplicate data is defined as data whose
datetime stamp is within a range of data that has already been processed into the IT data
mart for that machine or system. Starting with SAS IT Resource Management 3.3,
duplicate-data checking can be implemented through parameters that are set interactively
on the SAS IT Resource Management client. These parameters set up and call the
macros that manage the duplicate-data checking process. For information about
implementing duplicate-data checking from a staging transformation, see “How to
Implement Duplicate-Data Checking from a Staging Transformation” on page 459.
How Is Data Checked for Duplicates?

Four macros control the process of duplicate-data checking:

- `%RMDUPINT` loads macro definitions that are used by the other duplicate-data checking macros.
- `%RMDUPDSN` generates the name (WORK._DUPCNTL) of the temporary SAS data set that will contain datetime ranges for the data that is being processed into the active IT data mart. It also generates the name of the sourceAUDIT data set for duplicate checking.
- `%RMDUPCHK` checks for duplicate data by examining timestamps on data being read by the staging code. This macro also writes to the temporary control data set.
- `%RMDUPUPD` updates the permanent control data sets with information from a temporary control data set through the intermediate control data sets.

For more information about these duplicate-data checking macros, see “Introduction to the Macros in SAS IT Resource Management” on page 500.

Each of the duplicate-data checking macros performs a specific task. Together, these macros set up and manage duplicate-data checking. The macros are designed to check your data and to prevent duplicate data from being processed into the IT data mart. However, sometimes it is necessary to process data in a datetime range for which a machine's or system's data was already processed. For example, you might need to process data into a table that you did not use earlier or that you accidentally deleted. You can specify that the data is acceptable even though it appears to be duplicate data.

As raw data is being read, one of the macros that performs duplicate-data checking reviews the datetime information in each record. It then stores the information in a SAS data set called a temporary control data set. Later, by using intermediate control data sets, another macro merges the information in the temporary control data set into one or more SAS data sets that are called permanent control data sets.

When additional data is processed into the IT data mart, the timestamps of the incoming data are compared with the datetime information in the permanent control data sets in order to determine whether the new data has already been processed. If it has, the duplicate data is handled in the way that you specify.

A duplicate-data report is printed in the SAS log after the data is read. The report describes how many records were read for each machine or system and how many duplicates were found, if any. (If you specified Report = No on the Duplicate Checking page of the Staging Parameters tab of the staging transformation, this information is written to the sourceAUDIT file.)

Note: The first time you run a job with duplicate-data checking enabled, the permanent control data sets have not been built, so the macro `%RMDUPCHK` cannot check the input records. Your data is not checked or rejected for duplicates, but the permanent control data sets are created and the datetime information for this data is saved to them. Data is checked only on the datetime, although SMF data is also checked for the system name. (For example, if you try to add a new record type, but you have already read other record types from that adapter for that time period, the records are not kept.) The duplicate-data report contains only a limited amount of information about your data.
Control Data Sets for Duplicate-Data Checking

Types of Control Data Sets

Control data sets (temporary, intermediate, and permanent) are the basis on which duplicate data is rejected. The following section describes how the control data sets are created, used, updated, and stored.

- Temporary control data sets

When input data is processed, the %RMDUPCHK macro creates a temporary control data set, WORK._DUPCNTL, which stores information about the raw data from one or more adapters. Specifically, for each machine or system that generated data, the temporary control data set stores the datetime ranges and record counts in the raw data. If raw data from more than one data source is processed in the same job, then information is appended to the temporary control data set with each execution of the %RMDUPCHK macro.

- Intermediate control data sets

When all the input data has been read and stored in the temporary control data set, the %RMDUPUPD macro writes the data from the temporary control data set, WORK._DUPCNTL, to separate intermediate data sets, which are located in the staging library for that staging job.

Note: The first time a staging table is added to a staging transformation, a library is created to contain the control data information for all the staged tables that are created by that staging transformation. It is called adapter-nameStagingnnn, where nnn is a random number that ensures that the library name is unique within the IT data mart. For example, a library name might be DT Perf Sentry Staging 8926. (This library also contains other types of data.) If all the staged tables that are created by that staging transformation are subsequently deleted, and one or more new staged tables are added to the transformation, then a new library is created for the new staged tables. The first library that was created (for the original staged tables) is not used again. It is not automatically deleted, but you can delete it.

If the data set exists, then the data set is used and the new data overwrites the old data. Otherwise, the data set is created and the new data is written to that data set.

- Permanent control data sets

The data in the intermediate control data sets is then merged by %RMDUPUPD into the corresponding permanent control data sets, which are named sourceCNTRL in the staging library for that staging job. The permanent control data sets are stored and maintained in the staging library. One permanent control data set, named sourceCNTRL, can exist for each adapter. Each data set contains information about that adapter's machines or systems, datetime ranges, and record counts.

If a sourceCNTRL data set exists, the new data is merged into it. Otherwise, the data set is created and the new data is written to that data set.

The permanent sourceAUDIT data set contains one observation for each ID column (such as MACHINE) and the number of new and potentially duplicate records that were processed.
Content of Permanent Control Data Sets

The content of the permanent control data sets is based on intervals and ranges in your data. The INT= parameter flags datetime gaps. When you specify the INT= parameter in %RMDUPCHK, you define the maximum gap allowable between records in the same range. If the gap between datetimes for two consecutive records exceeds this value, then a new range is created.

A range is deleted when the end-of-range datetime value is older than the number of weeks that are specified in the KEEP= parameter in %RMDUPCHK. However, if your data is continuous, then you have only one range. Your control information is never deleted because the end-of-range datetime value is constantly extended by new datetime information.

Here are the ways that ranges are used with continuous and non-continuous data:

- If your data is continuous and does not have any datetime gaps that exceed the value of the INT= parameter, then your data always updates the same range. In this case, the permanent control data set contains one range for each unique value of the variable that is specified by the IDVAR= parameter. The values of that variable are typically the machine or system names from which the raw data originated. (Only the CSV, RRDtool, and user-written adapters require you to enter this parameter.)

- If your data is not continuous, then the permanent control data set contains multiple ranges for each unique value of the variable that is specified by the IDVAR= parameter. Each range is prefixed with a value of the variable that is specified by the IDVAR= parameter.

Note: For the HP Reporter and VMware adapters, one set of control data sets is created for each table by default. You can create just one set of control data sets for these adapters. To do so, specify a three-character identifier in the SOURCE= parameter of the %RMDUPCHK macro. SAS IT Resource Management then prefixes that identifier to the control data set.

Working with Duplicate-Data Checking Macros

About Working with Duplicate-Data Checking Macros

If you are using a test environment and staging new data for a new data source for the first time, you might not want to implement duplicate-data checking macros. To do so, on the Duplicate Checking page of the Staging Parameters tab of the staging transformation, set the Enable duplicate checking field to No. This setting provides more flexibility as you process different types of sample files. When you are satisfied with the results of your tests, you can purge the IT data mart. You can also choose whether to implement duplicate-data checking by specifying parameters in the staging transformation.

Note: If you edit the generated source code to modify the mode for duplicate-data checking, then your changes to the code are lost if the job is regenerated or redeployed. Although you can save the functionality of the source code to the local file system, the original source code is preserved. In addition, the mode for duplicate-data checking is not updated in the SAS Metadata Repository entries.
How to Implement Duplicate-Data Checking from a Staging Transformation

To implement duplicate-data checking, perform the following steps:

1. Right-click the staging transformation and select **Properties**.
2. On the Properties dialog box, select the **Staging Parameters** tab.
3. On the Duplicate Checking page, ensure that the **Enable duplicate checking** field is set to **Yes**. This setting enables you to specify the parameters that govern the duplicate-data checking process.

   *Note:* The SNMP adapter requires that duplicate checking be turned on. This setting is necessary because neither method of gathering raw data for SNMP (HPNNM and RRDtool) can ensure that only the most recent raw data is saved. Therefore, invoking the duplicate-data checking code of SAS IT Resource Management is the only way to determine what is new data and what is duplicate data.

   If you do not want to implement duplicate-data checking, set the **Enable duplicate checking** field to **No**. This setting makes the duplicate-data checking parameters unavailable.

4. Specify the following parameters:

   - **Duplicate checking option**
     specifies how duplicate data is handled. Select one of the following options:

     **TERMINATE**
     stops processing if duplicate data is encountered.

     **DISCARD**
     continues processing while rejecting duplicate data if it is encountered. This is the default value for this parameter.

     *Note:* For best results, the value for the **Duplicate checking option** parameter for the SNMP adapter should always be set to **Discard**.

     **FORCE**
     continues processing and accepts duplicate data if it is encountered.

     *Note:* Duplicate-data checking macros are designed to prevent the same data from being processed into the IT data mart twice. However, sometimes you might need to backload data. **Backloading** data means to process data that is in a datetime range for which the permanent control data sets have already recorded machine or system data. (For example, you might need to process data into one or more tables that you did not use earlier. You might also need to process data into one or more tables that you accidentally purged or deleted.) Make sure you restore the **Duplicate checking option** setting to its original value after you finish the backloading task.

   - **IDVAR**
     identifies the SAS variable that is used to denote the origin of each incoming record.

     *Note:* This parameter is visible only for the CSV, RRDtool, and user-written adapters.
Appendix 5 • Duplicate-Data Checking

- **INT**
  
  specifies the maximum time gap (or interval) that is allowed between the timestamps on any two consecutive records from the same system or machine. If the interval between the timestamp values exceeds the value of this parameter, then an observation with the new time range is created in the control data set. This is referred to as a **gap** in the data.

  The value for this parameter must be provided in the format **hh:mm**, where **hh** represents hours and **mm** represents minutes. For example, to specify an interval of 14 minutes, use **INT=0:14**. To specify an interval of 1 hour and 29 minutes, use **INT=1:29**.

- **Keep**
  
  specifies the number of weeks for which control data are kept. Because this value represents the number of Sundays between two dates, a value of 2 results in a maximum retention period of 20 days. This value must be an integer.

- **Report**
  
  The **REPORT** parameter specifies whether to display the duplicate-data checking messages in the SAS log or to save the messages in an audit table. If set to **Yes**, this parameter displays all the messages from duplicate-data checking in the SAS log. If set to **No**, the duplicate-data checking messages are saved in an audit data table that is stored in the staging library. The name of the audit table is **sourceAUDIT** (where **source** is the 3-character data source code).

  *Note:* If you are monitoring very high numbers of resources, setting this option to **No** can be beneficial. Eliminating the report reduces CPU consumption, shortens elapsed time, and makes the SAS log more manageable.

  *Note:* Prior to SAS IT Resource Management 3.3, you were required to create catalog entries or files in the MXG source library of your operating system in order to handle duplicate-data checking. Although these members or files are no longer necessary, if they exist, SAS IT Resource Management continues to honor them. However, it is preferable to manage duplicate-data checking by specifying the appropriate values on the staging transformation.

#### Additional Details for SAP ERP, MS SCOM, and HP Reporter Adapters

The staging code for the SAP ERP, MS SCOM, and HP Reporter adapters is designed to read in only those rows in the input database that were not previously staged. Even though the staged table is overwritten each time a staging job is executed, a record is kept of the data that was read. This ensures that only new data is read when the staging job is run.

The control data sets determine the raw data observations that should be staged. If the control data sets do not exist when the staging job is executed, then all of the data in the input database is staged.

The staging code for the SAP ERP, MS SCOM, and HP Reporter adapters always uses the control data sets so that only new data is staged. Therefore, the duplicate-data checking option is activated by default for these adapters. All subsequent staging jobs that specify that adapter's staging library location use that library's control data sets.
Note: You can temporarily turn off the duplicate-data checking option by modifying the generated SAS code. For an example, see “Example 3: Using Macro Variables to Subset Data for HP Reporter and MS SCOM Adapters” on page 462.

Duplicate-Data Checking for User-Written Staging Code

If you are using user-written staging code, you need to place the calls to the %RMDUPINT, %RMDUPDSN, %RMDUPCHK, and %RMUPUPD macros in the staging code. For information about how to implement duplicate checking of your data, see “Duplicate Checking” on page 274.

Examples

Example 1: Processing Data in a DATETIME Range for Which a DATETIME and IDVAR Was Already Processed

This example describes how to process data into a table that was not used earlier or that is in a table that was accidentally deleted.

To process data in a datetime range for which a particular DATETIME and IDVAR variable was already processed, select a value of FORCE for the Duplicate checking options parameter. (That parameter is located on the Duplicate Checking page of the Staging Parameters tab of the staging transformation.) The parameter specifies that the data is accepted, even though it appears to be duplicate data.

Example 2: Processing Data for Two IBM SMF Files

This example describes how to process data for two separate IBM SMF files. In this example, a site has two separate IBM SMF contiguous data sets for the same IDVAR variable. It attempts to stage them into a supplied SAS IT Resource Management table. The first IBM SMF input file covers a datetime stamp range from 9:00 a.m. to 10:00 a.m.; the second contains a range from 10:00 a.m. to 11:00 a.m.

In addition, the following conditions apply to this example:

• The Duplicate checking option parameter is set to DISCARD for both jobs.
• The records that describe the last IBM SMF interval are split across the two SMF data sets.
• Both of these IBM SMF files are processed for the same IT data mart.
• A 15-minute IBM SMF interval is being used—for example, an interval that starts at 9:45 a.m. and ends at 9:59:59 a.m. The RMF 70-79 records that describe all the statistics in this same interval are partially written in the first data set. When the SYS1.MAN1 data set is full, the RMF 70-79 records that start at 9:59:59 a.m are written in the SYS1.MAN2 data set.
• Each time an IBM SMF file is read, the data is processed into SAS IT Resource Management and aggregated.

There are two methods that you can use to process this data:
• Load all IBM SMF data into a single job, concatenating the two IBM SMF data sets. This is the preferred method because no data is lost.

• Load IBM SMF data in two unique JCL steps or batch jobs. Each job should read one IBM SMF file at a time.

Note: In each method, the first IBM SMF data set is loaded into the IT data mart. The duplicate-data checking macros mark the data as correctly loaded from 9:45:00 a.m. to 9:59:59 a.m. However, the second method processes the SMF data files individually. Those records that match the DATETIME and IDVAR parameters that range from 9:45:00 a.m. to 9:59:59 a.m. are considered duplicates and are discarded.

Example 3: Using Macro Variables to Subset Data for HP Reporter and MS SCOM Adapters

The staging transformations for the HP Reporter and MS SCOM adapters do not provide a parameter for duplicate-data checking. Duplicate-data checking is always enabled for these adapters. SAS IT Resource Management provides two macro variables that enable you to subset data for the HP Reporter and MS SCOM adapters: ITRM_LoadFromDate and ITRM_LoadToDate. These macro variables enable you to override the default action of subsetting the incoming data based on the duplicate-data control data sets.

The ITRM_LoadFromDate and ITRM_LoadToDate macro variables can be used in the following situations:

• to backload data into tables that are added to a staging job after it has already run once against a given set of data

Note: Only the data for HP Reporter and VMware adapters can be backloaded. MS SCOM data cannot be backloaded.

• to specify a datetime range to use during staging to extract only the data from the input database whose datetime stamps fall within the specified range.

Note: When the ITRM_LoadFromDate and ITRM_LoadToDate macro variables are set, the duplicate-data checking code is still executed. SAS IT Resource Management discards any data that is detected as duplicates.

The following code sets the ITRM_LoadFromDate and ITRM_LoadToDate macro variables to valid start and end datetime values. These values are used to subset the data from the database instead of the ranges in the duplicate-data control data sets. This code should be added to the generated code or to the deployed job code for the staging job:

```sas
%let ITRM_loadFromDate=14FEB2010:00:00:00;
%let ITRM_loadToDate=15FEB2010:23:59:00;
```

Example 4: Using Macro Variables to Process Observations with Equal Timestamps

The duplicate checking process discards an observation whose timestamp value is less than or equal to the upper limit of a datetime range. However, in some cases, SMF records with exactly the same datetime stamp are split across tapes. In these circumstances, the first few records of the second tape would be discarded because they match the criteria of being less than or equal to the upper limit of an existing datetime range.

The following two macro variables can be used to remedy this situation:
• **CPDUP_ALLOW_EQ**

  When set to **Yes**, this macro variable specifies whether observations with equal timestamp values can be processed when they are the first records processed for the value that is specified in the IDVAR parameter. The default value for this macro variable is **No**.

• **CPDUP_ALLOW_MSG**

  This macro variable specifies whether messages should be produced when both of the following conditions are met:
  
  • **CPDUP.Allow_EQ** is set to **Yes**.
  
  • observations with equal timestamps are encountered.

  The default value for this macro variable is **No**.

  The following text shows the format of the messages that are produced:

  Potential duplicate has been processed \_n\_=<observation number> system=<system name> smftime=<SMF timestamp>

  To set these macro variables, add the following statements to the beginning of the batch job:

%let CPDUP_ALLOW_EQ=YES;
%let CPDUP_ALLOW_MSG=YES;

  The following text is an example of the messages that might be produced:

  Potential duplicate has been processed \_n\_=28833 SYSTEM=ABC1 ID=30 SMFTIME=17MAR2012:01:00:00

  **Note:** If the macro variables are not specified in the batch job, their absence is interpreted as **No**.
# Appendix 6
## Data Model

### Overview of the SAS IT Resource Management Data Model
- About the SAS IT Resource Management Data Model
- Features of the SAS IT Resource Management Data Model
- Data Model Staging and Aggregation General Concepts
- Data Model Aggregation Table Groups and Time Periods
- Data Model Aggregation Key and Ranked Metrics

### Data Model Adapter and Domain Category Specifications
- BMC Perf Mgr Adapter - BMC Perf Mgr Domain Category
- DT Perf Sentry Adapter - DT Perf Sentry Server-Based Domain Categories
- DT Perf Sentry Adapter - DT Perf Sentry Exchange Domain Category
- HP Perf Agent and HP Reporter Adapters
- MS System Center Operations Manager Adapter - MS SCOM
  - Exchange Domain Category
- MS System Center Operations Manager - MS SCOM Server-Based Domain Categories
- SAPR3 Adapter - Systems, Machines, Tasks, and Transactions
- SAPR3 Adapter - SAPBTCH (Batch Job) and SAPWKLD (Workload)
- SAR Adapter - SAR Domain Category
- SMF Adapter - RMF Domain Category
- SMF Adapter - Jobs, TSO, and OMVS Domain Categories
- SMF Adapter - CICS Domain Category
- SMF Adapter - DB2 Domain Category
- SNMP Adapter - Network Activity, Device and Interface
  - Data, and System Data
- VMware Adapter - Guest and Host Disk, Network, and System Domain Categories
- Web Log Adapter - All Domain Categories

### What Are Key Metrics?

### Key Metrics for the Server Performance Domain Category
Overview of the SAS IT Resource Management Data Model

About the SAS IT Resource Management Data Model

The data model that is supplied for those adapters that are supported by SAS IT Resource Management provides a rich set of measures. The data model is fully documented on the product documentation page: http://support.sas.com/documentation/onlinedoc/itsv/zipfiles/HTMLDoc_3.3/DataModel.html. At this site, the SAS IT Resource Management data model can be interactively navigated, including all of the stage and aggregation (domain category) tables. For each staged table, data and computed columns along with the attributes of each can be reviewed. For each aggregation table, the staged data from which the aggregation was created; the properties of the aggregation; and the attributes of each of the class, ID, statistic, rank, and computed columns can be reviewed.

Reports that are built with this data model are supplied with the solution. Samples of reports are located here: http://support.sas.com/documentation/onlinedoc/itsv/zipfiles/HTMLDoc/Reports.html.

TIP When designing a user-written adapter, you should review and follow the column labeling scheme of the supplied data model as closely as possible. This practice enables you to copy and reuse those reports in support of your user-written data source. For more information about this topic, see “User-Written Staging Transformations” on page 265.

The data model supports a number of data sources from computer system hardware, operating system software, networks, Web servers, databases, and applications on z/OS, Windows, and UNIX platforms. Distinct data sources are characterized as adapters in SAS IT Resource Management terminology.

Features of the SAS IT Resource Management Data Model

The following characteristics are available from the SAS IT Resource Management data model for all of the supported adapters:

- Column labeling is standardized to make the data model meaningful and consistent across adapters in SAS IT Resource Management objects, including template tables, staged tables, aggregation tables, and information maps. Labels are coded for easier viewing and to shorten total label length, making them easier to understand. In most cases, columns with similar meaning in different adapters are named with a similar label in order to promote more consistency in classification and metric names across adapters. In most labels, the name incorporates the respective domain category.

- A significant number of computed columns are added to the data model. Computations for computed columns are often simply represented as an RVALUE expression. However, there are some computed columns that include multiple SAS statements in the expression. In addition to these supplied computed columns, users can extend the function of the data model by adding their own computed columns.

- Supplied computed columns include the following areas of functionality:
  - standard date and time derivations that are based on the source datetime found in the raw data.
• normalized columns that convert lowest common denominator units into industry standard data representations. These normalizations include the following conversions:
  • bytes to kilobytes, megabytes, and gigabytes
  • seconds to milliseconds
  • bits to megabits
  • service units to MSU (millions of service units)
  • percentages between 0 and 1 to percentages between 0 and 100
  • generation of a total value from several disparate parts—for example, input + output, read + write, received + sent, and so on.
  • generation of a column that contains a value that is the opposite of an already existing column. This conversion highlights the variance in the usage of a resource in contrast to the availability of the same resource.
  • generation of event counters to count individual events and enable them to be easily summarized when aggregating the data.
  • generation of new classification columns when an individual instance of a performance metric needs to be separated from the global instance. This enables the global and individual instances to be aggregated separately.
  • conversion of raw counts to rate-based values.
  • calculation of buckets for counts and percentages that are associated with ranges of response time.

• Formulas are also available in the data model. In SAS IT Resource Management, formulas are reusable shared expressions for use with computed columns. Supplied SAS IT Resource Management formulas are frequently used to set the values for date-based and time-based computed columns that are included in the data model.

• The most suitable national language support (NLS) format is used for many supplied columns in the data model. Therefore, a large percentage of columns is ready for formatting in multiple languages. However, some time-based columns that focus on accumulations of time and other columns already using specialized formats have not been converted to NLS. The reason for this is that there is currently not an acceptable equivalent NLS format.

Data Model Staging and Aggregation General Concepts

The process of staging data is required in order to prepare raw data and to create data extracts in SAS data set format. Staging is an intermediate step that is performed before the creation of aggregations in the SAS IT Resource Management data model. (Existing staged data is overwritten for each new iteration of the staging process.) The SAS IT Resource Management data model is based on aggregations. Aggregations are created to provide report-ready data that can be easily input into an information map. An information map is a map that enables the aggregated data to be available for several SAS reporting clients, including SAS Enterprise Guide, SAS Web Report Studio, and SAS OLAP Cube Studio.

Note: The following information describes the aggregations that are generated by means of the Adapter Setup wizard. The information does not necessarily apply to all aggregations in general.
Aggregated data tables in the SAS IT Resource Management data model have the following structures and properties associated with them:

- The name of the aggregation table consists of a concatenation of a time period and a descriptive string. The descriptive string represents a domain category in a mixed-case format that uses uppercase letters to signify the beginning of a new word. For example, the name of an aggregation table might be one of the following: DayHourCpu or MonthJobSummary.
- The aggregation table has an aging limit specified in days.
- The time period for aggregated data is represented by one or more columns in the classification list.
- The aggregated data contains one or more classification columns. Some of these columns are time-based and other columns are not based on time.
- The aggregated data might contain one or more ID columns.
- The aggregated data contains one or more statistics. Statistics can be weighted or unweighted, depending on the nature of the performance metric. Weighting is typically by duration of time or by a counter that indicates a number of events. Weighting columns are explicitly specified in SAS IT Resource Management.
- The aggregated data can contain one or more ranked metrics. Each ranked metric can be based on a class or ID variable or on a statistic.
- The aggregated data can contain one or more computed columns. These columns can use any aggregated data as sources for their calculations.
- Filters can be used both to keep only appropriate data, and to reduce the volume of the aggregation table’s output data.

**Data Model Aggregation Table Groups and Time Periods**

Aggregation tables in the data model are grouped into aggregation table groups. Multiple aggregation table groups can be defined within an adapter’s domain category. An aggregation table group is a set of aggregation tables that contain a set of classification columns that are identical, except for the time period classification columns. The time periods vary among the aggregation tables in the aggregation table group.

For example, in an aggregation table group that is based on Memory, the aggregation tables are named DayMemory, DayHourMemory, DayShiftMemory, MonthMemory, MonthHourMemory, MonthShiftMemory, and XMinMemory. (XMinMemory signifies aggregation tables that are based on sub-hourly memory activity). Typical time periods that can be represented in an aggregation table are datetime, hour, shift, day, week, and month. An aggregation table can focus on a single time period, such as datetime, day, week, or month. Alternatively, it can include multiple time periods such as day and hour or day and shift. An aggregation table that uses the datetime period typically focuses on time intervals that are less than a full hour. Aggregation tables that focus on day, week, month, hour, and shift time periods work with time periods of an hour or more.

**Data Model Aggregation Key and Ranked Metrics**

The SAS IT Resource Management data model provides metrics that are identified as key or ranked metrics. Key and ranked metrics are primarily the same metrics within the adapters, but they are handled differently depending on the type of aggregation that they are used in.
Key metrics are metrics that are output to a key metrics aggregation table. A key metrics aggregation table usually includes the term “KeyMetrics” in its name (for example, KeyMetricsMemory). The intent of the key metrics aggregation table is to keep a limited set of important performance metrics for a long period of time. This tactic facilitates better capacity planning and forecast reporting. Wherever appropriate, key metrics are standardized across adapters. Key metrics are not ranked. Only one statistic is specified for a key metric in a key metrics aggregation table. For specific information about the key and ranked metrics for an adapter and domain category, see “What Are Key Metrics?” on page 484.

Note: For some adapter and domain combinations, such as the SMF adapter and the RMF, CICS, DB2, Jobs, TSO, and OMVS domain categories, the key metrics also provide the ability to filter on the top or bottom rated resource values within a set of classification values. The latter ranking filters are very useful to limit the number of reports that are created to those classifications with the greatest or the least resource utilization.

Ranked metrics are metrics within an aggregation table for which ranking is done. Metrics can be ranked in any aggregation tables. Ranked metrics are based on statistics. Typically, only the most meaningful statistic is ranked.

Both metrics and date classifications can be ranked using either ascending or descending criteria that is based on a list of classifications that are specified for the ranking of the available data.

There are several distinct types of aggregation processing strategies that are available for the supported adapters and domain categories in the data model. Each SAS IT Resource Management supplied adapter can have one or more domain categories that are associated with it. Domain categories have been created that enable users to group source data that should have data staged and aggregated together for reporting purposes.

Data Model Adapter and Domain Category Specifications

BMC Perf Mgr Adapter - BMC Perf Mgr Domain Category

About the BMC Perf Mgr Adapter - BMC Perf Mgr Domain Category
The domain categories for this adapter use the server activity strategy for the staging and aggregating of data. A SAS IT Resource Management staging transformation is used in staging the data.

The staged tables for this adapter are input to a series of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, monthly, and sub-hourly time periods. Hourly and shift-based activity is included in a number of these aggregation tables. Filters that query the CPU instance are used to divide aggregation tables that contain global CPU measurements from those that contain individual CPU processor measurements.

Key Classifications in the BMC Perf Mgr Domain Category
The following key classifications are found in this domain category:

- System (Machine)
- CPU ID
Focus of Report-Ready Data for the BMC Perf Mgr Adapter

Report-ready data for this adapter focuses primarily on the following areas:

- utilization of CPU, memory, queuing, cache, paging, and swapping on the global server level
- utilization of CPU for individual CPU processors
- utilization, response times, transfer rates, and wait and queuing for physical disks
- utilization of space for file systems
- packet and data volume transfer activity, utilization, and queuing for network interfaces

DT Perf Sentry Adapter - DT Perf Sentry Server-Based Domain Categories

About the DT Perf Sentry Adapter - DT Perf Sentry Server-Based Domain Categories

The domain categories for this adapter represent a subset of data collected by Performance Sentry software that is available from Demand Technology Software. They focus on server-level activity and performance on the Windows platform. These adapter and domain category combinations use the server activity strategy for the staging and aggregating of data. A SAS IT Resource Management staging transformation is used in staging the data.

The staged tables for this adapter are input to a series of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, monthly, and sub-hourly time periods. Hourly and shift-based activity is included in a number of these aggregation tables.

Key Classifications in the DT Perf Sentry Server-Based Domain Categories

The following key classifications are found in these domain categories:

- Domain
- System (Machine)
- CPU ID
- Disk ID
- Network Interface

Focus of Report-Ready Data for the DT Perf Sentry Adapter - DT Perf Sentry Server-Based Domain Categories

Report-ready data for these adapter and domain combinations focuses primarily on the following areas:

- utilization of CPU, memory, queuing, cache, and paging on the global server level
DT Perf Sentry Adapter - DT Perf Sentry Exchange Domain Category

About the DT Perf Sentry Adapter - DT Perf Sentry Exchange Domain Category
The domain categories for this adapter represents a subset of data that is collected by Performance Sentry software, which focuses on Microsoft Exchange server activity and performance on the Windows platform. This adapter and domain category combination uses the server activity strategy for the staging and aggregating of data. A SAS IT Resource Management staging transformation is used in staging the data.

The staged tables for this adapter are input to a series of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, monthly, and sub-hourly time periods. Hourly and shift-based activity is included in a number of these aggregation tables.

Key Classifications in the DT Perf Sentry Exchange Domain Category
The following key classifications are found in this domain category:

- Domain
- System (Machine)
- Information Store ID
- Mail Server ID

Focus of Report-Ready Data for the DT Perf Sentry Adapter - DT Perf Sentry Exchange Domain Category
Report-ready data for this adapter and domain combination focuses primarily on the following areas:

- Remote Procedure Call (RPC) response times, transfer rates, and request and operation rates at the global Exchange server level
- total and active user counts at the global Exchange server level
- virtual memory utilization at the global Exchange server level
- delivered, sent, and submitted messages and receive and send queue lengths for mailboxes and public and private information stores
- message rates, data transfer rates, and queue lengths for Exchange mail servers
**HP Perf Agent and HP Reporter Adapters**

**About the HP Perf Agent and HP Reporter Adapters**

The domain categories for the HP Perf Agent and HP Reporter adapters focus on server level activity and performance on the UNIX and Windows platforms. Recent changes were made to data collection by HP Perf Agent and HP Reporter. As a result, it is possible to monitor the performance of logical systems that are configured as virtual guests of host servers. These adapters provide some support of the new technology of virtualization. Operating environments that are currently supported for virtualization are HP Virtual machines, AIX LPARs, and VMWARE ESX guests on Linux. These adapters use the server activity strategy for the staging and aggregating of data. A SAS IT Resource Management staging transformation is used in staging the data.

The staged tables for this adapter are input to a series of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, monthly, and sub-hourly time periods. Hourly and shift-based activity is included in a number of these aggregation tables. Filters that query the operating system are used to divide aggregation tables that contain UNIX platform performance measurements from those that contain Windows platform performance measurements.

**Key Classifications for the HP Perf Agent and HP Reporter Adapters**

The following key classifications are found for these adapters:

- System (Machine)
- CPU ID
- Disk ID
- Network Interface
- Logical System ID
- Logical System name

**Focus of Report-Ready Data for the HP Perf Agent and HP Reporter Adapters**

Report-ready data for these adapters focuses primarily on the following areas:

- utilization of CPU, memory, queuing, paging, swap, disk, and network on the global server level
- utilization of CPU for individual CPU processors
- utilization, response times, transfer rates, and wait and queuing for physical disks
- packet and data volume transfer activity, utilization, queuing, and error rates for network interfaces
- utilization of CPU and memory for logical systems to determine the share of resource utilization for the virtual guests associated with host servers
**MS System Center Operations Manager Adapter - MS SCOM Exchange Domain Category**

**About the MS System Center Operations Manager Adapter - MS SCOM Exchange Domain Category**

This domain category represents a subset of data that is collected by a Microsoft product called System Center Operations Manager, which focuses on Microsoft Exchange server activity and performance on the Windows platform. This adapter and domain category combination uses the server activity strategy for the staging and aggregating of data. A SAS IT Resource Management staging transformation is used in staging the data.

The staged tables for this adapter are input to a series of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, monthly, and sub-hourly time periods. Hourly and shift-based activity is included in a number of these aggregation tables.

**Key Classifications in the MS SCOM Exchange Domain Category**

The following key classifications are found in this domain category:

- System (Machine)
- Information Store ID
- Mail Server ID

**Focus of Report-Ready Data for the MS SCOM Manager Adapter - MS SCOM Exchange Domain Category**

Report-ready data for this adapter and domain combination focuses primarily on the following areas:

- Remote Procedure Call (RPC) response times, transfer rates, and request and operation rates at the global Exchange server level
- Total and active user counts at the mailboxes' information stores
- Delivered, sent, and submitted messages and receive and send queue lengths for mailboxes' information stores

**MS System Center Operations Manager - MS SCOM Server-Based Domain Categories**

**About the MS System Center Operations Manager - MS SCOM Server-Based Domain Categories**

The domain categories for this adapter represent a subset of data collected by a Microsoft product called System Center Operations Manager. They focus on server-level activity and performance on the Windows platform. These adapter and domain category combinations use the server activity strategy for the staging and aggregating of data. A SAS IT Resource Management staging transformation is used in staging the data.

The staged tables for this adapter are input to a series of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, monthly, and sub-hourly time periods. Hourly and shift-based activity is included in a number of these aggregation tables.
Key Classifications in the MS SCOM Server-Based Domain Categories

The following key classifications are found in this domain category:

- System (Machine)
- CPU ID
- Disk ID
- Network Interface
- Paging File ID

Focus of Report-Ready Data for the MS SCOM Adapter - MS SCOM Server-Based Domain Categories

Report-ready data for this adapter and domain combination focuses primarily on the following areas:

- utilization of CPU and memory the global server level
- utilization, response times, transfer rates, and wait and queuing for logical and physical disks

SAPR3 Adapter - Systems, Machines, Tasks, and Transactions

About the SAPR3 Adapter - Systems, Machines, Tasks, and Transactions Domains

SAP R/3 performance data is collected by using the SAS IT Management Adapter for SAP in conjunction with SAS/ACCESS to SAP R/3 software. This adapter and domain category combination uses the event hourly summarization strategy for the staging and aggregating of data. A SAS IT Resource Management staging transformation is used in staging the data.

These staged tables are input to a series of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, and monthly time periods. Hourly activity is included in a number of these aggregation tables. (There are no sub-hourly aggregation tables for this domain category due to the staged data being pre-summarized to the hourly level.) There are groups of aggregation tables that are created for each of the staged tables in the previous table. Filters that query the transaction code are used to exclude blank transaction codes from the system-transaction aggregation tables.

Key Classifications in the Systems, Machines, Tasks, and Transactions Domain Categories

The following key classifications are found in these domain categories:

- System
- Machine (Host or Application Server)
- Account ID
- Task Type
- Transaction Code
- Elapsed Time Goal
- Program Name
Focus of Report-Ready Data for the SAPR3 Adapter - Systems, Machines, Tasks, and Transactions Domain Categories

Report-ready data for these adapter and domain combinations focuses primarily on the following areas for various groups of classifications:

- event, task type, and transaction counts
- total and average values for CPU, database, elapsed, response, processing, overhead, wait, and RFC times
- total and average values for database requests and physical database accesses and changes
- total and average values for kilobytes of data transferred
- request counts and time expended for Sequential Reads, Direct Reads, Update, Insert, and Delete operations
- counts of physical records read, updated, inserted, and deleted
- lock counts

SAPR3 Adapter - SAPBTCH (Batch Job) and SAPWKLD (Workload)

About the SAPR3 Adapter - SAPBTCH (Batch Job) and SAPWKLD (Workload) Domains

SAP R/3 performance data is collected by using the SAS IT Resource Management Adapter for SAP in conjunction with SAS/ACCESS to SAP R/3 software. This adapter and domain categories combination uses the event activity strategy for the staging and aggregating of data. A SAS IT Resource Management staging transformation is used in staging the data.

These staged tables are input to a series of aggregation jobs that create aggregation tables for daily, weekly, and monthly time periods. (At this time, there is no hourly, sub-hourly, or shift-based activity in these aggregations.) There are several groups of aggregation tables that are created for each of the staged tables that are listed in the previous table. Filters that query transaction code are used to exclude blank transaction codes from the workload-related aggregation tables that focus on transaction activity.

Key Classifications in the SAPBTCH (Batch Job) and SAPWKLD (Workload) Domain Categories

The following key classifications are found in these domain categories:

- System
- Machine (Host or Application Server)
- Account ID
- Job Name
- Transaction Code
- Module
- Sub-Application
- Development Class
- Task Type
- Program Name
Focus of Report-Ready Data for the SAPR3 Adapter - SAPBTCH and SAPWKLD Domain Categories

Report-ready data for these adapter and domain combinations focuses primarily on the following areas for various groups of classifications:

• event, job, and transaction counts
• total and average values for CPU, database, elapsed, response, processing, overhead, wait, and RFC times
• total and average values for database requests and physical database accesses and changes
• total and average values for kilobytes of data transferred
• request counts and time expended for Sequential Reads, Direct Reads, Update, Insert, and Delete operations
• counts of physical records read, updated, inserted, and deleted
• lock counts

SAR Adapter - SAR Domain Category

About the SAR Adapter - SAR Domain Category

This domain category represents a subset of data collected by the System Activity Reporter (SAR) utility on various UNIX environments and focuses on server level activity and performance on the UNIX platform. This adapter and domain category combination uses the server activity strategy for the staging and aggregating of data. A SAS IT Resource Management staging transformation is used in staging the data.

The staged tables for this adapter are input to a series of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, monthly, and sub-hourly time periods. Hourly and shift-based activity is included in a number of these aggregation tables.

Key Classifications in the SAR Domain Category

The following key classifications are found in this domain category:

• System (Machine)
• CPU ID
• Disk ID
• Network Interface

Focus of Report-Ready Data for the SAR Adapter

Report-ready data for this adapter focuses primarily on the following areas:

• utilization of CPU, memory, queuing, cache, paging, and swapping on the global server level
• utilization of CPU for individual CPU processors
• utilization, response times, transfer rates, and wait and queuing for physical disks
• packet and data volume transfer activity for network interfaces
**SMF Adapter - RMF Domain Category**

**About the SMF Adapter - RMF Domain Category**

Resource Management Facility (RMF) data collection represents a subset of the following record types: 70, 71, 72, 74, 75, 77, and 78. These record types are collected by SMF on the z/OS platform. This adapter and domain category combination uses the server activity strategy for staging and aggregating data. MXG software is the primary tool that is used in staging the data. A SAS IT Resource Management staging transformation uses the MXG staged output to complete the staging of the data.

The preceding Adapter Setup Wizard Default Availability legend is applicable to the RMF based tables.

The staged tables for this adapter are input to a number of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, monthly, and sub-hourly time periods. Hourly and shift-based activity is included in many of these aggregations. These aggregations are structured by domain categories. In some cases, domain categories are further broken down into subsets of aggregations known as subcategories. The following table summarizes these domain categories and subcategories.

**Key Classifications in the RMF Domain Category**

The following key classifications are found in this domain category:

- Sysplex
- CEC
- System (Machine)
- CPU ID
- LPAR name
- LPAR number-name concatenation
- Service Class
- Service Class Period
- Workload ID
- Workload ID-Description concatenation
- Workload Period
- Device Number or Volume
- Paging data set name

**Focus of Report-Ready Data for the SMF Adapter - RMF Domain Category**

Report-ready data for this adapter and domain combination focuses primarily on the following domain categories:

- utilization of CPU, memory, queuing, paging, and swap activity on the global server level
- CPU-based hardware MSU and MIPS usage on the global server level and by Processor engine type
- utilization of CPU and level of service measurements by logical partition (LPAR)
Appendix 6 • Data Model

- CPU-based hardware MSU and MIPS usage by LPAR and by Processor engine type
- utilization of CPU for individual CPU processors
- utilization of CPU, memory, I/O, and level of service measurements by defined workload
- CPU-based software MSU and MIPS usage by defined workload and by Processor engine type
- utilization of CPU, memory, I/O, and level of service measurements by defined Service class and period
- CPU-based software MSU and MIPS usage by defined Service class and period and by Processor engine type
- utilization, response times, and wait and queuing for devices (disk and tape)

SMF Adapter - Jobs, TSO, and OMVS Domain Categories

About the SMF Adapter - Jobs, TSO, and OMVS Domain Categories
Batch Job, TSO session, and OMVS session data collection represents a subset of record types (6, 26, and 30) collected by SMF on the z/OS platform. The full complement of data that is collected by SMF for these record types contains performance measurements for batch jobs, TSO sessions, started tasks, Open Edition MVS sessions, and APPC tasks. For SAS IT Resource Management 3.2 and later, this domain category focuses solely on Batch job, TSO sessions, and OMVS session activity. This adapter and domain category combination uses the event activity strategy for the staging and aggregating of data. MXG software is the primary tool that is used in staging the data. A SAS IT Resource Management staging transformation uses the MXG staged output as input and then completes the staging of the data.

This staged table is input to a number of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, and monthly time periods. Shift-based activity is included in a number of these aggregation tables. These aggregations are structured by domain categories. All domain categories in this group are further broken down into subsets of aggregations known as subcategories. The following table summarizes these domain categories and subcategories.

Key Classifications in the Jobs, TSO, and OMVS Domain Categories
The following key classifications are found in this domain category:

- Sysplex
- System (Machine)
- Job class
- Job name
- Job number, TSO session number, or OMVS session number
- Service class
- Group ID
- User ID
Focus of Report-Ready Data for the SMF Adapter - Jobs, TSO, and OMVS Domain Categories

Report-ready data for these adapter and domain combinations focuses primarily on the following domain categories:

- job counts, TSO session counts, and OMVS session counts for various groups of classifications
- accumulated service and times for CPU, memory, and I/O for individual batch jobs, TSO sessions, OMVS sessions across various groups of classifications
- accumulated CPU-based software MSU and MIPS by Engine type for individual batch jobs, TSO sessions, and OMVS sessions across various groups of classifications
- printing output associated with batch jobs and TSO sessions
- utilization of tape resources for batch jobs
- batch job, TSO session, and OMVS abends and associated return codes

SMF Adapter - CICS Domain Category

About the SMF Adapter - CICS Domain Category

CICS data represents record type 110 collected by SMF on the z/OS platform. This adapter and domain category combination uses the event hourly summarization strategy for the staging and aggregating of data. MXG software is the primary tool that is used in staging the data and in performing the hourly summarization of the staged data. A SAS IT Resource Management staging transformation uses the MXG staged output as input, and then completes the staging of the CICS transaction data. The staging job generates the XCICSUM staged table as output.

This staged table is input to a number of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, and monthly time periods. Hourly and shift-based activity is included in many of these aggregations. There are no sub-hourly aggregations for this domain category because the staged data is pre-summarized to the hourly level. A filter that queries transaction ID is used to exclude all CICS management transactions from the aggregated data. Other filters can easily be created that can be used to exclude conversational transactions. Filters can also be created to include or exclude various operating environments (such as production, test, development, or quality assurance) from the aggregated data. These aggregations are structured by domain categories. All domain categories are further broken down into subsets of aggregations known as subcategories.

Key Classifications in the CICS Domain Category

The following key classifications are found in this domain category:

- Processing environment
  
  **Note:** The customer must customize this value by adding code or logic to the staged table Environment column that computes the valid applicable values for the local customer site.

- System (Machine)
- Application region
- Transaction ID
- User ID
**Focus of Report-Ready Data for the SMF Adapter - CICS Domain Category**

Report-ready data for this adapter and domain combination focuses primarily on the following areas, using the classifications previously specified:

- transaction counts
- average response time
- average and accumulated CPU time
- file access counts
- counts and percentages of selected response time criteria
- monitoring of service level objectives for transactions

*Note:* SAS IT Resource Management includes the new metrics that the ASUMCICX member creates. This MXG member is stored in the SAS IT Resource Management CPMISC PDS on z/OS, or the `misc` folder on UNIX, or the `sasmisc` folder on Windows. Before you use the ASUMCICX member, you must run the UTILEXCL MXG job. This job creates and implements the IMACEXCL member that is customized for your site. Documentation for ASUMCICX and UTILEXCL can be found inside each member.

---

**SMF Adapter - DB2 Domain Category**

**About the SMF Adapter - DB2 Domain Category**

DB2 data represents record type 101 collected by SMF on the z/OS platform. This adapter and domain category combination uses the event activity strategy for the staging and aggregating of data. MXG software is the primary tool that is used in staging the data. A SAS IT Resource Management staging transformation uses the MXG staged output as input, and then completes the staging of the DB2 accounting data. The staging job that the Adapter Setup wizard creates from the DB2 report group generates the XDBACCT staged table as output.

This staged table is input to a number of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, and monthly time periods. Hourly and shift-based activity is included in many of these aggregations. These aggregations are structured by domain categories. All domain categories are further broken down into subsets of aggregations known as subcategories.

**Key Classifications in the DB2 Domain Category**

The key classifications that are found in this domain category are:

- Processing environment

*Note:* The customer must customize this value by adding code or logic to the staged table Environment column in order to compute the valid applicable values for the local customer site. For optimal reporting, sites need to customize the classification column ENVIRONMENT to reflect the applicable Processing environments that are defined locally. This customization, which ideally is performed before any data collection, would typically correlate the processing environment with activity on one or more DB2 subsystems. For example, activity on DB2 subsystems DB2P and DB2A could be considered production work, so the ENVIRONMENT column could be set to 'Production' for them. Activity on DB2 subsystem DB2D could be considered development work, so the ENVIRONMENT column could be set to 'Development' for it. Activity on DB2
subsystem DB2Q could be considered quality assurance work, so the ENVIRONMENT column could be set to 'QA' or 'Quality Assurance' for it. Other criteria, along with the subsystem, might be used to establish the proper processing environment to be used in reporting. The customization of the ENVIRONMENT column is part of the staging transformation customization.

To perform the customization, perform the following steps:

1. Open the staging job that performs the staging of the DB2 accounting data (it outputs XDBACCT).
2. Right-click the XDBACCT file and select Properties.
3. Click the Columns tab.
4. Scroll down to the ENVIRONMENT column.
5. In the Expression column, replace the " " code with your replacement code that assigns the proper values for processing environment at your local site.
6. To verify your code changes, stage some DB2 accounting data using the staging job. Then, review the output to check that the ENVIRONMENT column contains the values that you expect for your local site.

- System (Machine)
- DB2 subsystem
- Connection type
- Connection name
- Attachment type
- Plan name
- Location name
- Correlation ID
- Authorization ID
- Job name
- Transaction ID
- Network ID (Local and Remote)
- Client platform
- Client application

Focus of Report-Ready Data for the SMF Adapter - DB2 Domain Category

Report-ready data for this adapter and domain combination focuses primarily on the following areas, using the classifications previously specified:

- thread counts
- CPU, Elapsed, and I/O time in DB2
- CPU and Elapsed total time (inside and outside DB2)
- CPU and Elapsed percentages in DB2
- lock, latch, and I/O wait time in DB2
- lock escalations
SNMP Adapter - Network Activity, Device and Interface Data, and System Data

About the SNMP Adapter - Network Activity, Device and Interface Data, and System Data Domain Categories
The SNMP adapter contains several domain categories that are based on MIB II SNMP metrics. The data that is collected by default by the SNMP adapter is focused on measuring network activity through several protocols (IP, TCP, UDP, and ICMP), as well as device and interface data and system data. The SAS IT Resource Management staging transformation for SNMP is used in staging the data.

These staged tables are input into a series of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, and monthly time periods. Hourly and shift-based activity is included in a number of these aggregation tables, as well as several simple aggregations.

Key Classifications in the Network Activity, Device and Interface Data, and System Data Domain Categories
The following key classifications are found in these domain categories:
- Device
- Interface

Focus of Report-Ready Data for the SNMP Adapter
Report-ready data for this adapter focuses primarily on the following areas:
- Throughput - bits per second, packets or datagrams per second, packet sizes, and packet types
- Error Rates
- Utilization and Availability by interface
- TCP Connections

VMware Adapter - Guest and Host Disk, Network, and System Domain Categories

About the VMware Adapter - Guest and Host Disk, Network, and System Domain Categories
The domain categories for this adapter represent a subset of data stored in the VMware vCenter database. They focus on host and guest level activity and performance. These adapter and domain category combinations use the server activity strategy for the staging and aggregating of data. A SAS IT Resource Management staging transformation is used in staging the data.

The staged tables for this adapter are input to a series of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, monthly, and sub-hourly time periods. Hourly and shift-based activity is included in a number of these aggregation tables.
Key Classifications in the Guest and Host Disk, Network, and System Domain Categories

The following key classifications are found in these domain categories:

- Cluster
- Guest
- Host
- DiskUnit

Focus of Report-Ready Data for the VMware Adapter

Report-ready data for this adapter focuses primarily on the following areas:

- utilization of CPU and memory, CPU ready, memory ballooning, and paging for Guests
- utilization of CPU and memory, memory ballooning, and paging for Hosts
- transfer rates and counts of reads and writes for disks
- packet and data volume transfer activity for network interfaces

Web Log Adapter - All Domain Categories

About the Web Log Adapter - All Domain Categories

The Web Log adapter contains four domain categories that are supported by the Adapter Setup wizard. These domain categories represent different categorizations of the same, limited set of metrics that are available from Web logs. The data that is collected focuses on measuring page counts and requests, the size of those requests and the response time to service those requests. The SAS IT Resource Management staging transformation for Web Log is used in staging the data.

The staged tables for this adapter are input into a series of aggregation jobs that create aggregation tables across a spectrum of daily, weekly, and monthly time periods. Hourly and shift-based activity is included in a number of these aggregation tables, but no simple aggregations are included.

Key Classifications in Web Log - All Domain Categories

The following key classifications are found in these domain categories:

- Host Name
- Site Name
- Machine
- Domain
- Browser Name
- State
- Country
- Organization Type
- URL
- Status
Note: The Browser Activity domain does not have any designated key or ranked metrics.

Focus of Report-Ready Data for the Web Log Adapter

Report-ready data for this adapter focuses primarily on the following metrics:

- Bytes sent and received
- Number of pages received
- Number of requests sent
- Response time

What Are Key Metrics?

Key metrics are a subset of the available metrics provided by adapters for the server performance area such as resource utilization. SAS IT Resource Management identifies key metrics because monitoring hundreds of available metrics within and across adapters is not effective. You can use key metrics to quickly view the most critical data for a performance area. You can also collect key metrics over a long period of time to create capacity planning and forecasting plans.

Key metrics are standardized across adapters, enabling metrics from various data sources to be identified and compared appropriately. SAS IT Resource Management supports the collection of these performance measurements in the IT data mart by staging and aggregating key metrics via adapter domain categories in the Adapter Setup wizard.

The Adapter Setup wizard creates key metric aggregations and regular aggregations for the specific domain categories that you choose for a given adapter. Key metrics aggregations are named with a prefix of “KeyMetrics.” The following image shows a key metrics aggregation, circled in red, in a process flow diagram.

Display A6.1  Key Metrics Aggregation in a Process Flow Diagram
SAS IT Resource Management has identified important measures for adapters for which aggregation tables are provided. Typically, these measures can be found in the key metrics aggregation tables for various domain categories within an adapter. Often these measures can also be found in other summarized aggregation tables. In that case, they can have a corresponding rank measure that can be used for reporting on the top or bottom resources for the specific measure.

In addition to identifying these important measures, SAS IT Resource Management has selected common labels for these measures when they represent the same activity across adapters. When you design a user-written adapter, you should use these common labels, if your data represent a similar measurement.

Key metrics aggregations are designed to be narrow tables that serve as the source for capacity planning and forecasting. Key metrics aggregations include only key metrics and any relevant classification and ID columns that are associated with these key metrics to provide vital data for the performance metric.

**Note:** The measurements in a key metrics aggregation are considered key metrics and they are not ranked. However, these same individual measurements can be included in aggregations that are not key metrics aggregations. When a measurement is in a regular summarized aggregation, it can be ranked. If it is ranked, the measurement is considered a ranked metric (not a key metric) in the context of the regular summarized aggregation table.

This appendix provides information about the key metrics that are provided by SAS IT Resource Management adapters. To find other key metrics that are not listed in this appendix, see [http://support.sas.com/documentation/onlinedoc/itsv/zipfiles/HTMLDoc_3.3/DataModel.html](http://support.sas.com/documentation/onlinedoc/itsv/zipfiles/HTMLDoc_3.3/DataModel.html). This section of the SAS IT Resource Management Web page contains detailed information about all of the metrics that are provided by adapters for staged and aggregation tables.

### Key Metrics for the Server Performance Domain Category

Adapters extract and transform data from various data sources to report on several server performance metrics. Measuring server performance includes performance areas such as CPU, memory, I/O, paging and swapping, cache, and network time.

The following table shows the key metrics that are relevant to server performance and the adapter domain categories that support each metric. An X indicates that the key metric listed in the row is supported by the adapter domain category in the corresponding column.

**Note:** For the SAR, BMC Perf Mgr UNIX, and HP Perf Agent and HP Reporter UNIX domain categories, an X indicates that the corresponding metric is present for at least one of the supported environments (HP, Sun, AIX, Linux) that can run on the platform. The X does not necessarily mean that the metric is available in all environments for the domain category. For example, CpuWaitIoBusyPct is found in AIX and Sun environments on UNIX, but it is not available in HP and Linux environments.

In the following table, the abbreviated column headings stand for the following adapters:

- **DT:** Demand Technology Performance Sentry
- **RMF:** IBM Resource Management Facility
- **SAR:** System Activity Reporter
- BMCU: BMC Performance Manager for Servers - UNIX
- BMCW: BMC Performance Manager for Servers - Windows
- SC: Microsoft System Center Operations Manager
- VMC: VMware vCenter Server

### Table A6.1 Key Metrics for Server Performance Adapters

<table>
<thead>
<tr>
<th>Metric Category</th>
<th>Column Label Root</th>
<th>DT</th>
<th>RMF</th>
<th>SAR</th>
<th>BMCU</th>
<th>BMCW</th>
<th>HPU</th>
<th>HPW</th>
<th>SC</th>
<th>VMC</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>AllEngCpuHardwareMipsUsage</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>AllEngCpuHardwareMsuUsage</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>CpuBusyPct</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>CpuContextSwitchRate</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>CpuIoInterruptRate</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>CpuLoadAvg</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>CpuReadyPct</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>CpuSystemBusyPct</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>CpuUsedMSec</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>CpuUserBusyPct</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>CpuWaitIoBusyPct</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>FourHourMsuRollingAvg</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>IfaEngCpuBusyPct</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>IfaEngCpuHardwareMipsUsage</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>IfaEngCpuHardwareMsuUsage</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>IfIEngCpuBusyPct</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>LogicalSystemCpuBusyPct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>LogicalSystemEntitledCpu</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Metric Category</td>
<td>Column Label Root</td>
<td>DT</td>
<td>RMF</td>
<td>SAR</td>
<td>BMCU</td>
<td>BMCW</td>
<td>HPU</td>
<td>HPW</td>
<td>SC</td>
<td>VMC</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------</td>
<td>----</td>
<td>-----</td>
<td>-----</td>
<td>------</td>
<td>------</td>
<td>-----</td>
<td>-----</td>
<td>----</td>
<td>-----</td>
</tr>
<tr>
<td>CPU</td>
<td>LogicalSystemEntitledCpuBusyPct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>LogicalSystemHypervisorBusyPct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>LogicalSystemPhysicalCpuBusyPct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>LogicalSystemPhysicalCpuUsUsage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>LogicalSystemRunQueueLength</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>LparCpuBusyPct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>LparMsuHourlyRate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>MsuHourlyRate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>ReadyTasksWaitingPct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>RunQueueLength</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>CPU</td>
<td>StandardEngCpuBusyPct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>StandardEngCpuHardwareMipsUsage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>StandardEngCpuHardwareMsuUsage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>StandardEngCpuSoftwareMsuUsage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>ZipEngCpuBusyPct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>ZipEngCpuHardwareMipsUsage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>ZipEngCpuHardwareMsuUsage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device</td>
<td>DeviceActivePct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device</td>
<td>DeviceBusyPct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device</td>
<td>DeviceIoRate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device</td>
<td>DeviceQueueAvgLength</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Key Metrics for the Server Performance Domain Category**

487
<table>
<thead>
<tr>
<th>Metric Category</th>
<th>Column Label Root</th>
<th>DT</th>
<th>RMF</th>
<th>SAR</th>
<th>BMCU</th>
<th>BMCW</th>
<th>HPU</th>
<th>HPW</th>
<th>SC</th>
<th>VMC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>DeviceResponseAvgMSec</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskBusyPct</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskPhysicalIoRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskPhysicalReadRate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskPhysicalReadRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskPhysicalWriteRate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskPhysicalWriteRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskQueueAvgLength</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskReadCount</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskReadRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskReadTransferRateBytes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskReadTransferRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskResponseAvgMSec</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskSpaceAvailableGB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Disk</td>
<td>DiskSpaceAvailablePct</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskTotalCount</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Disk</td>
<td>DiskTransferLatencySec</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Disk</td>
<td>DiskTransferRate</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskTransferRateBytes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskTransferRateKB</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskTransferReadRate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk</td>
<td>DiskTransferTotalRate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Disk</td>
<td>DiskTransferWriteRate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Disk</td>
<td>DiskUsageRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
### Key Metrics for the Server Performance Domain Category

<table>
<thead>
<tr>
<th>Metric Category</th>
<th>Column Label Root</th>
<th>DT</th>
<th>RMF</th>
<th>SAR</th>
<th>BMCU</th>
<th>BMCW</th>
<th>HPU</th>
<th>HPW</th>
<th>SC</th>
<th>VMC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk</td>
<td>DiskWriteCount</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Disk</td>
<td>DiskWriteRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Disk</td>
<td>DiskWriteTransferRateBytes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Disk</td>
<td>DiskWriteTransferRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Disk</td>
<td>DiskPhysicalIoRate</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>AvailableCapacityPct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Memory</td>
<td>AvailableHostMemoryGB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Memory</td>
<td>CacheReadHitPct</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>LogicalSystemPhysicalMemoryUsageMB</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>LogicalSystemMemoryUsagePct</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryActiveGB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryAvailable</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryAvailableMB</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryAvailablePct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryBallooningGB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryCacheUsagePct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryCommittedPct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryConsumedGB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryGrantedGB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryOverheadGB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryPagesAvailableActual</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryPagesAvailableSwap</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Memory</td>
<td>MemorySharedGB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Metric Category</td>
<td>Column Label Root</td>
<td>DT</td>
<td>RMF</td>
<td>SAR</td>
<td>BMCU</td>
<td>BMCW</td>
<td>HPU</td>
<td>HPW</td>
<td>SC</td>
<td>VMC</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------</td>
<td>----</td>
<td>-----</td>
<td>-----</td>
<td>------</td>
<td>------</td>
<td>-----</td>
<td>-----</td>
<td>----</td>
<td>-----</td>
</tr>
<tr>
<td>Memory</td>
<td>MemorySwapInGB</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>MemorySwapOutGB</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>MemorySystemCacheUsagePct</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>MemorySystemUsagePct</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryTotalUsage</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryUsagePct</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryUserUsagePct</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryVirtualUsagePct</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>MemoryZeroGB</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>PagingBlockRate</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>PagingFileUsagePct</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>PagingInputRate</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>PagingOutputRate</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>PagingRate</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>PagingReadRate</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>PagingWriteRate</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>ReadyTasksWaitingPct</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>RemainingFreeMemoryGB</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>SwapRate</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>SwapSpaceUsagePct</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>TotalMemoryLiabilityGB</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>TpsRecoveryPct</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network</td>
<td>InterfaceUsagePct</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network</td>
<td>NetworkPacketsReceivedCount</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<p>| Appendix 6 • Data Model |</p>
<table>
<thead>
<tr>
<th>Metric Category</th>
<th>Column Label Root</th>
<th>DT</th>
<th>RMF</th>
<th>SAR</th>
<th>BMCU</th>
<th>BMCW</th>
<th>HPU</th>
<th>HPW</th>
<th>SC</th>
<th>VMC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network</td>
<td>NetworkPacketsSentCount</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Network</td>
<td>NetworkPacketsTotalCount</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Network</td>
<td>NetworkReceivedRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Network</td>
<td>NetworkSentRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Network</td>
<td>PacketsTotalRate</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network</td>
<td>ReceivedRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Network</td>
<td>SentRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Network</td>
<td>ThroughputRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Network</td>
<td>TotalRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Network</td>
<td>NetworkUsageRateKB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>System Logical Memory</td>
<td>LogicalSystemPhysicalMemoryUsagePct</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
Appendix 7
Naming Standards

About Naming Standards for SAS IT Resource Management Objects

SAS IT Resource Management uses specific naming conventions and locations when naming and saving the various folders, jobs, transformations, filters, and tables that it supplies and creates. These conventions simplify the management and maintenance of the various objects that are interrelated. For best results, if you choose to create or edit IT data mart folders, subfolders, jobs, transformations, tables, or any other object for processing your IT resource data, then use the same naming and storage conventions that SAS IT Resource Management uses for consistency and efficiency.

Naming Standards and Location of Objects

Aggregations

The following table describes the standard naming conventions and storage locations that SAS IT Resource Management uses when creating and saving the various objects that are associated with aggregations.

<table>
<thead>
<tr>
<th>Object</th>
<th>Naming Convention</th>
<th>Location</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>aggregation job</td>
<td><code>&lt;domain category&gt;</code></td>
<td></td>
<td>In the IT Data Marts tree: <code>&lt;IT data mart name&gt; &lt;&gt; &lt;adapter type&gt;&lt;number&gt; &lt;&gt; Domain Categories &lt;&gt; &lt;domain category&gt;</code></td>
</tr>
<tr>
<td></td>
<td><strong>Aggregation</strong> (Example: Disk Aggregation)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Object</td>
<td>Naming Convention</td>
<td>Location</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Aggregation transformation</td>
<td>The naming standard for aggregation transformations can vary slightly. However, the typical structure is <code>&lt;adapter identifier&gt; &lt;domain category&gt;</code>.(Example: NTSMF Disk)</td>
<td>An active Aggregation transformation is in the aggregation job. A template to create your own Aggregation transformation is in the Transformations tree in ITRM Transformations.</td>
<td>Transformation names cannot contain double quotation marks.</td>
</tr>
<tr>
<td>column labels (aggregation table)</td>
<td><code>&lt;corresponding staged table column name&gt; &lt;statistic&gt;</code></td>
<td>In an aggregation table.</td>
<td>Column names use the following guidelines:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Mixed case and no spaces.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Abbreviate when necessary or standardized (such as Geometric Mean to GMean or Range to Rng).</td>
</tr>
<tr>
<td>column label (ranked)</td>
<td>In the Adapter Setup wizard: <code>&lt;measurement&gt;Rank</code></td>
<td>In a table.</td>
<td>In the Adapter Setup wizard:</td>
</tr>
<tr>
<td></td>
<td>(Example: CacheReadHitPctWMeanAscRank )</td>
<td></td>
<td>• Mixed case.</td>
</tr>
<tr>
<td></td>
<td>In the Aggregation wizards: <code>&lt;measurement&gt;Rank&lt;number (optional)&gt;</code></td>
<td></td>
<td>• Appended with a number.</td>
</tr>
<tr>
<td></td>
<td>(Examples: CacheReadHitPctWMeanDescRank, CacheReadHitPctWMeanDescRank01)</td>
<td></td>
<td>In the Aggregation wizards:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Mixed case.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Appended with a number if necessary. The numbering starts with the second instance of a label with a similar name. For example, CRHTPCTRank1 has a label of CacheReadHitPctWMeanDescRank with no appended number. But CRHTPCTRank2 has a label of CacheReadHitPctWMeanDescRank01 where the appended number is 01.</td>
</tr>
<tr>
<td>Object</td>
<td>Naming Convention</td>
<td>Location</td>
<td>Notes</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------</td>
<td>----------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| column name (ranked) | In the Adapter Setup wizard: `<measurement><rank><number>` (Examples: DAYDATERANK01, CRHTTPCTRANK01)

In the Aggregation wizards: `<measurement>Rank<order(optional)>` (Examples: DAYDATEDescRank, CRHTTPCTRank) | In a table. | In the Adapter Setup wizard:
- Uppercase.
- Appended with a number.

In the Aggregation wizards:
- Mixed case.
- Not always appended with a number. |
| library (aggregation) | `<domain category>`

`<unique number>` (Example: Disk 5455) | In the IT Data Marts tree: `<IT data mart name> <adapter type><number> <Domain Categories <domain category>>`. |
| libref (in an aggregation library) | AGG `<same unique number as the library>`

(Example: AGG 5455) |  |
| simple aggregation table | Detail `<measurement category>` (Example: DetailDisk)

Tables of MXG views are identified in the metadata by the prefix `MXG_Simple_` | In the IT Data Marts tree: `<IT data mart name> <adapter type><number> <Domain Categories <domain category>>`. | Mixed case with no spaces. |
| summarized aggregation table | `<time period><measurement category>` (Example: MonthShiftDisk) | In the IT Data Marts tree: `<IT data mart name> <adapter type><number> <Domain Categories <domain category>>`. | Mixed case with no spaces. |
| summarized aggregation table (key metrics) | KeyMetrics `<measurement category>` (Example: KeyMetricsDisk) | In the same folder as its aggregation tables and aggregation job. In the IT Data Marts tree: `<IT data mart name> <adapter type><number> <Domain Categories <domain category>>`. |

**Information Maps**

The following table describes the standard naming conventions and storage locations that SAS IT Resource Management uses when creating and saving the various objects that are associated with information maps.
<table>
<thead>
<tr>
<th>Object</th>
<th>Naming Convention</th>
<th>Location</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>information map</td>
<td>An information map has the same name as its corresponding source table. (Example: MonthShiftDisk)</td>
<td>In the IT Data Marts tree: &lt;IT data mart name&gt; ⇒ &lt;adapter type&gt;&lt;number&gt; ⇒ Domain Categories ⇒ &lt;domain category&gt;.</td>
<td></td>
</tr>
<tr>
<td>information map filter (date type)</td>
<td>Includes descriptive words that show the performance area first, then a verb, the type of metric, and a statistic. (Examples: MemoryUsagePetWMean, PagesFreedRateMax)</td>
<td>In the Information Map transformation that is part of the information map job. Information map filters are available on the Information Map Parameters tab of the Information Map transformation properties.</td>
<td>Mixed case with no spaces.</td>
</tr>
</tbody>
</table>
| information map filter (statistic type) | Includes descriptive words and components that are based on the following guidelines:  
• The first two characters (if the filter is based on a rank column from a joined table) show which level the column comes from (such as D_ for Day level table, W_ for Week level table, M_ for Month level table, or nothing when it is not from a joined table).  
• The text string Top or Bot corresponds to ascending or descending order.  
• The label name on which the column is based, when appropriate, is included.  
• The text string DescRank or AscRank is included to show the rank order when appropriate. (Examples: BotMemoryAvailableMB, TopCpuBusyPct) | In the Information Map transformation that is part of the information map job. Information map filters are available on the Information Map Parameters tab of the Information Map transformation properties. | Mixed case with no spaces. |
| information map job                | <domain category> Information Map (Example: Disk Information Map)                 | In the IT Data Marts tree: <IT data mart name> ⇒ <adapter type><number> ⇒ Domain Categories ⇒ <domain category>. |                            |
Object | Naming Convention | Location | Notes
--- | --- | --- | ---
Information Map transformation | `<time period><measurement category>` (Example: MonthShiftDisk) | An active Information Map transformation is in the information map job. A template to create your own Information Map transformation is in the Transformations tree in ITRM Transformations. | • The same name as the aggregation table that it uses. • Cannot contain double quotation marks.

**Reporting**

The following table describes the standard naming conventions and storage locations that SAS IT Resource Management uses when creating and saving the various objects that are associated with reporting.

Object | Naming Convention | Location | Notes
--- | --- | --- | ---
domain category | Includes descriptive words for the resource that is being measured. | In the Folders tree: Products ⇒ SAS IT Resource Management ⇒ Adapters ⇒ `<adapter type>` ⇒ IT Template Tables. | 

Gallery transformation | `<domain category> <time period>` (Example: Disk Monthly) | An active Gallery transformation is in the reporting job. A template to create your own Gallery transformation is in the Transformations tree in ITRM Transformations. | Transformation names cannot contain double quotation marks.

report definition | Includes descriptive words that indicate the measures that are reported, the filters that are used, and the time period that is reported. (Example: DiskBusyHighUsageHours ForTheDay) | In the Folders tree: Shared Data ⇒ SAS IT Resource Management ⇒ 3.3 IT Report Definitions ⇒ `<adapter type>` ⇒ `<domain category or performance area>` ⇒ Supplied ⇒ `<time period>`. | Save the report definitions that you create in the Folders tree at Shared Data ⇒ SAS IT Resource Management ⇒ IT Report Definitions ⇒ `<adapter type>` ⇒ `<domain category or performance area>` ⇒ User Defined ⇒ `<time period>`. 

reporting job | `<domain category> <time period> Reporting` (Example: Disk Monthly Reporting) | In the IT Data Marts tree: `<IT data mart name>` ⇒ `<adapter type>` ⇒ `<number>` ⇒ Domain Categories ⇒ `<domain category>`. |
Staging

The following table describes the standard naming conventions and storage locations that SAS IT Resource Management uses when creating and saving the various objects that are associated with staging.

<table>
<thead>
<tr>
<th>Object</th>
<th>Naming Convention</th>
<th>Location</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>column labels (staged table)</td>
<td>&lt;performance area or object&gt; &lt;verb (if needed)&gt; &lt;interpretation&gt;</td>
<td>In a staged table.</td>
<td>Column names use the following guidelines:</td>
</tr>
<tr>
<td></td>
<td>(Examples: MemoryUsagePct, MemoryActivePages, PagesFreedRate)</td>
<td></td>
<td>• Mixed case and no spaces.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Limit of 40 characters.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Abbreviate when necessary or standardized (such as Average to Avg,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Minimum to Min, or Percent to Pct).</td>
</tr>
<tr>
<td>library (staging)</td>
<td>&lt;adapter type&gt; Staging &lt;unique number&gt; (Example: SAR Staging 1115)</td>
<td>In the IT Data Marts tree: &lt;IT data mart name&gt; ⇔ &lt;adapter type&gt;&lt;number&gt; ⇔ Staging.</td>
<td>Mixed case with no spaces.</td>
</tr>
<tr>
<td>libref (in a staging library)</td>
<td>STG &lt;same unique number as the library&gt; (Example: STG 1115)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>staging job</td>
<td>&lt;adapter type&gt; Staging (Example: SAR Staging)</td>
<td>In the IT Data Marts tree: &lt;IT data mart name&gt; ⇔ &lt;adapter type&gt;&lt;number&gt; ⇔ Staging.</td>
<td></td>
</tr>
<tr>
<td>staged table</td>
<td>A staged table has the same name as the template table on which it is based.</td>
<td>In the IT Data Marts tree: &lt;IT data mart name&gt; ⇔ &lt;adapter type&gt;&lt;number&gt; ⇔ Staging.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If tables of MXG views are created, they are identified in the metadata by the</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>prefix MXG_Staged_.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>staging transformation</td>
<td>&lt;adapter type&gt; (Example: SAR)</td>
<td>An active staging transformation is in the staging job. A</td>
<td>Transformation names cannot contain double quotation marks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>template to create your own staging transformation for an</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>adapter is in the Transformations tree in ITRM Transformations.</td>
<td></td>
</tr>
</tbody>
</table>
Appendix 8
Macros

Introduction to the Macros in SAS IT Resource Management

%RMDELETE .................................................. 501
  %RMDELETE Overview .................................. 501
  %RMDELETE Syntax .................................... 501
  %RMDELETE Required Arguments ..................... 502
  %RMDELETE Options .................................. 502
  %RMDELETE Notes .................................... 503
  %RMDELETE Examples ................................. 503

%RMDELPVT ................................................ 503
  %RMDELPVT Overview ................................. 503
  %RMDELPVT Syntax .................................. 504
  %RMDELPVT Required Arguments ................... 504
  %RMDELPVT Options ................................ 504
  %RMDELPVT Notes ................................... 505
  %RMDELPVT Example ................................. 505

Duplicate-Data Checking Macros ................................ 506
  %RMDUPCHK ............................................. 506
  %RMDUPDSN ............................................ 509
  %RMDUPINT ............................................ 510
  %RMDUPUPD ............................................ 510

%RMMSBMCP ............................................ 511
  %RMMSBMCP Overview ................................ 511
  %RMMSBMCP Syntax .................................. 512
  %RMMSBMCP Required Arguments ................... 512
  %RMMSBMCP Options ................................ 512
  %RMMSBMCP Example ................................. 513

%RMMSDTPS ............................................ 513
  %RMMSDTPS Overview ................................ 513
  %RMMSDTPS Syntax .................................. 514
  %RMMSDTPS Required Arguments ................... 514
  %RMMSDTPS Options ................................ 514
  %RMMSDTPS Example ................................. 515

%RMMSSCOM ............................................. 515
  %RMMSSCOM ........................................... 515
  %RMMSSCOM Syntax .................................. 516
  %RMMSSCOM Required Arguments ................... 516
  %RMMSSCOM Options ................................ 516
  %RMMSSCOM Example ................................. 517
Introduction to the Macros in SAS IT Resource Management

SAS IT Resource Management provides the following macros:

- **“%RMDELPVT” on page 503** - for purging, erasing, or deleting an IT data mart or a table.
- **“%RMDELPVT” on page 503** - for deleting unused private code macros.
- **“Duplicate-Data Checking Macros” on page 506** - for duplicate-data checking.
  - **“%RMDUPCHK” on page 506** - for executing the duplicate-data checking process.
  - **“%RMDUPDSN” on page 509** - for generating the name of the control data set.
  - **“%RMDUPINT” on page 510** - for setting up the macro definitions that are used by the other duplicate-data checking macros.
  - **“%RMDUPUPD” on page 510** - for updating the permanent control data sets.
- **“%RMMSBMCP” on page 511** - for working with the BMC Perf Mgr file adapter.
• “%RMMSDTPS” on page 513 - for working with the DT Perf Sentry adapter.
• “%RMMSSCOM” on page 515 - for working with the SCOM adapter.
• “%RMMSSSNMP” on page 518 - for working with the SNMP adapter.
• %RMPDB2DM - for migrating a SAS IT Resource Management 2.7 PDB to a SAS IT Resource Management IT data mart. For more information, see SAS IT Resource Management: Migration Documentation. To locate the SAS IT Resource Management documentation, use the Products Index at http://support.sas.com/documentation/index.html.
• “%RMPROINT” on page 520 - for converting counters to rates within staging code.
• “%MRUNEETL” on page 524 - for running ETL jobs.
• %RMUPGRDM - for upgrading the data to the data model of SAS IT Resource Management 3.3. For more information about this macro, see SAS IT Resource Management: Migration Documentation. To locate the SAS IT Resource Management documentation, use the Products Index at http://support.sas.com/documentation/index.html.
• “Backup and Recovery Macros” on page 530 - for backing up and recovering processes for a staging or aggregation transformation.
  • “%RM_BACKUP” on page 531 - for backing up content associated with a staging or aggregation transformation.
  • “%RM_Restore” on page 534 - for restoring content associated with a staging or aggregation transformation.
• “%RMVINST” on page 529 - for verifying that the application server is correctly configured.

%RMDELETE

%RMDELETE Overview

The %RMDELETE macro enables you to purge, erase, or delete either a table or an entire IT data mart. The TYPE=, DATAMART=, and TABLEID= arguments determine the actions to perform.

%RMDELETE Syntax

%RMDELETE(
  DATAMART=name-of-ITdatamart | TABLEID=table-ID,
  METAPASS=user-password,
  METASERVER=name-of-metadata-server,
  METAUSER=user-ID,
  TYPE=PURGE | ERASE | DELETE,
  WORKDIR=directory-path-for-work-files,
  <METADATAREPOSITORY=name-of-metadata-repository>,
  <METAPORT=port-for-metadata-server>
);
%RMDELETE Required Arguments

DATAMART=\texttt{name-of-ITdatamart}

specifies the name of the IT data mart that is to be purged, erased, or deleted. If the TABLEID argument is not specified, a value for this option is required.

TABLEID=\texttt{table-ID}

specifies the name of the table that is to be purged, erased, or deleted. If the DATAMART argument is not specified, a value for this option is required.

METAPASS=\texttt{user-password}

specifies the password that is associated with the metauser ID. A value for this parameter is required.

METASERVER=\texttt{name-of-metadata-server}

specifies the name of the metadata server. A value for this parameter is required.

METAUSER=\texttt{user-ID}

the user ID that is to access the metadata server. A value for this parameter is required.

TYPE=\texttt{PURGE} | \texttt{ERASE} | \texttt{DELETE}

specifies the function that the macro is to perform. The function varies depending on whether an IT data mart or a table is specified. A value for this parameter is required.

PURGE If the DATAMART argument is specified, the PURGE function deletes the contents of all the physical tables that are associated with the specified IT data mart. If the TABLEID argument is specified, the PURGE function deletes the contents of the specified physical table.

ERASE If the DATAMART argument is specified, the ERASE function deletes all the physical tables, libraries, and folders that are associated with the specified IT data mart. It also deletes the metadata for the specified IT data mart. If the TABLEID argument is specified, the ERASE function deletes the physical table and the metadata for the specified table.

DELETE If the DATAMART argument is specified, the DELETE function deletes the metadata for the specified IT data mart. If the TABLEID argument is specified, the DELETE function deletes the metadata for the specified table.

WORKDIR=\texttt{directory-location}

specifies a directory where %RMDELETE can write temporary external files. If this directory does not exist, it is created. For z/OS, this parameter needs to be a UNIX System Services directory path (HFS or zFS file system). A value for this parameter is required.

%RMDELETE Options

METAREPOSITORY=\texttt{name-of-metadata-repository}

the name of the metadata repository. The default value for this option is Foundation.

METAPORT=\texttt{port-for-metadata-server}

the port for the metadata server. The default value for this option is 8561.
%RMDELETE Notes

On Windows, run this macro with the sasbatch.bat command in order to have the correct options set.

The %RMDELETE code must be run on the same machine that the data is located, because the data libraries are accessed with local LIBNAME statements.

If %RMDELETE is accessing an IT data mart on a metadata server on z/OS, the SAS session and the metadata server must have the same character-set encoding.

%RMDELETE Examples

Example 1: Purging All Tables in an IT Data Mart
The following example purges all the tables in the IT data mart called “myITDataMart”.

%rmdelete(metaserver=myServer, metauser=myUserid, metapass=myPassword, workdir=c:\temp\workdir, type=purge, datamart=myITDataMart);

Example 2: Erasing a Table in an IT Data Mart
The following example erases the physical table with the A55DZBQ6.B70000ZC metadata ID. It also deletes the metadata for that table.

%rmdelete(metaserver=myServer, metauser=myUserid, metapass=myPassword, workdir=c:\temp\workdir, type=erase, tableID=A55DZBQ6.B70000ZC);

%RMDELPVT

%RMDELPVT Overview

The %RMDELPVT macro deletes the unused private code macros that are stored in the data libraries of staged and aggregation tables.

The private code macros are in a catalog in each library called sasmacr. Each time the code is generated for a job, either from the PFD or by deploying the job, a new version of the private code macro is generated. Old versions of the private code macros are not deleted, so the sasmacr catalog continues to grow every time the code is generated.

The %RMDELPVT macro deletes the unused private code macros from the sasmacr catalog. %RMDELPVT determines whether a private code macro is still in use by parsing the SAS code for all the deployed jobs and retrieving the name of the private code macro from the code. (This private code macro that is used in a deployed job is considered to be in use, and it will not be deleted.) All private code macros that are not used in deployed jobs will be deleted.
%RMDELPVT Syntax

%RMDELPVT(
  BACKUPLOCATION=\texttt{name-of-the-backup-library}
  ,DATAMART=\texttt{name-of-the-IT-data-mart}
  ,METAPASS=\texttt{user-password}
  ,METASERVER=\texttt{name-of-metadata-server}
  ,METAUSER=\texttt{user-ID}
  ,<\texttt{DOBACKUP}=\texttt{Yes} | \texttt{No}>
  ,<\texttt{DODELETE}=\texttt{Yes} | \texttt{No}>
  ,<\texttt{DOREPORT}=\texttt{Yes} | \texttt{No}>
  ,<\texttt{DORESTORE}=\texttt{Yes} | \texttt{No}>
  ,<\texttt{METAPORT}=\texttt{metadata-server-port}>
);

%RMDELPVT Required Arguments

- \texttt{BACKUPLOCATION=\texttt{name-of-the-backup-library}}
specifies the name of an existing SAS library that will be used to store a backup of
the \texttt{sasmacr} catalogs.

  \textit{Note:} The entire contents of this library will be deleted before running the backup
procedure.

  The default value of this argument is \texttt{YES}. This argument is required if the
\texttt{DORESTORE} option is set to \texttt{Yes}.

- \texttt{DATAMART=\texttt{name-of-the-IT-data-mart}}
specifies the name of the IT data mart. The macro will clean up all the private code
in this IT data mart.

  This value is not case sensitive.

- \texttt{METAPASS=\texttt{user-password}}
specifies the password that is associated with the metauser ID.

- \texttt{METASERVER=\texttt{name-of-metadata-server}}
specifies the name of the metadata server.

- \texttt{METAUSER=\texttt{user-ID}}
specifies the user ID that is to access the metadata server.

%RMDELPVT Options

- \texttt{DOBACKUP=\texttt{Yes} | \texttt{No}}
specifies whether to perform a backup of the \texttt{sasmacr} catalogs before they are
cleaned.

  The default value of this argument is \texttt{YES}.

- \texttt{DODELETE=\texttt{Yes} | \texttt{No}}
specifies whether to delete the unused private macros from the data mart libraries. A
report is generated that indicates the results of the process.
The default value of this argument is No.

- **DOREPORT=** *Yes | No*
  specifies whether to create a report that shows the private macros that are found in the IT data mart libraries. It also shows which private macros are in use in deployed jobs.
  The default value of this argument is Yes.

- **DORESTORE=** *Yes | No*
  specifies whether to restore the data from the backup made during a previous run of the macro. If doRestore is set to Yes, only the BACKUPLLOCATION option is required. No other functions will be performed and all other options will be ignored.
  The default value of this argument is No.

- **METAPORT=** *metadata-server-port*
  specifies the port of the metadata server.
  The default value for this option is 8561.

### %RMDELPVT Notes

The %RMDELPVT provides the ability to back up the sasmacr catalogs before cleaning them. It also provides the ability to restore the data from the backup.

### %RMDELPVT Example

#### Example 1: Run the Report and Perform the Backup and Delete Functions
This example runs the report and performs the backup and delete functions on a data mart called “my IT Data Mart”.

```plaintext
%rmdelpvt(backupLocation=c:\rmdelpvt_backup,
          dataMart=my IT Data Mart,
          doBackup=YES,
          doDelete=YES,
          doReport=YES,
          metaPass=myPassword,
          metaPort=8561,
          metaServer=myServer,
          metaUser=myUserid
          );
```

#### Example 2: Restore the Backup
This example restores the backup to the original IT data mart.

```plaintext
%rmdelpvt(backupLocation=c:\rmdelpvt_backup)
          doRestore=YES
          );
```
Duplicate-Data Checking Macros

%RMDUPCHK

%RMDUPCHK Overview
%RMDUPCHK checks for duplicate data and deletes it. It also builds up record counts of incoming and deleted data and datetime ranges for each system or machine. These record counts are stored in the control data set. If the control data set indicates that a gap was detected in the data, a report is generated.

The control data set is stored in the same library as the staged tables. This data set is created and managed by the %RMDUPxxx macros. (Users do not usually access this library.)

Note: For information about how to set up the %RMDUPCHK macro, see “Working with Duplicate-Data Checking Macros” on page 458. For information about how control data sets work, see “Control Data Sets for Duplicate-Data Checking” on page 457.

%RMDUPCHK Syntax
%RMDUPCHK( ENDFILE=variable-name, IDVAR=variable-name, SOURCE=identifier, TIMESTAMP=timestamp-variable-name, <, FORCE=YES | NO>, <, INT=interval>, <, KEEP=number-of-weeks>, <, REPORT=YES | NO>, <, TERM=YES | NO> );

%RMDUPCHK Required Arguments
• ENDFILE=variable-name
  specifies the name of the SAS variable that is used as the END= keyword for the SAS INFILE statement that reads the raw data.

• IDVAR=variable-name
  specifies the name of the SAS character variable that identifies the system or machine that generated the input data. The name of this variable can be no more than 32 characters in length.

• SOURCE=identifier
  specifies a unique three-character code that identifies the type of data.

• TIMESTAMP=timestamp-variable-name
  specifies the name of the SAS variable that contains the datetime stamp that uniquely identifies the time of the event or interval being recorded.

The SOURCE entries for the supported adapters are listed in the following table.
<table>
<thead>
<tr>
<th>ADAPTER</th>
<th>Value for the SOURCE Parameter for %RMDUPCHK</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG TMON2CIC</td>
<td>TM2</td>
</tr>
<tr>
<td>ASG TMONDB2</td>
<td>TMD</td>
</tr>
<tr>
<td>BMC Mainview</td>
<td>IMF</td>
</tr>
<tr>
<td>BMC Perf Mgr</td>
<td>PAT</td>
</tr>
<tr>
<td>CA TMS</td>
<td>TMS</td>
</tr>
<tr>
<td>Comma Separated Values</td>
<td>CSV</td>
</tr>
<tr>
<td>DT Perf Sentry</td>
<td>NTS</td>
</tr>
<tr>
<td>DT Perf Sentry with MXG</td>
<td>NTS</td>
</tr>
<tr>
<td>HP Perf Agent</td>
<td>(Multiple values are needed so that %RMDUPCHK can be invoked with each value.)</td>
</tr>
<tr>
<td>HP Reporter</td>
<td>(Multiple values are needed so that %RMDUPCHK can be invoked with each value.)</td>
</tr>
<tr>
<td>IBM DCOLLECT</td>
<td>DCO</td>
</tr>
<tr>
<td>IBM EREP</td>
<td>ERP</td>
</tr>
<tr>
<td>IBM IMS</td>
<td>IMS</td>
</tr>
<tr>
<td>IBM SMF</td>
<td>SMF</td>
</tr>
<tr>
<td>IBM TPF</td>
<td>TPF</td>
</tr>
<tr>
<td>IBM VMMON</td>
<td>VMM</td>
</tr>
<tr>
<td>MS SCOM</td>
<td>SCO</td>
</tr>
<tr>
<td>RRDtool</td>
<td>RRD</td>
</tr>
<tr>
<td>SAP ERP</td>
<td>BAT, SAP, and others. (Multiple values are needed so that %RMDUPCHK can be invoked with each value.)</td>
</tr>
<tr>
<td>SAR</td>
<td>SAR</td>
</tr>
<tr>
<td>MS SCOM</td>
<td>SCO</td>
</tr>
<tr>
<td>SNMP</td>
<td>SNM</td>
</tr>
<tr>
<td>VMware vCenter</td>
<td>(Multiple values are needed so that %RMDUPCHK can be invoked with each value.)</td>
</tr>
</tbody>
</table>
ADAPTER | Value for the SOURCE Parameter for %RMDUPCHK
--- | ---
Web Log | WWW

%RMDUPCHK Options

- **FORCE=YES | NO**
  - Specifies whether duplicate input data should still be processed, or whether it is a duplicate.
  - FORCE=YES indicates that, if a duplicate is detected, the duplicate data should be processed.
  - FORCE=NO indicates that duplicate data should not be processed.
  - The default value for this option is **NO**.

- **INT=interval**
  - Represents the maximum time gap (or interval) that is to be allowed between the timestamps on any two consecutive records from the same system or machine. If the interval between the timestamp values exceeds the value of this option, then an observation with the new time range is created in the control data set. This is referred to as a gap in the data.
  - The value for this option must be provided in the format hh:mm, where hh represents hours and mm represents minutes. For example, to specify an interval of 14 minutes, use INT=0:14. To specify an interval of 1 hour and 29 minutes, use INT=1:29.
  - The default value for this option is **0:29**, or 29 minutes.

- **KEEP=number-of-weeks**
  - Specifies the number of weeks for which control data will be kept. Because this value represents the number of Sundays between two dates, a value of 2 results in a maximum retention period of 20 days.
  - The default value for this option is **2**.

- **REPORT=YES | NO**
  - Specifies whether to display the duplicate-data checking messages in the SAS log or to save the messages in an audit table. If set to **Yes**, this parameter causes all the messages from duplicate-data checking to be displayed in the SAS log. If set to **No**, the duplicate-data checking messages are saved in an audit data table that is stored in the staging library. The name of the audit table is source AUDIT (where source is the 3-character data source code).
  - The default value of this option is **YES**.

  *Note*: If you are monitoring very high numbers of resources, setting this option to **NO** can be beneficial. Eliminating the report reduces CPU consumption, shortens elapsed time, and makes the SAS log more manageable.

- **TERM=YES | NO**
  - Controls whether SAS terminates if any duplicate input data is detected.
  - The default value of this option is **NO**.
%RMDUPCHK Notes
The Adapter Setup wizard prompts the user to specify how to handle duplicate records. Valid entries for the mode of duplicate-data checking are Discard, Force, or Terminate.

- **Discard**: Duplicate-data-checking macros are executed. FORCE=NO and TERM=NO are implied.
- **Force**: Duplicate-data-checking macros are executed. FORCE=YES and TERM=NO are implied.
- **Terminate**: Duplicate-data-checking macros are executed. FORCE=NO and TERM=YES are implied.

You can change the mode of duplicate-data-checking for a table on the Properties dialog box for that table.

*Note:* For information about how to set up the %RMDUPCHK macro, see “Working with Duplicate-Data Checking Macros” on page 458. For information about how control data sets work, see “Control Data Sets for Duplicate-Data Checking” on page 457.

%RMDUPCHK Example
The following example provides duplicate checking for the data that is input from the NTSMF adapter:

```sas
%rmdupchk(
   endfile=_eof,
   source=nts,
   idvar=machine,
   int=00:18,
   keep=52,
   report=yes,
   timestamp=datetime
);
```

%RMDUPDSN

%RMDUPDSN Overview
%RMDUPDSN generates the name of the data duplication control data set. This is a temporary SAS data set that will contain datetime ranges for the data that is being processed when duplicate-data checking is enabled. This information is also used by other duplicate-data-checking macros, such as %RMDUPCHK and %RMDUPUPD.

For supplied adapters, the %RMDUPDSN macro is automatically submitted in the staging code when duplicate-data checking is enabled. For user-written adapters, the duplicate-data checking is not automatically enabled. For information about how to enable duplicate-data checking in the user-written staging code, see “Duplicate Checking” on page 274.

%RMDUPDSN Syntax
%RMDUPDSN(
   SOURCE=identifier
);

%RMDUPDSN Required Arguments
- **SOURCE=identifier**
specifies a unique three-character code that identifies the type of data. It should be the same as the value that was coded for the SOURCE= parameter of the %RMDUPCHK macro.

%RMDUPDSN Notes
This macro executes only one time. It creates a global macro variable, &RMDUPDSN, that contains the name of the data duplication control data set. The global macro variable is resolved by the %RMDUPDSN macro.

%RMDUPDSN Example
This example shows the creation of a control data set, called cpnts.dsn, that is used to detect data duplication.

```%rmdupdsn(
   source=nts
);```

%RMDUPINT

%RMDUPINT Overview
%RMDUPINT sets up the macro definitions that are used by the other duplicate-data-checking macros. These macro definitions generate the name of the data duplication control data set.

%RMDUPINT Syntax
%RMDUPINT;

%RMDUPINT Notes
This macro requires no parameters. It contains the macro definitions and naming conventions for the control data set. The %RMDUPINT macro also defines the &RMDUPDSN macro variable that contains the data set name that is used in the %RMDUPDSN macro.

For supplied adapters, the %RMDUPINT macro is automatically submitted in the staging code when duplicate-data checking is enabled. For user-written adapters, the duplicate-data checking is not automatically enabled. To enable duplicate-data checking, in the user-written staging code, specify the %RMDUPINT macro in front of the staging code.

For information about how to enable duplicate-data checking in the user-written staging code, see “Duplicate Checking” on page 274.

%RMDUPINT Example
```%rmdupint;```

%RMDUPUPD

%RMDUPUPD Overview
%RMDUPUPD updates the permanent control data sets with information from a temporary control data set.
%RMDUPUPD Syntax
%RMDUPUPD;

%RMDUPUPD Notes
This macro requires no parameters. It reads the temporary control data set that was built by the %RMDUPCHK macro. It splits the contents into individual control data sets, depending on the number of staging transformations that contributed to the control data set.

The individual control data sets are then merged with their corresponding permanent data sets. If, during the merging process, the time interval between any two records is greater than the allowed time interval, then both records are output. (The allowed time interval is the value that was specified by the INT= option of the %RMDUPCHK macro.)

%RMDUPUPD subsequently generates a report that informs the user of the possibility of missing data. Records that relate to data that are older than the KEEP value are deleted. This macro is executed automatically by the staging transformations of all the supplied adapters. For user-written staging transformations, this macro must be coded to execute after the staged tables have been populated.

%RMDUPUPD Notes
This macro requires no parameters. It reads the temporary control data set that was built by the %RMDUPCHK macro. It splits the contents into individual control data sets, depending on the number of staging transformations that contributed to the control data set.

The individual control data sets are then merged with their corresponding permanent data sets. If, during the merging process, the time interval between any two records is greater than the allowed time interval, then both records are output. (The allowed time interval is the value that was specified by the INT= option of the %RMDUPCHK macro.)

%RMDUPUPD subsequently generates a report that informs the user of the possibility of missing data. Records that relate to data that are older than the KEEP value are deleted. This macro is executed automatically by the staging transformations of all the supplied adapters. For user-written staging transformations, this macro must be coded to execute after the staged tables have been populated.

%RMDUPUPD Example
%rmdupupd;

%RMMSBMCP

%RMMSBMCP Overview
%RMMSBMCP reads the records from a BMC Perf Mgr file that was created with the DUMP HISTORY command and creates the appropriate table and column metadata for the SAS IT Resource Management BMC Perf Mgr adapter.

Note: Run this program only after you have created an IT data mart and a job that contains a BMC Perf Mgr transformation.
%RMMSBMCP Syntax

\texttt{%RMMSDTPS(}
\texttt{LOGFILE=path-and-filename-to-BMC-Perf-Mgr-log}
\texttt{,METAPASS=user-password}
\texttt{,METASERVER=\textcolor{red}{\textbackslash name-of-metadata-server}}
\texttt{,METAUSER=\textcolor{red}{\textbackslash user-ID}}
\texttt{<,APPSERVER=\textcolor{red}{\textbackslash name-of-application-server}>}
\texttt{<,JOBID=\textcolor{red}{\textbackslash metadata-id-of-staging-job}>}
\texttt{<,CREATEMETADATA=\textcolor{red}{\textbackslash Y | \textbackslash N}>}
\texttt{<,FILEDEVICE=\textcolor{red}{\textbackslash type-of-device}>}
\texttt{<,FILENOOFVOLUMES=\textcolor{red}{\textbackslash number-of-volumes}>}
\texttt{<,FILESPACEPRIMARY=\textcolor{red}{\textbackslash primary-space-allocation}>}
\texttt{<,FILESPACESECONDARY=\textcolor{red}{\textbackslash secondary-space-allocation}>}
\texttt{<,METAPORT=\textcolor{red}{\textbackslash metadata-server-port}>}
\texttt{<,METAREPOSITORY=\textcolor{red}{\textbackslash name-of-metadata-repository}>}
\texttt{)};

%RMMSBMCP Required Arguments

- \texttt{LOGFILE=path-and-filename-to-BMC-Perf-Mgr-log}
  specifies the path to the BMC Perf Mgr log file.

- \texttt{METAPASS=user-password}
  specifies the password that is associated with the metauser ID.

- \texttt{METASERVER=name-of-metadata-server}
  specifies the name of the metadata server.

- \texttt{METAUSER=user-ID}
  specifies the user ID that is to access the metadata server.

%RMMSBMCP Options

- \texttt{APPSERVER=\textbackslash of-application-server}
  specifies the name of the application server. The default value for this option is \texttt{SASITRM}.

- \texttt{JOBID=\textbackslash metadata-id-of-staging-job}
  specifies the metadata ID of the staging job. The metadata-ID should be in the format \texttt{Axxxxxxxx.Zyyyyyyyy} and follow these specifications:
  - \texttt{Axxxxxxxx} is any set of eight alphanumeric characters preceded by the character “A.”
  - Z is any alphabetic character.
  - \texttt{yyyyyyyy} is any set of eight alphanumeric characters.
  \textit{Note:} This option is required if CREATEMETADATA is set to \texttt{Y}.

- \texttt{CREATEMETADATA=Y | N}
  specifies that the macro is to create the metadata for the tables and columns in the log file.
The default value for this option is N, which means do not create the metadata. The value N only produces a report of the metadata that would have been created.

- **FILEDEVICE=type-of-device**
  
  specifies the type of device. This value is required only if the library and tables are going to be stored on z/OS with a traditional file system.

- **FILENOOFVOLUMES=number-of-volumes**
  
  specifies the number of volumes. This value is required only if the library and tables are going to be stored on z/OS with a traditional file system.

- **FILESPECEPRIMARY=primary-space-allocation**
  
  specifies the primary space allocation. This value is required only if the library and tables are going to be stored on z/OS with a traditional file system.

- **FILESPECEOSECONDARY=secondary-space-allocation**
  
  specifies the secondary space allocation. This value is required only if the library and tables are going to be stored on z/OS with a traditional file system.

- **METAPORT=metadata-server-port**
  
  specifies the port of the metadata server.

- **METAREPOSITORY=name-of-metadata-repository**
  
  specifies the name of the metadata repository that contains the IT data mart. The default value for this option is Foundation.

### %RMMSBMCP Example

This example reads the BMC Perf Mgr log file called c:\BMCPerfMgr\citra1_Windows_format2.dat and creates the metadata for the tables and columns defined in this log file.

```bash
%rmmsbmcp(createMetadata=Y
   ,jobID=A5FWNTN9.BN0000RX
   ,metapass=myPassword
   ,metaserver=myServer
   ,metauser=myUserid
   ,logfile=c:\BMCPerfMgr\citra1_Windows_format2.dat
 );
```

### %RMMSDTPS

#### %RMMSDTPS Overview

%RMMSDTPS reads the header records from a DT Perf Sentry log file and creates the appropriate table and column metadata for the SAS IT Resource Management DT Perf Sentry adapter.

*Note:* Run this program only after you have created an IT data mart and a job that contains a DT Perf Sentry transformation.
%RMMSDTPS Syntax

%RMMSDTPS(
  LOGFILE=path-and-filename-to-DT-Perf-Sentry-log,
  METAPASS=user-password,
  METASERVER=name-of-metadata-server,
  METAUSER=user-ID,
  APPSERVER=application-server,
  JOBID=metadata-id-of-staging-job,
  CREATEMETADATA=Yes | No,
  FILEDEVICE=type-of-device,
  FILENOOFVOLUMES=number-of-volumes,
  FILESPACEPRIMARY=primary-space-allocation,
  FILESPACESECONDARY=secondary-space-allocation,
  METAPORT=metadata-server-port,
  METAREPOSITORY=name-of-metadata-repository);

%RMMSDTPS Required Arguments

  • LOGFILE=path-and-filename-to-DT-Perf-Sentry-log
    specifies the path to the DT Perf Sentry log file.

  • METAPASS=user-password
    specifies the password that is associated with the metauser ID.

  • METASERVER=name-of-metadata-server
    specifies the name of the metadata server.

  • METAUSER=user-ID
    specifies the user ID that is to access the metadata server.

%RMMSDTPS Options

  • APPSERVER=application-server
    specifies the name of the application server. The default value for this option is SASITRM.

  • JOBID=metadata-id-of-staging-job
    specifies the metadata ID of the staging job. The metadata-ID should be in the format Axxxxxxxx.Zyyyyyyyyy and follow these specifications:
    • Axxxxxxxx is any set of eight alphanumeric characters preceded by the character “A.”
    • Z is any alphabetic character.
    • yyyyyyyyy is any set of eight alphanumeric characters.
      Note: This option is required if CREATEMETADATA is set to Y.

  • CREATEMETADATA=Yes | No
    specifies that the macro is to create the metadata for the tables and columns in the log file.
The default value for this option is N, which means do not create the metadata. The value N produces only a report of the metadata that would have been created.

- **FILEDEVICE=type-of-device**
  specifies the type of device. This value is required only if the library and tables are going to be stored on z/OS with a traditional file system.

- **FILENOOVOLUMES=number-of-volumes**
  specifies the number of volumes. This value is required only if the library and tables are going to be stored on z/OS with a traditional file system.

- **FILESPACEPRIMARY=primary-space-allocation**
  specifies the primary space allocation. This value is required only if the library and tables are going to be stored on z/OS with a traditional file system.

- **FILESPACESECONDARY=secondary-space-allocation**
  specifies the secondary space allocation. This value is required only if the library and tables are going to be stored on z/OS with a traditional file system.

- **METAPORT=metadata-server-port**
  specifies the port of the metadata server.

- **METAREPOSITORY=name-of-metadata-repository**
  specifies the name of the metadata repository that contains the IT data mart. The default value for this option is **Foundation**.

---

**%RMMSDTPS Example**

This example reads the DT Perf Sentry log file called `c:\DTPerfSentry\arlington-1.smf` and creates the metadata for the tables and columns defined in this log file.

```bash
%rmmsdtps(createMetadata=Y,jobID=A5016lHR.BP0001MU,metapass=myPassword,metaserver=myServer,metauser=myUserid,logfile=c:\DTPerfSentry\arlington-1.smf);
```

---

**%RMMSSCOM**

%RMMSSCOM reads a management pack file in XML format and creates table and column metadata and formats for the SAS IT Resource Management SCOM adapter. If the management pack is sealed, you need to unseal it first to get the XML file.

*Note:* Run this program only after you have created an IT data mart and a job that contains an SCOM transformation.
%RMMSSCOM Syntax

%RMMSSCOM(
MPFILE=path-and-filename-of-the-management-pack
,METAPASS=user-password
,METASERVER=name-of-metadata-server
,METAUSER=user ID
,OUTPUTFILEPATH=path-of-output-text-file
,<APPSERVER=name-of-application-server>
,<FILEDEVICE=type-of-device>
,<FILENOOFVOLUMES=number-of-volumes>
,<FILESPECEPRIMARY=primary-space-allocation>
,<FILESPECESECONDARY=secondary-space-allocation>
,<JOBID=metadata-id-of-staging-job>
,<CREATEMETADATA=Yes | No>
,<METAPORT=metadata-server-port>
,<METAREPOSITORY=name-of-metadata-repository>
);

%RMMSSCOM Required Arguments

- **MPFILE=path-and-filename-of-the-management-pack**
  specifies the path to the management pack.

- **METAPASS=user-password**
  specifies the password that is associated with the metauser ID.
  *Note:* The password can be in plain text or encoded. You can use PROC PWENCODE to encode the password.

- **METASERVER=name-of-metadata-server**
  specifies the name of the metadata server.

- **METAUSER=user-ID**
  specifies the user ID that is to access the metadata server. The user must be able to read and write metadata in the IT data mart.

- **OUTPUTFILEPATH=path-of-output-text-file** specifies the path for a temporary text file called Temp_RMMSSCOM.txt. This file will contain the data that is retrieved from the management pack.

%RMMSSCOM Options

- **APPSERVER=name-of-application-server**
  specifies the name of the application server.
  The default value for this option is **SASITRM**.

- **CREATEMETADATA=Yes | No**
  specifies that the macro is to create the metadata for the staging tables.
  The default value for this option is **No**, which means do not create the metadata. The value **No** only produces a report of the metadata that would have been created.
• **FILEDEVICE=*type-of-device*  
  specifies the type of device. This value is required only if the library and tables will be stored on z/OS with a traditional file system.

• **FILENOOFVOLUMES=*number-of-volumes*  
  specifies the number of volumes. This value is required only if the library and tables are going to be stored on z/OS with a traditional file system.

• **FILESPECPRIMARITY=*primary-space-allocation*  
  specifies the primary space allocation. This value is required only if the library and tables are going to be stored on z/OS with a traditional file system.

• **FILESPECSECONDARY=*secondary-space-allocation*  
  specifies the secondary space allocation. This value is required only if the library and tables are going to be stored on z/OS with a traditional file system.

• **JOBID=*metadata-id-of-staging-job*  
  specifies the metadata ID of the staging job. The metadata-ID should be in the format Axxxxxxxx Zyyyyyyyyy and follow these specifications:  
  • Axxxxxxxx is any set of eight alphanumeric characters preceded by the character “A.”  
  • Z is any alphabetic character.  
  • yyyyyyyyy is any set of eight alphanumeric characters.  
  *Note:* This option is required if CREATEMETADATA is set to **Yes**.

• **METAPORT=*metadata-server-port*  
  specifies the port of the metadata server.  
  The default value for this option is **8561**.

• **METAREPOSITORY=*name-of-metadata-repository*  
  specifies the name of the metadata repository that contains the IT data mart.
  The default value for this option is **Foundation**.

---

**%RMMSSCOM Example**

This example reads the Microsoft SQL Server 2008 R2 management pack in XML format and creates table and column metadata and formats for the SCOM adapter.

```bash
%rmmsscom(createMetadata=Y ,jobID=A5016lHR.BP0001MU ,metapass=myPassword ,metaserver=myServer ,metauser=myUserid ,mpfile=c:\msscom\SQLServer2008R2.xml ,outputfilepath=c:\temp );
```
%RMMSSNMP

%RMMSSNMP Overview

%RMMSSNMP reads a management information base (MIB) definition and creates the appropriate table and column metadata and formats for the SAS IT Resource Management SNMP adapter.

Note: Run this program only after you have created an IT data mart and a job that contains an SNMP transformation.

%RMMSSNMP Syntax

%RMMSSNMP(
  MIBFILE=\textit{path-and-filename-of-the-MIB-definition},
  METAPASS=\textit{user-password},
  METASERVER=\textit{name-of-metadata-server},
  METAUSER=\textit{user-ID},
  \begin{itemize}
    \item \texttt{APPSERVER=\textit{name-of-application-server}}
    \item \texttt{FORMATLIBPATH=\textit{path-to-library-for-formats}}
    \item \texttt{JOBID=\textit{metadata-id-of-staging-job}}
    \item \texttt{KEEPRECOMMENDEDONLY=Yes | No}
    \item \texttt{CREATEMETADATA=Yes | No}
    \item \texttt{METAPORT=\textit{metadata-server-port}}
    \item \texttt{METAREPOSITORY=\textit{name-of-metadata-repository}}
  \end{itemize}
);

%RMMSSNMP Required Arguments

- \texttt{MIBFILE=\textit{path-and-filename-of-the-MIB-definition}}
  specifies the path to the management information base (MIB) definition file.
- \texttt{METAPASS=\textit{user-password}}
  specifies the password that is associated with the metauser ID.
- \texttt{METASERVER=\textit{name-of-metadata-server}}
  specifies the name of the metadata server.
- \texttt{METAUSER=\textit{user-ID}}
  specifies the user ID that is to access the metadata server.

%RMMSSNMP Options

- \texttt{APPSERVER=\textit{name-of-application-server}}
  specifies the name of the application server.
  The default value for this option is \texttt{SASITRM}.
- \texttt{CREATEMETADATA=Yes | No}
specifies that the macro is to create the metadata for the MIB tables.
The default value for this option is N, which means do not create the metadata. The value N only produces a report of the metadata that would have been created.

- **FORMATLIBPATH** = *path-to-library-for-formats*
specifies the path to the library where the formats for this macro are to be stored.
The default value for this option is the WORK library.

- **JOBID** = *metadata-id-of-staging-job*
specifies the metadata ID of the staging job. The metadata-ID should be in the format Axxxxxxxx.Zyyyyyyyy and follow these specifications:
  - Axxxxxxxx is any set of eight alphanumeric characters preceded by the character “A.”
  - Z is any alphabetic character.
  - yyyyyyyyy is any set of eight alphanumeric characters.
*Note*: This option is required if CREATEMETADATA is set to Y

- **KEEPRECOMMENDEDONLY** = Yes | No
specifies that the macro should keep only the recommended tables and columns.
The default value for this option is N, which means that all tables and columns are to be kept, including the tables and columns that are deprecated or obsolete, and columns whose Max-Access attribute has a value of not-accessible.

- **METAPORT** = *metadata-server-port*
specifies the port of the metadata server.
The default value for this option is 8561.

- **METAREPOSITORY** = *name-of-metadata-repository*
specifies the name of the metadata repository that contains the IT data mart.
The default value for this option is Foundation.

**%RMMSNMP Example**

This example reads the BGP-4-MIB definition and creates the metadata for the recommended tables and columns that are in the MIB definition.

```%rmmssnmp
%rmmssnmp(createMetadata=Y
 ,formatLibPath=c:\mibFormats
 ,jobID=A50161HR.BP0001MU
 ,keepRecommendedOnly=Y
 ,metapass=myPassword
 ,metaserver=myServer
 ,metauser=myUserid
 ,mibfile=c:\mibs\BGP4-MIB.my
 );
```
%RMPROINT

%RMPROINT Overview

%RMPROINT creates an output SAS view that converts the values of the variables of data type C2RATE or D2RATE from counters or deltas into rates. This macro processes either counters or deltas in a single invocation (but not both). If DURATION is missing, then the macro also sets the value of DURATION to be the difference between successive values of the variable DATETIME within one BY group.

%RMPROINT Syntax

%RMPROINT(
    ADAPTER=adapter-name
    ,BYGROUP=list-of-BY-vars
    ,IN=input-SAS-table
    ,OUT=output-SAS-table
    ,VARS=list-of-vars
    <,CONVERT=C2RATE>
    <,_RBDF=relative-bad-delta-factor>
    );

%RMPROINT Required Arguments

- **ADAPTER=adapter-name**
  specifies the name of the adapter to which the table belongs.

- **BYGROUP=bygroup**
  specifies the space-delimited list of BY variables that govern how this data is sorted.

- **IN=infile**
  specifies the input SAS table.

- **OUT=outfile**
  specifies the output SAS table. (This table can be the same as the input table.)

- **VARS=variable-name**
  specifies the space-delimited list of variables that require conversion.

%RMPROINT Options

- **CONVERT=conversion-type**
  specifies the type of conversion to be performed. The following values are valid for conversion-type:

  - **C2RATE**
    The data is converted from counter to rate. The default value for this option is C2RATE.
• **D2RATE**
  
The data is converted from the delta value to rate.

• **_RBDF=relative-bad-delta-factor**
  
specifies the name of the SAS macro variable that is created that contains the Relative Bad Delta Factor as a percentage. The default value of this option is RBDFTMP.

**%RMPROINT Notes**

The %RMPROINT macro converts metrics that are considered counters or deltas to rates. A counter is a metric whose value is constantly increasing. A delta is a metric whose value represents the difference between the value of a counter at the start and end of an interval of time. The rate is determined by taking the delta metric (or by calculating the delta from the counter) and dividing it by the duration of the interval. The following table lists the counters that are converted to rates for the NTSMF Adapter.

**Table A8.2  List of Counters That Are Converted to Rates for NTSMF Adapters**

<table>
<thead>
<tr>
<th>NTSMCNT Table</th>
<th>NTTCP Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALMSGKB</td>
<td>CNCACTV</td>
</tr>
<tr>
<td>EXTMSGS</td>
<td>CNCFLRS</td>
</tr>
<tr>
<td>EXTRMKB</td>
<td>CNCTPSV</td>
</tr>
<tr>
<td>INTMSGS</td>
<td>CNCTRST</td>
</tr>
<tr>
<td>INTRMKB</td>
<td></td>
</tr>
<tr>
<td>TTLMSGS</td>
<td></td>
</tr>
</tbody>
</table>

The following table lists the counters that are converted to rates for the SAR Adapter.

**Table A8.3  List of Counters That Are Converted to Rates for SAR Adapters**

<table>
<thead>
<tr>
<th>XTYTCP TABLE</th>
<th>XTYTCP TABLE</th>
<th>XTYTCP TABLE</th>
<th>XTYTCP TABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICIMDEU</td>
<td>ICOMDEU</td>
<td>IMFQGOK</td>
<td>IMRMSOK</td>
</tr>
<tr>
<td>ICIMECQ</td>
<td>ICOMECQ</td>
<td>IMFGCRE</td>
<td>IMRMSRE</td>
</tr>
<tr>
<td>ICIMECR</td>
<td>ICOMECCR</td>
<td>IMFGFLD</td>
<td>IMRSMAC</td>
</tr>
<tr>
<td>ICICERR</td>
<td>ICOMERR</td>
<td>IMIADRE</td>
<td>IMRSMFU</td>
</tr>
<tr>
<td>ICIMIPP</td>
<td>ICOMIPP</td>
<td>IMIDELV</td>
<td>IMRSMTO</td>
</tr>
<tr>
<td>ICIMISQ</td>
<td>ICOMISQ</td>
<td>MIDISC</td>
<td>IMRTDIS</td>
</tr>
<tr>
<td>ICIMITE</td>
<td>ICOMITE</td>
<td>IMIFWDD</td>
<td>IMSMFLD</td>
</tr>
<tr>
<td>XTYTCPS TABLE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ICIMMKQ</td>
<td>ICOMMKQ</td>
<td>IMIHGRE</td>
<td>INSEGS</td>
</tr>
<tr>
<td>ICIMMKR</td>
<td>ICOMMKR</td>
<td>IMIRECV</td>
<td>OUTSEGS</td>
</tr>
<tr>
<td>ICIMRED</td>
<td>ICOMRED</td>
<td>IMIUNPR</td>
<td>USINDGR</td>
</tr>
<tr>
<td>ICIMSGS</td>
<td>ICOMSGS</td>
<td>IMODISC</td>
<td>USINERR</td>
</tr>
<tr>
<td>ICIMTIQ</td>
<td>ICOMTIQ</td>
<td>IMONORT</td>
<td>USNODGR</td>
</tr>
<tr>
<td>ICIMTIR</td>
<td>ICOMTIR</td>
<td>IMOREQS</td>
<td>USOTDGR</td>
</tr>
</tbody>
</table>

For example, if you have recorded odometer mileage and the start time of each mileage reading, then the counter is mileage. When this macro is executed, the duration is determined by calculating the difference between the start times of one observation and the preceding observation. Then, the number of miles per second can be calculated for each observation. To calculate the number of miles per second, find the difference between the odometer mileage of one observation and the mileage of the preceding observation, and then divide the result by the duration in seconds.

A counter continues increasing across all intervals until it reaches its maximum value and then, typically, it resets to zero and starts again. The counter maximums are 65,536 (for a 16-bit counter), 4,294,967,296 (for a 32-bit counter), and 18,446,744,073,709,551,616 (for a 64-bit counter). Using the previous and current value of the counter and knowing the maximum limit for that particular counter, it is possible to calculate the rate for that interval, based on these assumptions:

- If the previous value is smaller than the current value, it is assumed that the counter has not reset.
- If the previous value is larger than the current value, it is assumed that the counter has reset one time.

**Note:** For information about “Length and Precision of Variables” when using any 64-bit counter, see the SAS Companion documentation for your host.

**Fast-Moving Counters**

A problem that exists, especially for 16-bit counters, is that fast-moving counters can reset more than one time during an interval. One way to resolve this problem is to sample at a shorter interval. This shorter interval would ensure that there is not enough time during the interval for the counters to reset more than once.

SAS IT Resource Management also provides another way to resolve this problem. Although SAS IT Resource Management converts counters to rates automatically, there are three macro variables that you can use to affect how the conversion is done. By default, these macro variables are set as follows:

- Macro variable CP16PCT is for use with 16-bit counters. By default, it is set as follows:

  ```
  %let cp16pct = 0.95;
  ```

  As a result of this setting, a threshold is calculated for 16-bit counters, and the threshold has the value of: 0.95 * 65536 = 62259.2.
• Macro variable CP32PCT is for use with 32-bit counters. By default, it is set as follows:

   \%let cp32pct = 0.97;

As a result of this setting, a threshold is calculated for 32-bit counters, and the threshold has the value of 0.97*4292967296 = 4164178277.

• Macro variable CP64PCT is for use with 64-bit counters. By default, it is set as follows:

   \%let cp64pct = 0.97;

As a result of this setting, a threshold is calculated for 64-bit counters, and the threshold has the value of 0.97*18446744073709551616 = 17893341751498265067.

When a rate is being determined and the current value is less than the previous value, one of the following situations might have occurred:

• If the previous value is greater than or equal to the threshold, the rate is calculated based on the assumption that one reset occurred during the interval. That is, the previous value was so close to the counter's maximum that it is possible that it was reset once during the interval.

   In this case, a "Corrected" message (see the following example) is written to the SAS log.

• If the previous value is less than the threshold, the rate is not calculated, and, instead, the rate is set to missing. That is, the previous value is so far from the counter's maximum that the counter must have been moving extremely fast to reset during the interval. And if the counter is moving that fast, it is possible that it was reset more than one time during that interval.

   In this case, a "Set to missing" message (see the following example) is written to the SAS log.

Example

The following example illustrates the situation for a 16-bit counter, assuming 5-minute intervals:

Table A8.4 Table of Counters and Calculated Rates

<table>
<thead>
<tr>
<th>Counter Value</th>
<th>Calculated Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>20000</td>
<td>.</td>
</tr>
<tr>
<td>40000</td>
<td>66.67</td>
</tr>
<tr>
<td>62260</td>
<td>72.20</td>
</tr>
<tr>
<td>300</td>
<td>11.92</td>
</tr>
<tr>
<td>4000</td>
<td>132.33</td>
</tr>
<tr>
<td>62259</td>
<td>74.19</td>
</tr>
<tr>
<td>2000</td>
<td>.</td>
</tr>
</tbody>
</table>

In the preceding table, the calculated rates for the first three counter values are computed according to the following rules:
• The first observation's rate is missing, because there is no previous value with which to calculate the difference.

• The first time the counter resets, the value preceding the reset (62260) meets (or exceeds) the default threshold of 95% for 16-bit counters (62259.2). The rate is therefore calculated based on one reset, and the following message is written to the SAS log:

(CLEANUP)Obs4 16 bit Overflow Start 01JAN01:00:10:00 SVAL=62260 Corrected End 01JAN2001:00:15:00.00 SVAL=300

• The second time the counter resets, the value preceding the reset (62259) does not meet (or exceed) the default threshold of 95% for 16-bit counters (62259.2). The rate is therefore set to missing, and the following message is written to the SAS log:

(CLEANUP)Obs 7 Inconsistent Start 01JAN01:00:25:00 SVAL=62259 Set to missing End 01JAN2001:00:30:00.00 SVAL=2000

If a large percentage of your data is producing the second type of message, the work that is measured by the counters might have increased so much that the counters are resetting more than one time within an interval. Take one or both of the following actions as needed:

• Reduce the interval at which you sample, although this will increase the volume of data that you collect.

• Lower the thresholds. For example, you could insert the following SAS statement in the process-and-reduce job before the call to the process macro:

   %let cp16pct=0.94;

   Note: As you lower the thresholds, more rates are calculated, but the rates might be incorrect because of multiple resets due to fast-moving counters.

%RMPROINT Example

If you are working with a supported adapter, this macro is submitted automatically when necessary. If you are working with user-written staging code, you must submit the macro yourself if it is needed. To do so, execute it as a separate step in a job after the data has been staged.

```sas
DATA 
   ....
   staging code goes here
   ....
   run;
   %rmpoint(...);
```

%RMRUNETL

%RMRUNETL Overview

This is the order that the ETL jobs are run by %RMRUNETL:

1. the staging job
2. the aggregation jobs  
3. information map jobs  
4. the report jobs  

Note: The aggregation, information map, and report jobs are run in parallel using Multi-Processing (MP) Connect. 

If the staging job fails, the aggregation, information map, and report jobs are not run. After each job completes, the SAS log is examined by the program. The completion status of the job (Success, Warning, or Error) is sent by e-mail to the specified recipient. If the log displays warnings or errors, the e-mail includes the text of the error or warning along with the corresponding line number in the log file.

%RMRUNETL Syntax

%RMRUNETL(  
<ADAPTER=adapter-name>  
,<AGGJOB1=path-to-aggregation-job1>,...,<AGGJOB20=path-to-aggregation-job20>  
,<AGGLOG1=path-to-aggregation-log1>,...,<AGGLOG20=path-to-aggregation-log20>  
,<EMAILFROM=sending-email-address>  
,<EMAILTO=email.address@company.com>  
,<INFOMAPJOB1=path-to-information-map-job1>,...,<INFOMAPJOB20=path-to-information-map-job20>  
,<INFOMAPLOG1=path-to-information-map-log1>,...,<INFOMAPLOG20=path-to-information-map-log20>  
,<REPORTJOB1=path-to-report-job1>,...,<REPORTJOB20=path-to-report-job20>  
,<REPORTLOG1=path-to-report-log1>,...,<REPORTLOG20=location-of-report-log20>  
,<RUNDATE=date-that-this-macro-is-run>  
,<STAGINGJOB=path-to-staging-job>  
,<STAGINGLOG=location-of-staging-log>  
);  

%RMRUNETL Required Arguments

There are no required parameters for this macro. All parameters are optional. However, you must specify at least one job in order to run this macro.

%RMRUNETL Options

- **ADAPTER=adapter-name**  
  This value is used in the subject of the e-mail messages that are sent out and in the name of the audit table. This option can be left blank.

- **AGGJOB1=path-to-aggregation-job1...AGGJOB20=path-to-aggregation-job20**  
  specifies the paths to a maximum of 20 aggregation jobs. These jobs will be run in parallel.  
  
  Note: The path must include the name of the file that contains the job.

- **AGGLOG1=path-to-aggregation-log1...AGGLOG20=path-to-aggregation-log20**  
  specifies the paths to a maximum of 20 aggregation logs.  
  
  Note: The path must include the name of the file that contains the log.

- **EMAILFROM=email.address@company.com**  
  specifies the e-mail address from which the e-mail is to be sent. If blank, this value is set to the address that is specified in EMAILTO.
• EMAILTO=email.address@company.com
  specifies the e-mail address to which the status e-mail is to be sent. If this value is blank, a warning is written in the log that e-mail is not going to be sent.

• INFOMAPJOB1=path-to-information-map-job1...INFOMAPJOB20=path-to-information-map-job20
  specifies the paths to a maximum of 20 information map jobs. These jobs will be run in parallel.
  Note: The path must include the name of the file that contains the job.

• INFOMAPLOG1=path-to-information-map-log1...INFOMAPLOG20=path-to-information-map-log20
  specifies the paths to a maximum of 20 information map logs.
  Note: The path must include the name of the file that contains the log.

• REPORTJOB1=path-to-report-job1...REPORTJOB20=path-to-report-job20
  specifies the paths to a maximum of 20 report jobs. These jobs will be run in parallel.
  Note: The path must include the name of the file that contains the job.

• REPORTLOG1=path-to-report-log1...REPORTLOG20=path-to-report-log20
  specifies the paths to a maximum of 20 report logs.
  Note: The path must include the name of the file that contains the log.

• RUNDATE=date-that-this-macro-is-run
  specifies the date that is used in e-mail messages and in log filenames. If this value is blank, it is set to today's date.

• STAGINGJOB=path-to-staging-job
  specifies the path to the staging job that you want to run.
  Note: The path must include the name of the file that contains the job.

• STAGINGLOG=path-to-staging-log
  specifies the path to the staging log that is produced by the staging job. If the STAGINGJOB option is specified, then the STAGINGLOG must also be specified.
  Note: The path must include the name of the file that contains the job.

%RMRUNETL Notes
This macro can be run in batch mode, or interactively from the SAS Display Manager. It can run Windows, UNIX, or z/OS jobs that are stored in a PDS.

 If an option for a job is specified, the corresponding log option must also be specified. For example, if there is a path specified for the AggJob2 option, the AggLog2 option cannot be left blank.
%RMRUNETL Examples

Example 1: Running a Staging Job, Two Aggregation Jobs, and a Report Job

This example shows the code that runs a staging job, two aggregation jobs, and a report job. E-mail is to be sent to and from the same e-mail address. The RUNDATE option defaults to today's date.

```sas
%rmrunetl(adapter=SNMP
   ,aggJob1=C:\jobs\_1_aggJob.sas
   ,aggJob2=C:\jobs\_2_aggJob.sas
   ,aggLog1= C:\jobs\logs\_1_aggJob.log
   ,aggLog2= C:\jobs\logs\_2_aggJob.log
   ,emailto=email@address.com
   ,reportJob1= C:\jobs\_1_reportJob.sas
   ,reportLog1= C:\jobs\_1_reportJob.log
   ,stagingJob=C:\jobs\staging.sas
   ,stagingLog= C:\jobs\logs\staging.log
 );
```

Example 2: Running an MS SCOM Job on Windows

MS_SCOM_Overall.bat: This code shows the Windows bat job that runs the MS_SCOM_Overall.sas program.

```bash
echo off

set ADAPTER=MSSCOM
set DATETIME=%date:~10,4%%date:~4,2%%date:~7,2%_%time:~0,2%%time:~3,3%
set BASE=C:\Data\Jobs\%ADAPTER%
set LOGDIR=%BASE%\logs
set JOBDIR=C:\SAS\ITRM33\Lev1\SASITRM\SASCode\Jobsset SRC=MS_SCOM_Overall
set SAS=C:\SAS\ITRM33\Lev1\SASITRM\sas.bat

%SAS% -sysin %BASE%\%SRC%.sas -log %LOGDIR%\%SRC%\_%DATETIME%.log
```

MS_SCOM_Overall.sas: This code shows the SAS program that runs all the daily jobs (staging, aggregation, and reporting) for an MS SCOM data mart.

```sas
%let adapter = %sysget(ADAPTER);
%let datetime = %sysget(DATETIME);
%let JOBhome = %sysget(JOBDIR);
%let LOGhome = %sysget(LOGDIR);

%rmrunetl(adapter = &ADAPTER
   ,stagingJob = &JOBhome\MS_SCOM_Staging.sas
   ,stagingLog = &LOGhome\ MS_SCOM_Staging_%datetime..log
   ,aggJob1 = &JOBhome\InfoStore_Aggregation.sas
   ,aggJob2 = &JOBhome\InfoStoreMailbox_Aggregation.sas
   ,aggJob3 = &JOBhome\Disk_Aggregation.sas
   ,aggJob4 = &LOGhome\System_Aggregation.sas
   ,aggLog1 = &LOGhome\InfoStore_Aggregation_%datetime..log
   ,aggLog2 = &LOGhome\InfoStoreMailbox_Aggregation_%datetime..log
   ,aggLog3 = &LOGhome\Disk_Aggregation_%datetime..log
 );
```
Example 3: HP_Perf_Agent_Overall:
This code shows the UNIX script (bash, Bourne and related shells) that runs the HP_Perf_Agent_Overall.sas program.

```bash
export ADAPTER=HPPerfAgent
export BASE=/var/opt/sas/prog/prod/$ADAPTER
export LOGDIR=$BASE/logs
export JOBDIR=/opt/sas/ITRM/itrm33srv/Lev1/SASITRM/SASEnvironment/SASCode/Jobs
export SRC=HP_Perf_Agent_Overall
export DATETIME=$(date +%Y%m%d_%H%M")ADAPTER=HPPerfAgent

SAS=/opt/sas/ITRM/SAS/SASFoundation/9.3/sas

$SAS -sysin $BASE/$SRC.sas -log $LOGDIR/"$SRC"_$DATETIME.log -noterminal -rsasuser &
```

HP_Perf_Agent_Overall.sas: This code shows the SAS program that runs all the daily jobs (staging, aggregation, and reporting) for an HP Perf Agent data mart.

```sas
%let adapter = %sysget(ADAPTER);
%let datetime = %sysget(DATETIME);
%let JOBhome = %sysget(JOBDIR);
%let LOGhome = %sysget(LOGDIR);

%rmrunetl(adapter = &adapter,
stagingJob = &JOBhome/HP_Perf_Agent_Staging.sas,
stagingLog = &LOGhome/HP_Perf_Agent_Staging_&datetime..log,
aggJob1 = &JOBhome/DiskUnix_Aggregation.sas,
aggJob2 = &JOBhome/SystemUnix_Aggregation.sas,
aggLog1 = &LOGhome/DiskUnix_Aggregation_&datetime..log,
aggLog2 = &LOGhome/SystemUnix_Aggregation_&datetime..log,
reportJob1 = &JOBhome/DiskUnix_Daily_Reporting.sas,
reportJob2 = &JOBhome/SystemUnix_Daily_Reporting.sas,
reportLog1 = &LOGhome/DiskUnix_Daily_Reporting_&datetime..log,
reportLog2 = &LOGhome/SystemUnix_Daily_Reporting_&datetime..log,
emailto = email.address@company.com
);
```
%RMVINST

%RMVINST Overview

%RMVINST verifies that the application server is correctly configured for use by SAS IT Resource Management.

**CAUTION:**

*Use this macro only under the direction of Technical Support.* This macro produces a large volume of information, the interpretation of which requires thorough knowledge of SAS IT Resource Management metadata structures.

The output produced by %RMVINST can be useful for debugging issues related to JAR files and JEOPTIONS settings.

The %RMVINST macro reports on the following issues:

- Can SAS run Java successfully?
- What version of Java is running?
- Has the location of the SAS JAR files been set with the JREOPTIONS system option?
- Are the SAS JAR files in the correct location?
- Is SAS able to access the SAS IT Resource Management JAR files?
- What version of the SAS IT Resource Management JAR files is being accessed?

To execute this macro, add it to a SAS IT Resource Management job or program that you submit from SAS.

Output from running the macro in batch is written to log and list files in the current directory or to the SAS log and list in the job output when you use z/OS batch. For more information about this macro and each of these parameters, see the documentation that is provided inside the macro.

%RMVINST Syntax

```sas
%RMVINST(
  METAPASS=user-password,
  METAPORT=metadata-server-port,
  METASERVER=name-of-metadata-server,
  METAUSER=user-ID
);
```

%RMVINST Required Arguments

- **METAPASS=user-password**
  
  specifies the password that is associated with the metauser ID.

- **METAPORT=metadata-server-port**
  
  specifies the password that is associated with the metauser ID.

- **METASERVER=name-of-metadata-server**
specifies the name of the metadata server.

- METAUSER=user-ID
  specifies the user ID that accesses the metadata server.

Note: All four parameters are required. If you do not supply a value for any parameter, %RMVINST uses the equivalent SAS option, if you have set one.

%RMVINST Example

```sas
%RMVINST(
    metapass=my-password,
    metaport=8561,
    metaserver=mybox.subdomain.domain.com,
    metauser=my-username
);
```

Backup and Recovery Macros

Overview of the Backup and Recovery Macros

The %RM_BACKUP and %RM_RESTORE macros provide an easy way for users to recover the content of failed SAS IT Resource Management staging or aggregation jobs. The following table shows the items that are managed by these macros.

<table>
<thead>
<tr>
<th>SAS IT Resource Management Transformation Type</th>
<th>Items Backed Up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staging transformation</td>
<td>Data duplication control information for this transformation</td>
</tr>
<tr>
<td></td>
<td>Staged data (if requested)</td>
</tr>
<tr>
<td></td>
<td>Deployed job code (if available)</td>
</tr>
<tr>
<td>Aggregation transformation</td>
<td>Aggregation data tables for this transformation</td>
</tr>
<tr>
<td></td>
<td>Aggregation status tables for this transformation</td>
</tr>
<tr>
<td></td>
<td>Percentile class and foreign key mapping tables for this transformation</td>
</tr>
<tr>
<td></td>
<td>Percentile data tables for this transformation</td>
</tr>
<tr>
<td></td>
<td>Stored compiled macro (“SAS IT Resource Management private code”) for this transformation</td>
</tr>
<tr>
<td></td>
<td>Deployed job code, if available</td>
</tr>
</tbody>
</table>
For each staging or aggregation transformation, there should be a corresponding execution of the %RM_BACKUP macro. This invocation of the backup macro would execute between successful runs of the staging or aggregation transformation. The backups could be done in one of the following ways:

- as a separately scheduled job
- by means of the **Precode and Postcode** tab on the Properties dialog box of the staging or aggregation transformation
- as a separate user-written transformation in the same job as the staging or aggregation transformation

### Managing the Backup and Restore Libraries

Each invocation of %RM_BACKUP uses libraries that you define and assign in order to store the items needed for recovery. To manage these libraries, it is important to determine how you want to handle recovery scenarios.

For example, you might decide to have a permanent SAS library that is always overwritten for a given backup invocation. In this scenario, you must always handle any recovery before the next regularly scheduled run for the SAS IT Resource Management job that contains the transformation that you are backing up. Otherwise, the valid backup recovery data is overwritten.

In a more likely scenario, you might define a set of recovery libraries. For example, if you want to have a 10-day recovery window, you should set up 10 libraries, one for each day of processing. Each day’s backup would use the next available library.

### %RM_BACKUP

#### %RM_BACKUP Overview

%RM_BACKUP backs up all the needed content for the given SAS IT Resource Management transformation so that recovery can be performed.

#### %RM_BACKUP Syntax

```sas
%RM_BACKUP(
  OUT=libref-of-the-backup-library
  ,METAPASSWORD=user-password
  ,METAPORT=port-of-metadata-server
  ,METASERVER=name-of-metadata-server
  ,METAUSER=user-ID
  ,TRANSFORMID=metadata-ID-of-the-ITRM-transformation
  ,<METAREPOSITORY=name-of-metadata-repository>
  ,<STAGEDDATA=Y | N>
  ,<_RC=return-code>
);
```

#### %RM_BACKUP Required Arguments

*Note:* If the SAS code that contains the macro invocation is submitted to an application server that uses token authentication (such as when submitting from the Code Editor window in the SAS IT Resource Management client), the following parameters are not required: METAPASS, METAPORT, METASERVER, and METAUSER. For
more information about token authentication, see *SAS 9.3 Intelligence Platform: Security Administration Guide*.

- **OUT=libref-of-the-backup-library**
specifies the libref of the already assigned library that is used for the content being backed up. This libref must refer to a library that has already been assigned.

- **METAPASS=user-password**
specifies the password that is associated with the metauser ID.

- **METAPORT=port-of-metadata-server**
specifies the port of the metadata server.

- **METASERVER=name-of-metadata-server**
specifies the name of the metadata server.

- **METAUSER=user-ID**
specifies the user ID that can access the metadata server.

- **TRANSFORMID=metadata-ID-of-the-ITRM-transformation**
specifies the metadata ID of the SAS IT Resource Management transformation that you want to back up. To find this value, perform the following steps:

  1. In the IT Data Marts view of the SAS IT Resource Management client, double-click to open the job that contains the transformation that you want to back up.

  2. In the **Diagram** tab of the Job Editor window, click the transformation to highlight it.

  3. Locate the Basic Properties view in the left panel of the client.

  4. Scroll down to find the metadata ID of the transformation that you highlighted.
**Display A8.1 Locating the Metadata ID**

%RM\_BACKUP Options

METAREPOSITORY=\textit{name-of-metadata-repository}

specifies the name of the metadata repository. The default for this option is Foundation.

STAGEDDATA=Y | N

specifies whether to back up the staged data, if the transformation being backed up is a staging transformation. The default for this option is N.

\textit{Note:} The default is not to back up the staged data because the recovery process typically requires this data to be staged again.

\_RC=\textit{return-code}

specifies name of the macro variable to contain the return code. The default for this option is RC.

%RM\_BACKUP Example

LIBNAME MYBKUP 'C:\mybackup';

%rm\_backup(
    metaPassword=my-password,  
    metaPort=8561,  
    metaRepository=FOUNDATION,  
    metaServer=my-server,  
    metaUser=my\_userID,  
    ...
%RM_Restore Overview

%RM_Restore restores all the content for the given SAS IT Resource Management transformation that was backed up by a previous invocation of the %RM_Backup macro. Any restored data, such as aggregation tables, status tables, and so on, is stored in the location specified by the metadata. The deployed job code is saved in the location that you specify in the JOBCODE= parameter.

%RM_Restore Syntax

%RM_Backup(
  JOBCODE=jobcode-location
 ,LIB=libref-of-the-backup-library
 ,METAPASSWORD=user-password
 ,METAPORT=port-of-metadata-server
 ,METASERVER=name-of-metadata-server
 ,METAUSER=user-ID
 ,TRANSFORMID=metadata-ID-of-the-ITRM-transformation
 <,METAREPOSITORY=name-of-metadata-repository>
 <,_RC=return-code>
);

%RM_Restore Required Arguments

Note: If the SAS code that contains the macro invocation is submitted to an application server that uses token authentication (such as when submitting from the Code Editor window in the SAS IT Resource Management client), the following parameters are not required: METAPASS, METAPORT, METASERVER, and METAUSER. For more information about token authentication, see SAS 9.3 Intelligence Platform: Security Administration Guide.

- JOBCODE=jobcode-location
  specifies the path and file where you want to save the restored deployed job.
  Note: At backup, if the job was not deployed, or the job code could not be found at the location indicated by metadata, then there is no job code to restore. A note is produced in the SAS log if there is no job code to restore.

- LIB=libref-of-the-backup-library
  specifies the libref of the library used for the content being restored. This libref must refer to a library that has already been assigned.

- METAPASS=user-password
  specifies the password that is associated with the metauser ID.

- METAPORT=port-of-metadata-server
  specifies the port of the metadata server.

- METASERVER=name-of-metadata-server
  specifies the name of the metadata server.
• METAUSER=\textit{user-ID} 
  
specifies the user ID that accesses the metadata server.

• TRANSFORMID=\textit{metadata-ID-of-the-ITRM-transformation} 
  
specifies the metadata ID of the SAS IT Resource Management transformation that you want to restore.

\%\textsc{RM\_RESTORE} Options

\textbf{METAREPOSITORY=}\textit{name-of-metadata-repository} 
  
specifies the name of the metadata repository. The default for this option is \textit{Foundation}.

\textbf{\_RC=}\textit{return-code} 
  
specifies name of the macro variable that contains the return code. The default for this option is \textit{RC}.

\%\textsc{RM\_RESTORE} Example

\begin{verbatim}
LIBNAME mybkup 'c:\mybackup' access=readonly;

%rm_restore(
   jobcode=my-jobcode-location,
   lib=mybkup,
   metaPassword=my-password,
   metaPort=8561,
   metaRepository=FOUNDATION,
   metaServer=my-server,
   metaUser=my-userID,
   transformid=A5HVVOMR.BV00019I, /* metadata ID of the transformation */
   _rc=my-return-code
);
\end{verbatim}
Appendix 9
Best Practices and Troubleshooting Tips

How to Back Up SAS IT Resource Management ........................................... 538
Introduction to the Backup Process ............................................................... 538
Scenario: Recovery of Metadata, Data, and Reports After a Job Fails ............... 538
Backing Up Metadata .................................................................................. 539
Backing Up Data ......................................................................................... 539
Backing Up Reports .................................................................................... 540
Backing Up Other Reporting-Related Content ............................................. 540

Debugging Problems in SAS IT Resource Management .............................. 541
Problems with the SAS IT Resource Management Client ............................... 541
Problems with the SAS Metadata Server .................................................... 542
Problems with the Object Spawner and Workspace Server ......................... 542
Client Logging Files .................................................................................... 542
Server Logging Files ................................................................................... 543
Turning On Standard Execution-time Debugging (ETLS_DEBUG) ................. 543
Turning On Additional Execution-time Debugging (LOGGERLEVEL) .......... 543
Investigating Problems Using Java from SAS Foundation ......................... 543

Tips for Working with SAS IT Resource Management Client ..................... 544

Tips for Working with the IT Data Mart ....................................................... 544
Managing IT Data Marts ........................................................................... 544
Archiving Your Data .................................................................................. 545
Storing Data Tables on z/OS Systems ......................................................... 545
Deleting IT Data Marts ............................................................................. 545

Tips for Working with Aggregations ......................................................... 546

Tips for Working with Information Maps .................................................... 546
Using SAS Information Map Studio ............................................................. 546

Tips for Installing and Configuring SAS IT Resource Management .......... 547
Installing and Configuring SAS IT Resource Management ......................... 547

Handling Holidays ..................................................................................... 547
Overview of Handling Holidays .................................................................. 547
Example of Handling Holidays .................................................................. 549

Performance Issues ................................................................................... 552
How to Back Up SAS IT Resource Management

Introduction to the Backup Process

The backup process takes a snapshot of the current state of the SAS IT Resource Management system. It is useful for record-keeping purposes to take backups before you make major changes to the tables and transformations in your system. Another good practice is to run the backup process nightly either before or after the system is being updated with new data.

Back up your SAS IT Resource Management system consists of backing up four separate areas of content:

- Metadata
- Data
- Reports
- Other miscellaneous content

**T I P** For best results, establish a formal, regularly scheduled backup process. It is important to back up all the above items at (approximately) the same point in time so that related information is synchronized. This practice is crucial if a restore becomes necessary.

Make sure that a backup process is put into place immediately after SAS IT Resource Management is initially deployed, and that backups are taken before major changes are made to the system. This practice will help the data administrator recover your system in the event of an error.

For information about backing up your system, see SAS Intelligence Platform: System Administration Guide at http://support.sas.com/documentation/index.html.

Scenario: Recovery of Metadata, Data, and Reports After a Job Fails

In the following scenario, someone updates the metadata server and inadvertently corrupts it. The error is not discovered until the next day's processing of the daily job fails. The regular backup schedule that is shown here enables the data administrator to restore the metadata server. It also shows how a good backup schedule can be used successfully, avoiding the reloading of multiple days of data.

- **Day 1**
  - At 2:00 a.m., the daily job is started.
  - At 4:00 a.m. (or as soon as the daily job finishes), the backup job runs, creating generation N of the metadata, data, and reports.
  - Later in day 1, the metadata server is corrupted. The problem is not discovered at this time.

- **Day 2**
  - At 2:00 a.m., the daily job is started.
  - At 4:00 a.m. (or as soon as the daily job finishes), the backup job runs, creating generation N + 1 of the metadata, data, and reports.
• Later in day 2, the error in the metadata server is discovered. The system administrator can restore the metadata, data, and reports from the backup that was made on day 1 (generation N), and rerun the daily job.

Note: The same schedule of regular backups for the metadata server that is described in this scenario should be used for backing up data, reports, and other report-related objects.

**Backing Up Metadata**

Metadata for SAS IT Resource Management is stored in the SAS Metadata Server. The following is a partial list of some operations that result in metadata being updated:

- An IT data mart is created or modified.
- The Adapter Setup wizard is executed.
- Staged tables or aggregations tables are created or modified.
- Jobs are created or modified.
- Reports are published with the ITRM Gallery task in SAS Enterprise Guide.
- Information maps are created or modified.

The data administrator should back up the metadata either before or after these or similar activities.

Note: Metadata is not updated during the execution of the daily ETL or report jobs.

The SAS 9.3 Metadata Server includes a new server-based facility that performs metadata server backups automatically on a scheduled basis. This facility can also be used to perform ad hoc backups and roll-forward recovery. The facility replaces the %OMABAKUP macro, which was available in SAS 9.1 and 9.2, and the Backup and Restore Wizard in SAS Management Console, which was available in SAS 9.2. For complete instructions for backing up the SAS Metadata Server, see Part 4, “Backing Up and Restoring Your SAS Content,” in the *SAS Intelligence Platform: System Administration Guide*. This documentation is located at [http://support.sas.com/documentation/index.html](http://support.sas.com/documentation/index.html).

Tip: If you stop the SAS Metadata Server to do a backup, any servers in your system that access the Metadata Server might be adversely affected.

**Backing Up Data**

SAS IT Resource Management stores data in files that reside in the customer’s physical file system. These files are pointed to by metadata objects in the IT data mart. Typically, all physical files for a single IT data mart reside underneath the root path of an IT data mart. You can use the Base SAS DATASETS or COPY procedures, operating systems commands, or third-party tools to copy all of the files and subdirectories beneath this root path to a backup location. This backup procedure should be done for all IT data marts.

For best results, you should back up the entire contents of the IT data mart, instead of selecting specific files or directories. In other words, make sure that your backup procedure includes the aggregation tables, staged tables, and the ADMIN and SPIN libraries.
**Backing Up Reports**

SAS IT Resource Management uses SAS Content Server, a WebDAV server, to store report output. Report output is created by the report jobs and is displayed in Gallery Manager. In addition, other SAS products that are included with SAS IT Resource Management, such as SAS Web Report Studio and SAS Information Delivery Portal, use SAS Content Server for storage of their reports and supporting files.

To back up SAS Content Server, perform the following steps:

1. Stop either the Web application server or the SAS Content Server application.
   - If you are using a JBoss Application Server, then you must stop that Web application server.
   - If you are using an IBM WebSphere Application Server Network Deployment or an Oracle WebLogic Server, then you must stop the SAS Content Server application.

   *Note:* If you stop the SAS Content Server to do a backup, any servers in your system that access the SAS Content Server might be adversely affected.

2. Use operating systems commands or third-party tools to copy all the files and subdirectories from the middle tier platform to a backup location.
   - If your middle tier platform is on Windows, back up the files and subdirectories that are in this location: `<SAS-configuration-directory>\Lev1\AppData\SASContentServer\Repository`.
   - If your middle tier platform is on UNIX, back up the files and subdirectories that are in this location: `<SAS-configuration-directory>/Lev1/AppData/SASContentServer/Repository`.

3. Start your Web application server or SAS Content Server application.

**Backing Up Other Reporting-Related Content**

If updates are made to any copies of SAS Enterprise Guide projects that are used for reporting in SAS IT Resource Management, then those user-owned copied projects should be backed up by using operating system commands or third-party tools. If you installed the supplied SAS Enterprise Guide projects, they can be accessed by navigating to the location where you installed SAS IT Resource Management. The projects are located at `SASITResourceManagementSASEnterpriseGuideComponents\3.3`. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at `C:\Program Files\SASHome\x86\SASITResourceManagementSASEnterpriseGuideComponents\3.3`.

*Note:* Making changes to supplied SAS Enterprise Guide projects is strongly discouraged. If you must change a project, copy the project and make your changes to that copied version of the project.

Users of Gallery Manager can create galleries and gallery folders. You might want to back up those items so that they do not have to be manually re-created in the unlikely event of a system failure. If so, you should use operating systems commands or third-party tools to copy all of the files on the middle tier platform:

- If your middle tier platform is on Windows, back up the files that are in this location: `<SAS-configuration-directory>\Lev1\AppData\ITMGalleryManager`.
Debugging Problems in SAS IT Resource Management

If you are experiencing problems with SAS IT Resource Management, make sure that you have the most current hot fix for IT Resource Management and for other products included in the software bundle. Hot fixes can be found at http://support.sas.com under the **Downloads and Hot Fixes** section. The correct third-party software support levels can be found at **Third-Party Software Reference**.

### Problems with the SAS IT Resource Management Client

If the SAS IT Resource Management client does not start, there might be a problem with the Java Virtual Machine (JVM) that is being used, or with the settings in the sasitrm.ini initialization file.

- The JVM is specified in the sassw.config file. (By default, this file is located in `C:\Program Files\SASHome\sassw.config`). Make sure that it satisfies the criteria that are listed under the **Third-Party Software Reference**. In addition, make sure that this JVM is correctly installed at the specified location.

- If you made any post-installation changes to the sasitrm.ini initialization file, verify that the changes were correctly made. Typographical errors can prevent the client from initializing properly.

If the client fails to connect to the metadata server that is specified in the login profile, verify the following items:

- The metadata server is operational.
- The metadata server is at an appropriate software version level for the client that you are using.
- The metadata server machine itself is accessible from the client on the network.
- The user ID and password are correct and the user can be properly authenticated on that server.

Some client operations create log files on the client machine, based on the Windows APPDATA environment variable. To see the current setting of the APPDATA environment variable, issue the following command in a DOS command prompt window:

```
SET APPDATA
```

The SAS IT Resource Management client creates logs during the execution of these tasks of the Adapter Setup wizard:

- adding new aggregation tables
- maintaining staged tables
- creating an IT data mart

These logs can be found in `-APPDATA%\SASITResourceManagement\version`. (For example, the logs for SAS IT Resource Management 3.3 can be found at `%APPDATA%\SASITResourceManagement\33.`)
**Problems with the SAS Metadata Server**

The metadata server log can be used to diagnose failures that are related to metadata, including failure to connect to the metadata server. This log is available in the SAS configuration directories, under the `MetadataServer` subdirectory, in a `Logs` folder. By default, the logs are time-stamped. An examination of the relevant log can show problems in authenticating users, problems in the metadata server configuration, and other issues.

The logging level for the metadata server can be changed to increase the level of detail. For information about changing the logging level and many other useful topics, see the *SAS 9.3 Intelligence Platform: System Administration Guide*.

For information about security and authentication, see the *SAS 9.3 Intelligence Platform: Security Administration Guide*.

**Problems with the Object Spawner and Workspace Server**

If the SAS IT Resource Management client can successfully connect to the appropriate metadata server, but the user cannot start a workspace server session, verify that the object spawner is correctly started on the appropriate server machine.

Also verify that the user is correctly authorized to create workspace server sessions.

By default, the object spawner performs only limited logging. However, both the object spawner and, specifically, the workspace server can have the level of logging detail increased. All servers, such as the SAS Metadata Server, the object spawner, and the application and workspace servers, can be configured to have logs. These logs can be useful in diagnosing problems. For information about configuring logging for these servers, see “Administering Logging for SAS Servers” in the *SAS 9.3 Intelligence Platform: System Administration Guide*.

For information about configuring servers, including setting up users and groups, see the *SAS 9.3 Intelligence Platform: Installation and Configuration Guide*. This document also includes a troubleshooting appendix.

**Client Logging Files**

The IT Resource Management Client automatically keeps log files for certain operations such as the following:

- creating an IT data mart
- running the Adapter Setup wizard
- adding staged tables

These log files can be useful to you or to Technical Support personnel, when investigating a problem.

On the client, these log files are located in a directory that is determined based on the `APPDATA` environment variable.

- On Windows XP, this location is typically `C:\Documents and Settings \userid\Application Data\SASHome\SASITResourceManagement \3.3`.
- On Windows 7, this location is typically `C:\Users\userid\AppData\Roaming \SASHome\SASITResourceManagement\3.3`.
Server Logging Files

All servers, such as the SAS Metadata Server, the object spawner, and the application and workspace servers, can be configured to have logs. These logs can be useful in diagnosing problems. For information about configuring logging for these servers, see “Administering Logging for SAS Servers” in the SAS Intelligence Platform: System Administration Guide.

Turning On Standard Execution-time Debugging (ETLS_DEBUG)

To turn on execution-time debugging in the generated code for SAS Data Integration Studio and SAS IT Resource Management transformations, add the following line to the generated code, before the transformation for which you would like additional debugging information: %LET ETLS_DEBUG=1;

Turning On Additional Execution-time Debugging (LOGGERLEVEL)

To turn on additional execution-time debugging information in the generated code for SAS IT Resource Management transformations, add or edit the following line to the generated code before the transformation for which you would like additional debugging information: %LET LOGGERLEVEL=[level];

This is the standard way of turning on debugging transformations in SAS IT Resource Management. (For SAS IT Resource Management 2.7 users, the LOGGERLEVEL flag replaces the CPDEBUG macro flag).

Legal values for [level] include: FATAL, ERROR, WARN, INFO, DEBUG, or TRACE. Users who want additional debugging information should set the level to DEBUG:

%LET LOGGERLEVEL=DEBUG;

Investigating Problems Using Java from SAS Foundation

Some features that use Java from SAS Foundation. These features include PROC INFOMAPS, the Information Map LIBNAME engine, and the migration of IT Resource Management 2.7 PDBs to IT data marts supported in SAS IT Resource Management 3.3 and later. For problems in running Java from SAS, use the following techniques to investigate whether SAS is configured correctly to use Java:

- Verify that the Java JVM can be started, and that it is the correct version of the JVM. To do so, submit this SAS statement:

  proc javainfo all; run;

  The results of this code will include JVM details and properties. This statement can be added to the SAS code of a deployed job, or submitted directly from the Tools ➪ Source Editor menu item in SAS Data Integration Studio.

- Check the JREOPTIONS settings to make sure that the Java options are correct, particularly in these elements:
  - Memory options such as -Xmx are specified according to the installation and configuration documents.
  - To see the current JREOPTIONS, submit this SAS statement:
Proc options
option=jreoptions; run;

This statement can be added to the SAS code of a deployed job, or submitted directly from the Tools Source Editor menu item in SAS Data Integration Studio.

Note: When running jobs in SAS Foundation, make sure that SAS is invoked using the appropriate configuration files because these files have been written specifically for use by SAS IT Resource Management.

Troubleshooting Error Messages in the SAS Log

Error message is displayed in the SAS log: “ERROR: Failed to insert filter” or “ERROR: Failed to insert data source.”

Make sure that the user who is running the job has the proper authorizations. To do so, open the SAS Management Console and perform the following steps:

1. Set the repository to Foundation.
2. In the User Manager component, select the user profile of the person who is running the job.
3. On the Logins tab, locate the entry for the authentication domain of the workspace server that was in use at the time of the error. (Each workspace server has an authentication domain.) The user ID and the password should be specified. The password cannot be left blank.

Note: Whenever the server is reset, the password might not have been saved. (A password field of asterisks does not necessarily contain your password.) In this case, you should manually update your password.

Tips for Working with SAS IT Resource Management Client

On any Properties dialog box, after you make a change to a field, use the Tab key to move out of that field. Then click Apply to make sure your changes are reflected in the metadata.

Tips for Working with the IT Data Mart

Managing IT Data Marts

Here are some tips that can help you manage IT data marts effectively:

• Do not create IT data marts with duplicate names. If IT data marts do not have unique names, generated information maps might not be placed in the correct job.
• Store all data and information maps in the IT data mart.
• You can create IT data marts in different folders. The choice of a parent folder should reflect your intended use. For example, if you intend to share access to a new
IT data mart, the /Shared Data/SAS IT Resource Management/IT Data Marts location is a logical place to create it. The /Products and /System folders are intended for product configuration files. Users are not typically permitted to write to these folders. Therefore, do not create IT data marts in those folders.

- The organization of your site's data into IT data marts depends on your site's needs. You do not have to put data from multiple adapters into the same IT data mart, and you are not prevented from doing so. If you decide to use multiple IT data marts, you can still combine data from the various IT data marts using information maps or other similar techniques.

**Archiving Your Data**

SAS IT Resource Management does not provide an automated archiving feature. However, archiving is easy to accomplish. If you want to archive your staged data, in the staging job add another transformation that copies the staged table to a secure location. To do so, you can use the Extract or User-Written Code transformations that are provided by SAS Data Integration Studio in the Data section of the Transformations tree. (For information about these transformations, see “Working with Extract Transformations” and “Working with User-Written Code” in the Help for SAS Data Integration Studio.)

**Storing Data Tables on z/OS Systems**

For best results, store data tables in the UFS file system instead of the traditional z/OS file system.

*Note:* The documentation for SAS on z/OS has traditionally used the terms UNIX System Services (USS) and hierarchical file system (HFS) to refer to the UNIX file system on z/OS. The SAS 9.3 documentation uses the terms UNIX file system and UFS to refer to this file system. UFS provides a hierarchical storage system (like UNIX or Windows) with outstanding performance. Using UFS for storing data tables can simplify the management of these tables and offer performance benefits over the traditional z/OS file system.

**Deleting IT Data Marts**

Here are some tips that can help you delete IT data marts effectively:

- Deleting an IT data mart might take a long time, depending on the contents of that IT data mart.

- When the IT data mart was created, the physical location for the Admin library was created. As certain wizards are executed, such as the Adapter Setup wizard, other physical locations are created. These physical locations each contain a readme.txt file that carries information about the IT data mart to which the library belongs. When that IT data mart is deleted, the physical tables that belong to that IT data mart are deleted. However, the directory structure is not deleted, and the readme.txt files remain for identification purposes. The physical directories that belonged to a deleted IT data mart are empty and can be removed from the location where they were specified.
Tips for Working with Aggregations

Here are some tips that can help you specify ID variables effectively in aggregations:

- **ID column suggestions**
  A useful technique for specifying ID variables is to choose columns that are based on or determined by the value of a column that is already in the class list. An example of this is to choose DATE-based or DATETIME-based columns that are less granular than the aging column.

  For example, consider the case where you have an aggregation that is aged according to the DAYDATE column, which records daily date values. The columns WEEKDATE and MONTHDATE are excellent candidates for use as ID columns because they are (essentially) determined by the value of DAYDATE. Thus, when creating reports, you can easily determine the days that belong with a particular week.

  The same is true for other types of date or datetime-based columns that the user might create, such as a column that represents the calendar quarter or accounting period.

- **ranking of DATE/DATETIME-based class or ID columns**
  This tip is a corollary to choosing ID columns based on date, or datetime values. If you have such columns in the class or ID list, then requesting a descending rank on such a column simplifies the report task of reporting on the "last N time periods" (such as the past three weeks). For example, if WEEKDATE is an ID column in an aggregation that has DAYDATE in the class list, then a descending rank on WEEKDATE facilitates reporting on the past three weeks of daily values. The report simply needs to filter where WeekDateRankDescending >= 3. (All the supplied aggregations and information maps make use of this feature.)

Tips for Working with Information Maps

**Using SAS Information Map Studio**

You can use SAS Information Map Studio to test existing information maps and to create more complex information maps that join tables, establish pre-filters, and change aggregation statistics. If you do modify an existing information map with SAS Information Map Studio, save the new map under a different name.

**Troubleshooting Problems with Information Maps**

You receive the following error message "ERROR: Failed to insert filter filter name."

This error message is displayed in the SAS log if the user does not have the following privileges: Read Metadata, Write Metadata, Read, and Delete. This error message might also be displayed if the user's password is not registered in SAS Management Console. To register this password, perform the following steps:

2. Select the Foundation repository.

3. Select User Manager to display the list of user names that can be accessed on this repository.

4. From the list of names, select the user whose password you want to register.

5. Double-click to open the Properties dialog box for that user.

6. Click Modify to open the Edit Login Properties dialog box.

7. Select the Logins tab.

8. Enter the password of the user in the Password and the Confirm Password fields.

9. Click OK.

10. Click OK to return to the list of user names displayed by the User Manager.


---

**Tips for Installing and Configuring SAS IT Resource Management**

**Installing and Configuring SAS IT Resource Management**

Here are some tips that can help you install and configure SAS IT Resource Management effectively:

- Customizations have been made to the application server configuration (sasv9.cfg) and autoexec (appserver_autoexec.sas) files for SAS IT Resource Management. If you need to make additional customizations for site-specific reasons, you should instead modify sasv9_usermods.cfg or appserver_autoexec_usermods.sas.

- The metadata repository for SAS IT Resource Management can become very large, and the SAS Metadata Server also requires substantial memory. Install the physical repository on the fastest media available. Allocate the SAS Metadata Server as much memory as possible.

- Starting and stopping the servers can require several minutes.

- Occasionally, when starting the Object Spawner immediately after starting the SAS Metadata Server, the Object Spawner will fail because it is attempting to contact the SAS Metadata Server. To avoid this situation when automating start-up and shutdown procedures, put sleep or delaying steps into the scripts. This action allows the SAS Metadata Server to fully initialize before the Object Spawner attempts to contact it.

---

**Handling Holidays**

**Overview of Handling Holidays**

SAS IT Resource Management 3.3 does not implement any specific holiday support. However, you can use the features of SAS IT Resource Management 3.3 to prevent data
that was generated on a holiday from being processed into an aggregation table. To accomplish this goal, perform the following steps.

1. If your site’s holidays can be specified as individual dates, define a SAS format to identify them. To do this, create a format that defines whether a given date is a holiday. For best results, create this format in the ADMIN library of the IT data mart. (This library is included in the SAS format search concatenation.)

You might want to specify holidays by using different date or datetime measurements (such as 8 AM on a given date). To do so, keep the entire holiday list in the source code of a formula. (This method is explained in the next step.)

*Note:* It is preferable to use formats to define holidays because formats can be easily revised to reflect changes to the list of holidays. In addition, you do not need to redeploy any jobs. If you use formulas to define your list of holidays, any changes to that list require that jobs be redeployed.

2. Define a formula in the SAS IT Resource Management client that identifies holidays. This formula will be used to create a computed column in the staged table.

To create a formula, select `File → IT Resource Management → Formula`. The New Formula wizard opens. On the General Information page of the wizard, specify a name for the formula. On the Expression page, enter the code to assign the `Y` or `N` value to the computed column. If you created a format in the previous step, use it in this formula.

In some cases, the holiday rule is not a simple assignment statement, based on a format. The rule that identifies whether data is generated on a holiday might require a more complex expression.

*Note:* If an expression is revised in order to accommodate a change in the list of holidays for a site, you will be required to redeploy the jobs that use that formula. For information, see “About Formulas” on page 111.

3. Specify a distinct value for SHIFT if the data is for a holiday. To do this, you must modify the SHIFT formula to include the code to handle the holiday.

*Note:* Formulas cannot use other formulas because the order of computation is not guaranteed.

For information about the effects of changing a formula expression, see “Consequences of Changing a Formula” on page 117.

*Note:* To propagate any change to formulas used in existing jobs, you must redeploy those jobs.

4. To define a computed column in your staged table, you can use the holiday formula. You can also use the SHIFT formula for this purpose. This computed column specifies whether the data in this row of the table was generated on a holiday. For information about adding a computed column to a staged table, see “Modify a Staged Table” on page 138.

5. Define an input filter that prevents holiday data from being processed into the aggregation tables. You can define filters for the aggregation table in the Aggregation transformation that generates the table. To do so, perform the following steps:

   a. Double-click the job that contains the Aggregation transformation. The job opens in the Diagram tab of the Job Editor window

   b. Right-click the Aggregation transformation. From the Properties dialog box, select the ITRM Options tab. On this tab, you can define a filter by clicking
New. In the List of Filters box, you can add a filter that can be used for this Aggregation transformation.

*Display A9.1*  ITRM Options Tab

Note: Set the filter so that data that satisfies its conditions is the only data that is processed.

After you specify the holiday filter, click **OK** and save the job.

6. After the filter is added to the Aggregation transformation, you can use it with one or more aggregation tables that are generated by this transformation. To apply a filter to an aggregation table, do one of the following two steps.

- For a new aggregation table that you want to create, right-click the Aggregation transformation and select **Add Aggregation Table** from the Properties dialog box. Select the type of table that you want to create (summarized or simple.) Respond to the prompts of the wizard that opens. On the second page of the wizard, you can select the holiday filter that you want to use. When you have completed entering the information for the table, click **Finish** and save the job.

- For an existing aggregation table, right-click the table and select **Edit Summarized Aggregation Table** or **Edit Simple Aggregation Table** from the Properties dialog box. Then navigate to the Apply Filter page of the wizard and select the holiday filter that you want to use. When you have completed editing the table, click **Finish** and save the job.

  Note: Implementing a filter does not change existing data in a table.

  Note: Newly created jobs or jobs that have been changed must be saved and redeployed. For information about redeploying jobs, see “Redeploy All Jobs on the Server” on page 314.

**Example of Handling Holidays**

**Overview of the Example**

In this example, a format is specified that defines Christmas Day as a specific holiday. A formula is created that uses the holiday format to specify a Holiday column. The Holiday column is added to a staged table as a computed column. This computed column will
contain a Y for every row of data whose date column corresponds to the definition of the holiday.

After the staged table is populated with the computed Holiday column, a filter is created in the Aggregation transformation. The filter prevents holiday data from being processed into the aggregation table. This filter can be implemented for any aggregation table that is created or updated by that Aggregation transformation.

**Creating the Format**

The following code creates a SAS format that specifies the Christmas holiday for 2010 and 2011. The resulting value of holiday is a single-character of ‘Y’ or ‘N’ that indicates whether the date of the data is a holiday.

```sas
libname ADMIN BASE "c:\datamarts\smfasw\admin";
proc format library=admin;
value holiday (default=1 min=1 max=1)
'25Dec2010'd = 'Y'
'25Dec2011'd = 'Y'
other = 'N';
run;
```

**Creating the Formula**

The following formula uses the value of the `holiday` format to define the Holiday column.

```sas
Holiday = PUT(DAYDATE,holiday.);
```

**Note:** Add the Holiday column to the staged table as a computed column. This column can be used as a filter to exclude from the Aggregation transformation all data that was generated on a holiday. The filter ensures that only data that is not a holiday will be processed.

**(Optional) Including the Holiday Specification in the SHIFT Formula**

Suppose your SHIFT formula currently has the following expression:

```sas
if weekday(datepart(datetime)) in (1,7) then shift = '3';
else if timepart(datetime) < '08:00:00't or
    timepart(datetime) >= '17:00:00't then shift = '2';
else shift = '1';
```

In order to accommodate the holiday specification, change this expression as follows:

```sas
if put(DAYDATE,holiday.) eq 'Y' then shift = '0';
else if weekday(datepart(datetime)) in (1,7) then shift = '3';
else if timepart(datetime) lt '08:00:00't or
    timepart(datetime) ge '17:00:00't then shift = '2';
else shift = '1';
```

**Define an Input Filter for Holiday Data in an Aggregation Transformation**

Open the job that contains the appropriate Aggregation transformation. Right-click the transformation. On the Properties dialog box of the Aggregation transformation, select the ITRM Options tab. Click New to define the following filter. In the following display, the Holiday filter has this expression:
Holiday eq 'N'

**Display A9.2  ITRM Options Tab**

Click **OK**.

**Use the Holiday Filter with One or More Aggregation Tables**

The Aggregation wizards enable you to specify the Holiday filter for your aggregation table. The following display shows the page of the Aggregation wizards where you can select the filter.

*Note:* The filter is an inclusive filter. Data that satisfies the conditions of the filter is processed into the aggregation table.
After you select the input filter, save the job and redeploy it for execution.

*Note:* The input filter does not affect data that is already in the aggregation table. However, it will filter any new incoming data to the aggregation table.

---

**Performance Issues**

**Improving Memory Performance**

*Out-of-memory issues can cause ETL jobs to fail.*

To resolve out-of-memory issues on UNIX platforms, set the following SAS options as shown:

- `MEMSIZE=512M`
- `SORTSIZE=256M`
- `BUFSIZE=48K`
- `BUFNO=1500`

To resolve out-of-memory issues on z/OS platforms, set the following SAS options as shown:

- `SORTSIZE=256M`
- `BUFSIZE=48K`
• BUFNO=1500

Note: In addition, using SAS IT Resource Management software on z/OS requires that batch jobs have a REGION of at least 1024M. A parallel ASSIZEMAX of 1024M is also required.

To resolve out-of-memory issues on Windows (64-bit) platforms, set the following SAS options as shown:

• MEMSIZE=2G
• SORTSIZE=256M

Tip: SAS options can be set at configuration time, invocation time, or run time.

If you use the Adapter Setup wizard and specify multiple domains, particularly if you simultaneously specify a full configuration level or multiple time periods, you might experience job failure due to an out of memory condition. To correct this problem, split the jobs into smaller pieces by running the Adapter Setup wizard several times with fewer domain categories, for example, only three domains.

Note: If you continue to experience out-of-memory issues, you might need to further increase the value of the MEMSIZE option. For information about metadata memory issues, see “Metadata Server Memory Issues” on page 31.

Limiting the Processing of SMF Records by System

An aggregation filter can be used to limit the SMF records that are processed into an aggregation table to specific systems. However, the staging code must process the data that will not be aggregated. In addition, the filter must be set on each SMF aggregation. It is more efficient to filter data during the staging job processing.

To limit the SMF records to process only specific systems during a staging job process, add an IF statement in the IMACFILE MXG SOURCLIB member. For example, if you want to process only those records from the 'PROD' and 'TEST' systems, place a copy of the IMACFILE MXG SOURCLIB member into your MXGUSER source library.

Modify the user IMACFILE MXGUSER member with the following SAS statement:

IF SYSTEM IN ('PROD','TEST');   /*Only process records for these systems */

where the systems for which you want to process SMF records are listed in the IN clause. For additional examples or information about coding the IF statement, please refer to the documentation found in the IMACFILE MXG SOURCLIB member.

Note: Make sure you have a working backup copy of your SAS IT Resource Management installation files and IT data marts before you make any changes.

Staging Jobs Fail Due to Lack of Space

Staging job fails due to lack of space on the WORK library on Windows.

The location of the Work library defaults to the user's C: drive. The space on this drive might not be adequate for running a staging job. To resolve this issue, edit the sas.cfg file to point WORK to a location that has more space.

Aggregation Jobs Require Lengthy Processing Times

Some aggregation jobs that contain rank variables or join columns can require a long time to finish.

For best results, minimize the number of rank variables or join columns that you specify in a summarized aggregation table.
Information Map Jobs Require Lengthy Execution Times

Executing a job that contains multiple information maps can take a long time. Information maps facilitate the process of generating reports on your IT data and are the required input to SAS Web Report Studio. Jobs that generate many information maps can take a long time to execute. Although SAS Enterprise Guide can generate reports from tables or information maps, using information maps is preferred.

The Adapter Setup wizard creates separate jobs for Information Map transformations. You do not need to schedule these Information Map jobs to run nightly. These Information Map jobs need to be run initially only once—after the underlying tables are written, and later if something changes about the structure of the tables for which information maps are to be created. For example, if you change the class columns or statistics in an Aggregation transformation, that will change the resulting aggregation table. In that situation, the corresponding Information Map must be re-created as well.

If you are sure that you will never use specific information maps, remove the unneeded Information Map transformation from the Process Flow Diagram before you deploy the job.
SAS IT Resource Management can calculate the following statistics:

- count
- geometric mean
- harmonic mean
- maximum
- mean
- minimum
- number missing
- population coefficient of variance
- population standard deviation
- population variance
- range
- sample coefficient of variance
- sample standard deviation
- sample variance
- sum
- uncorrected sum of squares
- weighted geometric mean
- weighted harmonic mean
- weighted mean
- weighted population coefficient of variance
- weighted population standard deviation
- weighted population variance
- weighted sample coefficient of variance
- weighted sample standard deviation
- weighted sample variance
- weighted sum
- weighted uncorrected sum of squares
SAS IT Resource Management can also calculate the period-to-period percent change of a statistic within class combination.
Index

**Special Characters**
- %RMDELPVT macro 503
- %RMDUPCHK macro 506
  - example 509
  - notes 509
  - options 508
  - required arguments 506
  - syntax 506
- %RMDUPDSN macro 509
  - example 510
  - notes 510
  - required arguments 509
  - syntax 509
- %RMDUPINT macro 510
  - example 510
  - notes 510
  - syntax 510
- %RMDUPUPD macro
  - example 511
  - notes 511
  - syntax 511
- %RMMSBMCP macro 511
  - options 512
  - required arguments 512
  - syntax 512
- %RMMSDTPS macro 513
  - options 514
  - required arguments 514
  - syntax 514
- %RMMSSCOM macro 515
- %RMMSSSNMP macro 518
  - options 518
  - required arguments 518
  - syntax 518
- %RMPROINT macro 520
  - example 524
  - notes 521
  - options 520
  - required arguments 520
  - syntax 520
- %RMRUNETL macro 524
  - options 525
  - required arguments 525
  - running an overall job 315
  - syntax 525

**A**
- access command 401
- accessibility 14
- adapter and domain category specifications 469
- Adapter Setup wizard 45
  - about 209
  - accessing and navigating 211
  - advantages of 210
  - aggregation jobs and objects created by 229
  - creating jobs 212
  - creating metadata for aggregation tables 151
  - deploying and running jobs created by 238
  - determining if reporting jobs will be created by 233
  - domain categories 237
  - generating jobs 296
  - information map filters created by 254
  - information map jobs and objects created by 232
  - information map objects created by 252
  - IT data processing 296
  - jobs created for domain categories 443
  - jobs types created by 224
  - libraries created by 235
  - log file created by 236
  - naming conventions 210
  - naming information map filters 254
  - naming information map objects 253
  - purpose of 4
  - renamed Quick Start wizard 13
reporting jobs and objects created by 233
staging jobs and objects created by 228
steps to complete 211
storing generated objects 226, 297
storing information map objects 253
adapter-based subfolders 56
adapters 13, 79
external names 145
MXG based, filerefs for 316
MXG views 371
staging data 87
staging parameters for 411
supported 325
template tables 87
types of 80, 325
Admin Library 55
age limit, for data acquisition table 400
aggregating staged tables 9
aggregation concepts 467
jobs created by Adapter Setup wizard 229
table groups and time periods 468
wizards 46, 152
aggregation table wizards 46
aggregation tables 149
adding columns 187
cloning 185
computed columns in 143
creating metadata with Adapter Setup wizard 151
creating metadata with aggregation wizard 152
creating with New Aggregation Table through Templates wizard 183
deleting filters from 204
deleting from Aggregation transformation 189
deleting from IT data marts 189
editing 190
erasing 190
generating physical aggregation table 152
indexing 194
libraries for 236
modifying 190
properties 153
publishing 192
purging data from process flow diagram 192
purging data on IT Data Marts tab 193
renaming 193
setting up Aggregation transformation in process flow diagram 160
simple 149
summarized 149
Aggregation transformation 9, 13
Aggregation transformation filters 201
accessing ITRM Options tab 202
defining 202
deleting 203
Expression Builder and 205
modifying 204
Aggregation transformations 9, 197
creating metadata with aggregation wizard 152
deleting aggregation tables from 189
deleting from jobs 200
properties 197
renaming 201
setting up in process flow diagram 160
aggregations
options for summarized aggregation tables 165
specifying criteria 166
analysis columns
creating statistics for 168
applications data sources 82, 327
architecture 6
ASG TMON2CIC adapter, customizations 374
ASG TMONC2CIC staging parameters 411
ASG TMONDB2 staging parameters 412
ASUMCICX
customizations for the CICS domain category 373
customizations for the DB2 domain category 373

B
backing up SAS Metadata Repository 31
backup process 538
backups
data 539
metadata 539
process 538
reports 540
SAS Metadata Repository 29
Base SAS sessions
browsing metadata repository from 30
Basic Properties pane 41
batch jobs 308
batch maintain table command
examples 106
for UNIX 108
for Windows 107
for z/OS 108
options 104
syntax 104
batch mode
deploying jobs for 18
BMC Mainview IMS staging parameters 413
BMC Perf Mgr
extracting raw data 333
preparing raw data 332
raw data 332
staging parameters 414
Windows domain category 469

C
CA TMS
staging parameters 416
CA TMS adapter
customizations for the Jobs domain category 374
case-sensitive delimiter string 406
character data, gathering with snmpwalk 410
Checkouts tree 41
class columns 402
class columns, for summarized aggregation tables 166
client
See SAS IT Resource Management client
client tier 6
client tier components 322
collecting raw data 8
collectors 13
columns
See also computed columns
computed 179
deleting from indexes 196
deleting from staged tables 140
external names of columns in staged tables 144
importing into staged tables 139
in staged tables 141
in template tables 91
labeling 466
modifying properties in staged tables 139
removing join columns 178
specifying join columns 177
specifying ranking for 176
computed columns 111, 179
adding 179
adding to a table 113
adding to staged tables 138
deleting 182
in aggregation tables 143
in data model 466
in staged tables 142
in template tables 95
modifying 113, 180
configuration 547
Connection Profile dialog box 35
Connection Profile wizard 36
connection profiles 35
consolidation function 402
control data sets 457
intermediate 457
permanent 457, 458
temporary 457
counters, fast-moving 522
custom tables 368

data, backing up 539
data acquisition table
age limit for 400
data administrators
architecture and basic principles for 6
data base adapters
accessing raw data 354
data columns
adding to staged tables 138
data marts
See also IT data marts
archiving 545
deleting 69, 545
managing 544
storing 545
tips for working with 544
data model 466
adapter and domain category
specifications 469
aggregation key and ranked metrics 468
aggregation table groups and time periods 468
features 466
staging and aggregation concepts 467
data row 411
data sets, control 457
data sources 80, 325
supported adapters 325
user-written 87, 332
database adapters
duplicate-data checking 355
preparing for staging 354
date values
National Language Support (NLS) 12
datetime values
  National Language Support (NLS) 12
d debug 404
debugging 541
  additional execution-time 543
  Java objects for 543
  standard execution-time 543
default duration 402
delimiter characters 402
delimiter in raw data 402
delimiter string 403
delimiter type 410
deploying jobs 306
  adding locations for 18
  allocating raw data file externally 316
  created by Adapter Setup wizard 238
  redeploying 313
  redeploying all jobs on server 314
desktop 37
detail aggregated tables 231
detail aggregation tables 229
detail tables 9
detail-level data 13
documentation 10
domain categories 237
  jobs created by Adapter Setup wizard 443
  specifications 469
DT Perf Sentry
  accessing raw data 337
  Exchange domain category 471
  extracting raw data 338
  preparing raw data for staging 337
  Server domain category 470
  staging parameters 419
DT Perf Sentry with MXG
  staging parameters 420
duplicate-data checking 403, 456
  control data sets for 457
  examples 461
  for SAP ERP adapter 460
  implementing 459
  implementing macros for 458
  overview 455
  user-written staging code 461
duplicate-data report 456
duration
  default 402
duration, presummarization 407

E
endfile 403
existing users, adding 17
Expression Builder 205
  accessing 113

IT Formulas tab 112
external file name 404
external names
  changing for table or variable 145
  for MXG adapters 146
  of staged tables and columns 144
  per adapter 145
  viewing for columns 146
  viewing for tables 145

F
filerefs for MXG based adapters 316
  Aggregation transformation filters 201
  deleting from aggregation tables 204
  information map filters 254
  selecting for summarized aggregation tables 164
Folders tree 39
formats
  National Language Support (NLS) 12
formulas 111
  accessing 112
  consequences of changing 117
  copying 115
  creating 112, 114
  creating with New Formula wizard 114
  deleting 116
  in data model 467
  modifying 116
  renaming 118
  usage 111
FTP 404
future data 405

G
galleries 4
  Gallery Manager 4
groups of users, adding 16
guessing rows 405

H
header row 406, 411
Help 12
host 404
HP Perf Agent
  domain categories 472
  raw data 340
  staging parameters 421
HP Reporter
  domain categories 472
  staging parameters 422
HP Reporter adapter
duplicate-data checking for 460

IBM DCOLLECT
   staging parameters 423
IBM EREP
   staging parameters 424
IBM SMF
   staging parameters 426
IBM SMF custom tables 368
IBM TPF
   staging parameters 428
IBM VMMON
   staging parameters 430
icons, for objects 48
ID columns
   for summarized aggregation tables 166
ID variables
   allowing duplicates 401
   idvar 406
IMACEXCL
   customizations for the CICS domain category 373
   customizations for the DB2 domain category 373
IMACINTV
   customizations for Jobs domain category 372
IMACOWT
   customizations for the CICS domain category 373
   customizations for the DB2 domain category 373
IMACSHFT
   customizations for RMF 372
IMACSPIN
   customizations for Jobs domain category 372
IMACUOW
   customizations for the CICS domain category 373
   customizations for the DB2 domain category 373
IMACWORK
   customizations for RMF 371
importing columns into a staged table 139
indexes 156, 194
   accessing 194
   creating 195
   deleting 196
   deleting columns from 196
   indexing aggregation tables 194
   renaming 196
information map filters 254
   accessing 255
   adding 257
   benefits of 254
   created by Adapter Setup wizard 254
   deleting 259
   modifying 258
   naming 254
information map jobs, created by Adapter Setup wizard 232
information map objects
   generated by Adapter Setup wizard 252
   naming 253
   storage by Adapter Setup wizard 253
Information Map Parameters tab 255
Information Map transformations 242
   accessing properties of 243
   creating 244
   deleting from jobs 250
   errors running 263
   modifying 248
   properties 242
   specifying 244
   user-specified 244
information maps 240
   accessing in SAS Information Map Studio 261
   benefits of using 240
   creating 240
   creating with SAS Information Map Studio 261
   deleting 251
   deleting items in 262
   error opening or accessing data from 263
   generating 9
   lengthy processing time 263
   modifying items in 262
   naming conventions 495
   not appearing in IT Data Mart folder 263
   permissions for 16
   renaming items in 262
   SAS Information Map Studio 259, 546
   storage of 241
   testing 262
   tips for working with 546
   troubleshooting 263
   updating from a template 251
input file parameters 406
installation and configuration 547
insufficient disk space 146
int 406
intermediate control data sets 457
intermediate staging view 410
Inventory tree 40
IT data
   jobs for processing 295
processing with Adapter Setup wizard 296
processing without Adapter Setup wizard 299
IT Data Mart folder
information maps not appearing in 263
IT data mart objects 55
IT data marts 13, 53
accessing 55
contents of 55
creating 54, 67
deleting 69
deleting aggregation tables from 189
erasing 69
exporting 71, 72
importing 71, 73
modifying 69
New IT Data Mart wizard 54
populating 55
promoting 71
purging tables of 70
renaming 70
storage location 54
IT Data Marts tab
purging data from aggregation tables 193
IT Data Marts tree 39
deleting tables from 303
deleting tables with contents 304
purging tables from 305
IT Formulas tab 112
IT Resource Management (ITRM)
using 8
ITRM
See SAS IT Resource Management (ITRM)
ITRM Options tab
Properties dialog box 202
itrmusers group 16
deleting 301
deleting Aggregation transformations from 200
deleting Information Map transformations from 250
deleting staged tables from 137
deleting transformations from 302
deleting User-Written Staging transformation from 290
deploying and running jobs created by Adapter Setup wizard 238
deploying for scheduling 306
generating with Adapter Setup wizard 296
modifying 301
processing IT data 295
redeploying 313
redeploying all jobs on server 314
renaming 305
running 305
running an overall job with %MRUMETL macro 315
running immediately 305
scheduling to run in batch 308
scheduling with built-in or third-party scheduler 308
scheduling with Schedule Manager 309
join columns
removing 178
specifying for summarized aggregation tables 177

K
keep 406
key metrics 484
aggregations 229, 230, 484
in data model 468
server performance 485

J
JES 406
job deployment, adding locations for 18
Job Editor 41
job failure, recovering 538
job properties 43
jobs
See also Adapter Setup wizard
adding an existed staged table to 136
adding transformations to 301
created by Adapter Setup wizard 224
created by Adapter Setup wizard, for domain categories 443
creating 300
creating with Adapter Setup wizard 212
libraries created by Adapter Setup wizard 235
library for temporary work space 407
local time, converting VMware data 143
locale 13
locations, adding for job deployment 18
log files
created by Adapter Setup wizard 236
logon
to metadata server 34
LSPR tables
working with 379

L
local time, converting VMware data 143
log files
logon
to metadata server 34
IT data mart objects 55
IT data marts 13, 53
accessing 55
contents of 55
creating 54, 67
deleting 69
deleting aggregation tables from 189
deleting staged tables from 137
deleting transformations from 302
deleting User-Written Staging transformation from 290
deploying and running jobs created by Adapter Setup wizard 238
deploying for scheduling 306
generating with Adapter Setup wizard 296
modifying 301
processing IT data 295
redeploying 313
redeploying all jobs on server 314
renaming 305
running 305
running an overall job with %MRUMETL macro 315
running immediately 305
scheduling to run in batch 308
scheduling with built-in or third-party scheduler 308
scheduling with Schedule Manager 309
join columns
removing 178
specifying for summarized aggregation tables 177

K
keep 406
key metrics 484
aggregations 229, 230, 484
in data model 468
server performance 485

J
JES 406
job deployment, adding locations for 18
Job Editor 41
job failure, recovering 538
job properties 43
jobs
See also Adapter Setup wizard
adding an existed staged table to 136
adding transformations to 301
created by Adapter Setup wizard 224
created by Adapter Setup wizard, for domain categories 443
creating 300
creating with Adapter Setup wizard 212
libraries created by Adapter Setup wizard 235
library for temporary work space 407
local time, converting VMware data 143
locale 13
locations, adding for job deployment 18
log files
created by Adapter Setup wizard 236
logon
to metadata server 34
LSPR tables
working with 379
machine name 407
macros 500
%RMDELVPVT 503
%RMDUPCHK 506
%RMDUPDSN 509
%RMDUPINT 510
%RMDUPUPD 510
%RMSSBMCP 511
%RMSSDTPS 513
%RMSSCOM 515
%RMSSNMP 518
%RMPROINT 520
%RMUNETL 524
process macros 13
reduction macros 13
Maintain Staged Tables wizard 46
about 97
using across all IT data marts 103
using to update tables within an IT data mart 97
working with 97
maintaining staged tables
about 103
in batch mode 103
management information base (MIB) definitions 353
memory
client and server issues 31
SAS IT Resource Management metadata server 31
memory issues
client 31
server 31
metabrowse command 30
metadata 27
accessing SAS IT Resource Management metadata 29
backing up 539
backing up and restoring SAS Metadata Repository 29
browsing repository from Base SAS sessions 30
creating for aggregation tables 151
creating with Adapter Setup wizard 151
creating with aggregation wizard 152
exploring SAS Data Integration Studio metadata repository 30
generating for transformations supplied 27
system authentication when logging on to SAS Metadata Repository 28
metadata repository
See also SAS Metadata Repository from Base SAS sessions 30
SAS Data Integration Studio 30
metadata server
See also SAS Metadata Server
logging on to 28, 34
memory issues 31
Microsoft Office products 5, 10
middle tier 6
middle tier components 321
migration wizard 22
prerequisites 22
running 22
minimum number of files 407
MIPS and MSU columns
calculation dependencies 378
calculations 387
including in staged tables 377
initializing 379
preparing 379
staging methodology 383
MS SCOM
Exchange domain category 473
Server-Based domain categories 473
staging parameters 431
MS SCOM adapter
duplicate-data checking for 460
multi-tier processing 6
MXG
accessing raw data 332
code 370
extracting raw data from views 371
MXG adapters
external names for 146
filerefs for 316
names
external names for MXG adapters 146
external names of staged tables and columns 144
naming conventions
Adapter Setup wizard 210
aggregations 493
information map filters 254
information map objects 253
information maps 495
ITRM objects 493
object locations and reporting 497
staging 498
National Language Support (NLS) 12
New Aggregation Table through Templates wizard
creating aggregation tables 183
New Formula wizard 45
creating formulas 114
New IT Data Mart wizard 45, 54
creating IT data marts 54
invoking 54
new users, adding 17
normalize datetime 407
number of processors 407

O
objects
created by Adapter Setup wizard 228, 229
icons for 48
naming conventions and location of 493
naming conventions for 493
online Help 12

P
password 404
PDB 13
percent change
for a statistic 173
specifying for summarized aggregation tables 172
percentiles
specifying for summarized aggregation tables 171, 174
permanent control data sets 457, 458
permissions
for information maps 16
setting 18
port 404
preliminary tasks 7
presummarization duration 407
process flow diagrams
deleting tables from transformations 303
deleting tables with contents 303
purging data from aggregation tables 192
purging tables from transformations 304
setting up Aggregation transformation in 160
process macros 13
processing raw data 8
properties
aggregation tables 153
Aggregation transformations 197
columns in staged tables 139
Information Map transformations 242, 243
job properties 43
staged tables 128
staging transformations 122
table properties 44
User-Written Staging transformation 266
Properties dialog box 40
ITRM Options tab 202
purging
contents of aggregation tables 192
data from aggregation tables, on IT Data Marts tab 193
data from aggregation tables from process flow diagram 192
options for summarized aggregation tables 165
specifying criteria 166
tables from IT Data Marts tree 305
tables from transformations in process flow diagrams 304

Q
QuickStart wizard 13

R
ranked metrics 468
ranking
deleting rank columns 177
for summarized aggregation tables 175
specifying for a column 176
raw data
adapters and 79
allocating files externally 316
collecting 8
delimiter in 402
input directory 408
input file 408
input library 408
input type 401
processing (staging) 8
staging 120
type 401
rcmd 404
redeploying jobs 313
reduction macros 13
renaming
aggregation tables 193
Aggregation transformations 201
formulas 118
indexes 196
IT data marts 70
items in information maps 262
jobs 305
User-Written Staging transformation 291
report option 408
reporting
naming conventions 497
Web-based 10
reporting jobs
created by Adapter Setup wizard 233
reports
backing up 540
defining and generating for summarized data 10
viewing 10
resources
collecting raw data about 8
restoring SAS Metadata Repository 31
RMFINTRV
customizations for RMF 371
rrdtool executable 408
rrdtool fetch end option 408
rrdtool fetch start option 408
rrdtool rsh/ssh host command 409
rsh host command 409
running jobs 305
immediately 305
in batch 308
running an overall job with %RMRUNETL macro 315
Runtime Manager pane 43

S
SAP ERP
staging parameters 432, 433
SAP ERP adapter
accessing raw data 359
duplicate-data checking for 460
preparing raw data 359
SAPR3
Batch Job and Workload domain categories 475
Systems, Machines, Tasks, and Transactions domain categories 474
SAR
accessing raw data 344
extracting raw data 344
preparing raw data 344
SAR domain category 476
staging parameters 434
sar command
using 345
SAS Add-In for Microsoft Office 5, 10
SAS Business Intelligence Platform 5
SAS Data Integration Studio 4, 33, 87, 332
configuring data extraction jobs 363
exploring metadata repository 30
metadata 27
tips for working with 544
with plug-ins for SAS IT Resource Management 27
wizards supplied by 46
SAS Enterprise Guide 5
accessing SAS Metadata Repository 20
metadata 27
migrating projects 22
setting up for SAS IT Resource Management data 20
working with 20
SAS Information Delivery Portal 5
SAS Information Map Studio 5, 259, 546
accessing 260
accessing information maps in benefits of 260
creating information maps 261
modifying, renaming, or deleting items in information maps 262
overview 259
testing information maps 262
SAS IT Resource Management
data model 466
documentation 10
logging on to SAS Metadata Server 28
metadata server memory issues 31
permissions for 18
tips for installing and configuring 547
SAS IT Resource Management (ITRM) 3
accessibility 14
architecture 6
basic principles and components 7
components 321
features 3
functionality 4
preliminary tasks 7
starting 8, 34
terminology changes 13
wizards supplied by 45
SAS IT Resource Management client 33
features 37
logging on to metadata server 34
SAS Management Console 15
accessing 16, 356
adding locations for job deployment 18
adding users and groups of users 16
creating SAS metadata objects 361
introduction to metadata 27
Schedule Manager 309
working with 15
SAS Metadata Repository 5
accessing for SAS Enterprise Guide 20
backing up and restoring 29, 31
from Base SAS sessions 30
SAS Data Integration Studio 30
system authentication when logging on to 28
SAS Metadata Server
logging on to 28
logging on to from SAS IT Resource Management 28
memory issues 31
SAS Statistics and Econometric Time Series 5
SAS Web Report Studio 5, 10
metadata 27
Schedule Manager
scheduling jobs 309
scheduling
deploying jobs for 306
jobs to run in batch 308
with built-in or third-party scheduler 308
scheduling jobs
with Schedule Manager 309
Section 508 14
Section 508 compliance 14
server
performance metrics 485
server tier 6
server tier components 321
servers
redeploying all jobs on 314
simple aggregation tables 46, 149
creating with Simple Aggregation Table wizard 161
data 13
Simple Aggregation wizard 46
simple aggregations 9
site name 409
SMF
CICS domain category 479
DB2 domain category 480
Jobs, TSO and OMVS domain categories 478
limiting records 377
RMF domain category 477
SNMP
accessing raw data 346
device type lookup table 352
extracting raw data 348, 349
Network Activity, Device and Interface Data, and System Data domain categories 482
sources of raw data 346
staging parameters 435
using HP NNM tools to extract data 348
using round-robin tools to extract data 349
snmpwalk 410
source 409
spin libraries 236
specifying for ASG TMON2CIC 375
specifying for IBM SMF 375
Staged Table wizard 46
staged tables 127
adding a new computed column to 138
adding a new data column to 138
adding an existing table to a job 136
aggregating 9
columns in 141
computed columns in 142
creating 129
creating from template tables 96
deleting columns in 140
deleting from a tree view 137
deleting from jobs 137
erasing 136
external names of 144
IBM SMF custom tables and 368
importing column from another table into 139
library for 236
modifying 138
modifying column properties in 139
properties of 128
purging content of 138
task list for 129
versus template tables 89
staging
naming conventions 498
raw data 8
staging and aggregation concepts 467
staging code, user-written 82, 327
See also User-Written Staging transformation
staging data 120
columns in staged tables 141
computed columns in staged tables 142
external names of staged tables and columns 144
insufficient disk space 146
methods for 120
reasons for 120
staged tables 127
staging transformations 121
VMware 143
with MXG code 370
staging jobs
adding staging transformations to 124
created by Adapter Setup wizard 228
staging parameters 400
ASG TMONC2CIC adapter 411
ASG TMONDB2 adapter 412
BMC Mainview IMS adapter 413
BMC Perf Mgr adapter 414
CA TMS adapter 416
DT Perf Sentry adapter 419
DT Perf Sentry with MXG adapter 420
duplicate checking 439
for supported adapters 411
HP Perf Agent adapter 421
HP Reporter adapter 422
IBM DCOLLECT adapter 423
IBM EREP adapter 424
IBM SMF adapter 426
IBM TPF adapter 428
IBM VMMON adapter 430
MS SCOM adapter 431
SAP ERP adapter 432
SAR adapter 434
SNMP adapter 435
user-written 411, 439
VMware Data Acquisition adapter 437
VMware vCenter adapter 437
Web Log adapter 438
staging transformations 13, 121
adapters and 87
adding to a staging job 124
deleting 127
editing 127
properties of 122
starting SAS IT Resource Management 8, 34
statistics 555
creating for analysis columns 168
deleting 170, 172, 175
percent change calculation for 173
removing percent change calculation for 173
specifying for summarized aggregation tables 168
storing data marts 545
summarized aggregation data 13
Summarized Aggregation Table wizard
creating summarized aggregation tables 163
summarized aggregation tables 46, 149
aging and purging options 165
completing the specification of 183
computed columns 179
creating with Summarized Aggregation Table wizard 163
deleting multiple columns 170, 172, 173, 175, 177, 179
entering general information about 163
ranking 175
removing join columns 178
selecting filters 164
specifying class and ID columns 166
specifying join columns 177
specifying library information 163
specifying percent change 172
specifying percentiles 171, 174
specifying statistics 168
summarized aggregations 9
summarized data
defining and generating reports for 10
summary level data 13
supplied formulas 111
T
table groups 468
table properties 44
tables
See also aggregation tables
adding to transformations 302
deleting, with contents, from IT Data Marts tree 304
deleting from transformation in process flow diagram 303
erasing from transformations 304
purging from IT Data Marts tree 305
purging from transformations in process flow diagrams 304
purging IT data mart tables 70
staged tables 127
tape 404
template tables 79, 87
adapters and 87
columns in 91
computed columns in 95
ITMS properties for 94
locating 88
properties 90
using 96
versus staged tables 89
viewing 90
temporary control data sets 457
temporary work space library 409
terminology changes 13
testing
information maps 262
time periods 468
timestamps 79
timestamp 409
transformations 8, 48
adding tables to 302
adding to jobs 301
Aggregation transformations 9
deleting from jobs 302
erasing tables from 304
generating metadata for 299
purging tables from process flow diagram 304
Transformations tree 40
Tree views 39
deleting staged tables from 137
trees 39
troubleshooting
information maps 263

U
UNIX system data sources 82, 327
user 404
user groups, adding 16
user-defined formulas 111
creating 112
user-specified Information Map
transformations 244
user-written data sources 87, 332
user-written staging code 82, 327, 461
user-written staging parameters 411
User-Written Staging transformation 265
additional generated code 292
Code tab 267
creating 284
deleting from a job 290
Extended Attributes tab 267
General tab 266
modifying 291
Notes tab 267
Precode and Postcode tab 267
properties 266
renaming 291
staging parameters 439
Staging Parameters tab 266
users
adding 17
users, adding 16
UTILEXCL
customizations for the CICS domain
category 373
customizations for the DB2 domain
category 373

V
viewing
reports 10
template tables 90
VMware
converting to local time 143
Guest and Host Disk, Network, and
System domain categories 482
VMware adapter
duplicate-data checking for 460
limiting data in staged tables 364
VMware Data Acquisition
staging parameters 437
VMware lookup table
populating 367
working with 366
VMware vCenter
staging parameters 437
VMware vCenter Data Acquisition
adapter 396
VMware vCenter Data Acquisition job
running 397
working with 396

W
Web Log
accessing raw data 354
all domain categories 483
staging parameters 438
Web-based reporting 10
Windows system data sources 82, 327
wizards 45
supplied by SAS Data Integration
Studio 46
supplied by SAS IT Resource
Management 45

Z
z/OS
additional requirements 31
z/OS data sources 80, 326